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요 약 문

Ⅰ. 제 목

아라온 멀티빔 잡음 제거 및 신호 활용을 통한 양극 해저면 물성 도출 연구

Ⅱ. 연구개발의 목적

본 연구의 목적은 멀티빔 자료를 활용하여 양극 해저면의 물성을 도출하고 양극해 환경

특성 지도 작성을 위한 기본 자료를 제공하는 것이다.

Ⅲ. 연구개발의 내용 및 범위

본 위탁과제에서 수행한 주요 연구 내용 및 범위는 다음과 같다.

§ 아라온호 설치 멀티빔 시스템 EM-122에 대한 제원, 현황 및 운영 방법 분석

§ 아라온호 승선을 통한 시범 자료 획득 (2회) 및 관련 원시 자료 획득

§ 양극해에서 획득된 멀티빔 자료에 대한 사전 편집 등 본격 잡음 제거 및 해저 물성 도출을

위한 사전 자료 편집 및 처리

§ 시범 항해 및 양극해 조사 측선도 작성

§ 상업용 멀티빔 자료 처리 프로그램인 Caris Hips & Sips를 통한 잡음 제거 및 보정 처리

§ 공개용 멀티빔 자료 처리 프로그램인 MB-system 활용 잡음 제거 및 보정 처리

§ 후방 산란 신호를 이용한 양극 해저면 물성 예비 평가 수행

§ 해저면 물성 추정 해석 및 잡음 제거 해저 기복도 (bathymetry map) 작성처리

Ⅳ. 연구개발결과

본 위탁과제를 통해 도출된 연구의 주요 결과는 다음과 같다.

§ 아라온호 Kongsberg사의 멀티빔 시스템 EM-122에 해안 제원 및 현황 분석 완료

§ 동해 시범 항해 (2012년 6월, 2014년 5월), 남극 로스해 (2012년 1월, 2013년 2월) 및 북극

척치/보포트해 (2012년 8월) 획득 자료 처리 및 조사 정밀 측선도 작성

§ 동해 및 양극해 자료의 정밀 검토 및 주요 지점에 대한 잡음 제거 효과 분석

§ 양극해 자료 후방산란 신호를 통한 해저 물성 추정 수행

§ 멀티빔 자료 처리 프로그램별 주요 기능 분석 및 특성 비교

§ 멀티빔 조사 대상 지역에 대한 해저 기복도 (bathymetry map) 구축

Ⅴ. 연구개발결과의 활용계획

본 연구의 연구개발 결과는 양극해의 환경 특성을 이해하고 이를 통한 환경 특성 지도 작

성에 기본 자료로 활용될 수 있다. 또한 본 연구 결과를 기초하여 향후 필요 시 아라온호 멀티

빔 시스템에 최적화된 자료 처리 모듈을 개발 할 수 있을 것으로 생각된다.



S U M M A R Y

I.  Title	
Araon	 Multi-beam	 Data	 Processing	 Research	 -	 Noise	 Suppression	 and	 Polar	 Ocean	 Bottom	 Properties	 Controls	 -	
II.  Purpose	 of	 R&D
The	 purpose	 of	 this	 study	 is	 to	 evaluate	 ocean	 bottom	 properties	 and	 provide	the	 basic	 data	 for	 construction	 of	 environment	 characteristics	 map	 on	 Antartic	 and	 Artic	Oceans	 by	 utilizing	 Araon	 multi-beam	 data.

III.  Contents	 and	 Extent	 of	 R&D
In	 this	 dispatched	 research,	 the	 following	 studies	 were	 conducted	 in	 order	 to	achieve	 the	 goals	 of	 main	 research	 :	
▪ Analysis	 of	 specifications	 and	 status	 of	 multi-beam	 EM-122	 system	 which	 were	installed	 on	 Araon	 Research	 Ship
▪ Involving	 in	 two	 test	 cruises	 in	 East	 sea	 and	 acquisition	 of	 raw	 mult-beam	 data	for	 the	 understanding	 EM-122	 system
▪ Multi-beam	 data	 converting	 and	 preliminary	 data	 editing	 for	 the	 noise	suppression	 and	 characterizing	 the	 sub-bottom	 sediments
▪ Preparing	 the	 survey	 maps	 for	 the	 test	 cruises	 and	 Artic,	 Antiarctic	 Oceans	multi-beam	 survey	 cruises
▪ Processing	 multi-beam	 data	 using	 Caris	 HIPS	 &	 SIPS	 (commercial	 software	licensed	 in	 KOPRI)	 for	 the	 noise	 suppression	 and	 data	 corrections
▪ Processing	 multi-beam	 data	 using	 MB-System	 (open	 source	 software)	 for	 the	noise	 suppression	 and	 data	 corrections
▪ Preliminary	 evaluation	 of	 ocean	 bottom	 sediments	 in	 polar	 regions	 using	 back	scattered	 multi-beam	 data
▪ Interpretation	 of	 ocean	 bottom	 sediment	 properties	 and	 prepapring	 bahymetry	maps	 in	 polar	 regions	 after	 noise	 suppression
	



IV.  R&D	 Results
In	 this	 dispatched	 research,	 the	 following	 representative	 results	 were	 obtained	 :	
▪ Analysis	 and	 understanding	 of	 specifications	 and	 status	 of	 Kongsberg	 multi-beam	EM-122	 system	 which	 were	 installed	 on	 Araon	 Research	 Ship
▪ Data	 processing	 of	 multibeam	 data	 acquired	 in	 East	 Sea,	 Ross	 Sea	 (Antiarctic	Ocean)	 and	 Chucki/Beaufort	 Sea	 (Arctic	 Ocean)	 and	 preparing	 the	 detailed	survey	 maps	
▪ Detailed	 multi-beam	 data	 reviews	 and	 analysis	 of	 the	 effects	 on	 noise	suppression	 in	 bathymetry	 study
▪ Preliminary	 prediction	 of	 ocean	 bottom	 sediments	 using	 back	 scattered	multi-beam	 data	 in	 polar	 regions
▪ Comparing	 and	 analysis	 of	 Caris	 and	 MB-system	 program	 characters	 in	multi-beam	 data	 processing	 steps	 	
▪ Making	 detailed	 bahymetry	 maps	 in	 polar	 study	 regions	 after	 multi-beam	 data	processing	
	
V.  Application	 Plans	 of	 R&D	 Results
It	 is	 believe	 that	 the	 results	 of	 this	 dispatched	 research	 would	 be	 used	 in	 basic	data	 set	 for	 the	 preparing	 of	 polar	 environment	 maps.	 Also	 the	 results	 and	 developed	 (or	reviewed)	 processing	 sequences	 would	 be	 helpful	 to	 construct	 optimal	 multi-beam	 processing	algorithm	 of	 EM-122	 system	 installed	 in	 Araon	 Research	 Ship.	
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제 1 장 서론

본 연구의 목적은 멀티빔 자료 신호 처리를 통해 보다 효율적인 양극 해저면의 물성을 도

출하는 방법을 제시하고, 궁극적으로 멀티빔 자료의 결과를 활용하여 양극해 환경 특성 지도

작성을 위한 기본 자료를 제공하는 것이다.

1. 기본 개요

해양 조사에 있어 음향을 활용한 수중과 해저면의 정보를 획득하는 기술은 이미 다양한 방

식으로 적용되고 있다. 이중, 멀티빔 음향 측심기는 가장 발전된 방식의 음향 활용 정보 획득

방법에 해당되며, 다중의 음향 신호 발생기의 신호를 다중의 음향 수신기에 기록하여, 기본적

으로 해저 기복, 해저면 상태 등을 확인하는 기술이다.

멀티빔 음향 측심기는 1960년대 미국 해군이 General Instrument사와 함께 최초로 개발하

여 활용한 것으로 알려져 있다(Theberge and Cherkis, 2013). 이 후, 멀티빔 음향 측심기는 해

양 공학, 해저자원탐사, 해저 건설 및 공사 등의 발전과 더불어 전 세계적으로 널리 이용되고

있으며, 특히 다중 채널 탄성파 탐사 장비(Multi-channel Seismic Survey Instrument), 해저

지층 탐사기(SBP : Sub-Bottom Profiler) 및 측면 주사 음향측심기(SSS : Side Scan Sonar)

등의 지구물리학적 방법과 함께 이용되고 있다. 음향 혹은 탄성파를 활용하는 다양한 장비 중

에서도 멀티빔 음향 측심기는 정확한 위치 정보를 근거로 정밀한 해저 지형을 조사할 수 있게

한다. 뿐만 아니라 멀티빔 음향 측심기는 해저면에 반사되어 되돌아오는 음파의 음압을 기록하

여 해저면 영상 자료의 취득도 가능하게 하여, 해양공간 정보를 정확히 획득하고 해저 지형을

면밀히 관찰할 수 있는 매우 유용한 탐사 장비이다. 멀티빔 음향측심기는, 단일빔 음향측심기

에 비해 보다 정밀하고, 작업 효율성이 높으며 광대역의 해양 공간 정보를 제공하며, 다양한

보조적인 관측 센서들과 하나의 시스템으로 통합 운영되고 있다(박요섭과 김학일, 1999; 공기

수 외, 2006; 정철훈 외, 2006).

군사용으로 처음 개발된 멀티빔 음향측심기는 수십～수백개의 수신기(Hydrophone)와 프로

젝터(Projector)로 이루어져 있으며, 탐사선에 수직방향으로 해저면을 주사(Swath)하여, 한번의

송수신(Ping)으로 다중의 빔 자료를 얻는 측심기이다(박요섭과 김학일, 1999). 송신 변환기

(transducer)로부터 부채꼴 모양으로 초음파 에너지를 방사하고, 해저면에서 반사 또는 후방 산
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란된 에너지를 수신 변환기가 감지한다(김준식 외, 2009).

멀티빔 음향 측심기는 sonar transducer array로 구성되어 각 sonar array의 위상차

(phase)를 조절하여 지향각 (pointing angle)을 가지는 빔을 생성할 수 있으며, 음파를 발사할

때에는 현방향으로 넓고, 선수방향으로는 빔 폭이 좁은 부채꼴 모양의 빔을 생성하여 발사하

고, 수신할 때에는 그와 직교되는 방향으로 여러 개의 빔을 수신하여 두 빔의 직교되는 방향으

로 여러 개의 빔을 수신하여 두 빔의 직교되는 시점을 관측하여 경사거리를 측정하게 된다(노

정식 외, 2009).

멀티빔 음향측심기는 세밀한 음향신호를 만들어내기 위해서 얇은 빔을 만들어 송신하고 시

간 순서대로 수신하는 구조로 되어있다. 음향 빔을 세밀하게 만들어도 전파되는 과정에서 확산

되기 때문에 얇은 빔을 만들어 관측 경로를 중심으로 횡방향으로 해상도가 저하된다. 다수의

음향신호를 소나방정식을 이용하여 거리를 계산하고 수신 각도 별로 재구성하여 해저 지형을

복원하게 된다. 심해용 시스템의 경우12 kHz 이하 주파수의 음향신호를 만들고 기록하는 송수

신기 센서가 매우 크기 때문에 설치할 수 있는 선박이 제한된다. 천해용 시스템의 경우 100에

서 200 kHz 정도의 음향 신호를 주로 사용하며 연안 쪽을 관측하는 용도로 주로 사용된다. 고

해상도 시스템의 경우 300에서 500 kHz 주파수 음향 신호를 사용하여 침몰한 배나 수중 구조

물을 검사하는 용도로 사용된다(권광석, 2013).

멀티빔 음향 측심기는 해저의 심도에 해당되는 거리 측정 용도뿐 아니라, 해저면에서 반사

혹은 후방 산란되는 음향 신호의 강도를 통해 해저면의 상태, 다시 말해, 해양 퇴적물의 상태

를 간접적으로 추정하는데, 활용될 수 있다. 멀티빔 음향측심기를 이용한 해저면 상태 평가는,

상대적으로 측면 주사 음향 측심기에 비해 정확도와 해상도가 낮지만, 넓은 범위를 빠르게 평

가하는데는 이점을 가지고 있다.

멀티빔 음향 측심기의 핵심 부품은 송신 장치(transmitter)와 수신 장치(receiver)로 그림 1

에서 보는 바와 같이 송신 장치는 배의 진행 방향에 수직한 방향으로 음향 빔을 발생시키고,

수신 장치는 배의 진행 방향과 평행한 방향의 음향 신호를 받아내는 방식으로 해저면 전체 평

면에서 반사되는 신호를 감지하여 처리할 수 있다.



3

그림 1. 멀티 빔 송신 빔과 수신 빔 관계 (from http://www.amloceanographic.com/)

멀티빔 음향 측심기를 통해 획득된 자료는 일반적으로 조사 측선과 해저 기복도의 형식으

로 제시되어 정보를 제공한다. 또한 해저면 상태의 경우는 주로 반사 신호의 강도를 흑백 혹은

천연색으로 구분하여 제시하고 특정 강도 범위에 대하여 추정되는 퇴적물을 평면적으로 표시

(contour or color map)하거나 혹은 강도 곡선을 특정 구간에 대하여 표시하는 방식(profile)으

로 제공한다. 본 위탁 연구 과제에서도 최종 결과는 주로 측선도, 해저 기복도 및 반사 신호

정보로 제공되었으며, 필요에 따라 개별적인 자료 처리 과정을 제시하였다.

2. 멀티빔 음향 측심기의 측심 원리 및 보정 기술

(가) 측심 원리

음향 측심의 기본 원리는 반사되어 온 주시 (travel time)을 이용하는 것으로 요약된다. 일

반적으로 음향 측심기는 주제어부, 기록부, 송수신부 등으로 구성되어있다. 주제어부는 음파 신

호 발진 주기, 강도, 신호보정 등을 담당하고 있으며 주제어부가 트랜스듀서에 전기적 트리거

신호를 입력하면 트랜스듀서에서 특정 주파수의 음파가 해수면을 향해 방사되며 해저면에서

반사된 반사파는 다시 트랜스듀서에 전달되어 전기적 신호로 수신된다. 이때 송신에서 수신까

지 걸린 왕복 주사시간(t)과 수중에서의 음파 전달속도(v)를 곱하여 전달거리(R)로 환산하게

된다.
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즉 기본적으로 반사되어 되돌아오는 신호를 감지하여 가정된 속도에 따라, 심도를 환산하게

된다. 여기서 중요한 것은 많은 신호 중에서 어떠한 신호가 실제 해저면에서 반사되어 돌아온

신호인지를 구별하는 것으로 이에 대한 다양한 반사 신호 선별 방식이 존재하게 된다.

(나) 멀티빔 음향측심기의 오차 및 보정

멀티빔 음향측심기는 수심의 처리 성과를 높이는 반면, 오작동과 오정렬로 인하여 측심기의

Roll 오차, Pitch 오차, Heading 오차, Tide 오차, 음속도 오차 등을 발생시키는 문제점도 있다.

이들 오차 중, Yaw, Roll, Pitch, Heading은 배가 완전히 고정되지 못하고 끊임없이 움직이는

현상에 의해 나타나는 현상이다. 실제 진행 방향과 뱃머리의 방향의 편차를 Heading, 수직 방

향축에 대한 회전을 Yaw, 진행방향 축에 대한 회전을 Roll, 진행방향의 수직한 수평면 축에

대한 회전을 Pitch라 하며(그림 2 참조), 이에 대한 상세한 사항은 다음과 같다.

그림 2. 측심 오차를 일으키는 배의 움직임 정의

▪Roll 및 Pitch 오차

Roll 오차는 수심측량 시 발생하는 오차 가운데 가장 크고 중요한 원인 중에 하나이다. 롤

에 의한 측심 오차는 평탄한 해저면에서 외곽빔으로 갈수록, 수심이 깊을수록 증가 한다. Roll

보정을 하지 않을 경우 이웃 측선과의 중첩지역 발생하지 않는 미 계측 구간이 생길 수 있다.

Roll에 의한 측심의 위치 오에 의한 수심오차는 일정한 Roll 오프셋에 의해 빔이 수심에 비해
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그 경사거리가 길어져 수평, 수직 오차를 발생시킨다. Roll 오프셋 값을 보정하기 위해 평탄한

해저면에서 측선을 설계하여 서로 다른 방향으로 탐사를 수행하여 보정해준다.

선체의 Pitch 오차는 소나헤드의 z축 상 거리의 변화에 영향을 미치며 이로 인해 주사폭의

변화에도 영향을 끼친다. 하지만 Pitch 오프셋이 측심 위치 및 수심 측정 결과에 미치는 영향

은 다른 오프셋에 비해 상대적으로 적다. Pitch 오프셋의 경우 측위 시각 지연과 거의 같은 현

상으로 파악되며, 이를 보정하기 위해서는 일정한 경사가 있는 동일한 측선에서 서로 다른 방

향으로 같은 선속을 유지하며 탐사를 수행하여야한다.

MB-system을 활용하여 Roll 및 Pitch 오차를 보정하기 위해서는 mbrollbias 명령과

mbpitchbias 명령이 사용된다. 기본적으로 이 명령을 통해 측선의 일부 중, 유사 지역을 지나

간 구간을 활용하여 그 오차 발생을 검토하고 이를 통해 개괄적인 Roll 및 Pitch의 오차를 보

정하는 방식이다. 관련 상세 사항은 개별 명령의 상세 설명을 참조할 수 있다.

▪Yaw 및 Heading 오차

Yaw 오차는 기본적으로 Heading 오차를 야기 시키게 되므로, 보통은 직접 사용되지 않고

Heading 오차의 형태로 보정에 이용되게 된다.

Heading 오차는 자이로 콤파스에서 측정한 선수각 기준과 트랜스듀서의 x축이 이루는 사

이각의 오정렬로 발생된다. Heading 오차를 보정하기 위하여 측선은 약 20% 중첩되도록 하고

특정한 해저 목표물을 기준으로 동일한 선속으로 서로 다른 선수방향의 측선을 탐사하여 자료

를 취득하고 보정해야한다.

위에 언급한 4가지 배의 흔들림과 관련된 오차 이외에 측정된 심도에 영향을 주는 대표적

인 오차는 조석 오차와 음속도 오차가 있다. 조석 오차는 조석 효과에 의해 실제 해수면의 높

이가 끊임없이 변화하는 현상으로 인해 발생되며, 음속도 오차는 실제 해양의 바닷물이 일정한

속도를 갖지 않고 수심에 따라 변화하는 현상에 의해 발생되는 오차이다. 이에 대한 설명은 다

음과 같다.

▪조석(Tide) 오차

바다의 수위는 천체에 의한 인력, 천체와 지구 사이의 지구공전에 의한 원심력, 기압의 변동,

수면의 진동, 장주기 파랑에 의해 끊임없이 변화한다. 이러한 요인에 의하여 해면이 주기적인

승강운동을 하는데, 이를 조석(Tide)이라 한다. 조석 현상은 해양에서의 각종 과정에 큰 영향을

주는 뚜렷한 자연 현상으로 조석의 정확한 파악과 추정은 매우 중요하다. 해변은 조석으로 인
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하여 끊임없이 변화하고 있으므로, 이 높이와 수심 기준면 (datum level)의 차를 시각에 따라

측정 수심에 개정해야 실제 수심이 된다. CARIS HIPS & SIPS 7.0 소프트웨어의 경우

Process 메뉴의 Lode tide를 통해 조석 보정이 가능하다.

▪ 음속도 오차

수중의 음파 전달 속도를 결정해 주는 값으로 일반적으로 해수의 수피 변동 즉 수온, 수심

및 염분의 변동은 음파의 전달속도와 밀접한 관계를 보인다. 음속은 해양에서 항상 일정 하지

않으며 그 음향의 줄기 또한 똑바로 진향하지 않고 음원에서 전파되어 나감에 따라 굴절된다.

그 기본적인 관련성은 음속도가 다른 충돌 사이에서 나타나는 굴절 각도와 관련이 잇는 스넬

의 법칙 (Snell’s Law)에서 주어진다. CARIS HIPS & SIPS 7.0 소프트웨어의 경우, 관측한 다

중빔 음향 측심 탐사를 하며 동시에 취득한 SVP (Sound Velocity Profile) 혹은 SSP (Sound

Speed Profile) 자료를 SVP editor를 이용하여 속도 보정이 가능하다. 그러나 이러한 음속도

오차 보정을 위해서는 SVP 자료의 확보가 필수적인데, 현장에서 SVP 자료 획득은 한계가 있

으므로 제한된 SVP 자료로부터 효과적으로 전반적인 해수층의 속도 분포를 유추하기 위한 노

력이 필요하다.

MB-system에서는 Mbvelocitytool을 통해 수중 음파 속도를 보정하며, 특별한 수중 음파

속도 정보가 없는 경우에는 그 동안 오랜 시간에 걸쳐 전 세계적으로 수집된 자료를 데이터

베이스로 활용하는 MbLevitus 프로그램을 활용하여 개략적인 SVP 자료를 추정 활용 가능하

다. Mbvelocitytool을 이용하여 측심을 보정하는 일련의 과정은 이 후의 주요 연구 내용 관련

부분에서 다시 설명한다.



7

제 2 장 국내외 기술개발 현황

기존 단일빔 음향 측심기는 수심이 측정되는 위치가 선박의 직하부 해저바닥에 국한되므로,

탐사측선 간격이 좁을수록 정밀한 성과를 얻을 수 있었으며 조사해역전체에 대한 해저지형은

등수심선으로 표현되었다. 한편, 멀티빔 음향 측심기를 사용하면 넓은 해역을 짧은 기간 내에

조사할 수 있을 뿐만 아니라 자료의 양이 방대하여 해저 지형을 3차원적으로 상세하게 표현할

수 있다.

국-내외 기술과 장비가 발전하면서 멀티빔의 활용뿐만 해석과 처리에도 많은 연구가 진행

되고 있다. 정밀한 해저 지형조사에 필수 장비로 알려진 멀티빔 음향측심기는 정확한 수심 및

해저지형을 파악할 수 있어서 선박의 안전한 항해에 이용되며, 해난사고의 발생 근원인 해저면

위험 요소 조사와 해저퇴적물의 이동 및 변화 등에 대한 연구에 많이 이용된다. 국내에 사용

예로 해저 가스배관 조사, 침선 조사, 인공어초 조사 및 해저 분화구 조사 등의 연구가 진행되

었다(김준식 외, 2009).

극지 환경의 이해는 미래의 환경변화 대응과 전 세계적인 관심사인 기후변화와 에너지 문

제를 해결하는데 객관적인 근거 제공의 기회를 부여한다고 할 수 있다. 또한 최근 해양조사의

수요는 전 세계적으로 꾸준히 증가하고 있으며, 이러한 해양 조사는 해저 환경의 이해뿐 아니

라 해저자원개발과 기타 인류의 해양공간 활용을 위한 기초가 되고 있다. 특히 멀티빔 음향 측

심기를 이용한 정밀조사는 해저면 지도 작성은 물론 반복적 조사를 통해 해저환경의 변화를

직접적으로 알아내는데 크게 기여할 수 있다.

일반적으로 해양에서 음원파를 사용하는 시스템은 SONAR(Sound NAvigation and Range),

로 불리우며, 원리적으로 레이다 및 전자광학 시스템과 유사하다(Hodges, 2010). 1980년대 경

부터 멀티빔 시스템이 등장하면서 정확한 위치정보를 근거한 정밀수심 자료와 해저면 영상자

료의 취득이 가능하게 되었으며 1990년대 말에는 후방산란 음압자료를 이용한 해저표층퇴적물

의 특성분류 시도가 시작되었다. 최근에는 음향특성을 고려하여, 해저면에서 반사되는 음향특

성과 퇴적물의 지질학적 특성간의 상관 관계를 정량화하려는 연구가 꾸준히 진행되고 있다

(Gonidec et al.,2003; Tang et al., 2005).

멀티빔 시스템은 우리나라에 1990년대 초 도입되기 시작하여 주로 해양수로 조사에 이용되

었으며 후방산란 음압자료를 이용한 해저면 특성에 대한 연구는 많이 이루어지지 않다가 1990

년대 후반부터 후방산란 음압의 오차 요인을 분석 처리하는 연구가 수행되면서 시작된 것으로

알려져 있다(박요섭, 2004). 또한 극지연구소에서 아라온호를 도입하면서 아라온호에 장착된 고
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성능의 멀티빔 장치에 의해 매년 다양한 연구 과제의 일환으로 꾸준히 멀티빔 자료가 획득되

고 있다. 본 연구 과제 수행을 위한 양극해 및 국내 연근해 (주로 동해) 시험 항해를 통해서도

멀티빔 자료가 착실하게 획득 보관되고 있다. 한편 국내의 경우, 울릉도와 독도 근해에서 정밀

한 퇴적물 분포에 대한 연구가 최근에 수행된 바 있다(이명훈 등, 2015).

한편 최근 들어 간섭 효과 (interferometry) 기법을 이용하여 보다 정밀하고 신뢰도 높은 해

저 심도 정보를 획득하는 연구들이 발표되고 있다(Kraeutner and Bird, 1999; Llort-Pujol et.

al, 2006; Llort-Pujol et. al, 2012). 간섭 효과 기법은 기본적으로 이격되어 수신된 신호들끼리

의 상호 상관 분석을 통해 일반적으로 놓칠 수 있는 신호를 향상 시키고, 사용하는 음파의 기

본 파장의 한계로 인한 심도 오차를 최소화하는 기법으로 설명할 수 있다. 그림 3은 수신기들

사이에 생기는 기본적인 신호 도달 시간 차이에 대한 기하학적 해석을 보여주며, 결국 이러한

신호의 차이를 상호 상관을 통해 부각시켜 보다 정밀한 해저 심도 정보를 획득하게 된다.

그림 3 음향 간섭 효과를 활용한 해저 심도 신뢰성 향상 기법 기본 원리 설명 사례

(Llort-Pujol et. al, 2012)

그림 4 . 인접한 두 수신기 상화 상관에 의한 간섭 신호 부각 사례 (Saeboe, 2010)
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그림 5는 간섭 효과를 통해 기존 멀티빔 자료에서 부각 시키지 못했던 부위를 정밀하게 부

각 시킨 해외 연구 실례를 보여주고 있다. 이러한 간섭 효과에 대한 연구는 본 위탁 연구 범위

에 포함되지는 않지만 향후 양극해에서 얻어지는 멀티빔 자료에 대한 높은 정밀도의 해저면

자료가 필요한 경우, 연구해 볼 과제로 판단된다.

그림 5 상관 분석을 통해 정밀 분석된 해저 심도 자료 사례

(Llort-Pujol et. al, 2012)

앞으로 국제적인 수준의 멀티빔 자료 활용 자료 처리 기술 및 해석 기술의 개발은 국가 경

쟁력 고양을 위해 매우 필수적인 기술이라고 할 수 있다. 현재 수행된 본 위탁 과제는, 신뢰성

있는 멀티빔 자료 확보를 위해 기본적으로 상업용/공개용 기존 프로그램을 통해 잡음 제거와

다양한 현장 획득 자료에 대한 보정 수행 그리고 일부 관심 구역에 대한 해저면 퇴적물 특성

을 후방 산란 신호 분석 처리를 통해 조사하는 내용으로 연구 수행 범위가 한정되어 수행되었

지만, 향후 경쟁력 있는 국제적인 수준의 멀티빔 관련 자료 처리 기술 확보를 위해 직접적인
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프로그램 개발, 간섭 기법 적용 연구와 더불어 필요하다면 멀티빔 자료 획득 장치의 개선 등을

통해 보다 신뢰성 있는, 해양 환경과 양극해 환경을 이해하기 위한 기초 자료 확보를 위한 연

구 투자가 필요할 것으로 생각된다.
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제 3 장 연구방법, 주요 연구 내용 및 결과

본 장에서는 기본적으로 본 위탁 연구 과제를 통해 수행된 연구의 방법, 주요 내용 및 결과

를 정리하여 기술하였다. 기존에 제출된 연차 보고서들을 통해 해당 년도의 연구 내용을 알 수

있으므로, 본 최종 위탁 보고서에서는 이들 내용을 연차별로 정리하지 않고, 주로 적용된 연구

방법과 연구 지역 등에 따라 구분하여 기술하는 방식을 취하였다. 또한 연차 보고서의 내용들

을 기본으로 하였으며, 일부 오류가 있거나 미흡한 부분의 내용은 보완하여 기술하였다.

쇄빙연구선 아라온호에 장착된 Kongsberg사의 EM-122의 제원 분석은 기본적으로 기존 아

라온호 관련 문헌 분석과 더불어 동해에서 2차에 걸쳐 수행된 (2012년 6월, 2014년 5월) 시험

항해에 연구원이 직접 승선하는 방식으로 수행되었다. 시험 항해 중, 실제 멀티 빔 자료 획득

운영 시스템에 대한 작동 과정을 기록하고 정리하였고, 현장에서 확인 가능한 자료와 추후 자

료 처리를 위해 저장되는 자료에 대한 구분을 수행하였다.

시험 항해와 양극해에서 획득된 자료는 상업용 프로그램인 CARIS HIPS and SIPS

(version 7.0, 운영체제 Windows, 극지연구소 구매 라이센스 확보)를 통한 방식과 공개용 프로

그램인 MB-system (version 5.5, 운영체제 Linux/Ubuntu 14.04LT 배포판에 설치)를 통한 방

식으로 주로 처리되었다. 자료 처리 과정에서 필요한 경우 자체적으로 작성된 간단한 스크립트

나 프로그램을 활용하여 작업의 편이성을 도모하기도 하였다.

활용된 멀티빔 자료 처리 프로그램인 CARIS HIPS and SIPS와 MB-system은, 본 위탁 연

구 과제에서 수행한 잡음 제거 및 보정 등을 통한 해저 기복도 작성과 후방 산란 신호를 이용

한 해저면 특성 분석 이외에도 다양한 기능을 갖추고 있지만, 본 보고서에는 수행한 연구와 직

접적으로 관련된 필요 부분에 대한 설명을 중심으로, 제 2 절 주요 연구 내용에 주로 기술하였

다.
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1. 아라온호 설치 멀티빔 시스템 EM-122 제원 현황 및 운영 방법 분석

쇄빙연구선 아라온호에 장착된 Kongsberg사의 EM-122는 현재 제작, 판매되고 있는 멀티

빔 음향 측심 시스템 중, 가장 깊은 심도까지의 해저면 조사가 가능한 고성능 멀티빔 장치다.

그림 6은 Kongsberg사에서 현재 제작 시판하는 대표적인 멀티빔 음향측심 장비들의 최대 조

사 심도를 도식적으로 보여주고 있다.

그림 6. Kongsberg 멀티빔 음향측심 장비 최대 조사 심도 개념도

(source : www.km.kongsberg.com)

EM-122 멀티빔 음향 측심 장비는, 수중음파 탐지기 주파수 대역으로 12 kHz를 사용하며,

빔의 각도는 최대 150°까지 가능하지만, 아라온의 경우, 보통 좌우 70°씩 140°로 설정되어 사용

되고 있다. 빔의 각도를 140°로 설정 할 경우, 수심의 약 3～5 배에 해당하는 해저면의 횡단면

스캔이 가능하며, 빔의 각도 및 범위는 제어를 자동으로 설정할 수 있어 해저면의 깊이에 따라

관측되는 폭의 범위도 자동으로 변환시킬 수 있다.

최소/최대 조사 심도는 20～11,000m로 아주 낮은 연근해와 매우 깊은 해구를 제외하고는

거의 모든 바다에서 조사를 수행할 수 있는 우수한 장비이다. 개별 구역으로 분할된 송신 팬은

항해 시 RPY 3축(roll, pitch, yaw)에 따라 독립적으로 활성화되어 운영되며, 항해 시 해양의

흐름과 파고로 발생되는 측정 오류를 특정 범위 내에서는 자동으로 보정이 가능하다. 핑의 비
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율은 주로 물의 왕복 소요시간에 의해 5 Hz (초당 5회)로 제한된다. 이 장비를 통해 넓은 범위

의 해저면 데이터를 보다 정확하게 고 해상도로 얻을 수 있다.

한편, 다른 조사 장비(sub-bottom profiler, side scan sonar, seismic survey system 등)와

통합 운영이 가능하다. EM-122 장비에 대한 상세한 제원과 특성은 별도 부록 자료 (EM-122

Specification)로 보고서 뒤에 첨부하였다.

그림 7은 아라온호에 장착된 EM-122의 시스템 기본 구성도를 보여주고 있으며, 그림 8 및

9는 실제 아라온호에서 촬영된 EM-system과 자료 획득 운영 과정 및 시스템 일부를 보여주

고 있다.

그림 7. 아라온호에 장착된 멀티빔 EM-122 시스템 구성

(A: 운영 시스템, B: SBP 송신 장치(옵션 장치), C: 멀티빔

송수신부 및 신호 처리부)
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그림 8 아라온호에 설치된 EM-122 시스템
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그림 9 아라온호 EM-122 멀티빔 자료 획득 운영 시스템 (2014년 동해 시험 항해 시 촬영)

강한 음향 신호를 발생 시키는 송신 변환기(Transmit transducer)는 빔 폭에 따라 96개의

모듈로 구성되어있으며, 각 모듈은 16개의 요소가 포함되어 있다. 각각의 요소는 개별적으로

TX 접속 배선함(TX Juntion box)을 통해 연결되어 있고, 이를 통해 진폭의 범위와 송신 운영

에 필요한 분야를 구동할 수 있다. 해저면에 반사되어 돌아온 신호는 수신 변환기(Receive

transducer)를 통해 획득하여 전치 증폭기(Preamplifier unit)로 신호의 감쇠 및 신호잡음비

(S/N)의 저하를 막고 송수신기(Transceiver unit)로 전송한다. 송수신기는 고성능의 제어장치와

연결되어 장비의 모든 매개 변수의 제어하고 작동시킨다.

한편, 현재 아라온의 자료 획득 운영 시스템은 자료 취득과 동시에 수심 분포에 대한 예비

처리 도면을 볼 수 있고 위치 설정 (geo-referencing)이 충분하지 않은 상태에서의 후방 산란

신호 강도 (seabed image)를 개괄적으로 볼 수 있다. 또한 획득되는 beam 신호를 조사선 진행

방향의 수직 단면 형태로 볼 수 있는 water column (혹은 beam fan)을 실시간으로 화면상에

서 확인 할 수 있지만(그림 10 참조), 이 신호들에 대한 자료 저장 시스템은 현재 구비되어 있

지 않아 후처리 등을 통한 해저면의 정밀한 특성 분석은 가능하지 않다.

그림 10 아라온 멀티빔 운영시스템 water column 자료 실시간 도시 영상
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향후 해저면의 열수 분출이나 가스 분출 등에 대한 정보 획득을 위해서는 water column

자료를 저장할 수 있는 시스템이 필요할 것으로 생각된다. 이러한 자료 저장 시스템은 시간에

대한 신호 강도 자료(time series amplitude)를 조사 구간 (range)에 대해 전체적으로 기록하므

로, 다양한 해저면 정보를 매우 정밀하게 제공할 수 있는 것으로 알려져 있다. 그림 11은 실제

해외에서 water column 자료를 통해 해저면에서 분출되는 gas plume을 정확히 조사해 낸 사

례를 보여주고 있다.

그림 11 Water column (beam fan) 자료를 이용한 해저 gas plume 조사 사례

(source : www.qps.nl/display/main/2015/06/17/20150617_UniversityHouston)

2. CARIS HIPS and SIPS 활용 해저 지형 조사 및 해저면 특성 분석 수행

CARIS HIPS and SIPS 프로그램은 대표적인 상용 멀티빔 자료 처리 소프트웨어로 2016년

현재 verison 9.1까지 출시되어 있으나, 본 위탁 연구에서는 극지연구소가 구매하여 사용권을

가지고 있는 version 7.0을 활용하여 연구를 수행하였다. 본 소프트웨어 활용은 자체적인 도움

말 기능을 통해 가능하지만, Caris사에서 제공하는 HIPS and SIPS 7.0 User’s Guide(Caris,

2009)를 통해 체계적인 기능과 활용법을 숙지할 수 있다. 이 사용자 설명서 (User’s Guide)는

부록에 차례를 소개하여 주요 내용을 파악할 수 있도록 조치하였다.

동해에서 수행된 시험 항해 자료 일부와 남극 로스해에서 획득된 자료 그리고 북극 척치해

에서 획득된 자료들이 CARIS HIPS and SIPS 프로그램을 통해 처리되어 해저 지형도

(bathymetry map)로 작성되었으며, 이 때, 잡음 제거 및 처리 방식별 해저 지형 차이에 대한

고찰이 수행되었다. 또한 Geocoder 도구를 통해 해저면 퇴적물 특성 규명이 수행되었으나 실

측된 퇴적물을 통한 확인이 수반되지 않아 절대적인 퇴적물 분류로는 한계가 있다고 판단된다.
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그림 12는 CARIS HIPS and SIPS 사용자 설명서에 제시된 멀티빔 자료의 처리를 통한 해

저 지형 조사의 일반적인 흐름도를 보여주고 있다. 한편 상술한 바와 같이 본 위탁 연구에서는

해저 지형 조사를 위한 아래의 일반적 자료 처리 업무 흐름 이외에 후방 산란 신호의 강도를

통한 퇴적물 분석이 Geocoder 도구를 통해 수행되었다.

그림 12. CARIS HIPS and SIPS 해저 지형 도출 업무 처리 흐름도

획득된 멀티빔 원시 자료는 위의 흐름도에서 알 수 있듯이 조사선 특성 파일 (Vessel File)

을 이용하여 기본적인 멀티빔 장착 상태를 파악하게 된다. 이후, 기록에 사용된 측지 좌표계

정보, 멀티빔 자료 획득 장치와 기록 방식 등이 제공된 후, CARIS HIPS and SIPS에서 활용

하는 파일 형식으로 전환된다. 보통 용량이 큰 자료의 경우, 이 전환 과정은 많은 시간이 소요

되므로 높은 사양의 서버급 컴퓨터가 필수적이다. 또한 자료 전환이 이루어지면 대부분 원시

자료 이외의 추가적인 별도 파일이 생성되므로 대용량 별도 저장 장치가 준비되지 않으면 자

료 처리를 진행하는 것이 곤란해 질 수 있다.

CARIS HIPS and SIPS 7.0는 자료 전환이 정상적으로 수행되면, 멀티빔 자료가 획득된 조

사 측선을 도시 할 수 있다. 조사 측선의 도시는 가장 기본적이고 향후 특정 위치 선택, 특정
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구간에 대한 자료 처리 등에 필수적인 사항이다. 보통 조사 측선이 그림으로 표현되는 부분을

CARIS HIPS and SIPS 7.0에서는 Display window라고 명명하며, 이들 조사 측선들에 대한

일련의 구조와 내부적인 정보는 다양한 window에서 확인할 수 있도록 구성되어 있다(그림 13

참조). 그림 14는 실제 2013년 2월 남극 로스해에서 수행된 멀티빔 조사 측선을 CARIS HIPS

and SIPS 7.0를 이용하여 도시한 결과이다.

그림 13. CARIS HIPS and SIPS 7.0 기본 창 구조 사례

그림 14. CARIS HIPS and SIPS 7.0 이용 남극 로스해 조사 측선 도시 사례 (전체 화면)
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(가) 멀티빔 신호 기본 처리 및 해저 지형 도출

원시 자료에서 전환된 멀티빔 자료는 일차적으로 3차원적인 좌표에 대한 보정과 위치 오차

보정이 수반되며, 그 처리 과정은 다음과 같이 정리된다. 조사선은 해수면에서 유수의 움직임

에 의해 특정 기준점 (Reference Point)을 중심으로 3차원 회전체 운동을 한다. 이러한 운동은

제 1 장 서론부 그림 2에 설명되어 있다. 선체에 부착된 모션센서의 기준좌표계 (x, y, z)를 중

심으로 x축을 기준으로 한 회전을 롤 (Roll), y축을 기준으로 한 회전을 피치 (Pitch), z축을 기

준으로 한 회전을 헤딩 (Heading)이라 한다.

조사선의 거동과 연관된 회전은 Euler각도 ω, ψ로 정의하며 변환행렬로 표현된다. 각도 ω는

x축을 중심으로 회전하는 롤을 의미하며 우현이 내려가는 방향을 양으로 정한다. 각도 ψ는 y

축을 중심으로 한 회전인 피치를 의미하고 선수가 올라가는 방향을 양으로 정한다. z축을 기준

으로 한 회 선수방향의 회전을 헤딩이라 정의하며 시계방향을 양으로 정한다. 거리기준점은 선

박의 무게중심점 (선박거동의 중심)으로 결정하며, 이 기준점이 위치 및 수심정보에 대한 기준

점이 된다.

멀티빔 자료 파일에는 탐사선의 위치에 대한 정보가 저장되어 있다. 이는 보통 WGS84 체

계의 경위도좌표 값으로 GPS 위성 항법 자료이다. 이 자료를 검토해 보면, 위치 정보가 연속

된 위치 자료가 아닌 비상식적으로 벗어나 있는 다른 위치에 표시되는 경우가 간혹 발생된다.

이러한 원인은 GPS 수신 장치의 교란 혹은 불량이나 전파 간섭 등에 의해 일어날 수 있다.

잘못된 탐사선의 위치정보는 수신된 빔의 위치 결정에도 동일하게 잘못된 정보로 나타나며, 이

러한 결과는 해저 지형에 오차를 발생시킨다. 따라서 이러한 탐사선 위치 오차는 반드시 제거

되어야 한다. 보통 CARIS사의 HIPS & SIPS 7.0 소프트웨어의 경우에는 Navigation editor을

사용하여 조사선의 조사 측선 위치 등을 검토와 보정이 가능하다. 참조로 MB-System의 경우

조사 측선 위치의 검토와 보정은 mbnavedit와 mbnavadjust로 가능하다.

멀티빔 자료를 통해 해저 심도를 알아내기 위해서 필요한 주요 정보는 수중의 음파 전달

속도에 대한 정보가 요구된다. 실제 멀티빔 자료에 기록되는 값은 신호의 강도와 주시 시간이

으로 실제 수심을 알아내기 위해서는 수중 음파 전달 속도가 필수적이다. 그러나, 해양의 수중

음파 전달 속도는 실제로 수심별, 위치별로 변화하므로 이에 대한 정보와 이를 통한 음속/심도

보정이 필요하다. 보통 수중의 음파 전달 속도를 결정해 주는 값으로 일반적으로 해수의 수피

변동 즉 수온, 수심 및 염분의 변동은 음파의 전달속도와 밀접한 관계를 보인다.

해양에서 음파 전달 속도는 항상 일정 하지 않으므로 그 음향의 파선 또한 똑바로 진행하

지 않고 매체 (바닷물)의 속도 분포에 따라 완만히 굴절된다. 그 기본적인 관련성은 음속도가

다른 층들 사이의 굴절 각도와 관련이 있고 이러한 굴절 각도는 잘 알려진 스넬의 법칙
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(Snell’s Law)에 따른다. CARIS HIPS & SIPS 7.0 소프트웨어의 경우, 실측된 SVP 자료를 활

용하거나, 다중빔 음향 측심 탐사를 하며 동시에 예측된 SVP (Sound Velocity Profile) 자료를

이용하여 심도를 결정한다. 또한 필요한 경우, SVP editor를 이용하여 해수층의 속도 보정이

가능하다. 확보된 SVP 자료를 통해 심도/속도 보정을 수행하였다

다음 그림 15는 CARIS HIPS and SIPS를 사용하여 2012년 6월에 동해에서 수행된 시험 항

해시 얻어진 자료에 대한 기본적인 보정 작업 (변경 혹은 삭제)과 편집 작업을 수행하고 있는

사례를 보여준다.

선회구간의 데이터

수신불량 제거 & filtering
Swath 기반 오류수정 Subset 기반 오류수정

그림 15. CARIS HIPS and SIPS를 활용한 멀티빔 오류 수정 작업 사례

CARIS HIPS and SIPS 7.0 소프트웨어를 사용하여 멀티빔 신호에 대한 조석 보정 전후 신

호를 비교 그림은 그림 16과 그림 17에 주어져 있으며, 조석 효과가 크지 않은 지역으로 신호

에 현저한 변화가 관찰되지는 않지만, 조석 효과 보정 후 신호의 정렬 상태가 다소 좋아진 것

으로 볼 수 있다.

마찬가지고 서브셋 (특정 부위)보정 (삭제, cleaning) 작업 사례는 그림 18에 주어져 있으며,

삭제 보정된 신호는 회색으로 표시되어 있다.

그림 19은, 2013년 2월 남극 로스해에서 수행된 멀티빔 조사에 대한 해저 심도 도시 처리를

기본적인 처리 과정만 적용하여 얻어진 결과 사례를 보여준다. 붉은 색 계통은 상대적으로 낮

은 수심을, 푸른색 계통은 상대적으로 깊은 수심을 지시한다. 그림 19는, 그림 14의 CARIS

HIPS and SIPS 기본 상태에서 해저면 도출 처리가 수행된 결과이며, 이러한 해저면 도출을

위한 일련의 과정은 SWATH editor, CUBE editor 등을 통해 이상 신호들을 제거, 보완하는

과정을 거치는 것이 일반적이다.
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그림 16. 조석 보정 이전 멀티빔 신호 분포 (남극 로스해 2013년 3월 자료)

그림 17. 조석 보정 이후 멀티빔 신호 분포 (남극 로스해 2013년 3월 자료)
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그림 18. 서브셋 보정 (삭제) 처리 신호 (남극 로스해 멀티빔 자료)

그림 19. 남극 2013년 Ross Sea 트랙 라인에 대한 개략 심도 분포도

다음 그림 20은 CARIS HIPS & SIPS 7.0 소프트웨어를 사용하여 후방 산란 신호 분석 작

업을 수행하고 있는 사례를 보여준다. 활용된 자료는 2013년 2월 로스해에서 획득된 자료이며,

반사 신호의 강도를 음영으로 모자이크 방식 처리하여 표시한 사례이다. 반사 신호 강도는 기

본적으로 해저면 퇴적물 평가에 활용될 수 있으며, 이에 대한 사항은 후술할 “(나) 멀티빔 반
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사 신호를 이용한 해저면 특성 분석”의 Geocoder를 이용한 해저면 평가 관련 부분에 기술되어

있다.

그림 20. 남극 로스해 멀티빔 자료 CARIS 활용 후방 산란 신호 처리 편집 작업 사례

획득된 멀티빔 자료에 대한 신호 보정은 해저면 지형을 보다 정밀하게 추출하는데 도움을

주게 된다. CARIS HIPS and SIPS에서는 보통 SWATH Editor를 이용해, 조사 측선별 신호를

컴퓨터와 대화식 수작업으로 검토/수정 하거나 이미 프로그램에서 기본 값으로 주어진 몇 몇

변수 조건에 맞지 않는 신호들을 제거하는 방식으로 해저 심도 분포를 산정한다. 보통 이러한

수작업에 의한 자료 조정은 동일 지점을 지난 측선에서의 심도 값 편차를 최소화하는 방식으

로 많이 진행되며, 본 위탁연구에서는 이러한 방식의 보정을 SWATH 방식 보정으로 칭해 사

용하였다. 또한 특별한 자료 정보가 없는 경우에는 대부분 프로그램에서 제공하는 기본 값을

활용하여 이상 신호를 제거한 후 해저 지형을 작성하였다.

그림 21과 22는 2012년 1월 로스해 장보고 기지 인접 지역에서 획득된 자료를 SWATH

editor를 통해 처리하기 전, 후 신호 분포를 보여준다. 측면 신호와 전후 신호에서 주변과 차이

를 보이던 이상 신호 부분이 정상적으로 제거된 형태를 볼 수 있다.
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그림 21. SWATH editor 신호 처리전 (로스해 2012년 1월 자료)

그림 22. SWATH editor 신호 처리후 (로스해 2012년 1월 자료)

그림 23은, 2012년 8월 북극 척치해/보버트해 멀티빔 자료 중 일부로, SWATH editor를 통

해 이상 신호를 설정, 제거된 형태를 보여주고 있다. 선택되어 제거될 신호는 측면과 전후 신

호 자료 창에 회색으로 보여지고 있다. 2012년 8월부터 9월에 북극 척치해에서 조사된 멀티빔

측선의 개황도는 그림 24에 주어져 있으며, 실제 위치도는 다음 절 MB-system을 활용한 자료

처리 부분에서 별도로 상세하게 제시되어 있다.
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그림 23. SWATH editor 이상 신호(side, rear 창 회색선) 선별 (2012년 북극 척치해)

그림 24. 2012.08.03～09.05 아라온 북극 척치해/보퍼트해 조사 측선 전체 개황도

이러한 SWATH editor를 이용한 수작업 방식과 대조적으로 CARIS HIPS and SIPS는

CUBE 방식으로 불리는 일종의 통계적 신호 처리 방식에 의해 자료를 처리하는 도구를 제공

하고 있다. 여기서 CUBE는 Combined Uncertainty and Bathymetry Estimator의 영어 첫글자

를 이용한 약어로 Calder의 의해 2003년에 개발된 기술로 알려져 있다(Calder, 2003). 영어에서

알 수 있듯이 CUBE 방식에 의한 멀티빔 보정은 통계적으로 불확실성을 최소화하면서 처리자
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의 주관적 판단을 배제하면서 이상 신호를 제거할 수 있다. 그러나 실제로 CARIS HIPS and

SIPS의 CUBE editor를 통해 해저면 지형을 도출할 때, 사용자는 기본적으로 중요한 몇 가지

요소들을 결정하여야 한다. 이 중 대표적인 요소는 격자 해상도 (grid resoltion; GR), 추정 이

격 거리 (estimate offset; EO), 모호성 제거 방법 (disambiguation method) 등으로 상세한 요

소들에 대한 정보는 사용 설명서를 참조할 수 있다. 이러한 요소의 결정은 일반 사용자들이 쉽

게 결정하기 어렵고, 요소에 따라 최종 해저면 지형의 변화도 다양하므로 보통은 프로그램이

제공하는 기본 값을 사용하게 된다. 본 위탁 연구에서도 기본적으로 특별한 언급이 없는 한

CUBE editor가 제공하는 기본 값들을 요소 값으로 사용하였다.

동해 시험 항해 자료, 남극 장보고 인접 로스해 자료, 남극 로스해 자료 및 북극 척치해/보

버트해 자료의 해저면 지형 정보는 위에 언급한 자료 신호 처리 과정을 통해 작성되었으며, 이

결과는 제 3 절 연구 결과에 제공된다.
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(나) 멀티빔 반사 신호를 이용한 해저면 특성 분석

송신기에 의해 발생된 음파는 해수층을 지나 해저면에서 반사되며 다시 해수층을 지나 궁

극적으로 수신기에 기록된다. 수신기에 기록되는 값은 기본적으로 도달시간과 음압이며, 기록

된 음압의 강도는 해저면에 대한 정보를 반영하게 된다. 보통 멀티빔 시스템에서는 해저면에서

반사되어 수신기에 기록되는 신호를 후방 산란 신호라고 하며, 멀티빔의 특성상 송신기와 수신

기의 위치가 거의 동일하므로 반사법칙에 의해 반사된 신호는 대부분 수신기에 도달하지 못하

고 수신기에 도착하는 신호는 상대적으로 미약한 산란 신호 (일부 해저면에 거의 수직으로 도

달하는 신호들은 예외임) 들이기 때문이다.

CARIS HIPS and SIPS 프로그램은 후방 산란 신호 처리를 위해 그림 25와 같이 우선적으

로 해저 지형 (Bathymetry) 처리가 수행된 후, 후방 산란 신호 처리를 통해 입사 각도에 따른

해저면의 퇴적물을 분석이나 후방 산란 반사 신호의 강도를 이용한 모자이크 음영도를 작성하

게 된다.

그림 25. CARIS HIPS and SIPS 후방 산란 신호 처리 흐름

(MacDonald and Collins, 2008)

CARIS HIPS and SIPS 프로그램은 입사 각도에 따른 후방 산란 신호 강도의 변화를 분석

하기 위해 Geocoder라는 도구를 제공하며, 이 결과는 GeoBaR (Geo-referenced, Backscatter

Raster)라고 불리는 파일로 저장된다. 그림 26은, 다른 연구에서 수행된 이 처리 과정을, 예제

분석 자료와 함께 보여주고 있다.
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그림 26. CARIS 후방 산란 신호를 통한 해저면 분석 사례

(MacDonald and Collins, 2008)

해저면 퇴적물의 다양한 음향 반사 특성이 입사각에 따른 후방 산란 신호 강도를 결정하

며, 대표적인 음향 반사 특성으로는 해저면 퇴적물의 밀도, P파 속도, 반사 체적, 음파 중심 주

파수 등으로 알려져 있다(Artilheiro, 1998). 또한 이러한 입사각에 따른 반산 강도 변화는

Lambert 법칙과 몇 몇 대표적인 모델을 이용하여 추정할 수 있다. 그림 27은 Jackson 모델을

이용하여 퇴적물의 종류에 따른 후방 산란 신호 강도 변화의 변화 사례를 보여준다.

그림 27. 입사각도에 따른 해저면 (퇴적물) 후방 산란 반사 강도 변화 사례

(95kHz, Jackson 모델 활용; Artilheiro, 1998)

CARIS HIPS and SIPS를 활용하여, 본 위탁과제에서는 동해 시험 항해 멀티빔 자료, 남극

로스해 자료 및 북극 척치해 자료의 입사각에 따른 후방 산란 반사 강도 변화를 통해 퇴적물

의 특성을 분석하였다. 이 과정은 전술한 바와 같이 우선 해저 지형 분석 이후 수행되었으며,
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기본적으로 Mosaic Editor 내의 Geocoder 도구를 활용하였다. 한편 본 위탁과제는 멀티빔 자

료에 한정하여 해저면 특성을 분석하였으나, CARIS HIPS and SIPS에는 멀티빔 자료와 함께

측면 주사 음향 조사 장비 (side scan sonar)와 함께 이 분석 도구를 활용할 수 있으며, 이 경

우 보다 신뢰성 있는 해저면 특성 분석이 가능하다.

그림 28은 동해 시험 항해에서 획득된 자료 중 Geocoder 도구를 통해 자갈층(좌현)과 중립

질 모래 내지 자갈 섞인 점토(우현) 평가된 구간의 자료를 보여주고 있으며, 그림 29는 같은

항해에서 점토질 모래 (좌현)과 모래질 실트로 예비 평가된 사례를 보여준다. 자료에서 볼 수

있듯이 해석자의 최종 판단에 도움을 주기 위해 신뢰 정도도 함께 명기되는데, 그림 29로 주어

진 사례의 자료의 경우, 신뢰성이 높지 않아, 단정할 수 없음 (inconclusive) 주석이 제공되었음

을 확인 할 수 있다.

그림 28. 동해 시범 항해 CARIS HIPS and SIPS geocoder 활용 퇴적물 평가 사례 1

그림 29. 동해 시범 항해 CARIS HIPS and SIPS geocoder 활용 퇴적물 평가 사례 2



30

그림 30과 그림 31은 각각 2012년 8월 수행된 북극 척치해 지역에서의 해저면 퇴적물 특성

분석 사례와 2013년 2월 남극 로스해 지역에서의 해저면 특성 분석 사례를 보여주고 있다. 그

림 30은 기본적으로 조사 측선 도시 배경에서의 분석을, 그림 31은 후방 산란 신호 모자이크

처리 배경에서의 분석을 보여주고 있으며, 그림 31의 경우 해당 부분을 확대할 경우, 유사한

신호 강도를 보이는 영역을 추정하는데 도움이 된다.

그림 30. 퇴적물 추정 분류를 통한 해저면 특성 분석 사례 (2012년 북극 척치해 획득 자료)

그림 31. 모자이크 및 퇴적물 추정 분류를 통한 해저면 특성 분석 사례 (2013년 남극 로스해 획득 자료)
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3. MB-System 활용 해저 지형 조사 및 해저면 특성 분석 수행

MB-System은 멀티빔(multibeam), 간섭파동(interferometry) 및 사이드 스캔 소나(side

scan sonar)로 얻어진 해저 지형(bathymetry)와 후방 산란신호(backscattered) 영상 자료를

처리하는 유닉스 환경에서 구동되는 공개용 소프트웨어 패키지(open source software

packgage) 프로그램이다. 1993년부터 개발이 시작된 MB-system은 2016년 2월 현재

MB-system 5.5 (2016년 1월 7일 공개 버전)으로 지도 작성 도구인 GMT 5.2.1 version을 포함

하고 있다.

MB-System은 기본적으로 명령줄 입력 방식 (command line interface; CLI)으로, 기존의

GUI (graphic user interface) 방식 상업용 프로그램들에 비해 처음 접할 때 다소 불편한 점이

있지만, 어느 정도 익숙해지면, Unix 쉘 스크립트 작성이나 배치 작업 등을 통해 편하게 큰 용

량의 자료도 처리 가능하다는 장점을 갖는다.

MB-System 5.5는 총 54개의 명령 프로그램, 3개의 GMT 관련 처리 명령 및 24개의 매크

로 명령으로 구성되어 있으며 (부록 MB-System Program List 참조) 기본적으로 모든 프로그

램은 소스 (source)가 공개되어 있어 필요에 따라 수정하여 활용할 수 있다. MB-System은 멀

티빔 장비의 제조사에 따라 다른 형식으로 획득되는 원시자료들을 적절하게 변환하여 처리할

수 있다는 장점을 갖는다. MB-System 매뉴얼에 따르면 현재 이 소프트웨어로 처리 가능한

멀티빔의 종류는 아래와 같다. 기타 상세한 내용을 확인하기 위해서는 명령줄에서 “man mbio”

를 입력하여 확인할 수 있다.

- SeaBeam "classic" 16 beam multibeam sonar

- Hydrosweep DS 59 beam multibeam sonar

- Hydrosweep MD 40 beam mid-depth multibeam sonar

- SeaBeam 2000 multibeam sonar

- SeaBeam 2112, 2120, and 2130 multibeam sonars

- Simrad EM12, EM121, EM950, and EM1000 multibeam sonars

- Simrad EM120(122), EM300, EM1002, and EM3000 multibeam sonars

- Hawaii MR-1 shallow tow interferometric sonar

- ELAC Bottomchart 1180 and 1050 multibeam sonars

- ELAC/SeaBeam Bottomchart Mk2 1180 and 1050 multibeam sonars

- Reson Seabat 9001/9002 multibeam sonars

- Reson Seabat 8101 multibeam sonars

- Simrad/Mesotech SM2000 multibeam sonars

- WHOI DSL AMS-120 deep tow interferometric sonar
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- AMS-60 interferometric sonar

현재 아라온에 장착된 멀티빔은 Kongsberg사의 EM-122 시스템으로 MB-System이 활용

하는 입출력 형식 (MBIO) 구분에 의하면 58번 및 59번에 해당된다. 59번은 일종의 58번 확장

형으로 sidescan 값의 저장과 beam flags (특정 빔에 의미 부여용, 보통은 문제 등이 있어 삭

제 처리 등을 하기 위한 표식) 저장이 가능한 형태에 해당된다. 특히 대표적인 멀티빔 제조사

인 Kongsberg사의 소위 제3세대 멀티빔 시스템에 해당되는 EM122, EM302, EM710, EM2040

및 M3 획득 자료는 별도의 파일 전환 전처리 명령인 mbkongsbergpreprocess를 활용하여

mbcopy 혹은 mbm_multicopy 및 mbdatalist 등의 일련 명령 작업을 대신할 수 있다. 또한 상

기한 시스템 획득 자료에 대해서는 기본적인 파일 정보제공 보조 파일인 확장자 inf 파일 (file

statics), 개략 심도 정보 제공 파일인 확장자 fbt 파일 (fast bathymetry), 개략 항로 정보 파일

인 확장자 fnv 파일(fast navigation) 이외에 위치 보정 등에 활용할 수 있는 보조 파일인 ata

확장자 파일 (asynchronous attitude (roll and pitch)), ath 확장자 파일 (asynchronous

heading), ats(asynchronous sonar depth) 확장자 파일 및 sta 확장자 파일(synchronous

attitude (roll and pitch))을 한 번의 명령 처리를 통해 제공되어 전처리 과정을 용이하게 수행

할 수 있게 되었다.

MB-system의 MBIO 형식에 맞게 원시 자료가 전환되면 우선 특별한 자료 처리가 되어 있

지 않은 상태에서 항해 측선, 해저 지형 및 후방 산란 반사 강도 등을 점검 할 수 있다. 이러

한 점검은 명령문에서 몇 종류의 명령을 통해 직접 신호 수치를 확인하는 방법과 흑백 음영,

혹은 칼라 매핑 등의 그림으로 표현하여 확인하는 방식이 가능하다. 직접 신호 수치를 확인하

기 위한 명령은, mbinfo, mblist, mbdatalist 등이 있다.

2012년 동해에서 수행된 시험 항해를 통해 얻어진 멀티빔 자료의 내용을 전체적으로 확인

하기 위해서는 변환된 파일을 리스트로 만든 후, 그 리스트에 명기된 파일들의 값들을 검토하

여 전체적인 내용을 확인하는 방식이다. 만약 멀티빔 파일들 (MBIO 형식으로 변환되어 확장

자가 *.mb59인 파일들) 목록이 Donghae.lst에 보관된 경우, 다음과 같은 명령을 통해 기본 정

보를 확인가능하다.

$ mbinfo –F-1 –I Donghae.lst –O

위의 명령이 수행되면 Donghae.lst.inf라는 파일이 생성되며, 이 파일에서는 리스트 파일에

기록되어있는 99개의 원시자료 파일에 대한 파일 형식 등을 보여주고 전체 자료에 대해서 통

합적으로 아래와 같은 기초정보를 제공하여 준다.

----------------------------------------------------------------------

Data Totals:
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Number of Records: 35096
Bathymetry Data (432 beams):
Number of Beams: 15161472
Number of Good Beams: 13528444 89.23%
Number of Zero Beams: 0 0.00%
Number of Flagged Beams: 1633028 10.77%
Amplitude Data (432 beams):
Number of Beams: 15161472
Number of Good Beams: 13528444 89.23%
Number of Zero Beams: 0 0.00%
Number of Flagged Beams: 1633028 10.77%
Sidescan Data (1024 pixels):
Number of Pixels: 35938304
Number of Good Pixels: 32109772 89.35%
Number of Zero Pixels: 0 0.00%
Number of Flagged Pixels: 3828532 10.65%

Navigation Totals:
Total Time: 68.7570 hours
Total Track Length: 1063663.9494 km
Average Speed: 15469.8996 km/hr (8362.1079 knots)

Start of Data:
Time: 06 11 2012 11:43:54.471000 JD163
Lon: 0.0000 Lat: 0.0000 Depth: 736.4567 meters
Speed: 0.0000 km/hr ( 0.0000 knots) Heading: 62.8500 degrees
Sonar Depth: 5.8728 m Sonar Altitude: 721.0340 m

End of Data:
Time: 06 14 2012 08:29:19.685000 JD166
Lon: 130.0501 Lat: 36.0511 Depth: 1389.8182 meters
Speed: 4.4280 km/hr ( 2.3935 knots) Heading: 180.9000 degrees
Sonar Depth: 5.9495 m Sonar Altitude: 1382.7908 m

Limits:
Minimum Longitude: -0.0321 Maximum Longitude: 130.4345
Minimum Latitude: -0.0308 Maximum Latitude: 37.0307
Minimum Sonar Depth: 4.5237 Maximum Sonar Depth: 6.9999
Minimum Altitude: 64.4290 Maximum Altitude: 2156.7036
Minimum Depth: 67.1276 Maximum Depth: 2408.8057
Minimum Amplitude: -62.4000 Maximum Amplitude: 3.1000
Minimum Sidescan: -99.2000 Maximum Sidescan: 3.1000
----------------------------------------------------------------------

마찬가지로 mblist 혹은 mbdatalist 등의 명령도 다양한 옵션에 따라 사용자가 원하는 멀티

빔 자료의 정보를 확인할 수 있게 하여 준다. 그러나 이러한 값으로 자료를 확인하는 방식 보

다 일반적으로는 항해 측선, 해저 지형 등의 정보를 그림으로 표현하는 것이 더욱 편하고 빠르

게 정보를 확인하는 방식이다.

다음 그림 32는 동해 시험 항해 멀티빔 자료에 대한 전체 조사 측선과 심도 분포를 보여주

는 사례이며, 그림 33은 이중 첫 번째 측선만 별도로 도시한 것이다. 또한 MB-System은 후방

산란 신호의 강도를 송신 음파의 음압에 대한 비율로 보여 줄 수 있으며, 그림 34는 그 사례를

보여주고 있다.
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그림 32. MB-System을 이용한 2012년 동해 시험 항해 조사 측선도 및 심도 분포 사례

그림 33. MB-System을 이용한 2012년 동해 시범 항해 1번 측선 및 해저 심도



35

그림 34. MB-System을 활용한 후방 산란 신호 강도 표시 사례

많은 경우 획득된 멀티빔 자료는 다양한 원인으로 인해 해저 심도 추정과 해저면 반사 특

성을 평가하는데 방해가 되는 오류 신호를 포함하게 된다. 이러한 오류는 주로 항해하는 배의

흔들림, 조석 변화, 부정확한 위치 정보와 해수층 속도 정보 등이 원인이다. 이러한 오류 자료

들은 수동으로 보정이 가능하며, MB-System은 명령 방식 보정의 한계를 극복하기 위하여

GUI(Graphic user interface) 형태의 몇몇 수동 보정 기능을 제공한다.

수동보정 기능들은 datalist 파일을 사용하여 먼저 순차적으로 불리워질 목록을 활용하기도

하지만 기본적으로는 각각의 .mb59 자료 파일을 이용하며, 자료 처리 과정에서 만들어지는 부

속 파일들을 이용하여 처리된다. 또한 수동 조정을 통해 별도의 부속 파일을 생성하여

mbclean 이나 mbprocess와 같은 명령 시행 시 수정 편집 정보를 가지고 있는 부속 파일들이

활용되기도 한다.

MB-System에서 제공하는 GUI 형태의 수동 보정 기능은 다음과 같다.

mbedit: 측심자료의 불량 자료에 수정/표기 철

mbnavedit : 측심자료 중 불량 항로자료에 수정/표기 처리

mbvelocitytool : SSP (Sound speed profile) 수정/보정 처리
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만약 현장조사 시 rolling과 pitching을 보정하기 위한 별도의 항해를 수행하고 데이터를 수

집한 경우 mbeidt, mbprocess와 같은 팩키지를 이용하여 이러한 값들의 보정을 가능하게 한

다. 그러나 아라온호에 장착된 EM122 시스템의 경우 모션 센서에 의해 이러한 값들이 자동으

로 보정되어 원시 자료에 반영되므로 별도의 보정작업을 필요로 하지 않는다.

MB-System은 또한 mblevitus, mbvelocitytool과 같은 팩키지를 통해 SSP (Sound Speed

Profile)의 보정을 가능하게 한다. 아라온호 동해안 시험 항해 시에는 휴대용 SVP (Sound

Velocity Profile)를 이용하여 측정 후 EM122시스템을 보정하였고 획득한 원시자료는 이미 보

정된 값이므로 별도의 보정 작업을 필요로 하지는 않았는다.

그림 35와 그림 36은 동해 시범 자료와 북극 척치해 자료를 mbedit를 통해 수동으로 점검

하고 편집하는 방식을 보여준다. 또한 mbedit는 멀티빔 신호 정보를 측면, 평면 등 다양한 양

식으로 표현할 수 있어 오류 신호를 손 쉽게 선별할 수 있다(그림 37 참조).

그림 35. mbedit를 이용한 멀티빔 편집 (2012년 동해 시험 항해 자료) 사례
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그림 36. mbedit를 이용한 멀티빔 편집 (2012년 북극 척치해) 및 플롯 정보 선택

그림 37. 멀티빔 신호 평면 플롯을 통한 mbedit 자료 편집 사례

그림 38은 mbvelocitytool 프로그램을 통해서 해수층 속도 분포를 추정 평가하고 정확한 해

저 심도 단면을 작성하는 사례를 보여준다. 이 프로그램은 직접 해수층의 음파 속도 곡선을 수
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동으로 조정하면서 해저면에서 반사되는 빔에 의한 심도 잔차를 조정해 나갈 수 있다.

그림 38. mbvelocitytool 활용 SVP 추정 및 해저면 잔차 보정 사례 (2012년 북극 척치해 자료)

MB-System은 mbeditviz 명령을 통해 3차원적인 멀티빔 신호에 대한 편집과 보정과 더불

어 전체적인 해저면 형상 검토를 가능하게 해주는 기능을 제공한다. 그러나 이 명령은 전산기

의 사양이 충분하지 않은 경우, 매우 느리게 작동되거나 간혹 작업이 갑자기 정지하는 등 다소

불안정하게 작동하는 문제가 있어 매우 고성능 전산기으로 작업할 것을 권장한다. 그림 40은

북극 척치해 집중 조사 구간 B (그림 39 참조) 일부를 보여준다.

그림 39. 2012년 8월 및 9월 북극 척치해 멀티빔 조사 측선
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그림 40. mbeditviz 활용 북극 척치해 site B 일부 지역 멀티빔 자료 검토/편집 사례

그림 41은 2012년 장보고 인접 로스해에서 획득된 자료 mbeditviz의 경사도 분석 결과와

함께 3차원으로 도시한 후, profile view 기능을 통해서 심하게 왜곡된 해저 지형 정보를 찾고

수정하는 과정을 보여준다. 이러한 3차원 자료 확인과 편집 기능을 통해 MB-System은 편리

하게 수동으로 잡음을 제거할 수 있는 기능을 제공한다.
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그림 41. 3차원 경사 분포 및 해저면 측선 보기 (profile display)을 통한 잡음 제거

MB-System은 전술한 다양한 수동 기능을 통해 잡음 신호를 표시하고 제거하는 방식과 더

불어 특정 조건을 mbclean 명령에 함께 제공하는 방식으로 자동적인 자료 보정과 잡음 신호를

제거하는 기능을 가지고 있다. mbclean 명령은 우선 조건에 적합하지 않은 멀티빔 신호를 선

별해내는 과정으로 다음과 같은 명령 형식(옵션은 값은 단순 사례로 변경 가능)을 갖는다.

$ mbclean -F-1 -I araonem122 -M2 -C3.0 -D0.01/0.20 -G0.70/1.30 -V

M: 과도한 경사를 가진 빔에 대해 표기

C: 최대 허용 가능 경사 (단위: tangents)

D: 빔사이의 거리에 대한 최대 최소 허용 기준, 평균심도에 대한 배율, meter

G: 심도값에 대한 최대 최소 허용 기준, 평균심도에 대한 배율, meter

V: 처리과정을 화면에 표시

위에서 예로 제시한 mbclean은 –M2 –C3.0 옵션에 따라 약 70도 이상의 빔에 대해서,

-D0.01/0.20 옵션에 따라서 평균심도가 1,000 m인 경우 빔 사이의 거리가 10에서 200 m를 벗어

나는 경우, -G0.70/1.30 옵션에 따라서 평균심도가 1,000 m인 경우 심도 값이 700 에서 1,300 m
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를 벗어나는 경우에는 표식(mark)가 되어 진다. 명령이 수행되면 전체 멀티빔 자료가 점검되

고, 이 중 몇 개의 자료가 주어진 조건을 만족하지 못해 표식 되었는지 알려준다. 또한 폴더안

의 모든 .mb59 파일들에 대하여 각각 .esf .esf.stream .par 파일이 생성되어 표식 정보를 이 후

처리과정에 제공하게 된다. 이 때, .esf .esf.stream 파일에는 표기된 빔이 이벤트 형식으로 기

록되고 .par 파일에는 변화된 파라미터에 대한 정보가 기록된다.

MB-System의 자동 및 수동 기능을 이용하여 불량 및 오류 데이터에 표기를 하였고, 이러

한 표기된 자료들은 여러 종류의 부가파일에 표식 정보가 저장 되어 있을 뿐 실제 측심 자료

에 보정 값이 반영되는 것은 아니다. 모든 자동 및 수동 표식은 mbprocess를 이용하여 실제

측심자료에 반영된다. 다음은 mbprocess 명령을 통해 멀티빔 자료 보정이 되는 과정을 설명한

다.

$ mbprocess -F-1 -I araonem122

mbprocess의 실행결과로 폴더 안의 모든 .mb59 원시자료 파일의 이름 마지막에 processed

의 'p'가 첨부된 파일들이 새로이 생성되며, 이후 보정된 측심 자료를 얻기 위해서는 이 파일

이 사용되어야 한다. 이 후 처리된 자료의 도시 방법은 앞에서 설명한 mbplot 사용 방식과 동

일하다.

(처리 전후 파일명 예시)

0001_20120611_114430_ShipName.mb59 --> 0001_20120611_114430_ShipNamep.mb59

그림 42와 그림 43은 2012년 북극 척치해/보버트해 Site A의 멀티빔 자료의 보정 처리 전

후를 비교하여 보여준다. 결과 그림에서 알 수 있듯이 보정 전후의 큰 차이는 나타나지 않고

일부 구간, 특히 북동부 경사면 지역에서 미세한 차이를 보일 뿐이다. 이는 항해 시 아라온호

에 장착된 EM-122 멀티빔 시스템에서 1차적으로 navigation, heading, rolling, pitching 등에

대한 오차를 최대한 줄일 수 있도록 설치 및 작동되고 있기 때문이며 또한 조사 기간 동안 크

게 데이터를 보정해야할 만한 이벤트가 없었기 때문으로 생각된다. 실제 매우 정밀한 심도 분

포를 확인하기 위해서는 별도의 해수층 속도 정보 (SVP) 확보와 더불어 개별 자료들에 대한

수동 점검과 속도 추정 작업이 면밀하게 수행되면 보다 현저한 보정 효과를 기대할 수 있을

것으로 생각된다.
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그림 42. 북극 척치해 Site A 지역 멀티빔 신호 보정전 해저 심도 분포

그림 43. 북극 척치해 Site A 지역 멀티빔 신호 보정후 해저 심도 분포
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양극해 환경 특성을 이해하기 위하여 양극해에서 획득된 멀티 빔 자료를 처리하고 이를

통해 해저 지형과 해저면 퇴적물 특성을 분석하기 위한 방법이 연구 개발되었다. 자료 처리와

해저 지형 및 해저면 퇴적물 특성 도출을 위해 상업용 프로그램과 공개용 프로그램이 동시에

적용되어 각 각의 기능과 편의성 최종 결과 도출을 위한 일련의 과정이 검토되고 제시되었다.

기본적으로 멀티빔 신호의 특성을 분석하여 다양한 잡음 요소를 제거하기 위한 자료 처리

가 수행되었으며, 최종적으로 이를 통해 남극 로스해와 북극 척치해에서 획득된 멀티빔 자료를

처리하여 조사 지역에 대한 해저 지형이 작성되었고, 필요한 구간에 대한 해저 퇴적물 분포 특

성을 평가하였다.

멀티빔 조사가 수행된 조사 구간 중, 그림 43와 그림 44는 2012년 8월부터 9월까지 수행된

척치해/보버트해 지역 중 정밀 해저 지형과 해저면 특성을 조사하기 위한 site B 지역에 대한

해저 지형 및 후방 산란 반사 신호 강도를 보여주고 있다. 이 지역에 대한 상세 조사 측선은

그림 45에 제시 되어 있다.

멀티빔 자료 보정전 해저 심도 분포 자료 멀티빔 자료 보정후 해저 심도 분포 자료

그림 43 북극 척치해 멀티빔 (2012년 8월～9월 획득) Site B 지역 해저 지형 조사 결과

멀티빔 자료 보정전 후방 산란 신호 강도 멀티빔 자료 보정후 후방 산란 신호 강도

그림 44 북극 척치해 멀티빔 (2012년 8월～9월 획득) Site B 지역 해저면 신호 특성
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그림 45. 북극 척치해 멀티빔 정밀 조사 지역 site B 조사 측선 상세도

그림 46과 그림 47은 북극 척치해 멀티빔 상세 조사 지역인 Site A와 Site B의 3차원 해저

지형 조사 결과를 보여주며, 그림 48과 그림 49는 2012년 1월에 획득된 남극 장보고 기지 인접

로스해에 대한 3차원 해저면 지형 기복 조사 결과를 보여준다. 남극 장보고 기지 인접 로스해

의 전체 상세 조사 측선도는 부록에 제공된다.

그림 46. 북극 척치해 site A 지역 해저 지형 결과
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그림 47. 북극 척치해 site B 지역 해저 지형 결과

그림 48. 남극 장보고 기지 인접 로스해 2012년 1월 획득 해저 지형 기복
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그림 49. 남극 장보고 기지 인접 로스해 2012년 1월 획득 해저 지형 기복

(그림 48동일 조사 측선 90도 회전 방향)

그림 50 역시, 2012년 1월에 획득된 남극 장보고 기지 인접 Ross Sea 멀티빔 자료를 보정한

결과를 보여준다. 그림 50의 상부 구역이 그림 48 및 그림 49에 제시된 영역에 해당된다. 특히

그림 50의 우측 그림들은 CTD 데이터 중 얻어진 SVP(Sound Velocity Profile)를 통해 보정이

수행된 결과로 실측한 SVP 자료가 있는 경우, 다소 결과가 향상 되는 것을 알 수 있다. 그러

나 전반적인 형태에 있어 큰 차이는 발생하지 않는 점을 미루어 예측된 SVP 입력 값이 큰 문

제가 없었음을 알 수 있다.
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핑별 오측 자료 보정 SVP 보정후

A B

C D

E F

그림 50. 남극 2012 획득 Ross Sea의 핑별 오측 자료 보정과 SVP 보정 결과

한편 그림 51과 그림 52는 2013년 2월에 획득된 남극 Ross Sea 멀티빔 자료를 보정한 처

리 결과를 보여준다. 그림 51은 상대적으로 깊은 수심 지역 (심해 지역)에서 수행된 결과를 보

여주고 있으며, 그림 52는 낮은 수심 지역 (근해 지역)의 결과를 보여준다 (정확한 위치는 그

림 53 표시 부분 참조).
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Swath 편집 방식 CUBE 활용 방식
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그림 51. 남극 2013 획득 Ross Sea의 핑별 오측 자료 보정 결과 (심해 지역)
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Swath 편집 방식 CUBE 활용 방식
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그림 52. 남극 2013 획득 Ross Sea의 핑별 오측 자료 보정 결과 (근해 지역)

그림 53. 남극 2013 획득 Ross Sea의 핑별 오측 자료 보정 결과 비교 지역 표시도

후방 산란 강도에 의한 퇴적물 특성 분석은 해저면을 생성하여 퇴적물로부터 반사되는 강

도의 분석 그래프 및 해저 퇴적물의 일반적인 강도 자료를 비교하는 방식으로 가능하였다. 그



50

러나 전술한 바와 같이 실제 퇴적물 채취를 통한 비교 확인은 수행되지 못하여 이러한 후방

산란 신호를 통한 퇴적물 분류는 상대적인 비교 자료로 이해되어야 한다.

아래 그림 54는 멀티빔 신호의 후방 산란 강도 그래프의 분석 결과 사례를 보여준다. 분석

은 CARIS HIPS and SIPS의 geocoder 모듈이 활용되었으며, 주로 입사각에 따른 반사 강도

변화 곡선 형태를 통해 판단 방식이 적용되었다.

그림 54. 해저면 퇴적물 특성 분석 자료 사례

그림 55은 2013년 남극 로스해에서 획득된 멀티빔 자료의 후방 산란 신호 강도를 흑백 음

영으로 표시하고 이들 산란 신호 강도를 입사각 별로 분석하는 사례를 보여준다. 이러한 후방

산란 신호에 대한 반사 강도를 입사 각도별로 표시하여 실제 그 형상에 따른 퇴적물 유추할

수 있는 도구로 활용 가능함을 확인할 수 있었다. 그러나, 이들 후방 산란 신호를 통한 최종

퇴적물 분포 결정은 실제 현장에서 채취된 일부 퇴적물 시료와 비교 분석될 필요가 있으며, 본

위탁 연구에서는 퇴적물에 대한 직접적인 자료 확보가 포함되지 않아 본 연구에서 제시하는

분석 결과는 상대적인 입도 분포를 보여주는 한계가 있을 것으로 생각된다.
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그림 55. 남극 2013 Ross Sea 후방 산란 강도 분석을 통한 해저면 퇴적물 평가 예시

본 위탁 연구 과제를 통해 도출된 연구의 주요 결과는 다음과 같이 정리된다.

ㅇ 아라온호 Kongsberg사의 멀티빔 시스템 EM-122에 해안 제원 및 현황 분석 완료

ㅇ 동해 시범 항해 (2012년 6월, 2014년 5월), 남극 로스해 (2012년 1월, 2013년 2월) 및 북극

척치/보포트해 (2012년 8월) 획득 자료 예비 처리 및 조사 정밀 측선도 작성

ㅇ 동해 및 양극해 자료의 정밀 검토 및 주요 지점에 대한 잡음 제거 효과 분석

ㅇ 양극해 자료 후방산란 신호를 통한 해저 물성 추정 수행

ㅇ 멀티빔 자료 처리 프로그램별 주요 기능 분석 및 특성 비교

ㅇ 대상 멀티빔 조사 지역에 대한 잡음 제거 해저 기복도 (bathymetry map) 구축
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제 4장 연구개발목표 달성도 및 대외기여도

연구목표 연구 내용 달 성 도 수행 사항

멀티빔 

신호 특성 

분석 및 

잡음 제거 

기법 개발 

(1차년

도) 

아라온 EM-122 제원 

분석
 100%

아라온호에 설치되어 있는 Kongsberg사의 

멀티빔 시스템 EM-122에 대한 제원 및 현황 

분석 

멀티빔 자료 획득 및 

후처리 기존 프로그램 

특성 분석 

100%

실제 자료획득과정을 파악하고 시험항해 

동안 수행된 멀티빔 조사의 원시자료 획득

멀티빔 자료 후처리 프로그램인 

MB-System의 처리과정 분석

멀티빔 원시자료 

Input/Ouput 처리 
100%

MB-System을 이용하여 EM-122 시스템에서 

획득된 원시자료의 Input/Output 처리방법을 

파악하고 실제 자료 처리 활용

멀티빔 자료 처리 모듈 

활용성 평가
90%

MB-System의 일부 모듈을 이용하여 멀티빔 

자료의 처리 활용성 평가 수행, 일부 자료 

처리 모듈은 활용 미흡

기획득 자료 처리 100%
동해안 시험항해에서 획득된 멀티빔 자료를 

후처리 프로그램을 이용하여 처리 

(2차년

도)

산란 신호특성 분석 100%
 입사각도, 반사 퇴적물 등 후방 산란 신호에 

영향을 미치는 요소와 결과 분서 수행

산란 잡음 제거 기법 

제시
100%

 불필요한 산란 잡음 제거 기법들에 대한 

이해와 수동/자동 처리 기법 적용방식 제시

산란 신호 

semi-automatic 분리 

알고리즘 개발 

90%

 기존 개발 알고리즘 활용 중심 수행, 부분적 

수동 처리 부분은 기개발 프로그램 활용, 

독자적 알고리즘 개발 미흡

멀티빔 

신호 특성 

분석 및 

잡음 제거 

기법 개발

멀티빔 

자료 활용 

해저 정량 

정보 제공

(3차년

도) 

멀티빔 활용 도출 

해저면 특성 제시
100%

 기존 프로그램 관련 모듈 적용을 통한 

멀티빔 후방 산란 신호를 이용한 해저면 특성 

분석 및 평가 결과 제시

척치해 멀티빔 자료 

처리 
100%

 북극 척치해 멀티빔 자료를 활용한 해저 

지형 결과 제시

척치해 해저면 특성 

분석
100%

 후방산란 반사 강도 분포 및 geocoder 활용 

척치해 해저면 특성 분석 

(4차년

도)

로스해 멀티빔 자료 

처리 
100%

남극 로스해 멀티빔 자료를 활용한 해저 지형 

결과 제시

로스해 해저면 특성 

분석
100%

후방산란 반사 강도 분포 및 geocoder 활용 

남극 로스해 해저면 특성 분석

(5차년

도)

북극해 멀티빔 자료 

처리 
100%

북극 척치해 멀티빔 자료에 대한 보정 처리 

전후 자료 활용 해저 지형 결과 제시 및 비교 

수행

북극해 해저면 특성 

분석
100%

북극 척치해 멀티빔 자료에 대한 보정 처리 

전후 자료 활용 후방산란 반사 강도 분포 및 

geocoder 활용 해저면 특성 분석 및 비교 

결과 제시

전반적인 연구 목표에 따른 달성도는 전체적으로 약 95% 이상으로 평가된다. 일부 자체

알고리즘 개발과 기존 프로그램의 전체 모듈 활용은 현재 아라온에 장착된 시스템이

water column 방식 자료 저장이 되지 않는 부분 및 일부 보조 자료 (SVP 실측 자료 등)
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의 미흡 등으로 완전하게 수행되지 못하였다. 특히 최초 유빙 산란 신호 제거 방식에 대한

접근은 연구 기간 동안 확보된 자료 중, 특별히 유빙에 의한 잡음으로 평가되는 부분이 없

고, 실질적인 개발을 위해서는 기존 프로그램의 원시 코드 분석 등이 수행되어야 하는 시

간적 한계와 연구 능력 미비로 충분하게 수행하지 못하였다. 그러나 조사 지역에 대한 분

명한 해저 지형 작성 및 후방 산란 신호를 활용한 퇴적물 분석 결과 등은 극지 환경 이해

및 양극해 환경 특성 지도 제작을 위한 기초 자료로 향후 활용 가능할 것으로 평가된다.

또한 멀티빔을 통한 해저 지형 정보 등은 극지 해양 및 지질 연구에 가장 기본적이고 필수

적인 자료로 이를 필요로 하는 타 연구에 적극적으로 기여 할 수 있을 것으로 판단된다.
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제 5 장 연구개발결과의 활용계획

멀티빔 장비 및 후처리 프로그램의 특성을 파악함으로써 멀티빔 자료의 구성 및 획득

방법을 정확히 파악할 수 있고, 그에 맞는 분석 기술을 확보할 수 있다. 또한 이러한 연구

는 해저면의 지질정보에 대한 획득 기술의 발전을 위해 기본이 되는 연구로 다른 연구에

비해 선행적 수행되어야 할 과제이다. 또한 공개용 프로그램인 MB-System을 활용하므로

써 필요한 연구 목적에 맞는 처리 및 분석을 위한 기법을 개발하는 것이 가능할 것으로 판

단된다.

한편 상업용 멀티빔 자료 처리 프로그램은 단시간에 결과를 도출하여야 하는 경우 크

게 도움이 되며, 특히 많은 양의 자료를 처리하는 데 필수적으로 활용될 수 있다. 다만, 활

용 모듈별로 필요한 경우 별도의 검증을 하여 프로그램의 신뢰성을 높일 필요가 있다고 생

각된다. 향후 멀티빔 자료의 잡음을 효과적으로 제거하여 필요한 정보를 확보하여야 할 때

본 위탁 연구 과제의 결과는 적극적인 활용이 가능할 것으로 판단되며, 축적된 연구 및 다

양한 방법의 자료 처리는 해저면의 지질정보에 대한 멀티빔을 이용한 효과적인 자료 획득

및 최적 분석기법의 효율적인 개발에 꼭 필수적 기술이라고 할 수 있다. 이러한 내재된 정

보를 활용하고 극대화하는 것은 특이한 극지 환경의 발견 가능성을 높이고, 경제성 있는

조사 평가 기술을 확보하는데 기여할 것이다.
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부록 1. 

EM-122 Specitification 『Kongsberg 제공』



Kongsberg EM® 122
12 kHz multibeam echo sounder

The EM 122 12 kHz multibeam 
echo sounder is designed to perform 
seabed mapping – bathymetry and 
seabed imagery- to full ocean depth 
with an unsurpassed resolution, 
coverage and accuracy. It represents 
a major improvement from previous 
models by offering significantly larger 
swath width, improved data density, 
and greatly improved resolution. 
Beam focusing is applied both during 
reception and transmission.

EM 122 is equipped with a 
function to reduce the transmission 
power in order to avoid hurting 
mammals if they are close by.

The system has up to 432 
soundings per swath with pointing 
angles automatically adjusted 
according to achievable coverage or 
operator defined limits.

the vessel movements: yaw, pitch 
and roll. Each transmit sector has 
individual beam focusing.

The EM 122 transducers are 
modular linear arrays in a Mills cross 
configuration with separate units for 
transmit and receive. The projector 
array is available as 0.5, 1, 2, or 4 
degree resolution, while the receive 
array is available as 1, 2, or 4 degrees.

The receive transducer is 
wideband. In conjunction with a 
separate low frequency transmit 
transducer, the EM 122 may 
optionally be able to deliver sub-
bottom profiling capabilities with a 
very narrow beamwidth. This system 
is known as the SBP 120 Sub-bottom 
Profiler.

Dual or triple frequency versions 
can be obtained by integration with 
other EM multibeams.

Advanced functions

• Depth range from 20 to 11000 m
• Swath width up to 6 times     

water depth/30 km
• Focused beams for transmission 

and reception
• High density and multiping modes 

for increased resolution
• Up to 864 sounings per ping
• Yaw, pitch and roll compensation 

and stabilization
• High accuracy
• Seabed image (sidescan) data 

display and recording
• Water column data display and 

recording
• Modular design, beamwidths 0.5 

to 4 degrees
• Dual and triple frequency  

versions possible
• Integrated sub-bottom profiler 

available
• Mammal protection With multi-ping ( two swaths 

per ping) the transmit fan is 
duplicated and transmitted with a 
small difference in alongtrack tilt. 
The applied tilt takes into account 
depth, coverage and vessel speed to 
give a constant sounding separation 
alongtrack.

In multiping mode, 2 swaths are 
generated per ping cycle, with up to 
864 soundings. The beam spacing is 
equidistant or equiangular.

EM 122 uses both CW pulses 
and FM sweep pulses with pulse 
compression on reception, in order 
to increase the maximum useful 
swath width. The FM pulses will also 
increase the resolution compared to 
CW pulses of the same length.

The transmit fan is split in several 
individual sectors with independent 
active steering. This allows 
stabilization which compensates for 

EM 122 survey of the Gakkel Ridge by the Swedish Icebreaker ODEN,
depth 4000 m.
Data courtesy of Stockholm University



306105 / Rev.B / November 2013

Strandpromenaden 50

P.O.Box 111

N-3191 Horten,

Norway

Kongsberg Maritime AS

Telephone: +47 33034100

Telefax: +47 33 04 44 24

subsea@kongsberg.com

www.kongsberg.com

Technical specifications

EM® is a registered trademark of Kongsberg Maritime AS in Norway and other countries.

EM 122 performance data
Operating frequency.................................................................................................................................................. 12 kHz
Depth range....................................................................................................................................................... 20-11000 m
Swath width.............................................................................................................................. 6 x Depth, to approx 30 km
Pulse forms.............................................................................................................................................. CW and FM chirp
Swath profiles per ping....................................................................................................................................................... 2

Motion compensation:
•  Yaw.............................................................................................................................................................. ± 10 degrees
•  Pitch............................................................................................................................................................ ± 10 degrees
•  Roll.............................................................................................................................................................. ± 15 degrees

Sounding pattern.......................................................................................................... Equi-distant on bottom/equiangular
Range sampling rate................................................................................................................................. 3.03 kHz (25 cm)
High resolution mode.................................................................................................................... High Density processing
Sidelobe suppression............................................................................................................................................... - 25 dB
Suppression of sounding artefacts................................................................................ 8 frequency coded transmit sectors
Beam focusing....................................................................................................................... On transmit and on reception
Beamforming method......................................................................................................................................... Time delay
Gain control......................................................................................................................................................... Automatic
Swath width control............................................... Manual or automatic, all soundings intact when reduced swath width
Seabed imagery/sidescan sonar image................................................................................................................... Standard
Water column display............................................................................................................................................. Standard
Mammal protection................................................................................................................................................ Standard
Multi frequency operation.............................................................................................. Yes, by integration with other EM
Sub-bottom profiling...................................................................................... Yes, by integration with SBP 120 and Topas

Versions of EM 122
System version 0.5x1 1x1 1x2 2x2 2x4 2x4
Transmit array [deg] 150 x 0.5 150 x 1 150 x 1 150 x 2 150 x 2 150 x 4
Receive array [deg] 1 x 30 1 x 30 2 x 30 2 x 30 4 x 30 4 x 30
No of beams/swath 288 288 288 288 144 144
Max no of soundings/swath 432 432 432 432 216 216
Max no of swaths per ping 2 2 2 2 2 2
Max no of soundings/ping 864 864 864 864 432 432



부록 2. 

CARIS HIPS and SIPS User’ Guide 차례

(전체 설명서는 전산 PDF 파일로만 제공)
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“PURPOSE OF HIPS AND SIPS” ON PAGE 4
“LICENSING” ON PAGE 5
“CONFIGURATION REPORT” ON PAGE 6
“IF YOU NEED ASSISTANCE…” ON PAGE 7

“FIELD SHEET EDITOR FUNCTIONS” ON PAGE 8
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Purpose of HIPS and SIPS

HIPS and SIPS are designed to receive bathymetric and side scan 
sonar data from a variety of industry standard data-logging 
formats. HIPS and SIPS contain tools for interactively and 
automatically identifying bathymetric outliers. Also, there is a 
wide range of proven and powerful algorithms for applying value-
added processes to the data. The result of all these operations is 
a clean and final dataset that is ready for the creation of wide 
range of data products, available within the HIPS and SIPS 
software and other integrated CARIS products.
• The HIPS and SIPS products share a common Windows 

interface containing editors for vessel, attitude, navigation, 
single beam bathymetry, swath bathymetry, side scan sonar, 
and other data sensors. 

• The program also contains a georeferenced project view 
window for displaying the spatial location of these observed 
data with other georeferenced data, for example orthophotos, 
raster charts, CARIS vector map files, and S-57 Edition 3.1 
data.

• HIPS and SIPS also performs the tasks necessary to 
generate finished field sheets, as well as contours and shoal 
soundings selections. It can also add cartographic data to the 
field sheet and define a customized plot layout, as well as 
generating composited mosaics and seafloor sediment 
analysis.
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Licensing

HIPS and SIPS is comprised of three distinct products, each with 
its own license. This table outlines these licensing levels and the 
options that are included with each. 

All HIPS and SIPS products include the following features:
• vessel configuration
• tide/sound velocity preparation
• attitude/navigation cleaning
• GPS RTK tide
• background displays
• variable depth tiling
• contouring
• plotting 

Product Supported Formats Data Cleaning Data Processing

HIPS Singlebeam

• Atlas
• GSF
• Hypack
• Winfrog 
• generic ASCII data

• Interactive single beam 
depth cleaning

• Automatic single beam 
spike filters

• Subset area cleaning
• Automatic TPU filtering

• tide zoning,
• sound velocity corrections
• batch processing

HIPS Multibeam 
Professional

HIPS Singlebeam plus
• Elac
• Furuno 
• LADS 
• Seabeam
• Seafalcon
• Simrad
• UNBReson
• XTF

HIPS Singlebeam plus 
• interactive swath cleaning 
• automatic swath filters 
• refraction repair,
•  integrated side scan dis-

play
• 3-D subset area cleaning
• statistical surface cleaning

HIPS Singlebeam plus
• tide zoning,
• sound velocity corrections
• BASE surfaces

SIPS Professional

• Atlas
• CMAX
• Coda
• EdgeTech
• MarineSonics
• Qmips
• Seabeam
• Seafalcon
• SEGY
• Simrad
•  XTF

• side scan viewing and 
cleaning

• digitize towfish altitude

• Recompute towfish navi-
gation

• slant-range correction
• mosaics
• generate side scan con-

tacts
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Configuration Report

The configuration report is a text file containing a list of program, 
environment and system resources used by HIPS and SIPS.
1. From the Windows main menu, select Start > Caris > 

Utilities > Configuration Reporter.

The Configuration Reporter is displayed.

The CARIS Product Configuration Reporter contains a list of 
CARIS products already installed on your computer. This list is 
inactive until you select a path and name for the configuration 
report
2. Type a file path and name for the configuration report file, or click 

Browse and select a file path and type a name.

The list of CARIS products is now active.
3. Select HIPS and SIPS (version number) from the list.

4. Click Create to create a report in the selected folder, or click 
Email Report to create the report and send it as an email attachment 
to CARIS support.

The Configuration Report contains the following information:
• list of program files with version info
• HIPS and SIPS environment settings
• CARIS kernel registry
• system information
• system and user’s environment
• CARIS licensing report
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If you need assistance…

There are several options for getting help:
• Refer to the User Guide for the HIPS and SIPS editor you are 

using.
• Refer to the Online Help file in the editor you are working 

with by selecting Help > Help Topics.

• Refer to the training material you received when you attended 
the CARIS classroom training.

• Call Customer Support if you are unable to find an answer 
in Help or in the user documentation.

Before you contact CARIS Customer Support:

Are you able to reproduce the problem?
Have you looked for an answer in the documentation listed 
above?
Be prepared to describe the task(s) you were performing when 
you encountered the situation.
Be prepared to provide a description of what happened and any 
error messages you received. You can refer to the log files 
generated when the error occurred. 
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Field Sheet Editor functions

Field Sheet Editor functions were integrated into the HIPS and 
SIPS interface in this release. The following table lists the 
location of commonly used commands:

Command in Field Sheet Editor New location in HIPS&SIPS interface

View > Scale  / Alter Scale View > Zoom  > Zoom To

Delete Field Sheet Delete  - on right-click menu in Layers 
window

Delete layer of  a Field Sheet Delete  - on right-click menu in Layers 
window

Turn off field sheet 

Session tab  FS tab Layers window/tab

Contours Process > Products > Contours

Product Surface Process > BASE Surface > Product Sur-
face

Exporting / Importing Profiles Process > Products > Profile > Import /
Export

Projection Grid Select Field sheet layer & Process > 
Products > Projection Grid…   

Use Coordinate System On right-click menu in Layers window

Sounding Selection Wizard Process > Products > Selected Sound-
ings … 

View > Object Filter Create  Layer > by Attribute Value, Fea-
ture Type, Rule wizard etc.

Tools > Options > General - Contour 
options 

Tools > Options > Display > Contours

Remove Layer Remove layer on right-click menu in Lay-
ers tab

Tools > Tiles > Tiling Wizard Process > Products



2
 The HIPS & SIPS Interface

This chapter describes the interface and its components, and how to 
open projects and background data, use viewing and selection tools and 
take screen captures. 

It also describes the 3-D Display Window and its properties.

In this chapter...
“OPENING HIPS AND SIPS” ON PAGE 10
“MAIN DISPLAY” ON PAGE 11
“DISPLAY WINDOW” ON PAGE 12
“CONTROL WINDOW” ON PAGE 13
“PROPERTIES WINDOW” ON PAGE 16
“WORKSHEET WINDOW” ON PAGE 18
“REPOSITION AND RESIZE WINDOWS” ON PAGE 25
“TOOLBARS” ON PAGE 27
“OPEN PROJECTS AND BACKGROUND DATA” ON PAGE 31
“DISPLAY TOOLS” ON PAGE 38
“SELECTION TOOLS” ON PAGE 42
“SCREEN CAPTURES” ON PAGE 46
“3D DISPLAY WINDOW” ON PAGE 47
“MEASURE DISTANCE” ON PAGE 65
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The HIPS & SIPS Interface: Opening HIPS and SIPS

Opening HIPS and SIPS
1. To open HIPS from the Windows interface, select Start > Programs > 

CARIS > HIPS and SIPS version number > CARIS HIPS and SIPS

During installation you were prompted to place a HIPS 
icon on the desktop. If you selected this option you can 
also open HIPS and SIPS by double-clicking this icon. 
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The HIPS & SIPS Interface: Main Display

Main Display

The HIPS and SIPS interface has four windows:
• Display window 
• Worksheet window
• Properties window
• Control window

The windows can be displayed, hidden, or resized and moved to 
another location (see “REPOSITION AND RESIZE WINDOWS” ON PAGE 25).
The interface also includes toolbars (see “TOOLBARS” ON PAGE 27) and 
a status bar (see “STATUS BAR” ON PAGE 26).

Display window

Worksheet window Status bar

Control window

Properties window
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The HIPS & SIPS Interface: Display Window

Display Window

The Display window shows a graphical representation of the 
survey area.
1. Select the Display window command.

You can perform the following functions in this window:
• select track lines (see “QUERY LINE DATA” ON PAGE 290

• zoom and pan data (see “ZOOM” ON PAGE 39 and “PAN” ON PAGE 38)
• view graphic files (see “OPEN BACKGROUND DATA” ON PAGE 33) and 

S 57 data (see “DISPLAY S-57 DATA” ON PAGE 36)
• define a field sheet area (see “CREATE A FIELD SHEET” ON PAGE 210).
• save screen captures of the display in the window (see “SCREEN 

CAPTURES” ON PAGE 46)
For options for the display of the ship and towfish track lines see 
“DISPLAY WINDOW” ON PAGE 661.

M
en

u

Window > Display
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The HIPS & SIPS Interface: Control Window

Control Window

The Control window has four tabbed windows: Project, Layers, 
Draw Order and Extended Query. 
A fifth tabbed window will be available when you open a HIPS 
and SIPS editor, such as the Mosaic Editor or Attitude Editor.
The Control window is open as part of the default HIPS and 
SIPS layout, but it can be closed. To reopen the Control window:
1. Select the Control window command.

Project tab

The Project tab displays the currently open project files. Files 
are organized in a Project-Vessel-Day-Line hierarchy.You can 
expand a file tree by clicking the plus sign (+) beside a folder.
You can perform the following operations in this window:

• open and close lines (see “CLOSE A PROJECT” ON PAGE 68)
• select track lines (see “QUERY LINE DATA” ON PAGE 290)

Layers tab

The Layers tab lists the open data layers. Besides survey data, 
a layer can consist of a CARIS map, an image, or field sheet 
products such as contours, selected soundings, tiles, etc.

M
en

u

Window > Control
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Background 
file layers

Active layer

Field sheet 
layers

BASE surface 
layers
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The HIPS & SIPS Interface: Control Window

You can control what is viewed in the Display window by 
selecting or clearing the layer check boxes.
1. If necessary, expand an object file tree by clicking the + icon beside it.

2. Show/hide a layer by selecting or clearing the check box beside the 
layer name.

3. Select the Refresh command, or make sure the Automatic Refresh 
option in the General Options dialog box is selected (see “GENERAL” ON 
PAGE 657 ).

Draw Order tab

The Draw Order tab displays the order that objects are drawn 
to the Display window. Objects are drawn in order, from top to 
bottom, as they appear in the Draw Order tab. You can change 
the draw order by dragging an object to another position on the 
list. 

Extended Query 

The Extended Query tab displays attributes of selected S- 57 
background features when they are queried. 
For example, after you have used the Query command on 
features selected in an S-57 (*.000) or HOB file opened as 
background data, you can then select one of the queried features 
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The HIPS & SIPS Interface: Control Window

in the Query tab and its attributes will display in the Extended 
Query tab. 

Tab for editors in HIPS

When you open HIPS and SIPS editors such as the Attitude, 
Navigation, Subset or Sidescan Editor, a fifth tab will be 
displayed in the Control window. It will contain the controls for 
the active editor, for example, you can: 
• filter attitude data (see “ATTITUDE FILTER” ON PAGE 284).
• examine navigation data (see “EXAMINE NAVIGATION DATA” ON 

PAGE 279).
• control the display of subset data (see “SUBSET EDITOR TAB” ON 

PAGE 623).
• modify Swath Editor windows (see “SWATH EDITOR DISPLAY OPTIONS” 

ON PAGE 640).
• repair refraction problems (see “THE REFRACTION EDITOR” ON 

PAGE 326).
• set display options, create contacts in side scan data (see “SIDE 

SCAN EDITOR CONTROLS” ON PAGE 425).
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The HIPS & SIPS Interface: Properties Window

Properties Window

The Properties window controls the properties of lines, surfaces 
and features that appear in the Display window, and that are 
listed and activated in the Layers tab. The Properties window 
can be undocked and moved around the interface.
The display options shown in the window are determined by the 
selected layer type, e.g., ship track lines, field sheet layer, BASE 
Surface layer(not all layers contain display properties).
1. Select the Properties window command.

2. Select a layer in the Layers tab of the Control window.

The display properties for that layer are shown in the window. 
The undocked Properties window shown below shows properties 
for the HIPS Data layer.

3. Click Apply to implement the property changes.

See the following topics for more information on setting 
properties for specific layers:
• “SET TRACK LINE PROPERTIES” ON PAGE 32“ 

• “CRITICAL SOUNDINGS” ON PAGE 296

• “SET IMAGE PROPERTIES” ON PAGE 34“

M
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The HIPS & SIPS Interface: Properties Window

• “VIEW SURFACE PROPERTIES” ON PAGE 231 AND “SET ATTRIBUTE PROPERTIES” 
ON PAGE 232 for BASE Surface layers.

• “SET FIELD SHEET PROPERTIES” ON PAGE 215 for Field Sheet layers.
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The HIPS & SIPS Interface: Worksheet Window

Worksheet Window

.The Worksheet window has two tabs which are visible at all 
times while HIPS and SIPS is open: Query tab and Output tab.
• Query (for viewing information on selected data)
• Output (for viewing the result of a command or process).
The Quality Control, Graph, and Profile tabs display as needed 
when those functions are activated.
• Quality Control (for displaying quality control reports)
• Graphs (for displaying graph information)
• Profile (for displaying cross-sectional views of the BASE 

Surface or Tile area).

If the Worksheet window is closed, it can be re-opened with the 
Worksheet menu command or tool button on the Windows 
toolbar. 

Output Tab

In this tab you can view the results of a command or process.

Information in this tab is read-only and cannot be modified.
If you want to remove the information in this tab, right-click the 
mouse and select Clear from the pop-up menu.



CARIS HIPS and SIPS User’s Guide 19

The HIPS & SIPS Interface: Worksheet Window

Query Tab

The Query tab is used to view data on selected features in the 
Display window.

The data is shown in tabular format. You can invert the order of 
data by double-clicking a column header.
The type of data fields displayed in the Worksheet window and 
the order in which these fields are displayed is controlled by the 
Query Fields dialog box.
1. Right-click the Query tab in the Worksheet window and select the 

Query Fields command from the pop-up menu.

This opens the Query Fields dialog box. 

The data types listed in the dialog box are determined by the 
editor currently open in the application.
2. To add data fields to the Worksheet window, select a data type in the 

Available Fields list and click Add.

The data field is now listed in the Active Fields list.
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3. To remove a data field from the Worksheet window, select a data field 
in the Active Fields list and click Remove.

The data field is now in the Available Fields list.
4. To restore the default listing of fields and their order, click Default.

5. To change the display order of data, select a data field in the Active 
Fields list and click the up or down arrow buttons.

The data field is now in a different position on the list.
6. Click OK.

The fields moved to the Active Fields list are now visible in the 
Worksheet window, displayed in the order you set. 

Query options The following options are also available in the Query tab.
1. To save the data as a text file, right-click in the Query tab and select 

Save As from the pop-up menu.

2. To print the data, right-click in the Query tab and select Print from the 
menu.

3. To copy data, right-click in the field you want to copy (or use the Select 
All command to highlight all data), then use the Copy command.

4. To remove row(s) from the table, select the rows so they are 
highlighted, right-click and select Remove Selected from the menu.
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Graph Tab

The Graph tab displays the data from the tables in the Query 
and QC Reports tabs in graphical format. The Graph tab only 
becomes visible when data from the Query tab or from the QC 
Reports tab is graphed. It appears with the name of your graph 
on the tab. 

The graph can be rotated. Zoom and pan operations can also be 
applied. A legend is automatically generated when more than 
one data type is displayed.

Create Graph 1. While the cursor is in the Query and QC Report tabs of the Worksheet 
window, right-click and select New Graph from the pop-up menu.

The New Graph dialog box is displayed.

The fields in the Query or QC Report tab of the Worksheet 
window determine the available values for creating the x- and y-
axes of the graph.
2. Type a name for the graph in the Title field. This name will appear on 

the Graph tab.

3. Select values for the x- and y-axes. You can select more than one 
value for the y-axis.
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Data is displayed in the graph according to the list order. If you 
select more than one data type for the y-axis, the first data type 
may hide the other types in the graph. You can avoid this by 
using the mouse to move a data type up or down on the list in the 
dialog box.

4. Select a data type, press and hold the mouse button while moving the 
data type to a new position on the list.

5. Click OK.

A graph is created in the tab.
Graph Controls The display and control options are located on the left side of the 

tab. The image below shows an example of the 3D view and 
controls.

1. Choose a display mode from the Chart Type drop-down list. You can 
select from various points, lines or bars.

2. Graph positioning and other movement is controlled using the left 
mouse button. Select a mouse operation (rotate, pan, or zoom) from 
the Mouse drop-down menu.

3. Change the size of points, stars, diamond, crosses, diagonal crosses, 
and tubes in the Size field.
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4. Select 3D to display the graph showing depth, or select 2D to display 
the graph in an orthographic display without depth.

5. To flatten the chart, click the Snap to 2D button.

More detailed graph control options are available from a pop-up 
menu in the graph area. 

QC Reports Tab

The QC Reports tab contains statistical data generated from the 
QC Reports tool (Process > QC Report...). For details on creating 
QC reports, see “QUALITY CONTROL” ON PAGE 215.

The QC Reports tab has the same options available as in the 
Query tab. See “QUERY TAB” ON PAGE 19 for more information.
You can also create graphs using data from the table, see “GRAPH 
TAB” ON PAGE 21 for more information. 
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Profile Tab

This tab displays a cross-sectional diagram (profile) of a BASE 
Surface, weighted grid, or tile. 

To create and display profiles, see “PROFILES” ON PAGE 354.
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Reposition and Resize Windows
Repositioning All windows can be undocked from their default positions and 

moved anywhere on the screen.
1. Click and hold your cursor on the title bar or handle of the window and 

drag the window to the new position.

As you drag the cursor, the window un-docks from its current 
location and moves with the cursor. To prevent a window from 
automatically docking, hold the <Ctrl> key while dragging the 
window.
2. Release the mouse button when you want to dock the window in its 

new location.

Resizing Windows can also be sized to a new length and width.
1. Position the cursor on any edge of the window.

The cursor becomes a two-headed arrow.
2. Press and hold the mouse button and drag the edge of the window to a 

new position.

As you drag the cursor, the window expands or contracts, 
depending on whether you are pulling or pushing the window 
edge.
3. Release the mouse button when you have resized the window to the 

desired length and width.

Restore default 
windows layout

This command will close all editors open in theHIPS and SIPS 
interface, and reset the interface windows (e.g.Control window) 
to the same position as when the application was first installed.
You will be prompted to save data as editors are closed. 
1. Select the Restore Default Window Layout command.

Click handle and drag
to undock

Double-click title
bar to re-dock 
window 
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Status Bar

The status bar at the bottom of the interface displays the 
following information:
• message about the operation currently taking place, or the 

information in the tool tip for the command button or menu 
item your cursor is on 

• number of track lines selected out of the total lines open in 
the interface

• scale of the current display in the Display window
• coordinates of the current cursor position in the units chosen 

in Tools > Options 
• disk usage for a selected data repository 

Depending on which editor you have open, the status bar will 
also display information such as the day the survey was 
conducted, profile and beam number, etc. 

Status Bar options

You can hide the status bar: 
1. Select the Status Bar command.

The check mark beside the Status Bar option is gone and the 
status bar is no longer visible in the desktop.

Cursor coordinates The units for the coordinates of the cursor’s current position are 
set in the Options dialog box of the Tools menu. You can use the 
Units option to set the type of unit e.g. Geographic or Ground. 
The Position Precision option is used to set the number of places 
to the right of decimal point in the coordinate display. 
For further information see “UNITS” ON PAGE 90.
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Toolbars 

Toolbars allow swift access to commonly used commands. 
Toolbars can be undocked and moved about the interface. 
The following is a list of toolbars. 
• Standard: Access standard Windows commands such as 

opening and saving files.
• Edit: Access functions used for editing data.
• Window: Access commands for toggling windows to on or off.
• View: Access functions for controlling the view in the Display 

window.
• Tools: Access functions for opening editors and for processing 

data.
• Process: Access functions for executing processes such as 

creating BASE surfaces and merging.
• Filter: Access functions for defining and executing automatic 

filters.
• Select: Access functions for selecting objects in the Display 

window.
• Swath Editor: Access functions for examining and cleaning 

pre-merged sounding data.
• Single Beam Editor: Access functions for examining and 

cleaning single-beam data.
• Subset Editor: Access functions for examining and cleaning 

sounding data in the subset mode.
• Side Scan Editor: Access functions for examining data, 

slant-range correcting raw side data, and creating contacts.
• Lidar: Access functions for selecting and examining 

soundings recorded by a lidar system.
• Surface Cleaning: Access functions for surface cleaning and 

tiling.
You can also create a custom toolbar (see “CREATE A CUSTOM TOOLBAR” 
ON PAGE 29.
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Modify Existing Toolbars

Most toolbars are visible when the application is opened. You 
can remove toolbars from the desktop.
1. Select the Toolbars command.

2. Click a toolbar name from the Toolbars sub-menu so it is no longer 
checked.

The toolbar is removed from the desktop.
To make a toolbar visible again, select the toolbar name from the 
sub-menu so it is checked.

Move toolbars Toolbars can be moved to any location on the desktop.
1. Position the cursor over any area of the toolbar not covered by a 

button, or double-click the double bar grab handle on the left side of the 
toolbar.

2. Press and hold the mouse button while dragging the toolbar to a new 
location.

3. Release the mouse button to position the toolbar.

When moving a toolbar, press and hold the <Ctrl> key to stop 
the toolbar from automatically docking.

Modify appearance You can alter the buttons’ size and appearance.
1. Select the Customize command.

The Customize dialog box is displayed.
2. Select any of the following three options by checking a box.

• Tool Tips: Display the name of a command button when the cursor is 
placed over it.

• Cool Look: Remove the border outline from the buttons.

• Large Buttons: Display buttons with 32 x 32 pixel icons instead of 
16 x 16 pixel icons.

3. Click OK.
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Create a Custom Toolbar

Create a custom toolbar with buttons from other toolbars.
1. Select the Customize command.

The Customize dialog box is displayed.

2. Click the Toolbars tab.

3. Click New to open the New Toolbar dialog box.

4. Type a name for the toolbar, and click OK.

A new toolbar is displayed in the HIPS&SIPS interface. 
5. Click the Commands tab.

The existing toolbars and the toolbar command associated with 
them are displayed.
6. Select a toolbar name in the Categories list.

The buttons associated with that toolbar are displayed on the 
right side of the dialog box.
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To add a command button to your new toolbar:
7. Select the desired button so it is highlighted.

8. Press the mouse button and drag the highlighted button to the new 
toolbar.

9. Repeat Steps 7 and 9 until you have all the required buttons.

Delete a toolbar Use this command to remove a new toolbar from the interface. 

1. Select the Customize command.

The Customize dialog box opens.
2. Select the Toolbars tab (if the tabbed window is not already visible).

3. Select the new toolbar’s name in the Toolbar section, so the name is 
highlighted.

The Reset button becomes a Delete button. 
4. Click the Delete button.

The toolbar is removed from the desktop and is no longer listed 
in the Customize dialog box. 

The Delete option can only be applied to new toolbars and 
cannot be applied to default toolbars.
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Open Projects and Background Data

In HIPS and SIPS, survey data is organized into projects. All 
projects are organized in a Project-Vessel-Day file tree. 
Before any data from a vessel can be processed, a vessel 
configuration file must exist. For information on creating or 
editing vessel configuration files, see “CREATE A NEW HVF” ON PAGE 81. 
Once a HIPS Vessel File is set up, a new project is defined to 
organize the survey data in the Project-Vessel-Day-Line 
hierachy. (The process to create a new project is described in 
“DEFINE NEW PROJECT” ON PAGE 116 in the Workflow chapter.) 

Open a Project

To open a defined project: 
1. Select the Open Project command.

The Open Project dialog box is displayed.
2. Select a Project folder so it is highlighted.

If the project contains both bathymetric and side scan data, you 
can open either the vessel or towfish navigation, or open both. 
Your choice is saved in the registry and the session file for future 
use. 
3. Select either Open ship track lines or Open towfish track lines, or both 

options, to open the appropriate track lines in the Display window.

4. Click Open.

The track lines associated with the project are opened in the 
Display window. The Project/Vessel/Day/Line file tree is 
displayed in the Control window.

Open specific data You can also open the data for a specific vessel (if the project 
contains more than one), or for a specific survey day, or for an 
individual track line. As you expand each folder, the contents 
are displayed in the Contents pane of the Open Projects dialog 
box. 
1. Choose the Open Project command.

2. In the Open Project dialog box, expand the folder tree by clicking the 
+ icon so that the Vessel and Day folders are visible.

3. Select a vessel folder name so it is highlighted, and click Open, or 

4. Expand the Vessel folder to see the Day folders. 

5. Select a Day folder and click Open, or

6. Expand the Day folder to see the Line folders. 

7. Select a Line folder and click Open.
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Combining project data 
using Windows 
shortcuts

You can use a Windows shortcut to link HDCS 
Project\Vessel\Day\Line data on different drives or network 
locations. The project, plus the shortcut to the other data, is 
displayed in the Open Project dialog box. The data folders must 
contain a Vessel Configuration File.
1. Create a Windows shortcut in any P\V\D\L directory.

2. Copy the shortcut to the project where you want to place the shortcut. 
Remember that the shortcut must be copied to the appropriate folder. A 
Project folder shortcut must be copied to a HDCS data folder, a Vessel 
folder shortcut must be copied to a Project folder, etc.

3. Open the data using the Open Project command.

Set Track Line Properties

Change the colour and symbology of ship and towfish track lines.
1. Select the ship or towfish track lines layer in the Layers tab of the 

Control window.

2. If the Properties window is not open, select the Properties window 
command.

The Properties window for ship or towfish track lines is 
displayed. 

The colour of ship track lines can be changed to highlight 
whether data has been Merged (combined into a position/depth 
file) or Not Merged.
Tow fish track lines can be coloured to idicated Slant-Range 
Corrected or Raw Side Scan.
3. Select a colour from the colour palette, or create a custom colour from 

the standard Windows colour picker.

The following steps are applicable to both ship and towfish track 
lines.
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4. Select the Symbolize Lines check box to add symbolization according 
to a selected feature code.

5. Select a Feature Code for line symbolization from the drop-down list. 

The Use Multiple Colours option uses a set of 10 distinct colours to 
colour the track lines in the Display window. This is useful if the 
data was logged as multiple files along the same runline.
6. [Optional] Select the Use Multiple Colours check box to implement this 

option and select a colour map from the drop-down list.

7. Click Apply.

Open Background Data

HIPS and SIPS can open any of the following data types as 
background in the Display window:
• AutoCAD files (DXF, DWG)
• geo-referenced TIFF (GeoTIFF, TIFF/TFW, TIFF/IGA)
• JPEG 2000 (JP2)
• Shapefiles (SHP)
• raster charts (BSB, HCRF)
• CARIS maps (DES)
• S-57 Ed 3.11 (000)
• Hydrographic Object Binary (HOB) files (including Edit and 

Marker layers created in CARIS Notebook).
• MrSid image files (SID)2

• Bathymetric Attributed Grid files (BAG)
1. Select the Open Background Data command.

The Open dialog box is displayed. More than one data type can 
be selected while the dialog box is open.
2. Select a file or group of files by one of three methods:

• Select an individual file by highlighting it.

• Select a group of files by pressing the <Ctrl> key and selecting each 
file.

• Select a range of files by pressing the Shift key and selecting the 
first and last file in the range. All files between the first and last file 
are highlighted.

1. Update files included with the .000 file are automatically opened with the original S-57 
file.

2. MrSID image files can only be opened if you have installed the CARIS plugin for MrSID 
images. This free plugin can be downloaded from 
http://www.caris.com/products/mrsid.cfm.
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3. Click Open.

The files are opened in the Display window and are listed as 
layers in the Control window.

Set Image Properties

Set the display options for image files (TIFF, TWF, IGA, raster 
images, etc.).
1. Select the Image layer in the Layers tab of the Control window.

2. If the Properties window is not open, select the Properties window.

The Properties window automatically displays the display 
options for the selected image layer.

3. If applicable, select a colour map for a raster image from the drop-down 
list. 

The Shading options are applied to GIS raster images where 
height values are available.
The Image Shading option controls the lighting angles of the 
raster image. Using this option may highlight fine scale features 
in the image that would not normally be seen.
Sun position controls the shading effect in the image. The 
azimuth varies from 0 to 360 degrees in a clockwise direction. 
The elevation varies from 90 to 0 degrees starting from the 
middle of the sundial.
4. Select the Shading check box to activate the sundial and Vertical 

Exaggeration options.

5. Position the cursor over the button in the sundial and press and hold 
the mouse button to drag the button to a new position.
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6. Change the exaggeration of the illuminated sea floor by selecting a 
Vertical Exaggeration value. Increasing the exaggeration may improve 
the view of finer features in the image.

7. To set a transparency level for the entire image, type a Transparency 
percentage.

8. Set the See Through Pixel option to “True” to make a pixel value totally 
transparent. 

You can re-project a georeferenced raster image to a project 
projection using two methods: 
• The Full Raster option is a pixel-by-pixel reprojection to the 

project coordinate system. This option can take a long time if 
the image file size is large.

• The Rubber Sheet option uses the centre coordinate in the 
Display window as a starting point for image reprojection. 
This is done by aligning the same coordinate in the 
georeferenced image to the centre coordinate in the window. 
The raster image is then reprojected out from the centre 
coordinate. This means that the image is reprojected every 
time you pan or zoom the Display window.

9. Select either the Full Raster or Rubber Sheet options.

10.Click Apply to implement the changes.
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Display S-57 Data

HIPS and SIPS is capable of displaying S-57 Ed 3.1 and HOB 
(Hydrographic Object Binary) files. How the data is displayed is 
controlled by the Object Filter controls and by the settings in the 
Options dialog box (see “S-52 DISPLAY” ON PAGE 678).
1. Select the Open Background Data command (see “OPEN BACKGROUND 

DATA” ON PAGE 33) and open an S-57 dataset.

The S-57 dataset is opened in the interface and the file is listed 
in the data tree in the Layers tab of the Control window.

Object Filter You can determine what objects are shown in the Display 
window.
1. Select the S-57 file in the Session tab of the Control window.

2. Right-click the mouse and select the Object Filter command.

The S-57 Object Filter dialog box is displayed.
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The Available list contains all objects in the S-57 file. The Active 
list contains the S-57 objects that are currently shown in the 
Display window.
3. You can move objects between the lists.

• To move objects from the Active list to the Available list, select the 
object(s) and click the (< )left-arrow button.

• To move objects from the Available list to the Active list, select the 
objects and click the (>) right-arrow button.

• To move all objects from the Active list to the Available list, click the 
(<<) double left-arrow button.

• To move all objects the from the Available list to the Active list, click 
the (>>) double right-arrow buttons.

• To move all Skin of the Earth objects to the Active list, click Group1.

4. Select the Include or Exclude options to show or hide objects in the 
Active list.

5. Click Apply to save the settings. 

Query S-57 objects Data about selected S-57 objects can be displayed in the 
Worksheet window using the Query command. 
1. Select the S-57 file name in the Control window.

2. Select the S-57 objects in the Display window that you want to query.

3. Select the Query command.

Information about the selected S-57 objects is displayed in the 
Worksheet window. 
If further information about an object is available, it can be seen 
by selecting the object and then the Extended Query tab.
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Display Tools

There are two kinds of tools that you can use to manipulate the 
view of data in the Display window: Pan and Zoom. The Pan 
function lets you reposition your view within the Display 
window. The Zoom function magnifies or reduces the viewing 
area within the Display window.
The Zoom/Pan Reverse and Forward tools let you toggle between 
views, and you can zoom to centre on a specific set of coordinates 
using the Zoom To command. 

Pan

There are two ways to move the view of data up, down, or to the 
left or right, within the Display window: 
• by using the Pan tool to move by a defined amount, or
• by dragging with the mouse. 

Pan tool The Pan tool will let you move the view by a percentage of the 
view extents. You can set the amount that the view will move in 
the Pan Factor field on the General tab of the Tools > Options 
dialog box. (See “GENERAL” ON PAGE 657.) 
To move the view of data with the Pan tool: 
1. select a Pan command:

• Pan Up: Re-centre the display at a position that is above the current 
display area.

• Pan Down: Re-centre the display at a position that is below the 
current display area.

• Pan Left: Re-centre the display at a position to the left of the current 
display area. 

• Pan Right: Re-centre the display at a position to the right of the 
current display area.

The Pan commands on the View menu can be added as buttons 
to a new or existing Toolbar by using the View > Toolbars > 
Customize… command. 

Pan with the mouse You can pan the display with your mouse by using a press and 
drag action. 
To pan with the mouse:
1. Press and hold down the scroll wheel or middle button on your mouse. 

(The cursor changes to a hand.)

2. Use the mouse to drag the view in any direction. 

3. Release the mouse button when you have repositioned the view.
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Zoom

There are two ways to magnify or reduce the viewing area in the 
Display window:
• use the scroll wheel on your mouse, if available
• use the Zoom tools

Zoom with the mouse To zoom in or out using a mouse: 
1. Click in the Display window. 

2. Scroll back and forth with the scroll wheel to zoom the view up and 
down.

Zoom tool Use the Zoom tool to select a specific area of the Display to 
enlarge: 
1. Select the Zoom command.

The cursor changes to a magnifying glass icon. 
2. Press and hold the mouse button and drag the cursor to create a 

rectangle around the area you want to magnify.

The display is enlarged so that the area within the rectangle 
now fills the Display window.
Once the area has been zoomed, the Zoom tool button is no 
longer active. To keep the Zoom tool active, select the Enable 
Constant Zoom function in the Options dialog box (see “GENERAL” ON 
PAGE 657).

Zoom In

The Zoom In tool lets you enlarge the viewing area in the 
Display window automatically by a set amount.
1. Select the Zoom In command

The display is automatically enlarged by the percentage set in 
the Zoom Factor field on the General tab of the Options dialog box 
(see “GENERAL” ON PAGE 77).

Zoom Out

Zoom Out automatically reduces the viewing area in the Display 
window by a set amount.
1. Select the Zoom Out command.

The display is automatically reduced by the percentage set in 
the Zoom Factor field on the General tab of the Options dialog box 
(see “GENERAL” ON PAGE 77).
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Zoom/Pan Previous

This tool returns the view to the position or magnification that 
was displayed before you zoomed or panned the view. 
1. Select the Zoom/Pan Previous command.

Zoom/Pan Forward

This tool returns the view to the position or magnification that it 
was in prior to using the Zoom/Pan Previous command.
1. Select the Zoom/Pan Forward command.

Zoom To

Re-centre the view on specific coordinates in the Display 
window, or zoom in so that the viewed area is displayed at a 
specific scale. 
1. Select the Zoom To command.

The Zoom To dialog box is displayed.

2. Type the new coordinates in their respective fields to re-centre on that 
point in of the Display window, 

OR 
3. Type a new scale to zoom into or out of the display.

4. Click OK.
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Refresh Display

Redraw the view in the Display window.
1. Select the Refresh command, or click the middle mouse button when 

the cursor is in the Display window.

The display is redrawn.

Overview Display

Redraw the Display window to the full extent of all the data that 
is currently open. 
1. Select the Overview command.

Cancel Draw

Select the Cancel Draw command to stop a display from being 
drawn in the Display window. This command is only active while 
the image is being drawn. 
You can create a Cancel Draw tool button and place it on a new 
or existing Toolbar by using View > Toolbars > Customize… 
command.
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Selection Tools

You can select an individual track line or object in the display by 
clicking on it with the mouse so it is highlighted.
You must select a survey line to use these editor tools:
• Attitude Editor
• Navigation Editor
• Single Beam Editor
• Swath Editor
• Side Scan Editor
You must select one or more survey lines to use the following 
tools and processes:
• single beam filters
• swath filters
• Total Propagated Uncertainty (TPU) filters
• restart cleaning
• load tide
• sound velocity corrections
• compute GPS tide
• compute TPU
• load delta draft
• load TrueHeave
• close track lines
• merge
• recompute towfish navigation
• slant range correction
While you can select a group of objects by holding down the 
<Ctrl> key while clicking on each object in turn, the following 
tools make selection of multiple objects easier.

Select by Range

Select one or more objects.
1. Select a layer in the Control window.

2. Choose the Select by Range command.

3. Press and hold the mouse button while dragging the cursor to define a 
rectangular area. 
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The selected objects from the layer are highlighted.

Select All in Display

Select objects that are totally or partially in the current viewing 
extent of the Display window.
This command is useful for selecting a single object or group of 
objects in an enlarged section of the Display window. 
1. Select a layer in the Control window that contains the objects you want 

to select.

2. Use the zoom tool to enlarge a section of the Display window
(see “ZOOM” ON PAGE 39).

3. Choose a Select All in Display command.

Objects that cross or are within the current view of the Display 
window are highlighted.

Select All

Select all objects in a layer.
1. Select a layer in the Control window that contains the objects you want 

to select.

2. Choose the Select All command.

All objects are highlighted.

Select By Lasso

In the Swath Editor, Subset, Navigation and Attitude Editors, 
use the By Lasso tool to select objects by enclosing an area. 
The area is defined by the mouse in one of two ways: either by 
dragging the mouse around the area to be selected or by 
inserting a series of points to create an outline. All objects inside 
the defined area are selected when the lasso is closed.

Use Lasso in editors 1. Select the Lasso command.

2. Click and drag the mouse in any of the editor windows. The lasso 
outline is updated as you move the mouse, 
OR
repeatedly click the left mouse button in the editor window to define a 
point-to-point outline.  
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Note: These two modes can be used together in the editor 
windows.
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To complete the selection area, you must close the lasso outline. 
This can be done in one of three ways:

• release the left mouse button and right-click. 

• select Close Lasso from the Select menu 

• press the letter C key.

The first and last points will be connected and the lasso shape 
will be closed. The objects within the enclosed area are selected.

Use Lasso in Display 
window

To use the lasso tool to select objects in the Display window: 
1. Select the layer in the Control window that contains the objects you 

want to select.

2. Select the Lasso command.

3. Use the mouse to insert a series of points around the area in the 
Display window that you want to select.

The points are connected by a line as you continue clicking. 
When you have outlined the area:
4. Press <C> to close the lasso outline.

Select Next Line

Select track lines by ascending file order. This command is 
enabled only when the Attitude, Navigation, Swath and Single 
Beam Editors are open.
The file order can be sorted according to time or name by right-
clicking in the Display window and selecting Sort > By Name/
By Time from the pop-up menu. 
1. Select the Next Line command.

The track line directly below the currently selected line in the 
project data tree is highlighted.

Select Previous Line

Select track lines by descending file order. This command is 
enabled only when the Attitude, Navigation, Swath and Single 
Beam Editors are open.
The file order can be sorted according to time or name by right-
clicking in the Display window and selecting Sort > By Name/
By Time from the pop-up menu.
1. Select the Previous Line command.

When you select the command, the track line directly above the 
currently selected line in the project data tree is highlighted.
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Select Lines From the Control Window
1. Make sure the Control window is open.

2. Select the Project tab.

3. Click a track line file so it is highlighted.

The track line in the Display window is highlighted.
You can also select more than one file.
• To select a Project, Vessel or Day folder, click the folder. All 

files in that folder are highlighted.
• To select multiple files, press and hold the <Ctrl> key while 

clicking the files with the mouse.
• To select a range of files, click the first file in the range, press 

and hold the <Shift> key while clicking the last file in the set. 
This highlights all adjacent files between the first and last 
file.

Clear All

Deselect track lines or objects.
1. Select the Clear All command, or click anywhere in the display away 

from the lines.

The previously selected track lines or objects are no longer 
highlighted.
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Screen Captures

You can take a screen capture of the current display in the 
Display window or 3D Display window and save it as an 8-bit or 
24-bit GeoTiff image.
1. Right-click in the Display window or 3D Display window and select a 

Save Image command.

The Save As dialog box is displayed.
2. Select a directory for saving the image.

3. Type a name for the image in the File Name field.

4. Select to either save the image as an 8-bit or 24-bit image by selecting 
the appropriate option.

5. Select a Dots Per Inch (DPI) setting from the drop-down list.

The file size of the image is shown in the dialog box. If you select 
a large dpi setting, the image is resampled to that setting.
6. Click Save.

The image is saved to the selected directory.
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3D Display Window

The 3D Display window shows project-level information in three 
dimensions. Turn layers on and off in the Layers tab to 
determine which data will be displayed in the 3D display.
Data layers that are viewable in the HIPS and SIPS Display 
window can be viewed in 3D. This includes attribute layers for 
BASE Surfaces,vector data and background images such as 
GeoTiffs. 
The 3D Display is enhanced with a “fly-through” effect that gives 
the effect of gliding through the display. With practice 
manipulating the fly-through controls, you will be able to zoom 
and pan seamlessly in this 3D window.
To activate the 3D Display window, 
1. Select the 3D Display command or tool button.

The 3D Display is shown in the Display window and the 3D 
Scene tab replaces the Draw Order tab in the Control window.
 

Tools panel 

Control axes (compass)

Colour legend

Controller panel 
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Each type of data displayed in the 3D Display has its own layer 
in the 3D Scene tab.
• The Grid layer contains data for the surface being displayed.
• The Draped Images layer contains the data for all draped 

images.
• The Axes layer contains the Terrain Axes for the surface. The 

Terrain Axes (displayed as an x,y,z grid) are only visible when 
turned on in Tools > Options.(See “3D DISPLAY” ON PAGE 659.) 

• The Vector Data layer contains all vector data.
• The Image layer contains data for open raster images.

Select data for display 2. Adjust the content of the 3D Display by turning layers on or off in the 
Layers tab. Any layer that cannot be displayed is greyed out.
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Moving your mouse over the data will display a tooltip which 
gives the name of the data source and the value at the current 
location (based on the layer selected in the Layers tab).
The coordinates of the current location are displayed in the 
status bar. Also displayed in the status bar is the depth value for 
the surface, based on the camera depth.

View Background Images

If you have background images to accompany the surface data, 
they can also be displayed in the 3D Display.
1. In the Layers tab, click the image layer check box to enable the image.

2. The Image Options dialog box is displayed.

The Elevation field allows you to specify the height at which the 
image sits on the surface.
3. Type a value if you would like the image displayed at a particular 

elevation.

The Clip to terrain option allows you to display only the part of the 
image that is within the extents of the surface.
4. Select the Clip to terrain check box to limit the display of the image.

The image is added to the 3D Display, and listed in the 3D Scene 
tab.
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3D View Properties

The display in the 3D View can be adjusted using properties 
available for each type of data that can be displayed. Selecting a 
layer in the Layers tab will display the properties in the 
Properties window. Refer to the following sections for 
information on the available properties:
• “SURFACE DATA” ON PAGE 50

• “VECTOR DATA” ON PAGE 51

• “RASTER DATA” ON PAGE 53

Surface Data
1. Select the displayed attribute layer in the Layers tab to view the 

available properties in the Properties window. 

The Visible property allows you to have the data open and 
included in calculations, without actually having it displayed. 
This frees up resources to speed up processing time. By default 
this option is set to True.
1. Click the Visible check box to display the selected image, if desired. 

The Quality property allows you to display the surface using a 
finer or coarser resolution. The default setting is Normal.
2. Select the Quality property and select an option from the drop-down list.

Filter Properties The Filter properties can be used to filter data displayed in 3D.
3. Enable the FIlter property by clicking the check box. 

The value will change to True.
4. Enter the Min and Max Value of the data you want displayed.

5. Refresh the display.

M
en

u

View > Refresh (F5)

To
ol



CARIS HIPS and SIPS User’s Guide 51

The HIPS & SIPS Interface: 3D Display Window

Only data that falls within the range of the Min and Max values 
will be displayed.

Colour Properties Colour properties enable you to adjust the colour range used to 
colour the displayed data. (See also “COLOUR RANGE” ON PAGE 56.) 
6. Enter the Min and Max Values to be covered by the colour range.

Using the Colour By property, you can choose which attribute will 
be used as the source data for colouring the display.
7. Select an option from the Colour By drop-down list.

The display is updated to match the selected properties.

Vector Data
1. Select a vector data layer in the Layers tab while the 3D Display is 

active, to display its properties in the Properties window. 

The Visible property allows you to have the data open and 
included in calculations, without using resources to actually 
have it displayed. By default this option is set to True.
2. Click the Visible check box to display the selected image, if necessary.

When visible, you have the option of draping data over the 
surface, so you can accurately view contours and other vector 
data.
3. Expand the Drape property and in the Method field, select one of the 

folliowing three options:

• None: Data is displayed according to the Default Elevation 
property. With this option, all vector data will be on a level 
plane unless the data contains its own Z value. The Elevation 
defines the height at which the data sits above the surface. 

• Drape: Data is draped using the bathymetry of the surface 
and the Offset property. The bathymetry will apply the proper 

The other Draping properties are disabled when None is 
selected as the method.
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Z value to the data and the Offset will define the height at 
which it sits above the surface.

• Drape (use line splitting): Data is draped using the same 
values as the Drape method, but line segments are adjusted 
in length based on the Max segment length property. A larger 
segment length means less vertices and faster processing 
times. A smaller segment length means more vertices and 
slower processing times, but a more accurate representation 
of the elevations.

4. Choose an option from the drop-down list.

5. Depending on the selected method, enter any necessary values in the 
other properties. 

The image is draped over the surface.

6. [Optional] If the image extends beyond the extents of the data, select 
the Clip to terrain check box to only show the section of the image within 
the surface extents.

You can also perform the opposite of the drape function where 
the image is cut away according to the bounding polygon of the 
surface. This allows you to view a background chart image with 
the actual surface visible within the chart.
To cut the image:
7. In the Layers tab, right-click the image layer, select Cut Terrain, then 

select the name of the surface with which you want to cut the image.

The Max segment length property is only enabled when the 
Drape (use line splitting) method is selected.

Data that extends beyond the extents of the surface will be 
displayed according the Default Elevation value, regardless 
of the selected method.
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The image is cut and the gap is filled with the surface.

Raster Data
1. Select a raster data layer in the Layers tab while the 3D Display is 

active to display its properties in the Properties window. 

The Visible property allows you to have the data open and 
included in calculations, without using resources to actually 
have it displayed. This option is set to “True” by default.
2. Click the Visible check box to display the selected image, if necessary.

The Vertical Position property allows you to adjust the elevation of 
the image in the display so that it lines up with the surface 
properly.
3. [Optional] Enter a value in the Vertical Position field.

The Transparency property allows you to make the image 
transparent so the surface can be seen in relation to the image.
4. [Optional] Enter a value in the Transparency field.

The display is updated to match the selected properties.
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Draping Raster Data Raster images can also be draped over a surface using the 
bathymetry of the surface, but using a slightly different method 
than vector data. 
To drape a raster image:
1. Open a raster image.

2. Select the attribute layer in the Layers tab that you want to use to 
define the draping elevation.

3. Right-click the attribute layer, then select Drape Image and then the 
name of the raster image to be draped.

The image is draped over the surface and a sublayer is added to 
the Layers tab for the draped image.
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Adjusting the Display

In addition to defining properties, there are various tools within 
the 3D View that also allow you to adjust the display of data. 
Refer to the following sections for information on the tools:
• “LIGHTING” ON PAGE 55

• “VERTICAL EXAGGERATION” ON PAGE 55

• “COLOUR RANGE” ON PAGE 56

Lighting

The lighting control handles shading effects by controlling the 
position and angle of the light. The elevation value (displayed 
when the tool is selected) varies from 0º to 90º starting from the 
middle of a sundial. The azimuth value (also displayed when 
selected) varies from 0º to 360º in a clockwise direction.  
1. To access the Lighting Control, click the Light Control button in the 

Tools panel located in the top-left corner of the 3D Display.

The Lighting tool displays the current azimuth and elevation 
values.

2. Click and drag the ball to change the lighting.

As you drag, the values in the tool will be updated and you can 
see the affect on the data.
3. Release the mouse when the display has the proper lighting.

4. To close the tool, click the X in the top-right corner of the box.

5. To re-open the lighting tool, click the lightbulb.

Vertical Exaggeration

Use the Vertical Exaggeration tool to increase or decrease the 
vertical exaggeration of the data to display seabed features more 
clearly. 
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1. To access the Vertical Exaggeration tool, click the middle button in the 
Tools panel located in the top-left corner of the 3D Display.

The tool activates and a slider bar is displayed below the Tools 
panel.

2. Click the arrow on the side of the slider and move it up or down the bar.

As you move the arrow, note the change in the display.
3. Release the arrow when the data has the appropriate vertical 

exaggeration.

4. To close the tool, click the X in the top-right corner of the box.

Colour Range

Use the colour legend slider bar located along the right side of 
the 3D Display to adjust the colour range. 
The legend can be turned on or off using the Colour Legend 
button in the top-right corner of the 3D View. When the button 
is coloured, the legend is turned on and available for use. 
The arrows on the side of the legend represent the 
Min and Max Values of the colour range. 
To change the colour range using the colour legend:
1. Select the arrow at the top or bottom of the legend.

2. Drag the arrow to the desired Min or Max value.

The colours in the display will change as you drag 
the arrow.
3. To reverse the colours, drag one arrow past the opposite 

arrow and adjust the opposite arrow as needed.
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Navigate the 3D Display

In the 3D Display window, you can zoom and pan to create a 
flying effect over the display, which can be used to record a fly-
through.
The flying effect is accomplished using the Controller panel, the 
mouse or the keyboard.
The Controller panel consists of a directional pad and slider 
controls used to modify the view and perform a fly-through. 
The Controller panel can be turned on or off using the Controller 
Panel button in the top-right corner of the 3D View. When the 
button is coloured, the panel is turned on and available for use. 
When turned on but not in use, the panel becomes transparent 
so as not to obstruct the view of the data.
The Controller panel contains the following controls:

To “fly” using the mouse, press and hold one or both of the mouse 
buttons while simultaneously moving the mouse pointer in the 
direction you want to move.
To fly using the keyboard, press the <Arrow> key for the 
direction you wish to move the display.
When using the mouse to navigate, the speed you travel through 
the display or pan the view varies with the cursor’s distance 
from the centre (stationary) point.
The position of the cursor in the display indicates the direction 
you will move. The mouse button determines what operations 
are available.
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Control Axes

The Control axes, sometimes called compass controls, are 
displayed as an overlay to the surface, and enable you to rotate 
the view along the X, Y, or Z axis. 

1. To show or hide the control axes, click the Axis button  

on the 3D toobar, or double-click on the surface in the Display.

2. Select the end points of the axes to manipulate the view.

• To rotate the view of the surface horizontally, click and hold the left 
mouse button on the end of the X or Y axis and move the mouse to 
the left or right of the Z axis in the display.

• To rotate the view of the surface vertically, click and hold the left 
mouse button on the end of the Z axis and move the mouse up or 
down in the display.

 

Rotate horizontally Rotate vertically
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3D Flight Path

You can make and save movies of a 3D fly-through for playback 
at a later time. The controls for creation and playback are 
located in the 3D Display Tools panel and the 3D Flight Path 
submenu. 

Instructions for using these tools are provided in the following 
sections:
• “RECORD A FLIGHT” ON PAGE 59

• “PLAY A FLIGHT” ON PAGE 60

• “LOAD AN EXISTING FLIGHT” ON PAGE 60

• “SAVE A FLIGHT” ON PAGE 60

• “EXPORT A FLIGHT TO VIDEO” ON PAGE 61

Record a Flight

To record a fly-through:
1. Select a layer in the Layers tab to display in the 3D Display.

2. Adjust the view to display the starting point for your fly-through.

3. Select the Record command.

The Record button will change to red to indicate that you are 
now recording.
4. Use the controls to navigate through the 3D Display. See “NAVIGATE THE 

3D DISPLAY” ON PAGE 57 for information on navigating. 

All movements in the Display window are recorded.
5. To stop recording, select the Record command again or select the 

Stop command.

The Record button will return to the inactive state and your 
fly-through is recorded and ready for playback.
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Play a Flight

To playback a recorded fly-through:
1. Select the Play command.

The fly-through will begin to play. As it does so, the arrow on the 
slider bar will move from left to right and the counter at the end 
of the slider bar will count down, indicating the progress of the 
fly-through. The slider bar can also be used to go forward or 
backward in the recording.
2. [Optional] Click the arrow on the slider bar and drag it to the left or right 

to go forward or backward in the recording.

You can pause the playback if necessary without stopping it 
altogether.
3. [Optional] Select the Pause command to pause the playback.

The Pause button will be coloured to indicate that playback has 
been paused. Both the Pause and Play commands can be used to 
resume playback after the Pause command has been selected.
4. To stop the playback, either select the Play command again, or select 

the Stop command. Otherwise, playback stops when you reach the 
end of the recording.

Load an Existing Flight

If you have saved a fly-through to a file, that file can be loaded 
and played in the 3D View at anytime.
To load an existing flight:
1. Open the 3D Display.

2. Select the Load from File command.

A standard Windows Open dialog box is displayed. 
3. Navigate to the flight file and click Open.

The fly-through is loaded into the 3D View and the flight path 
controls are available.

Save a Flight

Once you have finished recording a fly-through, you can save it 
to an XML file that can be viewed in HIPS and SIPS at any time. 
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To save a flight to an XML file:
1. Record the fly-through.

2. Select the Save to File command.

A standard Windows Save As dialog box is displayed. 
3. Select a location for the file and enter a File name.

4. Click Save.

The flight is saved as an XML file in the selected location with 
the specified name.

Export a Flight to Video

If you do not export your recording, it can only be re-opened in 
HIPS and SIPS, but an exported recording can be opened in any 
standard media player. 
To record a movie of your fly-through:
1. Open or create a fly-through.

2. Select the Export to Video command.

The Record Movie dialog box is displayed.

3. Choose the format of the video file. If you selected AVI format, go to 
step 6. If you selected WMV format, continue with the next step.

You may select a bitrate for the recorded data as a variable or a 
constant value. 
• Variable Bitrate records the video using a fluctuating bitrate, 

which is based on a user-defined average quality level. 
During encoding, the bitrate will fluctuate to ensure the video 
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is created with the highest possible quality while maintaining 
the specified average.

• Constant Bitrate records the video using a user-defined 
number of kilo-bits per second. This option ensures that a 
constant bitrate is used during encoding, but may result in a 
lower quality video. 

4. Select a bitrate option.

5. If you selected Variable Bitrate, enter the average quality level for the 
resulting video and go to step 7.

OR

If you selected Constant Bitrate, enter the number of kilo-bits per 
second to use to record the video and go to step 7.

6. [Optional] To see the advanced playback options for your AVI movie 
before it is saved, select the Show Advanced Options option.

You must select image size and FPS (Frames-Per-Second) options 
for the playback of your movie.
7. Select a Size option.

8. Select an FPS option.

9. To select the save name and location for your movie file, click the 
Browse button (...).

A Save As dialog box is displayed.
10.Type a save name.

11.Select a save folder.

12.Click Save.

The Save As dialog box is closed, returning you to the Record 
Movie dialog box.
13.If you clicked the WMV format option, click Save and go to step 19;

OR,

if you clicked the AVI format option, click Save and continue with the 
next step.

Video Compression The Video Compression dialog box is displayed.
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14.Select a Compressor.

15.Use the slider control to select the compression quality (displayed as a 
value in the range of 0 and 100 percent).

16.[Optional] To insert key frames, select the Key Frame option and type a 
frames value.

17.[Optional] To set the data rate, select the Data Rate option and type a 
KB/sec (kilobits per second) value.

With some compressors, you can also choose the configuration 
settings to use for your AVI movie.
18.[Optional] To configure the selected compressor, click Configure and 

select from the available configuration options.

19.Click OK.

A message is displayed stating that the file was saved.
20.To finish, click OK.

The process is finished. 

Some video compressors do not allow you to set the 
following options (in steps 14 to 17) for your movie files.
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Cut, Copy and Paste

The Cut, Copy and Paste commands are useful for manipulating 
files in the Control window. These commands are similar to 
those used in other Windows applications.

Cut

The Cut command moves selected Vessel, Day, or Line folders to 
the clipboard.
1. Select the object you want to cut.

2. Select the Cut command.

The file names in the Control window are dimmed.
3. You can undo the Cut command by pressing the <Esc> key.

Copy

The Copy command reproduces the selected object without 
removing it from the Control window.
1. Click the object you want to copy.

2. Select the Copy command.

3. To copy data from the Query tab to the clipboard, use the 
Select All command on the right-click menu. The data can 
then be placed in another application.

Paste

The Paste command takes an object that has been cut or copied 
and places it in another location.
1. Make sure you have cut or copied an object.

2. Place the cursor at the location you want to place the object.

3. Select the Paste command.

The object is pasted into the application at the selected location.

NOTE: Line folders can only be moved or copied between 
Day folders and Day folders can only be moved or copied 
between Vessel folders.
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Measure Distance

Measure the distance between two points in a survey area or in 
the 2-D Subset View. 
The distance is shown in the units you selected in the Display 
tab of the Tools > Options dialog box (see “UNITS” ON PAGE 673).
1. Select the Measure Distance command.

The Measure Distance cursor icon is displayed.
2. Press and hold the mouse button and drag the cursor along 

the Display window.

As the cursor is dragged across the window, a line is drawn from 
the start point to the point where the mouse button is released. 
The distance between the two points is shown along the line.
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Set Keyboard Shortcuts

You can customize existing shortcuts, or create a new shortcut 
for a menu command that does not possess one. The keyboard 
shortcut definitions are stored in …\\Hips\bin\Hips.mac. 
1. Select the Shortcut Keys command.

The Shortcut Keys dialog box is displayed.

2. Click a menu command in the Select a Macro list box.

• If the command already has a shortcut, the keys are displayed in 
the Assigned Shortcuts box. A brief explanation of the shortcut is 
displayed in Description field. 

• If the command does not have a shortcut then these two sections 
are empty.

Modify existing 
shortcuts

3. To delete an existing shortcut, highlight the shortcut in the Assigned 
Shortcuts area and click Remove.

The shortcut is no longer active in the project.
Create a new shortcut You can create a new shortcut to replace a current one or create 

shortcuts for commands without any.
4. Click Create Shortcut.

The Assign Shortcut dialog box is displayed.
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You can create a shortcut using function keys, control keys or 
regular keys. You can also combine keys.
5. Type a new shortcut in the text area. As you type the keys are 

displayed in the text area. Already assigned shortcuts are displayed 
below the text box.

6. Once you have selected the key(s), click OK to close the dialog box.

The shortcut is displayed in the Shortcut Keys dialog box.
7. If you want to restore previous shortcuts, click Reset All.

The new shortcut is deleted and the previous default command 
is re-assigned.
8. Click OK to save the settings and close the dialog box.
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Save, Close and Exit

Save Projects

Save changes to data after cleaning or when the display in a 
session file is changed.
1. Select the Save command.

You can automatically save data-cleaning changes at regular 
intervals by selecting the Auto Save option (see “GENERAL” ON 
PAGE 77). 

Close a Project
1. Select the Close Project command, or click the Windows close icon on 

the top right corner of the window.

You are prompted to save any changes.
2. Click OK to save changes.

Close individual track 
lines

1. Select a track line file in the Control window, or select a track line in the 
Display window.

2. Right-click the mouse and select a Close Lines command.

The track line closes.

Exit HIPS and SIPS
1. Choose the Exit command.

2. You are prompted to save any changes, if necessary.

3. Click OK.

HIPS and SIPS is closed.
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Workflow in HIPS & SIPS

The workflow described here uses multibeam data and CUBE to illustrate 
a way of processing data in HIPS and SIPS. This workflow will take you 
through the steps from raw data to the creation of a contoured product 
surface and the publishing or export of cleaned data.

In this chapter...

“WORKFLOW” ON PAGE 70

“HIPS VESSEL FILES” ON PAGE 73

“WORKING WITH PROJECTS” ON PAGE 74

“SESSION FILES” ON PAGE 75
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Since some data does not require all processing steps and some 
can require repetition of one or more steps to produce a final 
product, the general workflow can be adapted to specific 
situations and data types. 
While the order in which certain functions are performed is 
important, many of the functions can be automated, one at a time 
or with the Batch Processor (see “BATCH PROCESSING” ON PAGE 487).

Brief description of workflow stages

• Create a Vessel File: Set up or edit vessel information about 
sensor locations and uncertainties. See “CREATE A NEW HVF” ON 
PAGE 81

• Create a new project: Set up the Project - Vessel - Day data 
structure. See “DEFINE NEW PROJECT” ON PAGE 116

• Convert raw data: Convert data into HIPS data format using 
automated process. See “CONVERT DATA” ON PAGE 131

• Save session: Save the current workspace (data and current 
view). See “SESSION FILES” ON PAGE 75

• [Optional] Sound Velocity Correction (SVC): Load and edit 
sound velocity profiles and apply the correction. See “SOUND 
VELOCITY CORRECTION” ON PAGE 171 

• Load tide: Load tide data from one or more tide stations to 
correct for tide variance. See “LOAD TIDE” ON PAGE 176

• Merge: Combine vertical and horizontal information to 
produce geo-referenced data. If changes are made to the 
navigation and/or motion data though the QC process l 
further on, the Merge process is re-applied. 

• Compute Total Propagated Uncertainty (TPU): Use 
uncertainty values entered in the HVF to compute the total 
propagated error of each individual sounding. See “COMPUTE 
TPU” ON PAGE 201

Workflows to process Side Scan, Singlebeam and Lidar 
data are described in the HIPS and SIPS Quick Reference 
guides. See also :

“USING SIDE SCAN EDITOR” ON PAGE 404

“PROCESSING SINGLE BEAM DATA” ON PAGE 463

“LIDAR DATA IN HIPS” ON PAGE 479
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• Define new field sheets: Organize dataset into manageable 
areas with defined locations and map projection. See “CREATE A 
FIELD SHEET” ON PAGE 210 

• Generate a Bathymetry Associated with Statistical Error 
(BASE) Surface: Either a Swath Angle, Uncertainty or CUBE 
surface from data contained in field sheet. See “CREATE BASE 
SURFACE” ON PAGE 226

• Generate a Combined Uncertainty and Bathymetry 
Estimator (CUBE) Surface: Use merged data to produce a 
CUBE surface. 

• Data QC: Examine and edit sensor data, such as navigation, 
gyro, heave, if problems have been identified in the BASE 
(CUBE) surface.

• Filtering: Use automated or manual tools to filter soundings 
using swath geometry and/or according to IHO survey order 
accuracies.

• Process Subset Data: Validate the CUBE surface and edit 
geo-referenced soundings directly, on many lines 
simultaneously, where the CUBE surface has been adversely 
affected by erroneous soundings.

• Finalize BASE Surface: Update the validated BASE Surface 
after data has been edited, and ensure designated soundings 
are carried through to bathymetric products.

• [Optional] Create Product Surface: Produce a generalized 
product surface from the BASE Surface. 

• Contours: Use automated functions with either the BASE 
Surface or product surface to output contours. (Contours can 
also be generated manually from tiles.)

• Sounding Selection: Use a height source for selection of a 
representative sounding set.

• Plot Composer: publish HIPS and SIPS data and product 
surfaces. 

• Export Data: Soundings and surfaces can be exported to 
various formats for data transfer (e.g., S-57).
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HIPS Vessel Files

All HIPS and SIPS projects must contain a HIPS Vessel File 
(HVF). The HVF describes the installation and calibration of 
equipment installed on the survey vessel. The information in the 
HVF is used in multiple processes including merging, 
mosaicking, and calculating sounding uncertainty.  

The HVF can be created or modified through the HIPS Vessel 
Editor. The Vessel Editor is a separate application that is 
launched from the HIPS interface. See “CREATE A NEW HVF” ON 
PAGE 81. 

A vessel file must exist prior to creating a new project in 
HIPS and SIPS.
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Working with Projects 

Every project in HIPS and SIPS is organized in a Project-Vessel-
Day folder hierarchy. New projects are created with a wizard, 
which generates a HIPS Project File (.hpf). 
A project can be created with new Project-Vessel-Day folders, or 
new Vessel-Day folders can be added to an existing project. Day 
and Line folders can be renamed, or taken out of the active 
project or deleted outright. (See “DEFINE NEW PROJECT” ON PAGE 116.)
Projects can also be archived. (See “ARCHIVE PROJECT” ON PAGE 124.)
All projects must contain a vessel file. (See “DEFINE VESSEL FILE” ON 
PAGE 104). If your raw data files are set up in a Project/Vessel/
Day/Line structure and a HIPS Vessel File exists for that data, 
you can skip this step and use the Conversion wizard to create 
the HIPS directory structure. (See “RAW DATA” ON PAGE 101 and 
“RENAME DAY AND LINE FOLDERS” ON PAGE 114 for more information.)
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Session Files

Session files are used for re-opening all data that was processed 
the last time the project was open. The data types that are 
recorded in the session file include:
• lines
• field sheets
• background data
• last geographic view extents of the Display window
All session files have an .hsf file extension and are stored by 
default in …\Hips\Session. The previous format of the session 
file (.ses) can be opened and automatically upgraded to the new 
session file format.

Save a session

1. Select the Save Session command, or select the Save Session As 
command if the session has not been saved before, or if you want to 
save an existing session under a new name.

• If this is an already saved file, the program re-saves the existing .hsf 
file.

• If this is a new file, then the Save As dialog box is displayed. Select 
a folder where you want to save the .hsf file and type a name in the 
File Name text box.

If a project contains a large number of track lines, you can make 
data processing more manageable and reduce the time it takes 
to load data into the application by selecting specific track lines 
for a session file.
1. Select the track lines you want to save in the session file.

2. Choose the Save Session As command and select the 
Save Selected Lines Only check box.

3. Type a name for the session file and click Save.

The Session file is saved.
Open a session

1. Select the Open Session command.

The Open Session File dialog box is displayed.
2. Select a session file.

3. Click Open.

The data listed in the Session file is opened and the layers are 
shown in the Session tab in the Control window.
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Close a session

1. Select the Close Session command.

If you have made changes to the session since the last save, you 
are prompted to save the current changes.
2. Click OK.

Add Session Files While a session file is open, you can display data from another 
session file in the already open one.
1. Select the Add Session command.

The standard Open dialog box is displayed.
2. Select a directory and file.

3. Click Open.

The file is opened in the application.
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Convert Survey Data

HIPS and SIPS files are created from survey data using the 
Conversion Wizard. The Conversion Wizard is a separate 
application that is launched from the HIPS and SIPS interface. 
Survey data converted to HIPS and SIPS format is in varying 
stages of completion—depending on the data format options. 
Data may or may not have been corrected for factors like heave/
pitch/roll or sound velocity.
All HIPS/SIPS data is organized in a Project-Vessel-Day-Line 
directory structure. If you organize the survey data according to 
this structure, you can convert line data from an entire Project 
or multiple Vessel and Day folders contained in a common 
Project folder. See “PROJECTS” ON PAGE 99 and “RAW DATA” ON PAGE 101 
for more information.
When entire project data has been converted, a Project-Vessel-
Day-Line directory is created for the converted data. If there is 
already a Project folder that is identical to the preprocess folder, 
then the line data in the existing folder is over-written with the 
new data. 

1. Select the Conversion Wizard command in the HIPS and SIPS main 
interface.

The Conversion Wizard is displayed.

For more information on how to use the Conversion Wizard, see 
“CONVERTING FILES TO HIPS/SIPS FORMAT” ON PAGE 132.

You must organize your raw data files in a HIPS/SIPS 
Project-Vessel-Day structure to convert complete Project, 
Vessel and/or Day data files.
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Generic Data Parser

HIPS can convert almost any single beam ASCII file through the 
Generic Data Parser. The parser can also add or replace any 
sensor data in an existing project—except swath and sweep 
bathymetry, and side scan imagery.
For example, if high-precision positions were obtained from a 
source other than the original raw data files converted into 
HIPS, this data could be loaded into an existing project to 
replace the original navigation data. The new position data must 
have a time stamp and be in ASCII format.
The Generic Data Parser is a separate program launched from 
the main HIPS and SIPS interface.
1. Select the Generic Data Parser command.

The Generic Data Parser is displayed.
For more information on the Generic Data Parser, see the help 
file associated with the application.
.
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Create Vessel File

The HIPS Vessel file (HVF) defines the offset configurations and 
associated error estimates for each of the sensors, which are necessary 
for creating final position and depth records for survey data. 

The HIPS and SIPS workflow begins with creating an HVF, and if 
necessary, editing the sensor configuration data. 

In this chapter...
“VESSEL FILES” ON PAGE 80
“CREATE A NEW HVF” ON PAGE 81
“EDIT SENSOR CONFIGURATION” ON PAGE 92
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Vessel Files

The Vessel file (HVF) in HIPS and SIPS describes the location 
and calibration of sensor equipment installed on the survey 
vessel. Written in Extensible Mark-up Language (XML), it 
defines the offsets and any associated error estimates for each of 
the sensors. The HVF is created in the HIPS Vessel Editor. 

The HVF is divided into a number of distinct sections, each 
describing one type of sensor. The sections are time-tagged and 
multiple entries can be defined for different time periods. These 
entries can be edited in the Vessel Editor. 
During the Merge process, corrected sensor data is combined 
with the observed data to create a final position/depth record.
The HVF for a ship is stored in the default directory 
…\Hips\HDCS_Data\VesselConfig. 
 

NOTE: In previous versions of HIPS and SIPS, a text file 
called the Vessel Configuration File (VCF) was used. 
VCF files can still be opened in the Vessel Editor and 
edited, but when the file is re-saved it is converted to 
HVF format.
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Create a New HVF

A vessel file is created in the HIPS Vessel Editor, which is a 
separate application launched from the HIPS andSIPS interface. 
(For a description of the Vessel Editor and its properties, see 
“VESSEL EDITOR INTERFACE” ON PAGE 550.)
There are four main steps to creating and configuring a HIPS 
Vessel file in the Vessel Editor:
• Open the HIPS and SIPS Vessel wizard to enter the 

parameters for the file, based on the type of data being 
surveyed. 

• Enter sensor position data using a 3D outline for the vessel. 
(See “CREATE VESSEL OUTLINE” ON PAGE 89.)

• Enter additional information such as the ellipsoid used in the 
survey. (See “DEFAULT ELLIPSOID” ON PAGE 91.)

• Enter and edit sensor configuration data. (See “EDIT SENSOR 
CONFIGURATION” ON PAGE 92.)

To create a new HIPS vessel file:
1. Open the Vessel Editor from the HIPS and SIPS interface. 
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In the Vessel Editor, 
2. Select the New Vessel File command.

The Vessel Wizard - Step 1 dialog box is displayed.
(The content of the dialog boxes that are then displayed is 
contingent on the type of sonar used in the survey.)

Vessel Information

1. Type a name similar to the vessel used in the survey. Make sure the 
name does not include any spaces.

2. Click the Calendar button to insert the year and date from which the 
vessel file is valid.

3. Click Next to open the next dialog box: “TYPE OF SURVEY” ON PAGE 84.
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Type of Survey

The second dialog box prompts you to enter the sonar type used 
in the survey.

There are four sonar types:
• Singlebeam

• Multibeam

• Multi-transducer

• Side Scan Sonar

1. Select a sonar type by clicking the appropriate check box.

2. Click Next to go to the next step in the Vessel Wizard, 

or, 
if you selected Side Scan Sonar, click Finish.

Single Beam    

If you select Single Beam as the type of survey data in Step 2, 
then the remaining steps in the creation of a new HVF are 
“MOTION SENSORS” ON PAGE 87 and “CONFIGURATION OPTIONS” ON PAGE 88.   
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Multibeam

If you selected Multibeam in the Step 2 dialog box, Step 3 will 
ask you for information on the sonar model and number of 
transducers.
 

1. Select the appropriate check box to indicate that one or two 
transducers were used in the survey.

2. Enter the number of beams in each transducer.

3. Select the sonar model.

4. Click Next to continue.

Multi-Transducer

If you selected Multi-transducer in the Step 2 dialog box, you 
will now be asked for information on the number and types of 
transducers and for TPU specific parameters. 
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1. Enter the Number of Transducers on a boom.

2. Select Yes if the transducers are mounted to a fixed boom or to the hull 
of the vessel, or select No if the transducers are on a movable 
(decoupled) boom.

3. Type the default Alongtrack value of all the transducers relative to the 
ship's reference point.

4. Type the default Depth of all the transducers relative to the ship's 
Reference Point.

5. Select the sonar model from the Model drop-down list.

The following parameters are necessary to calculate Total  
Propagated Uncertainty.
6. Type the distances from the positioning system to the centre of the 

boom in the Navigation to Boom X-Y-Z fields.

7. Type the distance from the motion recording unit to the centre of the 
boom in the MRU to Boom X-Y-Z fields.

The Roll and Gyro misalignment values are needed for fixed-boom 
system. However, for a decoupled boom, only a Gyro 
misalignment value is needed.
The Squat and Heave percentage values are transducer responses 
to overall heave and squat. For fixed-boom transducers this 
should be 100% and less than 100% for decoupled-boom 
transducers.
8. Type a degree offset in the Roll and Gyro fields.

9. Type a percentage value in the Squat and Heave fields.

10.Click Next to open the dialog box for: “CONFIGURATION OPTIONS” ON 
PAGE 87. 
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Motion Sensors

This dialog box determines which attitude sensors are displayed 
in the HVF.

1. Create entries for any (or all) of the following sensors by clicking the 
appropriate box:

• heave

• pitch

• roll 

The Apply in Post Processing option means that the data is applied 
during the Merge process or during Sound Velocity Correction.
2. Click any of the check boxes if you want to apply the attitude sensor 

data in post processing.

3. Click Next.
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Configuration Options

The Configuration Options dialog box is displayed

This dialog box lets you enable three options:
• the SVP (Sound Velocity Profile) pole parameters
• dynamic draft values
• waterline height variation
1. To include sound velocity corrections, click the Define Parameters for 

Sound Velocity Corrections check box.

2. To apply dynamic draft values to vessel speeds, click the Apply 
Dynamic Draft check box.

A draft-versus-speed table is created in the Vessel Editor. You 
can enter values in this table once the vessel file is created.
3. If you want to apply long period variations in the waterline height in 

processing data, click the Define Vessel Waterline Height Variation 
check box.

4. Click the appropriate Apply in Post Processing check boxes, as 
needed.

5. If you selected the Define Parameters for Sound Velocity Corrections 
check box, click Next, or click Finish if did not select this option.

Sound Velocity Corrections

The Sound Velocity Corrections dialog box is displayed only if 
you selected the Define parameters for sound velocity corrections 
check box in the Configuration Options dialog box.
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This dialog box records any transducer pole offsets.
Transducer head offsets must be taken into account 
when the SVP is applied to the data.
1. Select the 180-degree Azimuth box if the transducer is reverse 

mounted.

2. If the transducer is mounted with a large roll offset for use under 
wharves or along banks, then select the Roll Offset check box 

3. Type the amount of offset (in degrees) in the Roll Offset box.

4. If the transducer is mounted with a large pitch offset such that it is 
pointed forward or backwards, then select the Pitch Offset check box.

5. Type the amount of offset (in degrees) in the Pitch Offset box.

6. Repeat the above steps for the second transducer if there are two 
poles.

7. Click Finish.

A new HIPS Vessel File is created. You can now create an 
outline for the vessel (see “CREATE VESSEL OUTLINE” ON PAGE 89). 
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Create Vessel Outline

The Vessel Shape command creates a 3-D outline of the vessel, 
from measurements you enter to define the length, width and 
height of the vessel, and the position of the reference point in the 
vessel.
You can also use the Vessel Shape command to revise an 
existing vessel outline.
1. Open the HVF if it is not already open.

2. Select the Vessel Shape command.

The Plan View Shape dialog box is used for entering width and 
length of the vessel.

1. Enter a width for the vessel (port to starboard).

2. Enter a length for the vessel (stern to the base of the bow).

3. Enter a length for the vessel (stern to the tip of the bow).

4. Click Next.

The Plan View PR dialog box is displayed. It is used to set the 
position of the Reference Point (RP). 
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1. Type the distance from the stern to RP.

2. Type the distance from the starboard side to the RP.

3. Click Next.

The Profile View Shape dialog box sets the height measurements 
for the vessel.

1. Type the height of the vessel.

2. Type the height of the vessel RP from the keel.

3. Click Finish.

The Vessel Editor displays the vessel outline. 
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Vessel Shape 3-D Controls

The outline displayed in the editor can be rotated, zoomed and 
panned using the compass, keyboard, and mouse.

Compass Rotation along the X-Y-Z axis is handled by moving the arrow 
heads at the ends of the compass.

1. To rotate the image along the Z-axis, click the middle arrow head and 
drag the cursor upward so that the image is rotated. The compass can 
be rotated 90º.

2. To rotate the image along the X-Y axis, click any of the other arrow 
heads and drag the arrow head in a left-right or up-down direction. The 
compass can be rotated 360º.

3. Alternatively, the image can be rotated in the horizontal plane by 
grabbing the Z-arrow, then pressing the <Ctrl> key and the left-mouse 
button and moving the cursor up and down in the view. Rotation around 
the Z-axis can be performed by pressing the <Shift> key and moving 
the cursor left and right in these windows.

Pan There are three pan options:
• To pan along the X-Y axis: place the cursor in the 3-D area, 

press the middle mouse button and drag the display to a new 
location.

• To pan along the Z-axis: place the cursor in the 3-D area, 
press and hold both the <Shift> key and middle mouse button 
and move the cursor in the window.

• To centre the 3-D Display window on a selected point: 
position the cursor over the point and click the middle mouse 
button.

Zoom The zoom option is similar to pan
1. Press and hold both the <Ctrl> key and right-mouse button while 

dragging the mouse up or down to zoom in or zoom out.

Z-axis rotation 
arrowhead
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Options Dialog Box
Default ellipsoid The HVF must contain the ellipsoid and datum used by the 

navigation system in the survey vessel, regardless of whether 
projection coordinates or geographic coordinates are stored in 
the data. 
The list of available ellipsoids is maintained in the datum.dat 
file referenced by the uslXdatum environment variable. By 
default, this file is located in the System directory.
Set the ellipsoid for a new vessel file to be the same as the one 
used in the survey. 

1. Select the Options command.

The Options dialog is displayed.
2. Select the Options - General tab.

3. Select an ellipsoid from the pull-down menu.

4. Click OK to close the dialog box.

The name of the ellipsoid is displayed in the Navigation section 
of the editor.

Colours The locations of sensors and other equipment are shown by 
colour markers. You can select another colour for a sensor 
marker.
1. Select the Options command.

The Options dialog box is displayed.
2. Select the Options - Colours tab.
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3. Select a colour from the pull-down palette, or create a custom colour 
from the standard Windows colour picker.

4. Click OK to activate the changes and close the Options dialog.
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Edit Sensor Configuration

The active sensors listed in the Vessel Editor are determined by 
the sensor parameters you selected when creating the vessel file. 
If you want to add data for a sensor not already included in the 
vessel file, you can add a sensor to the list and enter its data. 
You can also remove a sensor and its values from the vessel file. 

In general, if sensor offsets or calibration values have already 
been applied to logged data during data acquisition, then do not 
enter the same offsets and calibration parameters in the Vessel 
Editor. 
Also, if compensation for heave, pitch, and roll has already been 
made to the recorded sounding data during data acquisition, for 
example as in Simrad data, then it must not be applied again.

Toggle data fields To add or remove sensors from the list of active sensors,
 1. Select the Active Sensors command.

The Active Sensors dialog box is displayed.

If a box is checked, the sensor is included in the vessel file and 
displayed in the Editor table.

Active sensors Table of values related to the highlighted sensor.
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2. Make sure a sensor box is checked to enable the sensor, or cleared to 
remove the sensor.

3. Click OK.

The list is refreshed to show the selected active sensors.

Sensors

Different sensors can require specific edits applied to the 
parameter data. The following sections explain the individual 
sensor data fields. 
•



96 CARIS HIPS and SIPS User’s Guide

Create Vessel File: Edit Sensor Configuration

Swath

The swath sonar, also known as multibeam, typically has beams 
that are formed in a fan shape, radiating from the centre of the 
transducer. 
1. Click Swath 1 in the Sensors list box so the selection is highlighted and 

the swath data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of current swath time stamp.

• Time: The hour and minute of the current swath time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the transducer from the 
Reference Point (0).

• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.

• Z: The vertical distance of the transducer, positive into the water.

The Pitch, Roll and Yaw fields refer to misalignment of the 
transducer, during mounting, from the vessel coordinate system.

• Pitch: The offset is positive when rotating the transducer towards 
the bow (bow up).

• Roll: The offset is positive when rotating the transducer away from 
starboard (starboard down).

• Yaw: Indicates the horizontal rotational offset and is positive for a 
clockwise rotation.

• Manufacturer: The maker of the transducer.

• Model: The particular make of transducer. The model information is 
necessary for the calculation of Total  Propagated Uncertainty.

• Serial Number: The serial number of the transducer.
 

Since the Simrad data read into HIPS is already corrected, 
the Swath values in the HVF must be set as follows:
• The X/Y/Z offsets are zero because the Simrad data 

acquisition has already applied static draft and shifted the 
swath profile to the vessel reference point.

• The Roll / Pitch / Yaw transducer mounting rotations are 
typically zero because the Simrad data acquisition has 
already applied patch test calibration results.
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Navigation

The navigation section of the HVF describes the location of the 
navigation source (for example, antenna or motion sensor). This 
section is used as a link between the fixed positioning coordinate 
system and the instantaneous vessel coordinate system.
1. Click Navigation in the Sensors list box so the selection is highlighted 

and the navigation data fields are visible.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current navigation time stamp.

• Time: The hour and minute of the current navigation time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the navigation source from 
the Reference Point (0).

• X: The athwart-ship distance of the source, positive to starboard.

• Y: The along-ship distance of the source, positive towards the bow.

• Z: The vertical distance of the source, positive into the water.

• Ellipsoid: From the drop-down list, select the ellipsoid on which the 
navigation is based. The ellipsoid should be the same as the one 
used in the survey. 

• Manufacturer: The maker of the navigation equipment.

• Model: The particular make of navigation equipment.

• Serial Number: The serial number of the navigation equipment.

Gyro

The gyro sensor refers to any device providing a heading 
orientation of the vessel.
1. Click Gyro in the Sensors list box so the selection is highlighted and the 

gyro data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current gyro sensor time 
stamp.

• Time: The hour and minute of the gyro sensor time stamp.

• Time Correction: The time correction value.

The Gyro Error is measured in degrees and is the difference 
between the recorded sensor value and the applied heading of 
the vessel: Applied Heading = Recorded value - Gyro 
Error.
3. Click an Edit button in the Error column to open the Gyro Error Table.
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4. Type new values in the Gyro or Error fields and click OK to close the 
dialog box.

5. Type data (as needed) in the following fields.

• Manufacturer: The maker of the sensor equipment.

• Model: The particular make of sensor equipment.

• Serial Number: The serial number of the sensor equipment.

Heave

The heave sensor records the vertical motion of the vessel. 
Although the heave sensor has its own section in the Vessel 
Editor, it is usually part of the same sensor package as Pitch and 
Roll in most survey configurations.
1. Click Heave in the Sensors list box so the selection is highlighted and 

the data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current heave sensor time 
stamp.

• Time: The hour and minute of the current heave sensor time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the heave sensor from the 
Reference Position (0).
The X-Y-Z location of the heave sensor must be defined ONLY 
when you intend to apply heave data during Merge AND when 
remote heave compensation is necessary.

• X: The athwart-ship distance of the sensor, positive to starboard.

• Y: The along-ship distance of the sensor, positive to the bow.

• Z: The vertical distance of the sensor, positive into the water.

• Error: The applied instantaneous values for the heave sensor are 
computed by subtracting the appropriate errors from the recorded 
values:

Applied Heave = Recorded Heave - Heave Error.
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• Apply: Select Yes to apply heave data in the merge process.

• Manufacturer: The maker of the sensor equipment.

• Model: The particular make of sensor equipment.

• Serial Number: The serial number of the sensor equipment.

The location of the heave sensor is shown in the Vessel Editor by 
a coloured dot.

Note: Simrad systems apply dynamic Heave, Pitch, and 
Roll values to the swath data during survey. Therefore, the 
HVF must be set up with the Apply switches for Heave, 
Pitch, and Roll set to '”No” so these values are not applied 
twice. 
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Pitch

Pitch refers to the rotational motion of the vessel around the X 
(port/starboard) axis. Although the pitch sensor has its own 
section in the Vessel Editor, it is usually part of the same sensor 
package as roll and heave in most survey configurations.
1. Click Pitch in the Sensors list box so the selection is highlighted and the 

data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current pitch time stamp.

• Time: The hour and minute of the current pitch time stamp.

• Time Correction: The time correction value.

• Error: The applied instantaneous values for the pitch sensor are 
computed by subtracting the appropriate errors from the recorded 
values:

Applied Pitch = Recorded Pitch - Pitch Error.

• Apply: Select Yes to apply the pitch data in the merge process.

• Manufacturer: The maker of the sensor equipment.

• Model: The partcular make of sensor equipment.

• Serial Number: The serial number of the sensor equipment.

The location of the pitch sensor is indicated in the Vessel Editor 
by a coloured dot.

Note: Simrad systems apply dynamic Heave, Pitch, and Roll 
values to the swath data during survey. Therefore, the HVF 
must be set up with the Apply switches for Heave, Pitch, 
and Roll set to '”No” so these values are not applied twice. 
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Roll

Roll refers to the rotational motion of the vessel around the Y 
(fore/aft) axis. Although the roll sensor has its own section in the 
Vessel Editor, it is usually part of the same sensor package as 
pitch and heave in most survey configurations.
1. Click Roll in the Sensors list box so the selection is highlighted and the 

roll data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current roll time stamp.

• Time: The hour and minute of the current roll time stamp.

• Time Correction: The time correction value.

• Error: The applied instantaneous values for the roll sensor are 
computed by subtracting the appropriate errors from the recorded 
values:

Applied Roll = Recorded Roll - Roll Error.

• Apply: Select Yes to apply the roll data in the merge process.

• Manufacturer: The maker of the sensor equipment.

• Model: The particular make of the sensor equipment.

• Serial Number: The serial number of the sensor equipment.

The location of the roll sensor is indicated in the Vessel Editor by 
a coloured dot.

Note: Simrad systems apply dynamic Heave, Pitch, and Roll 
values to the swath data during survey. Therefore, the HVF 
must be set up with the Apply switches for Heave, Pitch, 
and Roll set to '”No” so these values are not applied twice. 
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Dynamic Draft

The squat and lift of a vessel changes as the speed changes. For 
some vessels, if the squat/lift is not accounted for, significant 
errors are introduced into the soundings. In this section, you can 
specify up to 10 speed-draft value pairs. During merge, the 
difference between the instantaneous draft and the static draft 
is computed and the final depth compensated.
Draft is measured in metres/feet, and speed is measured in 
knots. All draft values entered should be relative to the same 
reference, but what that reference is, is not important. The first 
Speed-Draft pair must correspond to a state where no draft 
correction is necessary. The delta draft values, relative to the 
initial draft, are computed and used to correct observed 
soundings. 
The following formula is used to correct soundings for dynamic 
draft:
Depth = observed depth – waterline + delta draft.

Delta draft is computed from the present vessel speed, as 
derived from the navigation system.
You can also create your own dynamic draft model and load 
Delta Draft information directly which will override the 
Dynamic Draft table in the HVF. (See “DELTA DRAFT” ON PAGE 189.)
1. Click Dynamic Draft in the sensors list box so the selection is 

highlighted and the dynamic draft data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current time stamp for the draft 
table.

• Time: The hour and minute of the current time stamp for the draft 
table.

• Apply: Select Yes to apply the table during merge (or No to not 
apply the table).

3. Click Edit in the Error field. A dialog box containing a table with up to 
10 speed-draft pairs is displayed.
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4. Click inside the Speed cell and type a speed value (in knots).

5. Click inside the Draft cell and type a corresponding draft value.

6. Continue entering as many speed /draft pairs as needed.

7. Click OK.

The speed-draft table is saved in the HVF.

Single Beam

The Single beam section refers to a vertical beam echo sounder 
with one transducer mount. It can be a single or dual frequency 
sounder defined as one beam with one transducer.
1. Click Single Beam in the Sensors list box so the selection is highlighted 

and the data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current single beam time 
stamp.

• Time: The hour and minute of the current time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the transducer from the 
Reference Point (0).

• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.

• Z: The vertical distance of the transducer, positive into the water.

• Manufacturer: The maker of the transducer.

• Model: The particular make of the transducer.

• Serial Number: The serial number of the transducer.
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SVP

A sound velocity profile (SVP) records the speed of sound at 
various depths in the water column. One of the processes 
available in HIPS is the application of SVP data in sound 
velocity corrections. However, this procedure is not available for 
all types of sonars because some sonars and their data logging 
systems compensate for sound velocity during data acquisition.
To ensure the SVP is accurately applied in HIPS, the transducer 
X-Y-Z offset values must be entered.
1. Click SVP 1 in the Sensors list box so the selection is highlighted and 

the SVP transducer data fields are visible. If there is a second 
transducer then click SVP 2 and complete the same procedures as 
listed below.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current SVP pole time stamp.

• Time: The hour and minute of the current SVP pole time stamp.

3. Select Yes if there are dual transducers (or No if there is only a single 
transducer).

The following three fields are for entering the pole’s X-Y-Z 
coordinates. All coordinates are measured from the Reference 
Point
4. Type the transducer’s X-Y-Z offsets in the following fields:

• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.

• Z: The vertical distance of the transducer, positive into the water. 

The next three fields refer to the alignment of the transducer. 
The values you entered in the wizard when creating the HVF are 
displayed in these fields. The fields are only to be used for large 
transducer mounting offsets.

• Pitch: Pitch offsets of the transducer.

• Roll: Roll offsets of the transducer. 

• Yaw: Rotation of the transducer (either 0 or 180 degrees).

For information on applying SVP in processing see Sound 
Velocity Processing in the HIPS and SIPS User Guide.

Note: The Reference Point for Simrad data is the 
centre of rotation. It should be possible to retrieve 
offset values from the Simrad Installation 
Datagram.
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Sweep

Sweep systems typically contain multiple vertical beam 
transducers mounted on a boom and pointed straight down. The 
reference point for a sweep system can be anywhere on the X-Y 
plane, but must be on the water surface.
1. Click Sweep in the Sensors list box so the selection is highlighted and 

the data fields are visible.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current sweep time stamp.

• Time: The hour and minute of the current sweep time stamp.

• Time Correction: The time correction value.

• Transducers: Number of beams mounted on the boom.

3. Click the Edit button in the Transducer Status field to view a table for 
entering data for individual beams on the boom.

4. Type values in the fields and click OK.

5. Click Edit in the TPU Status field to enter TPU values for each beam 
on the boom and to edit values entered in the new vessel wizard.
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6. Type values as needed and click OK.



CARIS HIPS and SIPS User’s Guide 107

Create Vessel File: Edit Sensor Configuration

Towed Sensors

If a towed sensor—such as a side scan sonar—is used on a 
survey, then SIPS can compute the sensor’s position as from the 
ship's position by calculating the horizontal layback and a 
direction to the sensor.
1. Click Towed in the Sensors list box so the selection is highlighted and 

the Towed data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current towed sensor time 
stamp.

• Time: The hour and minute of the current towed sensor time stamp.

• Time Correction: The time correction value.

• Layback Error: The error in the computed or recorded horizontal 
layback. This can be used, for example, to compensate the 
recorded layback data or tow cable length for the distance between 
the origin of the measurements and the defined tow point location in 
the tow cable length. This value is subtracted from the computed 
horizontal layback.

• X: Offset of the tow point from the vessel’s reference position.

• Y: Offset of the tow point from the vessel’s reference position.

• Z: Height of the tow point (negative upwards) in relation to the 
datum that is referenced to the sensor depth (in most cases, this is 
the waterline).

• Manufacturer: The maker of the towed sensor.

• Model: The make of the towed sensor.

• Serial Number: The serial number of the towed sensor.
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Waterline

The purpose of this section is to define long-period changes in 
the vessel's draft due to fuel burn or other loading changes.
Specifically, you can enter the height of the waterline below the 
Reference Point.
If the Waterline section of the vessel configuration is not defined 
then the default of zero is used by the software as the height of 
the waterline below the RP. 
The Waterline section must be present in the HVF for use in 
sound velocity corrections.
1. Click Waterline in the Sensors list box so the selection is highlighted 

and the waterline data fields are displayed.

2. Type data (as needed) in the following fields:

Date: The year and Julian day of the current waterline time stamp.

Time: The hour and minute of the current waterline time stamp.

Waterline: The distance from the RP, positive when below the RP.

Apply: Select Yes to apply the waterline data in the merge process.

For Simrad data, the Waterline value must be set to the 
same value recorded as WLZ in the Simrad Installation 
Datagram. 

The Waterline value will only be used during Sound 
Velocity Correction.

The Apply switch must be set to “No”. It must not be set to 
“Yes”, because it must not be used by Merge.
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Total Propagated Uncertainty

This section defines the values for calculating Total Propagated 
Uncertainty (TPU). TPU is derived from a combination of all 
individual error sources. The TPU Configuration section of the 
vessel file contains the following error estimates (among others):
• nav/gyro/heave/pitch/roll/tide errors
• latency error estimate
• sensor offset error estimates.
These errors are combined with individual sonar model 
characteristics in the DeviceModels.xml file to calculate 
horizontal and vertical uncertainty values for every sounding 
along a track line when TPU is applied.
For more information on TPU, see “TOTAL PROPAGATED UNCERTAINTY” ON 
PAGE 200.
1. Expand the TPU section by clicking the + icon.

2. Type data (as needed) in the Offsets section:

• MRU to Transducer: The physical offset in three dimensions from the 
motion recording unit to transducer 1 on the vessel. 

• MRU to Transducer2: The physical offset in three dimensions from the 
motion recording unit to transducer 2 on the vessel.

• Navigation To Transducer: The physical offset in three dimensions 
from the navigation antenna to transducer 1 on the vessel.

• Navigation To Transducer2: The physical offset in three dimensions 
from the navigation antenna to transducer 2 on the vessel.

• Transducer Roll: The mounting roll offset for transducer 1. The offset 
is positive when rotating the transducer away from starboard 
(starboard down).

• Transducer Roll 2: The mounting roll offset for transducer 2. The 
offset is positive when rotating the transducer away from starboard 
(starboard down).

3. Type data (as needed) in the Standard Deviation section:

• Motion Gyro: The measurement standard deviation of the heading 
data in degrees.

• Heave % Amplitude: An additional heave standard deviation 
component that is the percentage of the instantaneous heave. 

• Heave (m): The measurement for standard deviation of the heave 
data. Most heave manufacturers quote heave error as being 
determined from StaticHeave or PercentageOfHeave depending on 
which value is larger.

• Roll: The measurement standard deviation of the roll data in 
degrees.

• Pitch: The measurement standard deviation of the pitch data in 
degrees.
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• Position Nav: The standard deviation associated with the 
measurement of positions for the vessel. This is usually the error of 
the GPS sensor being used.

• Timing Trans: Standard deviation in transducer time stamp 
measurement.

• Nav Timing: Standard deviation in navigation time stamp 
measurement.

• Gyro Timing: Standard deviation in gyro time stamp measurement.

• Heave Timing: Standard deviation in heave time stamp 
measurement.

• Pitch Timing: Standard deviation in pitch time stamp measurement.

• Roll Timing: Standard deviation in roll time stamp measurement.

• Offset X: Standard deviation for the X measured offset on the vessel.

• Offset Y: Standard deviation for the Y measured offset on the vessel.

• Offset Z: Standard deviation for the Z measured offset on the vessel.

• Vessel Speed: The standard deviation for the vessel speed 
measurements.

• Loading: Vertical changes during the survey because of fuel 
consumption, etc.

• Draft: The standard deviation in the vessel draft measurements.

• Delta Draft: The standard deviation in the dynamic vessel draft 
measurements.

• MRU Align StdDev Gyro: This value is the uncertainty of the motion 
recording unit placement within the vessel fixed coordinate frame.

• MRU Align StdDev Roll/Pitch: This value is the uncertainty of the 
motion recording unit placement within the vessel fixed coordinate 
frame.

• Comments: Any additional information.
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Vessel Coordinate System

Vessel configuration is based on an instantaneous three-
dimensional coordinate system, which is used to record the 
location of sensors and other equipment.

 

Reference Position Sensor positions are described using X-Y-Z axis coordinates 
relative to a Reference Position (RP). The RP is a location from 
which all other positions are derived. (Imagine standing at the 
location of the Reference Position and describing how far and in 
what direction the sensor is away from you.)
The location of the RP depends upon the type of sonar system 
used in the survey. Its location is usually at the centre of the 
ship’s gravity. This position is used as the centre of the ship’s 
rotation when applying the pitch/heave/roll parameters, and 
must be applied as accurately as possible. 

Coordinate definitions The axes are defined as follows:
• The Y-axis is oriented along the vessel’s fore/aft axis, positive 

forward.
• The X-axis is oriented along the vessel’s port/starboard axis, 

perpendicular to the Y-axis, positive to the starboard.
• The Z-axis is perpendicular to the X-Y plane, and positive into 

the water. 
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The location of the vessel’s coordinate system within the local 
fixed coordinate system is determined by the navigation system 
and tide. The orientation of the coordinate system is defined by 
the vessel’s gyro and attitude sensors (pitch and roll). Gyro, 
pitch and roll observations are defined as follows:
• A positive gyro observation is defined as the clockwise 

rotation of the vessel (from 0 and 360 degrees) within the 
navigation coordinate system.

• A positive pitch is observed when the bow of the vessel is 
down (bow down).

• A positive roll is observed when the starboard side of the 
vessel is up (starboard up).

Time Stamp

A vessel’s configuration changes over time. Different draft 
settings may be used in a survey, or the position of the 
transducers on a boom may change, or a different ellipsoid is 
used. A time stamp is used to keep track of these changes. The 
time stamp records the time from which a configuration is valid 
and is recorded with each entry to the HVF. Below is an example 
of time stamps showing changes in vessel configuration.

Time Correction

In the HVF, most sensors have a Time Correction field that 
contains the time difference between the sensor clock and the 
reference clock. Sensors are time tagged and all clocks are 
compared to the reference clock so sensor readings can be 
synchronized.

new nav. 
antenna 
position

new draft 
error

new ellipsoid/

datum

new nav. 
antenna 
position

1999-127 
14:10:1

1999-263 
09:23:0

2000-149 
17:10:3

2000-170 
10:0:0

NOTE: Time in HIPS is based on the recorded reference 
time. No distinction is made for UTC.
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The Time Correction field is specified in seconds and is positive 
if ahead of the reference clock:
Time Correction = Recorded Time - Reference Time

The following figure illustrates the concept of time correction 
with respect to the sensor clock.



5
Create a New Project

All projects in HIPS and SIPS are organized in a Project-Vessel-Day 
folder hierarchy. New projects are created with a wizard, which generates 
a HIPS Project File (.hpf).

In this chapter...
“DEFINE NEW PROJECT” ON PAGE 116
“RENAME DAY AND LINE FOLDERS” ON PAGE 120
“VIEW PROJECT OR VESSEL PROPERTIES” ON PAGE 121
“RECYCLE BIN” ON PAGE 122
“ARCHIVE PROJECT” ON PAGE 124
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Define New Project

If no vessel file is available, it must be defined before the new 
project can be created. (See “DEFINE VESSEL FILE” ON PAGE 104).
The default directory for projects is …\Hips\HDCS_Data, 
however you can modify this setting with Tools > Options. For 
more information see “PROJECTS” ON PAGE 693.
1. Ensure that an appropriate vessel file has been created for this project. 

2. Select the New Project command.

New Project (Step 1)

The New Project (Step 1) dialog box is displayed.

M
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File > Project > New
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Add a new Project folder 1. To create a new project folder, click Add Project.

The New Project Name dialog box is displayed
2. Type a name for the new project.

3. Click OK.

A new Project folder is created and displayed in the dialog box.
Add a new Vessel folder The Vessel folder contains the Day folders for the project. To add 

a Vessel folder to your project:
4. Select a project folder so it is highlighted.

5. Click Add Vessel.

The Available Vessels dialog box is displayed.

6. Select a vessel file from the list.

7. Click OK.

The Vessel folder is created and added to the new Project folder.
Add a new Day folder The Day folder contains track line data. For most formats the 

date is typically recorded with the raw data. If not, give the Day 
folder the date that the survey lines were recorded. 
Day folders are shown in Julian Day format, for example, April 
24, 2009 is shown as 2009-114. 
To add a Day folder to a Vessel folder: 
8. Select the Vessel folder.

9. Click Add Day.

The Calendar is displayed at the current year-month-day. 
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10.Select a different year or month, if needed, by clicking the arrow 
buttons at the top of the dialog box.

11.Select a new day, if needed, by double-clicking on the date.

12.Click Add Day again to create the Day folder with the selected dates. 

13.Click Next to go to Step 2.

Add to an existing 
project

You can add new Vessel and Day folders to an existing project 
instead of creating a new project.
1. Select the existing project from the list in the dialog box.

2. Add vessel and day folders as needed. 

Delete empty folders You can also delete an empty Day or Vessel folder by clicking 
Delete. The Delete button is disabled if a Vessel or Day folder 
already has data converted into it.

New Project (Step 2)

The New Project (Step 2) dialog box is displayed.

1. Type any comments about the project in the Description text area, if 
needed.

2. Enter the name of the person working with the project data in the 
Owner field. The default name that is displayed is taken from the 
current Windows NT logon name.

NOTE: If a HIPS Project File (HPF) already exists for a 
project, the Finish button is displayed at this point. You can 
enter a new Vessel or Day folder, but cannot enter 
information from the other wizard dialog boxes.
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3. Click Next.

New Project (Step 3)

The New Project (Step 3) dialog box is displayed. 
By default, HIPS and SIPS will select the appropriate UTM zone 
automatically. The Select UTM Zone Automatically check box is 
selected and the country and zone options are dimmed.

To set a different projection for your project:
1. De-select the Select UTM Zone Automatically check box. 

2. Select a country or area from the Group Name list box.

3. Select a zone from the Zone list box.

The Projection key name is automatically displayed once the 
country and zone have been selected. 

4. Click Next.

NOTE: The world-wide map projection coordinate systems 
are defined in the file …\Hips\System\mapdef.dat.
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New Project (Step 4)

The New Project (Step 4) dialog box is displayed. Use this dialog 
box to set the geographic coordinates (degrees-minutes-seconds) 
for the project area.

If you want to use the geographic coordinates of a currently open 
project: 
1. Click Current View.

To manually enter the geographic coordinates for the project 
area:
1. Select a project extents box (e.g., N) and type the coordinates, or 

select the degree, minutes or second field within a project extents box, 
and use the arrow keys to toggle the values.

2. Click Finish to complete the creation of the new project.

New Project-Vessel-Day folders have been created according to 
the options selected in the wizard. An HPF has been created and 
is located in the Project folder.



CARIS HIPS and SIPS User’s Guide
121

Create a New Project: Rename Day and Line Folders

Rename Day and Line Folders

You can rename existing Day and Line folders after raw data 
has been converted to HIPS/SIPS format. 
1. Select a Day folder or Line folder in the Control window, or select a 

track line in the Display window.

2. Select the Rename command.

The Rename dialog box is opened with the selected file or folder 
name displayed.
3. Enter a new name in the box.

4. Click OK.

The changed file name is displayed in the Control window.
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View Project or Vessel Properties

View essential project and vessel information. You can also use 
this dialog box to change the coordinate system, if needed.
1. Select a Project folder or a Vessel folder from the Project tab in the 

Control window.

2. Select the Properties command.

The Project Properties dialog box is displayed. 

The General tab displays information about the project or vessel. 
The information is read-only and cannot be modified.
If you selected to display the properties for a project, then the 
Coordinate System tab is included in the dialog box.
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You can select another coordinate system for the project using 
this tab.
3. Select either the Auto UTM option or the Select Manually option.

4. If you selected Auto UTM, click Recompute to compute the UTM zone.

5. If you want to manually select a coordinate system, select a projection 
and zone.

6. Click Apply to assign the new coordinate system to the project. 

7. Click OK to close the dialog box.

.
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Recycle Bin

You can “delete” Project, Vessel, Day, or Line folders from an 
active project by moving them to the Recycle Bin. These folders 
are no longer part of the active project, but can be restored to the 
project or permanently deleted. All folders in the Recycle Bin are 
located in …\Hips\Recycler. 
The Recycle Bin recreates the same directory structure as the 
active project.

Move items

1. Ensure the Control window is open and the Project tab is visible.

2. Select the folder(s) you want to delete.

3. Select the Delete command.

4. A dialog box asks if you want to delete the folder(s).

5. Click Yes.

6. [Optional] You can also select the folders and, while pressing the 
mouse button, drag them to the Recycle Bin.

The folders are moved to the Recycle bin. 
Restore an item You can move a previously deleted folder from the Recycle Bin to 

the active project.
1. Select the folders in the Recycle Bin.

2. Select the Restore command.

The folders are now restored to the active project. If all folders 
are removed from the Recycle Bin then the directory structure is 
deleted.
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Empty Recycle Bin Emptying the Recycle Bin permanently deletes the folders from 
the project.

3. Select the Empty Recycle Bin command.

4. A dialog box asks you if you want to continue.

5. Click Yes.

The folders are removed from the Recycle Bin.

You cannot restore folders that have been deleted from the 
Recycle Bin.
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Archive Project

Archive projects and related data using the Project Archive 
wizard.
The projects and data are converted to a ZIP format and must be 
decompressed if used again. The directory structures for the 
compressed files are as follows:
• Line files are in ../Projects/<ProjectName>/<VesselName>/

<DayName>/<LineName>
• Fieldsheet files are in  ../FieldSheets/<ProjectName>/

<FieldSheetName>
• Other files related to data processing are in ../Preprocess/

<ProjectName>
• Additional background files are in .. /Background/

<ProjectName>
To archive a project.
1. Select the Archive Project command.

The New Archive (Step 1) dialog box is displayed 
.

2. Type the file path for the new archived file in the New Archive Name 
field or click Browse to select a directory and type the name of the 
archived project file.

3. Click Next.

The New Archive (Step 2) dialog box is displayed.
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.

4. The directory path for the projects is shown in the Project Directory 
field. If necessary, click Browse and select another directory.

The projects in that directory are displayed in the Projects list.
5. Select a project from the list.

6. Click Next.

The New Archive (Step 3) dialog box is displayed. 

7. The directory path for field sheets is shown in the Field Sheet Directory 
field. If necessary, click Browse to select another directory.

The field sheets contained in the directory are displayed in the 
Field Sheet list.
8. Select a field sheet associated with the project using one of these three 

methods:
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• Select a single field sheet by clicking on it.

• Select a group of field sheets by pressing and holding the <Ctrl> key 
while clicking on each field sheet.

• Select a range of field sheets by pressing and holding the <Shift> 
key while clicking on the first and last field sheets in the range so 
that all field sheets in between are highlighted.

9. Click Next.

• The New Archive (Step 4) dialog box is displayed 
.

This dialog box is used for archiving related files necessary for 
the successful processing of data. Examples of these files would 
be tide files, sound velocity files, delta draft, TrueHeave files, 
etc.
10.Click Add to view a standard Open dialog to select auxiliary data.

The auxiliary files are shown in the Auxiliary Data list.
11.To remove a file, select it and click Remove, or click Clear to remove 

all listed files.

12.Click Next.
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The New Archive (Step 5) dialog box is displayed.

This dialog box is used for archiving data that is associated with 
the project, but is not necessary for processing data. Examples of 
this type of data would be background images, associated charts, 
etc.
13.Click Add to view a standard Open dialog to select additional data.

The auxiliary files are shown in the Additional Data list.
14.To remove a file, select it and click Remove, or click Clear to remove 

all listed files.

15.Click Next.

The New Archive (Step 6) dialog box is displayed.

This dialog box lists the selections you made in the previous 
dialog boxes.
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16.Click Back to go to a previous dialog box to make changes, or click 
Start to begin the archiving process.

The New Archive (Final) dialog box is displayed.

The Status list displays the files that have been archived. A 
progress bar displays the amount of archiving that has been 
accomplished.
17.Click Close to exit the wizard once archiving is completed.



6
 Convert Data

Use the Data Conversion wizard to convert various types of survey data 
into HDCS-specific format. 

In this chapter...
“CONVERTING FILES TO HIPS/SIPS FORMAT” ON PAGE 132
“DATA FORMAT OPTIONS” ON PAGE 139
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Converting Files to HIPS/SIPS Format

HIPS and SIPS files are created from survey data using the 
Conversion Wizard.   
Data that is converted to HIPS/SIPS format may be in varying 
stages of completion, depending on the data format options. 
Survey data may or may not have been corrected for factors such 
as heave/pitch/roll or sound velocity. Such correction can be 
applied during the Merge process and SVP Correction.   
All HIPS and SIPS data is organized in a Project/Vessel/Day/
Line directory structure. If you organize the raw data files 
according to this structure, then you can convert line data from 
entire Project or from multiple Vessel and Day folders contained 
in a common Project folder. Use the File Selection Type option in 
Step 2 of the wizard to do this (see “SELECT FILES FOR CONVERSION” ON 
PAGE 133).
When entire project data has been converted, a Project-Vessel-
Day-Line directory is created for the converted data. If there is 
already a Project folder that is identical to the preprocess folder, 
then the line data in the existing folder is over-written with the 
new data. 

To start the conversion process, activate the HIPS Conversion 
Wizard. 
1. Select the Conversion Wizard command in the HIPS and SIPS main 

interface.

The first Conversion dialog box is displayed.

You must organize your raw data files in a HIPS/SIPS 
Project-Vessel-Day structure to convert complete Project, 
Vessel and/or Day data files.
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Select Data Format

The Step 1 dialog box lists the data acquisition systems for 
which data can be converted to HIPS and SIPS files.
This list is created dynamically by searching the Hips\Bin 
directory for all format libraries with the name 
convert_*.dll.
1. Select the survey data type to be converted by clicking the appropriate 

name.

2. Click Next.

The next dialog box is displayed to select the files for conversion. 
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Select Files for Conversion

 

To convert data, 
1. Select the appropriate File Selection Type from the drop-down list. The 

default is RawData.

2. Click Select to browse to the file or files you want to convert. 

The selected file(s) is listed in the dialog box.
3. [Optional] To remove a file from the list, select it and click Remove.

Click Next to open the Select Project-Vessel-Day dialog box (Step 3 of the 
Conversion Wizard).Some data may already be organized into a 
Project/Vessel/Day structure. In this case you need only to select 
the folder containing the data to be converted. If you select 
Vessel as the data type, you will then need to indicate the project 
for that data. If you select Day, you will then need to indicate the 
vessel and project for the data. When you click Next, the Select 
Coordinate Type dialog box is displayed (see “SELECT COORDINATE 
SYSTEM” ON PAGE 134). 

Raw data being converted into HIPS and SIPS can also be 
located on a read-only media such as a CD-ROM, except 
for Atlas SURF data, which at this time, does not support 
conversion from read-only files.
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Select Project-Vessel- Day

Select a Project/Vessel/Day directory into which to save the 
converted data.
1. Click the Expand (+) icon on the Project file tree so it is expanded and 

the Day folder is visible.

If you want to add Project, Vessel or Day folders, or to delete a 
folder, continue with Steps 2 to 6 in this procedure, otherwise go 
to Step 7.
2. To add a vessel folder, make sure the project directory is highlighted 

and click Add Vessel.

The Available Vessels dialog box is displayed. 
3. Select a vessel folder and click OK.

The new Vessel folder is displayed in the selected project 
directory.
4. To add a day folder, click the Vessel folder and click Add Day.

The Calendar dialog box is displayed.
5. Select a year/month/day from the calendar, and click OK.

A Day folder with the selected date is stored in the Vessel folder.
6. To remove an empty Day or Vessel folder from the wizard, highlight the 

folder and click Delete. 

If a Vessel or Day folder is in a Project which already has data 
converted into it, it cannot be deleted using the Delete button.

7. Click the Day folder so it is highlighted.

8. Click Next to define the coordinates used when data was recorded.  
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Select Coordinate System

The next step is to define the type of coordinates that were used 
to record the navigation data in the raw data files.

To indicate the type of coordinate system that was used for 
navigation data during data logging,
1. Select one of the following options:

• Geographic: navigation data is recorded as latitude and longitude 
coordinates.

• Ground: navigation data is recorded as eastings and northings. 

If you select Ground, complete the following steps:
2. Select an area from the Group list.

3. Select a zone.

4. Click Next.
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Select Basic Filters

During the conversion process, some soundings may be 
automatically rejected due to disabled beams. This is controlled 
by the beam status settings in the vessel configuration. Also, 
several multibeam formats pre-flag some soundings as being 
failed detects. These soundings are also automatically rejected 
during conversion. 
This dialog box defines basic navigation and depth filters to 
automatically reject extremely large errors in the recorded 
navigation and depth data

1. Select the Navigation check box to enable the navigation filter.

The extents of the filter can be defined either by setting them 
manually in the dialog box or by using the extents in the HIPS 
Project File (HPF). The HPF is from the project you selected in 
Step 3 of the Conversion wizard. 
2. Select either Manual option or the Project File option.

3. If you selected the Manual option, enter the extents in the fields. You 
can use the <Tab> key to move between fields and use the arrow keys 
to move between values in a field.

4. Select the Depth check box to enable the depth filter.

5. Enter the minimum acceptable depth.

6. Enter a maximum acceptable depth.

7. For advanced filtering for multibeam or multi-transducer data select the 
Advanced Filtering check box and click Parameters to set advanced 
filtering options. 
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Advanced Filtering 

The Filtering options dialog box is displayed, listing the filtering 
options. 
Currently advanced filtering is only available for multibeam and 
multi-transducer data conversion. Any options greyed out are 
not available for the type of data you are converting.
 

Certain data can be filtered so that only the best quality data is 
imported to HIPS. The filter is applied to port and starboard 
beam angles.
1. Select Angle filter (Port/Stbd) and type a range of beam angles. 

The Range Filtering option converts soundings within a specified 
distance (in metres). Soundings outside of this range are not 
converted.
2. Select the Range Filtering check box to implement this option.

3. Click the up or down arrow buttons to select a minimum and maximum 
distance.

The Amplitude Filtering option filters soundings according to 
amplitude value. For each ping (port and starboard pings are 
handled separately), the min/max amplitude values are 
obtained, and samples that fall below the selected percentage (0-
50%) are rejected.
4. Select the Amplitude Filtering check box to implement this option.

5. Click the up or down arrow buttons to select a percentage value for 
rejecting soundings.

The Statistical Filtering option controls which soundings in each 
swath are considered for conversion. This option calculates the 
mean depth and standard deviation within a swath sector or 
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horizontal bin. It then prevents any soundings that fall outside a 
multiple of the standard deviation from being converted.
If Statistical Filtering is used, then the mean within the sector is 
re-computed. Ultimately, the soundings are sorted by their 
residual from the mean and those closest to the mean are 
converted. The actual number of soundings converted from 
within each sector is determined by the thinning factor (if used).
6. Select the Statistical Filtering check box to implement this option.

7. Determine a Threshold (multiples of the standard deviation) value by 
clicking the up and down arrow buttons.

The equivalent confidence value is displayed as a percentage.
The filtering and thinning methods are executed within a sector 
angle interval or a horizontal bin size. The sector angle option 
divides the swath into sectors according to degree angles while 
the horizontal bin size divides the swath into horizontal sectors 
based on a specified across-track distance.
Vessel motion and transducer mounting angles are considered 
when sector angle and horizontal bin locations are determined.
1. Select the Sector Angle Interval option and choose a degree level (to a 

maximum of 10º) by clicking the up or down arrow buttons.

2. As an alternate method, Select the Horizontal Bin Size option choose 
an across-track distance by clicking the up or down arrow buttons.

The thinning factor reduces the number of soundings converted 
on a per swath basis. The thinning factor uses a power of two 
reduction control (1/2, 1/4, 1/8, etc.) so that one of two, one of four 
or one of eight soundings can optionally be converted per swath 
sector.
3. Select the Data Thinning check box to implement the thinning option.

Select a Thinning Factor value by clicking the up or down arrow buttons.

4. Select Output thinned data to write out only non-rejected data.

The user has the option to not write out soundings which have 
been eliminated because of data thinning. Although by doing so, 
a mismatch is created between the converted HIPS data, and the 
original data file. (since multi-transducer data is tied to the 
settings in the vessel file, full dataset is always written out).
5. Click Next. 

Enter Data Parameters

Depending on the data acquisition format you selected in the 
Step 1 of the wizard, one or more dialog boxes, appropriate to the 
data, will now be displayed. See “DATA FORMAT OPTIONS” ON PAGE 142 
for more information on options for different raw data formats. 
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The example below shows the information for conversion of 
Hypack data. 
 

1. Choose the settings appropriate to the data format being converted.

2. Click Next.

Convert Data

The final step is to launch the conversion process with the 
settings and parameters you have selected. 

To convert raw data to HIPS/SIPS format,
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1. Click the Convert button.

A progress indicator bar along the bottom of the box is activated 
as the files are converted. When the operation is complete the 
results of the conversion process are displayed in the dialog box.
The converted files are saved in the directory you selected in 
Step 2 of the conversion process (see “SELECT FILES FOR CONVERSION” ON 
PAGE 133).
2. Click Close to close the wizard.

3. [Optional] to return to the initial step of the conversion process click 
Restart.
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Data Format Options

Beginning with Step 6 of the HIPS and SIPS Conversion Wizard, 
one or more dialog boxes with specific format options will be 
displayed. The number of options depends on the raw data 
format that was selected in Step 1 of the wizard.
The various data acquisition formats and their conversion 
options are presented below.  
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Atlas

The ASCII versions of Hydrosweep DS files are now supported. 
1. Type the correct year for the survey into the Data Survey Year field. 

You will not be able to enter a year prior to 1970. (The default value 
shown is obtained from the HIPS Day directory into which data is 
converted.) 

2. From the pull-down menu, select one of the following SURF data types 
to convert:

• multibeam

• single beam (low frequency)

• single beam (medium frequency)

• single beam (high frequency)

• dual frequency (low-medium)

• dual frequency (low-high)

• dual frequency (medium-high)

3. Click the Convert Side Scan check box to include side scan data in the 
conversion process.

Critical line name information can be fitted into 12 characters 
provided by the CARIS Source ID attribute for soundings in a 
CARIS map.
4. Select the Shorten line names check box to modify the file name to a 

12-character name (YYDDD_HHMMDD). 
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5. Select the higher frequency data as the primary soundings (if data 
format is dual-frequency).  

Chirpscan3D

There are no options for the Chirpscan3D format.

CMAX

There are no options for the CMAX format.

Coda
1. Select a sonar channel.

2. Click the Decimate Imagery check box to apply a decimation routine to 
the side scan data. Decimation reduces side scan data to 1024 or 
fewer intensities per side for each swath.

3. Click the Correct Imagery check box to increase contrast in the side 
scan imagery.

4. Select the Cable Out is Horizontal Layback option to omit sensor depth 
during conversion. If there is no sensor depth and the towpoint has a Z-
offset of zero, the cable out value is treated as the horizontal layback 
value during processing.

EdgeTech
1. Select a side scan system:

• Midas

• 260

• JSF

2. If Midas is enabled, select a sonar frequency channel:

• 100 KHz

• 500 KHz

3. If JSF is enabled, select a sonar frequency channel:

• All data

At the time of this writing, the Atlas SURF library cannot 
be converted from read-only files. Therefore, the Atlas 
files must be located on a read-write media before they 
can be converted into HIPS.
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• Low Frequency

• High Frequency

Edgetech side scan data can be imported in 16-bit format or 
converted to an 8-bit format.
4. Select either the Preserve 16-bit option or Convert to 8-bit option.

If the Convert to 8-bit option is selected, the Scale and Shift options 
are enabled. The Scale option averages the data and the Shift 
option selects a initial bit value (between 0 and 8) and includes 
the next seven bit values for export. For example, if you typed 8 
as your initial value, then bits 8 to 15 are included in the export 
process.
5. Select the Scale option to average the data into 8-bit format, or select 

Shift and type the value for the first bit.
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EIVA

At Step 5, you have the option of using the generic multibeam 
filtering functions built into the HIPS Conversion Wizard.
See “ADVANCED FILTERING” ON PAGE 135. 
Step 6 offers further conversion options specific to EIVA data. 

1. Select the Convert ROV depth option to store the EIVA sub-packets as 
HIPS delta draft values.

2. Select the Pad with NULL beams option, to replace missing data with 
NULL (rejected) beams in the case of dual head data where the data 
from head #1 is missing. This results in the beam numbers for 
transducer 2 data remaining consistent with fully populated profiles.

3. Select Swap transducers 1/2 data to exchange data between heads (in dual 
head set-up). 

4. Select the Separate dual head data option to specify that soundings from 
the dual head transducer data are not combined into a single HIPS 
profile. (Soundings from transducer head #2 will be identified via status 
bits encoding so no changes to your vessel files are needed.)

Since EIVA allows logging of data from multiple devices, the Data 

Source option enables you to select the source for heading, 
attitude, and navigation data. The data for each device is tagged 
with a sequence number, from 0 to 4, that represents one of up to 
five devices collecting each type of data. (If you select a number 
for which no device exists, no data is converted.)
5. Select a device number from the list for Gyro, Navigation and/or Motion 

data to convert the data from that device.
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Elac 

During conversion, XSE-format beams are numbered according 
to the sounding’s position along the swath (in relation to the 
vessel). 
1. To number the converted beams along the swath from starboard to 

port, select the Starboard to Port check box.

2. To number the converted beams along the swath from port to 
starboard, select the Port to Starboard check box.

If a single Sound Velocity value was used during the survey:
3. Select the Manual option and type the sound velocity value.

If a Sound Velocity Profile was recorded and used by the logging 
system, then the Interpolate option must be selected.
4. Select Interpolate to read surface sound velocity values from a 

datagram.

5. To convert side scan data, select the Convert Side Scan check box.

ELAC XSE data can be recorded as 108 beams or 126 beams 
(depending on the survey mode). The Pad Transducer 1 with NULL 
beams writes 63 beams to Transducer 1 so that the same HIPS 
Vessel File (HVF) can be used for both survey modes.
6. Click the Pad Transducer 1 with NULL beams check box so that the 

soundings associated with transducer 1 are padded to have 63 beams. 

7. Click Next.

Furuno
1. Make sure the Convert Side Scan option is checked to include side 

scan data with the bathymetric data.
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GeoAcoustics 

If you selected the Geographic option in Step 4 of the wizard, you 
can obtain the latitude/longitude readings from GPS strings.
1. In the Nav Source field, select Any GPS String, or GGK, GGA, or 

GGL.

2. If you want to convert data from Aux1 as delta draft, select the Convert 
Aux1 data as delta draft option. 

The Amplitude Filtering option filters soundings according to 
amplitude value. For each ping (port and starboard pings are 
handled separately), the min/max amplitude values are 
obtained, and samples that fall below the selected percentage (0-
50%) are rejected.
3. Select the Amplitude Filtering check box to implement this option.

4. Click the up or down arrow buttons to select a percentage for rejecting 
soundings.

The Range Filtering option converts soundings within a specified 
distance. Soundings outside of this range are not converted.
5. Select the Range Filtering check box to implement this option.

6. Click the up or down arrow buttons to select a minimum and maximum 
distance.

The Pre-Filtering option controls which soundings in each swath 
are considered for conversion. This option calculates the mean 
depth and standard deviation within a swath sector or 
horizontal bin. It then prevents any soundings that fall outside a 
multiple of the standard deviation from being converted.
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If Pre-filtering is used, then the mean within the sector is re-
computed. Ultimately, the soundings are sorted by their residual 
from the mean and those closest to the mean are converted. The 
actual number of soundings converted from within each sector is 
determined by the thinning factor (if used).
7. Select the Pre-Filtering check box to implement this option.

8. Determine a Threshold (multiples of the standard deviation) value by 
clicking the up and down arrow buttons.

The equivalent confidence value is displayed as a percentage.
The filtering and thinning methods are executed within a sector 
angle interval or a horizontal bin size. The sector angle option 
divides the swath into sectors according to degree angles while 
the horizontal bin size divides the swath into horizontal sectors 
based on a specified across-track distance.
Vessel motion and transducer mounting angles are considered 
when sector angle and horizontal bin locations are determined.
1. Select the Sector Angle Interval option and choose a degree level (to a 

maximum of 10º) by clicking the up or down arrow buttons.

2. Alternatively, select the Horizontal Bin Size option choose an across-
track distance by clicking the up or down arrow buttons.

The thinning factor reduces the number of soundings converted 
on a per swath basis. The thinning factor uses a power of two 
reduction control (1/2, 1/4, 1/8, etc.) so that one of two, one of four 
or one of eight soundings can optionally be converted per swath 
sector.
3. Select the Data Thinning check box to implement the thinning option.

4. Select a Thinning Factor value by clicking the up or down arrow 
buttons.

5. Click Next.
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GSF

Data recorded during line turns it is marked as Offline data in 
GSF. This data can be included or excluded during conversion. 
When included it can also be automatically rejected. One 
purpose for including the Offline data would be to maintain the 
same swath profile numbers in HIPS format. 
1. Make sure the Include Offline Data box is checked to convert data 

recorded during turns between track lines. Otherwise select the 
Reject Offline Data check box.

When offline data is converted, it can be rejected automatically.
Horizontal and depth uncertainty values in the GSF file are also 
included during conversion.
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Hypack

The Hypack format supports recording bathymetry from single 
beam, multibeam, and multiple transducer systems. It also 
supports reading side scan data from Hypack Max format.
For dual-frequency single beam data, you must indicate if the 
data records in Hypack are recorded as primary/secondary or 
secondary/primary. The primary frequency, by default, becomes 
the selected data for use in the field sheet.
If the conversion wizard detects records containing 12-bit data, 
they will be converted to 16-bit format. Otherwise they are 
converted to 8-bit data.
To process of EDIT (dual frequency) and HS2 (multibeam) 
formats, select Convert Bathy. 

1. Select the type of data to be converted: Bathy, Side Scan or both. (You 
must make a selection or the conversion process will not go forward.)

• To process EDIT (dual frequency) and HS2 (multibeam) formats, 
select Convert Bathy. 

Note: If Convert Bathy is selected, ensure that the vessel file for 
the data contains a Depths section, or conversion will fail.

• For side scan you can select either Low or High frequency data to 
be converted. If the data file contains only single frequency data 
then this setting is ignored and all data is converted.

2. Select a sounding data type:

• single frequency

• dual frequency (primary, secondary or secondary, primary)
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• multibeam

• multiple transducers

3. If you wish to a apply the static draft during conversion, click the Apply 
During Conversion check box.

The Device Numbers section is used if sensor data was recorded 
from more than one device. To import data from a specific 
sensor, you must type the number for that device. If no number 
is entered then all sensor data is imported. The following 
sensors are effected by the device number setting:
• Navigation for positional records.
• Gyro for heading records.
• Motion Sensor for roll, pitch and/or heave settings.
• Port transducer for port multibeam records.
• Starboard transducer for starboard multibeam records. 
• SOW Sensor for speed over water records.
4. If data is recorded from more than one sensor device, click the sensor 

check box and enter a device number.

5. Enter the sound velocity value that is used to compute the original 
travel time data from the recorded depths. This allows sound velocity 
corrections to be applied in HIPS.

The HS2 format does not store day and year values with the 
timestamp (it does store a time value). When the data is 
converted to HIPS, the Day folder is used for reading the date. If 
you want to include another date value, you must complete the 
following Year and Day fields.
6. Select the Use HS2 Survey Date check box to enable the Day and Year 

fields.

7. Type the year and day in the fields.

Imagenex

Navigation data can be imported from an external *.NAV file 
with the same name as the Imaginex *.83P file. If the HIPS 
converter detects that a *.NAV file exists, it will import 
navigation and GPS height data from the GPS strings in the 
*.NAV file. In this case the stored navigation data in the *.83P 
file is not converted.
You can choose read either the GGK or the GGA string, or have 
either read by selecting the Any option. These controls are only 
applied if there is an *.NAV file with the same name as the 
*.83P file. 
To read GPS height data from Imagenex files: 



CARIS HIPS and SIPS User’s Guide 153

Convert Data: Data Format Options

1. Select the height string to be read: GGA, GGK or Any. 

LADS

LADS data is contained in two files that are copied into the 
HIPS survey line folder: An ASCII CAF file that contains the 
bathymetry data, and a binary CBF file that contains the 
waveform data. The CAF file can contain data from more than 
one survey line (or “run”). When this is the case, the converter 
splits the file into separate line folders for each run. The .caf and 
.cbf prefixes are retained in the HIPS Line folder.
There are four sounding classifications in the LADS format:
• S (Secondary sounding): the best soundings
• P (Primary sounding): an unreliable result
• N (No bottom found at depth): potentially a useful depth 

result
• X (No bottom detected): no result 
When the data is converted, each sounding is given a status flag 
according to its classification. The following table outlines 
classification and matching HIPS status flag.

LADS
Classification

HIPS Sounding 
Flag

Definition

S Accepted Good soundings until they are flagged as 
rejected during cleaning in HIPS.

P Rejected by 
disabled beam

A reject flag in HIPS that can be changed 
to Accepted, if necessary.
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There are no dialog box options for the LADS format.

LAS

There are no specific options for the LAS format.

MarineSonics

There are no specific options for the MarineSonics format.

Navitronics
1. Select one of the following data types to be converted:

• Multibeam

• Singlebeam

• Multiple Transducer

2. Select the Convert Side Scan check box to convert side scan data.

Navitronic side scan data can be imported in 16-bit format or 
converted to an 8-bit format.
3. Select either the Preserve 16-bit option or Convert to 8-bit option.

If the Convert to 8-bit option is selected, the Scale and Shift options 
are enabled. The Scale option averages the data and the Shift 
option selects a initial bit value (between 0 and 8) and includes 
the next seven bit values for export. For example, if you typed 8 
as your initial value, then bits 8 to 15 are included in the export 
process.
4. Select the Scale option if you want to average the data into 8-bit format, 

or select Shift and type the value for the first bit.

5. Click Next.

N Examined A special flag for an Accepted sounding. 
The sounding can be filtered out when 
creating a BASE Surface or exporting. It 
can also be flagged as Rejected during 
cleaning in HIPS

X Rejected by Depth 
Gate

A type of Reject flag that can be changed 
to Accepted, if desired.

LADS
Classification

HIPS Sounding 
Flag

Definition
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Qmips
1. Choose a pair of sonar channels by clicking one of two options (1,2 or 

3,4).

Reson PDS

The final step of the conversion process for Reson data provides 
options for filtering soundings by status bits, and separating 
dual head data by profiles.
 

1. Select the Filter soundings by status option to filter using the status bits in 
the data file. 

2. Select the quality bits for which soundings will be rejected when 
converted into HIPS format. (If you select all four check boxes all 
soundings will be rejected. 

3. Select a number for your PDS navigation, motion and/or heading 
device to convert the data from that specific device. 

4. Indicate the source of S7K data by selecting option from the drop-down 
list. The default value is “All”. 

In the case of dual head data stored in the Reson 7K format, the 
data from transducer #1 is combined with that from #2 to form a 
single HIPS profile. To convert the two sets of data separately, 
5. Select the Separate profiles for dual head data option. 
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Scripps

There are no options for the Scripps format.

SDF

1. Select a Klein 3000 High or Low frequency.

2. Select a Pressure Sensor reading from the drop-down list to set the 
depth of the towfish.

3. Select the Range of voltage for the pressure sensor, either 0-5V or 1-
5V.

4. Hidden data consists of repeated pings over the same area. Select the 
Convert Hidden check box to include hidden data in conversion.

5. Select the Convert SSGyro check box to include side scan sonar gyro 
data.

6. Select the Cable Out is Horizontal Layback option to omit sensor depth 
during conversion. If there is no sensor depth and the towpoint has a Z-
offset of zero, the cable out value is treated as the horizontal layback 
value during processing.

SDF side scan data can be in 16-bit or 8-bit format. If the data is 
in 16-bit format, you can choose to convert to an 8-bit format.
7. Select either the Preserve 16-bit option or Convert to 8-bit option.

If the Convert to 8-bit option is selected, the Scale and Shift options 
are enabled. The Scale option averages the data and the Shift 
option selects a initial bit value (between 0 and 8) and includes 
the next seven bit values for export. For example, if you typed 8 
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as your initial value, then bits 8 to 15 are included in the export 
process.
8. Select the Scale option if you want to average the data into 8-bit format, 

or select Shift and type the value for the first bit.

Seabeam
1. Make sure the Convert Side Scan option is checked to include side 

scan data with bathymetric data.

2. Select the Shorten Line Names check box to modify the file name to a 
12-character CARIS name (YYDDD_HHMMDD).

Seafalcon

Seafalcon allows the option of importing a full-sounding dataset 
or a thinned dataset. The thinning options are based on reducing 
the number of beams per profile that are imported. All profiles 
are imported.
1. Select the thinning option, if needed.

The following two options are enabled if the thinning option is 
selected.
2. Select the amount of data to be processed.

• half the number of beams are imported

• one fourth the number of beams from each profile are imported

3. Select the sounding type to be imported into HIPS format.

• shoal

• average

• deep

You can select the swaths per ping that you want to import. In 
deep water, the Seafalcon sonar produces five swaths with each 
firing of the transducer. These five swaths are in an along-track 
position to the ship—with swath 1 forward of the sonar and 
swath 5 aft of the vessel. In shallow water only one swath per 
ping is generated.
By default all five swaths are selected for import, but you can 
decide which swaths to import.
4. Select the swath number(s) for import.

SEGY

There are no options for the SEGY format.
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SHOALS

All soundings in the SHOALS format are given a confidence 
value during acquisition. These confidence values are used to 
flag soundings during conversion so that soundings with certain 
confidence values are rejected. The following status flags are 
assigned to soundings. These can be changed in HIPS.
• Rejected by disabled beam: This flag rejects soundings 

with a negative confidence value.
• Rejected by depth gate: This flag is for soundings with 

confidence values that range from 0 to 70. The 0 to 50 range 
represents soundings where no bottom was found, and the 51 
to 70 represents soundings of questionable confidence.

• Accepted: This flag is for soundings with confidence values 
from 71 to 99.

When converting to HIPS, all soundings with a confidence value 
less than the Confidence Cutoff Value will be automatically rejected. 
The default cutoff value is 70.
1. Use the mouse to select a cutoff value.

If the dataset contains land data, you can select the topographic 
format (TOF) options to convert this data too.
2. Select either the First Pulse check box to convert the return from the 

top of the vegetation canopy or the Second Pulse check box to convert 
the return from the ground.
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Simrad

1. If you are using the EM3000 sonar, select the channel used for the 
primary position.

2. Select Manual Override to read from the navigation system data that is 
marked inactive by Simrad.

3. Click the Convert Side Scan/Backscatter box if you want to convert this 
data.

You can fit critical line information into the 12 characters 
provided by the CARIS Source ID attribute for soundings.
4. Select the Shorten line names check box to modify the file name to a 

12-character CARIS name (YYDDD_HHMMDD).

Large attitude data files can result if there is a straight one-to-
one import into HIPS. The Attitude Data Decimation option down-
samples the data so that a smaller attitude dataset is converted. 
The Decimation Factor determines the ratio of attitude data. For 
example, if you select 10 as the Decimation Factor, then one out 
every tenth attitude record is converted. 
5. Select the Attitude Data Decimation check box to implement this 

option. 

6. Select a Decimation Factor to set the ratio for down-sampling attitude 
data.

Data Source Motion data (heading, heave, roll, and pitch) is automatically 
read from the active motion reference unit. However, you can 
select another motion reference unit to read the data. Gyro data 
can also be read from the headings datagram.
7. For Heading, select the Auto option to read gyro data from the active 

motion reference unit, or select an inactive unit by selecting MRU1/
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MRU2 options. Select the H. Diagrams option to read gyro from the 
headings datagram.

8. For Heave, Roll, and Pitch, select the Auto option to read data from the 
active motion reference unit, or select an inactive unit by selecting 
AutoMRU1/MRU2 options.

9. For GPS Height, select a source from either the EM Height datagrams 
or the GPS String in the navigation datagrams.

Navigation time stamps can be selected from either the logging 
system or from a source specified by Simrad Installation 
datagram (the GPS string in the navigation datagram or the 
logging system).
10.Choose System to select the logging system or choose Automatic to 

select the timestamp specified by the Installation datagram.

11. If you are converting single beam data from the dual frequency 
EA400\600 system, select Primary to use the primary sounding as the 
selected sounding in the HIPS file, or select Secondary to use the 
secondary sounding as the selected sounding.

Time shifting The Time shifting option lets you add a constant number of 
seconds to each piece of data retrieved from the simrad.all file. 
This time shift value can be positive or negative and it’s set to 
zero by default. 
12.Enter the value to be added as a constant. 
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SWATHPlus 

1. Type a value in the Speed of sound field to apply sound velocity to the 
imported data.

UNB
1. Select one or two transducers.

2. Select the Convert Sonar option, if you want to import side scan data.

Winfrog
1. Select Single or Dual Frequency.

2. Select attitude records to be converted.

3. Specify the speed of sound, so that slant range data can be generated 
from the measured sounding depths.

4. Choose the navigation records to be converted.
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XTF

The XTF format conversion has two sections: bathymetry and 
side scan. 
For both sonar types, you must indicate the field used as the 
source for navigation and gyro/heading data. 
For side scan, there are additional options for converting 
horizontal tow fish layback or tow cable length distances. There 
are also options for reading the dynamic depth information for a 
remote operated vehicle (ROV).
 

1. Click one of following options to select a source for reading the 
navigation data fields:

• Raw navigation datagram

• Position

• Bathy datagram 

If you select Bathy datagram, the Ship and Sensor fields are 
enabled.
2. Select either the ship or sensor as a source for reading navigation data.

Note: Navigation data for the ship can now be read from the 
new XTFRAWNAVIGATION datagram that is available for 
Reson MBES data stored in XTF format by Triton ISIS.

If you select the Raw navigation option, the option to read the 
ship attitude data from the historical XTF attitude datagram or 
the new XTFRAWNAVIGATION datagram is activated. 



CARIS HIPS and SIPS User’s Guide 163

Convert Data: Data Format Options

3. Select one of the following options:

• attitude datagram

• raw navigation datagram

Convert Bathymetric data

To convert bathymetry data
4. Click the Convert Bathymetry check box.

5. Select a bathymetric data format from the Convert drop-down list:

• Multibeam 

• Multi-transducer 

• Single beam from records {Prim=0} or {Prim=1}:

If there are two channels of data, you can identify which channel 
contains the primary data 

• Single beam from AUX (1,2,3, or 4). 

Select gyro data field The Gyro data field source fields are enabled. One source is 
CMG (Course Made Good) from Navigation. Other options in the 
pull-down list are determined by the selections made in the 
previous steps. 

If you previously selected the Raw navigation datagram 
option to read navigation and attitude data then the option to 
use the same datagram for ship gyro data is available on the 
drop-down list.
If you previously selected the Attitude datagram option then 
the option to use that datagram is available.
If you selected either the Position or Bathy datagram options 
at Step 1, you can select from the following options:

• ship
• sensor
• attitude packet
• Course Made Good (CMG) from Navigation
• Course Made Good from SSS Navigation

Note: Benthos C3D data will be converted to two lines: 
multibeam and single beam. 

The singlebeam HIPS line (with the addition of 
_SingleBeam to the line name) will have the same set of 
navigation and attitude data as the multibeam line, but the 
sounding depths will be single beam data from the XTF 
sensor AuxAltitude field.
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Set reject soundings 
flags

The XTF format attaches quality flags to soundings. For 
example, with Reson sonars, 0 represents the lowest quality and 
3 represents the highest quality. You can reject soundings with a 
specific flag. These soundings are flagged as Rejected by 
Disabled Beam in HIPS.
6. Select a quality flag so the soundings with that specific flag value are 

rejected when converted to HIPS format.

If you are converting C3D or QPS data, you can apply filtering 
before moving to the next step.
If you do not want to apply filtering 
7. Click Next to continue with the import process.

Filtering To apply filters for Benthos C3D or QINSy QPS data
8. Select the Multibeam Filtering check box and click Parameters to 

select filtering options. 

The Filtering options dialog box is displayed.

Benthos C3D data can be filtered so that only the best quality 
data is imported into HIPS. You can apply the filter to port/
starboard beam angles.
1. Type a range of beam angles to select the cleanest data from the port 

and starboard beams.

All other options are applied to QPS data only.
The Range Filtering option converts soundings within a specified 
distance (in metres). Soundings outside of this range are not 
converted.
2. Select the Range Filtering check box to implement this option.

3. Click the up or down arrow buttons to select a minimum and maximum 
distance.
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The Amplitude Filtering option filters soundings according to 
amplitude value. For each ping (port and starboard pings are 
handled separately), the min/max amplitude values are 
obtained, and samples that fall below the selected percentage (0-
50%) are rejected.
4. Select the Amplitude Filtering check box to implement this option.

5. Click the up or down arrow buttons to select a percentage value for 
rejecting soundings.

The Statistical Filtering option controls which soundings in each 
swath are considered for conversion. This option calculates the 
mean depth and standard deviation within a swath sector or 
horizontal bin. It then prevents any soundings that fall outside a 
multiple of the standard deviation from being converted.
If Statistical Filtering is used, then the mean within the sector is 
re-computed. Ultimately, the soundings are sorted by their 
residual from the mean and those closest to the mean are 
converted. The actual number of soundings converted from 
within each sector is determined by the thinning factor (if used).
6. Select the Statistical Filtering check box to implement this option.

7. Determine a Threshold (multiples of the standard deviation) value by 
clicking the up and down arrow buttons.

The equivalent confidence value is displayed as a percentage.
The filtering and thinning methods are executed within a sector 
angle interval or a horizontal bin size. The sector angle option 
divides the swath into sectors according to degree angles while 
the horizontal bin size divides the swath into horizontal sectors 
based on a specified across-track distance.
Vessel motion and transducer mounting angles are considered 
when sector angle and horizontal bin locations are determined.
1. Select the Sector Angle Interval option and choose a degree level (to a 

maximum of 10º) by clicking the up or down arrow buttons.

2. As an alternate method, Select the Horizontal Bin Size option choose 
an across-track distance by clicking the up or down arrow buttons.

The thinning factor reduces the number of soundings converted 
on a per swath basis. The thinning factor uses a power of two 
reduction control (1/2, 1/4, 1/8, etc.) so that one of two, one of four 
or one of eight soundings can optionally be converted per swath 
sector.
3. Select the Data Thinning check box to implement the thinning option.

4. Select a Thinning Factor value by clicking the up or down arrow 
buttons.

5. Click Next to go to the Convert Side Scan Data dialog box.
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Convert Side Scan data

The XTF dialog box for converting side scan is displayed. 
If you do not want to convert side scan data then click Next and 
go to “CONVERT DATA” ON PAGE 137.
 

Note: Contact records created in Triton ISIS are also imported 
into HIPS when associated XTF data is imported.

To convert side scan data,
6. Click the Convert Side Scan check box.

7. Select one of four sonar channels by clicking an option.

8. Select one of following options to select a source for reading the 
navigation data for the towfish:

• ship

• sensor

• raw

• position

9. Select one of the following options from the pull-down list as a source 
for reading the gyro fields for the towfish:

• ships

• sensor

• attitude packet

• raw navigation

• Course Made Good from Navigation

• Course Made Good from SSS Navigation
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The XTF format flags repeated pings over an area as hidden 
data.
10. Select the Convert Hidden Data check box to include this data type in 

the SIPS project.

11.To enhance the image by scaling the intensity values, click the Apply 
Image Enhancement check box.

XTF side scan data can be in 16-bit or 8-bit format. If the data is 
in 16-bit format, you can choose to convert it to 8-bit format.
12.Select either the Preserve 16-bit option or Convert to 8-bit option.

If the Convert to 8-bit option is selected, the Scale and Shift options 
are enabled. The Scale option averages the data and the Shift 
option selects a initial bit value (between 0 and 8) and includes 
the next seven bit values for export. For example, if you typed 8 
as your initial value, then bits 8 to 15 are included in the export 
process.
13.Select the Scale option if you want to average the data into 8-bit format, 

or select Shift and type the value for the first bit.

14.Click Next.

The third XTF conversion dialog box is displayed.

15.If you want to recompute side scan towfish positions in HIPS with the 
recorded horizontal layback or tow cable length data, make sure the 
Cable Out/Layback box is checked.

16.Select one of the following options:

• from Layback field: The distance from the vessel towpoint to the 
towfish.

• from Cable Out field: The length of the tow cable to the towfish 
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17.If you selected Cable Out, enter a number in the Multiplier box to 
correct for integer value recording, if necessary.

18.Select the Calculate Sensor Depth check box to enable options for 
calculating the depth of the towfish below the waterline.

19.Type a number of the Auxiliary field that contains the total measured 
depth.

The total measured depth and the digitized height of the towfish 
are used to compute the depth of the towfish below the 
waterline. The towfish depth can then be combined with the tow 
cable length data and the vessel's tow point configuration to 
compute the position of the towfish.
When ship navigation is being read from the bathymetry packet, 
then the options available for the source of GPS ellipsoid height 
data are the RTK Packet and the Ocean Tide field in XTF.
However, if the ship navigation is being read from the new 
XTFRAWNAVIGATION datagram then the GPS ellipsoid 
height, if available, will always come from this new raw 
navigation datagram.
20.Convert the GPS height of the antenna or navigation sensor from:

• RTK packet

• Ocean Tide

21.If data is being collected from an ROV (Remote Operated Vehicle), 
click the check box to enable the source options for measurement of 
vehicle depth.

The auxiliary and sensor depth fields are enabled.
22.Click the appropriate check box to select a source for reading ROV 

depth data:

• Auxiliary

• Sensor Depth

23.Type the number of the Auxiliary field (from 1 to 6), if this option is 
selected.

24.Click Next to go to the step to “CONVERT DATA” ON PAGE 137 of the 
Conversion Wizard.



7
 Sound Velocity Correction

Sound Velocity Correction contributes to a more accurate soundings file 
by converting travel time and angle information into across-track and 
depth values. The process combines transducer orientation and 
positioning data from the HVF with Sound Velocity Profile data and 
applies a ray-tracing algorithm. 

In this chapter...
“SOUND VELOCITY PROCESSING” ON PAGE 170
“SOUND VELOCITY CORRECTION” ON PAGE 171
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Sound Velocity Processing 

Raw data formats such as XTF contain two-way travel time and 
beam launch angle data. The Sound Velocity Correction 
algorithm uses this data to calculate the length and path of the 
sound wave through the water column for each beam. 
Sound velocity processing is not available for all types of 
multibeam and single beam sonar data. Only those sonar 
formats that provide raw travel time and angle from the 
transducer are currently supported in HIPS. This includes 
multibeam bathymetry from XTF, Hypack, XSE and Simrad EM 
formats. 
For all other multibeam sonar formats, it is assumed that sound 
velocity corrections were applied during data acquisition. 

HVF For effective sound velocity correction, the Sound Velocity 
section of the HIPS Vessel file must be set up to define the 
transducer offsets. These offsets are used in Sound Velocity 
Correction, together with the Sound Velocity profile data. (See 
“SVP” ON PAGE 570 for these sensor configurations.) 

SVP file A sound velocity profile contains data on the acoustic velocity of 
the water column, in a text file divided into sections defined by 
time stamps. (See 
This data can be viewed and modified in the SVP Editor. (See 
“EDIT SVP DATA” ON PAGE 591).

See also 
“SVP FILES” ON PAGE 582

“CREATE A NEW SVP FILE” ON PAGE 583

It is recommended that sound velocity correction be applied to 
bathymetry before cleaning the data. Whenever SVC is applied, 
the Merge command should be applied to the data 
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Sound Velocity Correction

The sound velocity correction process uses a ray tracing 
algorithm to apply the sound velocity profiles. You can use either 
regular attitude data or smoothed data for applying vessel 
motion data to the ray-tracing algorithm (see “SMOOTH DATA” ON 
PAGE 578).
1. Select a track line or group of track lines.

2. Select the Sound Velocity Correction command.

The Sound Velocity Correction dialog box is displayed.
3. navigation data even if the data does not cover the entire line.

4. Select the Allow gap between records check box to limit the interval 
allowed between consecutive data records in the file. If an interval 
exceeds the amount specified in the Maximum field, the data will not be 
loaded and the process will stop.

5. If the time stamp in the file does not match the time stamps in the 
project, you select the Apply Time Offset option and type a time value 
(in seconds).

6. Click Load.

7. Select the Load New SVP File check box.

M
en

u Process > Sound 
Velocity Correction
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8. Click Select to choose an SVP file.

The Open an SVP File dialog box is displayed.
9. Select the file you want, or type the file path in the File Name text box. 

The default directory is …\Hips\Svp.

10.Click Open.

The file name and path is displayed in the text box.
11. If you want to edit the data with the SVP editor, click Edit (see “SVP 

EDITOR” ON PAGE 577).

When there is more than one sound velocity profile, the program 
can use one of four options for selecting an SVP at the time of 
each swath:
• Previous in Time: Select the profile with a time stamp prior and 

nearest to the time of the swath.
• Nearest in Time: Select the profile with a time stamp nearest to 

the time of the swath. This can either be prior to or after the 
time.

• Nearest in Distance: Select the profile with a position nearest the 
position of the swath. This requires that positions be included 
in the SVP file.

• Nearest Distance Within Time: Select the profile with a position 
nearest to the swath and has a timestamp nearest the time of 
the swath within a selected range.

The following diagram demonstrates the relationship of the four 
SVP options to the swath.
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P1=Previous in Time

P2=Nearest in Time

P3=Nearest Distance Within Time

P4=Nearest in Distance
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The above two graphics demonstrate the relationship of the 
profile options to the time/location of the swath. P1, P2 and P3 
all are calculated within a time period. P4 is calculated 
independently of the time period.
12.Select one of above options by clicking the appropriate check box. If 

you select the Nearest in Distance and Time option, make sure you 
select a time range for the timestamp.

Simrad EM data For Simrad EM data, the Sound Velocity Correction function 
requires the range/angle datagram to be recorded. The function, 
at a minimum, provides a re-computation of the across-track/
along-track/observed depth solution based on the new sound 
velocity profile starting with the recorded range/angle data for 
each beam.
An additional option switch is provided on the dialog box to 
perform an optional re-computation of the steered beam angles 
when you believe the recorded surface sound velocity is not 
reliable. In this case, a new surface sound velocity will be 
interpolated for each swath from the new sound velocity profile.

 

13.Select this check box to perform an additional re-computation of the 
steered beam angles based on a new surface sound speed that is 
interpolated from the sound velocity profile.

14.Select which smoothed sensor data is to be applied during sound 
velocity correction. Sensor data can be smoothed in the Attitude Editor 
(see “SMOOTH DATA” ON PAGE 578).

15.Click Process to apply the SVP file to the selected data.
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8
  Correct for Tide

Tidal data must be loaded for every track line to generate final depths. 
Tide files can be edited or new files created using the Tide Editor. 

In this chapter...
“LOAD TIDE” ON PAGE 176
“TIDE FILES” ON PAGE 178
“TIDE ZONE FILES” ON PAGE 178
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Load Tide

Tidal observation data must be loaded for every track line before 
the Merge process can be executed. Tide data is used to generate 
final depths relative to the tide datum by subtracting the tide 
from the sounding depth.
There are two options for tide loading:
• load a *.tid file to apply tide observations from a single 

station. (For information on these files, see “TIDE FILES” ON 
PAGE 178.)

• load a *.zdf file to apply tide observations from multiple tide 
stations to a tide zone. (For information on these files, see 
“TIDE ZONE FILES” ON PAGE 178.) 

To apply tide observation data to selected HIPS track lines,
1. Select the track line(s).

2. Select the Load Tide command.

The Load Tide dialog box is displayed.

Select tide files To use a tide file of observations from a single tide station for 
loading into the currently selected lines,
1. Choose the Single Tide Station Observations option.

2. Click Select… to choose a tide (.tid) file.

The Open Tide File dialog box is displayed.
3. Select a tide file or type the file path and name in the field.
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4. Click Open.

The tide file name is displayed in the Select Tide File field.
5. [Optional] To revise the tide file, click Edit to open the Tide Editor.

6. Click Load to associate the file with the selected track line(s).

Select tide zone files This option is available with or without weighted averaging from 
multiple tide stations. To apply a tide zone file to the currently 
selected lines, 
1. Choose the Multiple Tide Stations Using Tide Zones option.

2. To select a tide zone (.zdf) file, click Select …

The Load Zone Definition File dialog box is displayed.
3. Select a tide file or type the file path in the field.

4. Click Open.

The tide zone file is displayed in the Select Zone Definition File 
field.
5. Select the Weighted Averaging check box to apply this option. 

(see “TIDE STATIONS AND WEIGHTED AVERAGE” ON PAGE 179). If the selected 
doesn’t contain any averaging options, this option is not available 

6. Select the Compute Errors check box to apply the uncertainty value in 
the tide zone file. This value is used to create a tide zone uncertainty. If 
there are no error parameters in the file, this option is not available.

7. Click Load.

The tidal observation is loaded into the selected track lines using 
the tide zone definition file.
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Tide Files

When tide observations from a single station are applied to a 
track line or lines, the time extent of the line(s) is used. The 
illustration below shows the tide values from a single station 
that would be applied to three selected lines, based on the time 
each line was recorded.

Tide data from a single station is loaded from files with the 
extension *.tid. These files can be created or edited in a text 
editor (such as Notepad), or with the Tide Editor. 
HIPS supports a standard Canadian Hydrographic Service tide 
format called COWLIS as well as two NOS/NOAA formats. HIPS 
also supports a basic format consisting of just the required date, 
time, and tide values.
Track lines in areas without water level changes, such as rivers 
or lakes, must also have a tide file. In this case, or if tidal data 
cannot be obtained, a “zero tide” file—where all tide/time values 
are zero—is used so merging can proceed.
All tide files, including zerotide.tid, are located by default 
in…\Hips\ver\Tide. 
For more detail, see “TIDE FILE FORMATS” ON PAGE 733.

Tide Zone Files

When tide observations from multiple tide stations are applied to 
to a line or lines, tide zones are used. 
Where a survey line falls within two or more tide zones, the tide 
data to be loaded for each part of a line is determined by the zone 
in which that part of the line falls (as illustrated below). 
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The tide data file must span the entire time frame of the track 
line. The time zone of the tidal observation data must match the 
time zone of the survey data to which it will be applied. 
The output from the Load Tide function (see “LOAD TIDE” ON 
PAGE 176) attaches a binary HIPS tide-time series to each track 
line.
The tide zone option assigns tide observations to track lines from 
multiple tide stations based on the time period in defined 
geographic zones. 
Each tide zone is defined by a closed polygon with tide, time and 
range corrections for a primary station, plus up to three backup 
secondary tide stations. 
HIPS uses a Zone Definition File (with the extension .zdf) for 
defining tide zone data. This is an ASCII file and can be 
prepared with any text editor. 
For complete description of the ZDF format, see “TIDE ZONE 
DEFINITION FILES” ON PAGE 738.

Display tide zones Tide zones and station locations can be displayed. To view an 
outline of tide zones:
1. Select the Display Tide Zones command.

The Open Tide Zone Definition File dialog box is displayed.
2. Select a tide zone file, or type the file name and path in the File Name 

field.

3. Click Open.

The outlines of the tide zones, and their labels, are drawn in the 
Display window. The Tide Zones layer is listed in the Session tab 
of the Control window.

Tide stations and 
weighted average

When an average tide is calculated from multiple tide stations, 
the weight given to a tide station’s data is inversely proportional 

M
en

u View > Display Tide 
Zones
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to its distance from the vessel at that time. In other words—the 
further a station is from the survey line, the less weight is 
accorded to the data from that station.

Tide Editor

The Tide Editor presents tide file information in both graphical 
and tabular formats. You can use the editor to edit an existing 
file or to create a new tide file to apply to survey lines before the 
Merge process.
The Tide Editor is a separate application that launched from the 
HIPS and SIPS interface. 
For more information on how to use the Tide Editor, see “EDITING 
TIDE DATA” ON PAGE 552 or the help file available in that application.
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GPS Tide

The Compute GPS (Global Positioning System) Tide function 
provides an alternative to normal tidal observation for reducing 
soundings to the sounding datum
It is based on the recorded GPS ellipsoid height of the navigation 
antenna and uses the recorded vessel motion, if available, to 
reduce the ellipsoid height measurements to water level.
The following image demonstrates how GPS tide is calculated. 
The arrows indicate the positive sense of the values.

The full formula for GPS tide is:
GPS Tide = GPS Height - Datum Height + Antenna 
Offset - Heave + Dynamic Draft - Waterline Offset

The above diagram and equation show the complete formula for 
GPS tide where GPS Height needs to be motion corrected. 
However, in some systems, GPS Height may already be motion 
corrected. Applying sensor values (such as dynamic heave) again 
will only distort the final GPS Tide. The Compute GPS Tide 
command lets you include or omit selected sensor values.
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There are two options for applying the sounding datum height(s) 
(distance from the ellipsoid to the sounding datum) to the track 
line. 
• apply a single height to a track line, or 
• apply a binary or ASCII text file containing a grid of 

sounding datum heights.
Two binary sounding datum models can be used for computation 
of GPS tide:
• GEOID99
• EGG97 (European Gravimetric Geoid 1997)
Alternatively, an ASCII sounding datum model can also be used. 
The data must be in the following format: Lat,Long,Z. Values are 
delimited using a comma.
An example of the file is shown below.
-33.848326,151.192435,20.4
-33.849484,151.192370,20.1
-33.849237,151.193173,19.7
-33.849506,151.194227,19.8
-33.848298,151.193916,20.0
-33.848402,151.193149,20.2

ASCII datum model files must follow a specific format:
• Latitude and longitude must be in decimal degrees.
• The hyphen symbol (-) must be used to designate coordinates 

in the Southern or Western hemispheres.
• All files must be saved with a TXT or XYZ file extension.
To compute GPS tide, complete the following steps:
1. Select a track line or group of track lines.

2. Select the Compute GPS Tide command.

The Compute GPS Tide dialog box is displayed.

M
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u Process > Compute 
GPS Tide
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3. Enter the Sounding datum height to apply a single height to a track 
line.

4. To apply a file containing a grid of sounding datum heights, type the 
path and name for the Sounding Datum Model file, or click Browse to 
select a file.

5. Select the Smooth Height check box to apply smoothed GPS heights 
to the track line (see “SMOOTH DATA” ON PAGE 192).

The following check boxes apply sensor values to GPS tide if GPS 
Height needs to be motion corrected.
6. Select Apply Dynamic Heave to apply dynamic heave (regular vessel 

heave, or true heave if exists).

7. Select Apply MRU Remove Heave to apply remote heave resulting 
from vessel roll/pitch on an offset mounted MRU.

8. Select Apply Antenna Offset to apply vertical offsets as a result of 
rotating GPS antenna by vessel roll/pitch.

9. Select Apply Dynamic Draft to apply dynamic draft (as a result of 
interpolating the draft table in HVF, or stored in HIPS as time series 
data).

10. Select Apply Waterline Offset to apply the waterline offset in the HIPS 
Vessel File (HVF).

11. Select Apply Height Correction to apply a static offset to the GPS 
antenna and type the value in the Offset field.

12. Select From Installation XML to apply the waterline value from the 
InstallationParameters.xml generated by the Simrad converter.

13. Click Compute.
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The GPS Tide is calculated for the selected line(s). The settings 
in the dialog box are remembered by the application. 
You can open and view the GPS tide data in the Attitude Editor 
(“ATTITUDE EDITOR” ON PAGE 185).



9
Merge

The Merge process converts along-track/across-track depths into latitude, 
longitude, and depth by combining the ship navigation with the horizontal 
and vertical offsets from the HIPS vessel file. This produces 
geographically referenced sounding position and depth.

In this chapter...
“MERGE PROCESS” ON PAGE 186
“APPLY MERGE” ON PAGE 187
“DELTA DRAFT” ON PAGE 189
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Merge Process

Once Sound Velocity Correction has been applied, (see “SOUND 
VELOCITY CORRECTION” ON PAGE 171) the final sounding depth and 
geographical position need to be calculated. This is done with the 
Merge process. 
Tracklines must be Merged before BASE surfaces can be created 
and before surface cleaning can be performed. 
Merge takes into consideration the following:
• Observed depth
• Navigation
• Gyro
• Tide or GPS tide
• pertinent vessel configuration offsets
• Delta draft 
• Refraction coefficients 
• Dynamic draft
• Smoothed sensor data
• Waterline (if not applied in the SVC process)
• Motion data:Heave, Pitch, and Roll (if not applied in the SVC 

process)
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The following operations take place when merging:
• Recorded sensor information is compensated for constant 

time errors as noted in the vessel file.
• For each time-tagged depth record, the position for the centre 

of the swath profile is calculated based on the interpolated 
position fix at that time.

• For each depth record, the position of the sounding is 
calculated, based on the profile centre position and any gyro/
heave/pitch/roll corrections that are appropriate (this is echo 
sounder system dependent).

• Tide is interpolated and applied to each depth record. 
• Draft is applied.
A processed depths file is created for each line. This file contains 
the final computed geographic position for each depth record.

Apply Merge

Lines must have tide loaded before they can be merged. 
To apply Merge : 
1. Select a line or group of lines.

2. Select the Merge command from the Process menu or toolbar.

The Merge dialog box is displayed.

3. Click the Apply refraction coefficients check box to apply any data 
created in Refraction Editor. ( See “THE REFRACTION EDITOR” ON PAGE 326)

4. Click the Apply GPS tide check box to use GPS tide data instead of 
tidal observation data.
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If you have a SmoothedCoefficients file (see “SMOOTH DATA” ON 
PAGE 613) for a sensor, you can apply this file during merge to 
smooth selected sensor data.
5. Click the check box beside a sensor to select the appropriate data that 

is to be smoothed during Merge. 

6. Click Merge.

You can view the progress of the Merge process in the Output 
tab of the Worksheet window.
The Merge is now complete. Other functions requiring 
georeferenced soundings can now be used such as the Subset 
Editor, Surface Cleaning, BASE Surface and others. The 
settings in the dialog box are remembered by the application.

If a line is merged and then changes are made to the 
sensor data used by merge, the track line is marked as 
Outdated. An Outdated track line must be remerged.
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Delta Draft

The Load Delta Draft function lets you import your model for 
dynamic changes in draft and have these changes applied to the 
soundings during the Merge process. Delta Draft represents a 
change in draft that is positive as draft increases and negative 
as draft decreases. The data, which is loaded from a ASCII text 
file, overrides the Dynamic Draft information in the vessel file. 
The Delta Draft value is interpolated between timestamps in 
Merge and added to the Observed Depth to obtain the Final 
Depth.
The input format for the Delta Draft text file is similar to the 
COWLIS tide format. Each record is in the following format: 

YYYY/MM/DD HH:MM:SS.SSS 1.234

The Delta Draft function can also be used to load recorded depth 
versus time data for an underwater platform on which the 
multibeam sonar is mounted, such as a ROV (Remote Operated 
Vehicle) or AUV (Autonomous Underwater Vehicle), or towed 
vehicle.
1. Select the track line(s).

2. Select the Load Delta Draft command.

The Load Delta Draft dialog box is displayed.

3. Type the path of the file or click Select to locate the file.

4. To make changes to the file, click Edit.

The file is opened in the default text editor (such as Notepad). 
Make any changes and save the file.
5. Click Load.

The delta draft is loaded into the line folder.
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Compute TPU

Total Propagated Uncertainty (TPU) is used to assign a horizontal error 
estimate (HzTPU) and a depth error estimate (DpTPU) to each sounding.

In this chapter...
“TOTAL PROPAGATED UNCERTAINTY” ON PAGE 200
“COMPUTE TPU” ON PAGE 201
“TPU FILTERING” ON PAGE 202
“LOAD ERROR DATA” ON PAGE 205
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Total Propagated Uncertainty

Total Propagated Uncertainty (TPU) is essential for the 
following functions:
• creating S-44 or S-57 compliant datasets (see “TPU FILTERING” ON 

PAGE 202)
• calculating Bathymetry Associated with Statistical Error 

(BASE) Surfaces weighted by uncertainty (see “UNCERTAINTY 
WEIGHT” ON PAGE 224)

TPU is derived from a combination of all individual error 
sources. The following errors (among others) contribute to TPU:
• nav/gyro/heave/pitch/roll/tide errors
• latency error estimate
• sensor offset error estimates
• individual sonar model characteristics
Error values are located in the vessel file for the survey and the 
DeviceModels.xml file in …\HIPS\System. Other errors are 
directly entered in the Compute TPU dialog box.
The following sonar error-models in the DeviceModels.xml have 
been tested by the University of New Hampshire (UNH).
• Simrad EM300
• Simrad EM1000
• Simrad EM1002
• Simrad EM3000
• Simrad EM3000D
• Reson SeaBat 8101
• Reson SeaBat 9001
• Reson SeaBat 9003
• Reson SeaBat 8125
• Atlas Hydrosweep DS
• Elac Nautik 1180
• Seabeam 2112
Other sonars listed in the file may make assumptions that could 
produce less rigorous results than the error models supplied by 
UNH.
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Compute TPU

The Compute TPU (Total Propagated Uncertainty) command 
applies HzTPU and DpTPU values to each sounding along the 
track line.
The HzTPU and DpTPU values are stored line-by-line with 
indexing to profiles and beams. You can find specific error values 
for individual soundings by querying the soundings in the 
Swath, Single Beam, and Subset Editors. The HzTPU and 
DpTPU values are displayed in the Query View. 
Static errors (such as those related to sensor position) that are 
used to compute the TPU are read directly from the project’s 
vessel file and the DeviceModels.xml file. These errors are 
directly entered in the TPU computation. 
Dynamic errors due to tide and sound velocity values, which can 
change from time to time, due to a variety of reasons, are 
entered via the dialogue box, to make it easy for the user to 
change them. 
1. Select a track line in the Display window so it is highlighted.

2. Select the Compute TPU command.

The Compute TPU dialog box is displayed. 

3. In the Tide Values fields, enter the error offsets to be applied to all lines 
being processed. 

• The Measured offset is the error value for the tide station.

• The Zoning offset is the error value in range calculation for a tide 
zone file.

4. Enter error offsets for Sound Speed Values. 

• The Measured offset value is to compensate for inaccuracies in 
SVP measurements. 

• The Surface offset value is used to account for errors in surface 
sound speed measurements.
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Transducer motion offsets for sweep surveys are entered in the 
following three fields.
5. Type the estimated observed heave offset in the Peak-to-Peak Heave 

field.

6. Type the roll values for the transducers in the Max Roll field.

7. Type the pitch values for the transducers in the Max Pitch field.

8. Click Compute.

The results are displayed in the Output tab of the Worksheet 
window. A log file is also created showing the results.
 

TPU Filtering

The TPU filtering option rejects (or accepts) soundings with 
uncertainty values that fall outside limits set by International 
Hydrographic Organization (IHO) standards.
For other automated filters, see “ATTITUDE FILTER” ON PAGE 284, “SWATH 
FILTERING” ON PAGE 322, “SINGLE BEAM FILTERING” ON PAGE 472, and “FILTER 
CRITICAL SOUNDINGS” ON PAGE 297.)
These parameters can be saved in a HIPS Filter File (.hff) that 
can be reopened for use on another track line.
1. Select a track line.

2. Select the Set Filters command.

The Zoom To tab of the Set Filters dialog box is displayed.

The Compute TPU function must be performed after the 
Sound Velocity correction. Whether it is applied before or 
after Merge will depend on your adopted workflow.  When 
you compute TPU it will always be done on the Observed 
depths, therefore tide and draught offsets will not affect the 
values.

You should update TPU if the observed depths have been 
modified.
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3. Select the TPU tab.

4. [Optional] Select an existing HIPS Filter File from the list or click 
Browse to select a file.

If you load a filter file, all the values used in that file are shown 
in the fields. You can change any of the values.
5. Select either a Reject or Accept logic command to apply to the filtered 

data.

6. Complete all data in the necessary fields (see below).

7. Click Close, or click Clear to remove data from the fields.

8. Click Save As to save the settings to a filter file.

9. Apply the filters to the data.

The filter compares each sounding’s HzTPU and DpTPU values 
against the depth and horizontal error limits for a specific S-44 
survey order or S-57 zone of confidence (CATZOC) attribute. All 
soundings with HzTPU and DpTPU values outside those limits 
are rejected (or accepted).
When you select an S-44 or S-57 CATZOC standard, the dialog 
box is refreshed to display the options associated with that 
standard. The options for the IHO S-44 survey orders and S-57 
CATZOC attribute are shown below.
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Each survey order or zone of confidence contains the following 
fields:
• a: constant depth error (i.e. the sum of all constant errors)
• b: factor of the depth dependent error
• m: position limit for horizontal errors
• %: percentage of depth used to calculate horizontal error (S-

44 only).
Depth error limit To calculate the error limits for depth accuracy, the constant 

depth error (a) and the factor of the depth dependent error (b) 
are combined with depth (d) and the depth dependent error 
(b * d) in the following formula:

When the filter is run, soundings with a vertical uncertainty 
outside the error limit for the survey order or zone of confidence 
are rejected (or accepted).

Horizontal error limit To calculate horizontal accuracy, the limit for horizontal 
error (m) and (if applicable) the depth percentage (%) for the 
selected survey order or zone of confidence are compared against 

a
2

b d )×(+
2±Error limit for depth accuracy =
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a sounding’s HzTPU. Soundings with a horizontal uncertainty 
outside the limits are rejected (or accepted).

Run Filter 1. Select either the ISO 2-44 or S-57 CATZOC options.

The IHO frame of the TPU tab is refreshed to display the S-44 
survey order options or the zones of confidence (see above).
You can apply filtering to a selected depth range by entering the 
maximum and minimum soundings for that range. Leave these 
fields empty to apply filtering to every sounding along the track 
line.
2. Select the Depth Limit check box to apply the filters to a depth range.

3. Type depth levels in the Minimum and Maximum fields to set a range for 
the filters.

4. Select a survey order or zone of confidence option.

All fields in the User defined option are activated when this option 
is selected.
5. Type Depth and Horizontal values.

6. Run one of the Filtering commands.
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Load Error Data

Override error values in the HIPS Vessel File with real-time 
error values.
Applanix POS MV files and Applanix POSProc files contain real-
time attitude and navigation error values recorded during the 
survey. This means that different error values are recorded for 
different conditions. This results in more precise error estimates 
than the static error values recorded in the HIPS Vessel File.
The files must be timestamped with valid GPS entries to 
determine the time of the data. 
The imported files must contain the Julian date of the day the 
data was acquired in the form: YYYY-JJJ-filename or filename 
YYYY-JJJ
1. Select a track line in the Display window.

2. Select the Load Error Data command.

The Load Error Data dialog box is displayed.

3. Click Add to select files. You can load either POS MV files OR load 
POSProc files, but not both at the same time.

M
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4. To remove a file from the File List field, select the file and click 
Remove.

Reference Week 5. [Optional] To accommodate a GPS week rollover event, you can select 
the Julian date of the day the data files were created. The rollover 
cannot span more than 7 days.

Import Data 6. Choose which error records in the Applanix files you want to import into 
the line by clicking on the appropriate check boxes.

7. To reduce the volume of large attitude records to a manageable level, 
enter an output interval (in seconds).

Options 8. The Apply to all partially covered line option will load the error data 
even if the data does not cover the entire line.

9. Select the Allow gap between records check box to limit the interval 
allowed between consecutive data records in the file. If an interval 
exceeds the amount specified in the Maximum field, the data will not be 
loaded and the process will stop.

10.If the time stamp does not match the time stamps in the project, you 
can select the Apply Time offset option and enter a time value (in 
seconds).

11.Click Load.
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Field sheets in HIPS and SIPS are used to organize data products 
created from cleaned and processed bathymetry and side scan data. 

In this chapter...
“CREATE A FIELD SHEET” ON PAGE 210
“OPEN AND CLOSE FIELD SHEETS” ON PAGE 213
“SET FIELD SHEET PROPERTIES” ON PAGE 215
“FIELD SHEET PROJECTION GRID” ON PAGE 216



210 CARIS HIPS and SIPS User’s Guide

Create Field Sheets: Create a Field Sheet

Create a Field Sheet

Field sheets have a role in almost every process in HIPS and 
SIPS. They are essential for the creation of BASE surfaces. They 
are used to:
• create BASE surfaces. (“CREATE BASE SURFACE” ON PAGE 226)
• create a layer of contours from a BASE surface or a layer of 

tiles. (“CONTOURS” ON PAGE 348)
• create a layer of tiled soundings.
• generate a profile from a BASE surface.
• create a mosaic from side scan data.
• select soundings from a layer of tiles. (“SOUNDING SELECTION” ON 

PAGE 359)
To define an area for a new field sheet: 
1. Select the new New Field Sheet command.

The New Field Sheet Step 1 dialog box is displayed.

2. Type a name for the field sheet in the Name text box. Names should be 
alphanumeric characters only and cannot contain any spaces.

3. Define the scale of the field sheet.

The Horizontal Resolution field sets the minimum distance between 
two adjacent coordinate values in the field sheet. The first time 
you create a field sheet this field will contain the default value of 
0.020 (the minimum allowable resolution for S-57). You can 
reset this field to default to a different value. 
4. Type a new value in the Horizontal Resolution field, if needed.

M
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Sheet
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The Depth Resolution sets the minimum distance between two 
adjacent depth values. The Depth Resolution field contains a default 
value of 0.0010 (default resolution used in CARIS maps for 
heights/depths).Type a new value in the Depth Resolution field, if 
needed.
5. Click Next.

The New Field Sheet Step 2 dialog box is displayed.

This dialog box lists projections available to display your field 
sheet data. These are based on the coordinate systems and 
ellipsoid parameters as defined in the editable text file 
..\Hips\System\mapdef.dat. 
6. Select a projection from the Group column. 

The pre-defined projections specific to that projection system are 
listed in the Zone column. 
7. Select a projection from the Zone column. 

8. Click Next.

The New Field Sheet Step 3 dialog box is displayed.
9. Select either the Geographic or Ground coordinates option.

10.Define the field sheet extents by one of three methods:

• use the current extents of the Display window, or 

• use the mouse to create a box defining the extents, or

• enter the geographic or ground coordinates.
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Use current extents 1. Zoom in on the area you want to include field sheet so that it fills 
the Display window.

2. Click the Display Window Extents button.   

OR
Draw a bounding box 1. Click the Bounding Box button. 

The cursor in the Display window is shown as a cross-hair.
Press and hold the mouse button, and drag the cursor across the 
area where you want to create the field sheet.

A rectangular box is drawn across the area where the cursor was 
dragged.

• If you want to move the bounding box, position the 
cursor inside the box so it becomes a four-headed arrow. 
Press and hold the mouse button, and then drag the box 
to a new location.

• If you want to resize the bounding box, position the 
cursor on any of the box handles so the cursor becomes a 
two-headed arrow. Press and hold the mouse button and 
drag the handle to resize the box.

OR
Enter coordinates 1. Enter the northeast and southwest extents by clicking in one of 

the appropriate fields and typing the information, or by using the 
arrow keys to toggle the values into the entry fields.

After the area for the field sheet has been defined, 
11.Click Finish to create the field sheet.

The new field sheet is outlined in the Display window.
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The new field sheet data and files are located, by default, in 
..\Hips\Fieldsheets\ProjectName\FieldSheetName.
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Open and Close Field Sheets

Open a field sheet in a project or session. 

1. Select the Open Field Sheets command.

The Open Field Sheets dialog box is displayed.
2. Select a field sheet from the list of available field sheets.

3. Click Open.

The field sheet outline is displayed in the Display window. The 
field sheet file tree is displayed in the Layers tab of the Control 
window. 

Field sheet layers (for example, contours, soundings values or 
text), can be displayed by expanding the field sheet file tree and 
selecting a layer check box (you may have to select the Refresh 
command to view the data). 

Set as active field sheet It is possible to create field sheets with different coordinate 
systems and to have them open in the same session. But only 
one field sheet can control the coordinate system used in the 
Display window. 
The Set as Active Field Sheet function identifies the field sheet 
that controls the coordinate system in the Display window.
1. Select a field sheet file in the Control window and select the Set as 

Active Field Sheet command.

The field sheet is highlighted. 

NOTE: Opening a session file automatically opens all field sheets 
that were open when the session file was last saved.
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Turn off field sheet Individual layers in a field sheet can be activated or turned off 
by clicking the check box next to the layer. To make it easier to 
view data when there are many layers, or when more than one 
field sheet is open, you can turn off an entire field sheet with one 
command.
To remove a field sheet from the display without closing it:
1. Highlight the field sheet in the Layers tab.

2. Select Turn Off Field Sheet from the right-click menu.

All the previously selected layers of the field sheet are de-
selected. To display the field sheet or any of its layers again, 
select the check box beside the layer. 
To remove all the attribute layers of a surface (e.g., a BASE 
surface) in the field sheet, while continuing to display the field 
sheet:
1. Highlight the surface in the Layers tab. 

2. Select Turn Off Layers from the right-click menu.

The selected surface and all its attribute layers are no longer 
visible in the Display window.

Delete field sheet 1. Select the field sheet by name in the Layers tab.

2. Select Delete from the right-click menu.

The field sheet is permanently removed and does not go to the 
Recycle bin.

Close all field sheets

1. Select a field sheet from the Field Sheets tab in the Control window.

2. Select the Close Field Sheets command.

The field sheet outline is removed from the Display window and 
the file name is no longer displayed in the Control window.

Close single field sheet 1. Select a field sheet file in the Control window.

2. Right-click the mouse and select the Close command from the pop-up 
menu.

The field sheet is no longer open in the interface.
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Set Field Sheet Properties

To set the display properties of a field sheet:
1. Select a field sheet layer in the Layers tab of the Control window.

2. If the Properties window is not open, select the Properties window 
command.

The Properties window for field sheets is displayed.

The Extents, Coordinate System, Projection and Scale fields are 
read-only and cannot be modified. You can modify the following 
properties: 
3. Set the Show outline check box to “True” to display a border around the 

field sheet area.

4. Set the Show label check box to “True” to display the name of the field 
sheet in the Display window.

5. Select a border Colour from the colour picker, or, create a custom 
colour from the standard Windows Colour Palette.
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Field Sheet Projection Grid

The Projection Grid feature lets you display a grid of ground 
projection coordinates onto a field sheet. The grid will cover the 
field sheet area to its extents. (To display a grid over the extents 
of your project, see “PROJECTED GRID” ON PAGE 666.) 
The grid has grid line properties such as thickness, shape and 
colour. You can also annotate the grid with the coordinates of 
your field sheet data, and set the look and positioning of these 
annotations. These settings for the grid are saved with the field 
sheet. 
1. Select a field sheet in the Layers tab. 

2. Select the Projection Grid command.

The Grid Properties dialog box is displayed.

3. Set the options for positioning and style of grid lines as described in the 
table below. 

4. Click Apply if you want to set annotations. Click OK to apply the 
gridline settings and close the dialog box.
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5. Click the Annotations tab to set position and format of annotations 
for the grid.

6. The Annotations tab is displayed. 

Property Description

Corners The lower left and upper right corners of the rectangular field 
sheet determine the corners of the grid.

Lower Left The latitude (North) and longitude (East) coordinates of the 
lower left corner of the field sheet. 

Upper Right The latitude (North) and longitude (East) coordinates of the 
upper right corner of the field sheet.

Spacing The spacing of the gridlines is calculated by adding the 
spacing values to the 0,0 position until the grid fills the area 
defined by the corners.

Synchronize If you wish the spacing values to be the same, enable 
Synchronize.

North Set the latitude interval (North)

East Set the longitude interval (East).

Line Attributes Set a colour and line weight for the grid lines.

Colour Click on the Colour button and select a colour from the drop-
down list. 

Weight Units are millimetres at display scale.

Type Select the type of grid.

Full The grid will be formed of solid lines.

Ticks and 
Crosses

The grid will be formed of ticks and/or crosses.
If you enable Ticks, you can set the following options:

• Length (length of the markings in mm at display scale)
• Offset
• Alignment

If you enable Crosses, you can set the following option:
• Length (the dimensions of the crosses)
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7. Use the following table to complete the fields in the Annotations 
tab.

Property Description

Position 
Attributes

 Select any combination of Top, Bottom, Right, Left 
positions for the annotation.

Digits Show only the most significant digits. By default, the 
annotation is displayed in full.
• Thousand Separator: uses a comma to separate the digits 

to the right of the decimal point into groups of three. 
• Left: The number of digits to the left of the decimal point.
• Right: The number of digits to the right of the decimal 

point.

Format Select a font for the digits, and choose to have it positioned 
above or below the normal line of digits.
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8. Click OK to apply the values.

A grid of coordinates is generated and displayed in the Display 
window. A Projection Grid layer is added to the Layers tab.
.

Position • Position to neatline: placement of annotation relative to 
neatline , either Inside or Outside

• Offset from neatline: distance of the annotation from the 
neatline in millimetres

• Position to Grid: Choose Above /Left, Centre, or Below/ 
Right 

• Offset from gridline: the distance between the annotation 
and the grid line in millimetres

• Orientation to grid: Parallel to the grid or at right angles to 
it.

Property Description
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BASE Surfaces

The Bathymetry Associated with Statistical Error (BASE) Surface is a 
georeferenced image of a multi-attributed, weighted-mean surface. A 
BASE Surface can also contain a visual representation of horizontal and 
vertical uncertainty.

Three kinds of BASE surfaces can be created: 

• Uncertainty 

• Swath angle

• Combined Uncertainty and Bathymetry Estimator (CUBE)

In this chapter...
“OVERVIEW” ON PAGE 222
“THREE TYPES OF BASE SURFACES” ON PAGE 224
“CREATE BASE SURFACE” ON PAGE 226
“BASE SURFACE COMMANDS” ON PAGE 237
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Overview

A Bathymetry Associated with Statistical Error (BASE) Surface 
can be generated to provide either safety of navigation or a 
detailed examination of the seafloor.
An example of a BASE Surface image is shown below.

The BASE Surface is used for the following purposes:
• as a background visual aid when cleaning data interactively 

or automatically.
• to create a georeferenced TIFF that can be exported to other 

software such as real-time navigation systems.
• to export data as an XYZ text file so it can be imported as 

soundings in a CARIS map or used to build digital terrain 
models in other software.

• as a Product Surface that can be used to build contours, 
sounding selections, profiles, and other data layers. This data 
can later be used to create an ENC or raster chart.

• as a quality control feature for data. By viewing the 
uncertainty values for nodes, you can identify bad data and 
determine if an area needs to be re-surveyed.

A BASE Surface file is saved with a HNS extension (HIPS 
Navigation Surface). An XML file with the same name as the 
BASE Surface is also generated when the Surface is created. 
This file contains the metadata for the Surface.

Range weighting

All BASE Surfaces use range weighting to determine how a 
sounding is applied to a node. Range weighting is based on 
distance—soundings close to a node are given greater weight 
than soundings further away. The calculated node positions are 
determined by the corner coordinates of the field sheet.
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The range weight is inversely proportional to distance from the 
node: soundings closer to a node are given a greater weight than 
soundings further away.
The number of nodes each sounding is applied to is determined 
by the size of the beam footprint. The beam footprint is 
calculated using depth, sonar beam width, and the grazing 
angle. 
The sonar that is used, with the appropriate beam width, is 
defined in the BASE Surface wizard. 
A list of multibeam systems and corresponding beam widths is 
listed in ..\Hips\System\DeviceModels.xml. You can modify 
this file.
The following graph demonstrates range weighting using 
distance from a node in units of pixels (multiples of the BASE 
Surface resolution).
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Three types of BASE surfaces 

Three different surface types can be created:
• Uncertainty uses a weighting scheme based on depth 

uncertainty as specified by a selected S-44 survey order.
• Swath angle uses a weighting scheme based on a beam's 

intersection angle with the seafloor.
• Combined Uncertainty and Bathymetry Estimator (CUBE) 

surface uses multiple hypotheses to represent potential depth 
variances along the seafloor (see “CUBE PROCESSING” ON PAGE 255).

Uncertainty Weight

The weight that a sounding contributes to a node is inversely 
proportional to the predicted depth uncertainty of the sounding. 
The sounding’s depth uncertainty is scaled as a function of the 
sounding’s distance from the node. The propagation of the depth 
uncertainty to the node takes into account the sounding’s 
distance from the node AND the sounding’s horizontal 
uncertainty. Thus, both depth uncertainty and horizontal 
uncertainty play a role in determining the weight a sounding 
contributes to a node.
The sounding’s area of influence is a radius that determines the 
number of nodes to which the sounding can be applied. This 
radius is determined by the depth uncertainty of the selected 
IHO S-44 survey order (see formula below).   

Once the depth uncertainty is propagated beyond the selected 
S-44 survey order requirement for depth accuracy, then it has 
reached its area of influence limit.
All distance computations are based on the ground coordinate 
system defined for the BASE Surface—they are not simplified to 
cell distances. All of the nodes within a sounding’s area of 
influence are located rigorously. No simplified weight matrix 
scheme is used.

a
2

b d )× 2(+Depth Uncertainty =
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Swath Angle Weight

The weight a sounding contributes to the Surface also varies 
with the sounding's grazing angle with the seabed. 
This weighting value is important in areas with adjacent or 
overlapping track lines. The swath angle weight ensures that 
higher weight is given to beams from the inner part of a swath 
than to outer beams from adjacent track lines.
In the following graph, beams with a grazing angle between 90 
and 75 degrees are given a weight of 1.0. The weight decreases 
linearly to 0.01 as the angle with the sea floor decreases to 
15 degrees. .

This is the default swath angle weight scheme as defined by the 
file ..\Hips\System\GrazingAngleWeights.txt. The default file 
can be customized to other weighting scheme. 

CUBE 

The Combined Uncertainty and Bathymetry Estimator (CUBE) 
generates a surface that contains multiple hypotheses 
representing potential depth variances on the seafloor. 
Examining these hypotheses in the Subset Editor, you can 
determine if they are valid or not. The hypotheses can be 
replaced by alternative hypotheses (if necessary). 
Using a CUBE filtering tool soundings that fall outside specified 
parameters can be rejected and another CUBE Surface 
generated. Thus, CUBE is used in an iterative process to filter 
data to produce the best-possible representation of the surveyed 
area. 
For generation of CUBE surface and hypothesis editing see 
“GENERATING CUBE SURFACES” ON PAGE 259.
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Create BASE Surface

BASE Surfaces are created using a wizard. You can select 
specific track lines to include in the BASE Surface or let the 
wizard select them for you automatically. You can generate as 
many BASE Surfaces as necessary within a field sheet. 

To create a BASE Surface:
1. Open a field sheet of the area for the BASE Surface:

• To create a BASE Surface for the entire field sheet area, select the 
field sheet in the Layers tab in the Control window.

• To create a BASE Surface for a single track line, select a track line 
within the field sheet and then select the field sheet layer in the data 
tree.

2. Select the New Base Surface command.

The number of steps in the wizard is determined by the type of 
surface you are creating. 

BASE Surface (Step 1)

The BASE Surface Wizard (Step 1) dialog box opens.

1. Type a Name for the BASE Surface.

All track lines must be merged before a BASE Surface can be 
created.
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2. Type any necessary Comments in the text box, and click Next.

BASE Surface (Step 2)

The BASE Surface Wizard (Step 2) dialog box is displayed.

The Resolution value(s) sets the distance(s) between BASE Surface 
nodes. You can use the same single resolution value for the 
entire surface, or use different resolutions for each range of 
depths. 
1. Select Single and enter a resolution value, or select the Multiple option 

and enter a range of values.

If you select the Single option, you can determine the range of 
depths to include in the BASE surface by using the Depth Filter 
option.
2. Select Depth Filter and enter a range of depths. 

If you select the Multiple option, the depth ranges and related 
resolution values can be saved as a template to apply when 
creating other new BASE surfaces. 
3. Enter the series of depth ranges and the desired resolution in metres, 

and click Save to save the settings as a template.

OR
4. Click Load to use a saved file. 
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Values are entered in the following format: 
minimum depth - maximum depth, resolution (all in metres. For 
example, 0.0-10.0,5.0 which associates depths between zero and 
10 metres with a resolution of 5 metres
5. Select a Surface Type: CUBE, Uncertainty, or Swath angle. 

6. Click Next. 

The content of the next dialog box is determined by the choice of 
surface type made in step 5: 
“BASE SURFACE (STEP 3) - CUBE” ON PAGE 260

“BASE SURFACE (STEP 3) - SWATH ANGLE WEIGHTING” ON PAGE 228

“BASE SURFACE (STEP 3) - UNCERTAINTY WEIGHTING” ON PAGE 229
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BASE Surface (Step 3) - Swath Angle Weighting

If you selected the Swath Angle Weighting option at Step 2, the 
following BASE Surface Wizard (Step 3) dialog box is displayed.

The Max Footprint Size defines the maximum area in the Surface to 
which a sounding is applied. Use this value to prevent over-
expansion of the footprint due to large depth spikes or very 
shallow grazing angles.
1. Click the up and down arrow buttons in the Max Footprint Size.

If one or more track lines were selected before the BASE Surface 
process was started, the Use Selected Lines check box is enabled. 
2. Clear this check box if you want apply a BASE Surface to the field 

sheet area.

 The Accepted check box is selected by default.
3. Select either the Examined or Outstanding check boxes to include data 

with these status flags in the BASE Surface process.

4. Select Additional Attributes to be displayed in the BASE Surface.

5. Click Finish.

The Swath Angle BASE Surface is created.
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BASE surface (Step 3) - Uncertainty Weighting

If you selected the Uncertainty option, the BASE Surface Wizard 
(Step 3) dialog box is displayed.

1. Select an IHO S-44 Order from the drop-down list.

The a (constant depth error) and b (factor of depth dependent 
errors) fields are automatically filled when a survey order is 
selected. The values are read from 
..\HIPS\System\IHO_Standards.xml.
2. If one or more track lines were selected before the BASE Surface 

process was started, the Use Selected Lines check box is enabled. Clear 
this check box if you want to apply the BASE Surface to the entire field 
sheet area.

3. Select either the Examined or Outstanding check boxes to include data 
with these status flags in the BASE Surface process. The Accepted 
check box is selected by default.

4. Select the attributes to be displayed in the BASE Surface.

5. Click Finish.

The Uncertainty BASE Surface is created.
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View BASE Surfaces

In the HIPS interface, A BASE Surface layer is created and 
displayed in the Layers tab of the Control window. Attributes 
are displayed as sub-layers of the BASE Surface.

1. Click Expand ( + ) icon beside the Field Sheet file name to expand the 
directory tree in the Layers tab.

2. Display the BASE Surface by selecting the check box beside the layer.

The following attributes can be displayed in the BASE Surface 
(depending on the weighting method you selected in Step 6 and 
the selected attributes in Step 7):
• Depth: Depth at the node.
• Density: The number of soundings contributing to a node.
• Standard Deviation: The number of standard deviations 

that the node is from the mean.
• Uncertainty: The depth uncertainty assigned to each node.
• Mean: The mean depth calculated from all soundings 

contributing to a node.
• Shoal: The shoalest sounding contributing to a node.
• Deep: The deepest sounding contributing to a node.
3. To view or hide layers, select or clear the check boxes beside the layer.

.
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Properties

You can use the Properties window to view basic information 
about a BASE Surface or to set the display options for a BASE 
Surface attribute layer.

View Surface Properties
1. Select a BASE Surface layer in the Layers tab of the Control window.

2. Select the Properties window command, or right-click the layer and 
select Properties from the pop-up window.

The Properties window for the BASE Surface is displayed.
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Set Attribute Properties
1. Select a BASE Surface attribute layer (depth, density, mean, etc.) in 

the Layers tab of the Control window.

2. Right-click the layer and select Properties from the pop-up window.

The Properties window for the BASE Surface attributes layer is 
displayed.

3. Select a colour map or colour range file from the Colour Type drop-
down list.
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If you select Colour Map, the following options are available:
• Colour file: A list of pre-defined colour maps available for images

• Reverse Colours: Change the order in the colour map.
• Min Range: All attribute values equal to or less than this value 

are assigned the shallow end of the colour map.
• Max Range: All attribute values equal to or greater than this 

value are assigned the deep end of the colour map.
If you select Colour Range, you can use the Colour Range Editor to 
create custom colour ranges showing variances in attribute 
properties. Colour ranges can be saved as CRF files. 
4. Select a colour file from the drop down list or <New…> to open the 

Colour Range Editor is displayed 

5. If necessary, click Browse to modify existing colour maps or colour 
ranges, or create new ones (see “COLOUR MAP EDITOR” ON PAGE 234 and 
“COLOUR RANGE EDITOR” ON PAGE 235).

You can display a raster legend containing the colour map for an 
attribute and corresponding attribute values and set its position 
in the Display window. A Raster Legend is a scale of ranges in 
the selected colour map.

Use Labels field settings to display of the surface and attribute 
names in the title of the legend. Set a colour for the legend and 
its labels.
Display options include transparency and shading. 
Transparency sets a percentage level for viewing other features 
through the Surface area.
The Shading option controls the lighting angles of the BASE 
Surface. Using this option may highlight fine scale features of 
the Surface that would not normally be seen.
The Sun Position field sets the shading effect in the image. The 
Azimuth value varies from 0 to 360 degrees in a clockwise 
direction. The Elevation value varies from 90 to 0 degrees 
starting from the middle of sundial. Seleting the field opens the 
sundial control.
You can change the exaggeration of the illuminated sea floor by 
selecting a Vertical Exaggeration value. Increasing the 
exaggeration may improve the view of the fine scale features on 
the seabed.
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The Filter option controls the value ranges that are displayed in 
the BASE Surface. An example of using the filter controls is 
displayed below.

6. Select the Filter check box to activate the filtering options.

7. Type the range of attribute values to be displayed once the filter is 
applied.

8. Click Refresh to implement changes.

BASE Surface before filtering. All depth values ranging 
from 0 metres to 24 metres are displayed.

BASE Surface after filtering. Only depths between 0 metres 
and 18 metres are displayed
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Colour Map Editor

The Colour Map Editor dialog box allows you to modify colour 
maps and create new colour maps from existing maps.

The table on the top left section of the Colour Map Editor 
displays the colours and index values that represent the 
minimum depth for that the colour in the map.
The bottom part of the dialog box shows a histogram with the 
horizontal axis representing the colour range used in the image 
and vertical axis representing the number of pixels used to 
display the colour.
The first colour is the background and is always assigned to 
pixel value 1. The custom colour bar is filled from pixel values 1 
to 255. Pixel value 0 is always assumed to be transparent.
Below the histogram is a slider control with each slider 
representing a colour in the map.
The dialog box also includes the following commands:
• Add Colour: Add a custom colour to the colour list.
• Delete Colour: Remove a newly selected colour.
• Clear: Remove a colour from the colour list.
• Reverse: Reverse the shallow and deep ends of the colour 

map.
• Save As: Save a new colour map.
• Blend: Merge colours together.
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Change colour range You can change the range of an individual colour using the table 
or the slider control.
1. To change a colour range using the table, double-click a colour in the 

table.

The Add Colour dialog box is displayed.

2. Type a new number in the Value field and click OK.

3. Alternately, you can position the cursor on the slider representing the 
colour in the histogram and use the mouse to move the slider.

As the value is changed, the histogram and Value column in the 
table are refreshed to show the new colour value and range.

Add Colour You can add or remove colours from an existing map, or create a 
new colour map.
1. Click Add Colour or click directly on the slide bar.

The Add Colour dialog box is displayed.
The number in the Value field shows the pixel value of the 
displayed colour.
2. Select a colour from the colour palette or click Other to create a custom 

colour from the standard Windows colour picker, and click OK.

The selected colour is displayed in the dialog box.
3. Repeat the process to insert more colours.

As you select more colours, the colour values and the depths are 
displayed in a table. Each colour also has a slider control 
associated with it.
4. Move the slider to adjust the pixel value of that colour.

The Value and Depth data in the box adjusts as you move the 
sliders.
5. If you want to blend the colours, click the Blend check box.

6. If you want to remove a colour, click the colour value and click Delete 
Colour.

7. If you want to remove all the colours, click Clear.

8. Click Save to retain the settings as a colour map.

The Save As dialog box is displayed.
9. Type a file name for the colour map. All colour maps have a .cma 

extension and the directory always is ..\Hips\System.

10.Click Save to save the colour map to the directory.
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Colour Range Editor

The Colour Range Editor dialog box allows you to modify or 
create new colour range files.

The top part of the dialog box contains a table showing the range 
of depths and the colours used to represent those depths.
The bottom part of the dialog box shows a histogram with the 
horizontal axis representing the colour range used in the image 
and vertical axis representing the number of pixels used to 
display the colour.
1. To add a colour range, click Add.

The Add Range dialog box is displayed.

2. Type the minimum and maximum values in the Min and Max fields.

3. Select a colour to represent the minimum and maximum values from 
the colour picker, or create a custom colour using the standard 
Windows colour palette.

4. Click OK.

The colour range is listed in the table and displayed in the 
histogram.
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5. Repeat Steps 1 to 4 until all needed ranges are represented.

6. To remove a single colour range, select the range and click Remove.

7. To clear all colour ranges, click Remove All.

8. To save the ranges as a CRF for future use, click Save As to open the 
standard Windows Save As dialog box.

9. Click OK to close the Editor.
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BASE Surface Commands

Open

To open a BASE surface you first need to open the field sheet in 
which it was created. 
1. Select the Open Field Sheets command.

The Open Field Sheets dialog box is displayed.
2. Select one (or more) field sheet files from the list.

3. Click Open.

The field sheet file is displayed in the Layers tab of the Control 
Window and the field sheet outline(s) is shown in the Display 
window.
4. Click the ( + ) icon to expand the field sheet file tree.

5. Select the BASE Surface check box.

The BASE Surface is now visible in the Display window. 

Delete

Permanently delete a BASE Surface from a field sheet.
1. Select a BASE Surface layer in the Control Window.

2. Right-click and select the Delete command from the pop-up menu.

The BASE Surface layer is permanently deleted from the field 
sheet.

Add to BASE Surface

The Add to BASE Surface command applies new track lines to 
an existing surface without the need to regenerate the surface. 
You can add specific lines to the Surface or you can let the 
program select the lines to be added automatically. 
1. Select the track line layer in the Layers tab of the Control window.

2. Select the track line(s) you want to add to the BASE Surface so it is 
highlighted.

3. Select the BASE Surface layer in the field sheet file tree so it is 
highlighted.

4. Select the Add to BASE Surface command.

The BASE Surface Wizard dialog box (Step Two) is displayed.
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u File > Open Field 
Sheets
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5. Fill in the fields as needed.

6. Click Next.

The BASE Surface Wizard dialog box (Step 3) is displayed.
7. Fill in the fields as needed.

8. Click Finish.

The BASE Surface is updated to include new track lines.

Remove From BASE Surface

Remove a survey line from a Swath Angle or Uncertainty BASE 
Surface.
1. Select the survey line in the Project tab of the Control window.

2. Select a BASE Surface layer in the Session tab of the Control window.

3. Select the Remove from BASE Surface command.

The BASE Surface is regenerated without data from the selected 
survey line.
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u Process > Remove 
From BASE Surface
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New Layer

Create a new sub-layer in an existing BASE Surface. The layer 
is created using existing attributes and mathematical operators 
to create SQL-style queries.
1. Select a BASE Surface layer in the Layers tab of the Control window.

2. Select the Add Layer command.

The Compute Layer dialog box is displayed.

3. Type a name for the new surface layer in the Layer Name field.

The following steps create the criteria for the new surface. The 
criteria is determined by attributes and mathematical operators. 
You can insert as many attributes and operators needed to 
create the criteria.
4. Double-click any of the attributes in the Available Attributes list to insert 

the attribute into the field below.

5. Click any of the operators to add it to the field.

6. To remove the criteria from the field, click Clear.

7. Click OK.

The new layer is drawn in the Display window and is listed as a 
BASE Surface sub-layer in the Control window.
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Add Layer (Control 
window only)
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Recompute surface

The recompute function rebuilds a BASE Surface and 
regenerates the Surface image. 
1. Select a Surface name in the field sheet file tree so it is highlighted.

2. Select the Recompute BASE Surface command.

Only the track lines used previously in the Surface are processed 
during rebuilding. 
The Recompute operation checks to see if the surface makes use 
of HIPS data that is no longer present. 
If data is missing, a dialog box lists what is missing. You then 
have the option of terminating the Recompute process, or 
continuing without the missing data. 

M
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u Process > BASE 
Surface > 
Recompute
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NOTE: If you choose to continue, the replacement surface will 
have the missing data lines removed from its list of contributing 
lines.
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Interpolate BASE Surface

The Interpolate Surface command eliminates small holes that 
appear in areas of sparse data. This sometimes happens in the 
outermost beams along the outside edges of surveyed areas 
where there is little or no overlapping coverage.
This command examines each BASE Surface node to determine 
if it contains a pixel value. If the node does not contain a value, 
the neighbouring pixels are examined to determine if enough of 
them contain pixel values to justify interpolating a value for the 
hole. This limits the interpolation to holes in the BASE Surface 
and prevents it from expanding the surface outward from the 
survey area. A copy of the BASE Surface, with these gaps filled, 
is then created.
In the following example, in a 3 x 3 BASE Surface node area, five 
nodes have pixel values (shown in red). 

This means if you select five or less as the value for the Number of 
Neighbours, a pixel value is created for the node without a value 
from the neighbouring nodes. 
1. Select a surface layer in the Control window so it is highlighted.

2. Select the Interpolate Surface command.

The Interpolate BASE Surface dialog box is displayed.

The Destination BASE Surface field displays the file name of the copy 
that is created from the original surface. The default name is the 

This node does not 
contain a pixel value.

This node does contain a 
pixel value and can be 
used to interpolate a value 
for nodes without a pixel 
value.
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original BASE Surface name with _Interp appended to it. You 
can change the name, if necessary.
3. [Optional] Type a new name in the Destination BASE Surface field.

The Matrix Size determines the number of nodes closest to the node 
that can be used to interpolate a pixel value.
4. Select either the 3 x 3 or the 5 x 5 option.

The Number of Neighbours field is a threshold level used to 
determine the minimum pixels in the matrix area that must be 
present to interpolate a new pixel value. The matrix size 
determines the maximum and minimum values for the 
neighbours field. For example, if you select 3 x 3 for the matrix 
size, then the possible maximum number of neighbouring nodes 
with pixels is 9 and the minimum number is 3.
5. Type the number of neighbouring nodes used to interpolate pixels.

6. Click OK.

A copy of original BASE Surface is created and displayed in the 
field sheet data tree in the Control window. Note that the 
interpolated BASE Surface cannot be updated with the 
Automatic Update command in the Options dialog box.
As you can continue to re-interpolate the Surface, the effects 
accumulate to remove any remaining gaps. To do this, select the 
interpolated surface in the Control window and select the 
Interpolate Surface command again. The second interpolation is 
applied to the selected surface layer, you cannot create a new 
BASE Surface layer. 
Every time an interpolated BASE Surface is re-interpolated, the 
parameters are stored. Therefore, when using the Rebuild 
command (see “RECOMPUTE SURFACE” ON PAGE 240) on an interpolated 
BASE Surface, all interpolations are performed on the BASE 
Surface layer.
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Finalize BASE Surface

The finalized BASE Surface is a finished version of the Surface 
that is ready for export or for further processing (for example, a 
Product Surface). The automatic update function in the Options 
dialog box (see “GENERAL” ON PAGE 657) cannot be applied to a 
finalized Surface if soundings are re-cleaned in the Swath or 
Subset Editors.
Any of the following three operations can be applied to finalize a 
BASE Surface:
• Minimum uncertainty: Vertical uncertainty can fall to 

almost zero if a node contains too many soundings. This 
function applies a user-defined vertical uncertainty to each 
node to compensate for this situation.

• Designated soundings: If the dataset contains designated 
soundings, the Surface is regenerated and the designated 
soundings’ depth values are applied to the nearest nodes. (See 
“DESIGNATED SOUNDINGS” ON PAGE 207).

• Depth thresholds: A Finalized BASE Surface can be 
modified to represent a range of depths levels in the field 
sheet. When the Finalized Surface is generated, only these 
depths are displayed.

To create a finalized BASE Surface:
1. Select a BASE Surface layer in the Session tab of the Control window.

2. Select the Finalize BASE Surface command.

The Finalize BASE Surface dialog box is displayed.

3. The default name for the Finalized Surface is the name of the source 
BASE Surface with _Final appended to the end. You can change this 
by typing a new name.

M
en

u Process > BASE 
Surface > Finalize
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The values for calculating the uncertainty of the finalized 
surface can be selected from three sources:
• Uncertainty: The vertical uncertainty values in the source 

Surface.
• Std Deviation: The standard deviation values from the source 

Surface (scaled to 95% confidence interval).
• Greater of two: The larger of the two above values.
4. Select the Final Uncertainty from the drop-down list (this option is 

dimmed if source Surface does not contain uncertainty values).

5. Select the Minimum Uncertainty check box to enable this option.

6. Type a depth value to represent the minimum uncertainty.

7. Select the Apply Designated Soundings check box to use this option.

When this option is selected, designated soundings take prece-
dence over other soundings during the soundings selection proc-
ess. 

If this option remains unselected, designated soundings are proc-
essed no differently from other soundings. 

8. Select the Depth Threshold check box to create a finalized Surface that 
displays only node depths between the minimum and maximum depth 
values.

9. Type the minimum and maximum depth values in their respective 
fields.

10.Click OK.

A finalized BASE Surface is generated and visible in the Display 
window. The finalized BASE Surface is listed in the Session tab 
of the Control window.

Combine

The Combine options stitches two or more BASE Surfaces 
together to form one surface. This option is used when you have 
created finalized BASE Surfaces with different depth thresholds 
(see “FINALIZE BASE SURFACE” ON PAGE 243), or when you have two 
adjacent Surfaces with different resolutions. The geographical 
extents for the combined BASE Surface are determined by the 
geographical extents of the field sheet.
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1. Select field sheet in the Session tab of the Control window that contain 
the BASE Surfaces you want to combine.

2. Select the Combine command.

• The Combine BASE Surfaces dialog box is displayed.

A

B

Surface A displays 
depths between 0 and 
16 m. Surface B 
displays depths 
greater than 16 m. 

The Combine function 
joins these two 
Surfaces into one 
Surface.
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window only)
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3. Select the BASE Surfaces from the file tree by two methods (you may 
have to click the expand icon to view all the available Surfaces):

• Press <Ctrl> and select individual surfaces with the mouse.

• Press <Shift> and select a range of surfaces by clicking the first and 
last surface in the range. All surfaces between the first and last 
surface are selected.

4. The Output Folder field is read-only and displays the directory path of 
the selected field sheet. The combined BASE Surface is saved to this 
folder.

5. Type a name for the combined Surface.

6. Type a resolution for the combined Surface

7. Click OK.

A new BASE Surface that combines the selected Surfaces is 
generated. The combined Surface is listed in the Session tab of 
the Control window. The combined BASE Surface reproduces all 
the attribute layers contained in the source Surfaces.
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BASE Surface QC Report

The BASE Surface Quality Control report lists significant data 
gaps (“holidays”) within the surface and analyzes how much of 
your data conforms to the S-44 standard for survey orders.
1. Select a BASE Surface layer in the Control window.

t 2. Select the Surface QC Report command.

The BASE Surface QC Report dialog box is displayed. 

The top section of the dialog box sets the criteria for finding 
significant data gaps (known as “holidays”). A holiday is formed 
when enough gaps are clustered together within a specified 
radius. A layer that displays these holidays can also be created. 
This layer does not display every gap in the surface, but only 
those gaps that meet the criteria.
1. Type the number of nodes to use as a radius for searching for gaps in 

the Holiday Search Radius field.

2. Type the Minimum number of nodes that must contain data so that a 
holiday is not formed. For example, if the value is 6, then a node 
without data must be surrounded by five or less nodes with data to be 
included (with other empty nodes) in a holiday.

3. Select the Create holiday layer check box to create a layer displaying 
the data holidays selected by the search criteria.

The bottom section compares uncertainty values contained in 
the surface to the S-44 standard. This determines how many 
nodes within the surface meet the S-44 criteria.
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The depth levels shown in the dialog box are the minimum and 
maximum depth levels for each survey order. You can change 
these to conform with depths in your surface.
4. [Optional] Type new depth levels for any of the survey orders. You can 

have overlapping depth levels.

A text file of the QC report can be saved to a text format and 
viewed later.
5. Click Browse to select a directory path and name for the QC report. 

The path and name is shown in the Output File field.

6. Click OK.

The report is shown in the Output window and, if selected, saved 
to a text file. The Holiday layer is displayed in the Control 
window.

QC Report File example The following is an example of a QC report file: 
BASE Surface QC Report
----------------------
Date and Time: 11/9/2006 10:59:09 AM
Surface: 
d:\hips\FieldSheets\HIPSTraining\smallsheet\asdfasdf.hcs
Holiday Search Radius: 1
Holiday Minimum Number of Nodes: 6
Holiday layer created: Yes
Number of nodes processed: 6,181
Number of nodes populated: 6,131
Percentage of nodes populated: 99.191
Number of holidays detected: 5
IHO S-44 Special Order: 
     Range: 0.0 to 10.0
     Number of nodes considered: 620
     Number of nodes within: 0
     Residual mean: 0.307
S-44 Order 1: 
     Range: 10.0 to 100.0
     Number of nodes considered: 5,511
     Number of nodes within: 0
     Residual mean: 0.035
S-44 Order 2: 
     Range: 10.0 to 5000.0
     Number of nodes considered: 5,511
     Number of nodes within: 5,511
No depths within IHO S-44 Order 3
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Sections of a QC report 
file

The first section contains information about the report file and 
the options the data holiday options set in the dialog box:
• The data and time that the QC report file was created.
• The BASE Surface on which the QC report is based
• The holiday search radius.
• The minimum number of nodes required to omit a node 

(without data) from being included in a holiday.
• If a holiday layer was created or not.
The second section contains information on the number of nodes 
containing data:
• The total number of nodes processed in the surface
• The total number of nodes that contained data
• Percentage of the surface that contains data.
• Number of data holidays located.
The third section contains information about each S-44 survey 
order:
• The depth range for the survey order (set in the dialog box).
• The number of nodes within that depth range with 

uncertainty values that were considered for the survey order.
• The number of nodes that fall within the depth error limits 

for that survey order.
• The residual mean is derived from the computed and reported 

uncertainty. If the value is negative, the uncertainty values 
meet the requirements for the selected survey order. If the 
value is positive, the uncertainty values do not meet the 
requirements for the selected survey order. Therefore, if no 
nodes were considered for the survey order, the residual mean 
would have to be above zero.
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Surface Filtering

Surface filtering uses a scaled standard deviation or uncertainty 
threshold to reject soundings that fall outside that threshold.
Soundings that fall outside the threshold are assigned a 
Rejected by Surface Filter flag and are no longer available for 
processing (unless they are given an Accepted flag again).
For infomation applying a surface filter to CUBE surface, see 
“CUBE FILTERING” ON PAGE 272. 
1. Select a BASE surface layer in the Layers tab of the Control window.

 
2. Select the Surface Filter command.

The Surface Filter dialog box is displayed. 

3. Select the error values from either Standard Deviation or Uncertainty to 
set the threshold for the filter.

4. Select the Confidence Level from the drop-down list to scale the 
standard deviation or uncertainty thresholds.

5. Select the check box to include rejected data when running the filter.

6. Select the check box to reject soundings that are offset from the 
surface.

Click OK.

M
en

u Tools > Apply Filters 
> Surface Filter



13
CUBE Processing

A Combined Uncertainty and Bathymetry Estimator (CUBE) surface uses 
multiple hypotheses to represent potential depth variances along the 
seafloor.

In this chapter...
“INTRODUCTION” ON PAGE 256
“GENERATING CUBE SURFACES” ON PAGE 259
“HYPOTHESIS EDITING” ON PAGE 266
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Introduction

The CUBE process uses sounding propagation along with 
disambiguation to create and select hypotheses.
When soundings are propagated to a grid of estimation nodes:
• Soundings with a low vertical uncertainty are given more 

influence than soundings with high vertical uncertainty
• Soundings with a low horizontal uncertainty are given more 

influence than soundings with a high horizontal uncertainty.
• Soundings close to the node are given a greater weight than 

soundings further away from the node.
Generally, as soundings are propagated to a node, a hypothesis 
(depth value) is developed at that node. If a sounding’s value is 
not significantly different from the previous sounding then the 
same or modified hypothesis is used. If the value does change 
significantly, a new hypothesis is created. A node can contain 
more than one hypothesis.

In the above graphic, two soundings—S1 and S2—have similar 
values and therefore are part of the same hypothesis at the 
estimation node. However, sounding three (S3) has a 
significantly different value so it forms a new hypothesis.

Disambiguation The final process in CUBE is disambiguation. Disambiguation 
selects one hypothesis over others. There are four 
disambiguation options:
• Density: Select the hypothesis with the greatest number of 

sounding samples.
• Locale: Select the hypothesis that is most consistent with the 

surrounding nodes that have only one hypothesis.
• Locale and Density: Select the hypothesis the contains the 

greatest number of soundings and is also consistent with 
neighbouring nodes.

• Initialization: Select the hypothesis that is nearest to a node 
value of a previously created BASE Surface. Initialization 
differs from the other methods because it filters potential 
outlier soundings just prior to disambiguation.
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When a surface using the density and locale options is 
generated, two layers specific to the CUBE Surface are 
displayed.
• The Hypothesis Count layer is a visual representation of 

hypothesis density at a node. A Surface with a Hypotheses 
Count layer is displayed below.

• The Hypothesis Strength layer is a visual representation of 
the mathematical confidence of a chosen hypothesis. Each 
node is given a value ranging from 0.0 (high confidence) to 5.0 
(low confidence). Nodes with one hypothesis have a confidence 
value of 0.0 while nodes with multiple hypotheses will have 
confidence values greater than 0.0. A Hypothesis Strength 
layer is displayed below.

More than one hypothesis or a low confidence value does not 
necessarily mean an error. Uneven areas (slopes, for example) 
show more than one hypothesis because of the changing terrain. 
Nodes with multiple hypothesis should be examined in the 
Subset Editor. See “HYPOTHESES CLEANING” ON PAGE 271.
When you select the Initialization method of disambiguation, 
two additional layers are created:

Areas with multiple 
hypotheses are shown in 
a brighter colour than 
areas with only one 
hypothesis.

The brightly coloured areas 
represent nodes with more 
than one hypothesis.
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• Guide_Depth: Depths from the initialization surface.
• Guide_Uncertainty: Vertical uncertainty values from the 

initialization surface.
The User Nominated layer displays the nominated hypotheses 
that were chosen over the hypotheses selected by CUBE 
disambiguation (see “NOMINATE ALTERNATIVE HYPOTHESES” ON PAGE 269).
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Generating CUBE Surfaces

CUBE Surfaces are created using the BASE Surface wizard. All 
track lines must be merged and TPE must be computed before a 
CUBE Surface can be created.
To create a CUBE Surface:
1. Open a field sheet of the area for the Surface:

• To create a Surface for the entire field sheet area, select the field 
sheet in the Layers tab in the Control window.

• To create a Surface for a single track line, select a track line within 
the field sheet and then select the field sheet layer in the data tree.

2. Select the New Base Surface command.

The number of steps in the wizard is determined by the type of 
surface you are creating. 

BASE Surface (Step 1)

The BASE Surface Wizard (Step 1) dialog box opens.

1. Type a Name for the BASE Surface.

2. Type any necessary Comments in the text box, and click Next.

BASE Surface (Step 2)

The BASE Surface Wizard (Step 2) dialog box is displayed.
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Surface > New
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The Resolution value(s) sets the distance(s) between BASE Surface 
nodes. You can use the same single resolution value for the 
entire surface, or use different resolutions for each range of 
depths. 
1. Select Single and enter a resolution value, or select the Multiple option 

and enter a range of values.

If you select the Single option, you can determine the range of 
depths to include in the BASE surface by using the Depth Filter 
option.
2. Select Depth Filter and enter a range of depths. 

If you select the Multiple option, the depth ranges and related 
resolution values can be saved as a template to apply when 
creating other new BASE surfaces. 
3. Enter the series of depth ranges and the desired resolution in metres, 

and click Save to save the settings as a template.

OR
4. Click Load to use a saved file. 

Values are entered in the following format: 
minimum depth - maximum depth, resolution (all in metres. For 
example, 0.0-10.0,5.0 which associates depths between zero and 
10 metres with a resolution of 5 metres
5. Select a Surface Type: CUBE, Uncertainty, or Swath angle. 

6. Click Next. 
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The content of the next dialog box is determined by the choice of 
surface type made in step 5: 
“BASE SURFACE (STEP 3) - CUBE” ON PAGE 260

BASE Surface (Step 3) - CUBE

A sounding’s area of influence (the number of nodes to which a 
sounding is applied) is determined by the vertical uncertainty 
limit in a selected S-44 survey order. When a sounding’s vertical 
uncertainty increases beyond the requirement for the survey 
order then it cannot contribute to the node.
 

1. Select an IHO S-44 Order from the drop-down list.

The a (constant depth error) and b (factor of depth dependent 
errors) fields are automatically filled when a survey order is 
selected. These values are read from 
..\HIPS\System\IHO_Standards.xml.
If one or more track lines were selected before the BASE Surface 
process was started, the Use selected lines check box is enabled.
2. Clear this check box if you want to apply the BASE Surface to the 

entire field sheet area.

3. Select either the Examined or Outstanding check boxes to include data 
with these status flags in the BASE Surface process. 

The Accepted check box is selected by default.
4. If you are creating a CUBE surface, click Next.

5. If you are creating an Uncertainty surface, click Finish.
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BASE Surface (Step 4) - CUBE

1. Select a disambiguation method from the drop-down list. (These 
methods are described in “DISAMBIGUATION” ON PAGE 256.) 

2. Click Advanced to open the dialog for advanced settings. For more 
information, see “ADVANCED OPTIONS FOR CUBE SURFACE” ON PAGE 264. 

The Initialization Surface check box activates filtering tests to 
remove potential outliers from CUBE Surface processing. If you 
select the Initialization disambiguation method then you must 
complete the following fields. Otherwise, select Initialization 
Surface as an optional filtering method used in conjunction with 
other disambiguation methods.
3. Select the Initialization surface check box to activate the optional filtering 

function.

4. Type the path and name of an existing BASE Surface, or click Select… 
and choose the BASE Surface.

Initialization Surface filtering uses depth and vertical uncertainty 
values in an existing BASE Surface (the Initialization Surface) 
to exclude potential outliers from the new surface. There are 
three filtering tests:
• Minimum Difference is a set distance from an existing BASE 

Surface node. For example, if the Minimum Distance is set at 10 
metres, all soundings that are not within 10 metres of the 
node are excluded when a new Surface is generated.

• Filter Percentage is a percentage of depth at a node. For 
example, if the depth at a node is 20 metres and the 
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percentage value is 0.25, all soundings that are more than 5 
metres from the node (20x0.25) are excluded from the new 
Surface.

• Variance Scaler is a multiplier of vertical uncertainty at a node. 
For example, if the scaler is set to three and depth 
uncertainty for a node is one metre then soundings more than 
three metres (1x3) from the node are excluded from the 
processing of the new BASE Surface.
The shoalest values from the three tests are then used as the 
threshold to filter outlier soundings.

5. Select any of the three tests to filter soundings during disambiguation.

6. Click Finish.

A CUBE Surface is shown in the Display window and the layers 
associated with the Surface are listed in the Control window. See 
“VIEW BASE SURFACES” ON PAGE 230 for more information on display 
options.
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Advanced Options for CUBE surface 

The Advanced Options dialog box displays more detailed 
configuration settings for the CUBE surface. These settings are 
contained in the CUBEparams.xml file. You can use the settings 
in this file or select a custom configuration file. If you use a 
custom file, make sure that you use the same syntax and 
structure as the CUBEparams.xml file.
Changes made in this dialog box are saved to the 
CUBEparams.xml file or to the configuration file you selected.
When the Advanced button is clicked in the 
CUBE Surface (Step 4) dialog box, the Advanced Options dialog 
is displayed.
 

1. [Optional] Click Browse to select another configuration file. The file 
path is displayed in the Template File field.

2. Select a configuration setting from the Configuration drop-down list. If 
you select New, the New CUBE Configuration dialog box is displayed.
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3. [Optional] Type the name for the new configuration setting and click 
OK.

4. [Optional] Type any additional information in the Comments field.

5. Complete the following fields, as needed:

• Estimate Offset: The threshold for significant offset from current 
estimate to warrant an the creation of a new hypothesis. The value 
must be between 0.1 and 10.0.

• Capture Distance Scale: Scale on predicted or estimated depth for 
how far out to accept data. Value is a percentage of depth used to 
limit the radius of influence a sounding may have on the grid. Value 
must be between 1.00 and 100.00.

• Capture Distance Minimum: The minimum value (in metres) on 
predicted or estimated depth for how far out to accept data. This 
value is used in conjunction with Capture Distance Scale to limit the 
radius or influence of a sounding. Value must be between 0.0 and 
100.00.

• Horizontal Error Scalar: The value used to scale the horizontal error 
of each sounding when used in the radius of influence computation. 
Value must be between 0.0 and 10.00.

• Density Strength Limit: The strength value used to switch from the 
'density' disambiguation method to the 'locale' version when using 
the density & locale algorithm. Value must be between 0.00 and 
5.00.

• Locale Strength Maximum: The maximum strength value allowed as 
part of the mean in the locale algorithm. Value must be between 
0.00 and 5.00.

• Locale Search Radius: The radius of the search when computing 
the trimmed mean. The values are in pixels and must be greater 
than zero. The original system default value is 1.

• Null Hypothesis Test: Flag used to control the application of the 
NULL hypothesis test. Value must be either True or False. Default 
value is False. 

• Minimum Number of Neighbours: During the Null Hypothesis test, 
this controls the minimum number of neighbours that a node must 
have in order to be considered for the Standard Deviating Ratio test. 
If the node has less the specified number, it is automatically marked 
as 'Null'. Values must be between 2 and 8.

• Standard Deviation Ratio: During the Null Hypothesis test, this 
represents the cut-off limit for the standard devotion ratio including 
the node in question to the standard deviation of the qualified 
neighbouring nodes. If the computed ratio exceeds the specified 
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value, the node is marked as 'Null'. Values must be between 0.0 and 
10.0.

• Neighbour Strength Maximum: The maximum strength value that is 
allowed to be considered as part of the standard deviation 
computations in the NULL hypothesis test. Value must be between 
0.00 and 5.00.

Click OK to save and apply settings.
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Hypothesis Editing

CUBE surfaces can be displayed in the Subset Editor for 
examination and editing, using an iterative process to choose 
which of multiple hypotheses of depth values are the best ones to 
represent the sea floor.
To examine the CUBE Surface in Subset Editor:
1. Select the Subset Editor command.

2. Draw a subset bounding box.

3. Use the mouse to adjust the size of the bounding box by moving the 
handles

4. Load the subset.

Data contained in the bounding box area is loaded into the 3-D 
Subset view.
5. In the Subset Editor tab, select the CUBE Hypothesis layer.

The display options for the CUBE surface are displayed in the 
Subset Editor tab.

6. Expand the Select Surface data tree and select a BASE Surface 
containing CUBE data.

7. Click Load to view the CUBE surface.
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8. To return to the normal display in the 3-D and 2-D Views, click Unload.

Below is an example of a section of a CUBE surface in the 3-D 
View.

Hypotheses are represented as squares. Squares are shown with 
different dimensions to reflect the confidence level given to each 
hypothesis. These confidence levels range from 0.0 (the highest 
value) to 5.0 (the lowest value). The size of a square is related to 
the numerical confidence level: large squares represent nodes 
with the high confidence values while smaller squares represent 
nodes with low confidence values.
The thickness of the square represents the vertical uncertainty 
assigned a node (to a 95% confidence interval). The thicker the 
square, the greater the vertical uncertainty.
More than one hypothesis or a low confidence value does not 
necessarily mean an error. Uneven areas (slopes, for example) 
show more than one hypothesis because of the changing terrain. 
Hypotheses squares can also be displayed without a fill so that 
they are transparent except for the outlines of the squares.
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9. Select the Wireframe Hypotheses check box.

The 3-D View is refreshed to display the squares without fill.
The Fixed Size Hypotheses option flattens the hypotheses squares 
and redraws them to a standard size. This option is useful if you 
want to examine the dataset for holes or to see the exact position 
of a square in the subset.

10.Select the Fixed Size Hypotheses check box.

The 3-D View is refreshed to display the squares as flattened 
and in a standard size.
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Nominate Alternative Hypotheses

Some nodes have alternative hypotheses that were not selected 
during disambiguation You can view alternative hypotheses and 
compare them against the selected ones. If needed, the 
alternative hypotheses can be nominated to replace the 
established hypotheses.
11.Select the Show Alternative Hypotheses check box and click Apply.

The 3-D and 2-D Views are refreshed to display the alternative 
hypothesis. The following graphic shows the 3-D View with the 
alternative hypotheses displayed.

The red squares represent hypotheses that were not selected 
during disambiguation. The vertical lines that run between the 
nodes are viewing aides to match the alternative hypotheses to 
the selected ones.
1. To replace an hypothesis, select the alternative hypothesis.

The alternative hypothesis is highlighted. The Nominate and 
Clear commands are now active.
2. Select the Nominate command.

The alternative hypothesis is highlighted in blue. This means 
that the nominated hypothesis has replaced the established one. 
All nominated hypotheses are given the highest confidence value 
of 0.0.
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3. To compare nominated nodes against the existing nodes, clear the 
Show Alternative Hypotheses check box and select the 
Show Only Selected Alternatives check box.

The Views are refreshed to show only the nominated and 
established hypotheses. The following image shows the 3-D View 
with only nominated and established hypotheses displayed.

4. To remove the nomination flag, select the Clear command.

5. When you have completed nominating alternative hypothesis data, 
select the save command.

The User Nominated layer displays the nominated hypotheses 
that were chosen instead of the hypotheses selected by CUBE 
disambiguation.
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Hypotheses Cleaning

Like soundings in the Swath and Subset Editors, hypotheses can 
be given a rejected flag. When a hypothesis is rejected, it is 
retained in the Surface but is excluded from processing when 
disambiguation is run again or when filtering is applied.

Reject 1. Select a hypothesis

2. Select the Reject command.

The hypothesis is now flagged as rejected.
To change rejected back to the accepted status (and therefore 
available for further processing).

Accept 3. Select a hypothesis.

4. Select the Accept command.

The hypothesis is now flagged as accepted and is available for 
further processing.

Reject Node To reject all hypotheses at a node:
1. Select a hypothesis.

2. Select the Reject Node command.

All hypotheses associated with the node are rejected.

Accept Node To return hypotheses associated with a node to their normal 
status.
1. Select a hypothesis

2. Select the Accept command.

All hypotheses associated with the node are flagged as accepted.

Update CUBE Surface

If changes are made, the CUBE Surface can be rebuilt to show 
these changes using the following methods:
• Select the Recompute BASE Surface command (see “RECOMPUTE 

SURFACE” ON PAGE 240). 
• Select the Automatic BASE Surface Update check box in the 

Options dialog box (see “GENERAL” ON PAGE 657)

M
en

u Tools > Subset Editor 
> Reject

To
o

l
M

en
u Tools > Subset Editor 

> Accept

To
o

l
M

en
u Tools > Subset Editor 

> Reject Node

To
o

l
M

en
u Tools > Subset Editor 

> Accept

To
o

l



CARIS HIPS and SIPS User’s Guide 273

CUBE Processing: CUBE filtering

CUBE filtering 

A CUBE Surface can be used as a cleaning tool in the HIPS 
workflow. When a CUBE surface is created, soundings are 
weighted and contribute to surface grid nodes based on TPU 
values and distance from the nodes. (See “CUBE” ON PAGE 225.)
The CUBE surface allows for multiple depth estimates or 
hypotheses to exist at a single grid node, depending on the 
variation of the sounding data.  CUBE then uses 
“Disambiguation” to determine which hypothesis at each node is 
the most “correct”.
You can verify and, if necessary, override, CUBE decisions in 
Subset Editor.  Once any necessary edits have been made to the 
CUBE surface, the surface is updated. (See “RECOMPUTE SURFACE” ON 
PAGE 240

A surface filter can then be applied to the data.  Any sounding 
data that is not in agreement with the selected hypotheses will 
be flagged as rejected.
By applying this surface filtering we can greatly reduce the 
number of manual edits required by the hydrographer to 
produce a clean sounding data set.
Note: When following a CUBE workflow, this process is 
perfomed instead of other filtering such as Swath or Subset 
Editor filters.
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Data QC

Use the BASE surface to highlight problem with sensor data that may 
exist,and if necessary, edit problem areas. 

In this chapter...
“WORKFLOW” ON PAGE 276
“EXAMINE NAVIGATION DATA” ON PAGE 279
“ATTITUDE DATA” ON PAGE 284
“TOOLS FOR EXAMINING DATA” ON PAGE 289
“QUERY LINE DATA” ON PAGE 290
“SET LINE CLASSIFICATION” ON PAGE 291
“REJECT LINE” ON PAGE 292
“DESIGNATED SOUNDINGS” ON PAGE 294
“CRITICAL SOUNDINGS” ON PAGE 296
“RESTART CLEANING” ON PAGE 299
“QUALITY CONTROL REPORTS” ON PAGE 300
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Workflow

Problems with sensor offsets, auxiliary sensor data, etc. become 
apparent in the BASE Surface. Relying on a surface to highlight 
problems in the auxiliary sensors can improve processing 
efficiency, because the user is no longer required to investigate 
the motion and navigation for each survey line.
In the HIPS multibeam workflow described here, the auxiliary 
sensor data was not investigated prior to creating the surface. So 
at this point in the workflow, you can use the BASE or CUBE 
surface to highlight problem areas that may exist.
Certain edits will require that data be Merged again. For 
example, if you reload tide, edit navigation, or edit gyro, you will 
need to Merge the modified lines again. 
If you edit heave, pitch or roll, you will need to re-apply Sound 
Velocity Correction. If you re-apply SVC, recompute TPU before 
Merging again.
If any project lines are re-Merged, the BASE surface will need to 
be re-generated. See “RECOMPUTE SURFACE” ON PAGE 240.
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After data QC, the following processes can be applied to further 
clean data:
• statistical surface cleaning (see “CREATING TILES AND CLEANING DATA” 

ON PAGE 310)
• “SUBSET CLEANING” ON PAGE 331

• “SWATH CLEANING” ON PAGE 318

• filters 
• “FILTER CRITICAL SOUNDINGS” ON PAGE 297, 
• “ATTITUDE FILTER” ON PAGE 284, 
• “TPU FILTERING” ON PAGE 202, 
• “SINGLE BEAM FILTERING” ON PAGE 472.)
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Examine Navigation Data

Navigation outliers can affect the final positions of the 
soundings during the Merge process. Therefore, the navigation 
data should be (but is not required to be) examined and cleaned 
for any outliers. 
In Navigation Editor you can examine track lines to accept or 
reject, and query data, as necessary. 
There are two methods for locating navigation outliers:
• Examine the track lines and time graphs that show the 

computed speed, distance, and course made good between 
navigation points.

• Find speed and time jumps using the search functions in the 
Control window.

To edit lines in Navigation Editor,
1. Select a track line in the Display window.

2. Select the Navigation Editor command from the Tools menu or Tools 
toolbar. 

The Navigation Editor time graphs open in the HIS and SIPS 
interface and display relevant speed, distance, and course-made-
good data for the line.
3. Select data in either the Display window or the time graphs by pressing 

and holding the mouse button while dragging the cursor across the 
data.

The selected data is highlighted.
4. Release the mouse button when finished.

5. Select a reject (see “REJECT DATA” ON PAGE 282), accept (see “ACCEPT 
DATA” ON PAGE 283) or query (see “QUERY DATA” ON PAGE 283) option.

Speed jumps The Speed Jump option searches the track line for changes in 
vessel speed that are same as, or greater than, the Speed Jump 
value.
1. Ensure that the Control window is open and the Navigation tab is 

displayed.

2. Select the Automatic Query check box if you want to display the 
selected position fixes in the Query tab of the Worksheet window.

3. Enter a value in the Speed Jump check box.

4. Click the List Buffer up or down arrow keys to select the number of 
adjacent position fixes that are highlighted when a jump is found. For 
example if you choose 5, the two position fixes to the right and left of 
the selected fix are also selected.

5. Click Find.

6. Select Accept (“ACCEPT DATA” ON PAGE 283), Query (“QUERY DATA” ON 
PAGE 283) or one of the Reject “REJECT DATA” ON PAGE 282) options.
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7. Click Find again to move along the track line.

Time jumps The Time Jump option searches the track line for changes in 
time (in seconds) that are the same as, or greater than, the Time 
Jump value.
1. Ensure that the Control window is open and the Navigation tab is 

displayed.

2. Select the Automatic Query check box if you want to display selected 
position fixes in the Query tab of the Worksheet window.

3. Enter a value in the Time Jump box.

4. Click the List Buffer up or down arrow keys to select the number of 
adjacent position fixes that are highlighted when a jump is found. For 
example if you choose 5, the two position fixes to the right and left of 
the selected fix are also selected.

5. Click Find.

6. Select one of the Reject options (“REJECT DATA” ON PAGE 282), Query 
(“QUERY DATA” ON PAGE 283) or Accept (“ACCEPT DATA” ON PAGE 283).

Line Interpolation

Position observations do not usually occur at exactly the same 
instant as a depth observation (ping). Thus it is unlikely that 
there is position data for every ping.
For example, positions observations may be taken every second, 
(1 Hz frequency), while pings may be observed 10 times a second 
(10 Hz frequency). So, in most cases it will be necessary to 
interpolate positions to match the time for each ping. 
You use either linear or Bezier method of interpolation.
• Linear: Calculate new positions by connecting consecutive 

positions using straight lines. 
• Bezier: Calculate new positions by connecting points using a 

Bezier curve that does not necessarily connect all navigation 
positions. Bezier curves are available in three types: tight, 
medium and loose.

If you do not select an interpolation method then the default is 
linear. Linear interpolation is suitable if the original navigation 
positions are clean and do not significantly deviate from 
neighbouring positions. Bezier interpolation is suitable if the 
original data is noisy.
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In the Navigation Editor the interpolation method is set in the 
Interpolation method section of the Navigation Editor tab.
1. Select the Navigation Editor tab in the Control window.

2. Select either Linear or Bezier Curve by selecting the appropriate check 
box.

3. If the Bezier Curve option is enabled, select either a Loose, Medium or 
Tight format from the drop-down menu.

To set an interpolation option for one or more survey lines 
without opening the Navigation Editor, 
1. Select a line.

2. Select the Set Interpolation command from the Tools menu.

The Set Interpolation dialog box is displayed.

Linear Interpolation.

Bezier Interpolation: 
Loose

Bezier Interpolation: 
Tight

Bezier Interpolation: 
Medium
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3. Select an interpolation option: Linear or Bezier Curve 

Click OK.

Reject, Accept and Query Data

All data is marked as Accepted until flagged otherwise. Data can 
be queried for position fixes, and rejected using one of two 
alternatives: Reject with interpolation and Reject and break 
interpolation. These alternatives are illustrated below.

For some multibeam sonars, the data converted into HIPS has 
already been compensated for heave, pitch, and roll. Therefore 
heave, pitch, and roll are not applied during Merge as indicated 
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by the “Apply” options in the vessel configuration. However, it is 
still possible to use Reject–Break Interpolation on the recorded 
heave, pitch, and roll data which results in the sounding data 
during the same time period being rejected by Merge. 

Reject Data

Select from two reject data options:
• Reject-With Interpolation: Soundings associated with this 

navigation data are processed further since they have 
positions interpolated for them.

• Reject-Break Interpolation: Soundings associated with 
this navigation data are flagged as rejected and cannot be 
processed.

1. Select the data so it is highlighted.

2. Select a Reject command.

The selected data is now flagged as rejected.

Accept Data

All data is marked as accepted until flagged otherwise. Use this 
option to change the status of rejected data.
1. Select the data so it is highlighted.

2. Select the Accept command.

The previously rejected data is now flagged as Accepted.

Query Data

Examine data for further information.
1. Select the data so it is highlighted.

2. Select the Query command.

Information is displayed in the Worksheet window. Data an be 
rejected or accepted in this window.

Query Line

The Query Line command lets you view navigation data for an 
entire track line.
1. Select a track line.

2. Select the Query Line command.
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Attitude Data

You can examine and clean the motion data of the vessel or 
towed transducer using the Attitude Editor.
The Attitude Editor is displayed within the HIPS and SIPS 
interface. To open the Editor:
1. Select a track line so it is highlighted.

2. Select the Attitude Editor command.

The Attitude Editor is displayed

Attitude Filter

You can reject data with residual values that fall outside user-
defined threshold limits, and apply these changes to attitude 
data across entire track line(s). 
The Attitude filter can be used to accomplish two tasks:
• Smooth data: The Smooth function is used to smooth out 

localized variability. The parameters for creating the 
smoothed data are saved to the SmoothedCoefficients file in 
the HCDS_Data\Project\Vessel\Day\Line folder. This file is 
applied to the track line during any process that supports 
smoothing.

• Filter data: The Filter function is used to reject attitude that 
falls outside of defined boundaries. Soundings with the same 
time stamp as the rejected data are also flagged as rejected. 
You can choose to reject attitude data with interpolation.

These options are also found in the Attitude Editor.
1. Select a track line. 

2. Select the Set Filters command.

The Set Filters dialog box is displayed.
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3. Select a sensor from the list.

4. Select the Filter check box.

By default, the filter is set to “Reject with interpolation” so that 
soundings with the same time stamp as the rejected data are not 
also flagged as rejected. 
5. Clear the Reject with Interpolation check box if you want 

soundings associated with the rejected sensor data to also be 
rejected.

There are two filtering options: Moving Average and Fast 
Fourier. 
• The Moving Average calculates a mean for each data point, by 

calculating an average sensor value over a window of data 
using the Box Size parameter. The window is defined as a 
number of data points or seconds centred on a point. The 
average value for all of the values in the window is calculated 
and will be given to the central point. 

• Fast Fourier applies a common wave-smoothing algorithm to a 
data point. The Fast Fourier transformation performs a low-
pass filter on the selected sensor. You select a Box Size in 
either points or seconds.This value is converted into seconds 
and then inverted to become the cut-off frequency.

6. Select either the Moving Average or Fast Fourier filtering option.

7. Select the Box Size parameter by clicking the up or down arrow 
buttons. When using the Moving Average, the Box Size determines the 
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size of the window for averaging the data point. When using the Fast 
Fourier, the Box Size determines the cut-off frequency that is applied to 
all data.

8. Determine if the Box Size is in (data) points or time, by selecting the 
Points or Seconds option.

9. Click the Box Size up or down arrow buttons to select the number of 
adjacent data points.

10.Click the Threshold up or down arrow keys until you reach a desired 
value. Threshold is a multiple of the standard deviation (sigma).

11.Click Save As to save the filter settings to a HIPS filter file.

12.Select an Apply Filter command from the Tools menu.

The corresponding attitude data is rejected.
For other automated filters, see “SWATH FILTERING” ON PAGE 322, “TPU 
FILTERING” ON PAGE 202, “SINGLE BEAM FILTERING” ON PAGE 472, and “FILTER 
CRITICAL SOUNDINGS” ON PAGE 297.) 
See also “SMOOTH DATA” ON PAGE 613. 

Query attitude data 

Querying displays information about selected data. 
1. Press and hold the left mouse button while dragging the cursor across 

the data to be queried.

The data is selected.
2. Select the Query command.

The following data is displayed in the Worksheet window:
• time stamp
• d-time difference in seconds from last time stamp
• sensor value in either degrees or metres/feet
• d-value difference from last value
• status
The following two data values are related to the smoothing and 
filtering options (see “SMOOTH DATA” ON PAGE 613 and “ATTITUDE FILTER” 
ON PAGE 284):
• averages derived from adjacent data points
• difference between original data values and moving average 

or FFT value for each data point
Change data status flag to rejected or accepted.
1. Select the data in the Worksheet window so it is highlighted.

2. Select a Reject or Accept command.

The data is marked as accepted or rejected, depending to the 
option you selected.
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TrueHeave Data
Load TrueHeave data to a survey track line.
Applanix’s TrueHeave values are computed from real-time heave 
data and stored in a separate binary file along with the 
corresponding heave data. This file is not imported into HIPS 
during regular data conversion and has to be separately loaded to 
the track line. The location of TrueHeave files can be set from the 
Directories tab of the Options dialog box (see “DIRECTORIES” ON 
PAGE 674).
1. Select a track line.

2. Select the Load TrueHeave command.

The Load TrueHeave dialog box is displayed.

3. Click Add and select the TrueHeave file.

The file name is displayed in the dialog box.
4. To remove a file, select it and click Remove.

5. Select the Apply Time Offset if the time stamps in the TrueHeave files 
do not match the time stamps for the rest of the project.

6. Type the offset to synchronize the time stamps in TrueHeave files to 
the project.

7. If you are loading files logged over the GPS week number roll-over, 
use the drop-down box to select a reference date for the files to be 
loaded. 

8. To apply the TrueHeave data to the track line, click Load.
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Load Attitude/Navigation Data

Load attitude and navigation data from Applanix POS MV or 
POSProc files to selected track lines.
1. Select one or more track lines.

2. Select the  command.

The Load Navigation/Attitude Data dialog box is displayed.
.

3. Click Add to select the files by browsing to their location. You can load 
either POS MV files OR load POSProc files, but not both at the same 
time.

4. To remove a file from the File List, select the file and click Remove. 

Reference Week 5. [Optional] To accommodate a GPS week roll-over event, you can 
select the Julian date of the day the data files were created. The 
rollover cannot span more than 7 days.

Import Data 6. Click the appropriate check boxes to choose which attitude/navigation 
records you want to import into the track line(s) from these files.

7. To reduce the volume of large attitude records to a manageable level, 
enter an output interval (in seconds).
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8. The Apply to all lines that are partially covered option will load the 
navigation data even if the data does not cover the entire line.

9. Select the Allow gap between records check box to limit the interval 
allowed between consecutive data records in the file. If an interval 
exceeds the amount specified in the Maximum field, the data will not 
be loaded and the process will stop.

10. If the time stamp in the file does not match the time stamps in the 
project, you select the Apply Time Offset option and type a time value 
(in seconds).

11. Click Load.
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Tools for examining data

There are a number of tools available to assist examining data, 
and in tracking the progress of data cleaning. For example, you 
can: 
• examine information about one or more selected track lines 

(“QUERY LINE DATA” ON PAGE 290). 
• set a flag to indicate the type of survey line (“SET LINE 

CLASSIFICATION” ON PAGE 291).
• reject an entire track line to remove it from processing (“REJECT 

LINE” ON PAGE 292)
• show selected types of rejected data (“VIEW REJECTED SOUNDINGS” 

ON PAGE 293)
• preserve and highlight shoalist soundings (“DESIGNATED 

SOUNDINGS” ON PAGE 294)
• easily view Designated, Examined and Outstanding 

soundings when working with a large data set (“CRITICAL 
SOUNDINGS” ON PAGE 296)

• reverse previous depth cleaning by resetting status flags from 
“Rejected” to “Accepted” (“RESTART CLEANING” ON PAGE 299)
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Query Line Data

Examine information about one or more selected track lines.
1. Select track lines in the Display window or in the Project tab of the 

Control window.

2. Select the Query command.

The Query view in the Worksheet window can display more than 
40 different fields of data about each line. You can view all query 
fields by selecting Detailed Line Query in the General Options dialog 
box (see “GENERAL” ON PAGE 657) or only the most important fields by 
de-selecting this option. The information is read-only and cannot 
be modified.(see “WORKSHEET WINDOW” ON PAGE 18).
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Set Line Classification

Use this command to set or change a classification flag for a 
track line, to help distinguish between line types and purposes.
1. Make sure the Ship Track Lines layer is selected in the Layers tab of 

the Control window.

2. Select a track line in the Display window or Control window.

3. Select the Classify Lines command.

The Classify Lines dialog box is displayed.

4. Select from four options for setting the line classification flag:

• Check Line: A line that is run perpendicular to the survey and is 
used to check the validity of survey data.

• Patch Test Line: A line that is run over a surveyed area to calibrate 
sensor and sonar offsets.

• Shoal Examination Line: A line that is run over a surveyed area to 
re-check possible shoals on the sea floor.

• Track Line: A line that is part of the main survey grid.

5. Click OK.

The line is now flagged according to one of four categories.
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Reject Line

Use the Reject Line command to remove an entire track line from 
data processing. 
When a rejected line is merged, the profiles are marked as 
rejected, which prevents the soundings from being used in BASE 
surfacing, surface cleaning, and mosaicking. However, status 
flags on the individual soundings are maintained. A rejected line 
is not processed in the tiling operations or exported to a CARIS 
map or ASCII file.
1. Select a track line.

2. Select the Reject Line command.

The rejected line is displayed in the Project tab in the Control 
window with a red X beside the file name.
3. To change a rejected line back to accepted, select the Accept Line 

command.

The line is displayed in the Project tab of the Control window 
with a red exclamation point ( ! ) beside the file name. This 
indicates the line has been flagged as outdated. You must merge 
the soundings again before they are available for further 
processing (see “MERGE” ON PAGE 185).
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View Rejected Soundings

You can show or hide rejected data in the Attitude, Navigation, 
Single Beam, Swath, and Subset Editors. Data that was rejected 
in the Subset Editor can also be viewed in the Swath Editor.
1. Select the Show Rejected command.

You can also control which type of rejected data is displayed in 
the Single Beam, Swath, and Subset Editors.
2. Select the View command.

The Rejected Flag Types dialog box opens.
3. Place a check mark beside the box with the type of rejected data you 

want to view.

• Rejected by Swath/Single Beam Editor: View sounding data 
rejected in the Swath or Single Beam Editors or by the Swath or 
Single Beam filters.

• Rejected by Hydrographer: View data rejected interactively in the 
Subset Editor by the hydrographer.

• Rejected by TPE: View data rejected through the Total Propagated 
Error filtering process.

• Rejected by Surface Cleaning: View data rejected through the 
Surface Cleaning process.

• Rejected by Surface Filter: View data rejected through surface 
filtering.

• Rejected by Depth Filter: View data rejected by the depth filter in 
the Conversion Wizard or the Generic Data Parser when it was 
converted to HIPS format. 

• Rejected by Disabled Beam: View data rejected due to a disabled 
beam status during conversion. This occurs when the beam is 
disabled in the vessel configuration or if the sonar system flagged 
the beam as a bad detection in the raw data file.

4. Click OK.

The rejected data types you selected are displayed in the editors.
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Designated Soundings

The Designated Sounding flag identifies the shallowest sounding 
on important features. For example, in a cluster of soundings 
surrounding an outcrop of rocks, the shallowest sounding among 
that cluster would be identified as Designated.
The purpose of the Designated Sounding flag is to ensure that the 
shallowest depths over significant seabed features are 
maintained for standard hydrographic products.
When these soundings are applied to a Bathymetry Associated 
with Statistical Error (BASE) Surface, the Surface is regenerated 
so that the Designated Sounding’s depth value is applied to the 
nearest node (see“FINALIZE BASE SURFACE” ON PAGE 243).
The Designated Sounding option is available in the Swath and 
Subset Editors. Designated Soundings can exported to ASCII, 
CARIS, GSF, and HOB formats. The location of designated 
soundings can be viewed in the Display window. (See “CRITICAL 
SOUNDINGS” ON PAGE 296.)
To flag a sounding as shoalest,
1. Open either the Swath or Subset Editor, and load data.

2. Select the shallowest sounding from a cluster of soundings around a 
shoal feature. 

3. Select the Designated command.

When a sounding is flagged as Designated, it is displayed in the 
Subset or Swath Editor by a special symbol as shown in the 
zoomed in view below.

Find Designated 
Sounding

The Find Designated Sounding command automatically selects 
the shallowest sounding in cluster of highlighted soundings. This 
feature reduces the time needed to select a Designated Sounding.
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1. Use the cursor to highlight soundings in the Swath, Single Beam or 
Subset Editors.

2. Select the Find Designated command.

The shallowest sounding among the cluster of highlighted 
soundings is flagged as Designated.M

en
u Edit > Status Flag > 

Find Designated
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Critical Soundings

Display soundings that have been set with Designated, 
Examined and Outstanding status flags during subset and swath 
cleaning. (See “SUBSET CLEANING” ON PAGE 331 and “SWATH CLEANING” ON 
PAGE 318.) For more information on sounding status flags, see 
“STATUS FLAGS AND VALUES” ON PAGE 698.
Activating the Display Critical Soundings function reduces the 
time needed to locate Designated, Examined and Outstanding 
soundings when working with large datasets. 
It does this by creating a layer of critical soundings which can be 
turned on or off to display the soundings. 
1. Select the Display Critical Soundings command from the View menu.

When you select this command for first time, a message informs 
you that the file has not yet been built and that building this file 
might take time. This is because HIPS & SIPS is filtering the 
project data to collect and index all the critical soundings. These 
soundings are saved in a HCSIDX file that contains the line, 
profile, beam number and depth of all special soundings in the 
project.
If a file already exists, then it is automatically compiled.
A critical soundings layer is created and displayed in the Layers 
tab of the Control window.
2. Select the Critical Soundings layer. 

3. Select the Refresh command.

The soundings are drawn in the Display window according to the 
colour settings for each sounding flag (see “STATUS” ON PAGE 671).

Query Soundings To view information on specific soundings, select the soundings 
in the Display window and use the Query command. (See“QUERY 
LINE DATA” ON PAGE 290.) Information about the soundings will be 
displayed in the Query tab of the Worksheet window.
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u View > Display 
Critical Soundings
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Critical Sounding 
Properties

The status of critical soundings can be colour-coded using the 
Tools > Options dialog box. To colour code soundings,
1. Select the Display tab in the Tools > Options dialog box.

2. Select Status from the list.

3. Set the colours for the various status settings using the colour picker.

Display colours can also be set in the Properties window, where 
you can also change the font and type size for soundings. 
1. Highlight the Critical Soundings layer in the Layers tab to view and 

change properties in the Properties window.

To change the type face and font size of the soundings, 
2. Click the Font tab in the Properties window to view the standard 

Windows Font dialog box.

Filter Critical Soundings

You can set a protective spherical area around critical soundings 
to protect any other soundings within the sphere from being 
rejected when you apply automated filters. 
The size of this protective area is determined by setting a radius. 
You can also select to which type of critical soundings the 
protection will be applied. 

To prevent the neighbours of critical soundings from being 
rejected during automated filtering:
1. Select the Set Filters command from the Tools menu.

2. The Set Filters dialog box is displayed.

Data must be merged before critical sounding filtering is applied.
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3. Select the Critical tab.

4. Select the Enable Protective Radius check box.

5. Select which type(s) of soundings to apply the radius to.

6. Type the dimensions of the protective area in the Radius field.

7. Click Save or Save As to save your filter file so it can be applied with 
the Apply Filters command.

For other automated filters, see “SWATH FILTERING” ON PAGE 322, 
“ATTITUDE FILTER” ON PAGE 284, “TPU FILTERING” ON PAGE 202, and “SINGLE 
BEAM FILTERING” ON PAGE 472.) 
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Restart Cleaning

The Restart Cleaning function resets status flags from “Rejected” 
to “Accepted” for sounding, attitude, and navigation data.

1. Select the track line(s).

2. Select the Restart Cleaning command.

The Restart Cleaning dialog box is displayed.

3. Select any of the following check boxes to select a rejected data 
criteria.

• Rejected by Swath Editor/Single Beam Editor: Reset to accepted 
sounding data that was rejected in the Swath or Single Beam 
Editors, or by the Swath or Single Beam filters.

• Rejected by Hydrographer: Reset to accepted the sounding data 
that was interactively rejected in the Subset Editor.

• Rejected by TPE: Reset to accepted the data that was rejected 
during Total Propagation Error (TPE) filtering.

• Rejected by Surface Cleaning: Reset to accepted data that was 
rejected during Surface Cleaning.

• Rejected by Surface Filter: Reset to accepted data that was 
rejected during CUBE filtering.

• Rejected by Depth Filter: Reset to accepted data that was rejected 
by the depth filter during conversion.

• Rejected by Disabled Beam: Reset to accepted data that was 
rejected due to the disabled beam flag during conversion.

Warning: All previous depth cleaning is lost once this 
command is implemented.
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• Rejected with Interpolation (Navigation): Reset to accepted 
navigation data that was rejected without interpolation.

• Rejected break Interpolation (Navigation): Reset to accepted 
navigation data that was rejected without interpolation.

• Rejected with Interpolation (Attitude): Reset to accepted attitude 
data that was rejected with interpolation.

• Rejected break Interpolation (Attitude): Reset to accepted attitude 
data that was rejected without interpolation.

4. Click OK.

The selected data is now flagged as accepted.
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Quality Control Reports

The Quality Control (QC) process in HIPS is typically used to 
statistically compare soundings recorded from check lines 
against selected attribute values from a BASE Surface in the 
same survey area.
Statistical variances between the check-line soundings and the 
attribute values are shown in a table in the Worksheet window 
once the QC tool is run.
1. Make sure that the Project tab of the Control window is visible.

2. Select a survey line. You can also, if needed, select a Project, Vessel, 
or Day folder.

3. Select the Quality Control command.

QC Report - Step 1

The QC Report - Wizard Step 1 dialog box is displayed. 

1. Select a BASE Surface attribute from the Select Reference Surface list.

A template file is an XML file that contains output from the 
Quality Report. You can save the output as a template file or 
open an existing template file. If you open an existing template 
file, the settings saved in that file are applied to the options in 
the other dialog boxes.
2. Select the Use template file check box to create or open a template file.

3. Click Browse to select a location and name for the file or select an 
existing file.

4. Click Next.
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302 CARIS HIPS and SIPS User’s Guide

Data QC: Quality Control Reports

QC Report - Step 2

The QC Report - Wizard Step 2 dialog box is displayed. 

This dialog box selects the IHO standard for determining what 
percentage of soundings fall within a selected error limit for 
depth accuracy. You can use the S-44 Ed. 4 survey orders or 
S-57 CATZOC zones of confidence. For more information on how 
error limit for depth accuracy is calculated, see “TPU FILTERING” ON 
PAGE 202).
1. Select either the S-44 or S-57 option.

The dialog box is refreshed to show the categories relevant to the 
selected option.

2. To display a category in the QC report, select it in the Available list and 
click Add to move to the Active list.

If you are using the user defined (User Def) category, the a 
(constant depth error) and b (factor of the depth dependent 
error) fields become active once it is moved to the Active list.
3. [Optional] Type the values for the user defined category in the a and b 

fields.
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4. To remove a category, select it in the Active list and click Remove to 
move it back to the Available list.

5. Select a category and click the up or down arrow buttons at the top of 
the Active list to determine its order in the Active list. This will determine 
the order that data is displayed in the Worksheet window when the QC 
Report is generated.

6. Click Next.

QC Report - Step 3

The QC Report - Wizard Step 3 dialog box is displayed.

This dialog box defines how soundings are grouped in the QC 
Report. There are three options available:
• Beam number: Soundings are grouped according to across-track 

beam number.
• Angle: Soundings are grouped according to beam angle from 

nadir.
• Distance: Soundings are grouped according to across-track 

distance from nadir.
1. Select a method for grouping soundings from the drop-down list.

Soundings can be further organized by range. The range values 
must correspond to grouping method selected above.
2. Type the range in the Minimum and Maximum fields.

Ranges are incremented according to the value entered in the 
In steps of: field. For example, for beam numbers 1 to 100 with an 
increment of 10, the beams are then displayed in the QC Report 
tab in 10 rows.
3. Type a value to increment the ranges.



304 CARIS HIPS and SIPS User’s Guide

Data QC: Quality Control Reports

4. Click Add to display the range in the Defined Ranges list.

5. To remove a range, select it in the Defined Ranges list and click 
Remove.

6. To include rejected soundings, select the Include Rejected check box.

7. Click Finish to complete the wizard and close the dialog box, or click 
Cancel to close the wizard without implementing changes.

Quality Control Statistics

The quality control report is displayed in the QC Reports tab of 
the Worksheet window.

The fields are explained in the following table.

Field Definition

Beam Number Range grouping as defined in the third dialog box 
in the wizard.

Count Total soundings in range.

Max Maximum distance of soundings above surface.

Min Maximum distance of soundings below surface.

Mean Mean difference of soundings to surface.

Std Dev Standard deviation of mean differences is 
presented at one sigma or 68% Confidence 
Interval.

(Selected S-44 or S-57 
categories)

Percentage of soundings that fall within the 
selected S-44 survey orders or S-57 CATZOC 
zones of confidence categories.
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Statistical Surface Cleaning

The surface cleaning function is used to perform area-based statistical 
data cleaning on multibeam data in HIPS. 

The process uses advanced tiling technology for subdividing the entire 
area into variable size and density cells. It then applies rigorous 
polynomial regression statistics to compute the surface.

In this chapter...
“CREATING TILES AND CLEANING DATA” ON PAGE 310
“QUERY OPTIONS” ON PAGE 312
“TILE HISTOGRAM” ON PAGE 314
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Process

In surface cleaning, tiling is used to subdivide the area into 
manageable cells where each tile is considered separately during 
the polynomial regression and statistical threshold testing. The 
tile split criteria is based either on the density of soundings 
within the tile, or the tile size, or both.
The Surface Cleaning function automatically creates a Starting 
Level Tile set (even if you do not select the tiling option). The 
Starting Level Tile Set is created by taking the largest 
dimension of the field sheet and dividing the area by 3.
For each tile, a polynomial solution is computed using iterative 
least-squares re-weighted regression. The objective of the 
regression is to generate a surface defined by a set of polynomial 
terms, which closely matches most of the real depths. However, 
since the number of terms defining the polynomial surface are 
less than the number of points considered, then the points do not 
fit the surface exactly. Using the residual values of each point as 
a goodness measure, outliers can be detected by testing for high 
residual values.
The process is iterative within each tile, and for each new 
iteration the soundings are re-weighted inversely proportional to 
their previous residual. You can fix the re-weighting scheme to 
apply full weight to all soundings within a defined limit from the 
surface. This re-weighting limit can be based on a fixed distance 
or a multiple of the standard deviation of the residuals within 
the tile.
You can also define the maximum number of iterations. The 
buffer around each tile determines how much extra data is used 
to compute the tile polynomial surface. This helps eliminate 
edge effects during statistical testing.
The second stage of surface cleaning is the testing of the 
residuals once the surface has been computed. The relevant 
parameters are the rejection threshold scaling values in both the 
positive and negative directions (above and below the surface), 
and the minimum absolute residual of an outlier. The latter 
parameter specifies that no point within this distance (either 
above the surface or below) are rejected. This is an important 
parameter if the local standard deviation of a tile is small, 
because the scaling values are multiplied by a small standard 
deviation and may reject points which are only slightly removed 
from the surface. This parameter is location dependent and 
maybe used, for example, to prevent the rejection of rocks of a 
specific height. The rejection threshold values are also location 
dependent and surface dependent.
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The following table lists each of the polynomial surface types 
with the corresponding equation and a graphical example of 
each surface type.
 . 

Polynomial Surface Types

Surface Equation Example

Mean

Tilted Plane

Curved Tilted 
Plane

Quadratic

Cubic 

f xy( )– b0=

f xy( )– b0 b1x b2y+ +=

f xy( )– b0 b1x b2x b3xy+ + +=

f xy( ) b0 b1x b2x b3xy b4x2 b5y2+ + + + +=

f xy( ) b0 b1x b2x b3xy b4x2 b5y2
b6x2y b7xy2 b8x3 b9y3

+ + + + + +
+ + +

=
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Creating Tiles and Cleaning Data

 

1. Select a field sheet.

2. Select the Surface Cleaning command.

The Surface Cleaning box is displayed.

3. Set parameters for creating tiles, as needed, in the following fields:

• By Density: When this box is checked, each tile is continuously sub-
divided until one of the sub-tiles has less than the minimum number 
of soundings.

• Minimum soundings per tile: The minimum number of soundings in 
a tile.

• By Size: When this check box is selected, each tile is continuously 
sub-divided until the sub-tiles reach the minimum size (this size 
cannot be larger than the Starting-Level Tile Set.

• Minimum size of tile: The minimum size for a tile.

4. Type a name for the tile file. All tile files are assigned an .mts extension. 
Also created is a .mmi file that records the list of track lines used to 
create the tiles.

NOTE: Data must be merged before surface cleaning can 
be performed.
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5. Select the Cleaning check box to enable the surface cleaning functions.

6. Enter cleaning parameters, as needed, in the following fields:

• Shallow threshold: The threshold above the polynomial surface. The 
value is selected by clicking the up and down arrow buttons beside 
shallow threshold field. The sigma value is a multiple of the 
standard deviations of residuals in the tile. 

• Deep threshold: The threshold below the polynomial surface. The 
value is selected by clicking the up and down arrow buttons beside 
deep threshold field. The sigma value is a multiple of the standard 
deviations of residuals in the tile. 

• Sigma: The equivalent confidence values are displayed as a 
percentage.

• Minimum residual required for rejection: A sounding that fails the 
threshold test will not be rejected if the absolute value of the 
residual is less than the minimum.

• Include data previously rejected by surface cleaning: 

7. Click Advanced to view more cleaning options.

The Surface Cleaning dialog expands to display more cleaning 
options.
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8. Enter advanced tiling parameters, as needed.

• Degree of polynomial: Selection of available polynomials. Select the 
type that matches the expected complexity of the sea floor.

• Maximum iterations: The number of times the least squares 
computation of the polynomial processes the soundings. The 
computing continues until there are no additional rejected 
soundings or the maximum number of iterations is reached.

• By residual surface: The full re-weighting of soundings for each 
iteration can be fixed as a distance from the surface.

• By standard deviation: The full re-weighting of soundings for each 
iteration can be a multiple of the standard deviation of the residuals.

• Perpendicular to surface: When this option is checked, the residual 
is calculated as the perpendicular distance between the sounding 
and the nearest point on the polynomial surface. The default 
calculation for the residual uses the depth difference between the 
sounding and the polynomial surface at the location of the 
sounding.

• Tile buffer: The extra area around the tile that is included in the 
surface computation. The value is a percentage of the tile size and 
describes the width of the buffer around the tile.

9. Click OK.

The tiles are displayed in the Display window and the tile 
surface is listed (by the file name that was assigned in Step 4) in 
the Layers tab under its field sheet layer. The properties of the 
tiles can be viewed in the Properties window.

Properties of the displayed tiles
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Query Options

You can use two query commands to view attributes of tile data.
• Query Tile Surface: Display the polynomial surface 

parameters of selected tiles.
• Query Tile Soundings: Display information on all the 

soundings plus the residuals of selected tiles.

Query Tile Surface
1. Make sure the tiles are open in the Display window.

2. Select the tile layer in the Session tab of the Control window.

3. Press and hold the mouse button while dragging the cursor over the 
tiles to be queried.

4. Select the Query Tile Surface command.

The tile surface information is displayed in the Worksheet 
window.
• Count: number of points in the tile
• Rejected: the number of points rejected during surface 

cleaning.
• Z Mean: the mean depth in the tile.
• Residual_Sigma: standard deviation for residuals.
• Polynomial terms: the number of terms with values depends on 

the degree of polynomial you selected in the Surface Cleaning 
dialog box.
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Query Tile Soundings
1. Make sure the tiles are open in the Display window.

2. Select the tile layer in the Session tab of the Control window.

3. Press and hold the mouse button while dragging the cursor over the 
tiles to be queried.

The selected tiles are highlighted.
4. Select the Query Tile Soundings command.

The following data is displayed in the Worksheet window.
• East: easting coordinate for soundings.
• North: northing coordinate for soundings.
• Depth: depth of sounding.
• Surface Depth: depth of polynomial surface at the location of 

the sounding.
• Residual: difference between the sounding and the 

polynomial surface.
• Shallow Threshold: depth of rejection threshold above the 

polynomial surface.
• Deep Threshold: depth of rejection threshold below the 

surface.
• Status: status of the sounding.
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Tile Histogram

The Tile Histogram dialog box displays the distribution of 
residuals within a tile.
If the histogram resembles a bell curve then the selected 
polynomial is well suited for the area. However, if the histogram 
has many peaks or a wide centre, then the polynomial surface is 
not suited to the area. If there are severe shifts in data 
distribution, then the area may have to re-tiled using a higher 
degree of polynomial.
You can also use the histogram to change the threshold values 
and reject soundings.
1. Select the tiles you want to examine using the tile selection command.

2. Select the Tile Histogram command.

The Histogram dialog box is displayed.

Information about the tile is displayed on the right-hand side of 
the dialog box.
3. To view other tile data, click Next Tile or Previous Tile 

1. Position the cursor over the Shallow Threshold or Positive Threshold 
slide bars and while pressing the mouse button move the bars to a new 
position.

The corresponding confidence intervals and Maximum Residual 
Distance values change as the bars are moved.
2. Click Apply.

The rejected residuals are displayed in red.
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The Swath Editor displays multiple views of the data with controls for 
scaling, vertical exaggeration, colours, and so on. 

Data cleaning consists of interactively selecting and rejecting soundings 
and using proven and efficient filtering functions to automatically detect 
and reject outliers. 

You can also use the Swath Editor to flag Designated Soundings

In this chapter...
“SWATH CLEANING” ON PAGE 318
“MANUAL CLEANING” ON PAGE 318
“SWATH FILTERING” ON PAGE 322
“FLAG DESIGNATED SOUNDINGS” ON PAGE 325
“THE REFRACTION EDITOR” ON PAGE 326
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Swath Cleaning

During data conversion, the original data file is separated into a 
number of distinct files, each storing a different type of 
information. All are related by time. One of these files is the 
Observed Depths file. This file contains measured single beam, 
sweep, or swath soundings as reported by the data acquisition 
system.
The Swath Editor displays the contents of the file for sweep and 
swath systems on the screen in graphic form and lets you perform 
cleaning and filtering operations on the data.
For more information on the Swath Editor see “SWATH EDITOR” ON 
PAGE 635.
Sounding outliers can be rejected interactively (see “MANUAL 
CLEANING” ON PAGE 318) or by applying automatic swath filters (see 
“SWATH FILTERING” ON PAGE 322).

Manual cleaning 
1. Select a track line.

A track line must be selected before the Swath Editor editor can 
be opened.  
2. Select the Open Swath Editor command.

The Swath Editor opens with all views displayed. 
(For a complete description of the Swath Editor Interface, 
display options and controls, see “SWATH EDITOR INTERFACE” ON 
PAGE 636.) 
3. Select soundings to be cleaned. When soundings are selected they are 

highlighted in yellow.

Apply the appropriate flag to the sounding. These flags can be 
activated from the Edit toolbar or from the pop-up menu in the 
3-D View.
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You can also use the keyboard to set the flag: Accept (or the “A” 
key), Query (Q), Reject (R), and Reject Swath (S). 

Auto Cursor Mode To speed up the interactive process, use Auto Cursor Mode. This 
mode combines the selection and Accept/Reject/Query functions 
into a single procedure.
1. Select the Auto Cursor command.

2. Select a Reject/Accept/Query command.

3. Press the mouse button and draw a bounding box over the data.

4. Release the mouse button.

Search for Sounding Use the Find function to search for a sounding(s) by beam and/or 
profile number. 

Reject Data 

Each sounding in the HIPS format carries several status flag 
switches that the software turns on and off as needed. Each 
sounding begins as an Accepted sounding and can be rejected for 
any reason during processing. A rejected sounding it can always 
be returned to the accepted status without loss of data.

Edit Toolbar buttons 
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A sounding rejected within the Swath Editor has the Rejected by 
Swath Editor flag turned on.
To reject a sounding, complete the following steps: 
1. Select the data you want to reject.

2. Select the Reject command.

The Rejected by Swath Editor status flag is now on and the 
sounding may or may not be displayed depending if the rejected 
data is toggled to visible. (See “VIEW REJECTED SOUNDINGS” ON PAGE 293.)

Reject Swaths

In some instances it may be necessary to reject all soundings in 
one or more swaths. This can be done with the Reject Swaths 
function without having to select all of the data in the swaths.
1. Select some sounding in the swath you want to reject.

2. Select the Reject Swaths command.

All soundings in the swath (whether selected or not) now have 
the Rejected by Swath Editor status flag turned on. The 
sounding may or may not be displayed (see “VIEW REJECTED 
SOUNDINGS” ON PAGE 126). 

Accept Data

Change rejected soundings back to the Accepted status.
1. Select the rejected data so it is highlighted.

2. Select the Accept command.

The soundings are now flagged as accepted.
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Query Data

Select soundings to view status and other information. 
3. Select the data you want to query.

4. Select the Query command.

The following data about the selected soundings are displayed in 
the Worksheet window. You can control the amount of data that 
is opened in the Worksheet window through the Query Fields 
dialog box (see “WORKSHEET WINDOW” ON PAGE 19).
• time of the swath profile
• d-time from the previous profile
• profile number
• beam number
• across track distance
• along track distance
• depth
• d-depth from the previous profile
• d-depth from the previous beam
• amplitude / phase detect
• quality value
• status flag
• horizontal error value
• vertical error value

Change sounding status Once data information is displayed, you can change the status of 
the sounding.
1. Click the sounding data in the Worksheet window.

Select an Accept or Reject command.
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Swath Filtering 

When dealing with high-volume bathymetric datasets, it is 
advantageous to be able to reject outliers automatically. Using 
Swath filters can be an effective way to reduce the time it takes 
to clean large volumes of data. (For other automated filters, see 
“FILTER CRITICAL SOUNDINGS” ON PAGE 297, “ATTITUDE FILTER” ON PAGE 284, 
“TPU FILTERING” ON PAGE 202, and “SINGLE BEAM FILTERING” ON PAGE 472.)
There are three basic types of swath filters:
• Spike detection: The minimum and maximum depth filters 

and the beam-to-beam slope filters.
• Swath reduction: Across-track distance filters and nadir 

angle filters.
• Sonar quality: Quality values set by the sonar and missing 

neighbours. 
The parameters for filtering are set through the Set Filters dialog 
box. These parameters can be saved in a HIPS Filter File (.hff) 
that can be reopened in the Set Filters dialog box for use in 
another track line.
1. Select the Set Filters command.

The Swath/Sweep tab of the Set Filters dialog box is displayed
 

1. [Optional] Select an existing HIPS Filter File from the list or click 
Browse to select a file.
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If you chose to load a filter file, all the values used in that file are 
shown in the fields. You can filter data or change any of the 
values in the fields.
2. Set the logic to Accept or Reject.

3. Select the Include Filter check box to activate the filtering options.

4. Select the filter parameters used to flag data (see below).

You can define and apply more than one filter test. The filters are 
applied in sequence. Any data rejected by one filter is not 
considered in the next filter test.
5. Click Close, or click Clear to remove data from the fields.

6. Click Save As to save the settings to a filter file.

The following filters are available.
• Minimum Depth.Reject any soundings that are shallower than 

the depth specified (e.g., 10 m). 
• Maximum Depth. Reject any soundings that are deeper than 

the depth specified (e.g., 50 m). 
• Across Track. Beam-to-beam slopes, across-track. For each 

beam on the same swath, calculate the slopes in degrees to 
the prior and post beams, and if both slopes exceed the 
defined value and are of opposite sign then reject the beam. 

The Include Rejected option includes previously rejected 
soundings when recalculating the slopes during multiple 
runs of the filter.

• Across track distance: X Nadir Depth. Any soundings with an 
across-track distance, from the centre beam, greater than the 
nadir depth times this number (e.g,. 3.0) are rejected. For 
example, in 30 metres of water, with a setting of 3.0, all 
soundings with an across-track distance greater than 90.0 
metres are rejected. 

• Across track distance: Port. Filter a sounding if the across track 
distance on the port side is greater than the value entered in 
this field.

• Across track distance: Starboard. Filter a sounding if the across 
track distance on the starboard side is greater than the value 
entered in this field.

• Beam Numbers. Specify beams to be rejected. Separate 
individual beams with a space and specify a range of beams 
with a hyphen. For example, entering 12 32 56-60 72 rejects 
beams 12, 32, 56, 57, 58, 59, 60, and 72.

• Angles from Nadir: Port and Starboard. Filter beams that are 
outside of the designated angles (e.g., 60 degrees). Angles are 
computed from the nadir using depths and across-track 
distances (roll corrected).
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• Quality Flags. If your system attaches quality codes to 
soundings, and those codes are transferred to HIPS during 
conversion, a sounding can be rejected according to its value.

Missing neighbours are beams rejected during the conversion 
process into HIPS. This occurs if the beam is disabled in the 
vessel configuration or if the sonar system flags the beam as a 
bad detect in the raw data file.
• Port-Starboard. Beams are rejected if beams on each side of the 

swath are rejected.
• Forward-Aft. Beams are rejected if the adjacent beams in the 

previous and next swath are rejected.
• Any 2 of 4. Beams are rejected if two of the four neighbouring 

beams are rejected.
During filtering, only accepted soundings are used; therefore, the 
soundings rejected after one pass are not considered in the next.

Apply Filters

The last step is applying the automatic depth filter to the swath 
data.
1. Select an Apply Filter command to apply the criteria set by the Set 

Filters dialog box.

You have four options for applying the filters.
• Filter 1 Screen: Apply the filters only to the swaths that 

are currently visible in the Plan View of the Swath Editor.
• To End of Line. Apply the filters to the track line currently 

open in the Swath Editor, from the first swath currently 
visible in the Plan view to the end of the line.

• Selected Lines. Apply the filters to all of the currently 
selected track lines. This function does not require that the 
Swath Editor be open. 

• All Lines. Apply the filters to all track lines currently open 
in the Display window. This function does not require that 
the Swath Editor be open.

Quality flags are currently supplied by Reson, Elac, Hypack, 
and GSF multibeam systems/formats. 
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Flag Designated Soundings

The Designated Sounding flag identifies the shoalest sounding 
in a feature. The purpose of the Designated Sounding flag is to 
ensure that the shoalest depths over significant seabed features 
are maintained in charts and other standard hydrographic 
products. 
.Soundings can be designated in both Swath Editor and Subset 
Editor.
For more information, see “DESIGNATED SOUNDINGS” ON PAGE 294. 
1. Select the shoalest sounding from a cluster of soundings around a 

feature in the Swath Editor.

For example, in a cluster of soundings surrounding an outcrop of 
rocks, the shoalest sounding among that cluster is identified as 
Designated.
2. Select the Designated Soundings command.

The sounding is flagged as Designated.
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The Refraction Editor 

Since it is not possible to completely control the sound speed 
variations in water we apply sound velocity profiles to correct for 
this. However, refraction artifacts may still remain, especially if 
incorrect or insufficient sound velocity profiles are applied either 
during acquisition or during post processing.
To correct for this, you could choose to limit the usable swath 
angle (and therefore survey more lines), or you can use the 
Refraction Editor, which simulates the effects of altering the 
SVP to derive a better refraction solution.
Since refraction errors are most pronounced in the outer parts of 
the survey line coverage, they tend to create characteristically 
curved (upward or downward) refraction artifacts.
Apply the velocity correction at a user-defined depth. As you 
adjust the values, you can observe the changes in the shape of 
the swath profiles. When you arrive at the values which give you 
the desired correction, you can save these coefficients. Later, 
during the Merge process, you can apply these Refraction Editor 
coefficients that are recorded here. 
To open the Refraction Editor,
1. Open the Swath Editor, then select the Refraction Editor command.  

The Refraction Editor tab is displayed in the Control window.
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As you change the values in the dialog box you will be able to see 
the effects of these changes in the Swath Editor display.
2. Select the Preview check box to view the effects of your changes.

If the Preview option is selected, you can also enable the Apply 
Roll option. When you first open the Refraction Editor, this 
control is set to be the same as the setting in the Roll section of 
the Vessel file (HVF). This control allows you to quickly observe 
the effects of applying (or not applying) dynamic roll to the 
sounding data. 
NOTE: If there is no roll data, or if the appropriate Roll section 
cannot be found in the HVF, or if the survey line has already 
been sound velocity corrected, toggling the "Apply Roll" switch 
will have no effect. 
3. Select the Apply Roll check box to see the effects of roll on the data. 

4. Adjust the values for velocity correction and depth until the desired 
effect is observed.

5. Click Add to add the new entry to the list of coefficients.

6. To change an existing coefficient, adjust the settings and click Replace 
to update the list.

7. To remove an entry from the list select it and click Delete.

8. Click Save to save your entries.

The velocity correction and depth are recorded with the current 
swath profile number. While paging through the track line 
during cleaning, new swath/correction/depth values can be 
recorded.

Interpolation When you add the first Refraction Coefficient, the correction 
starts at that profile and goes to the end of the line with that 
same correction. If you add a second Refraction Coefficient after 
the first, the correction applied between the two profiles is 
actually interpolated. This is done so that there is no “jump” in 
the profile when the correction at the second Refraction 
Coefficient is applied to the data.
This interpolation is linear. That is, if the selected profile is 
between two refraction entries, the depth and delta velocity are 
both interpolated from these entries.

Querying Querying the data in the Swath Editor will always give the 
results from the display, so if you change the display with the 
Preview option of the Refraction Editor turned on, the query will 
return the results of the change.The Observed Depth data 
(across-track, along-track and depth) does not change.
The effects of the Refraction Editor can be turned on or off using 
the Calibration Module (see “CALIBRATION” ON PAGE 371). The effects 
on the final merged depths can be modified any time by editing 
the coefficients and re-merging, or the effects can be removed by 
re-merging and choosing not to apply the coefficients.
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Process Data in Subsets

Create subsets to efficiently visualize and clean data from multiple track 
lines at the same time, and use subset tiles to track the progress of 
processing. 

In this chapter...
“DATA CLEANING WORKFLOW” ON PAGE 330
“SUBSET CLEANING” ON PAGE 331
“TRACK PROGRESS WITH SUBSET TILES” ON PAGE 334
“SUBSETS AND BASE SURFACES” ON PAGE 339
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Data Cleaning Workflow

A subset is a user-defined rectangular area that contains some of 
the soundings of a survey project. Dividing the area of the survey 
into subsets makes the cleaning of a large data set more 
manageable.
The following workflow is a suggested method for cleaning data 
with the Subset Editor.
1. Open a field sheet with a BASE surface.

(See “CREATE A FIELD SHEET” ON PAGE 210)
2. Create Subset Tiles in the field sheet area.

(See “TRACK PROGRESS WITH SUBSET TILES” ON PAGE 334)
3. Open the Subset Editor and create a subset area using the subset 

bounding box in the tiled area.

(See “SUBSET EDITOR INTERFACE” ON PAGE 619 and “SIZE AND RESIZE 
SUBSET” ON PAGE 621)

4. Use the 3D View Controls to adjust the view of the data.

(See “THE 3D VIEW” ON PAGE 626, “THE 2D VIEW” ON PAGE 630)
5. Clean subset data.

(See “SUBSET CLEANING” ON PAGE 331)
6. Classify data in subset area.

(See “TRACKING CLEANING STATUS” ON PAGE 337)
7. Define another subset and repeat the process.

If you are processing a small amount of data, using subset tiles 
to track progress can be omitted (Steps 1 and 2), and the Subset 
Editor can be directly opened into the track lines.
However, if you are processing large areas of data, the subset 
tiling method is a useful way to track changes. 



CARIS HIPS and SIPS User’s Guide 331

Process Data in Subsets: Subset Cleaning

Subset Cleaning

Soundings in the 2D and 3D Views can be interactively 
examined and their status flags can be modified.
To open Subset Editor, 
1. Select the Subset Editor command.

2. Define a subset bounding box:

• Press and hold the left mouse button, and drag the cursor across 
the area that contains the data you want to include in the subset.

As the cursor is dragged across the Display window, a bounding 
box is drawn to show the area that will be included in the subset.
3. Select the Load Subset command to the load the data into the Subset 

Editor windows. (If the data will not load, check to ensure that your data 
has been Merged. See“MERGE” ON PAGE 185 for more information.)

The subset is generated and displayed in the Subset Editor 
windows. 
 

Reject

Each sounding in the HIPS format carries several status flags 
that the software turns on and off as needed. Each sounding 
begins as an Accepted sounding and if rejected, for any reason 
during processing, it can always be returned to the accepted 
status without loss of data.
A sounding rejected within the Subset Editor has the Rejected 
by Hydrographer status flag turned on.
1. Select the data you want to reject so it is highlighted.

2. Select the Reject command.

The sounding status flag, Rejected by Hydrographer, is now on 
and the sounding may or may not be displayed depending if the 
rejected data is toggled to visible.
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When selecting data in the 3D View, remember that all 
data in the highlighted area is selected, not just the visible 
data.
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Accept

Change rejected soundings back to the accepted status.
1. Select the rejected data that you want to accept.

2. Select the Accept command.

The soundings are now marked as accepted.

Outstanding

Flag a sounding as requiring further examination.
1. Select the data that you want flag as Outstanding.

2. Select the Outstanding command.

Examined

Flag questionable soundings as having been examined and 
verified.
1. Select the data that you want to flag as Examined.

2. Select the Examined command.
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Query

View information on selected data.
1. Select the data that you want to query.

2. Select the Query command.

The data is displayed in the Worksheet window.

Designated Soundings

The Designated Sounding flag identifies the shoalest sounding 
in a feature. The purpose of the Designated Sounding flag is to 
ensure that the shoalest depths over significant seabed features 
are maintained in charts and other standard hydrographic 
products. For example, in a cluster of soundings surrounding an 
outcrop of rocks, the shoalest sounding among that cluster is 
identified as Designated.
For more information, see “DESIGNATED SOUNDINGS” ON PAGE 294.
1. Select the shoalest sounding from a cluster of soundings around a 

feature in the Subset Editor.

2. Select the Designated Soundings command.

The sounding is flagged as Designated.
Shoalest soundings can also be designated in Swath Editor.
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Track Progress with Subset Tiles

Subset Tiles are used to track the process of examining and 
cleaning areas within the survey project.Each tile within a 
Subset Tile layer has one of three tracking settings: Incomplete, 
Partially Complete, or Completed (see “TRACKING CLEANING STATUS” ON 
PAGE 337).
The extents of the subset tile area can be determined in two 
ways: 

• the tiles cover the entire field sheet area, or
• the tiles cover the area of the field sheet that contains a 

height source, such as a BASE Surface.

The option to cover the entire field sheet area is useful if you are 
cleaning newly acquired data with the Subset Editor while the 
area is being surveyed. You would not have to create a new 
subset tile layer because of additional data in your project.
Subset tiles are produced in field sheets. To create subset tiles 
for tracking, 
1. Create a field sheet in your project.

2. Select the field sheet in the Layers tab of the Control window.

3. Select the New Subset Tiles command.

The New Subset Tiles dialog box is displayed.

Field sheet with 
BASE Surface

Tiles cover 
BASE Surface

Tiles cover entire
field sheet
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The Control Coverage by Surface option constrains the new subset tile 
area to a selected BASE Surface. When this check box is cleared, 
the subset tiles will cover the entire field sheet area.
To tile the entire field sheet, 
4. De-select the Control Coverage by Surface check box.

5. Type the tile size.

6. Click OK.

A Subset Tile layer is created and displayed within the extents 
of the field sheet area. 
To tile the area of a specific BASE surface, 
1. Select the Control Coverage by Surface check box to apply the subset 

tiles to a BASE Surface.

2. From the list, select the BASE surface to be used as the template for 
subset tiles.

3. Type the tile size.

4. Click OK.

The Subset Tile layer name is added to the Layers tab. The 
names are automatically generated beginning with 
SubsetTiles1. You can show or hide the layer with the check box 
beside the Subset Tile file name in the Layers tab.

Subset tile properties You can set display properties for tiles in the Properties window.
1. Select a tile layer in the Layers tab of the Control window.

2. Select the Properties window command, or right-click the layer and 
select Properties from the pop-up menu.
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The Properties window showing the display options for tiles is 
opened.  

The Active Attribute list contains all attributes included in the tile
(such as cleaning status and last modified date). When you select 
an attribute, the tile is displayed according to the attribute val-
ues.
1. Select an attribute from the drop-down Active Attribute list.

2. Select a colour map from the Colour Map drop-down list. 

3. Change how tiles are rendered to the Display Window by selecting the 
Display Level, either:

• Maximum: Draw all tiles
• Automatic: Draw tiles to fit the current extents of the Display window.

The Colour Fill Tiles check box determine how attribute values are 
drawn in the Display window.
• If the Colour Fill check box is set to “True”, the tiles are drawn 

according to the selected colour map.
• If the check box is unchecked and set to “False”, the tiles are 

drawn in outline only. 
4. Select a Transparency percentage to make features visible through the 

tiles. 

The Show Tile Borders check box determines how the border lines 
dividing the tile areas are displayed.
• If the Show Tile Borders check box is checked, the value is set to 

“True” and the lines are colour coded according to the colour 
selected in the Border colour field. 

• If the Show Tile Borders check box is clear, the value is set to 
“False”, and the borders of the tiles are not displayed.

5. [Optional] Select an alternative colour for the border lines from the 
colour picker in the Border colour field.
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Use the Display tile value field to turn the display of the 
attribute value on or off. For example, the cleaning status 
attribute has three values: 0,1 and 2. 
6. Select the Display tile value check box to set the value to “True” so the 

appropriate value is displayed in each tile.

View subset data in a 
tile 

Once the tracking tiles are created, you can examine and edit 
the data by opening Subset Editor and defining a subset. (See 
“OPEN SUBSET EDITOR” ON PAGE 619). You can clean data from the open 
subset (see “SUBSET CLEANING” ON PAGE 331).

Tracking Layer Properties

The layer containing the tracking tiles has options which can be 
set in the Subset Editor tab of the Control window (see “SUBSET 
EDITOR TAB” ON PAGE 623).
1. Open the Subset Editor and select the Subset Editor tab.

2. Select the Tracking layer.

The tab is refreshed to display the tracking options.
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3. Select the Subset Snapping check box to activate the snapping 
options.

4. Select the Tile Overlap check box so that the subset bounding box 
overlaps the tile by a selected percentage. This option is useful when 
you have data that overlaps the tile area.

5. Click Apply.

6. Select the Automatically Mark as Complete check box to flag the data 
as examined and cleaned. This can be changed later (see “TRACKING 
CLEANING STATUS” ON PAGE 337).

When the Automatically Mark as Complete check box is selected, two 
other options are made active.
7. Select the Mark all Subset Tile layers option to flag the tiles in ALL tile 

layers as completed, or select Mark only snap target to select tiles only 
in the selected tile layer as completed.

Tracking Cleaning Status 

Once you have examined and cleaned a subset of the data, the 
subset area can be assigned one of three classifications:

• Complete: All data in the selected area is clean and ready for 
further processing or export.

• Partially Complete: Not all the data within the area has been 
viewed and verified as clean in the Subset Editor.

• Reset: Data has not been verified or cleaned.

The area is colour-coded in the Subset Tile according to the 
selected cleaning status classification:
• Complete = green
• Partially Complete = yellow
• Incomplete or not processed = red. 
To assign a cleaning status to a subset area,
1. Select the appropriate status from the Subset Editor toolbar or from the 

Tools >Subset Editor submenu. 

The flagged tiles will be displayed with the colour appropriate to 
their status. Only tiles totally encompassed by the subset 
bounding box are flagged with the selected status command. 
Tiles partially covered by the bounding box are flagged as 
Partially Complete, as in the example below.
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Subset outline

Tiles with 
Complete 

Tiles with 
Partially 
Complete
status

status

Incomplete or
not processed
tiles
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Subsets and BASE Surfaces

BASE Surfaces can be shown in the 3-D View. This feature can 
be used to:
• determine the position of Designated soundings against an 

existing BASE Surface.
• determine if Designated soundings have been correctly 

applied to a Finalized BASE Surface. 
1. Select the Reference Surface layer in the Subset Editor tab.

The Subset Editor tab is refreshed to show the property options 
for the Reference Surface layer.

2. Select the BASE Surface from the Select Surface file tree.

3. Although the Depth attribute is used to display the surface, you can 
colour the surface by another attribute by selecting that attribute from 
the Colour by Attribute drop-down list.

4. Display the surface as a points, wireframe or a complete surface by 
selecting an option from the Display drop-down list.

5. Select a transparency level for the Surface, by moving the up or down 
arrow buttons.
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6. Click Load.

The BASE Surface is displayed in the 3-D View according to the 
above options.
7. [Optional] Click Unload to remove the BASE Surface from the 3-D 

View.
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Product surfaces can be created from finalized BASE surfaces. They 
maintain the designated soundings from the finalized BASE Surface and 
can be used to create more cartographically correct contours. Product 
surfaces can also be created from tile layers.

Use product surfaces are for building contours, sounding selections, 
profiles, and other data layers. 

In this chapter...
“PRODUCT SURFACES” ON PAGE 344 
“CONTOURS” ON PAGE 348
“PROFILES” ON PAGE 354
“SOUNDING SELECTION” ON PAGE 359
“COLOUR OPTIONS FOR SOUNDINGS AND CONTOURS” ON PAGE 368
“TILING” ON PAGE 370
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Product Surfaces

A Product Surface is a shoal-biased surface that can be used for 
creating more cartographically correct contours for navigation 
aids (for example, Electronic Nautical Charts). 
The Product Surface is down-sampled so that some of the finer 
surface details are no longer visible, while the shoals are 
preserved. This surface can be used to directly generate contours 
and selected soundings (instead of generating contours or 
selected soundings from tiles).

Process

A Product Surface is created through the process of 3D Double 
Buffering. This process smooths the surface to reduce clutter 
and highlight significant shoals. 
Double buffering is like rolling a ball over the surface at an 
interval determined by the surface’s node resolution. The radius 
of the ball is determined from the chart scale (radius = 1/100 of 
chart scale). As the ball is rolled over the surface, the surface is 
smoothed, but the shoals are retained.

Defocusing 

This optional process can also be applied to the generalization 
process. Defocusing spreads each shoal depth over an area 
defined by the horizontal error. The process uses an ellipsoid of 
rotation around each node with the horizontal error as the semi-
major axis. Nodes within the ellipse are adjusted up to the 
surface of the ellipse. 
In the following image, the webbed surface overlaying the BASE 
Surface represents the Product Surface area after defocusing 
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has taken place. The shoals are preserved, but without the 
sharply defined detail of the original BASE surface.
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Create a Product Surface

To create a Product Surface from a finalized BASE surface: 
1. Open the BASE surface.

2. Select the field sheet layer for the BASE surface.

3. Select the New Product Surface command.

The Create Product Surface dialog box is displayed.

4. Type a name for the new Product Surface.

5. Type the scale that best suits the type of chart.

The scale of the Surface should match the scale of the product 
being created. For example, if you are creating a Product Surface 
that is going to be used for an ENC approach to a harbour, then 
use the appropriate scale for an approach.
The scale determines the radius used for generalizing the 
contours of the Surface. The Radius value changes as the Scale 
value is changed.
The Resolution value sets the node spacing of the generated 
Product Surface.

6.Type a Resolution value, if needed.

7.[Optional] Select Surface Defocusing to implement this option.

The defocusing operation requires you to apply a horizontal error 
value. This value must be derived from the errors values 
associated with the data. 
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8.Type a Horizontal Error value.

9.Select the Reapply Designated Soundings check box to make sure that 
designated soundings are applied to the surface.

10.Click OK.

When the Product Surface is created it is listed in the Layers tab, 
with a Generalized layer which displays the nodes that were 
affected during the product surface-creation process.

The Product Surface layers are shown in the Display window 
when the check boxes are selected in the Layers tab.
In the following example, the brown dots belong to the 
Generalization layer and show which nodes have been modified 
by the Product Surface.

Nodes that have been modified are given a status flag of 1; nodes 
that retain their original values are given a status flag of 0.
When you create selected soundings from the Generalization 
layer, you can use SQL-type filters to omit nodes that have been 
modified. For more information on Selected Soundings, see 
“SOUNDING SELECTION” ON PAGE 359.
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Contours

Contours can be generated from a Product Surface, a finalized 
BASE surface or a tile layer. 
Contour smoothness is related to the amount of detail in your 
depth source. A finely detailed depth source will result in 
rougher contour lines. For smoother contour lines, use a 
smoothed Product Surface as a source for contouring. 
You can label contours with depth values, adjust the size and 
colour of contours, and mask the lines behind the contour label.

Create Contours 
1. Open a Project and a Fieldsheet containing a BASE surface.

2. Select the field sheet layer in the Layers tab.

3. Select the New Contour Layer command.

The Contour Wizard - Step 1 dialog box is displayed. 

4. Expanding the layer tree and select a tile, Product Surface or 
BASE Surface attribute layer to be the height source for the 
contour interpolation.

5. Click Next.

The Contour Wizard - Step 2 dialog box is displayed.

M
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u Process> Products > 
Contours > New 
Contour Layer
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This step lets you enter the intervals for standard and index 
contours. 
You can create a single contour level over the entire range of 
depths or create multiple contour intervals for different depth 
levels. If you use this dialog box to set the depth intervals, the 
settings are saved in field sheet directory as 
DepthSource_ContourLayerList.txt.
You can index contours to visually emphasize certain contour 
levels, for example, at 5 metre intervals. These index contours are 
optional.
The dialog box contains two read-only fields:

• The Depth Range field shows a range of depth values 
derived from the contour source (BASE Surface, bin or 
tile). The depth range values also provide an indicator of 
spikes in the source.

• The Levels field shows the number of contour levels 
produced at the current contour interval.

Create a Depth list 1. Select the Create a Depth List option to manually set a series of depth 
intervals (or go to Use a Depth List to select an existing list of depth 
intervals).

The depth list table is enabled.
2. Type the Minimum depth level for the contour interval.

3. Type the Maximum depth level for the contour interval. 

4. Type the contour interval between the maximum and minimum values.
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5. Press <Enter> to input the settings.

The Levels field changes to show the number of intervals produced 
by the above settings.
6. Repeat Steps 2 to 5 to enter another range of intervals.

Use Depth List Depth range files are text files that set a range of depths for 
tiling and contouring data, where values are: 

• Negative when representing heights above the datum, and 

• Positive when representing depths below the datum. 

These files are automatically generated during the contouring 
process.
7. Select the Use Depth List option to use a Depth Range File 

containing a range of depths. 

8. Type the name and path of the text file, or click Browse to locate it.

Index Contours 9. If you want to create index contours, select the Index Contours tab and 
select the Enable check box. 

This activates depth list fields identical to those in the Standard 
Contours tab. 
10.Complete Steps 1 to 8, as needed, and click Next. 

The Contour Wizard - Step 3 dialog box is displayed.

You can save the contours as a field sheet layer or save the 
contours to a new or existing HOB file.

1. Select either the Contour to Field Sheet option or the Contour to 
HOB File option. (See “CONTOUR TO HOB FILE” ON PAGE 351.) 
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Contour to field sheet The next step is to describe the various CARIS attributes for the 
new contours.

2. Enter the following information for standard and index contours:

• Name

• Theme Number

• Feature Code

3. Click Finish.

Contours are created for the selected field sheet and shown in the 
Display window. The standard and index contours are listed in 
the Control window.

Contour to HOB file If you selected the Contour to HOB option, the dialog box is refreshed 
to display the Contour Wizard - Step 3 (HOB) dialog box.

1. Click Browse and select an existing HOB file, or type the path and 
name for the file. You can also enter the name of a new file.

2. Click Finish.

An existing HOB file now includes a contours layer, or a new file 
with contours has been created. The contours can be opened in 
the Display window by choosing the File Open command and 
selecting the HOB file.
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Contour Labelling

You can label contour lines with their associated depth values. 
You set the path for the labels by drawing a line across the 
contours where you want the depth values to appear. Labels are 
added at the point where the line intersects the contours.

1. Select the Contours layer in the Layers tab of the Control window.

2. Select the Add Labels command.

Your cursor changes to a digitizing tool so that you can set the 
path for the labels.
3. In the Display window, click on the part of the field sheet where you 

want to start the line and drag the cursor to the part of field sheet where 
you want the line to end. 

Labels are now added to the contours.
You can change the size and colour of contour labels. To set the 
size of the labels in mm, 
1. Select the contour layer.

2. Select Set Label Size from the pop-up menu. 

3. Type the new value in mm.

4. Click OK.
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Drag the cursor along the 
line where you want the 
labels to appear.

l
 Release the mouse button and 
the labels are added along the 
path of the line.
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The colour of the labels can be changed from the default (black) 
by checking the Override Colour option in the Properties window and 
selecting a colour from the drop-down menu.
Labels can also be removed from the display. 
1. Select the Remove Labels command.

Masking Lines Behind Contour Labels

Concealing the part of the contour line behind a label can make a 
map area easier to read.

1. Make sure all previous work is saved.

2. Select the Contour Masking command.

The parts of the contour lines that intersect the labels are now 
hidden.
This masking process can be reversed with the Unmask contours 
command.
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Profiles

A profile is a cross-sectional view of a BASE Surface or tile. The 
profile contains two axes: the vertical axis is the attribute values 
from the surface etc. and horizontal axis is distance. While in 
digitizing mode, the view can be rotated, zoomed or panned. 
Profiles are saved as field sheet layers.

Create Profile
1. Make sure that a field sheet is open and a BASE Surface or tile is 

visible in the Display window.

2. Select the field sheet layer in the Layers tab of the Control window.

3. Select a New Profile command.

The New Profile Layer dialog box is displayed.

4. Type a name for the profile layer.

5. Type a CARIS feature code for the profile. The default code is 
PROFILE.

6. Type a layer number.

7. Select a BASE Surface attribute or tile layer as a height source. To 
expand the file tree, click the + icon beside the layer.

8. Enter a Step Size value so that depth data is extracted at regular 
increments along the profile.

9. Click OK.
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Digitize the profile The cursor changes to digitizing mode so you can digitize a two-
point profile or multi-point profile in the Display window using 
the Edit Line options. 
10.Click in the Display window where you want to start your profile.

11.Right-click and from the pop-up menu determine the type of line to be 
drawn:

• Point-to-Point: Connect the points as a straight line. This is the 
default option.

• Spline: Connect more than two points with a slightly curved line.

• Stream Line: Connect more than two points by dragging the cursor 
to draw a line.

• Fitted Curve: Connect points in a curve based on polynomials.

12.Click in another section of the BASE Surface or tile to join the points 
with a line.

13.Continue entering as many line segments as needed.

14.Right-click in the Display window and select End Line from the Edit 
Line menu to complete the profile line.

The profile line is drawn in the Display window and can be 
selected.
The Profile tab in the Worksheet window displays the graphed 
attribute and distance data between the points. The attribute 
values (vertical axis) and distance levels (horizontal axis) are 
measured in metres or feet. You may want to expand the 
Worksheet window to get a better view of the data.
The profile expands as more points are entered.

Display Properties

Once a profile is created you can modify its properties, including 
vertical and horizontal exaggeration, display a legend and 
vertical reference, etc., using the right -click menu in the Profile 
tab.
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Point Line/Cubic 
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Exaggeration Setting the vertical and horizontal scale renders a clearer 
display of the profile.
1. Right-click in the Profile tab and select Set Chart Scale from the pop-up 

menu.

The Chart Scale dialog box is displayed.
2. Type the horizontal and vertical exaggeration scales and click OK.

The Profile tab is refreshed to display the profile at the new 
scale.

Axis Settings Select the display for the X and Z axes.
1. Right-click in the Properties tab and select Graph Axis from the pop-up 

menu.

The Axis Settings dialog box is displayed. 

2. Type the labels for the X and Z axes in the X-Axis and Z-Axis fields.

3. Select the X-axis and Z-axis increments as Automatic (derived from the 
maximum and minimum values in the profile) or as User Defined.

4. If you selected User Defined, type the Step Size value in the field.

5. Select the Display Min/Max Value check boxes to show the minimum 
depth value (Z-axis) or maximum distance value (X-axis).
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6. Select Automatic to scale data according to the minimum and 
maximum values in the profile, or select User Defined to enter scale 
data according to selected depth and distance values.

7. If you selected User Defined, type the Minimum and Maximum Values 
for the data range.

8. Click OK.

Legend Display a legend and set the location of the legend.
1. Right-click in the Profile tab and select Show Legend from the pop-up 

menu.

The Show Legend dialog box is displayed.

2. Select the Show Legend check box.

3. Select the location of the legend: either to the left or the right of the 
profile.

4. Type the width of the legend.

5. Click OK.

The legend is displayed in the Profile tab.
Zoom/Pan/Rotate You can rotate, zoom, and pan the profile. These options are 

available while in digitizing mode from a pop-up menu in the 
Profile tab of the Worksheet window. The profile can be rotated 
to a maximum of 180°.
1. Right-click in the Profile tab and select Mouse Mode > Trackball from 

the pop-up menu.

2. Press and hold the mouse button while dragging the cursor in 
Worksheet window up or down, or sideways to rotate the profile.

The profile display is rotated according to the position where you 
release the mouse button.
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3. Zoom in or out of the profile by right-clicking in the Profile tab and 
selecting Mouse Mode > Zoom from the pop-up menu.

4. Pan the profile by right-clicking in the Profile tab and selecting Mouse 
Mode > Pan from the pop-up menu.

The zoom and pan operations require you to press and hold the 
mouse button while dragging the cursor in the Worksheet 
window.
You can view the profile with vertical and horizontal grid lines 
in front of profile.
5. Right-click in the Profile tab and select Wall Lines > Show Horizontal 

Front Line or Show Vertical Front Line from the pop-up menu.

6. Select Snap to 2D from the pop-up menu to return the profile to its 
original position.

Export Profile

Create a text file containing position and depth data from a 
selected profile.
1. Right-click in the Profile tab and select Export Graph to ASCII from the 

pop-up menu.

Show Vertical Front line is on
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The Export Settings dialog box is displayed.

2. Click Browse to select a directory for the file.

3. Type the file name prefix in the Filename field. All files will have the 
profile name appended to the end of it. 

• For example, a text file for Profile 21 with the prefix HBC4 will be 
named HBC4-Profile21.txt.

4. Select the Ground Coordinates:

• X, Y (values are derived from the reference coordinate system in 
the field sheet)

• Distance (from the start of the profile), Z

5. Click OK.

The profile data is exported to a text file in the selected 
directory.

Display Profile

Display an existing profile in the Worksheet window.
1. Make sure that the Worksheet window is open.

2. Select a profile layer in the Control window.

3. Select the Display Profile command.

The Display Profile dialog box is shown 
4. .Select a height source by expanding the list and selecting the layer 

you want to use.

5. Type a Step Size to extract position and depth data from the profile line.

6. Click OK.

The profile is loaded into the Profile tab of the Display window.
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Sounding Selection

A selection of soundings for display can be created as a sub-layer 
of a field sheet. The sounding selection is generated from a tile, 
grid or BASE Surface attribute layer. The selection mechanism 
is shoal- or deep-biased and allows control over the final density 
of the selected sounding layer. The sounding layer can be 
written to a CARIS file or to a Hydrographic Object Binary 
(HOB) file.
You can colour code the selected soundings according to depth, if 
necessary. See “COLOUR OPTIONS FOR SOUNDINGS AND CONTOURS” ON 
PAGE 368.
To create a layer of selected soundings:

1. Choose the Selected Soundings command.

The Sounding Selection Wizard is displayed.

Step 1

The Selected Soundings function uses tile layers (including bin 
layers) and BASE Surface attribute layers as data sources.
From the chosen layer, one value from each tile/bin or attribute 
layer node is used to represent all of the soundings from that 
cell. In the case of a bin layer, there is only one value present, so 
it is used. In the case of a tile layer, each tile contains a number 
of attributes and a primary sounding. The primary sounding is 
the value that is used in the Selected Soundings operation.

M
en

u Process > Products 
>Selected Soundings 

P
op

-u
p New > Selected 

Soundings…



CARIS HIPS and SIPS User’s Guide 361

Create Product Surfaces: Sounding Selection

2. Select a BASE Surface attribute layer or tile layer. You can view all 
layers by clicking the + icon to expand the file tree.

The “Apply designated soundings” option lets you choose how 
soundings are treated in the selection process. 
3. Select the check box to have designated soundings processed first.

4. Leave the check box un-selected to all soundings processed in the 
same way. 

5. Click Next.

Step 2

The Sounding Selection - Step 2 dialog box is displayed.

Selection criteria You have three criteria for sounding selection: 
• All selects soundings from three sources: 

• node values from the BASE Surface attribute layer 
• the primary sounding from every tile
• the sounding stored in every bin

• Radius selects values from a designated area.
• Overplot Removal selects soundings to fit on a field sheet so 

that there is no overlap.
6. Select one of the three criteria from the Selection Criteria drop-down list.

If you selected Radius or Overplot Removal, the dialog box is 
refreshed to display the options associated with those criteria.
7. Select the shoalest or deepest values for the selected soundings by 

choosing the Shoal Bias or Deep Bias options.
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Settings in the wizard can be saved to a Sounding Selection 
Template (CSST) file. This file can be opened and reused again.
8. Select the Use Template option to open or create a template file that 

contains criteria options.

9. Select the Use Existing Template to open a template file, or select Save to 
New Template to create a new template file from the settings in the 
wizard.

10.Click the browse button to open a file, or create a new file.

Radius If you choose Radius option from the Selection Criteria list, the 
dialog box is refreshed to show the following options.

11.Set the Radius Value. (If you select mm at map scale, type a scale 
value in the Map Scale field.) 

12.To set a standard minimum distance between soundings, select the 
Single User Defined Radius and enter the interval. 

13.If you are using a radius table to set the minimum distance between 
soundings, select the Use Radius Table File option and click Browse to 
select the file. 

Sounding Radius Table The sounding radius table sets the minimum suppression radius 
between soundings when generating a soundings layer. The 
radius table can be applied to more than one depth range. Each 
depth range can contain its own radius value. The table contains 
three columns:
• minimum depth of the range
• maximum depth of the range
• suppression radius for the depth range.
The suppression radius field is set according to the radius value 
selection in the dialog box. An example of a radius table is shown 
below.
0.0 10.0 1.0

10.0 20.0 2.0

20.0 50.0 5.0 

50.0 500.0 10.0

Overplot Removal 14. If you choose the Overplot Removal option from the Selection 
Criteria list, the dialog box is refreshed to show the 
following options.
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Overplotting occurs when soundings overlap or are so close 
together that they are plotted on top of each other. Two soundings 
with depths of 11 and 22 might look like 1212 if they are 
overplotted. 
The Overplot Removal option suppresses certain soundings in a 
dense set of soundings so that the dataset can be plotted at a 
certain scale without overplotting. Overplot Removal places a 
buffer zone around each sounding then suppresses either the 
deepest or shoalest soundings which overlap these buffer zones. 
Suppression or overplot removal does not physically remove the 
soundings from the HIPS file. Excess soundings have a 
compilation status of suppressed while the rest have a 
compilation status of background.

15. Type the map scale in the appropriate field.

16. Type the size of the soundings (as they appear in the Display 
window) in the Sounding Size field.

17. Select a Sounding Rounding Rule from the drop-down list.

18. Click Next.
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Step 3

The Sounding Selection - Step 3 dialog box is displayed. 
 

The soundings can be exported to two formats: a CARIS map or a 
HOB file. The HOB file is stored in the same directory as the field 
sheet. The default directory is 
..\Hips\Fieldsheets\ProjectName. CARIS files are directly 
opened as a layer.

CARIS map To place soundings in a CARIS file, complete the following steps:
1. Select the Output to CARIS Map command.

2. Type a name for the layer in the Layer Name field.

The Layer Number is used to organize information in the CARIS 
file. It is important to maintain each layer on a separate theme, 
therefore be sure to change it from the default number each time 
you create a new sounding selection.

3. Type a number in the Layer Number field.

Soundings can be displayed in two formats.
• Slanted: This format displays the sounding in a slanted 

format with the value to the right of the decimal point 
shown in subscript.

4. Engineer: This format displays 
the sounding in regular text with 
the depth values separated by a 
decimal point. 

5. Select either Engineer or Slanted 
sounding styles from the drop-down menu.

The Add Extended Attributes option adds useful additional 
information to each sounding. The Add Keys option gives each 

Slanted Engineer
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sounding a unique identifier or key. This key provides a link back 
to the original sounding in the HIPS file and is required to open 
a specific sounding in the HIPS Swath/Single Beam or Subset 
Editors.

6. Select the Add Extended Attributes option if you want to include 
time stamp, launch ID, accuracy value, and tidal reduction value 
with the soundings.

7. Select the Add Keys option to give each sounding a unique 
identifier. The key format is XXXBBBBBBPPP where XXX is a 
random value, BBBBB is the beam number and PPP is the profile 
number.

HOB file A HOB file contains S-57 feature objects. Additional tile 
attributes to help identify the soundings are also included in the 
HOB file. The wizard lets you map these tile attributes to 
corresponding S-57 attributes. 

1. Select the Output to Hob File option.

2. Select a Navigational Purpose to set a scale for the HOB file.

3. Type a name for the Data Set Name field (a minimum of five 
characters).

4. Click Finish if you selected the CARIS map option in the first 
dialog box, or click Next if you selected the HOB file option.

Step 4

The Sounding Selection - Step 4 dialog box is displayed.  

You can use filters to display the soundings you want in your 
selection. The Enable Filter option allows you to extract the 
soundings that meet the conditions you set for the filter.
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For example, with the depth units set to Metres, if you only want 
soundings with a Depth value of less than eight metres, select 
Depth from the available Attributes list and type the following in the 
Enable Filter field:
[Type: Depth<spacebar>, click “<“ button or Shift+”<“ key, 
type: <spacebar>8]
The value displayed in the field is “Depth < 8”

5. [Optional] To apply filters to the surface data, select the Enable Filter 
option and enter the filter conditions to apply.

6. Click Next if you selected HOB file in Step 3 of the wizard, or click 
Finish if you selected CARIS Map in Step 3 of wizard.

Step 5

The Sounding Selection - Step 5 dialog box is displayed (if you 
selected HOB file in Step 3).
 

The sounding selection process generates S-57 SOUNDG objects 
that can have certain attributes populated. These attributes —
SORIND (information about the source of the sounding) and 
RECDAT (date the object was captured, edited or deleted)—do 
not have information populated unless you select the Auto Populate 

SORIND and RECDAT check box.

The other S-57 option is to map the BASE Surface attributes to 
S-57 attributes, via a translation file. The translation file has a 
BSST file extension and is in XML format.

Note: autopopulating the SORIND and RECDAT attributes can 
have a negative impact on save times, export times as well as file 
size, particularly with large, high-density datasets.
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7. To apply a translation file, choose the Translation File option, or 

8. To finish, select the No Attribute Translation option.

9. Click the Browse button (...) to select an existing translation file (with a 
.bsst extension) or to specify a name for a new translation file.

10. Click Edit to manually map BASE Surface attributes to S-57 attributes.

The Edit Translation File dialog box is displayed. 
 

 

11.Select a mapping acronym from the drop down list. 

The mapping dialog box is refreshed so you can enter values in 
the editing fields. The fields shown depend on the acronym 
selected. If there are no attributes associated with the acronym, 
the dialog box is empty.
The following is an example of a translation file where the value 
of SCAMIN is multiplied by 2.
<?xml version="1.0" encoding="UTF-8"?>
<Selected_Sounding_Conversion>
  <Depth New_Acronym="SCAMIN">
    <Conversion_Factor>&lt;value&gt;*2</
Conversion_Factor>
  </Depth>
</Selected_Sounding_Conversion>

12. If the selected attribute acronym are enumerated or 
numeric types, the dialog box is refreshed to show the 
options for those types. See “ENUMERATION ATTRIBUTES” ON 
PAGE 366 and “NUMERIC ATTRIBUTES” ON PAGE 366.
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Enumeration attributes

Some S-57 object attributes are of the Enumerated type which 
means they contain numerical codes that more precisely define 
the attribute. You can map these codes to the object attribute.
If the selected Object Attribute is a enumerated type, the dialog 
box is refreshed to show the following options.

13.Type the existing tile attribute values in the Add Value field.

14.Click Add Value to add the tile values to the Original Values field.

15.Double-click an S-57 attribute value in the Available Values list.

The S-57 value is displayed in the New Values field.
16.Click OK.

Numeric attributes

Some S-57 object attributes are Integer, Float or Double types.
If the selected Object Attribute is a numeric type, the dialog box 
is refreshed to show the following options.
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Numbers are typed into the area provided to display the formula. 
Mathematical operators are inserted by clicking the appropriate 
button on the right side of the dialog box. The Value button inserts 
value of the attribute in the formula.
1. Create a conversion formula by typing any appropriate numbers and 

inserting mathematical operators.

2. If you want to remove the formula, click Clear.

3. Click Test to view a an example of the formula

4. Click OK.

When the selected soundings are saved to the HOB file, the tile 
attributes are converted to the values determined by formula 
that was created in the previous steps.

View HOB soundings

The display settings in the S-52 tab of the Options dialog box 
must be set prior to displaying the soundings stored in a HOB 
file. (See “S-52 DISPLAY” ON PAGE 678.)
5. Open the Options dialog box and select the S-52 tab.

6. Select Base and Other or Standard and Other from the Category drop-
down menu.

7. Select the Soundings check box.

8. Select the File Open command and select the HOB file where the 
soundings are stored.

9. Click Open.

The soundings are listed in the file tree in the Control window, 
and are opened in the Display window.
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Colour Options for Soundings and Contours

The Colour Table Editor lets you colour code soundings and 
contours for easier display and interpretation.

1.Select a sounding or contour layer in the Control window.

2.Select the Edit Colours command from the right-click menu.

The Colour Table Editor dialog box is displayed.
.

Single colour Use this option to display a soundings or contours in a single 
colour.

1.Select the Single Colour option.

2.Select a colour from the colour picker, or create a custom colour 
from the standard Windows colour palette.

3.Click OK to save and apply settings.

Colour table To apply different colours to different depth ranges:
1.Select the Colour Table option.

2.Select a colour from the colour palette, or create a custom colour 
from the standard Windows colour picker.

3.Type a minimum range depth in the field beside the palette.

4.Type a maximum range depth in the next field

5.Click Insert Range.
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The colour and range values are displayed in the Colour Table 
dialog box.

6.Repeat Steps 2 to 5 to continue adding a colours for each range.

7.To remove a single colour range, select a range so it is highlighted 
and click Remove Range.

8.To remove all selected ranges, click Clear.

9.Click OK to save and apply settings.

The soundings or contours are colour-coded according to the 
range values you selected earlier.

Standard colour map Use this option to select a standard colour map.
1.Select the Colour Map option.

2.Select a colour map from the drop-down menu.

3.Type the minimum and maximum range values for the colour map.

4.Click OK to save and apply settings.

The layer objects are displayed according to the colour map 
settings.

Reverse colours Select this option to reverse the order in which the colour map is 
applied (see illustration below). 
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Tiling

Tiling divides a a data display into manageable parts based on 
selected criteria. Generally, the tiling process splits a selected 
area into sections (tiles) and continues sub-dividing until a 
network of squares cover the data.
Below is an example of a tiled field sheet in the Display window.

Tiling a field sheet

There are three methods of tiling a field sheet: tiling, binning and 
QTC tiles. If you need to examine the data for more detailed 
statistical information then the tiling option should be selected.

Tiling The field sheet tiling process divides a field sheet into four 
sections (tiles) and continues sub-dividing each section by four 
until the criteria for creating the tile is reached. The result is a 
network of tiles covering the data. These tiles can vary in size.

Binning Binning splits the surface of a field sheet into squares or “bins” 
based on a user-defined size. Within each bin, the shallowest or 
deepest sounding can be selected. This option is very fast and 

A special type of tiling is used to track the progress of subset 
data cleaning, (see “TRACK PROGRESS WITH SUBSET TILES” ON 
PAGE 334) and for performing statistical surface cleaning on 
sounding data (see “STATISTICAL SURFACE CLEANING” ON PAGE 305).
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should be selected if you want to generate only soundings and 
contours from the data.

QTC Tiles Seafloor classification is a procedure in which the amplitude and 
shape of the reflected acoustic signal is used to interpret the 
physical nature of the bottom. Quester Tangent Corporation has 
developed a program called QTC View to perform this analysis. 
The analysis in QTC View groups the return signals into classes 
which correspond broadly with physical properties of the seafloor. 
The results are summarized in a text file (.seabed). HIPS and 
SIPS generalizes these results by creating tiles based on the class 
values in the .seabed files.

Create Tiles 
1. Make sure a field sheet is open.

2. Select the field sheet layer in the Layers tab.

3. Select the Tiling command.

The Tiling Wizard - Step 1 dialog box is displayed.

4. Select the method of tiling, in this example, select tiling.

5. Click Next.

The Tiling Wizard - Step 2 dialog box is displayed.
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6. Set the minimum tile size by clicking the up or down arrow buttons. As 
you increment upwards, the tile size is doubled.

7. Select from the following four options to set a tiling criteria:

• Same Size For All Tiles: Set all tiles to the minimum tile size.

• Tile by Depth Tolerance: Select a depth level for creating new tiles. 
For example, if you enter five then new tiles are created as the 
depth changes by five metres (or feet, if you are working in imperial 
units).

• Tile By Depth Range File: Type the file name and path of the Depth 
Range File with a list of depths, or click Browse to select the file. 
The tiles are created according to the listed depths. (See “USE 
DEPTH LIST” ON PAGE 350.)

• Tile By Depth Range Interval: Use interval levels between a set 
depth range for creating new tiles. Type the depth interval and the 
start and end depths. For example, for a depth interval of five 
metres, a start depth of zero metres and end depth of 20 metres, a 
tile is created for every five metres between 0 metres and 20 
metres. 

8. Click Next.

The Tiling Wizard - Step 3 dialog box is displayed.
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9. Type a name for the tile file.

10. Select a primary sounding as the starting point for the tiling 
process. Choose from five options:

• Minimum - True Position: Use the shoalest sounding at its 
actual position.

• Maximum - True Position: Use the deepest sounding at its 
actual position.

• Average - Tile Centre: Use the mean value of the soundings 
as the centre of the tile.

• Minimum - Tile Centre: Use the shoalest sounding as the 
centre of the tile.

• Maximum - Tile Centre: Use the deepest sounding as the 
centre of the tile.

11. Choose other tile attributes by selecting an attribute in the 
Available list and clicking Add to move it to the Active list.You can 
move the attribute from Active list by clicking Remove.

12. Click Finish to complete the tiling process.

A progress indicator on the status bar shows how much of the 
tiling process has been completed. Once the tiling is completed, it 
is shown in the Display window and the tile layer is listed in the 
Control window.
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Create Bins
1. Select the field sheet.

2. Select the field sheet layer in the Layers tab.

3. Select the Tiles command.

The Tiling Wizard - Step 1 dialog box is displayed.
4. Select the Binning option.

5. Click Next.

The Tiling Wizard - Step 2 dialog box is displayed.

6. Type a size for the bin tiles.

7. Click Next.

The Tiling Wizard - Step 3 dialog box is displayed. The Available 
Attributes section is dimmed.

8. Type a name for the file

9. Select a minimum or maximum sounding position as the starting 
point for the binning process.

10. Click Finish. 

A bin file is created and displayed in the Display window. A bin 
layer is also added to the Layers tab.
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Create QTC Tiles

1. Select the field sheet.

2. Select the field sheet layer in the Layers tab.

3. Select the Tiles command.

The Tiling Wizard - Step 1 dialog box is displayed.
4. Select the QTC Seabed Classification option.

5. Click Next.

The Tiling Wizard - Step 2 (QTC) dialog box is displayed.

6. Type a name for the QTC tile layer.

7. Set the minimum tile size by clicking the up or down arrow 
buttons. As you increment upwards, the tile size is doubled.

The Percent Value Used to Split option continuously splits the tiles 
until the total amount of a specific class value in a tile meets or 
exceeds the entered percentage. For example, if the percentage is 
set at 50, then a tile is continuously sub-divided into smaller tiles 
until one of the tiles contains at least 50 per cent of a class value.

8. Type the percent value.

9. Click Next.

The Tiling Wizard - Step 3 (QTC) dialog box is displayed.
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10. Click Select files to browse to the .seabed file used to create the 
tiles.

The selected file is displayed in the QTC Files text area.
11. Click Finish.

A progress bar displays the percentage of tiles created.
The tiles are drawn to the Display window. You can use the Tile 
Display Query (see “TILE DISPLAY QUERY” ON PAGE 378) functions with 
the tile set.
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Open and Close Tiles
1. Select the Open Field Sheets command.

The field sheet file name is displayed in the Layers tab of the 
Control window. 
2. Expand the field sheet file tree by clicking the Expand ( + ) icon beside 

the field sheet so the tile file name is visible 

3. Select the check box beside the field sheet file name, to make the tile 
visible in the Display window.

Below is an example of a tiled area.

Close a tile file in the Display window.
1. Select the Close Field Sheets command.

All tiles associated with the field sheet are closed.
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Set Tile Properties

Set the display properties for tiles.
1. Select a tile layer in the Layers tab of the Control window.

2. Select the Properties window command, or right-click the layer and 
select Properties from the pop-up menu.

The Properties window displays the tile layer properties. 

The Active Attribute list contains all attributes included in the tile 
(such as the Profile number). When you select an attribute, the 
tile is displayed according to the attribute values
1. Select an attribute from the drop-down Active Attribute list.

2. Select a colour map from the drop-down list. A preview of the colour 
map is displayed below the list.

Change the display of tiles in the Display window.
3. Change how tiles are rendered to the Display Window by selecting 

from three Display Level options:

• Maximum: Draw all tiles

• Size: Draw all tiles at the selected tile size level or higher. Select a 
minimum tile size by clicking the arrow buttons

• Automatic: Draw tiles to fit the current extents of the Display window.

The Colour Fill check boxes determine how attribute values are 
drawn in the Display window.
• If the Colour Fill check box is cleared, these values are drawn 

according to the selected colour map, but the tiles are left 
blank. 

• If the Colour Fill check box is selected, then the individual tiles 
are filled according the colour map, but the attribute values 
are shown in black.

4. Select Colour Fill to colour code tiles according to the colour map.
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5. Select a Transparency percentage to make features visible through the 
tiles.

6. Select the Show Tile Border check box to choose a single colour to 
display tile border lines.

The Show Tile Border check box determines how the border lines 
dividing the tile areas are displayed.
• If the Show Tile Border check box is cleared, the lines are colour 

coded according to the colour map and attribute values.
• If Border Colour is selected, then choose a single colour to 

display tile border lines. 
7. Select the Display Tile Value check box to draw the selected attribute 

values.
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Tile Display Query

Using the Tile Display Query dialog box you can create an SQL-
type query based on selected tile attributes and defined values. 
Only those tiles that meet the search criteria are displayed.
1. Select the tile layer in the Layers tab.

2. Select the Tile Display Query command.

The Tile Display Query dialog box is open.

3. Select an attribute from the list.

4. Click one of the following operator buttons:

• less than (<)

• greater than (>)

• less than or equal to (<=)

• equals (=)

• greater than or equal to (>=)

• not equal to (!=)

5. Type a value for the attribute in the Value field, and click Enter.

The search criteria you selected in the dialog box are displayed 
in the Query section.
6. To add other search criteria, click either of these logic operators:

• AND: This operator combines two queries together so the results of 
both are shown in the Display window.

• OR: This operator searches and displays either one of two search 
criteria in the Display window.

7. Repeat Steps 3 through 6 to add as many search criteria as needed. 

8. Click OK.
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Query Tiles
1. Make sure the tiles are open in the Display window.

2. Select the tile layer in the Layers tab of the Control window.

3. Select the tiles to be queried.

The selected tiles are highlighted.
4. Select the Query Tiles command.

The following tile data is displayed in the Worksheet window 
(from left to right):
• East: easting coordinate for the centre of the tile.
• North: northing coordinate for the centre of the tile.
• Z_Mean: mean depth value for tile.
• Z_Min: minimum depth value for tile.
• Z_Max: maximum depth value for tile.
• Residuals_Mean: mean value for residuals from polynomial.
• Residuals_Sigma: standard deviation for residuals.
• Count: number of points in the tile.
• Rejected: number of points rejected during surface cleaning.
• NumberOfCoefficients: the number of polynomial 

coefficients used.
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Processing in SIPS—Mosaic Editor

Side scan and backscatter imagery data can be processed directly into 
mosaics, which can then be examined for anomalies and corrected.

Mosaic Editor is used to create and edit mosaics, and analyze the 
sediment properties of the create imagery. 

In this chapter...
“SIPS WORKFLOW” ON PAGE 386
“INTRODUCTION” ON PAGE 387
“CREATE GEOBARS” ON PAGE 391
“CREATE MOSAIC” ON PAGE 397
“EDIT MOSAICS” ON PAGE 400
“SEDIMENT ANALYSIS” ON PAGE 405
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SIPS Workflow

Most users will be able to perform all their imagery processing 
directly in Mosaic Editor. However, if you:
• need to edit altitude data for side scan data, or 
• will be digitizing and editing contacts, or
• prefer to use a waterfall display for editing, or 
• intend to apply advanced TVG controls 
then these functions must be performed in Side Scan Editor.
Imagery corrected in Side Scan Editor can also be georeferenced 
and composited in Mosaic Editor. (See “PROCESSING IN SIPS—SIDE 
SCAN EDITOR” ON PAGE 403.)
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Introduction

Mosaic Editor uses the accurately modelled backscatter 
correction algorithms of the Geocoder engine to process source 
data. Geocoder-processed data is stored in SIPS as 
Georeferenced, Backscatter Rasters, or GeoBaRs. 
GeoBaRs are the basis for all mosaics created in SIPS. 
From the GeoBaRs, you can create an initial mosaic which can 
be examined and edited in Mosaic Editor. Once imagery has 
been corrected a full mosaic can be compiled from the data, or 
sediment analysis applied.
With GeoBaRs you can generate mosaics with data from various 
surveys in the same geographic area. 
Mosaic Editor has two processing engines: Geocoder Engine and 
SIPS Engine.

Geocoder Engine

Geocoder was purpose-build to process multibeam backscatter, 
both beam- averaged and the higher resolution time series 
returns as well as side scan sonar data.

SIPS Engine

Side scan data can still be processed on a line-by-line basis in 
Side Scan Editor. However, with the SIPS engine in the Mosaic 
Editor, survey data can be corrected and geo-referenced on a 
“whole survey” basis, by creating a mosaic and then examining it 
for anomalies that may require closer attention.  

Multibeam data must be converted to HIPS format, processed with 
the bathymetric editors (Sound Velocity Correction, Apply Tide 
etc.— see Multibeam “WORKFLOW” ON PAGE 70), and Merged (see 
“MERGE” ON PAGE 185) before the imagery can be corrected in 
Mosaic Editor. 

Side scan data must be converted to HIPS format, and if it is 
necessary to digitize altitude or recompute towfish navigation, this 
should be applied before image correction is done in Mosaic Editor 
(see “DIGITIZING SONAR ALTITUDE” ON PAGE 407 and “RECOMPUTE 
TOWFISH NAVIGATION” ON PAGE 406).
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Open Mosaic Editor
1. Open Mosaic Editor with the command on the Tools menu or toolbar.

The Control Window is refreshed to display the three control 
tabs of the Mosaic Editor. The tabs are:
• Process - used to set the options for the creation of GeoBaRs
• Analysis - used to perform sediment analysis on backscatter
• Edit - used to edit the display of mosaics or GeoBaRs “on-the-

fly” and change the draw order of the GeoBaRs
The image below shows the Mosaic Editor tabs in the Control 
window. 
 

The Mosaic Editor and Beam Pattern toolbars are also 
displayed. 
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Mosaic Editor toolbar 
 

The Mosaic Editor toolbar contains the following controls:
• Create a GeoBaR: based on options selected in the Process 

tab.
• Create a Mosaic: from available GeoBaRs.
• Load a single GeoBaR for the selected trackline(s): the user 

will be prompted to choose which GeoBaR(s) are loaded for 
each line.

• Load all GeoBaRs for the selected trackline(s)
• Unload all GeoBaRs for the selected trackline(s)
• Sediment Analysis Options: choose when to create a 

sediment analysis file for a line
• Open/Close Sediment Analysis Graph

Beam Pattern toolbar 

The Beam Pattern toolbar has the following controls:
• Create Beam Pattern: create a Geocoder beam pattern file.
• Load Beam Pattern: open an existing Beam Pattern File for 

use during Beam Pattern Correction.
• Close Beam Pattern.
• Save Beam Pattern.
• Save Beam Pattern As....

Create 

Open/Close Sediment
Analysis graph

GeoBaR

Create a Mosaic 

Load single
Load all GeoBaRs 

Unload GeoBaRs Sediment Analysis 
OptionsGeoBaR 

Reset AutoHistogram
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• View Beam Pattern: open the Beam Pattern graph window 
to display the average beam pattern intensity as a function of 
angel from nadir. With the Geocoder procesing engine 
backscatter dB is displayed, and with SIPS engine, intensity 
values.

• Remove Spikes -removes anomalies from the Beam Pattern 
Graph (not available with the Geocoder processing engine).

• Smooth Beam Pattern - uses a moving average filter to 
reduce noise in the beam pattern (not available with the 
Geocoder processing engine).

• Reload: restore the beam pattern file to the point just after 
you last saved it. 

• Set Sediment Class: choose the sonar frequency (Hz) and 
mean grain size and set it for the selection (not available with 
the SIPS processing engine.)

• Set Beam Pattern Offset (dB) for the selection (not 
available with the SIPS processing engine).

Mosaic Editor Display Options

Options for the display window while Mosaic Editor is active are 
set in the Display tab of the Tools > Options dialog box. 
1. Set the display colours for four types of backscatter in the Sediment 

Analysis graph. 

• Total Backscatter

• Interlaced Backscatter

• Volume Backscatter

• Kirchkov Backscatter

2. Select the Auto-Adjust GeoBaR Histograms check box to allow the 
same range of intensity values (min/max) to be used for all GeoBaRs 
created.

3. Select the Show All Sediment Analaysis Patches check box to allow 
display of the patches within the selection area along the line, when the 
sediment analysis tool is activated. 
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Create GeoBars

GeoBaRs are created with the Create GeoBaR command or 
toolbar button, using the options selected in the Process tab. 
Different options are available, depending on which processing 
engine is selected. 
You can create multiple GeoBaRs on a survey line to:
• Correct multiple sources of data (i.e., time series, beam 

averaged, and/or side scan) from the same file, if applicable.
• Have different resolutions per GeoBaR.
• Visually compare data.

Create GeoBaR with the Geocoder Engine

The simplest way to create a GeoBaR is to use the default values 
for options displayed on the Process tab, and then view and 
correct the GeoBaR imagery by adjusting these values. Then can 
the settings from the created GeoBaR to other tracklines. 
To create a GeoBaR: 
1. Select a line in the Display window.

2. In the Process tab, select Geocoder from the Processing Engine drop-
down list.

3. Select the type of data being processed: Side Scan, Beam Average, or 
Time Series. 

4. By default, the General Options of Auto Gain and Auto TVG correction 
are selected. These options should be left on. 

5. Select the Beam Pattern Correction check box, and select a Geocoder 
Beam Pattern Correction file (*.bpt). If none is available it will need to 
be created. See “BEAM PATTERN CORRECTION” ON PAGE 393.

Angle Varying Gain (AVG) Correction removes the angular gain 
artefacts of sediment from the imagery, normalizing the mean 
angular intensities.
6. Set the AVG Correction check box and select a method from the drop-

down list. Set the AVG window size using the arrow buttons.

Imagery may have isolated pixels with intensity levels that are 
inconsistent with neighbouring pixels.  It is possible to remove or 
filter the isolated light and/or dark pixels through the Despeckle 
process.  This will produce smoother, more consistent imagery.
7. Select the Despeckle check box and select a strength of adjustment to 

filter out pixels with intensity values inconsistent with their neighbours. 

8. Select the Create GeoBar command from the Tools > Mosaic Editor 
menu, or from the Mosaic Editor toolbar.
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The new GeoBaR will be displayed in the Display window 
correction, and listed by name in the Layers tab, with its child 
layers: 
• Intensity layer displays the current intensity (including edits.
• Original Intensity displays the intensity when the GeoBaR 

was created (before edits to GeoBaR).
• Weights displays the computed weights based on sonar 

geometry.  These values are used when compiling a mosaic 
based on the Auto-Seam method. 

Create GeoBaR with the SIPS Engine

You can create GeoBaRs from the default settings in the Process 
tab, or adjust the values of the correction options and apply to 
the line or lines to create GEoBaRs. 
1. Select a line in the Display window.

2. Select SIPS from the Processing Engine drop-down list.

If you have already corrected your data, using Side Scan Editor 
or the SIPS Template Wizard. 
3. Select the Create GeoBar command.

If you have not corrected data, use the tools on the Process tab as 
follows: 
1. Select SIPS from the Processing Engine drop-down list.

2. Select the type of data being processed: Side Scan, or Beam Average. 

3. Select the Slant Range Correction check box if you want to apply this to 
your data. The default settings are listed. Click Change…to change 
these values. (For information on slant range correction, see “SLANT 
RANGE CORRECTION” ON PAGE 413.)

4. Select the Beam Pattern correction check box to apply this correction, 
and browse to select a Beam Pattern Correction file to apply. (For 
information on creating and applying a Beam Pattern file, see “BEAM 
PATTERN CORRECTION” ON PAGE 416.)

5. Select the AVG Correction check box to apply this correction and select 
the method and AVG window size. (For information, see “ANGLE-VARYING 
GAIN” ON PAGE 419.)

6. Select the Despeckle check box to apply this option. Default values are 
displayed. Click Change… if you want to change these values. 

7. Select the Create GeoBar command.

The new GeoBaR will be displayed.
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Beam Pattern Correction 

Beam Pattern Correction can be applied to remove angular 
artifacts caused by the transducer. Depending on the processing 
engine you are using, Beam Pattern different functions are 
available.
First a Beam Pattern file must be created.
1. Make sure the Ship Track Lines layer is active in the Layers tab.

2. In the Display window, superselect an area of trackline by holding down 
the down arrow key on the keyboard while range-selecting a 
homogenous area of the GeoBaR.  

The selected area will be highlighted blue at nadir of the 
GeoBaR.
3. Select Create Beam Pattern from the Beam Pattern toolbar, name and 

save the .bpt file.

The Beam Pattern file is saved and loaded. 
4. Select View Beam Pattern to open the Beam Pattern window.

With the Geocoder engine selected, this graph displays the beam 
pattern information in a waveform display as backscatter 
intensity and angle from nadir. (The SIPS engine will display 
the graph as done in Side Scan Editor. See “VIEW BEAM PATTERN” ON 
PAGE 417.)
Four types of waveforms are displayed:
• Total Backscatter
• Interlaced Backscatter
• Volume Backscatter
• Kirchkov Backscatter
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The display colours for these waveforms can be adjusted in the 
Mosiac Editor option on the Tools > Options > Display dialog 
box. 
You can manually adjust this Geocoder Beam Pattern with the 
Set Sediment Class and Set Beam Pattern Offset tools on the 
Beam Pattern toolbar. These tools are only available when using 
the Geocoder processing engine.
5. Select the Set Sediment Class button  from the Beam Pattern 

toolbar. 

The Set Sediment Class dialog box is displayed.

6. Select the Set Beam Pattern Offset button. 

7. Adjust the offset value to apply to port, starboard or both sides. 
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Edit GeoBaR

Editing GeoBaRs includes adjusting brightness, contrast, 
visibility options and the draw order of GeoBaRs. These 
corrections are done with the tools on the Edit tab.
1. Select the GeoBaR layer to edit. This will activate the Edit function.

1. To adjust brightness, slide the sliders to the right or left to change the 
intensity of the image. 

2. To adjust contrast, slide the Contrast slider to the right for more 
contrast and to the left for less contrast.

As you change these values with the slider, new values are 
displayed in the Intensity Range fields. These fields show the 
minium and maximum intensity values for the GeoBaR. 
Use Reset to restore the GeoBaR to the original intensities it had 
when it was created. 
3. Use the Visibility Options to turn on or off the various child layers of the 

GeoBaR.

4. Manipulate the Draw Order of the GeoBaRs using the Top, Bottom, Up 
and Down buttons. (This function is important if you intend to make 
your final mosaic using the Overwrite method.)
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Delete GeoBaR

To delete a GeoBaR:
1. Right-click on the GeoBaR layer in the Layers tab. 

2. Select Delete GeoBaR from the pop-up menu.

This deletes the GeoBaR permanently from your disk.
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Create Mosaic

A mosaic can be composited from two or more GeoBaRs. Like 
other HIPS and SIPS surfaces, a mosaic is created in a field 
sheet. 
To create a mosaic in from GeoBars in Mosaic Editor:
1. Open or create a field sheet to encompass the area you want to 

mosaic.

2. Make sure the Ship Track Lines layer is active in the Layers tab.

3. Select two or more track lines.

The Create Mosaic command and toolbar button are activated.
4. Select a Create Mosaic command.

If there is more than one GeoBaR for a line, the Resolve Conflict 
dialog box will appear so you can choose which GeoBaR will be in 
the mosaic. 

There are three methods to resolve a conflict: Newest GeoBaR, 
Finest Resolution, and Manual. (For more information on 
conflict resolution, see “CONFLICT RESOLUTION” ON PAGE 403.)
5. Select a method to resolve the conflict. 

The Create Mosaic dialog box will be displayed.  
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6. Type a name for the mosaic.

7. Enter a resolution value.

If one or more of the GeoBaRs to be included in the mosaic have 
a lower resolution than what you have set for the mosaic, the 
Resolve Conflict dialog boxes will display. 
8. Select a method to process the overlapping data from the drop-down 

list.

There are five methods to choose from:
• Auto-Seam: This method determines which pixels have 

higher significance when there is overlap. A weighting 
function is constructed that assigns lower significance to 
pixels at the edge of the swath than to pixels near the centre. 
The first few pixels near the nadir are assigned low 
significance due to the low resolution in that region.

• Full Blend: This method uses Geocoder’s blend operation to 
smooth pixel values. It also relies on a weighting scheme. 

• Overwrite: Uses the draw order to decide which pixel will be 
used in an overlapped area. 

• Shine Through: The highest intensity pixel will be used.
• Underlay: The opposite of Overwrite. The pixel is added only 

if no other point exists.
9. Select a colour map from the drop down list. The range of colours will 

be displayed in the Preview fields below. 

10.Click Create.

The mosaic that is created will appear in the Layers tab, with its 
child layers: Intensity, Original Intensity and Weights (as for 
GeoBaRs) plus a layer called Contributor. When this layer is 
selected, the contributor GeoBaRs are colour-coded in the Mosaic 
display. 
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Delete Mosaic

To delete a Mosaic:
1. Right-click on the Mosaic layer in the Layers tab. 

2. Select Delete Mosaic from the pop-up menu.

This will permanently delet the mosaic from your disk. (It does not 
delete the component GeoBaRs. 
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Edit Mosaics

Mosaics can be edited for brightness, contrast, and and visibility. 
As well, component GeoBaRs can be added, modified or removed.
While you may have more than one mosaic open in the display, 
only one mosaic can be edited at a time.
To edit a mosaic:
1. Right-click on the mosaic layer in the Layers tab of the Control window.

2. Select Edit Mosaic from the pop-up menu.

The functions on the Edit tab are displayed. 
 

1. To adjust brightness, slide the sliders to the right or left to change the 
intensity of the image. 

2. To adjust contrast, slide the Contrast slider to the right for more 
contrast and to the left for less contrast.

As you change these values with the slider, the new values are 
displayed in the Intensity Range fields.
3. Use Reset to restore the values of the Original Intensity layer. 

(Removes the effects of the adjustments made with the sliders.)

4. Use the Visibility Options to turn on or off the various child layers of the 
mosaic.
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Edit Mosaic Components 

The way in which a component GeoBaRs contributes to a mosaic 
can modified. GeoBaRs can be removed from a mosaic, and other 
GeoBaRs added. 
The methods available to add or modify GeoBars are the same as 
used to create the mosaic: Auto-Seam, Shine Through, 
Overwrite, Underlay and Fully Blended.
To edit mosaic components:
1. With the mosaic open and the Edit tab activated, select a GeoBaR from 

the mosaic.

2. The Edit tab now displays Component options.

Modify Components To modify the method by which a component contributes to the 
mosaic: 
1. Select Modify 

2. Select the preferred method from the drop-down list.

3. Click Commit.
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Remove GeoBaR from 
mosaic

To remove a component from a mosaic, 
1. Select Remove.

2. Select an option from the drop-down list: 

Remove Complete will re-mosaic the portion of the mosaic covered 
by selected GeoBaR, without any contributions from the selected 
GeoBaR. 

Remove Explicit will keep any blended pixels, but remove any pixels 
that are explicitly from the selected line.

3. Click Commit to save the changes.

You can select a GeoBaR and perform a manual blending 
operation with it.
1. Click Blend to open a slider dialog that you can use to blend a GeoBar 

into the existing mosaic.

2. Move the slider to see the effects of blending. When you have a 
desired blend, click Commit. 

3. To back out of the Blend function without saving, click Cancel.

Add a new component To add another GeoBaR to the mosaic:
1. Select a GeoBaR that is not part of the mosaic.

2. In the Edit tab select the Add option.

3. Select a method for processing overlap from the drop-down list.

4. Click Commit.
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Conflict Resolution 

This dialog box can appear in any operation where there is more 
than one GeoBaR for a line, but only one GeoBaR can be used. 
The Resolve Conflict dialog box allows you to choose the single 
desired GeoBaR from a group of GeoBaRs.
The options for resolving this conflict are to select:
• the most recently created mosaic
• the finest resolution (looks for the GeoBaR that occupies the 

most disk space)
• the component GeoBaR for a mosaic being edited
• the source type: Side Scan, Beam Average, Time Series. If 

more than is of the specified type, then a new Resolve Conflict 
dialog box is displayed containing only the GeoBaRs tha 
share the source type in conflict. 

or to select the GeoBaR manually.
When conflict arises, the dialog box displays the name or 
identifying information for the track line, and a drop-down list of 
these resolutions.

The title bar shows you the number of the current conflict and 
the number of conflict there are. If there is more than one 
conflict you can use the Apply to all option to apply the same 
method of resolution to all conflicts.
The dialog also has three buttons: Apply, Skip, and Cancel. All 
three of these buttons close the dialog. Apply uses the current 
settings to resolve this conflict. Skip will not resolve this conflict 
but will allow the user to continue with any other conflicts. 
Cancel will stop the process of resolving conflicts regardless of 
how many conflicts are remaining.

total 
number

of conflicts

current
conflict 
number

line
name
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Manual resolution If you choose to resolve the conflict by selecting a specific 
GeoBaR, the dialog box refreshes to display a drop down list of 
the conflicted GeoBaRs.
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Sediment analysis

Use the Sediment Analysis Tool (SAT) in Mosaic Editor to 
analyze the angular responses of corrected data to determine 
sediment type. This tool is located on the Analysis tab of Mosaic 
Editor.
When a GeoBaR is created, a sediment analysis file is also 
created for the line.  Sediment analysis is performed over a 
certain number of pings, controlled by the Patch Size in the 
Sediment Analysis Options.  
Data is analysed with respect to the sediment angular response 
models in order to determine an average grain size. This average 
grain size is then cross-referenced to the customizable look-up 
table in order to provide a textual response. 
The SAT tab has two main parts: 
• a set of controls for initiating analysis or interacting with the 

backscatter models. The controls have both Standard and 
Advanced modes. (Analysis tab of Mosaic Editor), and 

• a dockable, resizable graph window that displays the average 
angular response for a given range of data. 

Set SAT options
1. Open the Display tab of the Tools > Options dialog box.

2. Select Mosiac Editor.

3. Select the Show All Sediment Analysis Patches check box. 

4. Click OK and close the dialog box.

When the sediment analysis tool is activated, this will allow 
display of the patches within the selection area along the line.
5. Open the Sediment Analysis Options from the Mosaic Editor toolbar, or 

from Tools > Mosaic Editor > Sediment Analysis Options.
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6. Set the number of pings in the Patch Size over which the sediment 
analysis will be performed.

By default, every time a new GeoBaR is created for a line, a 
Sediment Analysis file is also, overwriting any file that had been 
created previously. This can be changed to never have a 
sediment analysis file created, or to only generate the file once. n
7. Set the File Creation Option by selecting one of the three 

options.
8. Click OK.
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Analyze

There are two modes of sediment analysis: Standard and 
Advanced.

Standard Analysis 1. Select Standard from the Display drop-down list on the Analysis tab.

2. Click Analyze.

The results are displayed on the Analysis tab.The results show 
an estimate of mean grain size and a confidence in that analysis 
for each side based on the sediment angular response 
measurements collected by the sonar equipment. 
 

Advanced The Advanced analysis option enables you to adjust the values 
in the grain size table used in the analysis, set variations in 
parameter values for port and starboard data, and to set options 
for the graph displayed in the Sediment Analysis window. 



408 CARIS HIPS and SIPS User’s Guide

Processing in SIPS—Mosaic Editor: Sediment analysis

1. Select Advanced in the Display field on the Analysis tab.

The tab is refreshed to display other options.

2. Select a Source. 

• Sediment Data: this options allows you to edit the Grain Size table.

• Model Parameters activates the Parameters table so you can set 
different values for the parameters for port and starboard using the 
slider control.

3. Click Edit to open the Grain Size table.
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Grain size values and their descriptions can be edited using the 
Modify button. New Classes can be added using the Insert button. 
Use Reset to restore the default values.
If you select Model Parameters as Source, the Parameters list 
box is activated so you can modify values in the list using the 
slider below it. When you modify this table you have the option 
of having it automatically update as you change values, or to use 
the Update button to apply all changes at the same time.
The Model Options field allows you to select to use Biot model. 
Click Graph Options to open the options dialog box for the 
Sediment Analysic Graph window.
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Sediment Analysis Graph 

You can view the results graphically in the Sediment Analysis 
Window. 
To open this window:
1. Select the Open Sediment Analysis graph command. 

The graph is displayed.
 

To close the graph window, select the Open Sediment Analysis 
graph command or toolbar button again.
To set which backscatter forms will be displayed in the graph 
window:
2. Click the Graph Options button on the Analysis tab.

3. In the Options dialog box, select the check boxes for the types you wish 
to display.
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Processing in SIPS—Side Scan Editor

SIPS provides tools for viewing and processing side scan sonar and 
multibeam backscatter data. The SideScan Editor can be used to process 
data, to digitize and edit contacts, or as an alternative to correcting 
imagery in Mosaic Editor. 

In this chapter...
“USING SIDE SCAN EDITOR” ON PAGE 404
“EDIT SIDE SCAN DATA” ON PAGE 405
“IMAGE PROCESSING” ON PAGE 412
“SIDE SCAN EDITOR INTERFACE” ON PAGE 422
“SIDE SCAN EDITOR CONTROLS” ON PAGE 425
“CONTACTS” ON PAGE 442
“SIPS TEMPLATE WIZARD” ON PAGE 448
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Using Side Scan Editor

In Side Scan Editor you view, edit and process data in 
preparation for creating mosaics or digitizing and editing 
contacts.
Use Side Scan Editor to:
• use a waterfall display for editing, or 
• apply advanced Time Varying Gain controls, or 
• edit altitude data for side scan data, or 
• digitize and edit contacts

Side Scan Editor 
workflow

Data in Side Scan Editor can be viewed in either raw or 
processed mode. Processing can be applied to a single ping, to a 
range of pings, or to one (or more) track lines. 
1. If desired, the raw data may be edited by selecting, querying, rejecting 

or accepting pings. Rejecting pings removes them from consideration 
for any mosaics to be created from this data (see “EDIT SIDE SCAN DATA” 
ON PAGE 405).

2. Once pings are edited, you may need to digitize the “first return” or 
altitude if the sonar did not detect and record this data during 
acquisition. The altitude is required to perform slant range correction. If 
digitized altitude data does exist, it may need to be edited first. (see 
“DIGITIZING SONAR ALTITUDE” ON PAGE 407).

3. With fish altitude and an average sound velocity, the raw data can be 
slant range corrected. Slant range correct data is shown in processed 
mode, where the across track measurement is horizontal distance. 
(see “APPLY SLANT RANGE CORRECTION” ON PAGE 414).

In this processed mode, you can edit and query pings, make 
height and distance measurements, and mark and edit contacts. 

4. Use the correction tools to remove unwanted artifacts:

• “BEAM PATTERN CORRECTION” ON PAGE 416)
• “ANGLE-VARYING GAIN” ON PAGE 419 
• “TIME-VARYING GAIN” ON PAGE 420

• “DESPECKLE” ON PAGE 421)
The parameters for applying these correction tools can also be 
saved in a template file and loaded and applied again. (See “SIPS 
TEMPLATE WIZARD” ON PAGE 448). 

5. Create and edit contacts

See “CONTACTS” ON PAGE 442.
Corrected data from Side Scan Editor can be opened in Mosaic 
Editor where it can be used to create GeoBars and from them, 
composited mosaics, or to analyze bottom sediment (See 
“INTRODUCTION” ON PAGE 387).
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Edit Side Scan Data

In Side Scan Editor you can reject or accept lines as you do in 
other HIPS and SIPS editors, except that you select a ping 
rather than an individual sounding or beam. (This line editing 
does not need to be done within the Side Scan Editor, it can be 
done in the HIPS Display window.)
“ACCEPT/REJECT/QUERY” ON PAGE 405

If navigation sensor data has been edited with in Navigation 
Editor it may be necessary to recompute towfish navigation. (See 
“RECOMPUTE TOWFISH NAVIGATION” ON PAGE 406.)
If you intend to apply a slant-range correction, the altitude of the 
sonar must be known. If this is not already logged with your 
data, the altitude must be digitized. (See “DIGITIZING SONAR ALTITUDE” 
ON PAGE 407.) 

Accept/Reject/Query

You can change the status of an entire ping or of only the 
starboard or port side.

1. From the Side Scan toolbar, use the Side Scan Selection tool  to 

select the range of pings from the Side Scan Editor window (“waterfall 
view”) to be accepted or rejected (see “SELECTION” ON PAGE 434).

2. [Optional] From the HIPS Edit Toolbar, select 

• Edit Port Side Only or Edit Starboard Side Only.

3. Select the desired status from the menu or toolbar: Accept or Reject.

When a ping is rejected in the Side Scan Editor, it is given a 
status flag that excludes it from further processing in SIPS. 
4. Select the Reject tool.

The status of the ping or range of pings is set to Rejected. 
However, Rejected data is not deleted and can be changed to 
Accepted status again with the Accept command. 

Accept To make rejected data available for further processing in SIPS: 
1. From the Side Scan toolbar, use the Side Scan Selection tool to select 

the rejected pings (see “SELECTION” ON PAGE 434).

2. Select the Accept tool.

Previously rejected data is now flagged as accepted and is visible 
in the Side Scan Editor.
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Query Use the Query function to view information about selected pings.
1. From the Side Scan toolbar, choose the Side Scan Selection tool and 

select a range of pings to be queried (see “SELECTION” ON PAGE 434).

2. Select the Query tool.

Information about the selected data is shown in the Worksheet 
window. If the window is not open at the time you query the 
data, it will open automatically.

Recompute Towfish Navigation

Navigation data for towed sensors can come from the following 
sources:
• If computed during data logging and stored in the raw side 

scan format, it can be converted directly into the SIPS towfish 
navigation data structure. The Recompute Towfish 
Navigation process is therefore not required.

• It can be computed by SIPS if specific sensor data is available. 
SIPS requires ship navigation data with cable out and towfish 
depth to compute towfish navigation, or ship navigation with 
horizontal layback.

If you want SIPS to compute the towfish navigation data:
1. Select one or more towfish track lines.

2. Select the Recompute Towfish Navigation command.

The Recompute Towfish Navigation dialog box is displayed.
.

Towfish sensor data can be smoothed in the Attitude Editor (see 
“ATTITUDE EDITOR” ON PAGE 572) and this data can be applied when the 
towfish navigation is computed. Select a check box to apply the 
smoothed data.
3. Select the Recompute Contact Positions check box to update the 

contact positions based on the new navigation data.
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4. Click OK.

If contacts are contained in the track lines where towfish 
navigation has been updated, you must update the contact 
positions to match the new navigation (see “RECOMPUTE CONTACT 
POSITIONS” ON PAGE 447).
To compute towfish navigation from the ship’s navigation 
requires a horizontal distance and direction from the ship’s 
towpoint location to the towfish. The towpoint is defined in the 
vessel file.
• Horizontal distance. Recorded horizontal layback data or 

actual cable length both share the same data structure in 
SIPS called SSS Cable Out. SIPS can distinguish between the 
two by the towfish sensor depth data. If the sensor depth data 
is zero, the horizontal layback is used. If the sensor depth 
data is non-zero it will be combined with the cable out data 
using trigonometry to produce horizontal distances. All 
distances to the towfish are applied from the towpoint 
position on the ship as defined in the vessel configuration file.

• Direction. The direction from the ship’s towpoint location to 
the towfish is derived using a “follow-the-dog” method. The 
average of the first 30 seconds of the ship’s “course-made-
good” is used for the initial direction. Thereafter, each 
successive position computed for the towfish occurs along the 
direction from the next ship’s position to the previous towfish 
position.

If horizontal layback or tow cable length data is not available, or 
if the Recompute Towfish Navigation step is not executed, then 
the recorded towfish navigation data converted into SIPS is used 
for generating the positions of contacts and for mosaics. 
If towfish navigation is not available at all then the position of 
the side scan imagery data is assumed to be the same as the ship 
navigation data.

Digitizing Sonar Altitude

Before side scan data can be processed, the altitude of the sonar 
must be known. With some sonars, altitude is logged in the raw 
data files and is converted by SIPS. However, in other cases, 
altitude is not logged or is logged and needs to be edited. The 
Side Scan Editor provides automated and manual tools to 
digitize the bottom directly from the side scan trace.
A raw side scan sonar display with a digitized seabed is shown 
below.
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Digitization and colour 
maps

Sometimes there is no clear distinction between the water 
column and the seabed. You can compensate for this by 
adjusting the display of intensity values in the editor so that the 
seabed and water column are clearly outlined. Also see “COLOUR 
MAPPING” ON PAGE 427.
1. Make sure that only two colours are displayed in the editor (for 

example, GreyScale.cma).

2. Use the sliders in the colour histogram to adjust the display in the 
editor.

3. Once the there is clear distinction between the water column and 
seabed use the digitizing tools to trace the first bottom return.

4. To remove the digitized lines, select the Clear command.

Automatic digitizing

The automatic digitizing method traces the first bottom return 
using a sophisticated multi-pass algorithm. Automatic digitizing 
is most effective when there is a clear distinction between the 
water column and the bottom. This method can be applied to a 
range of pings or to the entire line.
Settings for automatically digitizing the side scan return are in 
the Altitude tab of the Control window.

Offset from nadir

Digitized 
seabed
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The Altitude tab options are described below in the order that 
they appear in the tab. While the Contrast Step Size and Max Height 
Changes are compulsory for digitizing, the other options can be 
applied depending on the specific conditions of your data.

Contrast Step Size The Contrast Step Size and Max Height Change options must be set 
to correctly auto digitize the side scan.
The Contrast Step Size is the minimum difference in contrast 
expected between the intensity values of the water column and 
the seafloor. The Signal Display Window may be helpful in 
determining a good step size.

Max Height Change The Max Height Change is the maximum allowable ping-to-ping 
change in detected bottom position (in pixels). It is a restriction 
on the variation anticipated in detected bottom position. It could 
be visualized as error bars guiding the algorithm along the 
bottom.
1. Use the <Up> or <Down> arrow buttons to select the percentage for 

the Contrast Step Size and Max Height Change values.
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Offset from Nadir Strong solid returns in the water column, such surface 
reflections, can be compensated for by setting an offset from 
nadir in raw data mode.
2. Set the value in milliseconds for an Offset from Nadir by clicking the up 

or down arrow buttons.

3. Select Show Offset from Nadir to display the offset visually as a dashed 
line. 

• The line colour is set to the Measure / Offset tools colour in Tools > 
Options > Side Scan Editor.

• The thickness of the line is set in the Line thickness field on the 
General tab in the Side Scan Editor Control tab.

Verification The verification option tests the detected point to see if its 
intensity is consistent with nearby values further across-track 
that should also represent seafloor.
Its purpose is to detect and ignore anomalous points in the water 
column (for example, noise from equipment, reflections off the 
surface, marine life), by checking to see if there is water rather 
than sea floor on the other side of a detected point.
4. Select the Verification check box.

5. Select a desired strength-level for the verification from the drop-down 
list. Choices range from “Very Weak” to “Very Strong”. The default is 
“Normal”.

Interpolation The Interpolation option fills along-track gaps in the detected 
bottoms.
6. Select the Interpolation option.

7. Select the size of the gap to be filled by clicking the up or down buttons 
beside the Max Gap Size field.

Moving Average Filter The Filter option smooths the digitized line.
8. Click the Moving Average Filter check box.

9. Click the <Up> or <Down> arrow buttons to select the number of pings 
used for averaging in the Filter Width field.

You can use the Auto Digitize tool, or use the buttons at the bottom 
of the Altitude tab to complete digitizing. If you are using the 
buttons, continue with Step 8, otherwise, go to Step 11.
10.Choose any of the following digitization options:

• Click To Start to extend the digitized region to the back of the entire 
line.

• Click To End to extend the digitized region to the end of the line.

• Click All to digitize the entire selection or the entire line. 

11. If you change a value in the tab, click Recalculate to update the 
Digitization.

12.Select Overwrite to enable re-digitization of selected areas without 
clearing. With Overwrite disabled, only zero-altitude/cleared fish 
heights will be available for digitization.
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13.Click anywhere on the seabed to select the start and end pings for 
digitization and also to indicate the side (port or starboard) on which to 
perform the calculations.

14.[Optional] You can select the Clear tool to remove the digitization.

Manual digitizing 

Add altitude lines by selecting areas along the first bottom.
1. Select the Manual Digitize tool.

2. Press and hold the mouse button and drag the cursor along the bottom 
contact.

As you drag the cursor, a digitizing line is drawn in the window. 
When you digitize one side, the other side is automatically 
mirrored.
3. Alternatively, create a point-to-point line by clicking carefully along the 

first return.

4. Cancel the Manual Digitize tool when finished.

At any time during the digitizing process, you can select the 
Clear tool to remove the digitization.

Interpolate Selection

Interpolation digitizes a straight line between the fish height 
values found at the start and end of the selection. Any altitude 
data within the selection is overwritten during this operation.
1. Use the Side Scan Selection tool to select an area of raw mode data 

that has been digitized. (See “SELECTION” ON PAGE 434) 

2. Select the Interpolate Selection command.

The pixels between the digitizing points are interpolated and the 
digitizing lines are smoothed.
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You can also use the space bar to move along the track 
line while in digitizing mode.
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Image Processing

Side scan imagery has been traditionally processed on a line-by-
line basis, using a “waterfall” display, and a number of carefully 
designed process tools. These processes are available on the 
Process menu and on the Process Side Scan toolbar: 

1. “SLANT RANGE CORRECTION” ON PAGE 413

2. “APPLY SLANT RANGE CORRECTION” ON PAGE 414

3. “BEAM PATTERN CORRECTION” ON PAGE 416

4. “ANGLE-VARYING GAIN” ON PAGE 419

5. “TIME-VARYING GAIN” ON PAGE 420

6. “DESPECKLE” ON PAGE 421

7. “PURGE REJECTED CONTACTS” ON PAGE 446

Imagery corrections can also be applied using the SIPS 
Template Editor (see “SIPS TEMPLATE WIZARD” ON PAGE 448). 

Revert/Reapply

The most recent correction made in processed mode can be 
undone or redone using the Revert and Reapply tools. 
1. Select the Revert tool to reverse the last correction.

2. Select the Reapply tool to reapply the last correction.

This facility to go back a step without losing your work, in effect 
enables you to “toggle” between the before and after of a process. 
For example, with the Signal Display Window open, use Revert/
Reapply to see the effect of slant range correction.

1. 2. 3. 4. 6.5. 7.
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Slant Range Correction

Side scan sonar is initially logged as a series of time-indexed 
intensity values for each ping. Slant range correction re-samples 
this raw side scan data to produce profiles of image pixels where 
the across-track scale is related to distance from nadir instead of 
time.

Across-track positioning 
using height sources

The standard slant range correction operation applies a sound 
velocity estimate to the two-way travel time for each intensity 
value. This produces an estimated ray length that when 
combined with the known sonar height (from the digitized or 
logged bottom) is used to produce the across-track distance to 
the pixel using simple trigonometry. This method presupposes 
that the bottom is flat across the ping and can result in the 
across-track misplacement of objects over varied or steeply 
sloping terrain.
SIPS can use a height source (such as a BASE Surface, grid, or 
tile) in the slant range correction operation to supply depth 
values to improve the across-track positioning of pixels.
In the following figure, raw side scan data is represented as a 
series of time (t) and pixel intensity values (i).

When a height source is used during slant range correction, a 
depth profile is first derived from the source along the path of 
the side scan ping. Then, the two-way travel time to each pixel is 
converted to a distance from nadir using the estimated velocity 
of sound in water. The distance is then used to calculate the 
position of the image pixel along the ping drawn from the height 
source.
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The resulting output is an intensity value indexed to across-
track distance (x) rather than time.

Apply Slant Range Correction

In the Side Scan Editor, Slant Range Correction is applied to 
data in raw mode. Other corrections in Side Scan Editor are 
made to data that has been slant range corrected. Once you 
slant-range correct data, you can return to raw mode to start 
again, however, any correction previously made to processed 
data will be lost.
1. .Select the track line(s) in the Display window.

2. Select the Slant Range Correct tool.

The Slant Range Correction dialog box is displayed.
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1. Type the resolution (in metres or feet) for the slant range corrected file. 
The resolution value defaults to the minimum value appropriate to the 
sonar system. If this is not available then it defaults to 0.10 metres or 
0.33 feet. A finer resolution generates a larger file.

2. Enter the average speed of sound.

3. Select the setting for Data Reduction from the drop-down list. 

• The default is to use the 16-bit factor that is stored with the line.

• Select Use 8-Bit Shift if you want to create a slant range file using 
only eight bits of storage per pixel. This option is important if the 
data that you are slant range correcting was originally 16-bit and all 
16 bits were maintained at conversion. 

• Select Use Shift Factor Per Line 

4. Select the Use Height Source check box if you want to apply a height 
source, then select the height source from the list. (This is only 
available if you have a BASE surface or other height source open.)

5. Click Set. The slant range corrected data is displayed in the Side Scan 
Editor.
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Beam Pattern Correction

Beam pattern correction uniformly removes along-track banding 
inherent to the sonar beam. This effect is produced by each 
transducer uniquely.
Beam pattern correction relies on a user-generated beam 
pattern file to identify and remove this effect. Tools are provided 
to create, view and process beam pattern files. The process uses 
the beam pattern file to uniformly correct the selected line(s), 
producing a more consistent appearance in mosaics.
Once the beam pattern file is created it can be applied to one or 
more lines in the Display window, or to one or more pings in the 
Side Scan Editor.
If no Beam Pattern Correction file exists you will need to create 
one in order to apply Beam Pattern Correction parameters. All 
the tools to create a beam pattern file are accessible on the Beam 
Pattern Toolbar, while the Side Scan Editor is open.

Create Beam Pattern Correction File 

To create a beam pattern file you must select an area that is as 
flat, featureless and homogenous as possible. It is recommended 
that a “patch test” be done during a survey over an area known 
to have such properties. In order to create a more robust and 
accurate beam pattern correction file, it is also important to vary 
the fish height over the range expected to be used during the 
survey.
1. Using the Side Scan selection tool, select an area along the track line.

2. Select the Create Beam Pattern tool.

The Beam Pattern Correction dialog box is displayed.

The option is available to alter the range of pings to be included 
in the creation of the beam pattern. While this should be done 
with care, it is possible to create a beam pattern file from a 
selection larger than the range visible in the Side Scan Editor 
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display. You may also select the whole line for the creation of the 
beam pattern if you wish. It is recommended that only an area 
meeting the criteria set forth above be considered for inclusion in 
a beam pattern file.
3. Select Process to create the Beam Pattern file.

The Windows Save As dialog box is displayed.
4. Type a name for the Beam Pattern file and select Save.

The Save Beam Pattern, Save Beam Pattern As, View, 
Remove Spikes, Smooth, and Reload tools are now active in 
the menu and on the Beam Pattern Correction toolbar (below). 

View Beam Pattern

5. Select the View Beam Pattern tool.

The Beam Pattern Graph window is displayed.This window 
shows the intensity levels of the side scan sonar over the 
selected area. 

Remove Spikes/Smooth The Remove Spikes tool removes anomalies from the Beam 
Pattern Graph. 
6. Select the Remove Spikes tool.

Create Beam 

Load Beam 

Close Beam 

Save Beam 

Save Beam 

View Beam 

Reload
Set Sediment 

Set Beam 
Pattern Offset Pattern

Pattern 

Pattern Pattern As

Pattern Pattern

Class
Remove Spikes

Smooth Beam 
Pattern
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The next step is to apply the Smooth Beam Pattern tool. The 
Smooth Beam Pattern tool uses a moving average filter to 
reduce noise in the beam pattern. 
An example of the graph before and after using the Smooth tool 
is shown below. The left-hand window shows the unsmoothed 
graph and right-hand window shows the graph after smoothing. 

7. Select the Smooth Beam Pattern tool.

The Smooth Beam Pattern tool can be used repeatedly until the 
preferred degree of smoothing is reached.

Reload The Reload tool reloads saved changes from the active beam 
pattern file. Any changes to the beam pattern after the last save 
are lost.

 For example, if you remove spikes and then Save, then apply 
Smooth Beam a few times, the Reload tool will restore the graph 
to the point just after you saved it.
8. Select the Reload tool.

Save/Save As When you have completed smoothing the data, you can save 
these settings using the Save Beam Pattern or Save Beam 
Pattern As… tools.
9. Select Save Beam Pattern to save the filtering and smoothing changes 

to the Beam Pattern File.

10.Select the Save Beam Pattern As command to save the file as a new 
file.

Apply Beam Pattern Correction

The Beam Pattern Correction file can be applied to a selection in 
the Side Scan Editor or to track line(s) in the Display window. 

Before smoothing

After smoothing
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1. Make a selection in the Editor, or, 
select a track line or group of track lines in the Display window.

2. Select the Beam Pattern Correction command.

The Beam Pattern Correction dialog box is displayed. 

The Beam Pattern file will default to the last created, loaded, 
saved or executed one. You can use the Browse button to locate a 
different file for processing. The default location for Beam 
Pattern files is <Data Dir>/Sidescan.
The outer edges of some pings may have been recorded at angles 
beyond the extent of the beam pattern file being used. The Outer 
Edge option must be specified for handling these cases.
3. Select a method for handling sonar data collected outside the bound of 

the beam pattern file:”

• Extrapolate: Extrapolate the beam pattern to correct angles beyond 
the outer edge of the generated beam pattern file.

• Trim: Remove sonar data that is beyond the extent of the beam 
pattern file. Trimmed data will appear as 0 intensity white space in 
the Side Scan Editor.

• Do Nothing: Does not correct sonar data beyond the extent of the 
beam pattern file. Uncorrected data will appear the same before and 
after Beam Pattern Correction in the Side Scan Editor.

4. Apply the Beam Pattern Correction to the both sides of the side scan or 
to either the starboard or port sides.

5. You can apply the Bean Pattern Correction to your entire survey by 
selecting all the track lines, or you can open the Side Scan Editor and 
select a portion of the data: 

• Ping: the correction will apply to the single ping selected in the Side 
Scan Editor window.

• Selection: the correction will apply to the range of pings you 
selected in the Side Scan Editor window. 

• Line: the correction will apply to the entire trackline you have 
selected. 
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6. Click Process to apply the correction. 

Angle-Varying Gain

Angle-Varying Gain (AVG) correction removes the angular 
response of sediment from the imagery, normalizing the mean 
angular intensities, ping-by-ping, with a moving average filter. 
AVG correction can be applied to a selection or a single ping in 
the Side Scan Editor or to one or more track lines in the Display 
window. 
1. Make a selection in Side Scan Editor. (See “SELECTION” ON PAGE 434 for 

selecting areas and pings).

2. Select the AVG Correct tool.

The AVG Correct dialog box is displayed.

3. Select the number of adjacent pings to include in the moving average 
by clicking Moving Average Window Size up or down arrow buttons.

For example, an average based on a window size of 100 will 
include 50 pings before and after the ping being corrected.
4. Apply angle-varying gain to the port, starboard, or both sides of the 

side scan.

5. Apply the angle-varying gain correction to either a Ping, Selection, or 
Line by selecting the appropriate option.

6. Click Process.
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Time-Varying Gain

Time-Varying Gain (TVG) Correction allows you to adjust the 
signal intensity by applying a non-uniform, time-dependent 
gain.
During acquisition, this is necessary because of the attenuation 
that occurs due to absorption and spreading as the sonar beam 
travels back to the receiver. Since these returns are received 
over a predictable and constant time period, a time-varying 
curve can used to increase gain to compensate for the decayed 
sonar return. In post-production, it maybe necessary to augment 
the TVS correction applied during acquisition.
The TVG Correction command also allows you to apply a 
uniform gain correction without applying the any time-
dependent gains by using only the Gain control.
TVG Correction can be applied to a single ping, selection, or the 
currently selected line in the Side Scan Editor, or to one or more 
track lines in the Display window. 
1. Make a selection in the Side Scan Editor. (See “SELECTION” ON PAGE 434 

for selecting areas and pings).

2. Select the TVG Correct command.

The Time-Varying Gain Correct dialog box is displayed.

There are two modes for TVG correction: Standard and 
Advanced.
3. Select either the Standard or Advanced mode from the Mode drop-

down list. (The options available depend on the mode selected.)
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The Preview window is available when a selection or 
superselection is made in the Side Scan Editor. The Preview 
window is not available when a track line is selected.
The Preview window is divided into three panes:
• Gain (shown as a percentage)
• Intensity values before TVG is applied.
• Intensity value after TVG is applied.
Changes are instantaneously shown in the Preview window. 
4. Click Open to view the Preview window. To close the window, click 

Close.

5. The TVG correction can be made to port, starboard, or both sides by 
selecting the appropriate from the Side drop-down list.

6. The correction can be made to a single ping, a selection, or the entire 
line by selecting any of these options from the Range drop-down list. 
(The options depend on the selection made in the Side Scan Editor or 
in the Display window).

Standard The Standard mode contains two options for correcting TVG.
7. Increase or decrease the percentage Gain by clicking the up or down 

arrow buttons.

8. Increase or decrease the TVG value by clicking the up or down arrow 
buttons. This changes the TVG curve.

Advanced The Advanced mode contains more precise options for correcting 
TVG.
9. Spherical Spreading compensates for the loss of energy caused by 

signal displacement along the sea floor. Increase or reduce the signal 
intensity by clicking the Spherical Spreading up or down buttons.
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10.The Absorption value compensates for attenuation due to energy loss 
in water. The scale factor is in dB/unit distances. Click the up or down 
arrow buttons to increase or reduce this value.

11.Click Process to apply the TVG correction.

Despeckle

Despeckling uses a calculated value based on neighbouring 
intensity levels to replace the current pixel’s intensity if it is 
outside the specified range. The value calculated from the 
neighbouring intensities can be derived by one of two methods 
mean or median.
Despeckling imagery is a visual process, consisting of adjusting 
the despeckle values and viewing the display until the desired 
results are obtained. 
The following steps are used for despeckling images:
1. Select a track line.

2. Select the Despeckle tool.

The Despeckle dialog box is displayed.

3. Select the Mean or Median Filter from the Method drop-down list.

4. Use the up and down arrows to select a Threshold for defining an 
acceptable range in which the pixel value will not be replaced. 

For example, if the mean value is 50 and the threshold is +/- 20% 
then the acceptable range is 40 to 60. Thus a pixel value of 38 
would be replaced by the mean value of 50 as it is outside the 
range, but a pixel value of 42 would not be replaced. 
5. Select a pattern of neighbouring pixels from the Matrix Size drop down 

list be used in calculating the mean/median.

6. Click Process

The line is filtered to remove noise from the sonar image.
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Side Scan Editor Interface

The Side Scan Editor consists of a data display window, toolbars 
and the Side Scan Editor tabs in the Control window. 
To open the Side Scan Editor:
1. Select a towfish track line in the HIPS and SIPS Display window.

2. Select the Side Scan Editor tool.

When the Side Scan Editor is opened, the data for the selected 
track line is displayed in the Side Scan Editor window, which 
has a default location along the right side of the interface. 
As well, a histogram of the sonar file is displayed in the 
Worksheet window, and the Side Scan Editor toolbar and the 
Beam Correction toolbar are activated. 
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Side Scan Editor window

The Side Scan Editor data display window (also called the 
“waterfall” view) can be undocked and moved to another 
position, for example, at the bottom of the interface, as in the 
figure above (see “REPOSITION AND RESIZE WINDOWS” ON PAGE 25). 
There are two modes to display data in the Side Scan Editor 
window:
• Raw: (the unprocessed sonar data). In raw mode the across-

track axis represents time, thus the data is shown in the 
sequence in which it was received. The central portion of the 
image still displays the water column. This mode will always 
show the raw data for the selected track line. 

• Processed: (the processed sonar data). In processed mode 
the across-track scale represents distance. The water column 
is no longer visible as it is removed during the slant range 
correction process. The data displayed in this mode will 
reflect the last processing done to it. 

1. Select a display mode.

The display is refreshed to show the data in the selected mode. 
The selected mode is indicated with a check mark in the menu.

Coverage outline A coverage outline in the Display window automatically 
highlights the location of the side scan data that is visible in the 
Side Scan Editor window. The starboard and port areas of the 
coverage outline are appropriately colour coded. The size of the 
coverage outline varies with the amount of side scan visible in 
the Side Scan Editor window.
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Note: If the data does not fill the entire height of the Editor 
window, it will be displayed in the bottom of the window 
and can be processed normally. The empty area above the 
data will indicate “No data to display”.
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Colours for outlines and selection are controlled from the Tools 
>Options dialog box (see “SIDE SCAN EDITOR” ON PAGE 669).

Compression The number of pixels used to display data in the Side Scan 
window is determined by the width of the display window and 
screen resolution. However, because the volume of data is often 
too great for the window to display all pixels, the imagery must 
be compressed.
There are three compression methods to choose from.
1. Select a Compression command. 

• Skip selects pixels for display at regular intervals across the 
track.

• Average compiles average pixel intensity within a group of 
pixels spaced at regular across-track intervals.

• Maximum selects the brightest pixels from groups of pixels 
at regular across-track intervals.

The display in the Side Scan Editor is refreshed to show the data 
according to the selected compression option. The default display 
uses the Skip option. 
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Side Scan Editor controls

The General tab of the Side Scan Editor contains controls for 
navigating and displaying data in the Editor window. This tab is 
visible in the Control Window when the Side Scan Editor is 
opened.

Across-track display The width of the ping shown in the Side Scan Editor window can 
be increased or decreased by time or distance, using the controls 
in the Acrosstrack Display Limit fields.

To set across track display limits:
1. Make sure the Control window is open.

2. Select the General tab from the Side Scan Editor tab.

3. To have the entire width of the ping is shown in the Editor, leave the 
Across Track Display Limit box unchecked.

4. To limit the width of ping displayed, check the Across Track Display Limit 
box and select which value to use as limiter:

• Milliseconds: Click the arrow button to change the time value. This 
option is automatically selected. 

• Metres/Feet: Click the arrow buttons to change the distance value. 

As time or distance is incremented or decreased, the amount of 
the data is displayed in the window is changed.
The units of distance units can be changed using the Display tab 
in Options on the Tools menu. 

Enable Range display The range display runs across the top and bottom of the Side 
Scan Editor window. In Raw mode the range displays time 
intervals in milliseconds. In Processed mode, distance is 
displayed in the units you have set in the Tools >Options 
>Display dialog box. 
1. Select the Enable Range Display check box in the Side Scan Editor 

General tab.
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The colour of the range display is set to the same colour used for 
measure/offset tools in the Side Scan Display Options of the 
Tools menu.
. 

16-Bit Shift Factor An 8-bit colour display in a 16-bit processed data set can be 
enhanced by bit-shifting to select which 8 bits are used to 
generate the display. This can create a more even distribution of 
pixels.
1. Make sure that 16-bit processed data is displayed in the Side Scan 

Editor.

2. Click the up or down arrow keys beside the 16 Bit Shift Factor field to 
select a value from 0 to 8.

The display is refreshed.
Ping selection The two Selection fields display the start and end ping numbers 

when you select part of the trackline displayed in the Editor 
window. You can use these fields to select specific start and end 
pings. 
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Colour Mapping

Colour maps provide a clear visual representation of sonar 
intensity levels along the track line. Colour mapping is applied 
to the histograms displayed in the Worksheet window, as well as 
the port and starboard sections of ping in the Side Scan Editor 
window.
You can select different colour maps for port and starboard 
sections, or select a single colour map for both sections. All 
colour maps are stored with a .cma extension in the directory 
…\Hips\System.

Change from GreyScale To change the colour mapping from the default setting of 
GreyScale: 
1. Open the Control window and select the Colour tab from the Side Scan 

Editor tab.

2. Select either Port, Starboard or Both to apply new colour to.

3. Select a colour map from the drop-down menu (the default colour map 
is GreyScale.cma).

When the colour map is chosen, both the histogram and the ping 
window are refreshed, so that the port and starboard sections (or 
both) display the selected colour mapping.

In the Histogram, the horizontal axis represents the intensity 
range of the pixels in the sonar file and the vertical axis 
represents the distribution of pixels in the editor. 
Use the slider bar below the histogram in the Worksheet window 
to adjust colours. Each colour in the histogram has a slider 
control associated with it. 
1. Move the slider to adjust the pixel value of that colour in the histogram 

and in the ping.
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The value shown in the Control window adjusts as you move the 
sliders.
Colour display can be adjusted also using the other options:
• Blend will blend the colour borders
• Delete Colour will remove it from the list, and from the 

areas that it colours 
• Clear will remove all colours. To view ping clearly, restore 

GreyScale colour map.
Custom colour maps You can create custom colour maps using either the Colour tab 

or the sliders below the histogram in the Worksheet window.
1. Make sure both the Worksheet and Control windows are open.

2. Click Add Colour, or click on a slider to open the colour mapping 
controls.

 

The Value field shows the pixel value of the displayed colour.
The pixel values range from 1 to 255 with the first colour always 
assigned to pixel value 1. Pixel value 0 is always assumed to be 
transparent.
3. Enter a pixel value for the colour, as needed.

4. Click on the button to open a colour palette

5. Select a colour from the colour palette or click Create Custom Colour 
to create a custom colour from the standard Windows colour picker.

Values for current 
colour selection

Custom colour 
mapping 
controls

Colour tab

Colour map 
setting name
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6. Click OK.

The new colour and its assigned pixel value is added to the 
listing in the Control window, and applied to the histogram in 
the Worksheet window. The colour of the ping in the Side Scan 
Editor also changes to display the new colour in the appropriate 
areas.
7. Repeat Steps 2 to 6 to insert more colours, as needed.

As you select more colours, the colour values and the depths are 
displayed in the Control window. 

Reverse Sonar recorders have traditionally used dark colours to 
represent high signal returns. You may want to use the Reverse 
option to change the order in the colour map to reflect this 
practice. 
To reverse the colour map order, click Reverse.
8. Click Save As to retain the settings as a colour map.

The Save As dialog box is displayed.
9. Type a file name for the colour map.
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Toolbar

The Side Scan Editor toolbar is displayed in the interface when 
the editor is started.
The toolbar can docked or undocked, or removed from the 
interface like other toolbars. Below is an example of the toolbar 
in the undocked position.

The toolbar contains controls to navigate through the track line 
and perform other functions.  

Toolbar Buttons Purpose

Playback (see “NAVIGATE IN SIDE SCAN 
EDITOR” ON PAGE 431)

Zoom (see “ZOOM” ON PAGE 433)

Select (see “SELECTION” ON PAGE 434)

Measure distance and shadow (see 
“MEASURE DISTANCE” ON PAGE 436 and 
“MEASURE SHADOW” ON PAGE 437)

Digitize (see “DIGITIZING SONAR 
ALTITUDE” ON PAGE 407)

Contacts (see “CREATE CONTACTS” ON 
PAGE 442)

View waveform (see “SIGNAL DISPLAY 
WINDOW” ON PAGE 440)

Revert and reapply (see “REVERT/
REAPPLY” ON PAGE 412
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Navigate in Side Scan Editor

You can navigate up or down the track line by clicking along the 
scroll bar to the right of the Side Scan Editor window.
• Clicking the scroll arrow buttons moves the view in the editor 

forward or backward by a single ping.
• Clicking the scroll bar, or dragging the scroll box forward or 

backward increments your view by a set of pings.
Alternately, you can move up or down the track line by turning 
the mouse wheel (if available).
You can also navigate up or down the track line using the 
keyboard.
• Pressing <Page Up> or the space bar moves the editor 

forward by one “page” (the height (# of pings) visible in your 
Side Scan Editor window is the increment).

• Pressing <Page Down> or holding the <Ctrl> key while 
pressing the space bar moves the editor back by one “page”.

• Pressing <Home> takes you to the start of the track line, and 
pressing <End> takes you to the end of the track line.

Playback The Side Scan Editor can automatically scroll data from the 
start of the track line to the end by using the Playback option. 
The view in the Side Scan Editor will scroll at the speed set on 
the Side Scan tab of the Control window.
 
 

The ping coverage outline in the Display window moves with the 
display in the Editor.

1.Click Start to go to the start of the track line. 

 2.Click Play to start scrolling the data.

The Side Scan Editor moves up the track line, ping by 
ping, until it reaches the end of the surveyed data. 
3. Reset the Side Scan Editor view to the previous position by clicking 

Start.

Playback speed You can adjust the scrolling speed for automatic scrolling in the 
Playback Speed field. 
1. Make sure the Control window is open and Side Scan Editor tab is 

displayed.

Go to Start 
of trackline

Skip Reverse Skip Forward

Go to End 
of trackline

Play
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2. Select speed value from the Playback Speed field in the General tab by 
clicking the up or down arrow buttons.

You can also view the data by moving up or down the track line 
in larger increments: “pages” the height visible in your Side 
Scan Editor window.
1. Click either the Start or End button to move to start or end of the track 

line.

2. Click Skip Forward or Reverse.

View contacts while 
scrolling

If you want your contacts to remain visible in the waterfall 
display while scrolling or using the Playback functions
1. Select Side Scan Editor from the Tools > Options > Display tab. 

2. Select the Display contacts during playback check box, and click Apply. 
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Zoom

You can magnify an area in the Side Scan window with the Side 
Scan Editor Zoom tool.
1. Select the Side Scan Zoom tool.

2. Press and hold the mouse button and drag the cursor over the area you 
want to enlarge.

A new window displaying the enlarged area will open.
You can display the image so that the entire zoomed area fits the 
zoom window or you can scale the image according to a selected 
percentage.
3. Right-click the mouse in the zoom display window and choose any of 

the following options from the pop-up menu:

• Select the Fit to Window option so that the entire area of the 
zoomed image is displayed in the window.

• Select the Aspect Ratio to keep the same height and width ratio for 
the zoomed area. When this option is cleared, the image is resized 
so that it fills the entire zoom window.

• Select the Scale option to resize the zoomed area to a scale. The 
scale is selected from the drop-down list. When a scale is selected, 
the image is displayed according to the selected percentage. 

• Select Close to close the window.

4. You can use the Measure Distance and Measure Shadow tools in the 
Zoom window (see “MEASURE DISTANCE” ON PAGE 436 and “MEASURE 
SHADOW” ON PAGE 437). When you release the mouse button, the results 
are shown in the Contacts tab in the Control Window.

5. Deactivate the Zoom tool when finished.
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Selection

Data can be selected in the Side Scan Editor using the Side Scan 
selection tool. The selection tool can be used to select a range or a 
single ping within that range. Selected data can be viewed, 
edited, or corrected using a variety of tools.
To range-select data: 
1. Choose the Select Side Scan button on the Side Scan Editor toolbar.

The cursor will become a cross-hair when positioned in the Side 
Scan Editor window.
2. Press the mouse button and drag the cursor across the area of the 

Editor that you want to select.

When you release the mouse button, the selected range is shown 
bounded with a rectangular yellow box.

The range remains selected until you click in the Editor window 
again.
To select a single ping:
3. Select a range of side scan (see above).

4. While the range is selected, press the <Up Arrow> key, which produces 
a third horizontal line representing the selected ping.

5. Continue pressing the <Up Arrow> key to move the selection up, or 
press the <Down Arrow> key to move the selection down.
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Select by ping number You can also use the Selection fields on the General tab of the 
Side Scan Editor Control window to select a range in the Editor 
window. 
When you make a selection in the Editor window the start and 
end ping numbers of that selection are displayed in the General 
tab. To refine your selection, enter the specific ping numbers 
fields to specific start and end pings. 

 

Superselection Superselection is selecting data within an already selected 
range. You can superselect pings from the Worksheet window 
and display the superselected data in the Side Scan Editor. 
1. Select a range of side scan data.

2. Select the Query command.

A table listing the pings in the selection is displayed in the 
Query tab of the Worksheet window. 
 

3. To superselect a single ping, select the row in the Query tab. 

The superselected ping will be highlighted within the selection 
in the Side Scan Editor.
3. To superselect a range of pings, click in the first column on the first row 
of the range and drag the mouse through to the last row of the range you 
want to select.
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A rectangle is displayed containing the superselected range of 
pings within the selection.

Measure Distance
Measure distance This tool enables you to measure distance between two points 

with the mouse. This feature is used in processed mode, in either 
the Side Scan Editor window or in the Side Scan Zoom window. 
Distance units are determined by the settings in the Display tab 
of the Options dialog box (see “UNITS” ON PAGE 673).
1. Make sure the side scan display is in processed mode.

1. From the Side Scan Editor toolbar, select the Measure Distance tool.

2. Press and hold the mouse button, and drag the cursor across the Side 
Scan Editor. 

As you drag the cursor across the data, the distance is displayed 
at the cursor.
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Measure Shadow

This tool enables you to determine the height of an object by 
measuring its shadow. This feature is only available in processed 
mode, and can be measured in either the Side Scan Editor or in 
the Side Scan Zoom window.
1. Make sure the side scan display is in processed mode.

2. Select the Measure Shadow tool.

3. Press and hold the mouse button, and drag the cursor horizontally 
across the Side Scan Editor.

The height measurement is shown in the side scan window.
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Side Scan Editor and Swath Editor

The Swath Editor can also be open at the same time as the Side 
Scan Editor.

When the Side Scan is open in this mode, the playback functions 
used to scroll the track line, are unavailable. You can, however, 
move up and down the track line by scrolling the Plan View in 
the Swath Editor (see “EXAMINING SWATH DATA” ON PAGE 643).
All other Side Scan functions and tools are available.
When both the Side Scan and Swath Editors are open, a 
coverage outline of the multibeam data is displayed in the Side 
Scan Editor. This feature is useful when the across-track 
coverage of the multibeam is less than that of the side scan. 

Swath Time Offset If the multibeam data was recorded from a vessel and the side 
scan from a tow fish, then the coverage outline will not be in the 
correct along-track location. 
The Swath Time Offset adjusts the along-track locations of the 
swath outline in the Side Scan Editor by applying a time 
correction value. The time correction value can be either positive 
or negative. Negative values are used for track lines where the 
side scan sonar is positioned before the multibeam echo sounder.

Side Scan Editor Coverage outline for multibeam data
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To adjust the swath time offset:
1. Make sure the Side Scan Editor is open. (The Side Scan Editor tab in 

the Control window will be visible.)

2. Click the <Up> or <Down> arrows for the Swath Time Offset field on 
the Side Scan editor tab until the correct delay (in seconds) between 
the vessel and towfish is displayed.

Swath Time 
Offset f ield



442 CARIS HIPS and SIPS User’s Guide

Processing in SIPS—Side Scan Editor: Signal Display Window

Signal Display Window

The Side Scan Editor includes a Signal Display Window for 
viewing sonar intensity levels. This window provides a plot of 
signal intensity against across-track distance (or time, in raw 
mode). The pre-and post-processing state of any correction can 
be compared using the Revert and Reapply functions
The Signal Display Window can display a mean of all sonar 
intensities in a selection or the sonar intensity values for a 
single ping. The display can be switched back and forth between 
mean and single profile modes by use of the buttons on the 
toolbar.
The Signal Display Window can be used in both the raw and 
processed modes.
When the Signal Display Window is reopened, it will remember 
its previous setting and display either the mean intensity values 
for the entire selection or the intensity values of a single profile.

Open Signal Display Window
1. Select a range in the Side Scan window using the Side Scan Selection 

tool (see “SELECTION” ON PAGE 434).

2. Select the Signal Display Window tool.

The Side Scan Signal Display Window is displayed.

The vertical axis on the graph represents intensity level of the 
signal(s) being examined. The horizontal axis represents either 
time or slant-range distance depending on the display mode of 
the Side Scan Editor.
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View Selection Mean

The mean of the intensity values in the selected range can be 
displayed. 
3. Select the View Selection Mean tool.

View Single Ping

You can also view signal intensity for a single ping.
4. Select the View Single Ping tool.

The Signal Display Window is refreshed to show the sonar signal 
intensities for the single ping selected in the Side Scan window.

Pressing the Up Arrow key while an area of the side scan data is 
range selected will select a single ping
5. Use the Up and Down arrow key to view the sonar intensities for other 

single pings.

As you scroll through the selected range, the Signal Display 
Window will refresh to show the intensity values for each ping. 
The ping number is displayed in the top-right corner of the 
Signal Display Window in this mode. The location of the ping is 
also indicated by a new line within the selection. The single ping 
selection always defaults to the first ping in the selection. 
You can view the position and specific intensity values of points 
by clicking on any point in the graph in the Signal Display 
Window. The intensity and time/distance values for that point 
are shown in a tool tip.
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Tool tip
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Contacts

A Contact is the representation of an object or feature on the sea 
bottom (for example, a wreck, or a pipeline) that is visible in the 
sonar data. Contacts can be georeferenced, have positions 
calculated, and have attributes attached to them in the Side 
Scan Editor using the Add Point or Add Line Contacts tools.
In SIPS, you can pick individual contacts directly from the Side 
Scan Editor interface. A contact record is created for each 
contact, and includes sufficient information to be subsequently 
imported to a CARIS map or to a database application.
A contact file is created for each survey line and is stored in the 
line folder within the project directory structure. Each contact 
file is a text file that can be viewed and edited using a text 
editor. Each file consists of zero or more contact records.
For more information on contact file structure, see “CONTACT FILE 
FORMATS” ON PAGE 745.

Create Contacts

Point type contacts can be created for objects such as rocks, 
underwater posts or pile as well as wrecks. Contacts can also be 
created for continuous objects such as pipelines or underwater 
cables.
Contact information is entered on the General tab of the Control 
window and updated on the Contact Details tab. 
1. Make sure the Control window is open and the General tab in the Side 

Scan Section is displayed.

2. Enter information in the appropriate fields on the General tab.

• Contact Type: Select a point or line contact type from the 
appropriate drop-down list. Each contact type is assigned a CARIS 
feature code, and there is an identifying symbol for each type. The 
contact types shown in the lists and the corresponding CARIS 
feature codes are stored in …\Hips\system\ContactFeature.txt.

• User Initials: Type a maximum of three characters to identify the 
creator of the contact. The initials are used in the editor as part of a 
contact identifier.

• Prefix: The prefix is usually the line number. It is combined with the 
contact number to generate a 12-character key for database 
applications.

• Image Width: (optional) Enter a width for any image file created from 
the contact.

• Image Length: (optional) Enter a length for any image file created 
from the contact.
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• Display with single colour: Select this to have all contact markers 
and their identifiers appear in the same default colour. (The default 
colour can be set in Side Scan Editor Display Options on the Tools 
menu.) Leave blank to have a one colour apply to the contact 
markers and a different colour applied to the bounding box and 
contact labels. 

Point Contact

3. To insert a point contact, select the Add Point Contact tool and click 
where you want to place the contact.

A contact marker is placed in the Side Scan Editor at the point 
where you clicked. 
The type of contact is indicated by the symbol displayed. The 
contact is identified by the initials entered in the General tab, 
and a four-digit number (starting at 0001). The information 
entered in the General tab is assigned to the contact.

The image bounding box always snaps to the contact so that the 
contact point is in the middle of the box. The bounding box 
represents the image area of the contact. You can adjust the size 
of the image using the Image Width and Image Length fields on the 
Contract Details tab in the Control window. 
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Line Contact

To insert a contact record for a line:
1. Select the Add Line Contact tool and click the point where you want to 

insert the contact.

2. Click another section of the Side Scan Editor.

The two points are joined by a line.
3. Continue adding line segments as needed to represent the contact. 

4. Select Edit Line> Remove last to delete the line segment just created.

5. To escape the Line Contact tool, right-click the mouse and select Edit 
Line> End from the pop-up menu.

The contact lines are drawn in the Side Scan Editor. Each line is 
identified with a number, and each type of line is drawn in a 
different style. The information entered in the General tab is 
applied to the contact. The contact is identified with the initials 
entered in the General tab, along with a four-digit number 
(starting at 0001).

Repeat New Feature When the Repeat New Feature tool is activated, you can add any 
number of contacts of the same type and attributes, without 
having to set each one separately. 
To add multiple similar contacts:
1. Select the Repeat New Feature command. 

2. Enter contact information in the appropriate fields on the General tab in 
the Control window.

3. Use the Add Point Contact tool to place the contacts, one after the 
other, into the Side Scan Editor.

The Repeat New Feature tool button will remain depressed 
while you add contacts. To change to a different type of contact 
or to change contact data, deactivate the Repeat New Feature.
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Editing Contacts

You can reposition both line and point contacts and update the 
data associated with a contact.
The Select Contact tool is used to select point or line contact(s) 
for editing.

Select Contact

1. Choose the Select Contact tool.

2. To select a single contact, click on or draw a box around the contact so 
that it becomes highlighted. Clicking on any part of a line will select the 
entire contact.

3. To select a number of contacts, press the mouse button and drag the 
cursor across an area so that the contacts within it are highlighted.

Move Contact

1. To move a selected contact, select the Move Contact tool.

2. Position the cursor on top of the selected contact. Press and hold the 
mouse button. This will turn the highlighted contact into a red box with 
direction arrows.

3. Drag the contact to a new position.

4. Deactivate the Move Contact tool to finalize the new position of this 
contact. You are returned to the Select Contact tool.

You can use the Move Contact tool to move an entire line 
contact, or to adjust or realign part of the line. 
5. To move a selected line contact, position the cursor on any part of the 

line, press and hold the mouse button, and drag the whole line to a new 
position.

6. To realign part of a selected line, click on the line. This will highlight 
nodes which will appear as squares on the line. 

7. Click on the node to be adjusted, which will turn the node square red. 
Position the cursor on the node. Press and hold the mouse button, and 
drag it to a new position. This will pull the attached lines with it.

Changing Contact 
Information

You can change the information that is associated with the 
contact when it was first created, either by typing it in or with 
measurement tools.
1. Choose the Select Contact tool.

2. Select a single contact.

The contact is highlighted and the contact information is 
displayed in Contact Details tab in the Control window.
3. Type new information in the fields and/or select a new object type from 

the drop-down list.

4. Click Update.

Use the Measure Distance and Measure Shadow tools on the 
Side Scan Editor toolbar to amend the contact information.
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Use Measure tools 5. To update the contact width information, choose the Measure Distance 
tool and press and hold <Ctrl> while dragging the cursor across the 
area of the contact to be measured.

If measuring in the Side Scan Editor window, the value in the 
Contact Width field will reflect the measurement as you are 
make it. If measuring in the Zoom tool, the value will be updated 
when the mouse button is released.
6. To retain the updated information, release the mouse button and then 

the <Ctrl> key.

7. To update the Contact Length information, choose the Measure 
Distance tool and press <Alt> while dragging the cursor across the 
contact area.

8. To update the Contact Height field, select the Measure Shadow tool 
and press <Ctrl> while dragging the cursor across the contact area.

9. Click Update. If you do not click Update, the values will be lost when 
the contact is de-selected.

The contact information is updated.

Set contact status You can also use the Select Contact tool with the Query, Reject 
or Accept tools. A rejected contact can deleted from the track line 
using the Purge Rejected Contacts command.
10.Select either an Accept, Reject or Query tool (see “EDIT SIDE SCAN DATA” 

ON PAGE 405).

• If you select the Query tool, data relating to that contact is 
displayed in the Query tab of the Worksheet window.

• If you select Accept or Reject, the contact is assigned the 
appropriate status flag.

Purge rejected contacts 

To delete a rejected contact
1. Use the Select Contact tool to select the rejected contact.

2. Select a Purge Rejected Contacts command.

The rejected contact is deleted.
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Recompute Contact Positions

Update the geographic positions of contacts after towfish 
navigation has been recomputed for a track line or group of track 
lines (see “SLANT RANGE CORRECTION” ON PAGE 413).
1. Select the ship or towfish track lines layer in the Session tab of the 

Control window.

2. Select one or more track lines.

3. Select the Recompute Contact Position command.

Position information for contacts along the selected track lines 
are updated to match the new towfish navigation.
The start time, end time and elapsed time for the recompute 
process is reported in the Output window. Any error in the 
processing will be reported there also. 

View contacts while 
scrolling

If you want your contacts to remain visible in the waterfall 
display while scrolling along a track line or using the Playback 
functions
1. Select Side Scan Editor from the Tools > Options > Display tab. 

2. Select the Display contacts during playback check box, and click Apply. 

M
en

u Process > Recompute 
Contact Position
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SIPS Template Wizard

The SIPS Template Wizard (STW) combines imagery correction 
tools into a single flow, which can be saved as a template file and 
consistently applied to data. 
Use the Wizard dialog boxes to process one or more lines. The 
STW can also be run in Side Scan Editor to apply corrections to 
one track line at a time. 
The STW can also create GeoBaRs after the corrections have 
been applied. GeoBaRs can be used to create mosaics or analyze 
sediment properties.
The STW uses either a SIPS engine or a Geocoder engine to 
correct data. Depending on which engine is chosen, (and the type 
of data being processed) different correction parameters are 
presented. 
The settings entered into the wizard can be saved to a SIPS 
Template File (STF) that can be loaded and used again.
To open the SIPS Template Wizard:
1. Select one or more track lines.

2. Select the SIPS Template Wizard tool.

SIPS Template Wizard (Step 1)

The SIPS Template Wizard (Step 1) dialog box is opened so you 
can create a template or load an existing one. 
To create a new SIPS template file, 
1. Select a Processing engine, either Geocoder or SIPS. 

Depending on the engine chosen the dialog boxes which follow 
willl display different options.

2. Select the type of data. (Note that the SIPS engine will not process 
Time Series data.)

3. Click Next to open the next dialog box to set process options. 

Load Existing Template To load an existing SIPS Template file:
1. Click Load and choose an existing file. The file name is displayed in 

the Current File field. The Summary provides an overview of the 
settings. 

2. To remove the selected file, click Clear. 

3. To execute the loaded SIPS Template file, click Finish.

4. If you want to modify the loaded options, click Next .
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SIPS Template Wizard (Step 2)

The contents of the SIPS Template Wizard (Step 2) depends on 
the processing engine choice made at step 1. 

SIPS engine If you chose the SIPS engine, the options available for Slant 
Range Correction are displayed. 
.

1. Select Slant Range Correction to enable this correction process.

2. Type the Resolution (in metres or feet) for the slant range corrected file. 
The resolution value defaults to the minimum value appropriate to the 
sonar system. If this is not available then it defaults to 0.10 metres or 
0.33 feet. A finer resolution generates a larger file.

3. Type the average speed of sound.

4. Select the setting for Data Reduction from the drop-down list. 

• The default is to use the 16-bit factor that is stored with the line.

• Select Use 8-Bit Shift if you want to create a slant range file using 
only eight bits of storage per pixel. This option is important if the 
data that you are slant range correcting was originally 16-bit and all 
16 bits were maintained at conversion. 

• Select Use Shift Factor Per Line to use the shift factor that is stored 
with the line.

5. Select the Use Height Source check box if you want to apply a height 
source, such as a BASE surface and select the height source from the 
displayed list.
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For information on slant range correction, see “SLANT RANGE 
CORRECTION” ON PAGE 413.

Geocoder engine If you chose the Geocoder engine, the options to apply Auto Gain 
Correction and TVG Correction automatically are displayed. 
 

1. Select Auto Gain Correction or Auto TVG Correction to apply these 
corrections with default settings. 

2. Click Next .
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SIPS Template Wizard (Step 3)

The dialog box at Step 3 of the Wizard contains the options for 
corrections to data. Depending on whether you are working with 
the SIPS engine or the GeoCoder engine, different variables for 
those corrections are displayed. 

SIPS Engine Beam Pattern Correction removes along-track banding. For further 
information, see “BEAM PATTERN CORRECTION” ON PAGE 416. 
1. Select the Beam Pattern Correction check box to enable this option 

and browse to select an existing BPC file.

If no Beam Pattern Correction file exists you will need to create 
one in order to apply Beam Pattern Correction parameters. All the 
tools to create a beam pattern file are accessible on the Beam 
Pattern Toolbar, while the Side Scan Editor is open.

For information on creating a Beam Pattern Correction file, see 
“CREATE BEAM PATTERN CORRECTION FILE” ON PAGE 416.

The outer edges of some pings may have been recorded at angles 
beyond the extent of the beam pattern file being used. The Outer 
Edge option must be specified for handling these cases.
2. Select a method for handling sonar data collected outside the extents 

of the beam pattern file:

• Extrapolate: Extrapolate the beam pattern to correct angles beyond 
the outer edge of the generated beam pattern file.
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• Trim: Remove sonar data that is beyond the extent of the beam 
pattern file. Trimmed data will appear as 0 intensity white space in 
the Side Scan Editor.

• Do Nothing: Does not correct sonar data beyond the extent of the 
beam pattern file. Uncorrected data will appear the same before and 
after Beam Pattern Correction in the Side Scan Editor.

Angle-Varying Gain (AVG) removes the angular response of sediment 
from the imagery, normalizing the mean angular intensities, 
with a moving average filter applied ping by ping to selected 
areas of data. (See “ANGLE-VARYING GAIN” ON PAGE 419.)
3. Select the AVG Correction check box to enable the process. 

4. Select the number of adjacent pings to include in the moving average 
by clicking Moving Average Window Size up or down arrow buttons.

The Despeckle function removes “noise” in the processed side scan 
image. (Noise consists of randomly scattered pixels that are 
brighter or darker than their neighbouring pixels). (See 
“DESPECKLE” ON PAGE 421.) 
5. Select a Method from the drop-down list.

6. Select a Matrix Size from the list

7. Specify a Threshold Factor in the box.

8. Click Next .

Geocoder engine If you selected Geocoder as the engine the dialog box at Step 3 
displays these corrections with slightly different options:
 

Beam Pattern Correction removes along-track banding. For further 
information, see “BEAM PATTERN CORRECTION” ON PAGE 416.
1. Select the Beam Pattern Correction check box to enable this option 

and browse to select an existing BPC file.
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If no Beam Pattern Correction file exists you will need to create 
one in order to apply Beam Pattern Correction parameters. All the 
tools to create a beam pattern file are accessible on the Beam 
Pattern Toolbar, while the Side Scan Editor is open.

For information on creating a Beam Pattern Correction file, see 
“CREATE BEAM PATTERN CORRECTION FILE” ON PAGE 416.

Angle-Varying Gain (AVG) removes the angular response of sediment 
from the imagery, normalizing the mean angular intensities, 
with a moving average filter applied ping by ping to selected 
areas of data (See “ANGLE-VARYING GAIN” ON PAGE 419.)
2. Select the AVG Correction check box to enable the process, and 

choose a method from the drop-down list: Trend, Flat, or Adaptive 

3. Select the number of adjacent pings to include in the moving average 
by clicking AVG Window Size up or down arrow buttons.

The Despeckle function removes “noise” in the processed side scan 
image. (Noise consists of randomly scattered pixels that are 
brighter or darker than their neighbouring pixels). (See 
“DESPECKLE” ON PAGE 421.)
4. Select Despeckle and select the strength from the drop-down list. 

SIPS Template Wizard (Step 4)

The dialog box at step 4 when using the SIPS engine contains 
options for applying the time-varying gain correction. 
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SIPS engine Time-Varying Gain Correction adjusts signal intensities by 
applying a non-uniform, time-dependent gain.
1. Select the TVG Correction check box to make this option active.

2. Select the Standard or Advanced modes from the Mode drop-down list.

For further information, see “TIME-VARYING GAIN” ON PAGE 420.
3. Click Next.  .

Geocoder engine If you are setting options for the Geocoder engine, the Step 4 
dialog box displays options for the creation of GeoBaRs from the 
data. In this workflow GeoBaRs must be created, so the Create 
GeoBaR check box is automatically selected.
1. Type a name for the new GeoBaR.

2. Type a resolution or select Auto to have SIPS set the resolution for you.

3. [Optional] Select an alternate colour mapping scheme for your GeoBaR 
display from the drop -down list. The Preview field will show you the 
range of the colours in the colour map.

4. {Optional] Select Advanced 

5. Click Next to see a summary of your options for the Geocoder engine 
and to save the template file. 
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SIPS Template Wizard (Step 5)

If you are using the SIPS engine, the next dialog box lists the 
order in which the options will be processed on the track line(s), 
and allows for this order to be adjusted.

The Process Order list contains all options selected at the 
previous steps in the order that the operations will be processed 
on the track line.
1. If you want to change the processing order, select a correction and use 

the Up or Down arrow buttons to change its position in the list. The item 
at the top will be executed first. 

2. Slant Range Correction will be executed first, if it has been included. 
The order of this correction cannot be changed. 

3. Click Next .
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SIPS Template Wizard (Step 6)

If you are creating a template for processes for the SIPS engine, 
this step gives you the option of georeferencing the data by 
having the STW create GeoBaRs after completing the listed 
processes.

1. Select the Create GeoBar check box to activate this option.

1. Type a name for the new GeoBaR.

2. Type a resolution or select Auto to have SIPS set the resolution for you.

3. [Optional] Select an alternate colour mapping scheme for your GeoBaR 
display from the drop -down list. The Preview field will show you the 
range of the colours in the colour map.

4. Click Next to display 

SIPS Template Wizard (Step 7)

This step displays a summary of the options and associated 
values selected in the previous dialog boxes. These are the 
options which will be processed when the template file is 
applied.
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1. Review the summary and if needed, click Back to get a previous dialog 
box to make changes. 

2. If you wish to save this as a template, click Save to overwrite the 
currently loaded template file, or click Save As to create a new 
template file with these options.

3. If you do not wish to execute your template at this time, click Cancel to 
close the wizard. If you have saved your template, then your selection 
options will not be lost.

4. To execute the options selected in the Wizard, click Finish. 

Once processing has commenced, clicking the Cancel button will 
not terminate immediately. The STW processing will stop once the 
current correction is finished processing.
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 Processing Single Beam Data

The Single Beam Editor contains data cleaning tools for data converted to 
HIPS from single beam echosounding surveys. The Data can be cleaned 
both interactively and with filters, and the display of data can be scaled 
horizontally and vertically, and sounding depths can be adjusted.

In this chapter...
“SINGLE BEAM EDITOR INTERFACE” ON PAGE 464
“CHANGE SOUNDING DEPTHS” ON PAGE 468
“SINGLE BEAM FILTERING” ON PAGE 472
“BARCHECK FUNCTION” ON PAGE 475
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Single Beam Editor Interface 

To open the Single Beam Editor:
1. Select a survey line in the Display window.

2. Select the Single Beam Editor command.

The Single Beam Editor is opened in the HIPS interface.

The Single Beam Editor is located (by default) below the Display 
window. The editor can be undocked and moved to another 
location like other windows in HIPS.
The display and events options are controlled from the Single 
Beam Editor tab in the Control window.
The soundings are shown in the editor as dots connected by 
lines. The horizontal scale represents distance or time. 
Distances are are derived from the navigation data. The first 
sounding with an associated position is considered the start of 
the line. All subsequent distances are computed from this point 
using sounding positions interpolated from navigation data. 
When the horizontal scale is by time, the sounding timestamps 
are used.
You can move up or down the track line by clicking the scroll bar 
or turning the mouse wheel (if available).
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Toolbar The Single Beam toolbar is automatically 
displayed when the editor is opened. This toolbar 
is used for selecting primary or secondary data as 
Selected data (see “PRIMARY AND SECONDARY DATA” ON 
PAGE 347). The toolbar can moved and docked in the 
interface like other toolbars (see “MODIFY EXISTING TOOLBARS” ON 
PAGE 29)

Display Options
Change horizontal scale The range of data that is visible along the horizontal scale can 

controlled by distance or time. As you increase these values more 
data is displayed in the editor.
The purpose is to provide a scaling method that simulates the 
echo sounder paper speed controls so that the digital profiles can 
resemble the analogue records.
1. Make sure the Control window is open.

2. In the Single Beam Editor tab, select either the By Time or By Distance 
option.

3. Select a range of data by clicking the Horizontal Scale arrow buttons.

Adjust vertical scale The vertical scale displays the distance values. The Auto setting 
uses the maximum and minimum soundings in the current view 
to set the depth values for that view. As you move along the 
track line, the depth values change to accommodate the visible 
sounding data.
You can set a scale as a ratio of the vertical scale to the 
horizontal scale. As the ratio is increased, the vertical display of 
data becomes more exaggerated.
To set a vertical scale:
1. Clear the Auto check box.

2. Click the Vertical Scale arrow buttons to select an appropriate scale.

The display in the Single Beam Editor View is refreshed to 
accommodate the selected scale.
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Adjust horizontal labels The horizontal labels show the depth or time values at regular 
intervals along the survey line. The Auto selection spaces the 
labels far enough apart so you can see them clearly. You can 
determine the spacing you want for the labels.
1. Clear the Auto check box in the Horizontal Labels section.

2. Click the arrow buttons to select a new scale for the labels. If you select 
By Distance for the horizontal scale, then the labels are displayed as 
metres/feet. If you select By Time, the labels are displayed hours/
minutes/seconds/fractions of a second.

The display in the Single Beam Editor is refreshed to show the 
labels according to the selected settings.

Events Event marks are commonly generated by the logging system at 
periodic intervals. Each event mark contains a unique identifier 
and time stamp.
Display all event marks in a table.
1. Select the Event tab in the Control window.

2. Select the Show Event Marks check box.

The event marks are displayed in a table format.
View moving average 
data

You can see the moving average data in the Single Beam Editor 
by selecting any of the following check boxes in the Single Beam 
Editor tab in the Control window. For more information on 
applying Moving Average filtering to single beam data, see 
“SINGLE BEAM CLEANING” ON PAGE 258.
• Data graphs the raw sounding data. This box is checked by 

default.
• Moving Average graphs the computed moving average from the 

adjacent data points as described above.
• Difference graphs the difference between the original data 

values and the moving average for each data point.
• Thresholds displays horizontal lines in the graph indicating the 

difference values that are rejected during filtering. Threshold 
is a multiple of the standard deviation (sigma).
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Primary and Secondary Data

Dual frequency data can be imported through the Generic Data 
Parser, the Hypack converter and the Winfrog converter.
These frequencies (and the associated data) are designated as 
Primary or Secondary. By default, all Primary frequency data is 
designated as Selected. Selected data can be processed further in 
HIPS and other CARIS products.

Show/Hide data 1. Make sure the Single Beam Editor tab in the Control window is 
displayed.

2. Select or de-select the following check boxes to show or hide data. 
When the box is checked, the sounding data associated with that 
frequency is visible in the editor.

• Primary

• Secondary

• Selected

The Single Beam Editor is refreshed to show the selected 
frequencies.

Select Primary/
Secondary data 

Although Primary data is automatically designated as Selected, 
you can, if needed, flag the Secondary data as Selected data. The 
two frequencies cannot   be averaged.                                                             
1. Make sure that all frequency data is visible in the editor by selecting the 

Primary, Secondary, and Selected check boxes.

2. Press and hold the mouse button and drag the cursor to highlight both 
the Primary and Secondary data.

3. Select a Primary or Secondary command.

The highlighted Primary or Secondary data is now marked as 
Selected.
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Change Sounding Depths 

The Single Beam Editor lets you modify the digital depths 
created by the echo sounder's digitizer. Sometimes when fish or 
other obstructions in the water column trigger the digitizer, the 
sea bottom may still be visibly detectable on the analog sounding 
graph. This function lets you set the echo sounder’s depth values 
to the analog sounding depth values.

Change Depths
1. Select the Selected check box, if needed.

2. Press and hold the mouse button, and drag the cursor to highlight the 
Selected soundings.

3. Select the Change Depths command.

The Change Depths dialog box is displayed.

The Depth Offset value is always set at 0.0. To move the sounding 
to a deeper depth level, enter a positive value (for example, 5.5). 
To move the sounding to a shallower depth level, enter a 
negative value (for example, -5.5).
4. Click Preview to view the sounding at the new level.

5. Click Apply to set the sounding at the new depth and close the dialog 
box.

You can also change depth values directly in the editor. This 
option omits the preview function of the dialog box.
1. Press and hold the mouse button and drag the cursor to highlight the 

Selected data sounding.
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When the mouse is positioned over the selected data, the cursor 
becomes a two-headed arrow with a Z symbol beside it.
2. Press and hold the mouse button, and drag the cursor either up or 

down.

The highlighted soundings move with the cursor.
3. Release the mouse button when the soundings are at the new depth.

Add Depths

Add a new sounding by supplying time and depth. The position 
of the new sounding is interpolated from the existing navigation 
data (using the supplied time). A quality code can also be 
entered. If you enter a new depth, a new observed depths file 
and a new slant range (travel time) file is generated.
You can add depths by selecting an existing sounding and 
inserting a new depth or by creating a new time stamp without 
selecting an existing sounding.
1. Select the Add Depths command.

The Worksheet window is displayed, if it is not already open.
2. Select the Time field and type a new timestamp value.

3. Select the Depth field and type a new depth value.

4. Select a new quality flag, if needed.

5. Press <Enter> to add the new depth value to the file, or press <Esc> to 
undo the change.
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Single Beam Cleaning

Sounding data can rejected interactively or by applying the 
single beam filters (see “SINGLE BEAM FILTERING” ON PAGE 472). 
This section covers how to interactively reject, accept and query 
data in the Single Beam Editor. These processes are similar to 
the Swath Editor.

Reject Data

Each sounding carries several status flag switches that are 
turned on and off as needed. Each sounding begins with 
Accepted status. If rejected for any reason during processing it 
can be returned to Accepted status without loss of data.
A sounding rejected within the Single Beam Editor has the 
Rejected by Swath Editor flag turned on (the same status flag is 
used for both swath and single beam data).
To reject a sounding, 
1. Select the data to be rejected so it is highlighted.

2. Select the Reject command.

The Rejected by Swath Editor status flag is now on and the 
sounding may or may not be displayed depending if the rejected 
data is visible.
You can show or hide rejected data. When the rejected data is 
turned off, these soundings are no longer visible in the Single 
Beam Editor.
1. Select the Show Rejected command.

Accept Data

Change Rejected soundings back to Accepted status.
1. Select the rejected data so it is highlighted.

2. Select the Accept command.

The soundings are now flagged as Accepted.

Query Data

View data on selected soundings.
1. Select the data to be queried.

2. Select the Query command.
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The following data is displayed in the Worksheet window. The 
data is colour coded depending on whether it is Primary, 
Secondary or Selected frequency data. 
• Record
• Type (primary, secondary, or selected)
• Timestamp
• d-Time
• Approximate Position
• Distance
• d-Distance
• Depth
• d-Depth
• Status

Change sounding status Once data information is displayed, you can change the status of 
the sounding.
1. Select the sounding data in the Worksheet window.

2. Select Accept or Reject commands.

Change sounding 
position

You can also change a sounding’s position using the Worksheet 
window.
1. Select a sounding in the Worksheet window so it is highlighted.

2. Double-click the depth value.

3. Type a new depth value.

4. Click away from the highlighted area to de-select the sounding data. 

Auto-Cursor Mode

The auto cursor combines the select and Accept/Reject/Query 
functions into a single procedure.
1. Select the Auto Cursor command.

2. Select a Reject/Accept/Query command.

3. Press and hold the mouse button and drag the cursor over the data so 
it is highlighted.

4. Release the mouse button.

The data is marked as rejected/accepted or it is queried.
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Single Beam Filtering

Using the Single Beam Editor you can filter single beam data 
converted from single and dual frequency echo sounders. This 
tool inherits some of the functions of the Swath Editor such as 
vertical exaggeration and filtering functions. 
When dealing with bathymetric datasets, it is advantageous to 
reject outliers automatically. To do this, the Single Beam Editor 
has a set of filters.
The parameters for these filters are set through the Set Filters 
dialog box, and saved in a HIPS Filter File (.hff) that can be 
reopened for use in another track line.
1. Select a track line.

Select the Set Filters command.

The Set Filters — Single Beam tab of the Set Filters dialog box 
is displayed.

2. Make sure the Single Beam tab is displayed.

3. [Optional] Select an existing HIPS Filter File from the list or click 
Browse to select a file.

If you chose to load a filter file, all values in that file are shown 
in the fields. You can go to Step 7 or change any of the values.
4. Select either a Reject or Accept logic command to apply to the filtered 

data.
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5. Select the Include Filter check box to activate the filtering options.

6. Select from three filtering options:

• Moving Average (see “MOVING AVERAGE FILTER” ON PAGE 472)

• Depth (see “DEPTH” ON PAGE 473)

• Beam-to-beam slopes (see “BEAM-TO-BEAM SLOPES” ON PAGE 473)

You can define and apply more than one filter test. The filters 
are applied in sequence. Any data rejected by one filter is not 
considered in the next filter test.
7. Select the frequency to apply to the filters by making sure the 

appropriate box is checked.

8. Click Close, or click Clear to remove data from the fields.

Click Save As to save the settings to a filter file.

Moving Average Filter

The Moving Average Filter rejects (or accepts) data with 
difference values that fall outside of defined threshold limits. To 
view the Moving Average filtering options in the Single Beam 
Editor, see “DISPLAY OPTIONS” ON PAGE 465.
A moving average is calculated for each sounding (data point) by 
using the adjacent soundings. The amount of adjacent data is 
specified either as the number of points or as a time period.
1. Select the Moving Average check box to enable the associated fields.

Set the moving average 
using seconds 

This option uses a time range (in seconds) to calculate a mean 
average for each data point.
For example, if you select 10 seconds as the moving average, the 
filter calculates a mean average for any data point using itself 
and any data points in the five-second range either side of it.

Setting the moving 
average using points

This option uses a range of adjacent data points to calculate a 
mean average for each data point.
For example, if the moving average is set to five data points. A 
mean for any data point is calculated using itself and the two 
data points on either side of it (if available).
2. Select how you want the moving average to be calculated by selecting 

either Points or Seconds.

3. Use the arrow buttons to select the number of seconds or data points.

A difference value for each sounding is calculated for each 
sounding from the adjacent soundings.

Thresholds The thresholds indicate what difference values are rejected (or 
accepted) during filtering. 
The upper threshold is determined by the following formula:
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original mean value + (threshold value X the 
standard deviation)

The lower threshold is determined by the following formula:
original mean value – (threshold value X the 
standard deviation)

Select a threshold value by clicking the arrow buttons.

Depth
1. Enter the depth values for filtering soundings. There are two options:

• Minimum Depth: Reject (or accept) any soundings that are 
shallower than the depth specified (e.g., 10 m).

• Maximum Depth: Reject (or accept) any soundings that are deeper 
than the depth specified (e.g., 50 m).

Beam-to-Beam Slopes

For each sounding, calculate the slopes, in degrees, to the 
previous and next soundings. If both slopes exceed the defined 
value and are of opposite sign, then reject the sounding.
1. Enter the degree value for the slope.

2. Select the Include Rejected option to include previously rejected 
soundings when recalculating the slopes during multiple runs of the 
filter.

Apply Filters

The last step is applying the automatic depth filter to the data.
1. Select a Filter command to apply the criteria set by the Set Filters 

dialog box.

You have four options for applying the filters.
Filter 1 Screen. Apply the filters only to the soundings that are 
currently visible in the Single Beam Editor. 
To End of Line. Apply the filters to the track line currently 
open in the Single Beam Editor, from the first sounding 
currently visible in the editor to the end of the line. 
Selected Lines. Apply the filters to all of the currently selected 
track lines. This function does not require that the editor be 
open. 
All Lines. Apply the filters to all track lines currently open in 
the Display window. This function does not require that the 
editor be open.
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Barcheck Function

The barcheck function lets you generate a Sound Velocity Profile 
(SVP) file based on a list of measured depths against a list of 
actual depths. The file can then be used to perform sound 
velocity corrections.
1. Make sure the Selected data is visible.

2. In the Single Beam Editor, press and hold the mouse button and use 
the cursor to highlight the sounding(s).

3. Select an Add to Barcheck command.

The Add to Barcheck dialog box is displayed.
 

• The Measured Depth field displays the depth that was recorded 
by the sounder. 

• The Actual Depth field displays the depth that was recorded by 
the barcheck. 

If more than one sounding is selected, then a mean is calculated 
from the selected soundings.
4. Enter new depth values, if necessary.

5. Click Add.

6. Repeat Steps 2 to 5, as needed.

7. Click the Barcheck tab in the Control window.

The table shows the Measured Depth, the Actual Depth and the 
sound velocity.
8. If you want to delete a section, highlight it and click Remove.

9. Click Save.

The Save dialog box is displayed. The default location for the file 
is ..\Hips\Svp.
10.Type a name for the file and click Save.
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Overview

Light direction and ranging (Lidar) uses laser technology to 
measure bathymetry. In such surveys, laser wavelengths are 
transmitted to the water from a transceiver mounted on a plane 
or helicopter. Sounding data is returned to the transceiver in a 
continuous stream that forms a swath-like pattern.

Soundings are recorded in an bathymetry file. Each sounding 
has: 
• a latitude and longitude position
• a depth value
• a timestamp
• an across-track and along-track position
• a quality flag
• a status flag.
Waveform data is also included for each sounding. This data is 
stored in a waveform file (see “WAVEFORMS VIEW” ON PAGE 480).

Sounding Quality and Status Flags
Quality flags When a lidar sounding is converted into HIPS, it is given a 

quality flag that can be changed during processing. This table 
shows the quality statuses that can be attached to a sounding. 

Status flags Status flags are assigned to soundings during conversion, these 
status are determined from information provided by the specific 
acquisition format.

HIPS currently supports the Laser Airborne Depth Sounder (LADS) 
system and the Scanning Hydrographic Operational Airborne Lidar 
Survey (SHOALS) system.

Quality 
Flag

Description

0 The sounding has a detected depth only. The alternative depth is 
invalid. 

1 The sounding has both a detected and a valid alternative depth. A 
quality control/assurance decision has not yet been made. 

2 The sounding has a detected depth and a valid alternative depth, and 
the user has decided to keep the detected depth.

3 The sounding has both a detected and alternative value, but the 
alternative value has been swapped with the detected value.
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Lidar Data in HIPS

Lidar projects are organized in the same Project-Vessel-Day-
Line hierarchy as sonar projects. Each project contains the 
following files:
• HIPS Vessel File
• an Observed Depths file (along-track and across-track 

sounding positions before merge)
• a Processed Depths file (lat/long sounding positions after 

merge)
• a bathymetry file
• a waveform file
• gyro data
• navigation data
• tide data
The default location of all the above files is ..\Hips\HDCS_Data.
To open Lidar data, see “SELECTING DATA” ON PAGE 482.
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Swath Editor displaying SHOALS lidar data with the Waveform view and Lidar tab 
visible.

Toolbar

The Lidar toolbar controls the display and status options for 
soundings and associated waveform data in the Swath and 
Subset Editors. 

This is a floating toolbar that can moved or docked anywhere in 
the HIPS main window. The toolbar is not automatically 
displayed when the Swath Editor or Subset Editor is opened.
1. Select the Lidar Toolbar command.

Waveforms View

The Waveform view displays the waveform data for a super-
selected sounding (see “SELECTING DATA” ON PAGE 482 for more 
information on superselection). The display in the Waveform 
view is determined by whether the data is in SHOALS or LADS 
format.
1. Select data in any of the Swath Editor or Subset Editor views.

2. Select the View Waveforms command.

The first sounding in the selection is superselected when the 
Waveforms window is opened.

SHOALS There are four panels in the view. Each panel shows a graph of 
specific waveform data for the superselected sounding. The X 
axis represents time and Y axis represents amplitude.

LADS The LADS waveform window contains one panel that shows a 
graph of specific waveform data for the superselected sounding. 
One line represents the detected depth sounding and the other 
line represents the alternative depth sounding (if applicable).
To view the complete waveform for SHOALS data, the Y-axis 
scale may have to be increased. The default value is 255.
1. Click the Max Y-Axis Value up or down arrow buttons until the entire 

wave form is within view.
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Point display The points that describe the waveform graphs can be increased 
or decreased.
1. Select the Lidar tab in the Control window if it is not already displayed.

2. Click the Point Size up and down arrow buttons.

As the value changes, the displays in the four windows are 
redrawn to show the points at the selected size.
3. To draw a line through the points in the view, select the 

Connect Points check box.
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Selecting Data
Open data Lidar data can be viewed and cleaned in the Swath and Subset 

Editors. 
1. Open either the Swath Editor or the Subset Editor. 

2. Select the Lidar Toolbar command.

The Lidar toolbar is visible.
3. Select the View Waveform command.

The Waveforms window (see “WAVEFORMS VIEW” ON PAGE 480) is 
displayed and the Lidar tab is displayed in the Control window. 
No data is visible in the Waveforms window yet.
There are two levels of selection in Lidar mode: regular selection 
and superselection.
• Selection refers to all highlighted soundings in any of the 

Views. 
• A superselected sounding is a subset of the selected soundings 

and is highlighted in a different colour from the regular 
selection. When a group of soundings are selected, the first in 
the selection (i.e. the lowest beam and profile number) is 
automatically super-selected.

All selected soundings can be queried or rejected, but you can 
only view waveform data and sounding attributes for a 
superselected sounding. Make sure that the Waveforms window 
is displayed. When this window is closed, the superselection 
option is inactive.
4. Choose an Editor Selection mode (see “QUERY LINE DATA” ON 

PAGE 6-148). The Edit By Range option is selected by default.

5. Select data in any of the views.

The data is highlighted in the selection colour determined in the 
Options dialog box (see “LIDAR” ON PAGE 665). The superselected 
sounding is displayed in the Plan View (Swath Editor) and the 2-
D and 3-D Views (Subset Editor).
The waveform data for the superselected sounding is displayed 
in the Waveforms window.
The following attributes for superselected sounding are 
displayed in the Lidar tab in the Control window:
• HIPS Time Stamp: Year-Month-Day-Hour-Minute-Seconds-

Milliseconds.
• LIDAR Time Stamp: Half milliseconds since midnight (SHOALS 

only).
• Profile number: The along-track position of the sounding
• Beam number: The across-track position of the sounding.
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• Detected depth: If this depth is selected for the Observed Depth 
file (depths prior to merge), then an asterisk is displayed 
beside the field.

• Alternative depth: If this depth is selected for the Observed depth 
file (depths prior to merge), then an asterisk is displayed 
beside the field.

• Processed depth: The depth value for the sounding after the 
Merge process

• Confidence value: The confidence value for the sounding 
(SHOALS only).

• Tide: Tide data for the sounding. Data must be merged before 
this value can be displayed.

• Status: Current status flag for the sounding.
You can use the Lidar tab to superselect a neighbouring 
sounding.
6. To view another sounding in the current selection, click the Next or 

Previous button in the Lidar tab of the Control window. This moves you 
to the next or previous selected sounding by ping and beam number.

The graphs in the Waveforms dialog box is refreshed to show the 
new data and the new superselected sounding’s attributes are 
shown Lidar tab data fields.

Find sounding You can also super select soundings by locating it by the time 
stamp (SHOALS data only).
1. Type the Lidar time stamp in the Time Stamp field.

2. Click Find.

The sounding with that time stamp is highlighted as super 
selected and the sounding data is displayed in the Lidar tab 
fields.

Superselect data in the 
Worksheet window

Queried data can also be superselected.
1. Select data in any of the views.

2. Select the Query command.

The selected data is displayed in the Query tab of the Worksheet 
window.
3. To superselect a sounding, click a row so it is highlighted.

The beam is highlighted as superselected in the Plan View.
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Selecting Detected and Alternative Data

In some instances, two depth values (detected and alternative) 
are returned. You can decide which depth value is most relevant 
and change the sounding's quality flag accordingly (see “SOUNDING 
QUALITY AND STATUS FLAGS” ON PAGE 478).

Highlight alternative 
soundings

This command highlights soundings that contain valid 
alternative depths. It does not select or superselect soundings.
1. Select the Highlight Alternative Depths command. This command 

highlights only data in the Plan View.

Soundings with a Quality flag of 1, 2, or 3 are highlighted in 
colour that is selected in the Options dialog box (see “LIDAR” ON PAGE 
665).
You can select from three options.

View all alternative 
depths

This command refreshes the display so that the alternative 
depths for soundings with a Quality 1 flag are shown. This is a 
useful tool for viewing the position of alternative depths in 
relation to neighbouring soundings.
1. Select the View Alternative Depths command.

The data in the Views refresh to display the alternative 
soundings.

Depth values can be selected and changed in both the 
Swath Editor and the Subset Editor. 
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Swap to alternative This command applies an alternative depth in a superselected 
sounding to the detected depth. With SHOALS data, the depth is 
swapped, and with LADS data, the depth and position are 
swapped.
1. Select soundings and super select a sounding with a Quality 1 flag.

2. Select the Swap to Alternative command.

An asterisk beside the depth value indicates whether the 
detected or alternative depth is currently in the HIPS depth file.

Keep detected This command is used to verify that the detected depth is 
preferred over the alternative depth. The Quality flag is changed 
to 3. (see “SOUNDING QUALITY AND STATUS FLAGS” ON PAGE 478).
1. Select soundings and super select a sounding with a Quality 3 flag.

2. Select the Keep Detected command.
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Cleaning Sounding Data

Reject Data

Soundings can be assigned an Rejected by Disabling Sounding 
flag. These soundings are not included in the merge or any post-
processing operations. Data can rejected in the Swath and 
Subset Editors.
1. Select a sounding or group of soundings.

2. Select the Reject by Disabling Sounding command.

The soundings are now flagged as rejected.

Accept data

You can return soundings to the accepted status.
1. Select the Show Rejected command so the disabled soundings are 

visible.

2. Select the soundings.

3. Select the Accept command.
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Batch Processing

Batch processing automates what could otherwise be labour-intensive or 
time-consuming processing by combining a number of tasks into a single 
batch file that can reopened and used on multiple track lines.

The batch processing function is available in all licensing levels of HIPS 
and SIPS, but the processing options available are determined by the 
processing functions contained with the license.

In this chapter...
“RUNNING THE BATCH PROCESSOR” ON PAGE 488
“OPEN AN EXISTING HBP FILE” ON PAGE 489
“CREATE A NEW HBP FILE” ON PAGE 489
“SET UP A PROCESS” ON PAGE 490
“PROCESS DATA” ON PAGE 491
“BATCH PROCESSOR TASKS” ON PAGE 492
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Running the Batch Processor

The workflow for using the HIPS Batch Processor is simple: 
select the tasks you want to apply as a batch process, save the 
file then process the data with the Run command. 

Open Batch Processor
Batch Processor is a separate application that is opened from the HIPS 
and SIPS interface.

1. Select the Batch Processor command. You do not have to have a 
project or session file open in HIPS and SIPS.

The Batch Processor is opened.
The following image shows the Batch Processor with a complete 
list of tasks.
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When the processor is first opened, it is ready to create a new 
HBP file. 
The Batch Processor contains three windows. 
• The window on the left is the process list, containing the 

tasks that have been activated to be run in the batch 
processor. See “SET UP A PROCESS” ON PAGE 490

• The window on the right displays the options associated with 
each selected task. See“BATCH PROCESSOR TASKS” ON PAGE 492 

The window on the bottom displays the results of the processing 
operation.
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Batch Processing files

All data entered into the batch processor is saved in a HIPS 
Batch Processing File (HBP) file. HBP files are in XML format 
and can be viewed in any text editor or XML-compliant browser. 
Batch processing files are saved in ..\Hips\Session and can only 
be used in the Batch Processor.

Create a New HBP File

When the Batch Processor is first opened, it is ready to create a 
new HPB file. If a HPB file is already open and you select the 
New File command, any previously open file is closed, and the 
Processor is reset for the new file.
1. Select the New File command.

A new file is ready to be modified in the Batch Processor.

Save/Save As
1. In the Batch Processor interface, select a Save command to save a 

HBP file for the first time or save an existing file under a new name.

All files are saved to …\Hips\Session.

Open an existing HBP File
. 1. In the Batch Processor interface, select the Open File command.

The Open dialog box is displayed.
2. Select a file and click Open.

The file is displayed in the Batch Processor.
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Set up a Process 

A process is a specific order of activated tasks that are run 
through the Batch Processor. Each process is saved to the 
current HBP file. To add a task to your process list
1. Select the Add Process command.

The Select Task dialog box is displayed. 

2. Select tasks for the process in three ways:

• Select an individual task so it is highlighted.

• Select a group of tasks by holding the <Ctrl> key and clicking each 
of the required tasks. The selected tasks are highlighted.

• Select a range of tasks by holding the <Shift> key and clicking the 
first and last tasks in the range. All tasks in between are highlighted.

3. Click Add to move the selected tasks from the Available Tasks list to 
the Activated Tasks list, or double-click to move the task(s) to the 
Activated Tasks list.
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The list of tasks in Activated Tasks must be in the same 
order as the workflow in HIPS&SIPS, e.g., Sound 
Velocity Correction must be listed before the Merge 
task, and Compute TPU after Merge, and so on.
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4. Change the order that tasks are listed in the process using two 
methods:

• Highlight a task, and click the arrow buttons to move the task to a 
new position on the list.

• Highlight the task and press and hold the mouse button to drag it to 
another location on the list.

5. To remove one or more tasks, select a task in Activated Tasks list using 
any of the three methods in Step 2 and click Remove, or double-click 
the list to move the task(s) to the Available Tasks list.

6. Click OK.

The selected tasks are shown in the Process List in the Batch 
Processor interface.
7. To give a process a different name, select the Rename Process the 

command.

8. The process name is now ready to edited in the Process List window. 
Type a new name for the process.

9. To remove a task from the Process List, highlight the task and select the 
Remove Process command.

10.To move a task to a new position in the Process List, highlight the task 
and press and hold the mouse button to drag it to another location on 
the list.

11.Select a task to view the options associated with it.

The options associated with the task are displayed in the right 
side of the interface. You will notice that many of the options 
resemble the dialog boxes used in the main HIPS interface.
12.Fill in as many task options as necessary (see “BATCH PROCESSOR TASKS” 

ON PAGE 492).

Process Data
1. Select the Run command.

When the Run command is selected, you are prompted to save 
the batch processor file if you have not done so already.
2. Save the Batch Process file.

The results of the Run process are displayed in the Output tab of 
the Worksheet window.
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Batch Processor Tasks

When a task in the Process List is highlighted, the options 
associated with it are displayed in the right side of the Batch 
Processor window. 
To find more information on any of the following tasks, click a 
link in the Reference column.  

Batch Processor 
Task

HIPS and SIPS Command
Toolbar 
Button

Reference

Add to BASE Surface Process > BASE Surface > 
Add to…

“ADD TO BASE SURFACE” ON PAGE 242

Apply Filters to Lines Tools > Apply Filters “TPU FILTERING” ON PAGE 203

“SWATH FILTERING” ON PAGE 322

“SINGLE BEAM FILTERING” ON PAGE 472

“ATTITUDE FILTER” ON PAGE 284 
“FILTER CRITICAL SOUNDINGS” ON 
PAGE 298

Combine BASE 
Surfaces

Process > BASE Surface 
Combine

— “COMBINE” ON PAGE 248

Compute GPS Tide Process > Compute GPS Tide — “GPS TIDE” ON PAGE 741

Compute TPU Process > Compute TPU “COMPUTE TPU” ON PAGE 202

Conversion Wizard File > Import > Conversion 
Wizard

“CONVERTING FILES TO HIPS/SIPS 
FORMAT” ON PAGE 132

Finalize Surface Process > BASE Surface > 
Finalize

— “FINALIZE BASE SURFACE” ON PAGE 247

Load Delta Draft Process > Load Delta Draft — “DELTA DRAFT” ON PAGE 191

Load Tide Process > Load Tide “LOAD TIDE” ON PAGE 176

Load TrueHeave Process > Load TrueHeave “TRUEHEAVE DATA” ON PAGE 287
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Batch Processor 
Task

HIPS and SIPS Command
Toolbar 
Button

Reference

Merge Process > Merge “MERGE” ON PAGE 185

Recompute BASE 
Surface

Process > BASE Surface > 
Recompute

“RECOMPUTE SURFACE” ON PAGE 244

Recompute Contact 
Position

Process > Recompute 
Contact Position

— “RECOMPUTE CONTACT POSITIONS” ON 
PAGE 450

Recompute Towfish 
Navigation

Process > Recompute 
Towfish Navigation

— “RECOMPUTE TOWFISH NAVIGATION” ON 
PAGE 406

SIPS Template Wizard Process >SIPS Template 
Wizard

“SIPS TEMPLATE WIZARD” ON 
PAGE 451

Sound Velocity 
Correction

Process > Sound Velocity 
Correction

“SOUND VELOCITY PROCESSING” ON 
PAGE 170

Surface Cleaning Tools > Surface Cleaning “STATISTICAL SURFACE CLEANING” ON 
PAGE 307
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Use Plot Composer 5.1 or other publishing utilities to print HIPS and SIPS 
products to PDF or paper. 

In this chapter...



496 CARIS HIPS and SIPS User’s Guide

Create Publications: Publication Utilities

Publication Utilities 

HIPS and SIPS data can be formatted for printing to paper or 
Portable Document Format (PDF) with: 
• CARIS Plot Composer is an easy-to-use, comprehensive 

plotting tool kit that can efficiently produce paper products to 
illustrate raster and vector geospatial information. Plot 
Composer can use the data from other CARIS products such 
as Bathy DataBASE, in formats such as GeoTIFF, BSB, 
JPEG 2000, S-57, Shapefiles, AutoCAD, as well as HIPS and 
SIPS data to produce paper products. 

• the Publish command, which is supported by the CARIS 
Publication Designer and Template Editor.
• Publication Designer is used for building or modifying 

templates. Dictionary files can be opened in the 
Publication Designer and tags from those files inserted 
into the template. Other elements such as images or text 
can also be added. 

• Template Editor is used for creating or modifying borders, 
projected grids, and scale bars that can be opened with the 
template. 

Each of these publishing utilities can be opened from Start > 
Programs > CARIS > Utilities. All of these utilities include 
reference guides and help files to assist you with these 
applications.
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Plot Composer

Plot Composer is a comprehensive and intuitive plotting toolkit 
provided as a utility with various CARIS products. It provides 
the ability to efficiently produce paper products that illustrate 
raster and vector geospatial information.
Some of Plot Composer’s key functions are:
• Capturing application data views in GeoTIFF format through 

close integration with parent CARIS applications such as 
HIPS and SIPS 

• Configuring data and adding raster and vector data formats 
supported by CARIS applications in Viewports

• Adding geographic or grid/projection borders to data
• Configuring data views to be north-up or rotated
• Arranging plot object draw order, alignment or dimensions 

with the click of a button
• Adjusting the data display with dynamic pan, zoom, layer and 

property controls
• Adding plot markups, such as labels, lines and shapes
• Saving custom plot templates to reuse whenever necessary
• Printing the plot with any configured printer/plotter
This is an ideal utility for individuals and organizations that 
compile and manage geospatial information.
Plot Composer is shipped with HIPS and SIPS and a full 
description of its function can be found in the Plot Composer 
User Guide or help files. 
To open Plot Composer:
1. Select Plot Composer from the Start > All Programs > CARIS > Utilities 

menu. 
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Publish command
1. Open field sheet data in HIPS and SIPS.

2. Select Publish from the View menu.

The Publish command opens template files (RPX files) created in 
the CARIS Publication Designer. Adjust your output, then view 
your finished publication in the Publication Viewer, and copy, 
print or export it.
HIPS and SIPS data is displayed in the Publication Viewer.
 

Publication Designer

Use the Publication Designer to build or modify templates. Open 
dictionary files in the Publication Designer and insert tags from 
those files into the template. Other elements such as images or 
text can also be added for visual effect.
To open the Publication Designer
1. Select Publication Designer from the Start > Programs > CARIS > 

Utilities menu.

The Publication Designer interface is displayed.
 

M
en

u

View > Publish

To
ol



CARIS HIPS and SIPS User’s Guide 499

Create Publications: Publish command

For more information, see the CARIS Publication Designer 
Users Guide that can be opened from Start > All Programs > 
CARIS > Utilities > Documentation, or the help that is available 
in the application.

Template Editor 

The Template Editor defines borders, scale bars, and projected 
grids that can be saved and applied when creating templates for 
publication. 
Template Editor files can be saved using any name with the 
following file extensions.

Template Component File Extension

Borders .bsd

Scale Bar .ssd

Projected Grid .grd
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Default templates are stored in the ..\System directory where 
HIPS is installed. Your customized template files can be stored 
in any directory you choose
1. Select the Template Editor command.

The Template Editor is displayed.

For more information, see the CARIS Template Editor Reference 
Guide that can be opened from Start > All Programs > CARIS > 
Utilities > Documentation, or the help that is available in that 
application.
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Sounding and contour layers can be exported to S-57 format. As well, 
data products can be exported in various formats with the Export Wizard. 

In this chapter...
“EXPORT TO S-57” ON PAGE 502
“FORMATS EXPORTED” ON PAGE 503
“EXPORT WIZARD” ON PAGE 505
“BAG TO ASCII” ON PAGE 508
“BASE SURFACE TO ASCII” ON PAGE 509
“BASE SURFACE TO BAG” ON PAGE 511
“BASE SURFACE TO IMAGE” ON PAGE 513
“CONTACTS” ON PAGE 514
“GSF TO CARIS MAP/HOB” ON PAGE 517
“HIPS TIDE TO ASCII” ON PAGE 521
“HIPS TO ASCII” ON PAGE 522
“HIPS TO CARIS MAP” ON PAGE 525
“HIPS TO FAU” ON PAGE 529
“HIPS TO GSF” ON PAGE 530
“HIPS TO HOB” ON PAGE 531
“HIPS TO HTF” ON PAGE 533
“SIPS TO UNISIPS” ON PAGE 536
“MOSAIC TO IMAGE” ON PAGE 537
“PROJECTION” ON PAGE 539
“EXPORT” ON PAGE 540
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Export to S-57

You can export contour and sounding features to an S-57 file.
To export to S-57:
1. Open a project and field sheet containing a contour layer and or a 

contour layer.

2. Select the field sheet layer in the Layers tab.

3. Select Export to S-57 from the File menu.

The Export to S-57 dialog box opens.
 

4. Select a data layer to export. 

5. Type the full path or click Browse… to enter the full path to the data. 

6. Choose a Navigational Purpose layer from the drop-down list.

7. Type a data set name for the file. 

8. Click OK. 
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Formats Exported

The HIPS Export Wizard is a separate application launched 
from the HIPS and SIPS interface. The Export Wizard converts 
HIPS data products (soundings, BASE Surfaces, mosaics, etc.) to 
the following formats:
• ASCII text file
• CARIS map
• Bathymetric Attributed Grid (BAG)
• (FAU)
• Generic Sensor Format (GSF) files
• Hydrographic Object Binary (HOB) file
• Hydrographic Transfer Format (HTF) files
• TIFF image
• Unified Sonar Imaging Processing System (UNISIPS) format
See the table below to view export options.

Export Formats

Format Description Refer to...

BAG to ASCII Export data in Bathymetric Attributed Grid format 
to ASCII format 

“BAG TO ASCII” ON PAGE 508

BASE Surface to 
ASCII

Export BASE Surface position and attribute data 
to a text file.

“BASE SURFACE TO ASCII” ON 
PAGE 509

BASE Surface to 
BAG

Export BASE Surface elevation and uncertainty 
values to Bathymetric Attributed Grid (BAG) file

“BASE SURFACE TO BAG” ON 
PAGE 511

BASE Surface to 
Image

Export BASE Surface attribute data as a 
georeferenced image for further processing in a 
CARIS product or other application.

“BASE SURFACE TO IMAGE” ON 
PAGE 513

Contacts Export contacts to a CARIS map, an ASCII file, 
and/or a TIFF image.

“CONTACTS” ON PAGE 514

GSF to CARIS Export soundings and tracklines from one or 
more Generic Sensor Format (GSF) files to a 
CARIS map. The GSF data does not have to be 
converted to HIPS format prior to using this utility.

“GSF TO CARIS MAP/HOB” ON 
PAGE 517

GSF to HOB Export GSF data to a Hydrographic Object Binary 
(HOB) file that stores feature objects and 
associated attribute data. The HOB file can 
contain links to CARIS spatial objects. 

“GSF TO CARIS MAP/HOB” ON 
PAGE 517

HIPS Tide to ASCII Export tide data from track lines to text format. “HIPS TIDE TO ASCII” ON PAGE 521

HIPS to ASCII  Export HIPS data to a customized text listing of 
soundings that you can load into other software 
systems.

“HIPS TO ASCII” ON PAGE 522
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HIPS to CARIS  Export HIPS data to a CARIS map. This option 
contains three modes of exporting data: 
soundings, tracklines and swaths.

“HIPS TO CARIS MAP” ON 
PAGE 525

HIPS to FAU

HIPS to GSF Export processed HIPS data to GSF format. A 
new GSF file is created for each trackline that is 
exported from HIPS. Conversely, when HIPS 
data is created from GSF data, a copy of the 
original GSF file is maintained inside the HIPS 
directory structure. The Export to GSF function 
updates these GSF files.

“HIPS TO GSF” ON PAGE 530

HIPS to HOB Export HIPS data to HOB files that store feature 
objects and associated attribute data. The HOB 
file can contain links to CARIS spatial objects. 
This option contains three modes of exporting 
data: soundings, tracklines and swaths.

“HIPS TO HOB” ON PAGE 531

HIPS to HTF Export data to a Hydrographic Transfer Format 
(HTF) file. The HTF is a text file that contains a 
header section and a sounding record. The 
Export wizard can save a header section so it can 
be loaded into multiple HTF files.

“HIPS TO HTF” ON PAGE 533

SIPS to UNISIPS Export SIPS data to a Unified Sonar Imaging 
Processing System (UNISIPS) format.

“SIPS TO UNISIPS” ON PAGE 536

Mosaic to Image Export a mosaic as a TIFF image for further 
processing in a CARIS product or other 
application.

“MOSAIC TO IMAGE” ON PAGE 537

Format Description Refer to...
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Export Wizard

The first step to exporting data with the Export Wizard is to 
select the file format to be exported. The number of dialog boxes 
displayed in the subsequent steps depends on the export format 
selected in the Step 1 dialog box. 
To use the HIPS Export Wizard: 
1. Select the Export command.

The Export Wizard is displayed.

Step 1: Select Format 

The Select Format dialog box displays the available formats for 
exporting data.
 

1. Select an export format.

2. Click Next to select data to export.
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Step 2: Select Files 

The second dialog box lets you select the data for export.

Depending on the product you are exporting and the format you 
are exporting to, the data displayed here will vary, for example, 
to export BASE surface to BAG, you will select a layer; to export 
HIPS data to FAU, select track lines. 
For certain data you can Browse to the location of the specific 
product to be exported. Other product types will list the data 
available in the default directories. 

BASE surface/Mosaic 
data

If BASE Surface or Mosaic data is selected to export, the dialog box 
displays all project files with associated field sheets and layers.
1. Use the Browse button to select a field sheet directory. 

2. Expand the project file tree and select the layer you want to export. 

3. If you are exporting a mosaic to an image, you can select more than 
one mosaic for export by holding the <Ctrl> button while selecting 
mosaics.

Contacts/HIPS 
soundings/SIPS

For these file formats the Step 2 dialog box displays the existing 
projects, organized in a Project/Vessel/Day/Line structure.
1. Select some or all of the files in the Project/Vessel/Day/Line directory. 

Click the expand icon (+) icon to view the file tree, if needed.

HIPS to HTF When exporting HIPS to HTF this dialog box displays either a 
list of projects and associated field sheets, or the Project/Vessel/
Day/Line data structure depending on which export option you 
select.
1. Select the Field Sheet Product option and select a field sheet product 

layer, 

or
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2. Select the BASE surface option and select one or more BASE 
surfaces, 

or 

3. Select the Raw Data option to export sounding data. 

The file list will be refreshed to display the data available for 
export.
4. Open a project or session file tree and select a layer or trackline data.

If you select the Raw Data option, the Include Rejected option is 
active. This option includes rejected soundings in the export 
process.
5. [Optional] Select the Include Rejected option to export rejected data.

GSF The dialog box displays a section for the file path and name of 
the GSF file.
1. Click Select to choose the GSF files to be imported to CARIS/HOB 

format.

The file path and name is displayed in the dialog box.
2. To remove a file, select it so it is highlighted and click Remove.
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BAG to ASCII

Export data from a Bathymetric Attributed Grid (BAG) file to 
am ASCII file and optionally to an ISO 19115 Metadata XML 
file.

BAG to ASCII - Step 2
 

1. Type a path and name for the BAG file, or click Browse... to select a 
folder and file name.

2. Type a path and name for the output file, or click Browse to select a 
folder and then type the file name.

3. Select Positioning Units (Ground, Geographic DMS, Geographic DMS 
(no formatting), Geographic DD/ Geographic DM) from the drop-down 
list.

4. Specify the number of decimal places to display the position values. 

5. Select Headers to generate a header line at the top of the output ASCII 
file.

6. Select Generate ISO 19115 Meta Data XML file to generate an XML file 
with the same name as the output file.

7. Select what type of Delimiter you want to use to separate the fields in 
your output file. If you choose Other, type the character you want to use.

8. Click Next. 
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BAG to ASCII - Step 4
 

1. In the Vertical Length field, select the units for depth and uncertainty 
values.

2. The Horizontal Length field is only active if you selected Ground in the 
Position Units field at Step 2. Select the units for position data.

3. Click Next. 
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BASE Surface To ASCII

Export BASE Surface attributes to an ASCII text file.

BASE Surface to ASCII (Step 3)

1. Type a path and name for the output file, or click Browse to select a 
folder and then type the file name.

2. Select the position units for data from the drop-down list:

• ground units (east, north, depth)

• geographic DMS (latitude, longitude, depth)

• geographic DMS (no formatting)

• Geographic DD (decimal degrees)

3. Select how many digits are displayed to the right of the decimal point 
by selecting a number using the Precision up or down arrow buttons.

4. Select the BASE Surface attribute values to be recorded in the ASCII 
file by selecting the attribute in the Available column and clicking Add 
to move it to the Active column.

5. To remove an attribute, select the attribute from the Active column and 
click Remove to move it back to the Available column.

6. Choose a Attribute Precision value (number of digits to the right of 
decimal point) for attributes in the Active column by selecting an 
attribute and clicking the up or down arrow buttons.

7. Select the Headers check box to create print attribute names at the top 
of the attribute rows.
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8. Select either the Space, Comma, or Tab check boxes to use these 
characters as delimiters, or select the Other check box and type a 
character to use a delimiter.

9. Click Next.

BASE Surface To ASCII (Step 4)

This dialog box sets the unit type for recording data. The fields 
that are active in this dialog are determined by the attributes 
selected in the previous dialog box.

1. Select the units for recording BASE Surface data:

• metres and kilometres

• fathoms (US and international)

• feet (US and international)

• yards (US and international)

• miles (US, international, and nautical)

2. Click Next.

If you export attribute data from a BASE Surface created 
prior to HIPS and SIPS 6.1, this Step 4 dialog box is not 
displayed because the default measurement unit is metres.
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BASE Surface to BAG

Export a BASE Surface to a Bathymetric Attributed Grid file.

BASE Surface to BAG (Step 3)

1. Type the path and name for the BAG file, or click Browse and select a 
directory and name.

2. Select the BASE Surface attribute values to export from the drop-down 
list.

Metadata is general information about the file (the who, what, 
where, why, and how).
3. Type any information in the Abstract field.

4. Select a Status from the drop-down menu.

5. Click Next.
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BASE Surface to BAG (Step 4)

This dialog box is a continuation of the metadata section.

1. Type personal information in the Name, Position, and Organization 
fields and select a Role from the drop-down menu.

2. Select a Legal constraint from the drop-down list. If the 
otherRestrictions option is selected, you can type it into the Other field.

3. Select a Security constraint from the drop-down list. Type other 
information in the Notes field.

4. Type a Vertical Datum. Remember that the values above the vertical 
datum are positive.

5. Click Next.
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BASE Surface To Image

Select the following links to export a BASE Surface to an image 
file. BASE Surface to Image (Step 3)

1. Select a BASE Surface attribute to display as a georeferenced image.

If the selected attribute has a legend associated with it, you can 
include this legend in the image. The legend will be drawn 
according to the property settings. If the cover of the field sheet 
matches the cover of the BASE Surface, the field sheet cover can 
be expanded to accommodate the legend so it does not cover the 
surface.
2. Select the Display Raster Legend check box to draw a raster legend for 

the selected attribute.

3. Select the Expand cover to fit the raster legend check box to expand 
the area cover so that the legend does not overlay the surface.

4. Click Browse to select the file path and name of the image file.

5. Select a colour format for the image.

• 24 Bit (16 million colours)

• 8 Bit (256 colours)

The Surface can be saved as a TIFF file with either an IGA or a 
TFW georeferenced file, or both. You can save the image as a 
GeoTIFF image that records the georeferenced information 
directly in the .TIFF file. 
6. Select a geo-reference format for the image:

• GeoTIFF
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• IGA/TIFF

• TFW/TIFF

7. Click Next.
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Contacts

Export contacts to a CARIS map and/or an ASCII text file. You 
can also export contact snapshot images to TIFF files. The 
ASCII files are structured to be easily imported into a relational 
database.
If you select ASCII, you will have to browse to a folder location 
and type a file name. This name is used as the first component 
name of four files that will be created to store the contact 
information:
• filename_ContactLine.txt contains information identifying 

the survey line and indexes to the other files.
• filename_ContactSingle.txt contains all the information 

for single point contacts.
• filename_ContactMulti.txt contains all information for 

single point contacts.
• filename_ContactMultiPoints.txt contains all location 

information for multipoint contacts.
For more information on the structure of contact files, see 
“CONTACT FILE FORMATS” ON PAGE 745.

Contacts (Step 3)
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1. Select the Export Image check box to export the contact(s) in TIFF 
image format.

2. If you select Export Image, select from the following image formats:

• Mosaic: This option creates a georeferenced TIFF image from 
contact data.

• Speed Corrected: This option calculates the distance between 
profile lines in the contact and corrects for vessel speed.

• Uncorrected: This option does not correct for vessel speed and 
renders a one-to-one correspondence between the side scan image 
and the contact.

3. To export the colour map that was selected in the Side Scan Editor, 
select the Use Colour Map Specified in Contact File.

4. To export the contact with a new colour map, select the 
Use Other Colour Map option and select the map from the drop-down 
list.

The selected colour map is displayed in the Preview field.
5. Select the directory location for the contact. You can select from two 

options:

• Save Images in the Line Directory: This option saves the contact 
data to the line file in the HIPS/SIPS Project/Vessel/Day directory 
structure that you selected in the second dialog box.

• Save Images in User Defined Directory: This option saves the 
contact data in another directory. Click Browse to select the folder 
where you want to save the data.

6. Click Next.
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Contacts (Step 4)

This dialog box contains options for exporting contact data to a 
HOB or CARIS file

1. Select either the Export to CARIS Map or Export to ASCII check boxes. 
Both can be selected at the same time.

2. Type a file name and path to store the contact data after export, or click 
Browse to select the file path (both CARIS data and ASCII text files are 
typically stored in ..\Hips\CARIS_Files).

3. Type a layer number for the contact data in the Theme Number field.

4. Type a symbol size for the contact data in the Symbol Size field.

5. Click Next. 
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GSF to CARIS Map/HOB

The Generic Sensor Format (GSF) to CARIS/HOB function loads 
soundings and track lines from one or more GSF files into a 
CARIS map or HOB file. GSF data does not have to be converted 
to HIPS data prior to using this utility.GSF to CARIS/
HOB (Step 3)

Data can be exported either in the form of soundings or track 
lines:
• Soundings. Export all soundings (subject to the HIPS 

Sounding Status and Data Thinning settings) that fit within 
the boundaries of the work file.

• Track Lines. Export a line that connects the centre of each 
swath for each survey line, thus showing the track of the 
vessel along each survey line. It is not necessary to export 
soundings to use this option.

1. Select either the Export Soundings or the Export track lines check box.

2. If you selected Export Soundings, complete any or all of the following 
fields:

• Attributes: Select Basic or Advanced from the drop-down list. 

The Basic Attributes option creates mandatory CARIS feature 
attributes for the map file, such as feature code, user number and 
source ID. 
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The Advanced Attributes option creates additional CARIS feature 
attributes for soundings such as time stamps, launch identifier and 
tidal correction.

• Status: Select soundings flagged as Selected, Accepted or 
Accepted and Rejected.

• Feature Code: Select a feature code for the soundings from the 
drop-down list.

• User Number: Type a number value for layering data in the CARIS 
map or HOB file.

• Group By Beam: Load soundings into user numbers according to 
sonar beam number. For example, all soundings from beam 37 are 
loaded to user number 37 in the CARIS map file or HOB file

3. If you selected Export Tracklines, complete any or all of the following 
fields.

• Feature Code: Select a feature code for the track lines object from 
the drop-down list.

• User Number: Type a number value for layering data in the CARIS 
map.

4. Select the Include Offline Data check box to include data recorded 
during turns between track lines.

5. Click Next.

The next dialog box is determined by whether you are exporting 
to a CARIS map or HOB file.
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GSF to CARIS (Step 4)

This dialog box is displayed if you are exporting to a CARIS map.

1. Click Browse to select a CARIS map for data export, or type the name 
of a new map.

The map file path and name are displayed in the CARIS Map 
field.
The CARIS Source ID is a 12-character alphanumeric attribute in 
CARIS maps. The ID can be the first or last 12 characters in a 
GSF project name.
2. Choose either the first 12 characters or the last 12 characters for the 

CARIS Source ID.

3. Click Next.

If you created a new CARIS map in Step 4, a projection list is 
displayed in the next dialog box. Otherwise you can begin export 
of the data in the next dialog box.
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GSF to HOB (Step 4)

This dialog box is for saving the HOB file that contains the 
exported GSF data.
1. Click Browse and select a location and name for the HOB file.

2. Click Next.
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HIPS Tide to ASCII

Export HIPS tide data from selected track lines to a TID file. 
You can create TID files from single or multiple track lines in a 
project. TID files can be viewed in a text editor.

HIPS Tide to ASCII (Step 3)

This dialog box creates the output tide file.

1. Click Browse and use the standard Windows Open dialog box to select 
a path and name for the output TID file.

The path and name of the tide file is displayed in the Output File 
Name field.
2. Select the Include Rejected Records check box to include tide records 

that have been rejected.

3. Select GPS Tide to use tides calculated from a GPS ellipsoid height.

4. Select Smooth data to use tide data that has been smoothed for 
localized variability.
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HIPS To ASCII

The HIPS to ASCII function creates a customized text listing of 
soundings that you can load into other software systems.

HIPS to ASCII (Step 3)

Each sounding in a cleaned HIPS dataset are stored with bits 
that determine the status of that sounding. You can choose to 
restrict the export process to soundings with specific status 
flags.
1. To export soundings with a specific status flag, select any of the 

Sounding Status check boxes.

2. Choose the sounding’s unit of measurement by selecting either Metres 
or Feet.

The Data Binning option divides the survey area into a grid to 
select the shoal- or deep-biased soundings from each cell for 
export. The Bin Size option sets the size of the grid cells.
3. To apply a data thinning function, select the Data Binning check box.

4. Type the size for the grid cell in the Bin Size field and select either 
Metres or Feet. 

5. Select either the Shoal-Biased or Deep-Biased options to export only 
the shoalest or deepest soundings, respectively, to the ASCII file.

Soundings can be selected for export from each grid cell in the 
entire survey area or by processing each track line in sequence.
6. Select either the By Area or By Line options.
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7. Select One File to export all data to a single file or select Multiple Files 
to export data to separate files for each survey line.

8. Select an output location for the data.

• If you select One File, type a name and file path for the ASCII file, or 
click Browse to select a location and name for the file.

• If you select Multiple Files, click Browse to select a folder to save 
the files. The files are automatically named according to 
Project_Vessel_Date_SurveyLine.

9. Click Next.

HIPS to ASCII (Step 4)

This dialog box lists the attributes that can exported to the 
ASCII file and the delimiters used to separate data in the file.

1. Select the sounding attributes to be included in the ASCII file.

• To add an attribute, select the attribute in the Available list and click 
Add to move it to the Active list.

• To remove an attribute, select the attribute in the Active list and click 
Remove to move it to the Available list.

2. To change the order that attributes are exported, select the attribute in 
the Active list and click the up or down arrow buttons.

3. Select the Headers check box to create print attribute names at the top 
of the attribute rows.

4. Select either the Space, Comma, or Tab check boxes to use these 
characters as delimiters, or select the Other check box and type a 
character to use as a delimiter.
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You can define the boundaries of the ASCII map data from the 
boundaries of an existing CARIS map. If you do not select this 
option, the extents are defined from the ASCII data.
5. Select the Clip to CARIS Map check box to use a CARIS map to define 

the boundaries of the ASCII map data.

6. Click Browse to select an existing CARIS map.

7. To use the coordinate system from the selected CARIS map for the 
ASCII data, click the check box.

If you selected the Use Coordinate System From CARIS Map option, 
the next dialog box prompts you to export the data. If you did not 
select this option, the next dialog box prompts you to select a 
coordinate system.
8. Click Next.

HIPS To ASCII (Step 5)

This dialog box sets the unit type for recording data. The fields 
that are active in this dialog are determined by the attributes 
selected in the previous dialog box.
1. Select the units for recording sounding data:

• metres and kilometres

• fathoms (US and international)

• feet (US and international)

• yards (US and international)

• miles (US, international, and nautical)

2. Click Next.
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HIPS To CARIS Map

Export data to a CARIS map.

HIPS to CARIS (Step 3)

You can select which soundings are to be exported and how they 
will be stored in the CARIS map.

The Export Soundings option exports all soundings (subject to the 
sounding status and data binning settings).
1. Select the Export Soundings check box if you want to export soundings 

to a CARIS map. (See the next dialog box for the Export Tracklines and 
Export Swaths options).

There are four methods for exporting sounding attributes to a 
CARIS map.
• Basic: The basic sounding attributes in the CARIS map. These 

include user number, feature code, and source ID. This 
information is adequate to generate products such as 
sounding plots, contour plots, and DTMs. 

• Extended. Basic attributes plus time stamps, launch identifier 
(first four letters of the vessel name), and tidal correction.

• Extended with Key: The extended attributes set, plus the profile 
number and beam number as the CARIS Key. The profile 
number and the beam number, in addition to the other 
attributes, allow each sounding to be identified uniquely with 
respect to the original data set.
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• Extended with Unique Key: The extended attributes set, plus 
every object is given a unique key.

This additional information allows more flexibility for 
visualizing and manipulating CARIS files. For example, if time 
stamps are associated with each sounding, you can limit the 
display of soundings based on a time range.
However, each extra attribute adds to the storage requirements. 
More disk space is required to store the work file, and any HIPS 
program that processes the file must do more work and use more 
time and CPU resources.
2. Select from the four options in the Attributes drop-down list.

3. Select a new Feature Code for the soundings, if needed.

The Group by Beam Number option layers soundings according to a 
beam number in the CARIS file. Soundings belonging to a beam 
are assigned to the same user number in the map. User numbers 
in CARIS file are similar to layering. This option is used when 
exporting soundings from checklines into a separate checkline 
map so that a Quality Control Report can be generated. If you do 
not select this option, then a single user number will be used to 
hold all the exported soundings.
4. Select the Group by Beam Number check box to layer soundings 

according to beam numbers in the CARIS map.

The User Number option is available only if you do not select the 
Group by Beam Number option.
5. [Optional] Type a User Number to which all soundings are to be 

assigned.

The Sounding Status option enables you to export only 
soundings with a specific status flag.
6. To export soundings with a specific status flag, select any of the 

Sounding Status check boxes.

The Data Binning option divides the survey area into a grid for 
sounding selection. The Bin Size sets the size of the grid cells.
7. To apply a data binning function on export, select the Data Binning 

check box.

8. Type the size for the grid cell in the Bin Size field and select either 
Metres or Feet.

9. Select either Shoal-Biased or Deep-Biased to export only the shoalest 
or deepest soundings from each cell, respectively, to the CARIS file.

Soundings can be selected for export from the total survey area 
or by processing each track line in sequence.
10.Select either the By Area or By Line options.

11.Click Next.
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HIPS to CARIS (Step 4)

This dialog box sets the track line and swath export options.

The Export Track Lines option connects a line along the centre of 
each swath, thus showing the track of the vessel along each 
survey line. It is not necessary to import soundings to use this 
option.
The Export Swaths command connects a set of lines (one per 
swath) along the outermost port and starboard beams, thus 
showing the coverage of each ping. It is not necessary to import 
soundings to use this option. 
1. Select the Export Track Lines check box to export a line representing 

the track of the vessel along the survey area.

2. Type a new feature code for the vessel, if needed.

3. Type a User Number for the vessel so it is distinguished from other 
vessels in the same CARIS map.

4. Select a new Towfish Feature Code, if needed.

5. Type a User Number for the towfish so it is distinguished from other 
vessels in the same CARIS map.

6. Select the Exclude Rejected Record(s) check box to not include this 
data.

7. Select the Export Swaths check box to export a set of lines that 
represents the swaths along the survey.

8. Type a User Number for the swath so it is distinguished from other 
swaths in the same CARIS map.

9. Click Next.
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HIPS to CARIS (Step 5)
1. Click Browse to select a CARIS map for data export, or type the name 

of a new map.

The map file path and name are displayed in the CARIS Map 
field.
The Source ID is a 12-character alphanumeric attribute in 
CARIS maps. The ID can be the first or last 12 characters in a 
project name or line name.
2. Select either Project Name or Line Name to use as a Source ID.

3. Choose either the first 12 characters or the last 12 characters for the 
Source ID.

The Clip to CARIS Map option cuts the HIPS data at the 
boundaries of an existing CARIS map. If this option is not 
selected, the geographic extents of the map are extended to 
accommodate the HIPS data.
4. Select the Clip to CARIS Map check box to implement this option.

5. Click Next.

If you created a new CARIS map in Step 1, a dialog box for 
selecting a projection is displayed. Otherwise you can begin 
export of the data in the next dialog box.
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HIPS to FAU

Export processed HIPS data, with optional heave/pitch/roll/
quality/amplitude attributes, to the FAU format. The process 
will create multiple files with the extension *.fauTC designating 
the data as “tide corrected”. The names of the output files will 
match the HIPS line names. 
After you have selected the tracklines to export, the next step is 
to designate an output folder. 

1. Type a path and name for the output file, or click the Browse button (...) 
to select a folder and then type the file name. 

2. Select Maintain PVD Hierarchy to create output directories that 
correspond to the HIPS data being exported.

3. Click Next. 

4.
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HIPS To GSF

The HIPS to GSF function exports processed HIPS data to a 
GSF format. A new GSF file is created for each track line that is 
exported from HIPS. 
Conversely, when HIPS data is created from GSF data, a copy of 
the original GSF file is maintained inside the HIPS directory 
structure. The Export to GSF function updates these GSF files.

HIPS to GSF (Step 3)

1. Click the Browse button (…) to select a location for the GSF files.

The Browse for Folder dialog box is displayed. The stored GSF 
file will have the same name as the track line. The file path is 
displayed in the Output File field.
2. To export entire projects and maintain the HIPS Project/Vessel/Day/

Line structure in the output, click the Maintain PVD Hierarchy check 
box. 

3. Select the Ignore Disabled Beams option to exclude any soundings which 
have been rejected (because of disabled beams) from your export file. 

4. Click Next.
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HIPS To HOB

The Hydrographic Object Binary (HOB) file stores feature 
objects and associated attribute data. The HOB file can contain 
links to CARIS spatial objects.

HIPS to HOB (Step 3)

The Export Soundings option exports all soundings (subject to the 
sounding status and data binning settings).
1. Select the Export Soundings check box to export soundings to a 

CARIS map (see the next dialog box for the Export Tracklines and 
Export Swaths options).

2. To export soundings with a specific status flag, select any of the 
Sounding Status check boxes.

The Data Binning option divides the survey area into a grid for 
sounding selection. The Bin Size sets the size of the grid cells.
3. To apply data binning, select the Data Binning check box.

4. Type the size for the grid cell in the Bin Size field and select either 
Metres or Feet.

5. Select either Shoal- or Deep-Biased to export only the shoalest or 
deepest soundings, respectively, to the CARIS file.

Soundings can be selected for export from the total survey area 
or by processing each track line in sequence.
6. Select either the By Area or By Line options.
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The Export Track Lines option connects a line along the centre of 
each swath, thus showing the track of the vessel along each 
survey line. It is not necessary to export soundings to use this 
option.
The Export Swaths command connects a set of lines (one per 
swath) along outermost port and starboard beams, thus showing 
the coverage of each ping. It is not necessary to export soundings 
to use this option. 
7. Select the Export Track Lines and Export Swaths options.

8. Click Next.

HIPS to HOB (Step 4)
1. Click the Browse button to select a location for the HOB files.

The Browse for Folder dialog box is displayed.
2. Select a directory to store the HOB data and click OK to close the 

dialog box.

The file path is displayed in the Output File field.
3. Click Next.
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HIPS To HTF

The HIPS and SIPS Export Wizard converts field sheet layer 
data and soundings to a Hydrographic Transfer Format (HTF) 
file.

Hydrographic Transfer 
Format

The HTF file is an ASCII file that can be opened in any text 
editor (such as Notepad). It consists of two sections: a header 
section and a sounding data record.
• The header contains general information about the survey.
• The sounding data record contains the depths and other 

relevant information.
The total number of fields generated in the sounding data record 
depends on the survey. At the start of the sounding data record 
is a Field Population Key that gives each field a 1 bit to show 
that a field is included, or a 0 bit to show if a field is not 
included.
For example: [0000111110000000000]
In the above Field Population Key, fields 5 to 9 contain data 
(hence the 1 bits), while fields 1 to 4 and 10 to 20 contain no data 
(hence the 0 bits). Fields without data are not written to the 
HTF file when it is generated. There are a total of 20 HTF fields 
in the sounding data record. Two additional fields are added by 
the Export Wizard for beam and profile number. Extra fields can 
be added, if needed. The HTF export automatically exports 
TPU depth and TPU position values if these are included in the 
track line.
The HTF file contains an ordered list of all possible fields and a 
description of each field.

Hydrographic Transfer 
Format Template

Sometimes the same header information can be used for 
multiple HTF files. The export wizard gives you the option of 
saving a header for use in another file. Headers are saved as 
HTFT files (Hydrographic Transfer Format Template). The file 
is in XML format that can be viewed in a text editor or an XML-
compliant Internet browser.
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HIPS to HTF - Output options 

Enter the necessary header information. You can directly enter 
the data or load it from an HTFT (Hydrographic Transfer 
Format Template) file.
If you are exporting soundings, you can export all data to a 
single file or export data from each survey line to its own file. 
This option is not available for field sheet products.
1. Select an output location for the HTF file(s).

• If you choose Export to One File, type a name and file path for the 
HTF file, or click Browse to select a location and name for the file.

• If you choose Export to Multiple Files, click Browse to select a 
folder to save the HTF files. The files are automatically named 
according to Project_Vessel_Date_SurveyLine.

2. To enter new header information, click the Value field next to the HTF 
Header Field and type the data.

3. Click Load to open data from an existing HTFT file into the Value fields.

4. Click Clear to remove data from all fields, if needed.

5. Click Next.
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HIPS to HTF - Output options page 2

1. Select the Include Survey Line Name check box to include this 
information in the HTF file.

2. Select the Include Beam and Profile Information check box to include 
the beam and profile numbers in the HTF file.

If you entered values in the depth sounder, positioning system, 
and tidal station fields in the previous dialog box then the 
respective fields in these tabs are enabled. If you did not enter 
values, click Back and fill in the fields.
The Positioning Systems tab is for entering navigation systems 
information.
3. Type the name and model (and/or any additional information) of the 

system in the Name field.

4. Type the system used on the survey (GPS, DGPS, etc.).

The Depth Sounders tab is for entering sonar information.
5. Type the name and model of the sonar system used on the survey.

6. Type the mode of sonar (multibeam, single beam, multi transducer).

The Tidal Stations tab is for entering tide information.
7. Type the name of a tidal station.

8. Type the location.

9. Type the method used to acquire data (predicted, observed, etc.)

10.Click Save to save information to a new or existing HTFT file.

11.Click Next.
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HIPS to HTF - Attributes Options

If you are exporting a BASE surface you must map at least one 
BASE surface attributes to a HTF attribute. 
 

1. Click in a surface attribute field to access a drop-down box listing all the 
attributes available in the data file. 

2. Select an attribute from the list.

3. Click Clear to remove all values from the Surface Attributes fields.

4. Click Next to go to Export.
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SIPS To UNISIPS

Export SIPS data to a Unified Sonar Imaging Processing System 
(UNISIPS) format. 

SIPS TO UNISIPS (Step 3)

Select a file to store the data.

1. Click Browse to select a location for the UNISIPS files.

The Browse for Folder dialog box is displayed.
2. Select a directory to store the UNISIPS data and click OK to close the 

dialog box. The UNISIPS file will have the same name as the track line 
with a .u file extension.

3. Type a Sensor Name in the field (up to 10 characters).

The file path is displayed in the Output File field.
4. Click Next .
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Mosaic To Image

You can export a mosaic or group of mosaics to an image format 
for inclusion in a CARIS product or other application.

Mosaic to Image (Step 3)

1. From the Active Attribute list, select an attribute layer of the mosaic to 
export.

If you have activated a legend and its attributes in the 
Properties for the mosaic being exported, you can choose to 
export that legend with the mosaic.
2. Select the Display Raster Legend check box.

3. Select Expand cover to fit the raster legend to enlarge the area containing 
the mosaic and legend. 

4. Select an image format:

• 8 Bit (256 colours)

• 24 Bit (16 million colours)

5. By default the output file is compressed. If you do not want file 
compression, de-select the Compress TIFF check box.

6. To save georeference information with the image, select the 
Georeference Format check box.

7. Click Next.
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Mosaic to Image (Step 4)
 

You can export a single file or a tile set, or both formats at the 
same time.
1. Click Browse, and select the file path and Output File Name for the 

image file. 

2. Click Browse, and select the path to the Output Folder for the tile 
images.

3. Set the Tile Dimensions to specify the size of the tile. The units here 
are those set in Tools > Options > Display > Units (see “UNITS” ON 
PAGE 673).

4. Type a prefix for the exported tile files. 

The files will have a tile number appended to the prefix. The tile 
number is in the format RxC where R and C are the row and col-
umn index for the current tile. For example, with prefix RTFM, tiles 
would be numbered RTFM_1x1, the second RTFM_2x2etc.

5. Click Next. 
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Projection

All sounding data is stored in HIPS and SIPS as un-projected 
longitude and latitude. This dialog selects the appropriate 
coordinate system to reference the soundings. All soundings will 
be transformed to this coordinate system as they are exported.

1. Choose a coordinate system by selecting a Projection Group from the 
list.

2. Select a Zone associated with the Projection Group (the Key field is 
filled when the Zone is selected).

3. Click Next.
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Export

At this step you execute the export with the settings you have 
chosen. The dialog box shows the percentage of data exported 
and the status of the export process.

1. Click Back to review your settings.

2. Click Export to export the data with the settings you’ve selected.

A progress indicator shows the percentage of files converted to 
the selected format. When the export is completed, the Restart 
button is displayed to enable you to go back and export another 
file with the same or with different parameters.
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2
Vessel Editor

Use the Vessel Editor to create HIPS vessel files, and to edit sensor 
offsets and error estimates in those files.

In this chapter...
“VESSEL EDITOR INTERFACE” ON PAGE 546
“CREATE A NEW HVF” ON PAGE 548
“CREATE VESSEL OUTLINE” ON PAGE 555
“3-D CONTROLS” ON PAGE 557
“EDIT SENSOR CONFIGURATION” ON PAGE 560
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Vessel Editor Interface

Open the Vessel Editor

The Vessel Editor is launched from the HIPS and SIPS 
interface.
1. Select the Vessel Editor command from the Edit menu or from the 

Tools toolbar.

The Vessel Editor is displayed. 
The image below shows an example of the Vessel Editor 
displaying a vessel file and a vessel outline.
 

The Vessel Editor displays a wire-frame diagram of the vessel. 
The display can be manipulated in three dimensions using the 
3 D display compass. Location of a sensor is represented by a 
coloured dot or line.
Above the vessel outline display is a drop-down list containing 
all the unique time stamps in the vessel file. You can select a 
time stamp and view the outline configuration at that single 
point in time.
Below the outline are the tables into which you enter 
information on the sensors used in the survey. 

Reference point
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Open and Close Files

To open a saved file in the Vessel Editor: 
1. Select the Open command from the file menu.

The Open File dialog box is displayed.
2. Select the file from the list and click OK.

The file opens in the Vessel Editor with the vessel’s outline 
displayed in the editor, and a list of active sensors displayed in 
the Sensors list box.

To close an existing file:
1. Select the Close command from the File menu.

You are prompted to save changes made in the Vessel Editor.
2. Select a Save command.

3. Click OK.

To create a text file listing the parameters entered in Vessel 
Editor: 
1. Open the HVF in the Vessel Editor.

2. Select the Vessel Report command. from the Tools menu.

The Save As dialog box is displayed. The default directory is 
Hips\version number\HDCS_Data\VesselConfig.

Exit the Vessel Editor

Close the Vessel Editor and all files.
1. Select Exit from the File menu. 

Vessel Configuration Files that were created in previous 
versions of HIPS and SIPS can be opened and edited in 
the Vessel Editor. The files are automatically re-saved as 
HIPS Vessel Files. 
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Create a New HVF

Use the HIPS and SIPS Vessel wizard to set the parameters 
needed to create a new vessel file. The wizard will take you 
through the steps to enter vessel information and sensor 
configuration information based on the type of survey data. 
Once the vesssel file is created you can enter the sensor position 
data using a 3D outline for the vessel. (See “CREATE VESSEL OUTLINE” 
ON PAGE 555.)
Additional information such as the ellipsoid used in the survey 
and sensor configuration data is then entered after the file has 
been created. 
To create a new HIPS vessel file:
1. Select the New Vessel File command.

The Vessel Wizard - Step 1 dialog box is displayed.
(The dialog boxes displayed by the wizard are contingent on the 
type of sonar used in the survey.)

Vessel Information

1. Type a name similar to the vessel used in the survey. Make sure the 
name does not include any spaces.

2. Click the Calendar button to insert the year and date from which the 
vessel file is valid.

3. Click Next to open the next dialog box: “TYPE OF SURVEY” ON PAGE 549.
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Type of Survey

The second dialog box prompts you to enter the sonar type used 
in the survey.

There are four sonar types:
• Singlebeam

• Multibeam

• Multi-transducer

• Side Scan Sonar

1. Select a sonar type by clicking the appropriate check box.

2. Click Next to go to the next step in the Vessel Wizard, 

or, 
if you selected Side Scan Sonar, click Finish.

Single Beam    

If you select Single Beam as the type of survey data in Step 2, 
then the remaining steps in the creation of a new HVF are 
“MOTION SENSORS” ON PAGE 552 and “CONFIGURATION OPTIONS” ON PAGE 553.   
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Multibeam

If you selected Multibeam in the Step 2 dialog box, Step 3 will 
ask you for information on the sonar model and number of 
transducers.
 

1. Select the appropriate check box to indicate that one or two 
transducers were used in the survey.

2. Enter the number of beams in each transducer.

3. Select the sonar model.

4. Click Next to continue.

Multi-Transducer

If you selected Multi-transducer in the Step 2 dialog box, you 
will now be asked for information on the number and types of 
transducers and for TPE specific parameters. 
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1. Enter the Number of Transducers on a boom.

2. Select Yes if the transducers are mounted to a fixed boom or to the hull 
of the vessel, or select No if the transducers are on a movable 
(decoupled) boom.

3. Type the default Alongtrack value of all the transducers relative to the 
ship's Reference Point.

4. Type the default Depth of all the transducers relative to the ship's 
Reference Point.

5. Select the sonar model from the Model drop-down list.

The following parameters are necessary to calculate Total 
Propagated Error.
6. Type the distances from the positioning system to the centre of the 

boom in the Navigation to Boom X-Y-Z fields.

7. Type the distance from the motion recording unit to the centre of the 
boom in the MRU to Boom X-Y-Z fields.

The Roll and Gyro misalignment values are needed for fixed-boom 
system. However, for a decoupled boom, only a Gyro 
misalignment value is needed.
The Squat and Heave percentage values are transducer responses 
to overall heave and squat. For fixed-boom transducers this 
should be 100% and less than 100% for decoupled-boom 
transducers.
8. Type a degree offset in the Roll and Gyro fields.

9. Type a percentage value in the Squat and Heave fields.

10.Click Next to open the next step: “CONFIGURATION OPTIONS” ON PAGE 553. 
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Motion Sensors

This dialog box determines which attitude sensors are displayed 
in the HVF.

1. Create entries for any (or all) of the following sensors by clicking the 
appropriate box:

• heave

• pitch

• roll 

The Apply in Post Processing option means that the data is applied 
during the Merge process or during Sound Velocity Correction.
2. Click any of the check boxes if you want to apply the attitude sensor 

data in post processing.

3. Click Next.
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Configuration Options

The Configuration Options dialog box is displayed

This dialog box lets you enable three options:
• the SVP (Sound Velocity Profile) pole parameters
• dynamic draft values
• waterline height variation
1. To include sound velocity corrections, click the Define Parameters for 

Sound Velocity Corrections check box.

2. To apply dynamic draft values to vessel speeds, click the Apply 
Dynamic Draft check box.

A draft-versus-speed table is created in the Vessel Editor. You 
can enter values in this table once the vessel file is created.
3. If you want to apply long period variations in the waterline height in 

processing data, click the Define Vessel Waterline Height Variation 
check box.

4. Click the appropriate Apply in Post Processing check boxes, as 
needed.

5. If you selected the Define Parameters for Sound Velocity Corrections 
check box, click Next, or click Finish if did not select this option.

Sound Velocity Corrections

The Sound Velocity Corrections dialog box is displayed only if 
you selected the Define parameters for sound velocity corrections 
check box in the Configuration Options dialog box.
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This dialog box records any transducer pole offsets.
Transducer head offsets must be taken into account when the 
SVP is applied to the data.
1. Select the 180-degree Azimuth box if the transducer is reverse 

mounted.

2. If the transducer is mounted with a large roll offset for use under 
wharves or along banks, then select the Roll Offset check box 

3. Type the amount of offset (in degrees) in the Roll Offset box.

4. If the transducer is mounted with a large pitch offset such that it is 
pointed forward or backwards, then select the Pitch Offset check box.

5. Type the amount of offset (in degrees) in the Pitch Offset box.

6. Repeat the above steps for the second transducer if there are two 
poles.

7. Click Finish.

A new HIPS Vessel File is created. You can now create an 
outline for the vessel (see “CREATE VESSEL OUTLINE” ON PAGE 555). 
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Create Vessel Outline

The Vessel Shape command creates a 3-D outline of the vessel 
and displays it in the Editor. You can also use the Vessel Shape 
command to revise an existing vessel outline. 
The Vessel Shape command opens three dialog boxes so you can 
enter measurements to define the length, width and height of 
the vessel, and the position of the Reference Point in the vessel.
1. Open the HVF if it is not already open.

2. Select the Vessel Shape command.

The Vessel Shape - Step 1 dialog box is used for entering width 
and length of the vessel.

1. Enter a width for the vessel (port to starboard).

2. Enter a length for the vessel (stern to the base of the bow).

3. Enter a length for the vessel (stern to the tip of the bow).

4. Click Next.

The Vessel Shape - Step 2 dialog box is displayed. It is used to 
set the position of the Reference Point (RP). 
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1. Type the distance from the stern to RP.

2. Type the distance from the starboard side to the RP.

3. Click Next.

The Vessel Shape - Step 3 dialog box sets the height 
measurements for the vessel.

1. Type the height of the vessel.

2. Type the height of the vessel RP from the keel.

3. Click Finish.

The Vessel Editor displays the vessel outline. 
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3-D Controls

The outline displayed in the editor can be rotated, zoomed and 
panned using the compass (control axes), keyboard, and mouse.

Compass Rotation along the X-Y-Z axis is handled by moving the arrow 
heads at the ends of the compass.

1. To rotate the image along the Z-axis, click the middle arrow head and 
drag the cursor upward so that the image is rotated. The compass can 
be rotated 90º.

2. To rotate the image along the X-Y axis, click any of the other arrow 
heads and drag the arrow head in a left-right or up-down direction. The 
compass can be rotated 360º.

3. Alternatively, the image can be rotated in the horizontal plane by 
grabbing the Z-arrow, then pressing the <Ctrl> key and the left-mouse 
button and moving the cursor up and down in the view. Rotation around 
the Z-axis can be performed by pressing the <Shift> key and moving 
the cursor left and right in these windows.

Pan There are three pan options:
• To pan along the X-Y axis: place the cursor in the 3-D area, 

press the middle mouse button and drag the display to a new 
location.

• To pan along the Z-axis: place the cursor in the 3-D area, 
press and hold both the <Shift> key and middle mouse button 
and move the cursor in the window.

• To centre the 3-D Display window on a selected point: 
position the cursor over the point and click the middle mouse 
button.

Zoom The zoom option is similar to pan
1. Press and hold both the <Ctrl> key and right-mouse button while 

dragging the mouse up or down to zoom in or zoom out.

Z-axis rotation 
arrowhead
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Options Dialog Box
Default ellipsoid The HVF must contain the ellipsoid and datum used by the 

navigation system in the survey vessel, regardless of whether 
projection coordinates or geographic coordinates are stored in 
the data. 
The list of available ellipsoids is maintained in the datum.dat 
file referenced by the uslXdatum environment variable. By 
default, this file is located in the System directory.
Set the ellipsoid for a new vessel file to be the same as the one 
used in the survey. 

1. Select the Options command.

The Options dialog is displayed.
2. Select the Options - General tab.

3. Select an ellipsoid from the pull-down menu.

4. Click OK to close the dialog box.

The name of the ellipsoid is displayed in the Navigation section 
of the editor.

Colours The locations of sensors and other equipment are shown by a 
colour markers. You can select another colour for a sensor 
marker.
1. Select the Options command.

The Options dialog box is displayed.
2. Select the Options - Colours tab.
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3. Select a colour from the pull-down palette, or create a custom colour 
from the standard Windows colour picker.

4. Click OK to activate the changes and close the Options dialog.
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Edit Sensor Configuration

The active sensors listed in the Vessel Editor (shown below) are 
determined by the sensor and other parameters you selected 
when creating the vessel file. 
If you want to add data for a sensor not already included in the 
vessel file, you can add a sensor to the list and enter its data. 
You can also remove a sensor and its values from the vessel file. 

In general, if sensor offsets or calibration values have already 
been applied to logged data during data acquisition, then the 
same offsets and calibration parameters must not be entered in 
the Vessel Editor. 
Also, if compensation for heave, pitch, and roll has already been 
made to the recorded sounding data during data acquisition, for 
example as in Simrad data, then it must not be applied again.

Toggle data fields To add or remove sensors from the list of active sensors,
 1. Select the Active Sensors command.

The Active Sensors dialog box is displayed.

If a box is checked, the sensor is included in the vessel file and 
displayed in the Editor table.

Active sensors Table of values related to the highlighted sensor.

M
en

u

Edit > Active Sensors 

To
o

l



CARIS HIPS and SIPS User’s Guide 561

Vessel Editor: Edit Sensor Configuration

2. Make sure a sensor box is checked to enable the sensor, or cleared to 
remove the sensor.

3. Click OK.

The list is refreshed to show the selected active sensors.

Sensors

Different sensors can require specific edits applied to the 
parameter data. The following sections explain the individual 
sensor data fields. 
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Swath

The swath sonar, also known as multibeam, typically has beams 
that are formed in a fan shape, radiating from the centre of the 
transducer. 
1. Click Swath 1 in the Sensors list box so the selection is highlighted and 

the swath data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of current swath time stamp.

• Time: The hour and minute of the current swath time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the transducer from the 
Reference Point (0).

• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.

• Z: The vertical distance of the transducer, positive into the water.

The Pitch, Roll and Yaw fields refer to misalignment of the 
transducer, during mounting, from the vessel coordinate system.

• Pitch: The offset is positive when rotating the transducer towards 
the bow (bow up).

• Roll: The offset is positive when rotating the transducer away from 
starboard (starboard down).

• Yaw: Indicates the horizontal rotational offset and is positive for a 
clockwise rotation.

• Manufacturer: The maker of the transducer.

• Model: The make of the transducer. The model information is 
necessary for the calculation of Total Propagated Error.

• Serial Number: The serial number of the transducer.
 

Since the Simrad data read into HIPS is already corrected, 
the Swath values in the HVF must be set as follows:
• The X/Y/Z offsets are zero because the Simrad data 

acquisition has already applied static draft and shifted the 
swath profile to the vessel reference point.

• The Roll / Pitch / Yaw transducer mounting rotations are 
typically zero because the Simrad data acquisition has 
already applied patch test calibration results.
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Navigation

The navigation section of the HVF describes the location of the 
navigation source (for example, antenna or motion sensor). This 
section is used as a link between the fixed positioning coordinate 
system and the instantaneous vessel coordinate system.
1. Click Navigation in the Sensors list box so the selection is highlighted 

and the navigation data fields are visible.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current navigation time stamp.

• Time: The hour and minute of the current navigation time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the navigation source from 
the Reference Point (0).

• X: The athwart-ship distance of the source, positive to starboard.

• Y: The along-ship distance of the source, positive towards the bow.

• Z: The vertical distance of the source, positive into the water.

• Ellipsoid: From the drop-down list, select the ellipsoid on which the 
navigation is based. The ellipsoid should be the same as the one 
used in the survey. 

• Manufacturer: The maker of the navigation equipment.

• Model: The make of the navigation equipment.

• Serial Number: The serial number of the navigation equipment.

Gyro

The gyro sensor refers to any device providing a heading 
orientation of the vessel.
1. Click Gyro in the Sensors list box so the selection is highlighted and the 

gyro data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current gyro sensor time 
stamp.

• Time: The hour and minute of the gyro sensor time stamp.

• Time Correction: The time correction value.

The Gyro Error is measured in degrees and is the difference 
between the recorded sensor value and the applied heading of 
the vessel: Applied Heading = Recorded value - Gyro 
Error.
3. Click an Edit button in the Error column to open the Gyro Error Table.



564 CARIS HIPS and SIPS User’s Guide

Vessel Editor: Edit Sensor Configuration

4. Type new values in the Gyro or Error fields and click OK to close the 
dialog box.

5. Type data (as needed) in the following fields.

• Manufacturer: The maker of the sensor equipment.

• Model: The make of the sensor equipment.

• Serial Number: The serial number of the sensor equipment.
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Heave

The heave sensor records the vertical motion of the vessel. 
Although the heave sensor has its own section in the Vessel 
Editor, it is usually part of the same sensor package as Pitch and 
Roll in most survey configurations.
1. Click Heave in the Sensors list box so the selection is highlighted and 

the data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current heave sensor time 
stamp.

• Time: The hour and minute of the current heave sensor time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the heave sensor from the 
Reference Position (0).
The X-Y-Z location of the heave sensor must be defined ONLY 
when you intend to apply heave data during Merge AND when 
remote heave compensation is necessary.

• X: The athwart-ship distance of the sensor, positive to starboard.

• Y: The along-ship distance of the sensor, positive to the bow.

• Z: The vertical distance of the sensor, positive into the water.

• Error: The applied instantaneous values for the heave sensor are 
computed by subtracting the appropriate errors from the recorded 
values:

Applied Heave = Recorded Heave - Heave Error.

• Apply: Select Yes to apply heave data in the merge process.

• Manufacturer: The maker of the sensor equipment.

• Model: The make of the sensor equipment.

• Serial Number: The serial number of the sensor equipment.

The location of the heave sensor is shown in the Vessel Editor by 
a coloured dot.

Note: Simrad systems apply dynamic Heave, Pitch, and 
Roll values to the swath data during survey. Therefore, the 
HVF must be set up with the Apply switches for Heave, 
Pitch, and Roll set to '”No” so these values are not applied 
twice. 
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Pitch

Pitch refers to the rotational motion of the vessel around the X 
(port/starboard) axis. Although the pitch sensor has its own 
section in the Vessel Editor, it is usually part of the same sensor 
package as roll and heave in most survey configurations.
1. Click Pitch in the Sensors list box so the selection is highlighted and the 

data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current pitch time stamp.

• Time: The hour and minute of the current pitch time stamp.

• Time Correction: The time correction value.

• Error: The applied instantaneous values for the pitch sensor are 
computed by subtracting the appropriate errors from the recorded 
values:

Applied Pitch = Recorded Pitch - Pitch Error.

• Apply: Select Yes to apply the pitch data in the merge process.

• Manufacturer: The maker of the sensor equipment.

• Model: The make of the sensor equipment.

• Serial Number: The serial number of the sensor equipment.

The location of the pitch sensor is indicated in the Vessel Editor 
by a coloured dot.

Note: Simrad systems apply dynamic Heave, Pitch, and Roll 
values to the swath data during survey. Therefore, the HVF 
must be set up with the Apply switches for Heave, Pitch, 
and Roll set to '”No” so these values are not applied twice. 
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Roll

Roll refers to the rotational motion of the vessel around the Y 
(fore/aft) axis. Although the roll sensor has its own section in the 
Vessel Editor, it is usually part of the same sensor package as 
pitch and heave in most survey configurations.
1. Click Roll in the Sensors list box so the selection is highlighted and the 

roll data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current roll time stamp.

• Time: The hour and minute of the current roll time stamp.

• Time Correction: The time correction value.

• Error: The applied instantaneous values for the roll sensor are 
computed by subtracting the appropriate errors from the recorded 
values:

Applied Roll = Recorded Roll - Roll Error.

• Apply: Select Yes to apply the roll data in the merge process.

• Manufacturer: The maker of the sensor equipment.

• Model: The make of the sensor equipment.

• Serial Number: The serial number of the sensor equipment.

The location of the roll sensor is indicated in the Vessel Editor by 
a coloured dot.

Note: Simrad systems apply dynamic Heave, Pitch, and Roll 
values to the swath data during survey. Therefore, the HVF 
must be set up with the Apply switches for Heave, Pitch, 
and Roll set to '”No” so these values are not applied twice. 
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Dynamic Draft

The squat and lift of a vessel changes as the speed changes. For 
some vessels, if the squat/lift is not accounted for, significant 
errors are introduced into the soundings. In this section, you can 
specify up to 10 speed-draft value pairs. During merge, the 
difference between the instantaneous draft and the static draft 
is computed and the final depth compensated.
Draft is measured in metres/feet, and speed is measured in 
knots. All draft values entered should be relative to the same 
reference, but what that reference is, is not important. The first 
Speed-Draft pair must correspond to a state where no draft 
correction is necessary. The delta draft values, relative to the 
initial draft, are computed and used to correct observed 
soundings. 
The following formula is used to correct soundings for dynamic 
draft:
Depth = observed depth – waterline + delta draft.

Delta draft is computed from the present vessel speed, as 
derived from the navigation system.
You can also create your own dynamic draft model and load 
Delta Draft information directly which will override the 
Dynamic Draft table in the HVF.
1. Click Dynamic Draft in the sensors list box so the selection is 

highlighted and the dynamic draft data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current time stamp for the draft 
table.

• Time: The hour and minute of the current time stamp for the draft 
table.

• Apply: Select Yes to apply the table during merge (or No to not 
apply the table).

3. Click Edit in the Error field. A dialog box containing a table with up to 
10 speed-draft pairs is displayed.
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4. Click inside the Speed cell and type a speed value (in knots).

5. Click inside the Draft cell and type a corresponding draft value.

6. Continue entering as many speed /draft pairs as needed.

7. Click OK.

The speed-draft table is saved in the HVF.
• Comments: Any additional comments.

Single Beam

The Single beam section refers to a vertical beam echo sounder 
with one transducer mount. It can be a single or dual frequency 
sounder defined as one beam with one transducer.
1. Click Single Beam in the Sensors list box so the selection is highlighted 

and the data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current single beam time 
stamp.

• Time: The hour and minute of the current time stamp.

• Time Correction: The time correction value.

The X-Y-Z fields set the location of the transducer from the 
Reference Point (0).

• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.

• Z: The vertical distance of the transducer, positive into the water.

• Manufacturer: The maker of the transducer.

• Model: The make of the transducer.

• Serial Number: The serial number of the transducer.
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SVP

A sound velocity profile (SVP) records the speed of sound at 
various depths in the water column. One of the processes 
available in HIPS is the application of SVP data in sound 
velocity corrections. However, this procedure is not available for 
all types of sonars because some sonars and their data logging 
systems compensate for sound velocity during data acquisition.
To ensure the SVP is accurately applied in HIPS, the transducer 
X-Y-Z offset values must be entered.
1. Click SVP 1 in the Sensors list box so the selection is highlighted and 

the SVP transducer data fields are visible. If there is a second 
transducer then click SVP 2 and complete the same procedures as 
listed below.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current SVP pole time stamp.

• Time: The hour and minute of the current SVP pole time stamp.

3. Select Yes if there are dual transducers (or No if there is only a single 
transducer).

The following three fields are for entering the pole’s X-Y-Z 
coordinates. All coordinates are measured from the Reference 
Point
4. Type the transducer’s X-Y-Z offsets in the following fields:

• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.

• Z: The vertical distance of the transducer, positive into the water. 

The next three fields refer to the alignment of the transducer. 
The values you entered in the wizard when creating the HVF are 
displayed in these fields. The fields are only to be used for large 
transducer mounting offsets.

• Pitch: Pitch offsets of the transducer.

• Roll: Roll offsets of the transducer. 

• Yaw: Rotation of the transducer (either 0 or 180 degrees).

For information on applying SVP in processing see Sound 
Velocity Processing in the HIPS and SIPS User Guide.

Note: The Reference Point for Simrad data is the 
centre of rotation. It should be possible to retrieve 
offset values from the Simrad Installation 
Datagram.
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Sweep

Sweep systems typically contain multiple vertical beam 
transducers mounted on a boom and pointed straight down. The 
reference point for a sweep system can be anywhere on the X-Y 
plane, but must be on the water surface.
1. Click Sweep in the Sensors list box so the selection is highlighted and 

the data fields are visible.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current sweep time stamp.

• Time: The hour and minute of the current sweep time stamp.

• Time Correction: The time correction value.

• Transducers: Number of beams mounted on the boom.

3. Click the Edit button in the Transducer Status field to view a table for 
entering data for individual beams on the boom.

4. Type values in the fields and click OK.

5. Click Edit in the TPE Status field to enter TPE values for each beam on 
the boom and to edit values entered in the new vessel wizard.
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6. Type values as needed and click OK.
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Towed Sensors

If a towed sensor—such as a side scan sonar—is used on a 
survey, then SIPS can compute the sensor’s position as from the 
ship's position by calculating the horizontal layback and a 
direction to the sensor.
1. Click Towed in the Sensors list box so the selection is highlighted and 

the Towed data fields are displayed.

2. Type data (as needed) in the following fields:

• Date: The year and Julian day of the current towed sensor time 
stamp.

• Time: The hour and minute of the current towed sensor time stamp.

• Time Correction: The time correction value.

• Layback Error: The error in the computed or recorded horizontal 
layback. This can be used, for example, to compensate the 
recorded layback data or tow cable length for the distance between 
the origin of the measurements and the defined tow point location in 
the tow cable length. This value is subtracted from the computed 
horizontal layback.

• X: Offset of the tow point from the vessel’s reference position.

• Y: Offset of the tow point from the vessel’s reference position.

• Z: Height of the tow point (negative upwards) in relation to the 
datum that is referenced to the sensor depth (in most cases, this is 
the waterline).

• Manufacturer: The maker of the towed sensor.

• Model: The make of the towed sensor.

• Serial Number: The serial number of the towed sensor.
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Waterline

The purpose of this section is to define long-period changes in 
the vessel's draft due to fuel burn or other loading changes.
Specifically, you can enter the height of the waterline below the 
Reference Point.
If the Waterline section of the vessel configuration is not defined 
then the default of zero is used by the software as the height of 
the waterline below the RP. 
The Waterline section must be present in the HVF for use in 
sound velocity corrections.
1. Click Waterline in the Sensors list box so the selection is highlighted 

and the waterline data fields are displayed.

2. Type data (as needed) in the following fields:

Date: The year and Julian day of the current waterline time stamp.

Time: The hour and minute of the current waterline time stamp.

Waterline: The distance from the RP, positive when below the RP.

Apply: Select Yes to apply the waterline data in the merge process.

For Simrad data, the Waterline value must be set to the 
same value recorded as WLZ in the Simrad Installation 
Datagram. 

The Waterline value will only be used during Sound 
Velocity Correction.

The Apply switch must be set to “No”. It must not be set to 
“Yes”, because it must not be used by Merge.
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Total Propagated Error

This section defines the values for calculating Total Propagated 
Error (TPE). TPE is derived from a combination of all individual 
error sources. The TPE Configuration section of the vessel file 
contains the following errors (among others):
• nav/gyro/heave/pitch/roll/tide errors
• latency error estimate
• sensor offset error estimates.
These errors are combined with individual sonar model 
characteristics in the DeviceModels.xml file to calculate 
horizontal and vertical uncertainty values for every sounding 
along a track line when TPE is applied.
1. Expand the TPE section by clicking + icon.

2. Type data (as needed) in the Offsets section:

• MRU to Transducer: The physical offset in three dimensions from the 
motion recording unit to transducer 1 on the vessel. 

• MRU to Transducer2: The physical offset in three dimensions from the 
motion recording unit to transducer 2 on the vessel.

• Navigation To Transducer: The physical offset in three dimensions 
from the navigation antenna to transducer 1 on the vessel.

• Navigation To Transducer2: The physical offset in three dimensions 
from the navigation antenna to transducer 2 on the vessel.

• Transducer Roll: The mounting roll offset for transducer 1. The offset 
is positive when rotating the transducer away from starboard 
(starboard down).

• Transducer Roll 2: The mounting roll offset for transducer 2. The 
offset is positive when rotating the transducer away from starboard 
(starboard down).

3. Type data (as needed) in the Standard Deviation section:

• Motion Gyro: The measurement standard deviation of the heading 
data in degrees.

• Heave % Amplitude: An additional heave standard deviation 
component that is the percentage of the instantaneous heave. 

• Heave (m): The measurement for standard deviation of the heave 
data. Most heave manufacturers quote heave error as being 
determined from StaticHeave or PercentageOfHeave depending on 
which value is larger.

• Roll: The measurement standard deviation of the roll data in 
degrees.

• Pitch: The measurement standard deviation of the pitch data in 
degrees.

• Position Nav: The standard deviation associated with the 
measurement of positions for the vessel. This is usually the error of 
the GPS sensor being used.
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• Timing Trans: Standard deviation in transducer time stamp 
measurement.

• Nav Timing: Standard deviation in navigation time stamp 
measurement.

• Gyro Timing: Standard deviation in gyro time stamp measurement.

• Heave Timing: Standard deviation in heave time stamp 
measurement.

• Pitch Timing: Standard deviation in pitch time stamp measurement.

• Roll Timing: Standard deviation in roll time stamp measurement.

• Offset X: Standard deviation for the X measured offset on the vessel.

• Offset Y: Standard deviation for the Y measured offset on the vessel.

• Offset Z: Standard deviation for Z measured offset on the vessel.

• Vessel Speed: The standard deviation for the vessel speed 
measurements.

• Loading: Vertical changes during the survey because of fuel 
consumption, etc.

• Draft: The standard deviation in the vessel draft measurements.

• Delta Draft: The standard deviation in the dynamic vessel draft 
measurements.

• MRU Align StdDev Gyro: This value is the uncertainty of the motion 
recording unit placement within the vessel fixed coordinate frame.

• MRU Align StdDev Roll/Pitch: This value is the uncertainty of the 
motion recording unit placement within the vessel fixed coordinate 
frame.

• Comments: Any additional information.



3
SVP Editor

The SVP Editor helps you to edit existing SVP data, or to create new 
data.

In this chapter...
“SVP EDITOR INTERFACE” ON PAGE 578
“OPTIONS” ON PAGE 580
“SVP FILES” ON PAGE 582
“CREATE A NEW SVP FILE” ON PAGE 583
“EDIT SVP DATA” ON PAGE 585
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SVP Editor Interface

The SVP Editor is a separate program that is launched from 
HIPS and SIPS.

The Profiles area lists profiles contained in the SVP file. The 
profiles include a latitude and longitude position for applying 
the Nearest in Distance option. Below the Profiles section is a table of 
the depth/speed values for a selected profile. The left-hand side 
of the editor contains a graphical representation of the depth/
speed data.
The Depth Scale slider determines the view for the depth/speed 
graphed area by setting a maximum depth value. You can 
change the vertical display of data by dragging the slider.

Open an Existing File
1. Select the Open File command.
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The Open dialog box is displayed. All SVP files are located, by 
default, in ..\Hips\Svp.
2. Select an SVP file so it is highlighted, or type the file path in the File 

Name text box.

3. Click OK.

A list of profiles is displayed. Data in the first profile is displayed 
in the Profile Data table and the speed/depth graphed area.
4. To navigate between profiles, click the time stamps in the Profiles list 

box.



580 CARIS HIPS and SIPS User’s Guide

SVP Editor: Options

Options

You can select the colours used for the graphical display.
1. Select the Options command.

The Options dialog box is displayed.

Colour Options 2. Select a colour from the drop-down palette or create a custom colour 
from the standard Windows colour picker.

3. Click OK.

The display is refreshed to show the selected colours.
Draw points Show or hide the depth/speed data points in the graphical 

display.
4. Select the Draw Points check box.

If the box is checked, the data points are visible in the graphical 
display.
5. Click Apply to apply and save changes to the current file.

6. Click OK.

Show/hide tool tips A tool tip is a label containing the depth/time position for a data 
point in the graphical display. The label becomes visible when 
the mouse cursor is moved in the graphical display.
7. Select the Tool Tips check box to show or hide the tool tips.

If the box is checked, the depth/time labels are visible.
8. Click Apply to apply and save changes to the current file.

9. Click OK.

Show Julian date Switch the date fields in the SVP editor between the regular 
calendar format and Julian calendar format.
10.Make sure the Julian Date box is checked if you want to select this 

feature.
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11.Click Apply to apply and save changes to the current file.

12.Click OK to close the dialog box.

Show/hide toolbars

Display or hide a HIPS and SIPS toolbar.
1. Select the Toolbars command.

If there is a check next to a toolbar name, then that toolbar is 
visible. If it is not checked, the toolbar is not visible.

Show/hide Status Bar

Display or hide the Status Bar.
1. Select the Status Bar command.

If there is a check mark next to the Status Bar on the View 
menu, then the status bar is visible. It it is not checked, the 
status bar is hidden. 
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SVP Files

Sound Velocity Profile files are in text format and can contain 
more than one profile. SVP files are similar to one shown below.

The SVP file has the following characteristics (starting from the 
top):
• The section labelled [SVP_VERSION_2] specifies the version 

of the SVP file.
• The path and name of the file.
• A section heading for each profile. The section heading 

contains:
• the year and day (Julian date) that the profile was 

recorded
• time that the profile was recorded
• the latitude and longitude of the profile location.

• A list of depth/speed values.

[SVP_VERSION_2]

E:\HIPS\Svp\sampleSvp_v2.svp

Section 2000-198 22:37:00 47:15:04 -54:19:51

   1.00 1405.00

   5.00 1440.00

  10.00 1456.00

  15.00 1480.00

  20.00 1490.00

  25.00 1494.00

  40.00 1500.00

  70.00 1505.00

  130.00 1510.00

Section 2000-198 23:00:00 47:15:03 -054:19:52

   1.00 1408.00

   5.00 1430.30

  10.00 1440.56

  15.00 1456.00

  20.00 1475.00

  25.00 1485.00

  40.00 1500.00

  70.00 1550.00
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Create a New SVP File 

To create a new SVP file:
1. Select the New File command. 

2. Add new SVP profiles (see “CREATE NEW PROFILE” ON PAGE 583.) 

3. Create new depth/speed values, as needed.

4. Select the Save As command.

5. Type a name for the SVP file in the file name box.

6. Click Save.

The file is saved the directory you selected.

Create New Profile

New SVP profiles can be created through the SVP Editor.
1. Select the Add Profile command.

The Add SVP Profile dialog box is displayed.
 

2. Click the arrow buttons at the top of the calendar to select a month and 
year (all profiles must be time stamped).

3. Click a day button on the calendar to select a day for the file.

4. Enter the new hour/minute values (use the 24-hour clock) by clicking 
each section in the Time box and typing new values.

5. Enter latitude and longitude coordinates in the appropriate boxes, if 
needed.

6. Click Add to apply settings.

The new file information is displayed in the Profiles box.
If you are enter new speed/depth data, you must enter this data 
in pairs. There are two options for entering data:
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• separate the depth/speed data with a space: 15 1200
• separate the data with a comma: 15, 1200

Enter new depth/speed data
7. Click a profile to display the data in the SVP editor.

8. Type new depth and speed values in the text box beside the Add 
button.

9. Click Add.

10.Repeat Steps 1 through 3 until all necessary values are entered.
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Edit SVP Data

You can use the SVP Editor to modify existing speed/depth 
values, append new data to an existing file, delete data or delete 
a complete profile. 

Change depth/speed 
values 

Individual values in the depth/speed table can be changed.
1. Position the cursor over any Depth or Speed cell in the table.

2. Click inside the cell.

3. Type a new value.

4. Click outside the cell.

The table is changed to reflect the new data.
Edit geographic 
coordinates

Enter new latitude and longitude positions for SVP data. This 
information is important if you want to use the Nearest in Distance 
option for sound velocity correction (see “SOUND VELOCITY PROCESSING” 
ON PAGE 241).
1. Click a time stamp beside a profile.

2. Select the Edit Position command.

The Edit Position dialog box is displayed.

3. Click the latitude coordinates and type new ones.

4. Click the longitude coordinates and type new ones.

5. Click OK.

The new geographic coordinates are displayed in the Latitude and 
Longitude sections of the Profiles area.

Delete speed/depth 
data

1. Press and hold the mouse button, while dragging the cursor over the 
data points in the graphical display, or click a row number in the table.

The selected data is highlighted.
2. Select the Delete command.

The Speed/Depth data points are removed from the graphical 
display and the values are no longer displayed in the table.

Remove Profiles Remove a currently open profile from the SVP editor.
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1. Select a profile by clicking the time stamp in the Profiles list box.

The depth/speed values are displayed in the editor.
2. Select the Remove Profile command.

The profile is removed from the editor.
3.

Exit SVP editor

Close the SVP Editor.
1. Select the Exit command.

2. If you have not saved any changes you are prompted to do so.

The SVP Editor is closed.

M
en

u Edit > Remove 
Profile

K
ey <Ctrl+Delete>

M
en

u

File > Exit



4
 Tide Editor

Use the Tide Editor to create or edit tide files. Tide data is used to 
generate final depths relative to the tide datum by subtracting the tide 
from the sounding depth.

In this chapter...
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Open Tide Editor

The Tide Editor presents tide file information in both graphical 
and tabular formats. You can use the editor to edit an existing 
file or to create a new tide file to apply to survey lines before the 
Merge process.
Tide files are located by default in …\Hips\Tide and have a .tid 
file extension. 
To open the Tide Editor: 

1. Click on the Tide Editor button in the Tools toolbar , 

or select the Tide Editor command from the menu in the HIPS and 
SIPS interface.

1. Select an Open command to display the Open dialog box. 

2. Select a tide file and click Open, or type the file name and path in the 
field. 

The selected tide file is displayed in the editor. The graphical 
display shows a tide versus time graph of the data. Tide-level 
values are represented on the vertical axis. Time is represented 
on the horizontal axis. The tide data is also displayed in a table 
below the graphical display.
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Adjust tide scale To control the vertical scale of the graphical display: 
• Move the Tide Scale slide bar to select a range for the height of 

the vertical tide axis.
Adjust time interval Change the horizontal scale by adjusting the Time Interval 

setting. 
• The day option lets you view data by 24-hour increments.
• The hour/minute option lets you view data in increments of 

less than 24 hours.
1. Click the Day arrow buttons to select the range of days for displaying 

data.

2. If the Day value is set to zero then move the slide bar to select the 
minute/hour range for the display of data.

The display of tide data is adjusted for the new time interval 
along the horizontal axis.

Save a tide file Save changes to an existing tide file.
1. Select the Save command.

The file is saved with the changes.
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Editing Tide Data
Edit table data Edit data in an existing tide file.

1. Select a Date/Time/Tide cell in the tide table.

The cursor is displayed in the cell.
2. Remove the existing data and type a new entry.

The graphical display refreshes to show the new data.
Delete a tide entry 1. Press and hold the mouse button while dragging the cursor over data in 

the graph, or click the appropriate number cell in the tide table.

The data is highlighted.
2. Select the Delete command.

The tide data is removed from the graphed line and the table.

Search time gaps Tide gauges, recording tidal height observations, may be subject 
to occasional outages resulting in gaps in the tidal time series. 
The time gaps option lets you search for these gaps. You can 
enter new data, if needed.
1. Select the Options command.

The Options dialog box is displayed.
2. Select the General tab if it is not already displayed.

3. Enter a value (in minutes) in the Time Gaps box.

4. Click OK.

5. Select the Next Time Gap command.

When the interval (in minutes) between adjacent data points is 
the same as, or greater than, the Time Gaps value, the adjacent 
data points are highlighted.
6. Repeat the process, if necessary, by selecting the Next Time Gap 

command for each tide data point on the graphed line.

You can enter new data between two values.
Enter new data Enter data for a new or existing tide file.

1. Select the Add Tide command.

The Add Tide dialog box is displayed.
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2. Change the date (if necessary) by clicking the arrow buttons at the top 
of the calendar until you have selected the desired month and year.

3. Click the appropriate day button on the calendar.

The selected date (year and day) is displayed below the calendar.
The default time is the time of the currently selected tide record.
4. Click any of the three sections (00:00:00) in the Time box so they are 

highlighted and type the desired time (use the 24-hour clock).

The Input Interval option lets you quickly enter a series of tide 
values at a regular time interval, using the <Enter> key. You do 
not need the mouse to move the cursor between fields.
5. If you want to regularly increment the times for tide data, click the Input 

Interval check box.

6. Enter the minutes that the time value is to be incremented.

7. Enter a tide value.

8. Click OK.

The new tide data is displayed in the editor. If you selected the 
Input Interval option, the time is incremented by the value set in 
the Input Interval box.
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Create a New Tide File 

You can create new tide file. 
1. Select the New command.

Any tide file that is currently open in the editor is closed.
2. Select the Add Tide command and type a new tide entry (see “ENTER 

NEW DATA” ON PAGE 552).

The data is displayed in graph format in the editor.
3.  Repeat until all values are entered.

4. When ready, select the Save or Save As command.

The Save As dialog box is displayed.
5. Type a name for the file and click OK.
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Options

You can adjust the colour display of graphical data.
1. Select the Options command.

The Options dialog box is displayed.

Colour 2. Select a colour from the drop-down colour palettes, or create a custom 
colour from the standard Windows colour picker.

3. Click Apply to apply and save the settings for the project.

4. Click OK to close the dialog box.

The display is now refreshed to show the selected colours.
Show/Hide tide points 1. Select the Options command.

The Options dialog box is displayed.
2. Select the Draw Points check box.

When the Draw Points check box is selected, the data points are 
visible.
3. Click Apply to apply and save the settings for the project.

4. Click OK to close the dialog box.

Show/Hide tool tips A tool tip is a label that displays a specific tide level on the 
graph, when the cursor is positioned over it. You can show or 
hide tool tips.
1. Select the Options command.

2. Select the Tool Tips check box. If this option is checked then it is 
enabled.

3. Click Apply to apply and save settings for this project.

4. Click OK to close dialog box. 

Set date display The date in tide file table can be displayed in either Julian Day 
format or regular calendar format.
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1. Select the Options command.

The Options dialog box is displayed.
2. Click the Julian Date box, if the box is checked, this option is selected.

3. Click Apply to apply and save settings for this project.

4. Click OK to close dialog box

Show/Hide toolbar Display or hide the toolbar.
1. Select the Toolbar command.

2. Click the Toolbar menu item. When the check mark is displayed, the 
toolbar is visible.

Toggle status bar Display or hide the status bar.
1. Select the Status Bar command.

2. Click the Status Bar check box. When the check mark is displayed, the 
status bar is visible.
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Exit the Tide Editor

Close the Tide Editor.
1. Select the Exit command.

You are prompted to save any unsaved changes.
2. Click Yes to save the changed file.

The Tide Editor is closed. 
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Navigation Editor Interface

The Navigation Editor lets you examine and clean the position 
data for both the ship and towfish.
1. Select a track line.

2. Select the Navigation Editor command.

The Navigation Editor is displayed in the HIPS&SIPS interface.
 

The Navigation Editor shows the track lines as a series of 
continuous symbols, with each point representing a navigation 
fix. The CARIS feature code used to represent the navigation 
symbols is selected in the Options dialog box (see “GENERAL” ON PAGE 
657).
The editor contains three time-series graph views of information 
that is calculated between points in the recorded navigation 
data:
• Speed: Calculated speed.
• Distance: Calculated distance.
• Course Made Good: Calculated direction (in degrees) from 

one navigation fix to the next.
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Display Properties

Display of various aspects of the data in Navigation Editor is 
controlled by the properties options on the Navigation Editor tab 
in the Control window.

The amount of data displayed in the three graph views is 
determined by the number of navigation points visible in the 
Display window.

Resize data points The point symbols can be resized to a maximum of 10 pixels.
1. In the Control window, select the Navigation tab.

2. Click the up or down arrow buttons beside the Point Size box to change 
the size of the symbols.

The view in the Display window is refreshed so the navigation 
data is shown in the new point size.
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Time Stamps Display lines to represent time stamps in the Navigation Editor 
windows. The time stamp interval is displayed in seconds and 
can be changed.
1. Select the Time Stamp check box to display time stamp lines.

2. Click the up or down arrow buttons beside the Interval to select the gap 
(in seconds) between time stamps.

Set minimum/maximum 
of line

When this option is selected the vertical scaling of the graphs 
fits the maximum and minimum range of values for the entire 
line. Otherwise the vertical scaling of the graphs fits the max-
min range of the data currently in view.
1. Open the Control window.

2. Select the Navigation tab.

3. Select the Max-Min of Line check box.

Number of points 
displayed

This option determines the number of points visible in the 
Display window. 
• When Manual is selected, use the zoom tools to determine how 

many navigation points are visible in the Display window.
• When Fixed is selected, a set number of points are displayed in 

the window.
1. Open the Control window.

2. Select the Navigation tab.

3. Select either the Manual or Fixed check boxes (Manual is selected by 
default).

4. If you selected the Fixed check box, enter the number of navigation 
points to be displayed by clicking the up or down arrow buttons.

Connect points Join the displayed navigation point symbols with a line 
representing the current interpolation method.
1. Open the Control window.

2. Select the Navigation tab.

3. Select the Connect Points check box.

The navigation points are connected by line drawn according to 
the current interpolation method of the line.

Gyro indicator line A gyro indicator line that shows vessel heading can also be 
displayed in the Navigation Editor. This feature is useful for 
detecting dramatic changes in heading that could effect data 
acquisition.
1. Select the Gyro Indicators check box to display the gyro line in the 

Display window.

2. Click the up or down arrow buttons to select the size (in pixels) of the 
gyro indicator line.

3. Select a colour for the line from the Colour picker, or create a custom 
colour using the standard Windows Colour Palette.
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Attitude Editor 

The Attitude Editor displays sensor data related to the 
movement of a vessel or towed sensor. It also displays data from 
other auxiliary sensors that use a simple time/value data model. 
The data is plotted in chronological order and is time stamped. 
You can edit data directly in the editor or set filter parameters to 
reject unwanted data.

Attitude Editor Interface

The Attitude Editor is displayed in the HIPSand SIPS interface. 
To open the Editor:
1. Select a track line so it is highlighted.

2. Select the Attitude Editor command.

The Attitude Editor is displayed(as shown below). You can open 
the Attitude Editor while the Swath Editor is active and 
examine attitude and sounding data at the same time (see “SWATH 
EDITOR” ON PAGE 201).

The Project-Vessel-Day directory and file name of the selected 
track line is displayed on the title bar.
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Data is graphed in the windows according to an X-Y axis. In the 
default layout, the X-axis represents time and the Y-axis 
represents data.
By default, the following data is displayed in the editor:
• Gyro: Gyro observations are displayed in degrees from 

positive 1 to 360.
• Heave: Heave observations are displayed according to the 

Units setting in the Options dialog box and are positive as the 
vessel moves upward.

• Pitch: Pitch observations are displayed in degrees and are 
positive when the bow is down.

• Roll: Roll observations are displayed in degrees and are 
positive when the starboard side is up.

However, this is not the only data that can be displayed in the 
editor. All sensor data in HIPS/SIPS format can be displayed 
except for depths, navigation, and side scan data.
Besides the above sensors, the following sensors can be 
displayed (if available):
• loaded tide
• side scan gyro
• side scan cable out
• side scan depth
• side scan height
• delta draft
• GPS height
• GPS tide
• speed on water
Applanix’s MS POV systems calculate TrueHeave values from 
real-time heave values. The computed TrueHeave data and real-
time heave values are stored in a binary file that is not 
converted to HIPS/SIPS format when other data is imported. 
These files have to be separately loaded to the track line. For 
more information, see “TRUEHEAVE DATA” ON PAGE 287.
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Display Options
Show/hide sensor data You can control which attitude sensors are displayed.

1. Select the Sensor Layout command.

The Sensor Layout dialog box is displayed.

2. To remove a sensor from the Active Sensors list, select the sensor and 
click Remove.

3. To add a sensor to the Active Sensors list, select a sensor from the 
Available Sensors list and click Add.

4. Set the order that sensor windows are displayed by selecting a sensor 
and clicking the up or down arrow buttons, or by selecting the sensor 
and dragging it to a new position.

5. Click OK to apply settings.

The Attitude Editor is displayed according to the selected 
settings.
The display of data in the Attitude Editor windows is controlled 
through the Attitude Editor tab in the Control window. This tab 
is visible when the Attitude Editor is opened.
1. Open the Control window.

2. Select the Attitude Data tab if the tab is not already displayed.
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Time

By default, time is displayed on the X-axis. As the time scale is 
increased, more data is displayed in the graphs. As the time is 
decreased, less data is displayed.
3. Click the up or down arrows beside the Time Period box to set time in 

minutes and/or seconds.

4. Select the Time Stamp check box to display the time stamp in the 
windows.

5. Click the Time Interval up or down arrow buttons to select an interval 
for time stamp display.

The display in all graphs is adjusted to the new time setting.
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Scale Data

By default, the data scale is shown on the Y-axis. The scale of 
the data axis can be based on the minimum and maximum 
values of data in the entire line, the minimum and maximum 
values of the data currently in view, or by a user-defined axis.
1. Select a sensor from the Data list.

2. Select from one of three scaling options:

• Select Max-Min of Line to scale data according to the minimum and 
maximum data values of the entire line.

• Select Max-Min of View to scale data according the minimum and 
maximum values currently in view.

• Select User-defined Max-Min to define maximum and minimum 
scale and type the values in the maximum and minimum fields.

Vertical view

The Vertical option switches the data graph windows from a 
horizontal layout to a vertical layout. In this mode, the X-axis 
represents the data values and the Y-axis represents time.
1. To view the Attitude Editor in vertical mode, click the Vertical check 

box.

The Attitude Editor windows are displayed in vertical mode.

Other Display Options
Invert view The Invert command displays the data in a “mirror-image” view. 

This function is useful for viewing towfish depth in the water 
column.
1. Select an attitude data type in the Data list.

2. Select the Invert command.

The data is shown as inverted in the appropriate section.
Draw bars The Draw Bars function displays vertical bars for each sensor 

value in the graphs. This option makes it easier to see time gaps 
between sensor values.
1. Select the Draw Bars check box in the Attitude Data tab of the Control 

window.

The Smooth/Filter Line, Difference and Threshold options are 
described in the Shows Graphs section of “SMOOTH DATA” ON PAGE 192
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Colour Display

The colour for displaying the various graph lines can be changed.
1. Select the Options command.

The Options dialog box is displayed.
2. Click the Display tab and click the Sensor Editors category so it is 

highlighted.

3. Select a colour for the sensor filter line from the drop-down colour 
palette, or create a custom colour from the standard Windows colour 
picker.

4. Click OK.

See “DISPLAY” ON PAGE 80 for more information on colour options for 
the Attitude Editor.

M
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Tools > Options



614 CARIS HIPS and SIPS User’s Guide

Attitude Editor: Attitude Editor

Smooth Data

The Smooth Sensor function is used to smooth out localized 
variability. Any sensor data that can be viewed in the Attitude 
Editor can be smoothed.
Below is an example of GPS height and tide. 

The blue line represents the original data and the yellow line 
represents the smoothed data. The parameters for creating the 
smoothed data are saved to the SmoothedCoefficients file in the 
HCDS_Data\Project\Vessel\Day\Line folder. The file is in 
XML format. This file is applied to the track line during the 
merge process and SVP Correction.

Moving Average and 
Fast Fourier Transform

There are two methods available for smoothing: Moving Average 
and Fast Fourier Transform (or FFT). 
• The Moving Average function calculates an average sensor value 

over a window of data using the Box Size parameter. The 
window is defined as a number of data points or seconds 
centred on a point. The average value for all of the values in 
the window is calculated and will be given to the central 
point. 

• The Fast Fourier Transformation performs a low-pass filter on the 
selected sensor. You select a Box Size in either points or 
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seconds. This value is converted into seconds and then 
inverted to become the cut-off frequency. Increasing the Box 
Size results in greater smoothing.

Box size The Box Size (Step 6) determines how many neighbouring data 
points are used in the smoothing calculation. The number of 
neighbouring data points can determined using time or a set 
number of points.
Note the different ways the Moving Average and the FFT use 
the Box Size parameter. The Moving Average function uses the 
Box Size to determine the window that is used to calculate the 
average for the new “smoothed” centre point. The FFT algorithm 
uses the Box Size to define the cut-off frequency that is then 
applied to all data.
In the following example, the box size is set to five data points. A 
FFT value or mean for any data point is calculated from itself 
and ‘the two data points on either side of it (if available).

1. Make sure that the Control window is open and the Attitude Data tab is 
visible.

2. Select a sensor in the Data list box, or click inside a sensor window in 
the Attitude Editor.

3. Select the Smooth option.

4. Select either the Moving Average or Fast Fourier smoothing options.

5. Select either the Points or Seconds check boxes.

6. Click the Box Size up or down arrow buttons to select the number of 
adjacent data points or a time range.

Box Size = 5

FFT value or mean calculated for data point

Adjacent data points used for calculation of value
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Show graphs 7. Show any of the four graphs by selecting the appropriate check boxes:

• Data graphs the raw sensor data. This box is checked by default.

• Filter/Smooth Line graphs the computed values derived from the 
adjacent data points as described above.

• Difference graphs the difference between the original data values 
and the moving average or FFT value for each data point.

• Thresholds display horizontal lines in the graph indicating the 
difference values that are clipped during smoothing. Threshold is a 
multiple of the standard deviation (sigma).

The upper threshold signal is determined by the following 
formula: 

original mean value + (threshold value X the 
standard deviation)

The lower threshold signal is determined by the following 
formula:

original mean value - (threshold value X the 
standard deviation

The smoothing function applies the results only to the Data 
graph and Filter/Smooth Line graph.
The line is smoothed according to the parameters set above. 
When you close the Attitude Editor, you are prompted to save 
any changes. This saves any smoothing changes to the 
SmoothedCoefficients file.
8. Click Yes to save smoothed data.



6
Subset Editor

The Subset Editor is a tool for viewing and editing georeferenced 
sounding and lidar data. 

In this chapter...

“SUBSET EDITOR INTERFACE” ON PAGE 619

“SIZE AND RESIZE SUBSET” ON PAGE 621

“THE 3D VIEW” ON PAGE 626

“SUBSET EDITOR TAB” ON PAGE 623
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Overview

The Subset Editor differs from the Swath Editor in that 
soundings no longer have only an across-track and along-track 
relationship—but once corrected for navigation, vessel heading 
and other auxiliary sensors,  each sounding has a latitude and 
longitude value attached to it.
With the Subset Editor you can:
• view data in a three-dimensional mode so features such as 

depressions and rises are visible.
• rotate data to view it from different angles.
• view BASE Surface areas in the 3-D window.
• view and edit CUBE surfaces, using subset tiles to track the 

areas that have been completed.
• flag soundings as needed to status of:

• rejected
• accepted
• outstanding
• examined
• designated.

“DESIGNATED SOUNDINGS” ON PAGE 207.
“SUBSET CLEANING” ON PAGE 410
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Subset Editor Interface

Open Subset Editor

Track lines should be merged before the Subset Editor is opened.
1. Select the Subset Editor command.

The cursor changes shape.
2. Press and hold the mouse button, and drag the cursor across the area 

of the Display window where you want to create the subset.

As the cursor is dragged across the Display window, a bounding 
box is drawn to show the subset area. 

Subset bounding box

3. Select the Load Subset command. 

The subset is generated and displayed in the Subset Editor 
windows. Below is an example of HIPS and SIPS with the 
Subset Editor open.
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The Subset Editor has the following components:
• Subset bounding box: The bounding box selects an area 

where the subset is generated. Each time the box is moved or 
resized, a new subset is generated. The yellow 2D slice box 
defines the area to appear in the 2D window.

• The 3D View: The 3D (three-dimensional) View shows all 
soundings in the subset area. The view in the window can be 
rotated or changed.

• The 2D View: The 2D (two-dimensional) View displays 
soundings from the subset area that are within the 2D slicing 
box.
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Toolbar

Subset Editor commands can be accessed from the toolbar. This 
floating toolbar is automatically opened when the editor is 
started. (If it is not visible when the Subset Editor is opened, the 
View > Toolbars > Subset Editor command can restore it. 
It can moved and docked like other toolbars (see “MODIFY EXISTING 
TOOLBARS” ON PAGE 28).
 

Size and Resize Subset

The size of the subset is determined by the bounding box. As the 
bounding box area is changed, a new subset is generated and the 
displays in the 2-D and 3-D Views are refreshed to show the new 
area.
Below is an example of the subset bounding box. Note that the 
shape has been altered for display purposes and does not match 
the box shape as it is first shown in the interface.

To resize the subset areas:
1. Position the cursor over any of the balls at the corners of the boxes.

2. Press and hold the mouse button and drag the ball. 

3. As the ball moves with the cursor, the box is resized to a new area.

Show 2D 
Complete

Incomplete

Partly Complete

Clear

Show 3D 

Nominate

Reject

Accept
View

View

Reject Node

Accept Node

Load Subset

Lock

The 2D slice box 
determines the area that 
is displayed in the 2D 

Subset View.

The 3D bounding box 
determines the subset 
area. The area inside 
this box is displayed in 
the 3D View.

The arrow helps maintain 
a sense of direction 
when the subset is 
rotated.
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You can also move the 2-D Subset slice up or down in the 
bounding box by pressing the arrow keys. The arrow at the top of 
the box shows the direction of the 2-D slice when the up arrow 
key is pressed.
When the box is resized, a new subset is generated.
To rotate the subset:
1. Press and hold the <Ctrl> key.

2. Position the cursor over any of the corner balls of the box.

Press and hold the mouse button to rotate the bounding box to the desired 
angle.

Auto load subset The Auto Load Subset option automatically loads subset data in the 
3-D and 2-D Views when a subset area is created or changed. To 
create or adjust a subset area without immediately loading data, 
turn this option off.
1. In the middle section of the Subset Editor tab, select or clear the Auto 

Load Subset check box to turn this option to on or off (the default status 
is selected).

2. If you de-selected the Auto Load Subset option and want to load data 
manually, draw the subset and select the Load Subset command.

The Lock option locks the subset area so you do not accidentally 
resize or move the subset while moving it in the Display window. 
A new subset cannot be created while the lock is active.
1. Select the Lock command after creating a new subset or resizing a 

existing one.

The subset area is now locked into place and cannot be adjusted 
until the lock is removed.
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Subset Editor Tab

The Subset Editor tab is opened in the Control window when the 
Editor is started. The tab controls the data properties for the 
data layers in the Editor. 

The top part of the tab are the layers representing the data 
types. When you select a layer, the bottom part of the tab is 
refreshed to display the controls for the data properties for that 
layer. 
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The check boxes beside the layers control the display of data in 
the 3D and 2D Views. When the check boxes are selected and the 
layers are highlighted, data associated with that layer are 
shown in the 3D Display. When the check boxes are cleared, the 
data is no longer displayed.
The following layers are listed in the Subset Editor tab:
• HIPS Data: This layer controls the properties for sounding 

selection and display. The 3D and 2D sublayers control the 
display in their respective views.
For more information on the controls related to these layers, 
see the following sections:
• “VIEW SUBSET INFORMATION” ON PAGE 624.
• “COLOUR OPTIONS” ON PAGE 625

• “THE 3D VIEW” ON PAGE 626

• “THE 2D VIEW” ON PAGE 630

• Reference Surface: This layer controls the properties 
related to the display of BASE Surfaces in the 3D View of 
Subset Editor. For more information related to this layer, see 
the following section:
• “SUBSETS AND BASE SURFACES” ON PAGE 339.

• CUBE Hypothesis: This layer controls the display and 
editing properties related to CUBE data. For more 
information related to this layer, see the following section:
• “HYPOTHESIS EDITING” ON PAGE 266.

• Tracking: This layer controls the properties for subset tiles. 
For more information on the controls related to this layer, see 
the following section:
• “TRACKING LAYER PROPERTIES” ON PAGE 336.

View Subset Information

Each time a subset is generated, the following information is 
shown in the middle section of the Subset Editor tab:
• total soundings in the current subset
• total memory used by subset
• total accepted soundings
• total rejected soundings
• width
• height
• minimum depth level
• maximum depth level
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Colour Options

You can control how soundings are displayed in the subset.
1. Make sure the Control window is open.

2. In the Properties > Colours section of the Subset Editor tab, open the 
drop-down list in the Attribute field.

3. Select one of the following attributes from the drop-down list to colour 
code soundings:

• Depth: The recorded depth level of the soundings.

• Amplitude: Backscatter intensity values.

• Depth Uncertainty: The vertical uncertainty values accorded to 
soundings.

• Position Uncertainty: The horizontal uncertainty values accorded 
to soundings.

• IHO S-44: The S-44 Survey Order ranking applied to soundings.

• IHO S-57: The S-57 Zones of Confidence (CATZOC) attributes 
ranking applied to soundings.

• Project: The project where the data was saved.

• Vessel: The vessel(s) used on the survey.

• Day: The day the sounding data was recorded.

• Line: The track line in the project.

• Amplitude: The sonar’s wave pattern.

• Detection Method: The phase detection method.

Colour Map You can represent a range of values using a colour map. The 
colour ranges can be applied to other subsets so you have a 
standard colour code for displaying data. 
• The colour at the top end of the selected map represents the 

minimum value (and all values less than the minimum 
value). 

• The colour at the bottom of the map represents maximum 
value (and all values greater than the maximum value).

• The colours in between the minimum and maximum colours 
represent the depths and uncertainties between the defined 
range.

4. To set a minimum and maximum values, select these two check boxes 
and type the values in the respective fields. If these values are not set, 
then they are automatically read from the subset.

5. [Optional] Select the Reverse Colours check box to reverse the order in 
the colour map.    

The display in the Views is refreshed to show the subset in the 
selected colours.
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The 3D View

The 3D View displays the entire subset. You can use this view to 
examine and clean data.
1. Select the 3D View command to open the 3D view window.

All controls for the 3D View are contained in the 3D View sub-
layer of the Subset Editor tab. 
1. Click the Expand ( + ) icon beside the HIPS Data layer and select the 

3D View sub-layer in the Subset Editor tab.

The properties for the 3D View are displayed in the Data Display 
area below.

3-D Subset Display The Type of Data Display selected will determine the soundings 
that will be shown in the 3-D View: 
1. Select the display type from the list.

• Points 
• Spheres
• Cylinders
• Surface
• Surface Wireframe

The 3-D View is refreshed to show the soundings according to 
the selected display type. The options for each display type is 
explained in the following table. 
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Display Type Definition Options

Surface The soundings are shown as a smooth 
surface.

Soundings are drawn to the 3-D View either by 
selecting the shoalest sounding in a user-
defined area (or bin), or by selecting all 
soundings.

1. Select the Shoal Bin Size to select the shoal-
est sounding in an area (bin), or select 
Use All Points to display every sounding.

2. If you selected the Shoal Bin Size option, type 
the size of the area for selecting the shoalest 
sounding.

3. Click Regenerate.

Surface Wireframe The soundings are shown as a 
Triangulated Irregular Network (TIN) 
that connects soundings.
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Points Soundings are shown as unconnected 
points. 

3D Dynamic Skip option determines how many 
sounding profiles and beams are displayed. For 
example, the value 6 means that only every 6th 
profile and 6th beam are shown in the view.

1. Select a skip value by clicking the up or down 
arrow buttons, or directly typing a value in the 
3-D Dynamic Skip field.

2. Click Regenerate.

Spheres Soundings are shown as unconnected 
spheres.

Cylinders Soundings are shown as cylinders. If 
the soundings contain horizontal and 
vertical uncertainty values, then the 
cylinders are sized according to those 
values. For example, soundings on the 
outer edge of a swath have a larger 
radius than soundings on the inner 
edge because of the greater horizontal 
uncertainty. Soundings without TPU 
values are drawn to a set size.

Display Type Definition Options
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Controls

Rotation, illumination 
and exaggeration 
options

The compass (or control axes) rotates the view, the sun dial 
controls adjust illumination, and the slider controls vertical 
exaggeration.

2. Select or clear the Compass, Lighting and Exaggeration check boxes 
to show or hide these controls in the 3D View.

Shading Darkens the image in the 3-D View.
3. Select the Shading check box.

Symbolize Critical 
Soundings

Display soundings with Outstanding, Critical and Designated 
flags.
4. Select the Symbolize Critical Soundings check box.

Overview Reset the View so the entire subset area is visible (default).
5. Click Overview.

Show subset outline Display an outline of the subset bounding box.
6. Select the Show Subset Outline option. When this option is checked, 

the outline is displayed in the 3D View.

Show 2D slice Display an outline of the 2D slice area.
7. Select the Show 2D slice option. When this option is checked, the 2D 

slice outline is displayed in the 3D View.

Allow rotation under 
data

This option rotates the 3D display by 180º to view soundings 
underneath the subset. When this option is not selected, the 
subset can only be rotated by 90º.
8. Select the Allow Rotation Under Data option to rotate the subset display 

by 180º.

Compass

Lighting control

Slider
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Wireframe colours Select a colour to display 3-D and 2-D outline in the 3-D View.
9. Select a colour from the picker, or click Other and create a custom 

colour from the palette.

Pan and zoom The pan, zoom and rotation functions are the same as in the 3-D 
View in the Swath Editor. See “PAN AND ZOOM” ON PAGE 652 for more 
information.
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The 2D View

The 2D View displays a profile of soundings within the 2D 
slicing box. You can use this view to examine and clean data.
The location and size of the cutaway view is determined by the 
size of the 2D slice box (see “SIZE AND RESIZE SUBSET” ON PAGE 621). As 
the slice box is re-sized or moved to another position in the 
subset, the display in the 2DView changes accordingly.

1. Select the 2D View command to display data in the 2D View window.

All controls for the 2D View are in the 2D View sub-layer in the 
Subset Editor tab.
2. Click the Expand ( + ) icon beside the General layer and select the 2D 

sublayer in the Subset Editor tab.

The 2D View tab contains the following information:
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• number of soundings in the 2D slice
• dimensions of the slice (height x width)
When the 2D slice bounding box is resized, the information in 
the tab is refreshed with new data.

Change view 
perspective

When the 2D View is first displayed, the view perspective is 
determined by the dimensions of the 2D Slice Box.
• If the height of the slice box is greater than the width, the 

view is automatically shown from the left side.
• If the width of the slice box is greater than the height, the 

view is automatically shown from the bottom.
3. Select any of the following options from the View Perspective drop-

down list to change the view angle:

• top (view data from the front of the slice box)

• right (view data from the right side of the slice box)

• centre (view data from above the slice box)

• bottom (view data from the back of the slice box)

• left (view data from the left side of the slice box)

The 2D View is refreshed to show the data from selected angle. 
4. To return to the default view, select Automatic from the drop-down list.

2D vertical exaggeration The vertical exaggeration is the ratio of the vertical scale versus 
the horizontal scale. You can set the vertical exaggeration scale 
with the vertical exaggeration scale in the 2D View.
1. Position the cursor over the ball on the vertical exaggeration scale.

2. Press and hold the mouse button, and move the ball up or down the 
scale.

3. To change scale values, click the arrows at either end of the vertical 
exaggeration scale in increase or decrease the scale by a value of 10. 

As you move the ball, the data in the 2D View is rescaled.
The Auto Exaggeration option determines the scale automatically by 
using all visible depths.
When Auto Exaggeration mode is on, the Include Rejected option 
controls whether or not the rejected data is used to determine 
the minimum and maximum sounding depth to be displayed in 
the 2D View.
4. Select the Auto Exaggeration check box.

5. Select the Include Rejected option to resize the display in the view to 
include rejected data.

The 2D View is adjusted to display data according to the 
maximum and minimum settings.

Display options The display can also be modified to draw sounding values in the 
View and display a grid with depth and distance values.
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1. Select the Show Sounding Digits check box to draw sounding values in 
the View.

2. Select the Show Graticule check box to display a grid representing depth 
and distance. If the Show Graticule check box is cleared, the grid is 
removed from the 2-D View, but the values representing distance and 
depth are still displayed. The vertical scale represents depth and the 
horizontal scale represents distance. The values shown in the 2D View 
are determined by the display option:

• If the top/bottom/left/right display options are selected, both the 
depth and distance are shown.

• If the centre display option is selected, distance in both directions 
are displayed.

Move 2-D Display You can move the 2-D Slice box within the subset with the arrow 
keys.

1. Press the arrow keys to move the 2-D Slice Box within the subset.

2. Select an Overlap Percent to determine how much of the 2-D Slice Box 
overlaps the previous area in the 2-D View when the box is moved.

Pan and zoom options The pan and zoom functions are the same as in the 3D View in 
the Swath Editor. See “PAN AND ZOOM” ON PAGE 652 for more 
information.
You can also pan in the Subset Editor Views by clicking on a 
sounding with the middle-mouse button. This will shift the 
subset so that the sounding is centred in the View.
To return the display in the View to original setting before zoom 
and pan operations, click Overview.

Measure Distance

You can use the Measure Distance tool in the 2-D and 3-D Views 
to evaluate data problems, such as timing offsets, heave 
problems, etc.
1. Select the Measure Distance command.

A ruler icon is displayed next to the cursor.

The 2-D Slice Box is moved up as the up arrow key is 
pressed.

M
en

u Tools > Measure 
Distance

To
o

l



CARIS HIPS and SIPS User’s Guide 633

Subset Editor: Subset Editor Tab

2. Press and hold the mouse button and drag the cursor along the 2-D 
View or 3-D View. To maintain a straight horizontal line, press and hold 
the <Shift> key while drawing the line. To maintain a straight vertical 
line, press and hold the <Ctrl> key while drawing the line.

As the cursor is dragged across the View, a line is drawn from 
the start point to the point where the mouse button is released. 
The distance between the two points is shown along the line.

Close Subset Editor
1. Select the Subset Editor command.

2. If changes were made to the data, you are prompted to save them.

When data in the Subset Editor is changed and saved, the 
ProcessedDepths and ObservedDepths files are updated to 
reflect the changes.
3. Click OK to save changes.

The Subset Editor is closed and no longer visible in the HIPS 
interface.
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8
Swath Editor

The Swath Editor provides data-cleaning tools for multibeam data, multi-
transducer data and Lidar data.

You can also use the Swath Editor to flag Designated Soundings 

IN THIS CHAPTER...

“SWATH EDITOR INTERFACE” ON PAGE 636 

“SWATH EDITOR DISPLAY OPTIONS” ON PAGE 640

“EXAMINING SWATH DATA” ON PAGE 643 

“EXAMINE DATA IN THE 3-D VIEW” ON PAGE 648
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Swath Editor Interface

A track line must be selected before the Swath Editor editor can 
be opened (see “SELECT SURVEY LINES” ON PAGE 123). 
1. Select the Open Swath Editor command.

The Swath Editor opens with all views displayed. The Project-
Vessel-Day directory and file name of the selected track line is 
displayed on the title bar.
The main Swath Editor display is the 3-D View. The image 
below shows the default layout for the Swath Editor windows.

The Swath Editor consists of six views:
• Plan View
• Side View
• Rear View
• Profile View
• 3-D View (Swath Editor Display)
• Amplitude View
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Views can be displayed, hidden or positioned anywhere on the 
interface. They can also be adjusted to any size you want. 
(See “REPOSITION AND RESIZE WINDOWS” ON PAGE 26). The layout of the 
views is remembered by the application when you exit HIPS.
If the dataset contains side scan data, you can also open the Side 
Scan Editor while the Swath Editor is open (for more 
information on the Side Scan Editor, see “INTRODUCTION” ON 
PAGE 384).
The tabbed pages in the Control window set the various Swath 
Editor features.

Toolbars The display of the views is controlled from the Swath Editor 
toolbar.

This is a floating toolbar that is automatically displayed when 
the editor is opened. The toolbar can be docked or floated over 
any area of the interface. Its appearance is controlled from the 
Toolbar dialog box (see “MODIFY EXISTING TOOLBARS” ON PAGE 28).
To close the Swath Editor 

1. Click the Swath Editor tool button again. 

All Swath Editor views close and you are prompted to save any 
changes.
2. Click OK to save changes.

Plan View

Rear View

Side View

Profile 

Amplitude
3-D View Port&Starbord Beams 

Port Starboard 
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Plan View

The Plan View presents an overhead view of the swath profiles 
and beams. All profiles are spaced equally in the along-track 
direction. Across-track beam spacing is to correct scale. Each 
beam is represented by a square.
1. Select the Plan View command.

The number of swath profiles displayed in the Plan View is 
determined by three factors:
• height of the view
• point size of the beams
• distance (in points) between swath profiles (see “DATA DISPLAY IN 

VIEWS” ON PAGE 639)

You can apply a number of colour options:
• colour by port and starboard beams (see “SWATH EDITOR” ON 

PAGE 672) 
• colour by sonar detection method (not supported by all 

sonars) (see “SWATH EDITOR” ON PAGE 672)

• colour by depth interval (see “COLOUR BY DEPTH” ON PAGE 642)
• sun illumination (see “LIGHTING CONTROL” ON PAGE 651).

Rear View

The Rear View presents the survey as seen from behind the 
vessel. Each line represents one swath. 
Select the Rear View command.

Side View

The Side View presents the survey as seen from the side of the 
vessel with the vessel travelling from left to right. Each line 
represents soundings from the same beam.
1. Select the Side View command.

You can change the display (see “DATA DISPLAY IN VIEWS” ON PAGE 207) 
and depth label settings for this view (see “SOUNDINGS” ON PAGE 210).
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Profile View

The Profile View displays a single swath.
1. Select the Profile View command.

The time stamp and profile number of the swath are shown in 
the status bar.

Amplitude View

The Amplitude View displays the beam-averaged amplitude 
data that is recorded with the swath bathymetry data.
1. Select the Amplitude View command.

Beam-averaged amplitude data are intensity values for each 
sounding depth created by a multibeam sonar system.

3-D View

The three-dimensional (3-D) View shows all soundings currently 
visible in the Plan View in three-dimensional format. The data 
in this window can be rotated and moved around (see“COMPASS” ON 
PAGE 649).
Select the 3-D View command.

Data Display in Views

You can show or hide the display of data in the Rear, Side and 
Profile Views: 
• show or hide port beams
• show or hide starboard beams
• show both port and starboard beams (default setting)
1. Choose the Port or Starboard Beams command.

The display is refreshed to show only the Port or Starboard data. 
2. To view both starboard and port beam data, select the Port and 

Starboard Beams command.

Both Port and Starboard beams are displayed in the Rear, Side 
and Profile Views.
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Swath Editor Display Options

The display options for the views are controlled through the 
General tab in the Control window.

The following sections describe the options in this tab. 

Vertical Exaggeration

The vertical exaggeration is the ratio of the vertical scale versus 
the horizontal scale used in the Rear and Side Views.
The vertical exaggeration can be determined automatically by 
including all visible depths or it can be manually set.
When Auto mode is on, the Include Rejected option controls whether 
or not the rejected data is used to determine the minimum and 
maximum sounding depth in the Rear and Side Views. 
1. Deselect the Auto mode by clearing the check box.
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2. Click the up or down arrow buttons beside the Vertical Exaggeration 
box to set the vertical exaggeration.

You can set the vertical and horizontal scale of the view to 
control the amount of rejected data in the view 
3. Select the Include Rejected option to resize the display in the view to 

include rejected data.

This deTrend option is used when the general slopes of the sea 
floor topography makes it difficult to see individual depth spikes. 
DeTrend removes the general slope of the sea floor from the Rear 
and Side views and redraws the swath and beam profiles 
making it easier to locate depth spikes.
4. Select the deTrend check box to view data. Select the command by 

selecting from Tools > Swath Editor > deTrend.

Specified Min-Max

Use a constant scale as an alternative to vertical exaggeration 
by setting a minimum and maximum range for displaying data.
1. Select the Specified Min-Max check box to implement this option.

2. Type the minimum and maximum ranges for the scale.

The views are automatically refreshed to show data according to 
the scale.
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Soundings

By default, beams in the Side, Rear, and Profile Views are 
connected by lines. Sometimes, beams can be more clearly 
distinguished if displayed as points.
1. Select the General tab in the Control window.

2. Select the View as Points option to change the lines to points.

3. Click the up or down buttons beside the Point Size box to set a size 
value between one and five points.

Increase or decrease the beam display size in the Plan View.
4. Click the up or down buttons beside the Point Size box to set a size 

value between one and five points.

Beams are resized as determined by the point size setting. The 
Number of Profiles box displays a value for the maximum amount 
of profiles that can be shown in the Plan View. This value is 
incremented up or down as the beam display size values are 
changed.

Colour By Depth

Display soundings as colour coded by depth interval.
1. Select the Plan View tab in the Control window.

2. Select the Colour by Depth box so it is checked.

3. Click the up or down buttons beside the Depth Interval box to select a 
depth interval for the colour band.  

The soundings are now displayed by depth level. 
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Examining Swath Data

The scroll bar in the Plan View represents the time period of the 
entire line. You can use the slider to move alone the trackline or 
use the scroll arrows for more precision. 
Each click on an arrow button moves the screen forward or 
backward one swath. Clicking the grey area of the scroll bar 
moves the screen forward or backward for a set of swaths. As 
you move along the track line, all the views refresh to display 
the same data as in the Plan View window..

As you move up or down the track line, all the views refresh to 
display the data from the swaths that are visible in the Plan 
view.
The geographic location of the swaths currently in view is shown 
by the sounding coverage outline in the Display window (see 
“SWATH COVERAGE OUTLINE” ON PAGE 645). 
As an alternative, use the following methods to scroll through a 
track line:
• Press the space bar to move up the track line.
• Use the mouse wheel (if available) to move up or down the 

track line.
• Press <Ctrl + spacebar> to move down the track line.
• Use the mouse wheel (if available) to move up or down a track 

line.
• Press the <Home> or <End> buttons to move to the start or 

end of the track line.

Click here to 
move forward 
or back one 
swath

Move slider 
to view any 
location on 
the line

Click here to 
move forward 
or back a set of 
swaths 
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Select Swaths and 
Beam

The Middle button select option lets you select an individual 
swath or beam profile and see its location in the Display window. 
By moving the cursor in the Plan, Rear, 3-D or Side View while 
holding down the middle mouse button, individual swaths and 
beams will be highlighted in the Display (see example below).

To view both beam and swath profiles
1. Slect the Beam and Swath check box in the Middle Mouse Select section 

of the General tab in the Control window.

2. Place the cursor in either the Plan View, Rear View or Side View and 
click the middle mouse button.

The selected swath is highlighted.The other views are updated 
to reflect the same beam and swath location. The positions of the 
swaths and beams are also displayed in the sounding coverage 
outline.
If the Attitude Editor is open, you can view the sounding’s 
position in relation to attitude data by the yellow line in any of 
the sensor windows (see “ATTITUDE EDITOR” ON PAGE 185).

Find soundings Search a survey line for a specific swath or beam.
1. Select the Find Soundings command, or right-click and select Find 

from the pop-up menu in the Plan View.

The Find Soundings dialog box is displayed.

MIddle mouse 
click here…

shows swath and 
beam in Display
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2. To search by the swath or beam number, select the Profile and/or 
Beam option.

3. Type the swath or beam number in the Profile Number or Beam 
Number field.

4. To search for a swath that was recorded at a specific time, select the 
Time option.

5. Click inside the Profile Time box and type the time in the relevant fields 
(hour:minutes:seconds:decimal fractions of a second). Make sure you 
use the 24-hour clock.

6. Click Find.

The selected beam or swath is highlighted in the Plan, Rear and 
Side Views.

Swath Coverage Outline

The swath coverage outline is a marker in the Display window 
that shows the location of data currently visible in the Swath 
Editor (see example below) The display of the outline is 
controlled from the Options dialog box (see “SENSOR EDITORS” ON 
PAGE 90).



646 CARIS HIPS and SIPS User’s Guide

Swath Editor: Examining Swath Data

Automatic Recentre The automatic recentre option ensures that when the coverage 
outline reaches the edge of the Display window (when scanning 
along the track line), the display redraws with the coverage 
outline in the centre. This option is available in the General 
Options dialog box. (see “GENERAL” ON PAGE 77).
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Changing Track Lines

After examining a track line, you may want examine another 
line. 
There are four options for navigating between track lines in the 
Swath Editor: 
• Select the Next Line command
• Select the Previous Line command
• Click a line in the Display window so that the line is opened 

in the Swath Editor at that location
• Select a track line file name Project data tree in the Control 

window. 
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Examine Data in the 3-D View

Swath data be displayed in 3D format. The 3-D feature provides 
greater flexibility for examining and cleaning data.
1. Select the 3-D View command.

The 3-D view is displayed in the Swath Editor.

The 3-D display is manipulated by three controls:
• the compass
• the vertical exaggeration slider
• the light control.
The display of data and 3-D controls is handled through the 3-D 
View tab, shown below. The line thickness of these controls can 
be altered by changing the Line Weight value in the 3-D View tab.
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Compass

Rotation along the X-Y-Z axis is handled by moving the arrow 
heads at the ends of the compass. The compass is visible in both 
the 3-D View and the 3-D View tab.

Z-axis rotation arrow
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1. To rotate the image along the Z-axis, position the cursor on the middle 
arrow head, press and hold the mouse button, and drag the cursor so 
that the image is rotated. The compass can be rotated 90º.

2. To rotate the image along the X-Y axis, position the cursor on any of 
the other arrow heads, press the mouse button and drag the arrow 
head in a left-right or up-down direction. The compass can be rotated 
360º.

3. Alternatively, the image can be rotated in the horizontal plane by 
grabbing the Z-arrow, then pressing the left-mouse button and moving 
the cursor up and down. Rotation around the Z-axis can be performed 
by pressing the <Shift> key and moving the cursor left and right in 
these windows. 

The image is rotated in the same direction as the arrow heads.
4. To return the image to its original position, click Overview in the 

3-D View tab.

The image is restored to its original position. 

Vertical Exaggeration Slider 

By changing the vertical exaggeration, you can display seabed 
features more clearly.
Vertical exaggeration is controlled by the scale slider in the 3-D 
View. The slider can be displayed or hidden by selecting (or 
clearing) the Show Vertical Exaggeration check box in the 3-D Controls 
tab.

1. To change vertical exaggeration, position the cursor over the ball on the 
vertical exaggeration scale.

2. Press and hold the mouse button, and move the ball up or down the 
scale.

You can also change the vertical exaggeration using a dialog box.
3. Double-click the ball in the vertical exaggeration slider.
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The Vertical Exaggeration dialog box is displayed.
4. Type a value in the Vertical Exaggeration field and click OK.

The display is refreshed to show the image according to the 
selected exaggeration scale. The scale value is displayed below 
the slider.

Lighting Control

The lighting control handles shading effects by controlling the 
position and angle of the light.
The elevation value (on the bottom right of the compass) varies 
from 90º to 0º starting from the middle of sundial. The azimuth 
value (on the bottom left of the compass) varies from 0º to 360º in 
a clockwise direction. The lighting control can be displayed or 
hidden by selecting (or clearing) the Show Light Control check box in 
the 3-D View tab.

As the ball is moved, the elevation and azimuth values change.
You can also change the shading effect using a dialog box.
1. Double-click the ball in the lighting control.

The Set Sun Position dialog box is displayed.
2. Type new values in the Sun Elevation and Sun Azimuth fields and click 

OK.

The image is refreshed to the new lighting angle.

Pan and Zoom

There are three pan options for the 3-D View:

ElevationAzimuth

1. Position the cursor over the ball 
in the lighting control.

2. Press and hold the mouse button, and 
with the cursor.move the lighting control ball 
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• To pan along the X-Y axis: place the cursor in the 3-D View, 
press the middle mouse button and drag the display to a new 
location.

• To pan along the Z-axis: place the cursor in the 3-D View, 
press and hold the <Shift> key and middle mouse button and 
move the cursor in the window.

• To centre the 3-D View window on a selected point: position 
the cursor over the point and click the middle mouse button.

There are three zoom options:
• Press and hold the <Ctrl> key and right-mouse button and 

drag the cursor up in the display to zoom into display.
• Press and hold the <Ctrl> key and right-mouse button and 

drag the cursor down in the display to out of display
• Rotate the mouse wheel in a counter-clockwise direction to 

zoom into the display, or rotate the mouse wheel in clockwise 
direction to zoom out of the display.
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Introduction

The Options dialog box has a number of parameters to help you 
control the appearance of the interface, the behaviour of some 
commands, and the system environment.
1. Select the Options command.

The Options dialog box is displayed. The dialog box contains the 
following five tabs:
2. Click Apply to implement the changes without closing the dialog box, 

or OK to implement the changes and close the dialog box.
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General

On the Options - General tab you can set parameters that 
determine how you want to work with data.

1. Set the parameters described in the table below. 

Field Description To assign a value...

Zoom Factor Set the percentage to increase or 
decrease the display scale when using 
the Zoom functions.

Select a percentage rate for the zoom tool using 
the up or down arrows in the Zoom Factor box.

Pan Factor Set the percentage used to move up, 
down, left, or right while using the Pan 
tools.

Select a percentage by clicking the up or down 
arrow keys beside the Pan Factor box.

Pick Aperture The Pick Aperture determines the 
maximum distance (in pixels) that a 
cursor can be from an object to select 
it. For example, if the Pick Aperture is 
set to five, the cursor must be a 
distance of five pixels (or less) to select 
an object.

Select the pixel area for the Pick Aperture by 
clicking the up and down arrow buttons.

Sounding Size Display sounding digits in a field sheet 
or tiled area at a selected size 
(millimetres at map scale).

Enter a sounding size value in the Sounding 
Size field.
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Engineer Sounding 
Precision

Set the number of places to the right of 
the decimal point that digits are shown 
for engineering sounding display.

Select the precision value by clicking the up or 
down arrow buttons.

Editor Outline 
Transparency

Control the transparency levels of fills 
for Swath, Side Scan and Subset 
Editor outlines in the Display window.

Select a percentage value for transparency (0 
equals no transparency, 100 equals total 
transparency) by clicking the up or down arrow 
buttons.

SVP Location 
Symbol

Select a feature code for the symbol 
that shows the location where SVP 
data was recorded.

Select a feature code from the drop-down list.

Navigation Point 
Symbol

Select a feature code for the symbol 
display of points in the Navigation 
Editor.

Select a feature code from the drop-down list.

Symbolize CARIS 
Map

This option draws the background 
CARIS map with its associated line 
patterns and symbolization. 

Check the Symbolize CARIS Map box to 
implement this option.

Auto Save Automatically save all status flag 
changes at set intervals.

Select the Auto Save check box to implement 
this function.

Enter the interval (in minutes) that work is to be 
saved.

Enable Constant 
Zoom

Control whether the Zoom function 
allows repeated Zoom commands until 
the Zoom function is turned off.

Make sure the Enable Constant Zoom box is 
checked to implement this option.

Detailed Line 
Query

Display all data fields for a track line 
when it is queried.

Select the Detailed Line Query command.

Automatic 
Recentre

Redraw the Display window so that the 
sounding coverage outline is always 
displayed in the centre when scrolling 
along the line.

Select the Automatic Recentre check box.

Automatically 
Update Projects

Save the UTM zone setting in a project 
so HIPS/SIPS does not have to search 
for the zone when a project is 
reopened. This option is only available 
when project created using Select UTM 
zone automatically option.

Make sure the Automatically Update Projects box 
is checked to implement this option.

Automatic Refresh Refresh the Display window 
automatically when layers are turned 
on or off, or when the drawing order is 
changed in the Control window.

Make sure the Automatic Refresh box is 
checked to implement this option.

Enable Tool Tip Show/hide the display of ToolTips when 
the cursor is over a BASE surface or 
toolbar button.

Make sure the Show Tool Tip box is checked to 
implement this option.

Automatic BASE 
Surface Update

Automatically update BASE Surfaces 
after cleaning sounding data in the 
Swath and Subset Editors, or after 
cleaning CUBE data in the Subset 
Editor.

Select or clear the Automatic BASE Surface 
Update check box.

Field Description To assign a value...
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2. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box. 

Show Line Display a diagonal line inside the 
bounding box that is drawn when the 
mouse button is pressed down and the 
cursor is dragged across the screen.

Click the Show Line check box.

Show Distance Display the distance that the bounding 
box covers when it is drawn on the 
screen.

Click the Show Distance check box.

Field Description To assign a value...
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Display
1. Select the Options command.

The Options - Display dialog box is displayed.
2. Select the Display tab.

The Display tab has a list of various display controls such as 
colour, fonts, position of labels on grids and so forth. 
The controls for the selected editor or window are displayed on 
the right side of the window. Refer to the appropriate section 
below for instructions to set the parameters  for each window or 
editor.

3D Display

Use settings in the Tools > Options > Display > 3D to:
• display a Terrain Axes (x,y,z) grid for the selected surface.
• turn on or off the display of the Colour Legend. When turned 

off, the legend’s on/off button within the 3D View is also 
removed.

• turn on or off the display of the Controller Panel. When 
turned off, the controller panel’s on/off button within the 3D 
View is also removed.

• display the 3D View Toolbar. If this option is not enabled, the 
commands can be accessed from the View > 3D Flight Path 
submenu.

• select the colour to use as the Background Colour of the 3D 
View.

Contours

Use the settings in the Tools > Options > Contours to set the 
display of labels in contour lines created in a product surface. 
Set:
• Size in mm of the contour label.
• Number of decimal places to the right of the decimal point to 

display in the label.
• Space in mm around the label when the masking option is 

used.
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• Orientation of the label with respect to the contour line it is 
labelling.
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Display window

The Tools >Options - Display Window tab controls the display 
and colour features for the ship and towfish track lines.
1. Select Display Window from the Category list.

2. Set the parameters described in the table below. 

Field Description To assign a value...

Display Window fields:

Background Control the background colour. Select a colour for the background from 
the colour palette, or create a custom 
colour from the standard Windows colour 
picker.

Show Side Scan Outline The side scan outline marks the extent of 
the data currently visible in the Side Scan 
Editor.

Select the Show Side Scan Outline 
check box to display the marker in the 
Display window while the Side Scan 
Editor is open.

Enable during playback Move the side scan outline along the track 
line during the Playback option in the Side 
Scan Editor.

Select the Enable During Playback 
check box to make this option active.

Show Swath Outline The swath outline marks the extent of the 
data currently visible in the Swath Editor.

Select the Show Swath Outline check 
box to display the marker in the Display 
window while the Swath Editor is open.



CARIS HIPS and SIPS User’s Guide 663

Options: Display

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Measure Distance Select a font to display measurements 
when the Measure Distance command is 
used.

Click Font and select a type face, font 
size and colour from the dialog box.

Ship Track Lines fields

Not Merged The colour for track lines that have not 
been merged into a position/depth file

Select a colour from the colour palette, 
or create a custom colour from the 
standard Windows colour picker.

Merged The colour of track lines that have been 
merged into a position/depth file.

Towfish Track Lines fields

Raw Side Scan Only The colour used to display track lines 
when side scan data is still in raw mode.

Slant Range Corrected The colour used to display track lines 
when side scan data has been slant range 
corrected.

Use Multiple Colours This option uses a set of ten distinct 
colours to colour the track lines in the 
Display window. This is helpful if the 
survey data was logged as multiple files 
along the same runline.

Click the Use Multiple Colours check 
box to enable this option for ship track 
lines or towfish lines.

Field Description To assign a value...
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Geographic Grid

The Options - Geographic Grids tab controls the options for 
displaying grids based on geographic units.
1. Select Geographic Grid from the Category List.

2. Set the parameters described in the table below.

Field Description To assign a value...

Visible Show a grid based on geographic 
coordinates in the Display window.

Select the check box.

Labels:

Top/Left/ 

Bottom/Right

Display geographic coordinates at 
selected locations in the Display 
window 

Select the check boxes.

Colour Set a colour for the grid labels. Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Font Typeface and point size for grid labels Click the Font button to open the standard 
Windows Font dialog box to select a font type 
and size.

Type The type of markings for the 
geographic grid.

Select a type from the drop-down list.

Length The length of the markings (mm at map 
scale).

Type the length.
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3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Line Attribute 
Colour

Colour for the geographic grid 
markings.

Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Weight Thickness of the markings Type a value into the field.

Custom Spacing Position the grid markings at selected 
locations in the workspace.

Select the check box.

Grid Spacing Spacing of grid markers in mm at map 
scale.

Type a value in the provided field.

Field Description To assign a value...
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IHO Standards

The Options - IHO Standards tab controls the colour options in 
the Subset Editor to display data according to International 
Hydrographic Organization (IHO) standards. Colours can be set 
for each S-44 survey order and S-57 Zone of Confidence 
(CATZOC). The Unclassified option sets the colour for soundings 
that exceed defined limits of the selected standard.
1. Select IHO Standards from the Category list.

2. Set the parameters described in the table below.

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Field Description To assign a value...

IHO S-44 Colours for displaying soundings 
according to S-44 survey order. 

Select a colour from the appropriate colour 
palette, or create a custom colour from the 
standard Windows colour picker.

IHO S-57 Colours for displaying soundings 
according to the S-57 CATZOC zones 
of confidence attributes.



CARIS HIPS and SIPS User’s Guide 667

Options: Display

Lidar

The Tools> Options - Lidar tab controls the colour options for 
lidar data in the Swath and Subset Editors.
1. Select Lidar from the Category list.

2. Set the parameters described in the table below.

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Field Description To assign a value...

Waveform view:

Waveform Selected colour for displaying waveform data.

Select a colour from the appropriate colour 
palette, or create a custom colour from the 
standard Windows colour picker.

Detected Selected colour for displaying soundings.

Alternative Selected colour for displaying soundings with 
an alternative depth.

QA/QC:

No Decision Display soundings that have a detected and 
alternative depth (Quality 1 flag)

Display or hide soundings with specific 
quality flag by selecting or clearing any of 
the quality flag check boxes.

Select a new colour for each of the lidar 
flags from the colour palette, or create a 
custom colour from the standard windows 
palette.

Kept Detected Display soundings where the detected depth 
is retained over the alternative depth (Quality 
2 flag)

Swap to 
Alternative

Display soundings where the detected depth 
has been replaced by the alternative depth 
(Quality 3 flag)
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Projected Grid

The Options - Projected Grid tab controls options for displaying 
a grid based on the selected projection.
1. Select Projected Grid from the Category list.
 

2. Set the parameters described in the table below.  

Field Description To assign a value...

Visible Show a grid based on geographic 
coordinates in the Display window.

Select the check box.

Top/Left/Bottom/
Right

Display geographic coordinates at 
selected locations in the Display 
window 

Select the check boxes.

Colour Colour for the grid labels. Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Font Typeface and point size for grid labels Click the Font button to open the standard 
Windows Font dialog box to select a font type 
and size.

Type The type of markings for the 
geographic grid.

Select a type from the drop-down list.

Length The length of the markings (mm at map 
scale).

Type the length.
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3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Line Attribute 
Colour

Colour for the geographic grid 
markings.

Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Weight Thickness of the markings Type a value into the field.

Custom Spacing Position the grid markings at selected 
locations in the workspace.

Select the check box.

Grid Spacing Spacing of grid markers in mm at map 
scale.

Type a value in the provided field.

Field Description To assign a value...
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Scale Bar

The Options - Scale Bar tab controls the options for the scale 
bar.
1. Select Scale Bar in the Category list.

.

Field Description To assign a value...

Visible Show a scale bar in the Display window. Select the check box.

Location Position of the scale bar in the window. Select a location from the drop-down list.

Colour Colour of the scale bar. Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Font Select the font type, style and size from 
the Font dialog box.

Click the Font button to open the standard 
Windows Font dialog box to select a font type 
and size.

Background 
Colour

Display a colour fill for the scale bar area. Select the check box to implement this option.

Select a colour from the colour picker, or create a 
custom colour from the standard Windows colour 
palette.

Draw Border Draw a border line around the scale bar 
area.

Select the check box to implement this option.
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Sensor Editors

The Tools >Options - Sensor Editors tab controls some of the 
colour settings for the editors.
1. Select Sensor Editor from the Category list.

2. Set the parameters described in the table below.  

Field Description To assign a value...

Labels Labels display the horizontal and 
vertical scale lines and annotations in 
the editors. 

Show or hide labels (the labels are 
toggled to on when the Label box is 
checked).

Select a colour for the labels from the 
colour palette, or create a custom colour 
from the standard Windows colour 
selector.

Background Use this control to set the background 
colour in the editors.

Select a colour from the colour palette, 
or create a custom colour from the 
standard Windows colour selector.

Selected The colour for highlighted data in the 
Display window and in the editors.

Superselection Sets the colour for superselected lidar 
data in the Swath and Subset Editors.
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3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Moving Average Sets the colour for the Moving Average 
line in the Attitude and Single Beam 
Editors.

Select a colour from the colour palette, 
or create a custom colour from the 
standard Windows colour selector.

Difference Sets the colour for Difference line in the 
Attitude and Single Beam Editors.

Threshold Sets the colour for the Threshold line in 
the Attitude and Single Beam Editors.

Port Sets the colour for the port side of the 
side scan coverage outline in the Side 
Scan display, or the port soundings in 
the Plan View of Swath Editor. Select a colour from the colour palette, 

or create a custom colour from the 
standard Windows colour selector.

Starboard Sets the colour for the startboard side 
of the side scan coverage outline in the 
SideScan display, or the port 
soundings in the Plan View of Swath 
Editor.

Show Sensor 
ToolTips

ToolTips are used in the Attitude and 
Navigation Editors for displaying data 
values as the cursor moves over the 
graphs.

Show or hide tools tips by clicking the 
Tool Tips check box (checked means 
this feature is visible).

Field Description To assign a value...
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Side Scan Editor

The Tools >Options - Side Scan Editor Display tab controls the 
colours used for the Side Scan Editor.
The Port and Starboard colour palettes are set in Tools > Options > Display > 
“SENSOR EDITORS” ON PAGE 667.

1. Select Side Scan Editor from the Category list.

2. Set the parameters described in the table below.

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Field Description To assign a value...

Altitude Sets the colour of the digitized line along the seabed 
that is used determine the height of the towfish from 
nadir when slant-range correction is performed.

Select a colour from the appropriate 
colour palette, or create a custom 
colour from the standard Windows 
colour picker.

Measure /Offset 
Tools

Sets the colour for displaying the values when using 
the Measure Distance and Measure Shadow tools, 
and the colour of the range display.

Contact Image 
Outline

Sets the colour for displaying the outline of a contact. 

Show Rejected Sets the colour of rejected pings (which are visible 
when the Show Rejected button on the Toolbar is 
activated)

Display contacts 
during playback

Makes contacts visible in waterfall window during 
scrolling or playback.

Select the check box.
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Single Beam Editor

The Options - Single Beam Editor tab controls the colours for the 
Single Beam Editor.
1. Select Single Beam Editor from the Category list.

2. Set the parameters described in the table below.

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Field Description To assign a value...

Primary Colour of primary frequency soundings 
in a dual-frequency system.

Select a colour from the appropriate 
colour palette, or create a custom colour 
from the standard Windows colour 
picker.

Secondary Colour for secondary frequency 
soundings in a dual-frequency system.

Selected Colour for soundings that are selected 
for further processing. Selected data 
begins as a copy of primary frequency 
data, but can be modified to include 
secondary frequency data.

Track Line 
Highlight

The colour in the Display window for 
the section of track line visible in the 
editor.

Event Marks A unique marker placed at regular 
intervals in the survey.
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Status

The Tools > Options - Status tab controls the status colours for 
soundings.
1. Select Status from the Category list.

2. Set the parameters described in the table below. 

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Field Description To assign a value...

Accepted Colour for data that is flagged as ready for 
processing.

Select a colour from the 
colour palette, or create a 
custom colour from the 
standard Windows colour 
selector.

Rejected Colour for data that is flagged as rejected and 
excluded from further processing.

Reject - With 
Interpolation

Colour for attitude and navigation data that has 
been flagged as rejected but where associated 
soundings can still be processed.

Reject - Break 
Interpolation

Colour for attitude and navigation data that has 
been flagged as rejected and where associated 
soundings are also rejected.

Outstanding Colour for soundings in the Subset Editor that have 
been flagged as needing further examination.

Examined Colour for soundings in the Subset Editor that have 
been flagged as examined and verified.

Designated Colour for the sounding that has been flagged in 
the Swath or Subset Editors as being the shoalest 
sounding on a feature.
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Swath Editor

The Options - Swath Editor tab is for selecting colours for the 
Plan View display. Soundings can be coloured by location in the 
swath or by detection method. Soundings in the Rear, Side, and 
Profile Views are always coloured by their location in the swath.
1. Select Swath Editor from the Category list.

2. Set the parameters described in the table below. 

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Field Description To assign a value...

By Beam Number Colours soundings in the Plan View by 
their location in the swath (port and 
starboard).

Click the By Beam Number box so the port and 
starboard colour options are enabled.

Port and Starboard colour palettes are set in 
Tools > Options > Display > “SENSOR EDITORS” 
ON PAGE 667.

By Detection 
Method

Colours soundings in the Plan by the 
detection method used by the sonar.

Click the By Detection Method box so the 
amplitude and phase colour options are enabled.

Use the Phase and Amplitude colour palettes 
to select a colour, or create a custom colour from 
the standard Windows colour selector.
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Tide/SVP

The Options - Tide/SVP tab controls colour options for Sound 
Velocity Profile location symbols and tide zone lines.
1. Select Tide/SVP from the Category list.

2. Set the parameters described in the table below.

3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Field Description To assign a value...

SVP Positions Colour for Symbols and text labels 
show the positions of sound velocity 
profiles.

Select a colour from the appropriate colour 
palette, or create a custom colour from the 
standard Windows colour picker.

Tide Zones Colour for outline of tide zone areas.
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Units 

The Options - Units tab controls the measurement units that are 
used in all HIPS and SIPS applications. 
1. Select Units from the Category list. 
 

2. Set parameters described in the table below.

Field Description To assign a value...

Units There are four types of units:
• Geographic DD (Decimal Degrees). 

Example (to 3 decimal places): 50.361N; 
4.135W

• Geographic DM (Degrees, Minutes). 
Example: 50-21.650N; 004-08.423W

• Geographic DMS (Degrees, Minutes, 
Seconds). Example: 50-21-39.058N; 
004-08-04.671W

• Ground (ground units). Example (in US 
Miles) : 548.734; 2116.214 

Select a unit from the pull-down 
menu. 

If you select Ground units you may 
set the unit of measure using the 
Horizonal Length field. 

Precision The number of decimal places to the right 
of the decimal point that are displayed in 
expressing the value for the position of the 
cursor in the display.

Click the up or down arrow buttons 
beside the Precision field, or type a 
value in the field.
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3. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

Horizontal Length Length, height and area settings in metric 
or imperial units

Select a unit setting from the pull-
down menus.

Vertical Length

Area

Vessel Speed Speed units for Navigation Editor. Select a unit setting from the pull-
down menu.

Sounding 
Rounding

Set the rounding method to be used when 
displaying soundings, as well as the units 
to use to display sounding depths, e.g., in 
metres or feet.

Select a rounding/truncating rule 
from the drop-down list. A brief 
description of the selected rule is 
displayed below the selection.

Field Description To assign a value...
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Directories

The Directories tab lets you set the directories to be used by the 
system for finding and processing data.
The Active Profile options control where the directory settings are 
written to and read from in the Windows registry. The default 
setting for directory locations is Administrator. When this profile is 
selected, all environment settings are written to and read from 
the system-wide settings in the Windows registry. Changing 
these settings effects all users on the same machine who are 
using the Administrator option.
Only persons with a Power User or Administrator Groups 
account can make changes to directories while this option is 
selected. However, you can override the Administrator settings and 
select the directories you want to access. When your user name 
(your login name) is selected as the Active Profile, all environment 
settings are written to and read from your account settings in 
your Windows registry. Changes made using this option effect 
only the user that is currently logged in.
1. Select the Options command.

The Options - Directories dialog box is displayed.
2. Select the Directories tab.

3. Select the login name option to access directory locations in the 
application. The default setting is Administrator.

M
en

u

Tools > Options
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The Root Path option lets you select a file path to access a 
complete set of HIPS/SIPS directories. When this box is first 
checked, you are prompted to enter a path on your computer. 
This location is remembered by the program. 
4. Select the Root Path check box if you want to switch to another set of 

directories on a network.

5. Type the path for the directory or enter the path by clicking Select.

The list in the directories tab is updated to show the new 
location. If a directory is not available then the directory at the 
previous location is used.
6. To change an individual directory, select it and double-click or click 

Select.

The Browse for Folder dialog box is displayed.
7. Click the expand icon to view the file that you want to select, if needed.

8. Select the file or folder.

9. Click OK to close the Browse for Folder dialog box.

10.The selected file path is displayed in the Options dialog box.

11. If you want to view the amount of disk use by a selected repository, 
click the appropriate check box.

12.The percentage of disk use is shown in the status bar.

13.Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.
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Environment

The Environment tab controls the files or values used by 
HIPS and SIPS for ellipsoids, colour maps, feature codes, etc. All 
files are by default located in the System directory.
The Active Profile options control where the directory settings are 
written to and read from in the Windows registry. The default 
setting for directory locations is Administrator. When this profile is 
selected, all environment settings are written to and read from 
the system-wide settings in the Windows registry. Changing 
these settings effects all users on the same machine using the 
Administrator option.
Only persons with a Power User or Administrator Groups 
account can make changes to directories while this option is 
selected. However, you can select your login name to override 
the Administrator settings and select the directories you want to 
access. When your user name is selected as the Active Profile, all 
environment settings are written to and read from your account 
settings in the Windows registry. Changes made using this 
option will affect only the user that is currently logged in. 
1. Select the Options command.

The Options - Environment dialog box is displayed.
2. Select the Environment tab.

3. Select your login name option to change files and values. The default 
setting is Administrator.

M
en

u

Tools > Options
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Change default 
environment settings

1. Select the file path displayed in the window.

2. Click Select.

The Open dialog box is displayed.
3. Select another file and click Open.

The selected file is displayed in the Environment tab.
4. Click Apply to implement the settings without closing the dialog box, or 

click OK to save the settings and close the dialog box.
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S-57 Environment

The S-57 Environment tab controls the files and values used for 
displaying S-57 data in the Display window. The default 
directory for S-57 display files is \HIPS\System\S57Config.
The Active Profile options control where the directory settings are 
written to and read from in the Windows registry. The default 
setting for directory locations is Administrator. When this profile is 
selected, all environment settings are written to and read from 
the system-wide settings in the Windows registry. Changing 
these settings effects all users on the same machine using the 
Administrator option.
Only persons with a Power User or Administrator Groups 
account can make changes to directories while this option is 
selected. However, you can select your login name to override 
the Administrator settings and select the directories you want to 
access. When your user name is selected as the Active Profile, all 
environment settings are written to and read from your account 
settings in the Windows registry. Changes made using this 
option will effect only the user that is currently logged in. 

 1. Select the Options command.

The Options - S-57 Environment dialog box is displayed.
2. Select the S-57 Environment tab.

3. Select your login name option to change files and values. The default 
setting is Administrator.

1. Select the file path displayed in the window.

M
en

u

Tools > Options



CARIS HIPS and SIPS User’s Guide 685

Options: S-57 Environment

2. Click Select.

The Open dialog box is displayed.
3. Select another file and click Open.

The selected file is displayed in the S-57 Environment tab.
4. To change back to the original file path that was used when HIPS and 

SIPS was installed, click Default.

5. Click Apply to implement the settings without closing the dialog box, or 
click OK to save the settings and close the dialog box.
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S-52 Display

The S-52 Display tab controls the appearance of S-57 Ed. 3.1 
data shown as background data in the Display window

 1. Select the Options command.

The Options - S-52 dialog box is displayed.
2. Select the S-52 tab.

M
en

u

Tools > Options
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3.Set the parameters described in the table below..

Field Description To assign a value...

Presentation Display S-57 and HOB data in S-52 or INT1 
format.

Select a presentation format from the 
drop-down list.

Refresh 
Symbology

Automatically refresh the display to show the 
symbology associated with the selected 
presentation library.

Select the check box to make this option 
active.

Colours Select the time-of-day colour scheme in which 
to display S-57 data: Day Bright, Day Dark, Day 
White, Dusk, Night Filtered, Night No Filter. 

Select the appropriate item from the drop-
down list.

Points Select Simplified (default), which means to 
symbolize using the S-52 Presentation Library; 
or Full Chart, which means to symbolize using 
IHO (International Hydrographic Organization) 
chart specifications (the way an IHO-compliant 
paper chart appears).

Depths Select the number of depth shades to use: 2 or 
4 (default). This value works in conjunction with 
Safety Contour Depth, Shallow Water and Deep 
Water

Areas Select Plain Boundaries (default), which means 
to symbolize using the S-52 Presentation 
Library; or Symbolized Boundaries, which 
means to symbolize using IHO chart 
specifications (the way an IHO-compliant paper 
chart appears).

Transparency Select a transparency setting (none, 25, 50, 75, 
or 100 percent) for polygon fills in the display.

Safety Contour The areas that have sufficient depth for safe 
navigation. The safety contour is symbolized as 
a thick solid line. It also defines the boundary of 
shallow and deep-water areas for the purpose 
of area symbolization.

Type a value in the appropriate field.

Shallow Water The contour boundary between the two darker 
colours used for water shallower than the 
Safety Contour.

Safety Soundings The safety depth is used in the symbolization of 
soundings. Soundings whose depth is less than 
the safety depth are displayed in bold text.

Deep Water Define the contour boundary between the two 
lighter colours used for water deeper than the 
Safety Contour.

Categories Pre-defined categories of objects to be 
displayed

Select a category from the drop-down 
menu.
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4. Click Apply to implement the changes without closing the dialog box, 
or OK to implement the changes and close the dialog box.

SCAMIN Select this option to filter features from the 
Display window display that have SCAMIN 
values less than the display scale. These 
features are however, still drawn in the 
selection/superselection colours if they are 
selected or superselected.

Select or clear the check box to turn the 
display on or off

Safety Contour 
Labels/Contour 
Labels

Show labels on safety contours and/or other 
contours.

Soundings Control the display of soundings.

Text Control the display of text.

Error Ellipses Enable the display of the Errell (error ellipse) 
attribute.

Field Description To assign a value...
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3D Tab

The 3D tab provides options for adjusting the settings of the 
keyboard and mouse controllers used when navigating the 3D 
View. 

The following options are available:
• Controller Type: Select the type of controls to use when 

navigating the 3D View.
• Terrain Flyer: allows you to navigate from the perspective 

of the height source.
• First Person: allows you to navigate from a camera view of 

the current 3D scene. 
• Flight Speed: Controls the speed at which you move through 

the display during a fly-through. Move the bar left or right on 
the slider to increase or decrease flying speed.

• Zoom Speed: Controls how fast the view is changed when 
using the zoom controls. Move the bar left or right on the 
slider to increase or decrease zooming speed.

• Smooth-Fly-To Speed: Controls how fast the view is 
changed when a user double-clicks an area of the 3D View. 
Move the bar left or right on the slider to increase or decrease 
zooming speed.



B
B.Data Directories
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Introduction

The structure of the HIPS and SIPS data directories is designed 
to maximize data access efficiency during processing. By 
definition, these directories include only those used to store raw 
or processed data and products, not the HIPS and SIPS 
applications nor their associated system files and libraries. The 
data directories are listed in the following table.

For reasons of consistency with older code contained within 
HIPS and SIPS, directory names and paths should not contain 
any spaces or special Windows characters (\, /, :, *,?,”,<,>, and 
|).

Data Type Default Directory Location

Projects ..\Caris\Hips\HDCS_Data

Raw data ..\Caris\Hips\Preprocess

Session files ..\Caris\Hips\Session

Field sheets ..\Caris\Hips\Fieldsheets

Tide ..\Caris\Hips\Tide

SVP ..\Caris\Hips\Svp
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Projects

The Projects directory holds all of the converted data. The 
Project directory contains two main components:
• HIPS and SIPS data (“HIPS AND SIPS DATA” ON PAGE 693)
• Vessel files (“VESSELCONFIG DIRECTORY” ON PAGE 694)

HIPS and SIPS Data

Converted data in HIPS and SIPS is stored in a Project/Vessel/
Day/Line (P/V/D/L) structure. Each survey project is divided into 
one or several vessels (for example, survey launches), 
contributing to the same project. The data can be from different 
generations of surveys, or different hardware collection 
platforms. Each vessel folder is divided into separate survey 
days and each survey day contains one or more survey lines.
Below is an outline of the P/V/D/L structure for a project called 
Gilligan with a vessel called Minnow. The project contains three 
line files.

In the Project directory, in addition to the folder(s) containing 
the vessel(s), there is also a HIPS Project file (HPF) that 

Gilligan

Minnow

2003-001

Line003Line002Line001

Project

Vessel

Day

Line

VesselConfig

HIPS Project File
(Gilligan.hpf)
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contains the projection information used by the HIPS and SIPS 
interface to define the default projection for that project. When 
HIPS and SIPS accesses the navigation data (which is stored in 
unprojected latitude and longitude), the data is projected using 
the projection stored in this file. The HPF is given the same 
name as the project. For more information on creating a new 
project see “CREATE A NEW PROJECT” ON PAGE 115.
The name of the vessel in the P/V/D/L path provides the link to 
the actual HIPS Vessel File and therefore must be spelled the 
same as the HVF in the VesselConfig directory. The data cannot 
be processed if the HVF is not present or if the vessel name in 
the P/V/D/L path is misspelled.
The survey day in the P/V/D/L structure is composed of two 
components separated by a hyphen—the four-digit year and the 
three-digit Julian date. The date used in the Day directory name 
does not actually play a role in data processing—it is used as a 
convenient mechanism for organizing survey data.
When a new project is created, this directory structure is built 
and the HPF is generated. The vessel file must exist in the 
VesselConfig directory at the time the project is defined, 
however it can be modified at any time (providing the name is 
not changed).

VesselConfig Directory

The VesselConfig directory contains the HIPS Vessel File (HVF) 
used in the vessel component of the P/V/D/L path. The name of 
this directory must not be changed and it always has to be 
located inside the Raw Data directory on the same level as the 
project directories.
For more information about the HVF see “VESSEL FILES” ON 
PAGE 80.
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Raw Data

The raw data directory is used to store unprocessed files that are 
used as input into HIPS via the Conversion Wizard. 
Unprocessed files can be stored in any order and in any location 
on your system. However it is recommended that you store these 
files in a folder structure that mimics the P/V/D/L structure of 
the Projects folder.
Not only does the P/V/D/L structure provide a consistent path for 
data retrieval. You can also take advantage of a feature in the 
Conversion Wizard that lets you open for conversion at any level 
of the P/V/D/L folder structure and maintain that structure 
through conversion.
For example, a new project called "Gilligan" is created by the 
New Project wizard without adding a vessel or survey days to 
the project definition.
Raw data is then converted to HIPS and SIPS format through 
the Conversion Wizard. The File Selection Type is set to 
"Project" in Step 2 of wizard. The converter then knows that 
data is stored in the P/V/D/L structure and that you are loading 
from the Project level. All folders on the next level are 
interpreted as vessel names and the level after that as survey 
days.
Each vessel name must exist in the VesselConfig directory, 
otherwise the converter will report errors. In this example, there 
is only one vessel folder, called "Minnow" and it contains several 
survey days. There happens to be a HVF in the VesselConfig 
directory called "Minnow," so the converter creates the vessel 
folder beneath the project name "Gilligan" in the Project 
directory and also all of the survey days that are necessary. If 
the survey days or the vessel are already present, the converter 
uses them.
Finally, all of the lines found are converted.
To convert raw data that is not stored in the P/V/D/L structure, 
simply set the file selection type to "Raw" and select the files 
individually.
For more information on converting data to HIPS/SIPS format 
see “RENAME DAY AND LINE FOLDERS” ON PAGE 120.
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SVP and Tide

SVP

The SVP directory contains all of the sound velocity profile files. 
They can be stored in subdirectories of this directory if desired.

Tide

The Tide directory contains all of the tide files. They can be 
stored in subdirectories if desired.



C
C.HIPS Status Flags
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Status Flags and Values

Within HIPS and SIPS data structure each sensor data value has 
a series of status flags. Each profile in the depth and side scan 
formats also has status flags, and each survey line has status 
flags. The status flag settings are determined during data 
cleaning and processing. They are used to control the generation 
of new data layers such as BASE surfaces, tiles, and selected 
soundings.

Status Flag Value

Accepted The default status of sounding.

Rejected True if the sounding is rejected for any 
reason.

Examined Indicates that the sounding was verified.

Designated Indicates that the sounding is the shoalest in a 
cluster of soundings.

Outstanding Indicates that the sounding needs further 
examination.

Rejected by Swath Editor or 
Single Beam Editor

True if sounding was rejected in the Swath 
Editor or Single Beam Editor, or by the swath 
or single beam filters. 

Rejected by Hydrographer True for soundings rejected manually by the 
hydrographer within the Subset Editor.

Rejected by Surface Cleaning True if sounding was rejected during surface 
cleaning

Rejected by Depth Gate True for soundings rejected by the depth gate 
during conversion.

Rejected by Disabled Beam True for soundings rejected at conversion 
time because a disabled beam flag in the VCF 
or due to a pre-flagged bad sounding in the 
original raw data format.

Rejected by TPU True for soundings rejected during Total  
Propagated Uncertainty filtering.

Rejected by surface filter. True for soundings rejected during surface 
filtering.

Rejected by Auto Classification True if the sounding fails the auto 
classification tests filter contained in the HIPS 
v4.3.3 subset mode. This flag is not used in 
v5.x software.

Rejected by Bad Navigation True if the profile was rejected for bad 
navigation.

Rejected by Bad Gyro True if the profile was rejected for bad gyro. 

Rejected by Bad Heave True if the profile was rejected for bad heave.

Rejected by Bad Pitch True if the profile was rejected for bad pitch.

Rejected by Bad Roll True if the profile was rejected for bad roll.



CARIS HIPS and SIPS User’s Guide 699

HIPS Status Flags: Status Flags and Values

Rejected by Bad Tide True if the profile was rejected for bad tide.

Status Flag Value
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Overview

Calibration is performed by visually comparing the effects of 
various sensor offsets on calibration survey lines. The initial 
parameters are extracted from the HIPS Vessel File (HVF) and 
modifications can be written to the same HVF.
Calibration surveys are performed to allow adjustments of the 
survey data for parameters such as transducer mounting offsets 
(pitch, roll, yaw), and navigation latency. Other parameters, 
such as heave latency, can also be adjusted.

Calibration lines Calibration lines are a set of survey lines specifically designed to 
allow for calculation of minor sensor deviations from established 
parameters. By running the vessel over known sea bottom 
topography, at different speeds and directions, correction factors 
can be derived for various devices on the ship. These corrections 
are then used for the duration of the survey mission to ensure 
correct processing of data.
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Calibration Workflow

In HIPS and SIPS, Calibration is a six-stage process.
1. Open the calibration lines in HIPS and SIPS.

2. Select a pair of lines that were surveyed for a specific parameter.

3. Use the Calibration function to launch the Hydrographic Data Cleaning 
System (HDCS) directly into the Subset mode.

4. Create the subset in HDCS.

5. Use the Calibration tool in HDCS to measure and view the effects of 
the adjustments.

6. Make a note of the final adjustment values or save them directly into 
the HVF.
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Create Subsets in HDCS
1. In HIPS and SIPS, select the track line(s) you want to calibrate.

2. Select the Calibration command.

The HDCS interface is opened in Subset mode.

The track lines are shown in the HDCS interface. The 
Magnification window controls the track line display in the 
Operation window
3. Position the cursor in the Magnification window.

4. Press and hold the mouse button while dragging the bounding box 
corners to the edge of the window so all the track line area is displayed 
in the Operation window.

Define a subset

5. In the Operation window, right-click the mouse and select the Define 
Subset command from the pop-up menu.

The Subset Definition dialog box is displayed and a subset area 
bounding box is opened in the Operation window.
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6. To determine the subset area, use the mouse to move the Size slider 
control to the desired position.

As the slider is moved, the subset area is resized.
7. To determine the subset angle, use the mouse to move the Rotation 

From North slider control to the desired angle.

As the slider is moved, the subset is rotated.
8. Register the subset by positioning the cursor in the subset area of the 

Operation window and clicking the right mouse button.

The subset area is highlighted in blue and automatically 
numbered.
9. If you are creating more than one subset area, position the cursor on 

the subset. Then use the mouse to drag the subset bounding box to an 
adjacent survey area (make sure there is some overlap between the 
two areas).

10.Repeat Steps 8 and 9 until all the survey area is registered as subsets.

Clean subset Data must be displayed in the spatial subset mode before 
calibration can begin.
1. Click a subset so it is highlighted in yellow.

2. Select the Clean Subset command.

The soundings are now displayed in spatial subset mode.
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Perform Calibration
1. Right-click in the Operation window and select the Calibration 

command.

The Calibration dialog box is displayed.
 

When Calibration mode is in effect, the display in the 
Operations window reflects the locations of soundings as if they 
were merged using the on-screen parameters. 
In the Operations window, you retain the ability to switch view 
points, pixel sizes, and depth range, but not the ability to select 
soundings for query or rejection. 
The Magnification display is not updated with calibration-
adjusted soundings until the parameters are saved to the HVF, 
and the lines are re-merged. You can still generate mean and 
standard deviation maps, but only with unadjusted soundings. 
When Calibration mode is started, the current values from the 
HVF are accessed and displayed.
2. Select any of the following options:

• Current Line: Select the line to apply calibration adjustments. 
Usually all calibration lines are from the same vessel (and, 
therefore, the same HVF). However, you are not restricted to using 
lines with the same HVF. Other lines can also be opened in dialog 
box. If the parameters with that line are associated with other lines 
then those lines are updated too.

• Apply Refraction Coefficients: Select this option to apply refraction 
coefficients. The effects of the Refraction Editor data on the final 
depths can be changed at any time by editing the coefficients and 
re-merging. The effects can removed by re-merging and choosing 
not to apply the coefficients.
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• Apply GPS Tide: Select this option to apply GPS tide. The effects of 
GPS tide data on the final depths can be changed at any time by 
editing the Sounding Datum Height and re-merging. The effects can 
be removed by re-merging and choosing not to apply the GPS Tide.

• Up/Down Arrow Buttons: Use these buttons to increment/decrement 
parameter values. The first row of buttons adjusts the integer 
portion of the value, the second column adjusts in 0.1 increments, 
and the third column adjusts in 0.01 increments.

3. Once data has been selected or modified, you can select from among 
the following options:

• Apply: Effect all changes immediately.

• Reset: Reset all HVF parameters to their original settings.

• Compute Average: Append the settings to an internal buffer to 
compute the average settings. This is done because one set of 
parameters may work well in one area of a survey, but not in 
another area of the same survey. You can then have a set of 
averaged settings for the entire line.

• When calibration mode is started, the buffer is empty. 
Values extracted from the HVF are not put into it.

• If selected without any changes being made, the buffer 
is not updated (i.e., it remains empty).

• The first value entered (not the value extracted from the 
HVF) is the first value put into the buffer (after 
Compute Average is selected), and subsequent values is 
averaged with it.

• You are prompted to save settings in the HVF only if 
you submitted values for averaging. Even if only one 
number was entered, you must select Compute Average 
if you want the setting to be saved in the HVF when you 
exit.

• Quit: Submit the values to the buffer for averaging or close the 
calibration session. A calibration session remains in effect until Quit 
is selected. You cannot leave Subset mode while in Calibration 
mode.

If Quit is selected, a dialog box prompts you to update the HVF 
with the modified values. 
4. Click Yes, to confirm the modification.

When you exit the Calibration mode, you must merge the line(s) 
again for the calibration adjustments to take effect (see “MERGE” 
ON PAGE 254).
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Sample Calibration Procedure

The following are sample calibration procedures1 for adjusting 
sensor offsets. In this procedure Navigation Time Error, 
transducer Pitch offset, transducer Roll offset, and transducer 
Azimuth (or Yaw) offset are adjusted. Initially, all offsets are set 
to zero (in the HVF).

Navigation time error The Navigation Time Error adjustment is performed on sets of 
two coincident lines, run at different velocities, over sloping 
terrain or a conspicuous topographic feature. You must view a 
profile of the two centre beams.
1. In Subset Edit determine the along-track horizontal displacement 

between the two centre beam profiles of one set of coincident lines. 
Repeat this at several locations.

2. Compute the mean displacement.

3. Determine the Navigation Time Error as displacement / (high speed – 
slow speed).

4. Enter Calibration mode and enter the mean value (select Apply if 
necessary).

5. View result of correction, if it is not to your satisfaction, use the arrow 
buttons to adjust the value.

6. Select Compute Average.

7. Move to another location within the subset and repeat Steps 5 and 6.

8. Once the subset is to your satisfaction quit the calibration, confirm the 
update of the HVF and merging of all lines.

9. If calibration data covers more than one subset, repeat Steps 1 through 
8 for all other subsets. Be sure to write down the final correction from 
each subset.

10.Manually average corrections from all subsets

11.Update the HVF.

12.Re-merge all lines (see “MERGE” ON PAGE 254).

1. These procedures are taken from the document “Field Procedures for the Calibration of 
Multibeam Echo-sounding Systems”, by André Godin (available from CARIS).

Take care in cleaning position and attitude data. Depth 
cleaning is not as vital because you are looking at data 
trends and not individual spikes. Navigation Time Error, 
Pitch offset, Roll offset, and Azimuth (Yaw) offset should 
be set to zero in the HVF. Merge all lines.
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Transducer pitch offset This adjustment is performed on sets of two coincident lines, run 
at the same velocity, over sloping terrain or a conspicuous object, 
in opposite directions. Of the above mentioned offsets, only the 
Navigation Time Error should be set in the HVF. You must view 
a profile of the centre beams.
1. In Subset Edit determine the along-track horizontal displacement 

between the two centre beam profiles of one set of coincident lines. 
Note the depth.

2. Determine the Pitch offset as arctan ((displacement / 2) / depth).

3. Enter Calibration mode and input the offset (select Apply if necessary).

4. View result of correction, if it is not to your satisfaction use the arrows to 
adjust the value.

5. Select Compute Average.

6. Move to another location within the subset and repeat Steps 4 and 5.

7. Once the subset is to your satisfaction quit the calibration, update the 
HVF and merge of all lines.

8. If calibration data covers more than one subset, repeat Steps 1 through 
7 for all other subsets. Be sure to write down the final correction from 
each subset.

9. Manually average corrections from all subsets.

10.Update the HVF.

11.Re-merge all lines.

Transducer azimuth 
(yaw) offset

This adjustment is performed on sets of two lines, run over a 
conspicuous topographic feature. Lines should be run in opposite 
directions, with the same outer beams crossing the feature. Of 
the above mentioned offsets, only the Navigation Time Error and 
Pitch offset should be set in the HVF. You must view a profile of 
the same outer beams.
1. In Subset Edit find the desired topographic feature.

2. Observe an along-track profile that shows the same outer beams (from 
both passes) and the topographic feature.

3. Determine the along-track horizontal displacement between the two 
representations of the topographic feature.

4. Change bounding box orientation and view perspective in order to 
measure the across track distance for the observed outer beams.

5. Determine the Azimuth offset as arcsin ((displacement / 2) / across-
track).

6. Enter Calibration mode and input the offset (select Apply if necessary).

7. View result of correction, if it is not to your satisfaction use the arrow 
buttons to adjust the value.

8. Select Compute Average.

9. Move to another set of lines within the subset and repeat Steps 7 and 
8.
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10.Once the subset is to your satisfaction quit the calibration, update the 
HVF and merge all lines.

11. If calibration data covers more than one subset, repeat Steps 1 through 
10 for all other subsets. Be sure to write down the final correction from 
each subset.

12.Manually average corrections from all subsets.

13.Update the HVF.

14.Re-merge all lines.

Transducer roll offset This adjustment is performed on sets of two coincident lines, run 
over flat terrain, in the opposite direction. Of the above 
mentioned offsets, the Navigation Time Error, Pitch offset, and 
Azimuth offset should be set in the HVF. You must view a profile 
of individual swaths.
1. In Subset Edit view the across track profile of the desired lines.

2. Enter Calibration mode and adjust the Roll offset until the two profiles 
are coincident. 

3. Select Compute Average.

4. Move to another location within the subset and adjust the Roll off-set 
until the lies are coincident. 

5. Select Compute Average.

6. Once the subset is to your satisfaction quit the calibration, agree to 
update the HVF and merge all lines.

7. If calibration data covers more than one subset, repeat Steps 1 through 
4 for all other subsets. Be sure to write down the final correction from 
each subset.

8. Manually average corrections from all subsets

9. Update the HVF

10.Re-merge all lines.



E
E. Generic Data Parser
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Introduction

HIPS can convert almost any single beam ASCII file through the 
Generic Data Parser. The parser can also be used to add or 
replace any sensor data in an existing project, except swath and 
sweep bathymetry and side scan imagery.
For example, if high-precision positions were obtained from a 
source other than the original raw data files converted into HIPS, 
this data could be loaded into an existing project to replace the 
original navigation data. The new position data must have a time 
stamp and be in ASCII format.
The Generic Data Parser is a separate program launched from 
the main HIPS and SIPS interface.
1. Select the Generic Data Parser command.

The Generic Data Parser interface is displayed, as shown in the 
example below.

To open raw data to be converted with the parser, 
1. Select Open Raw Data from the File menu. 

2. Browse to select the *.raw or *.txt data file you want to convert. 
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The Raw Data window will open to display the data. This window 
can be sized and repositioned to the top, bottom, right or left sides 
of the interface. 

Data Parsing Components

The parser must be told where each piece of information is 
located in the ASCII text file. This set of parameters is stored in 
a configuration file that can be saved, retrieved or modified at any 
time. These configuration files are stored in the …\Hips\Session 
folder and have a .par extension.
The location of each type of data in the text file is determined 
using either the free form or fixed column method. In the raw 
data file the data fields are separated by delimiters, and lines of 
data are differentiated by identifiers.

Free Form The free form method is used when data items (separated by 
delimiters) have fields of varying lengths. In this case, you specify 
a field number to show where a data item is located in the text 
file. The field numbering starts at one (1) and is counted from the 
first character following one or more delimiters.
For example, in the input string 301.12, 45, 5.66 — field number 
three (3) indicates the start of string 5.66.
Quotation marks can be used to offset a text string, for example, 
“312, 45, 5.66” is treated a single string field (regardless of any 
characters or spaces inside the string).
The following characters are used as delimiters by the parser:
• tab
• space
• single quote ( ‘ )
• vertical bar ( | )
• comma ( , )
• semicolon ( ; )
These delimiters are replaced with spaces when the parser reads 
the file.

Fixed Column This method specifies the absolute location of a data item in the 
text file. The location starts at one (1). This method is used when 
the location of data items does not change and where there is no 
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obvious separation between fields. You must supply the length of 
the field when using the fixed form method.

Identifier When data items are stored in separate text lines, the program 
must differentiate between types of input. This is done with an 
identifier, which is a short text string whose location is specified 
as an absolute value. If an identifier is specified for a data item, 
the input line is tested for the item’s presence to make sure that 
it can be extracted.
For example, some depth data lines in a Hypack data file start 
with the string EC2. In this case, you specify the identifier as EC2 
at the location one (1). You can include spaces and other symbols 
in the identifier, as long as the symbols are not classified as 
belonging to any of the delimiters.
The use of identifiers is optional for any data item. In this case, 
the program extracts the data item on all input text lines.

Multiplier/Offset Once a value has been extracted from the input text line, 
additional operations may be needed to transform it to its final 
value.
This may be necessary because:
• The value is stored with an implied decimal point (for 

example 1/100th of a second).
• The value is stored in a different unit (for example, decimal 

radians instead of degrees).
• The sign of the value is opposite of what HIPS uses.
• The value is stored with an implied offset.
You may specify additional mathematical operations in terms of 
a Multiplier and an Offset. The actual formula used is:

final value = (extracted value x Multiplier) 
+ Offset

Pseudo Time The pseudo time stamp is a user-determined time sequence that 
overrides the Data Parser’s time stamp requirement for record 
conversion. By default, the time is set to midnight at the current 
date, but this can be changed. An increment value attaches a new 
time to each record. Make sure that the pseudo time stamps are 
comparable with the types of data you are importing.
If you are using this feature, the Time Stamps panel information 
must still be completed, but the pseudo time stamp overrides this 
information.
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Configuration File

The configuration file is a text that contains the settings for 
converting data through the Generic Data Parser. All 
configuration files have a PAR extension.
“OPEN A CONFIGURATION FILE” ON PAGE 715

“NEW CONFIGURATION FILES” ON PAGE 716

“SAVE A CONFIGURATION FILE” ON PAGE 716

Open a Configuration File

You can open an existing configuration file for editing and then 
convert text files with the Generic Data Parser wizard.
1. Select the Open File command.

The Open dialog box is displayed.
2. Select the configuration file you want to open.

3. Click Open.

The configuration file is now ready for editing or for proceeding 
directly to converting raw data files.
The data types included in the current configuration are shown 
by a check mark.
4. Optional: Select a data type and modify any parameters, as needed 

(see “DATA TYPES” ON PAGE 719).

5. Optional: Select or de-select a data type by clicking the check box to 
include or exclude data types during conversion.
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New Configuration Files

You can select data types and enter values for a new 
configuration file.
1. Select the New File command.

2. Select a data type and enter values for the parameters.

3. To reset any changes to the data, select the Reset Selected Sensor 
command.

4. Select the check box to include the associated data during conversion.

5. Repeat Step 2 and Step 3 until all necessary data types have been 
added to the new configuration file.

6. Select a Save/Save As command.

The Save As dialog box is displayed.
7. Type a name for the configuration file and select a directory for the file.

8. Click Save.

Save a Configuration File
9. When finished, select the Save or Save As commands or start the 

conversion wizard (see “GENERIC DATA PARSER WIZARD” ON 
PAGE 725).

If you selected the Save or Save As commands, then Save As 
dialog box is displayed.
10. Enter a name for the file and select a location to save it.

11. Click a Save command.
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Remember: You must complete each section before 
selecting the next data type.
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Raw Data Files

You can open a text file and find the exact column positions of the 
data you want parsed.
1. Select the Open Raw Data command.

The Open dialog box is displayed.
2. Select a text file and click Open.

The file is opened in the Editor.
When you position the cursor in the raw data file, the cursor 
location (and thus the column position) is displayed below the 
window.

When a section of the file is highlighted, the length (including 
characters and spaces) of the highlighted area is shown.

3. Select a data type from the list so the associated parameter fields are 
displayed in the parser.

4. Select the appropriate area in the text file by either placing the cursor 
in the file or highlighting a section of it.
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5. Enter the raw data file information in the parameters area (see “DATA 
TYPES” ON PAGE 719).

6. Continue with Steps 3 to 5 until all information has been collected for 
the configuration file.

Close files

7. To close files without saving information, select the Close Raw Data 
command.
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Data Types

The data types are listed on the left side of the interface.

If the check box beside the data type is selected then that data is 
available for conversion. Each data type has a set of parameters 
that are displayed when it is selected. These parameters 
determine what parts of the text file are parsed for the 
configuration file.
To view the parameters:
1. Select a data item so it is highlighted.

The parameters for the data type are displayed in the Parser. 
This example shows gyro data.
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2. Enter data as needed.

When you select another data type, the previous type is now 
checked (if it has a check box). This means that when the text file 
is parsed, that data is included in the conversion. If you do not 
want to include the data in the conversion, make sure the check 
box is cleared.

Reset selection

 3. To remove changed parameters from a data item, select the Reset 
Selected Sensor command.

The parameters are reset to the default positions.

File Header

This section indicates the number of lines in the header. These 
lines are skipped when the text file is parsed. The default value 
is zero.
1. Type the number of lines used for the file header.

File Date

1. Select either a line number or Identifier so the file data can located.

• If you selected line number, type the number in the text box 
provided.

• If you selected identifier, type a text string for the identifier in the 
Name field and the location on the line where the date begins.

2. Define the location of the date values within the field.

• If the length of the year field is two (2), then the converter 
automatically assigns the year a value between 1951 and 2050.

• If the length of the day field is three (3), the converter assumes the 
extracted value represents a Julian date.
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selecting another data type. 
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Time Stamp

Each line must contain a time stamp. The various components in 
the time stamp are specified in terms of absolute positions in 
relation to the start of the time stamp string.
1. Select the location of the time stamp as a Fixed Column or Free 

Form position.

2. Include year/month/day information:

• Select the Yes check box so the year/month/day fields are 
enabled.

• Type a position for the time stamp and the length of the year 
parameter.

3. To add hour and minute, select the appropriate check boxes and type 
the position and length information.

4. Enter the start and length values for the seconds parameters.

5. Enter any Multiplier/Offset values.

Sound Velocity

You can enter a sound velocity value directly or parse it from the 
input file. When converting single beam depth data, the sound 
velocity value can be used to recover the raw travel time from the 
recorded depths. This raw travel time can then be used to 
perform full sound velocity corrections on the data during post 
processing.
1. Select the position for the parser to start reading data by selecting 

either the Line Number or Identifier option.

2. Enter a line number to start reading the sound velocity data, or enter 
an identifier and start position for the data.

3. Select the location of the SVP data as a Fixed Column or Free 
Form position.

4. Enter the relevant free form or column position.

5. Enter any Multiplier/Offset values.

6. Type a default sound velocity value if you want to enter the sound 
velocity value directly.
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Depth

For each depth, indicate the location of the sounding data and 
whether any additional operations are needed.
1. Select the Identifier check box if the information is parsed from a 

specific line in the text file.

2. Type the name of the identifier and the start position for reading the 
depth data.

3. Select the dual frequency check box if the text file contains secondary 
single beam data that must also be converted.

The primary and secondary tabs contain identical fields. Enter 
data in one or both sections, as needed.
4. Select either Free Form or Fixed Column.

• If Free Form, enter the field number where the data is located.

• If Fixed Column, enter the start and length of data in the text file.

5. Enter any Multiplier/Offset values, as needed.

6. Select the Compute Raw Travel Time check box, if you want to 
calculate the raw travel time from the sonar to the seabed.

7. Select the Pseudo Time check box.

8. Type a Start date and type an Increment value (in seconds).

Navigation

The converter supports reading both ground and geographic 
coordinates. For geographic Latitude and Longitude values, 
negative values are supported as well as E/W and N/S tags.
1. Select the Identifier check box if a text string is used to identify 

navigation data in the text file.

2. Enter the identifier and start position for the identifier.

3. Select the type of coordinates used: geographic or ground.

The content of tabs below this section is determined by type of 
coordinates selected. 
• If Geographic is selected, the Latitude and Longitude tabs are 

displayed. 
• If Ground is selected, the North and East tabs are displayed.
4. Complete the following fields for the Latitude/Longitude or the North/

East tabs:

• Free Form: The free form method used to locate navigation data.
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• Field: The field where the data is located, if you selected the Free 
Form option.

• Fixed Column: The fixed position method used to locate data.

• Position: The absolute location of the latitude or longitude data if 
you selected the Fixed Column option.

• Degrees: These fields contain the start of the coordinate field, the 
length of the field and any multiplier and offset values.

• Min: This check box enables the Start, Length, Multiplier/Offset 
fields when selected (geographic coordinates only).

• Sec: This check box enables the Start, Length, Multiplier/
Offset fields when selected (geographic coordinates only).

• Tags: A hemisphere tag (N/S/E/W) is parsed with the data when 
this option is checked.

• Position: Position of the tag in the text file.

5. [Optional] Select the Pseudo Time check box.

6. Type a Start date and type an Increment value (in seconds).

Attitude/Navigation/Tide

This section includes the following data types:
• Gyro
• Heave
• Pitch
• Roll
• Tide
• GPS Height
• GPS Tide
• Speed on Water
• SSS Cable Out
• SSS Gyro
• SSS Navigation
All the fields in these sections are identical.
1. Select the Identifier check box, if the data is going to be associated 

with an Identifier.

2. Enter an identifier and start position for the data.

3. Select the location of the data as a Fixed Column or Free Form 
position.

4. Enter the relevant free form or column position.



724 CARIS HIPS and SIPS User’s Guide

Generic Data Parser: Data Types

5. Enter any Multiplier/Offset values.

Event

Event marks are sometimes generated automatically by the 
logging system to indicate that a certain amount of time has 
elapsed, or a certain distance has been travelled. The event 
marks can be displayed in the Single Beam Editor. In HIPS, 
event mark records consist of one or more unique event numbers 
and textual comments. In this dialog box, you must specify where 
to look for the event mark number within the data record.
1. Select the Identifier check box, if the data is going to be associated 

with an Identifier.

2. Enter an identifier and start position for the data.

3. Select the location of the data as a Fixed Column or Free Form 
position.

4. Enter the relevant free form or column position.

5. If the Events marks contain a textual description, check the Comments 
check box.

6. Type the Start Position of the comments in the text file.

7. Type the Length of the comment.

8. Select the Time Stamp check box to include the time stamp that is 
included with the event. If this option is not checked, the time stamp 
parsed from the file is used.
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Generic Data Parser Wizard

Single beam data or sensor data from a text file is converted to 
HIPS/SIPS format with a six-step wizard opened from the 
Generic Data Parser.

Open the wizard 1. Make sure that a configuration file is open in the Parser.

2. Select the Run command.

The GDP Wizard - Step 1 dialog box is displayed.

3. Select one of the following operations:

• Convert data into new CARIS HIPS/SIPS survey lines.

• Convert data into existing CARIS HIPS/SIPS survey lines.

4. Click Next.

The GDP Wizard - Step 2 dialog box is displayed.

The appropriate configuration file must be open in the Parser 
before data can be converted.

M
en

u

Tools > Run
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o

l
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You must select a Project-Vessel-Day directory to save the 
converted data if creating new survey lines, or select an existing 
survey line if you are updating existing data.
5. Click a Project file tree so it is expanded and the Day folder or survey 

line is visible.

If you want to add Vessel or Day folders or delete a folder, follow 
Steps 5 to 9, otherwise go to Step 10.
6. To add a vessel folder, make sure the project directory is highlighted 

and click Add Vessel.

The Available Vessels dialog box is displayed. 
7. Click a vessel folder and click OK.

The new Vessel folder is displayed in the selected project 
directory.
8. To add a day folder, click the Vessel folder and click Add Day.

The Calendar dialog box is displayed.
9. Select a year/month/day from the calendar, and click OK.

A Day folder with the selected date is stored in the Vessel folder.
10. To remove an empty Day or Vessel folder from the wizard, highlight 

the folder and click Delete. A Vessel or Day folder cannot be deleted 
using the Delete button, if its branch of the Project already has data 
converted into it.

11. Click the Day folder or survey line so it is highlighted.

12. Click Next.

Add PROJECT button added / alert to create 
NEw
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The GDP Wizard - Step 3 dialog box is displayed.

In this dialog box you select the text files you want to convert.
13. If the file path in the Raw Data Directory box is correct, click Select.

The Select Files dialog box is displayed.
14. Double-click a folder to access the text files.

The files are displayed.
15. Select the files so they are highlighted.

16. Click Open.

The selected files are displayed in the wizard dialog box.
17. To remove files, select the files and click Remove.

18. Click Next.

The GDP Wizard - Step 4 dialog box is displayed.
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In this dialog box you must indicate the type of coordinate system 
that was used for the Navigation data during data logging.
19. Select one of the following options:

• Geographic: navigation data is recorded as latitude and longitude 
coordinates.

• Ground: navigation data is recorded as eastings and northings. 

If you select Ground, complete the following steps:
20. Select a projection group from the Group list.

21. Select a zone.

22. Click Next.

The GDP Wizard- Step 5 dialog box is displayed.
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In this dialog box you can reject extremely large errors in the 
recorded navigation and depth data. Navigation and depth filters 
can be applied during conversion with the following steps:
23. Click the Navigation check box to enable the navigation filter.

24. Enter coordinates in the boxes to define the area:

25. Click the Depth check box to enable the depth filter.

26. Enter the minimum acceptable depth.

27. Enter a maximum acceptable depth.

28. Click Next.

The GDP Wizard - Step 6 dialog box is displayed.

Duplicate navigation points are recorded when the vessel is 
stationary. The Filter Duplicate Navigation Points option gives you to 
option to remove the duplicate points during import or to include 
them in the HIPS file (therefore representing the vessel as 
stationary).
29. Select Yes or No to for the Filter Duplicate Navigation Points option.

30. Click Next.

The GDP Wizard - Step 7 dialog box is displayed.
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In this dialog box you convert the text data to HIPS/SIPS format.
31. Click the Convert button.

32. A progress indicator bar along the bottom of the box is activated as the 
files are converted.

33. A text box displays the results of the conversion process.

The HIPS files are saved in the directory you selected in the 
second dialog box.
34. Click Finish to close the wizard, or click Restart to return to the first 

dialog box of the wizard.



F
F. Tide File Formats

HIPS supports a standard Canadian Hydrographic Service tide 
format called COWLIS as well as two NOS/NOAA formats. HIPS 
also supports a basic format consisting of just the required date, 
time, and tide values.

HIPS does not use predicted tide tables. The time zone of the tidal 
observation data must match the time zone of the bathymetry to 
which it will be applied.

As an alternative, a Computed GPS Tide calculation can be used 
with data in HIPS.

In this chapter...
“TIDE FILES (*.TID)” ON PAGE 618
“COWLIS” ON PAGE 619
“NOS PRELIMINARY TIDE DATA” ON PAGE 620
“NOS FINAL TIDE” ON PAGE 621
“TIDE ZONE DEFINITION FILES” ON PAGE 622
“GPS TIDE” ON PAGE 625
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Tide files (*.tid)

TID files are ASCII files consisting of date, time, and tide values 
collected from a single tide station. These files can be created or 
edited in a text editor (such as Notepad), or in the Tide Editor.
The following tide data file formats are supported by HIPS:
• CHS Cowlis
• CHS TMS 50
• CHS TMS 1000
• NOS Preliminary Tide Data
• NOS Final Tide Data

Basic Tide Format The basic tide format used by HIPS begins with a single line 
containing at least 8 dash characters, followed by tidal 
observation records consisting of date, time, and tide. Here is a 
simple example:

--------

2000/11/01 00:00   0.522    
2000/11/01 01:00   0.317     
2000/11/01 02:00   0.395   
2000/11/01 03:00   0.751    
2000/11/01 04:00   1.296    
2000/11/01 05:00   1.848    
2000/11/01 06:00   2.339 
2000/11/01 07:00   2.589 

For information on using the Tide Editor, see “EDITING TIDE DATA” 
ON PAGE 484.
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COWLIS 
--------------------- LIBEX file dump ----------------------
----------------------- STN?????.OBS -----------------------
------------------ Time Zone:  GMT ( 0.0) ------------------

--------------------- Invariant Fields ---------------------
Name             Type Size    Units Value
------------------------------------------------------------
station_id       CHAR    5          
station_name     CHAR   16          Rimouski, Quebec
data_product     CHAR    3          TMS1000
start_time       INTG    4  seconds 93/06/29 18:45:00
end_time         INTG    4  seconds 91/11/16 20:45:00
file_date        INTG    4  seconds 95/12/20 15:24:24
max_water_level  REAL    4   metres    1.640
min_water_level  REAL    4   metres    0.050
------------------------------------------------------------

---------------------- Variant Fields ----------------------
Name             Type Size    Units
------------------------------------------------------------
time             INTG    4  seconds 
water_level      REAL    4   metres 
std_dev          REAL    4   metres 
------------------------------------------------------------
1993/06/29 18:45:00   1.95  0.030
1993/06/29 19:00:00   1.84  0.030
1993/06/29 19:15:00   1.74  0.030
1993/06/29 19:30:00   1.63  0.030
1993/06/29 19:45:00   1.55  0.030
1993/06/29 20:00:00   1.48  0.030
1993/06/29 20:15:00   1.41  0.030
1993/06/29 20:30:00   1.37  0.030
1993/06/29 20:45:00   1.34  0.030
-------------------- End Of LIBEX File ---------------------
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************************ PRELIMINARY DATA **************************

     THIS RAW DATA HAS NOT BEEN SUBJECT TO THE NATIONAL OCEAN SERVICE’S
     QUALITY CONTROL OR QUALITY ASSURANCE PROCEDURES AND DOES NOT MEET
     THE CRITERIA AND STANDARDS OF OFFICIAL NATIONAL OCEAN SERVICE
     DATA.  IT IS RELEASED FOR LIMITED PUBLIC USE AS PRELIMINARY DATA TO
     BE USED ONLY WITH APPROPRIATE CAUTION.

************************ PRELIMINARY DATA **************************

      Water Level -  Acoustic (A1)
      Station   --   Unique seven character identifier for the station
      DCP       --   A one character identifier for the data collection
                     platform at a station
      SE        --   A two character identifier for the data sensor
      Date Time --   Date and time the data were collected by the DCP
      WL_Value  --   Water level height
      Sigma     --   Standard deviation of 1 second samples used to
                     compute the water level height
      Out       --   Count of number of samples that fall outside a
                     3-sigma band about the mean
      Flat      --   A flag that when set to 1 indicates that the flat
                     tolerance limit was exceeded
      ROFC      --   A flag that when set to 1 indicates that the rate
                     of change tolerance limit was exceeded
      Temp      --   A flag that when set to 1 indicates that the
                     temperature difference tolerance limit was exceeded
      Limit     --   A flag that when set to 1 indicates that either the
                     maximum or minimum expected water level height limit
                     was exceeded

      Data are in meters above MLLW
      Times are on UTC (GMT)

9453220 1 Yakutat, AK  from  19990614 to 19990618
  ------------------------------------------------------------------------
Station  DCP  SE  Date       Time   WL_Value   Sigma  Out Flat RofC Temp 
Limit

9453220   1   A1  1999/06/14 00:00     1.881   0.014   0    0    0    0    0
9453220   1   A1  1999/06/14 00:06     1.814   0.025   0    0    0    0    0
9453220   1   A1  1999/06/14 00:12     1.746   0.018   0    0    0    0    0
9453220   1   A1  1999/06/14 00:18     1.692   0.014   0    0    0    0    0
9453220   1   A1  1999/06/14 00:24     1.632   0.013   0    0    0    0    0
9453220   1   A1  1999/06/14 00:30     1.560   0.015   0    0    0    0    0
  ------------------------------------------------------------------------
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NOS Final Tide

 NOS SIX MINUTE WATER LEVEL HEIGHTS

      Data are verified

      Station   --   Unique seven character identifier for the station
      Date Time --   Date and time the data were collected by the DCP
      WL_Value  --   Water level height
      Sigma     --   Standard deviation of 1 second samples used to
                     compute the water level height
      Infer     --   A flag that indicates that the water level value
                     has been inferred.
      Flat      --   A flag that when set to 1 indicates that the flat
                     tolerance limit was exceeded
      RofC      --   A flag that when set to 1 indicates that the rate
                     of change tolerance limit was exceeded
      T_Flag    --   A flag that when set to 1 indicates that the
                     temperature difference tolerance limit was exceeded

      Data are in meters above MLLW
      Times are on UTC (GMT)

9452210 Juneau, Gastineau Channel, Stephens Pass, AK, USA  from  19980525 to 
19980530
  ------------------------------------------------------------------------
Station Date       Time    WL_Value   Sigma  Infer Flat RofC T_Flag

9452210 1998/05/25 00:00     2.473     0.019     0    0    0     0
9452210 1998/05/25 00:06     2.330     0.022     0    0    0     0
9452210 1998/05/25 00:12     2.200     0.019     0    0    0     0
9452210 1998/05/25 00:18     2.064     0.020     0    0    0     0
9452210 1998/05/25 00:24     1.938     0.019     0    0    0     0
  ------------------------------------------------------------------------
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Tide Zone Definition Files

 The following is an example of a Zone Definition File (.zdf).

Tide Zone Data The Zone Definition File has the following components:
• The mandatory header section must consist of this text 

string: [ZONE_DEF_VERSION_3]. This specifies the version 
of the Zone Definition File. 

• The section labelled [ZONE] contains the name of the zone(s) 
and the coordinates that define the boundary of the zone(s). 
All tide zone files must contain this section. 

There are two fields in the first line:
• <Zone Label> contains name of the zone (the 

name must not be longer than 256 characters).
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• number of points that define the boundary of the 
zone. (These are listed starting in the next line of 
the section.)

The remaining lines in this section list the geographic 
coordinates of these points, (latitude, longitude) in deci-
mal degrees.
The last line in the list must contain the same coordi-
nates as the first line to close the polygon.
If there is more than one zone being defined, this section 
is repeated with the definition information for each zone. 

• The section labelled [TIDE_STATION] contains the 
definition of the tide stations collecting the tide observations. 
There are six fields in each record of this section:
• station label (the name of the tidal station) - The name 

must not be longer than 256 characters.
• latitude in decimal degrees - Valid ranges are from -90.0 

to +90.0. The negative range represents the Southern 
Hemisphere.

• longitude in decimal degrees - Valid ranges are from -
180.0 to +180.0. The negative range represents the 
Western Hemisphere.  

• max amplitude (in metres) expected from the tidal station 
- This value will be used to compute a scaling factor 
during the Tidal TPU computation.   

• uncertainty error value associated with the data from the 
station (in metres)

• [optional] full file path and name of the tide file 
associated with the station ID - If this is omitted, HIPS 
will look for an observation file in the same directory as 
the *.zdf, with the file name <Station_Label>.tid.

• The section labelled [TIDE_ZONE] contains specific 
attributes that define a zone’s tidal parameters. There are 
seven fields in this section:
• tide zone label - this must match the name of the zone(s) 

defined in the [ZONE] section.
• tide station label - name of the tidal station associated 

with this entry.
• priority designation of the tidal station entry: either the 

primary (PRIM), secondary (SEC), tertiary (TER) or 
preliminary (PRELIM) station for this zone.

• time correction - the tide offset for this zone (in minutes)
• range correction - a multiplier (for example, 1.06) used to 

scale the tidal value read from the observation file
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• tidal shift - a number in metres added to the values after 
range correction has been applied. 

• uncertainty value for the tidal zone (in metres) used to 
compute the Tidal Zone Error. 

• The section labelled [TIDE_AVERAGE] assigns tide stations 
to zones for tide-weighted averaging. Each record has at 
least two station fields because each zone can be assigned 
one or more tide stations for the weighted average 
calculation. 

The section has the following fields:
• tide zone label - the zone (as defined in the [ZONE] 

section) to which the averaging should be applied
• tide station label, (as defined in the 

[TIDE_STATION] section). Enter as many as 
needed for averaging.

• The last section labelled [OPTIONS] contains options used 
during tide zoning or tide averaging. 
• The limit value field contains the outage time in seconds 

before switching from the current station to the next 
priority station

• final interval in seconds of tide data loaded into the track 
line.

For information on applying the data in a ZDF to survey lines see 
“CORRECT FOR TIDE” ON PAGE 169.
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GPS Tide

The Compute GPS (Global Positioning System) Tide function 
provides an alternative to normal tidal observation for reducing 
soundings to the sounding datum
It is based on the recorded GPS ellipsoid height of the navigation 
antenna and uses the recorded vessel motion, if available, to 
reduce the ellipsoid height measurements to water level.
The following image demonstrates how GPS tide is calculated. 
The arrows indicate the positive sense of the values.

The full formula for GPS tide is shown below.
GPS Tide = GPS Height - Datum Height + Antenna 
Offset - Heave + Dynamic Draft - Waterline Offset

The above diagram and equation show the complete formula for 
GPS tide where GPS Height needs to be motion corrected. 
However, in some systems, GPS Height may already be motion 
corrected. Applying sensor values (such as dynamic heave) again 
will only distort the final GPS Tide. The Compute GPS Tide 
command lets you include or omit selected sensor values.
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There are two options for applying the sounding datum height(s) 
(distance from the ellipsoid to the sounding datum) to the track 
line. 
• apply a single height to a track line, or 
• apply a binary or ASCII text file containing a grid of sounding 

datum heights.
Two binary sounding datum models can be used for computation 
of GPS tide:
• GEOID99
• EGG97 (European Gravimetric Geoid 1997)
Alternatively, an ASCII sounding datum model can also be used. 
The data must be in the following format: Lat,Long,Z. Values 
are delimited using a comma.
An example of the file is shown below.
-33.848326,151.192435,20.4
-33.849484,151.192370,20.1
-33.849237,151.193173,19.7
-33.849506,151.194227,19.8
-33.848298,151.193916,20.0
-33.848402,151.193149,20.2

ASCII datum model files must follow a specific format:
• Latitude and longitude must be in decimal degrees.
• The hyphen symbol (-) must be used to designate coordinates 

in the Southern or Western hemispheres.
• All files must be saved with a TXT or XYZ file extension.
To compute GPS tide, complete the following steps:
1. Select a track line or group of track lines.

2. Select the Compute GPS Tide command.

The Compute GPS Tide dialog box is displayed.M
en

u Process > Compute 
GPS Tide
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3. Enter the Sounding datum height to apply a single height to a track line.

4. To apply a file containing a grid of sounding datum heights, type the 
path and name for the Sounding Datum Model file, or click Browse to 
select a file.

5. Select the Smooth Height check box to apply smoothed GPS heights to 
the track line (see “SMOOTH DATA” ON PAGE 578).

The following check boxes apply sensor values to GPS tide if 
GPS Height needs to be motion corrected.
6. Select Apply Dynamic Heave to apply dynamic heave (regular vessel 

heave, or true heave if exists).

7. Select Apply MRU Remove Heave to apply remote heave resulting 
from vessel roll/pitch on an offset mounted MRU.

8. Select Apply Antenna Offset to apply vertical offsets as a result of 
rotating GPS antenna by vessel roll/pitch.

9. Select Apply Dynamic Draft to apply dynamic draft (as a result of 
interpolating the draft table in HVF, or stored in HIPS as time series 
data).

10.Select Apply Waterline Offset to apply the waterline offset in the HIPS 
Vessel File (HVF).

11.Select Apply Height Correction to apply a static offset to the GPS 
antenna and type the value in the Offset field.

12.Select From Installation XML to apply the waterline value from the 
InstallationParameters.xml generated by the Simrad converter.

13.Click Compute.

The GPS Tide is calculated for the selected line(s). The settings 
in the dialog box are remembered by the application. You can 
open and view the GPS tide data in the Attitude Editor (“ATTITUDE 
EDITOR” ON PAGE 571).
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Contact File Formats: Introduction

Introduction

Contacts in SIPS are stored in ASCII files in each line directory. 
SIPS gathers all of these files together and produces a single set 
of output files that represent all contacts from all of the survey 
lines. The SIPS Contact export function from SIPS produces four 
files:
• filename_ContactLine.txt contains information 

identifying the survey line and indexes to the other files.
• filename_ContactSingle.txt contains all the information 

for single point contacts.
• filename_ContactMulti.txt contains all information for 

single point contacts.
• filename_ContactMultiPoints.txt contains all location 

information for multipoint contacts.
• filename_ContactTiff.gat contains all image files created 

during export.
Filename represents the full path and name of the output file.
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ContactLine

The filename_ContactLine.txt file contains the names of the 
HIPS track lines and the corresponding index number. Each line 
in the file is a comma- delimited string terminated by the newline 
character (\n). Each line has the following format:

Field Name Field Description Description

Line Index 4-digit integer The index number for the line.

Project Name 256 characters 
(maximum) 

The name of the HIPS project that the line belongs to.

Vessel Name 256 characters 
(maximum) 

The name of the HIPS vessel that the line belongs to.

Day Name 256 characters 
(maximum) 

The name of the HIPS day that the line belongs to.

Line Name 256 characters 
(maximum)

The name of the HIPS line that the contact refers to.
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ContactSingle

The filename_ContactSingle.txt file contains the list of single 
point contact features from the export. Each line in the file is a 
comma (',')delimited string terminated by a newline character 
('\n'). Each line in the file has the following format:

Field Name Field Description Description

Contact Index 4-digit integer The index number for the contact. Index numbers are assigned 
sequentially from 0 when the export is performed. Guaranteed to be 
unique for all exported single contacts only.

Key 12 characters The key for the contact. This is created by concatinating the line name 
and the contact number together. The first 8 bytes are the first 8 bytes 
in the line name, and the last 4 bytes are the system generated 
number assigned to the contact.

Line Index 4 digit integer The line record number from the corresponding 
Filename_ContactLine.txt file.

Contact 
Number

4 digit integer The system generated contact number assigned to the contact when it 
was created in the SIPS software (same as the last 4 bytes of the ‘key’ 
field).

Creation Date 10 characters The date the contact was created. Has the mm/dd/yyyy format

Creation Time 10 characters The time the contact was created. Has the following format: 
HH:MM:SS.S

Created User 
ID

3 characters The user ID entered in the SIPS software at the time of contact 
creation (usually user initials)

Modified Date 10 characters The last date the contact was modified. It may be the same as the 
Creation Date if the contact has not been modified since creation. It 
has the following format: mm/dd/yyyy

Modified Time 10 characters The time of the last modification done to the contact. The time may be 
the same as the Creation Time if the contact has not been modified 
since it was created. It has the following format: HH:MM:SS.S

Modified User 
ID

3 characters The user ID of the user that last modified the contact. The ID may be 
the same as the Created User ID if the contact has not be modified 
since it was created.

Contact Prefix 8 characters The prefix assigned by the SIPS software when the user created the 
contact. This is normally used to generate the key for the contact.

Feature Code 12 characters The CARIS Feature code used to represent the point contact.

Contact Type 1 character This identifies the contact record as either a single point or multi point 
contact. Single point contacts are represented by a ‘1’ and multipoint 
contacts are represented by a ‘2’.

Profile Number 4 digit integer The profile number that the contact was picked from in the SIPS 
software.

Across 
Distance

6.2 Floating point The across track distance recorded by the SIPS software that the 
point contact was picked from.

Latitude 13.7 Floating point The latitude of the point contact.

Longitude 13.7 Floating point The longitude of the point contact.
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Target Height 6.2 Floating point The height of the target (in metres).

Target Width 6.2 Floating point The width of the target (in metres).

Target Length 6.2 Floating point The length of the target (in metres).

Image Height 4 digit integer The height of the contact image as defined by the user in the SIPS 
software.

Image Width 4 digit integer The width of the contact image as defined by the user in the SIPS 
software.

Status 1 digit integer The status of the contact. 0 if the contact is Accepted, 1 if the contact 
is Rejected.

Remarks 85 (maximum) 
characters

Remarks entered by the hydrographer about the created contact.

Field Name Field Description Description
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Contact File Formats: ContactMulti

ContactMulti

The filename_ContactMulti.txt file contains the list of 
multipoint contact features from the export. Each line in the file 
is a comma (',') delimited string terminated by a newline 
character ('\n'). Each line in the file has the following format:

Field Name Field Description Description

Contact Index 4-digit integer The index number for the contact. Index numbers are assigned 
sequentially from 0 when the export is performed. It is 
guaranteed to be unique for all exported multi point contacts 
only.

Key 12 characters The key for the contact. It is created by concatenating the line 
name and the contact number together. The first 8 bytes are the 
first 8 bytes in the line name, and the last 4 bytes are the system 
generated number assigned to the contact.

Line Index 4 digit integer The line record number from the corresponding 
Filename_ContactLine.txt file.

Contact Number 4 digit integer The system generated contact number assigned to the contact 
when it was created in the SIPS software (same as the last 4 
bytes of the ‘key’ field).

Creation Date 10 characters The date the contact was created. It has the mm/dd/yyyy format

Creation Time 10 characters The time the contact was created. It has the following format: 
HH:MM:SS.S

Created User ID 3 characters The user ID entered in the SIPS software at the time of contact 
creation (usually user initials)

Modified Date 10 characters The last date the contact was modified. The data maybe the 
same as the Creation Date if the contact has not been modified 
since creation. It has the following format: mm/dd/yyyy

Modified Time 10 characters The time of the last modification done to the contact. The time 
maybe the same as the Creation Time if the contact has not 
been modified since it was created. It has the following format: 
HH:MM:SS.S

Modified User ID 3 characters The user ID of the user that last modified the contact. The ID 
maybe the same as the Created User ID if the contact has not 
be modified since it was created.

Contact Prefix 8 characters The prefix assigned by the SIPS software when the user 
created the contact. This is normally used to generate the key 
for the contact.

Feature Code 12 characters The CARIS Feature code used to represent the point contact.

Contact Type 1 character This identifies the contact record as either a single point or multi 
point contact. Single point contacts are represented by a ‘1’ and 
multipoint contacts are represented by a ‘2’.

Target Height 6.2 Floating point The height of the target (in metres).

Target Width 6.2 Floating point The width of the target (in metres).

Target Length 6.2 Floating point The length of the target (in metres).
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Contact File Formats: ContactMulti

Image Height 4 digit integer The height of the contact image as defined by the user in the 
SIPS software.

Image Width 4 digit integer The width of the contact image as defined by the user in the 
SIPS software.

Status 1 digit integer The status of the contact—0 if the contact is Accepted, 1 if the 
contact is Rejected.

Remarks 85 (maximum) 
characters

Remarks entered by the hydrographer about the created 
contact.

Field Name Field Description Description
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Contact File Formats: ContactMultiPoints

ContactMultiPoints

The filename_ContactMultiPoints file contains the list of points 
used to construct the geometry of the multi point contacts listed 
in the Filename_ContactMulti.txt from the export. Each line in 
the file is a comma (',')delimited string terminated by a newline 
character ('\n'). Each line in the file has the following format:

Field Name Field Description Description

Record number 4-digit integer The record number. It is unique throughout the file.

Contact Record 
Number

4-digit integer The contact record number that this point belongs to. This 
corresponds to the Contact Index in the corresponding 
Filename_ContactMulti.txt file.

Profile Number 4-digit integer The profile number that the point was computed from in the SIPS 
software.

Across 
Distance

6.2 floating point The across-track distance recorded by the SIPS software that the 
point contact was picked from.

Accumulated 
Distance

6.2 floating point The accumulated distance. This is the distance from the first point 
in the set, to this point.

Latitude 13.7 floating point The latitude of the point.

Longitude 13.7 floating point The longitude of the point.
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Glossary

Altitude The height of the side scan sonar transducer above the sea 
floor. The transducer is typically mounted on a towed body or 
the surface vessel, but can also be mounted on an ROV or 
AUV.

Angle-Varying Gain Angle-Varying Gain (AVG) correction removes the angular 
response of sediment from the imagery, normalizing the mean 
angular intensities, ping-by-ping, with a moving average filter.

Attitude Data Commonly used to refer to the orientation of the vessel in three 
dimensions as represented by the Gyro, Heave, Pitch, and Roll 
sensors. The Attitude Editor displays this data as well as other 
sensors that consists of simple “time vs. sensor value” data.

Background Data Georeferenced vector and raster data providing visual context 
to the bathymetry and side scan data being processed. 
Examples include CARIS files, BSB raster charts, GeoTIFF 
orthophoto images, S-57 electronic chart data.

Backscatter Intensity of sounding returns collected by swath multibeam 
sounding systems. Backscatter data creates an image of the 
sea floor that can indicate the bottom type.

BAG The Bathymetric Attributed Grid (BAG) is an open-source 
binary file format for transferring gridded bathymetry and 
uncertainty values between software applications and 
agencies. The file contains four sections: metadata (in XML 
format), elevation, uncertainty, tracking, and certification. For 
more information on BAG, go to http://www.opennavsurf.org/.

BASE Surface The Bathymetry Associated with Statistical Error (BASE) 
Surface. A georeferenced TIFF representation of the seabed 
derived from processed bathymetry and computed uncertainty 
(error) values. The algorithm applies soundings to the grid 
based on beam footprint size. A customizable weighting 
system allows more emphasis in the mean calculation to be 
placed on the inner nadir beams or on soundings with lower 
uncertainty values.

Beam A single depth measurement is produced from a beam. Many 
beams make up a profile or a ping.
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Beam Pattern 
Correction

Beam pattern correction uniformly removes along-track 
banding inherent to the sonar beam. This effect is produced by 
each transducer uniquely.

Beam pattern correction relies on a user-generated beam 
pattern file to identify and remove this effect. 

CARIS File The format for recording vector map data features such as 
lines, symbols, text, soundings, etc. The map actually consists 
of set of files.

CATZOC The zone of confidence (CATZOC) attribute. The CATZOC 
attribute is part of the S-57 Quality of Data (M_QUAL) object 
class. It indicates that data meets the minimum criteria for 
seafloor coverage, and position and depth accuracy as defined 
by the attribute classification structure. There are five CATZOC 
classifications: A1, A2, B, C, and D.    

Contacts Point and line features identified in side scan sonar data. 
Attributes describing the location, size, and description or the 
target are recorded. Image snapshots are also generated.

CUBE Surface A Combined Uncertainty and Bathymetry Estimator (CUBE) 
Surface contains multiple hypotheses representing potential 
depth variances on the seafloor. As soundings are propagated 
to nodes—based on distance and uncertainty—a hypothesis is 
developed. If the there is a significant variation of depth at a 
node, a new hypotheses is created. A node can contain more 
than one hypothesis.   

Day One of the days for which there is survey data. Expressed as 
a Julian day.

Decimate Decrease the size of the bathymetric data set to be exported to 
the work file.

Delta Draft A “time vs. delta-draft” data structure that can be loaded into 
HIPS and used to model the dynamic squat and lift of the 
vessel. Also used to store the recorded depth of towfish and 
ROV/AUV mounted multibeam sonars.

Despeckle Despeckling uses a calculated value based on neighbouring 
intensity levels to replace the current pixel’s intensity if it is 
outside the specified range. The value calculated from the 
neighbouring intensities can be derived by one of two methods 
mean or median.

Disambiguation The process in CUBE of selecting one hypothesis over other 
hypotheses to represent the surface. Hypotheses can be 
selected or "nominated" by density, locale, locale and density, 
or by the nearest value to a previous CUBE Surface. 
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DpTPU Depth Total Propagated Uncertainty. The difference between 
the observed or computed depth value of a sounding and its 
true depth value (at a 95% confidence level).

Edit Layer A HOB layer created in CARIS Notebook to represent real-
world alterations in the survey area.

Ellipsoid The ellipsoid and datum to which logged positions in the 
survey refer must be stored in the HIPS vessel file, regardless 
of whether projection coordinates or geographic coordinates 
are stored in the logged file.  Any eeelipsoid may be used, so 
long as it is defined in the file referenced by the environment 
variable uslXdatum.

Field Sheet A collection of data products, within a defined geographic area, 
derived from the processed bathymetry and side scan data. A 
common coordinate system reference is used. Some example 
products include BASE surfaces, mosaics, tiles, selected 
soundings, contours, and plot layouts.

Filtering The process of detecting outliers in the data and setting the 
status flags to Rejected. Data points are not removed from the 
HIPS/SIPS format.

Gain A measure of increase in amplitude of a signal.

GPS Tide Instantaneous water level height above the sounding datum 
derived from the observed GPS ellipsoid heights of the 
navigation antenna. Reduced for sensor offsets, vessel 
motion, known sounding datum height above the ellipsoid, and 
other parameters.

Generic Data 
Parser

A program for converting recorded ASCII data sources into the 
HIPS/SIPS format. New survey lines can be generated for 
single beam bathymetry, or the program can update a sensor 
within an existing HIPS or SIPS project.

HOB The Hydrographic Object Binary (HOB) file is a spatially 
referenced dataset that is used to support the internal structure 
of S-57 data in CARIS products. The HOB file does not require 
a CARIS vector map and contains the point, line, and area 
geometry for hydrographic objects.

HzTPU Horizontal Total Propagated Uncertainty. The difference 
between the observed or computed position value of a 
sounding and its true position value (at a 95% confidence 
level).

HVF HIPS Vessel File. A vessel configuration file in XML format that 
consists of a list of sensors with their physical and calibration 
measured offsets, plus any error values. These are applied to 
the observed data during processing. The HVF supersedes the 
Vessel Configuration File (VCF).
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Hypothesis A representation of depth in a BASE Surface. The Hypotheses 
that are displayed in the Surface are selected or "nominated" 
through disambiguation. Hypotheses that were not selected 
remain as alternative hypotheses and can be nominated in the 
Subset Editor.

Index Contour A contour line accentuated by a heavier line weight to 
distinguish it from intermediate contour lines. Index contours 
are usually shown as every fifth contour with their assigned 
values, to facilitate reading elevations.

Layback If a towed sensor is used during a survey, the position of that 
sensor can be calculated as a horizontal “layback” from the 
position of the towing vehicle. The sensor layback is computed 
from the tow wire length and sensor depth.

LADS Laser Airborne Depth Sounder (LADS) is a lidar system 
developed by Tenix Corporation.

Lidar Light direction and ranging uses laser technology to calculate 
bathymetry. 

Line A single pass of the survey vessel over some or all of the area 
being surveyed, during which time referenced sensor data is 
continuously collected. Often the line is approximately straight.

Marker Layer A HOB layer created in CARIS Notebook for graphically 
identifying areas of interest and attaching notes, text and other 
information. The Marker layer is created as a sub-layer of an 
Edit layer.

Merge The process of calculating final positions and depths for 
soundings, based on all relevant inputs such as observed 
depths, navigation information, vessel dynamics such as gyro, 
heave, pitch and roll, and tide. Merging is carried out after 
these inputs are loaded and checked.

Mosaic A georeferenced raster image created from one or more side 
scan survey lines.

Outliers Unwanted data resulting, for example, from incorrect sea floor 
detection.

Ping A single output pulse of a sonar system

Profile / Swath A set of soundings, approximately perpendicular to the ship’s 
track, which is produced by the swath or sweep sonar over an 
instananeous or very short time period. CROSS -SECTION??

Product Surface A shoal-biased bin generated from a BASE Surface. Data is 
down-sampled so that finer details of the seafloor are not 
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visible, but the shoals are still maintained. Product surfaces 
can be used to create navigation products, such as Electronic 
Nautical Charts.

Project A survey area with data collected by one or more survey 
vessels over one or more days.

Publication 
Designer

The Publication Designer is an application developed by 
CARIS for formatting templates. You can use this application 
to insert dictionary tags, and add text and graphics. The 
application is opened directly from the Start button on the 
Windows taskbar or from a shortcut on the desktop. 

Raw Side Scan Time indexed imagery profiles where the across-track scale is 
time in milliseconds.

S-44 S-44 is the international standard developed and maintained 
by the International Hydrographic Organization (IHO) that sets 
the minimum standard for hydrographic surveys. The standard 
classifies surveys into survey orders (Special Order, Orders 1, 
2, 3) based on an area’s importance for safety of surface 
navigation. 

S-57 S-57 is the international standard developed and maintained 
by the International Maritime Organization (IMO). It is used by 
hydrographic data producers to describe how real-world 
entities are stored digitally for transfer among different 
computer platforms between the various hydrographic offices.

Session A record of all data that is currently open in the primary 
application. Typically contains a list of survey line names, 
background raster images, and field sheets that are currently 
open. Used to re-open an integrated dataset from a previous 
working session.

SHOALS Scanning Hydrographic Airborne Lidar Survey (SHOALS) is a 
lidar system owned and operated by the Joint Airborne Lidar 
Bathymetry Center of Expertise. 

Slant Range Raw travel time used to compute sounding depth 
(accompanied by receive angle).

Slant Range 
Corrected Side 
Scan

Time-indexed imagery profiles generated from raw side scan 
data using the measured altitude of the transducer. The across 
track scale is distance in metres.

Sounding A measured depth of water.
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Sound Velocity 
Correction

The process of applying rigorous refraction corrections to the 
raw travel time/angle bathymetry data using recorded sound 
velocity profiles.

Status Flag The indicator of the acceptance or rejection of a data point 
during cleaning.

Subset A rectangular area which encloses some or all of a survey 
project boundaries. It is used during sounding cleaning to limit 
the number and extent of soundings being processed during 
one session.

Surface Cleaning A statistical process of detecting bathymetric outliers within an 
area. A least square polynomial regression algorithm is used.

Templates Templates are forms that display session data. Session data is 
added using object tags from in the HIPS dictionary. When the 
template is opened in HIPS and SIPS, the object tags are filled 
with data from the open session. Other features, including text 
and graphics, can also be added. Templates can be built using 
the Publication Designer.

Template Editor The Template Editor is a CARIS application for creating and 
modifying borders, geographic grids, and scale bars. The 
Template Editor is used in conjunction with the Publication 
Designer for creating and editing templates. It is opened as a 
separate application from the Start menu on the Windows 
taskbar, or from a shortcut on the desktop. 
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Tiles A representation of the sea floor consisting of interlocking tiles 
of varying sizes. Tiles can make large data sets more 
managemable by subdividing them by user-defined criteria.

Tile positions are defined by a Morton Number scheme. Tiles 
can carry a variety of attributes generated from the data within 
the area of the tile.

Time-Varying Gain Time-Varying Gain (TVG) adjusts the signal intensity by 
applying a non-uniform, time-dependent gain. TVG is used to 
compensate for the attenuation that occurs due to absorption 
and spreading as the sonar beam travels back to the receiver. 
Since these returns are received over a predictable and 
constant time period, a time-varying curve can used to 
increase gain to compensate for the decayed sonar return.

TrueHeave A heave filtering function developed by Applanix. TrueHeave 
employs a bi-directional heave filter to remove artifacts from 
heave data. Values are computed from real-time data and 
have to be imported separately to the track line.

TPU Total Propagated Uncertainty. TPU is derived from a 
combination of all individual error sources and is used to 
calculate horizontal and vertical uncertainties for soundings.

Vessel A survey platform, whether it be a ship, a towfish, an ROV/
AUV, or an aircraft.

Weighted Grid A georeferenced TIFF representation of the mean sea floor 
depths derived from processed bathymetry, that was used in 
HIPS before the introduction of the BASE surface. 
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designated. 294
display critical 296
set status in Subset Editor 331

status bar
cursor coordinates 26
decimal point precision 26
overview 26
precision 673

subset
drawing bounding box 621
resize 621

Subset Editor
2D View 630
2D view perspective, changing 631



ix

3D View 626
close 633
data status ??–338
designated soundings 333
examined status flag 332
lock subset area 622
open 619
outstanding status flag 332
overview 617
query 333
reject data 331
resize subset 621
set sounding status 331
sounding colour options 625
subset tiles 334–??
toolbar 621
vertical exaggeration in 2D View 631
view information 624
workflow 330

Subset Editorsubset tiles ??–338
subsets

accept data 332
CATZOC colour settings 664
CUBE Surfaces 266
reset rejected data 299
S-44 survey order colour setting 664
view rejected soundings 293

surface cleaning
histogram 314
overview 308
parameters, setting 310–311
query tile soundings 313
query tile surface 312

SVP (Sound Velocity Profile)
barcheck function 475
location symbol selection 657

SVP Editor
depth scale 578
edit existing data 585
exit 586
interface options 580
new files 583
new profiles 583
remove profile 585

SVP files 582
SVP pole offsets in the Vessel Editor 102,

570
swath angle weight 225
swath cleaning 322–??
Swath Editor

3D View 639
accept data 320
Amplitude View 639
auto cursor mode 319
beam and swath location 644
beam display size 642
change sounding status from Worksheet

window 321
close 637
depth level labels in Side View and Rear

Views 641
detrend option 642
examine data 643
find soundings 644
open 636
Plan View 638
port and starboard beams, displaying 639
Profile View 639
query data 321
Rear View 638
Refraction Editor 326
reject data 320
reject swaths 320
reset rejected data 299
Side View 638
swath coverage outline 645
swath outline 661
toolbars 637
view rejected soundings 293

swath transducer location in Vessel Editor
94, 562
SWATHPlus format, conversion options for
156
sweep transducer location in Vessel Editor
103, 571
Symbolize Critical Soundings 628
symbology,track line 32

T

Template Editor 496, 498
text files (Generic Data Parser) 717



x

tide
 see also Tide Editor
GPS tide 181, 741
load tide 176
tide zone files 738
weighted average option 179

Tide Editor
create new tide files 554
edit table data 552
enter new data 552
exit 557
open file 550
scale 551
search time gaps 552
show or hide points 555
time interval 551
tool tips 555

tide file formats
NOS final 737
NOS preliminary 736

Tide stations 179
Tide Zone files 178
tiles

binning 370
close 376
display options for the View window

377
new tile layer 371
open 376
properties 377
query display 378
query tiles 379

Time Correction 109
time error in Vessel Editor 109
time stamp in Vessel Editor 109
time-varying gain 420
To select a mosaic 400
tool tip display 658
toolbars 27

about 27
buttons, modifying appearance of 28
custom 29
move 28
removing from desktop 28
Side Scan Editor 430
Single Beam Editor 465

Subset Editor 621
Swath Editor 637
types 27
undock and float 28

towed sensors location data in Vessel Editor
104, 573
towfish navigation, recompute 406
towfish trackline colour 661
TPE (Total Propagated Error)

compute 200
filter 202
vessel editor values 106, 575

TPE filtering
S-44 202

track lines
classify lines 291
close single lines 68
colour 32, 661
colour banding 661
Control window, select from 45
current display, select by 43
deselect 45
lasso select 43
opening a single line 31
properties 32
query line 290
range, select by 42
select all 43
select next line 44
select previous line 44
symbology 32

TrueHeave 287
turn off

field sheet 214
layers 214

TVG 420

U

UNB 156
UNB (Reson) format, conversion options for
156
UNISIPS, export data to 536
units,decimal point precision 26
Use Measure tools 446
UTM, auto update 658



xi

V

VCF (Vessel Configuration File, see HVF
80
Vessel Configuration file 80
Vessel Editor

3-D vessel outline 90, 557
colour options 91, 558
coordinate system 108
dynamic draft 100, 568
ellipsoid 91, 558
gyro 95, 563
heave 96, 565
navigation 95, 563
new vessel file 81–88, 548–554
open file 547
pitch 98, 566
reference position 108
roll 99, 567
single beam 101, 569
swath transducer location 94, 562
sweep transducers location 103, 571
time error 109
time stamp 109
towed sensors location 104, 573
TPE 106, 575
vessel outline 89, 555
view active sensors 92, 560
view sensor data 92, 560
waterline data 105, 574

View Beam Pattern, Geocoder engine 393

W

waterfall window 423
waterline data in Vessel Editor 105, 574
windows

3-D Display 47
Control 13
Display 12
Properties 16
reposition and resize 25
Worksheet 18

Winfrog format, conversion options for 156
workflow, Mosaic Editor 386
Worksheet window

Graph tab 21

Output tab 18
Profile tab 24
QC reports 23
Query tab 19

Worksheet window, overview of 18

X

XTF format, conversion options for 157

Z

zerotide 178
Zone Definition File 179
zoom

3-D display 57
constant zoom option 657
forward 40
previous 40
Side Scan Editor 433
Swath and Subset Editors 652
using scale 40
Vessel Editor 90, 557
zoom factor 657
zoom in 39
zoom out 39
zoom tool 39
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List of MB-System Programs:

Manual Page for the MB-System package:

mbsystem

Manual Page for the MB-System i/o library:

mbio

These are the current MB-system programs with links to the Unix manual pages:

mbabsorption: Calculates water sound absorption as a function of water properties.
mbareaclean: Identifies and flags bad beams in swath sonar bathymetry data within
a specified area.
mbauvloglist: Generate arbitrary text lists of values from MBARI AUV mission log
files.
mbauvnavusbl: Merge inertial and surface tracking navigation for submerged sonar
platforms (e.g. ROVs and AUVs).
mbbackangle: Generates corrections for sidescan and/or amplitude data by
calculating average amplitudes as a function of the seafloor grazing angle.
mbclean: Identifies and flags bad beams in swath sonar bathymetry data.
mbcopy: Copy swath sonar data files.
mbctdlist: List CTD data in swath sonar data files.
mbdatalist: Parses recursive datalist files and outputs the complete list of data files
and formats.
mbdefaults: Set or list default mbio parameters for reading and writing swath sonar
data
mbdumpesf: mbdumpesf reads an MB-System edit save file and dumps the
contents as an ascii table to stdout.
mbedit: Interactive editor used to flag bad beams in swath sonar bathymetry data.
mbeditviz: Interactive 3D visualization bathymetry editing and attitude bias patch
test.
mbextractsegy: Extract subbottom profiler or center beam reflection data to segy
files.
mbfilter: Apply one or more simple filters to sidescan and/or beam amplitude data.
mbformat: List information about swath sonar data formats supported by the MBIO
library.
mbgetesf: Extract bathymetry edits in edit save file format.
mbgrdviz: Vizualize GMT grids.
mbgrid: Grid bathymetry, amplitude, and sidescan data from swath sonar data files.
mbhistogram: Obtain histogram of bathymetry, amplitude, or sidescan data from
swath sonar data files.
mbhsdump: List raw information contained in Hydrosweep DS data files (formats 21
and 24).
mbhysweeppreprocess: Preprocess Hysweep HSX data (format 201), including
applying time lag and biases to attitude and navigation data.

http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbsystem.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbio.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbabsorption.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbareaclean.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbauvloglist.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbauvnavusbl.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbbackangle.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbclean.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbcopy.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbctdlist.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbdatalist.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbdefaults.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbdumpesf.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbedit.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbeditviz.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbextractsegy.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbfilter.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbformat.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbgetesf.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbgrdviz.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbgrid.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbhistogram.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbhsdump.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbhysweeppreprocess.html
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mbinfo: Output some basic statistics of swath sonar data files.
mbkongsbergpreprocess: performs preprocessing of data from third generation
Kongsberg multibeam sonars (e.g. EM122, EM302, EM710).
mblevitus: Create a water velocity profile which is representative of the mean
annual water column for a specified 1 degree by 1 degree region.
mblist: List data in swath sonar data files.
mbmakeplatform: Create or modify an MB-System platform file, which represents a
survey system as a set of sensors with positional and angular offsets.
mbmosaic: Mosaic sidescan and amplitude data.
mbnavadjust: Package that solves for optimal navigation by matching bathymetry
of overlapping swathes.
mbnavadjustmerge: Merge two mbnavadjust projects.
mbnavedit: Interactive editor used to fix problems with navigation in swath sonar
data files.
mbnavlist: List navigation data in swath sonar data files.
mbneptune2esf: Extract bathymetry edits from Simrad Neptune software into edit
save file format.
mbotps: Generate open ocean tidal model for specified time and location using the
Oregon State Tidal Prediction Software (OTPS) package.
mbpreprocess: Perform preprocessing of the logged data comprising a survey,
including applying lever arm corrections (if neccessary) and setting up the MB-
System processing environment.
mbprocess: Process swath sonar data files, including merging navigation, applying
bathymetry edits, recalculating bathymetry by raytracing, and applying a variety of
other corrections.
mbps: Simple perspective views of swath bathymetry in Postscript.
mbrollbias: Evaluate the roll bias of a swath sonar system using two pieces of
coincident bathymetry data collected with opposing ship headings.
mbrolltimelag Estimate attitude time lag by cross correlation of apparent bottom
slope with the roll time series:
mbroutetime Outputs a list of the times when a survey passes the waypoints of a
planned survey route.
mbsegygrid: Generate time vs. trace number grids of seismic data from segy files.
mbsegyinfo: Output some basic statistics of segy seismic data files.
mbsegylist: List selected header values in segy seismic data files.
mbsegypsd: Calculates the power spectral density function of each trace in a segy
data file, outputting the results as a GMT grid file..
mbset: Create and modify parameter files used to control mbprocess.
mbstripnan: Filter to remove NaN nodes.
mbsvplist: Extract water sound velocity profiles (SVPs) from swath data files.
mbsvpselect: Select the best available sound speed model for each swath file in a
survey according to user specified criteria.
mbswplspreprocess: Preprocess SwathPlus SXP data (format 222), including applying
time lag and biases to attitude and navigation data.
mbtime: Converts between calendar time and unix time.
mbvelocitytool: Interactive program for modeling the affect of the water velocity

http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbinfo.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbkongsbergpreprocess.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mblevitus.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mblist.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbmakeplatform.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbmosaic.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbnavadjust.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbnavadjustmerge.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbnavedit.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbnavlist.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbneptune2esf.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbotps.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbpreprocess.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbprocess.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbps.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbrollbias.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbrolltimelag.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbroutetime.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbsegygrid.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbsegyinfo.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbsegylist.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbsegypsd.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbset.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbstripnan.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbsvplist.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbsvpselect.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbswplspreprocess.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbtime.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbvelocitytool.html
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profile on swath sonar bathymetry calculations.
mb7k2jstar: Extract Jstar format (format 132) sidescan and subbottom data from
Reson 7k (format 88) data files.
mb7k2ss: mb7k2ss extracts Edgetech sidescan sonar data from Reson 7k format
data, bins and lays the sidescan onto the seafloor, and outputs files in the
MBF_MBLDEOIH formst (MBIO format id 71).
mb7kpreprocess: Preprocess Reson 7k data (format 88), including applying time lag
and biases to attitude and navigation data.

MB-system also includes three plug-in modules for the GMT software package that are
built as a shared library that can be called by GMT. Here are links to the Unix manual
pages:

mbcontour: Generate GMT compatible Postscript color swath contour plots.
mbgrdtiff: Generate TIFF image from gridded data.
mbswath: Generate GMT compatible Postscript color and color shaded relief swath
plots.

Macros are programs or shellscripts which make use of programs from the MB-System
and other software packages to accomplish common tasks easily. These are the current
MB-System macros:

mbm_arc2grd: Convert an ArcView ASCII grid file to a GMT grid file.
mbm_copy: Translate groups of swath data files between formats
mbm_bpr: Process data from a Seabird SBE53 pressure sensor into a tidal model for
use by mbprocess.
mbm_fmtvel: Scans a Hydrosweep swath sonar data file using the program
mbhsdump and generates a list in columnar format with time, date, latitude,
longitude, C-mean, and C-keel entrys.
mbm_grd2arc: Convert a GMT grid file to an ArcView ASCII grid file.
mbm_grd2geovrml: Create and execute commands which generate a TerraVision
tileset and GeoVRML set of files that can be combined with other data and viewed
in a web browser.
mbm_grd3dplot: Reads a GMT GRD grid file and writes a shellscript which will
generate a GMT 3D perspective view of the data.
mbm_grdcut: Extract a subarea of a GMT grid file.
mbm_grdinfo: Get information regarding a GMT grd file when the region of interest
is a subset of the area covered in the input file.
mbm_grdplot: Reads a GMT GRD grid file and writes a shellscript which will
generate a GMT map of the data.
mbm_grdtiff: Reads a GMT GRD grid file and writes a shellscript which will generate
a TIFF image of the data.
mbm_grid: Reads a swath sonar data file and writes a shellscript which will grid
bathymetry data or mosaic sidescan (or amplitude) data using reasonable guesses
at the appropriate grid bounds and bin size.
mbm_histplot: Create an executable shellscript which will generate a GMT
histogram plot of a dataset.

http://www.ldeo.columbia.edu/res/pi/MB-System/html/mb7k2jstar.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mb7k2ss.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mb7kpreprocess.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbcontour.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbgrdtiff.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbswath.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_arc2grd.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_copy.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_bpr.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_fmtvel.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grd2arc.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grd2geovrml.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grd3dplot.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grdcut.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grdinfo.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grdplot.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grdtiff.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_grid.html
http://www.ldeo.columbia.edu/res/pi/MB-System/html/mbm_histplot.html
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mbm_makedatalist: Generates an MB-System datalist file referencing all identifiable
swath files in the specified target directory.
mbm_makesvp: Generate a sound velocity profile model from sound speed and
depth values in swath files.
mbm_multicopy: Translate groups of swath data files between formats using parallel
processes.
mbm_multidatalist: Generates ancilliary files used in data managment using parallel
processes.
mbm_multiprocess: Apply specified processing tasks to a swath data file using
parallel processes.
mbm_plot: Reads a swath sonar data file and writes a shellscript which will generate
a swath and/or contour plot of the data.
mbm_route2mission: Translate an mbgrdviz survey route file into an MBARI AUV
mission script.
mbm_stat: Runs mbinfo on a swath sonar data file and extracts beam statistics from
the output of mbinfo.
mbm_utm: Performs forward and inverse UTM projections of ASCII data triples.
mbm_xbt: Processes a Sparton XBT data file and outputs a sound velocity profile
file which can be used to process swath sonar data.
mbm_xyplot: Reads one or more xy data files and writes a shellscript which will
generate GMT plot of the data.

Last Updated: $Id: mbsystem_man_list.html 2258 2015-10-06 04:57:28Z caress $

Back to MB-System Home Page...
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EM datagram formats

The data input and output formats to and from the EM Series multibeam echo sounders
are described in this document. The information applies to the Kongsberg Maritime
multibeam echo sounders introduced after 1995.

Note

The information herein applies to the EM 3002, EM 3000, EM 2040, EM 2000, EM
1002, EM 710, EM 302, EM 122, ME70BO, EM 300 and EM 120 multibeam echo
sounders. Some of the information may not be relevant for your specific system. Please
disregard this.

Information for EM 2040 is valid for all models of EM 2040, unless otherwise specified.

The information in this document is not valid for the EM 12, EM 100, EM 950 and EM
1000 multibeam echo sounders.

Note

In order to meet special customer requirements, Kongsberg Maritime may have to
change the datagram formats described here. The formats presented in this document
may therefore be altered without prior notice, although backward compatibility will
be maintained as far as possible. Before software is written in accordance with this
document, it is strongly recommended to contact Kongsberg Maritime to ensure that the
latest version is used, and that any planned changes are taken into account.
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Presentation format
The format description is according to the NMEA 0183 standard, Approved Parametric
Sentence Structure, with the ASCII character(s) given as follows
• “x.x” defines a variable length numerical field, with optionally included decimal

point and sign.
• “c–c” defines a variable length field of printable characters.
• “x–x” defines a variable length field of numeric characters.
• “a_ _” defines a fixed length field of alphabetical characters (e.g. “aa”= two character

long field.
• “x_ _” defines a fixed length field of numeric characters.

For binary fields, the length is given in number of bytes plus “U” for unsigned and
“S” for signed data.

Support information
If you need technical support on the EM Series system you must contact a
Kongsberg Maritime office. A list of all our support offices is provided on
http://www.km.kongsberg.com.

You can also contact our main support office in Norway.
• Address: Strandpromenaden 50, 3190 Horten, Norway
• Telephone: +47 33 02 38 00
• Telephone, 24h: +47 815 35 355
• E-mail address: KM.Hydrographic.Support@km.kongsberg.com
• Website: http://www.km.kongsberg.com
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Input datagrams

Topics
• Position on page 9
• Attitude on page 21
• Clock datagrams on page 27
• Sound speed datagrams on page 28
• Depth input datagrams from single beam echo sounder on page 33
• Remote control datagrams on page 35
• Sound speed at transducer on page 37
Only a limited number of input formats from external sensors are accepted. These are
primarily in accordance with the NMEA 0183 specification, or based upon the principles
of that specification.
Note

The majority of these formats have not been defined by Kongsberg Maritime. Thus, these
formats are not controlled by Kongsberg Maritime.

Almost all input formats are ASCII. Serial line or Ethernet input to the multibeam echo
sounder’s Processing Unit is most common, but some datagrams - which are not time
critical - are interfaced on serial line(s) or Ethernet to the Operator Station.

Position
Topics
• Overview on page 10
• GGA Datagram on page 12
• PTNL, GGK Local coordinate position datagram on page 14
• Trimble GGK Datagram on page 15
• VTG Datagram on page 16
• Transponder position on page 17
• Simrad 90 Position on page 18
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• Tide Input on page 20
• Depth, pressure or height input on page 20

Overview
The EM Series accepts position data in the following formats
• NMEA 0183 GGA
• GGK
• PTNL, GGK
• SIMRAD 90
• Transponder position
• With the GGA and GGK datagrams, information contained in NMEA 0183 GST and

VTG datagrams will also be accepted and used.

Note

The GST datagram is not used by the following multibeam echo sounders: EM 122,
EM 302, EM 710, EM 2040, EM 2040C, EM 3002 and ME70BO.

• A datagram format for Sonar Head depth is provided for the EM 3002, EM 3000, EM
2040, EM 2000 and EM 710. Note that the format is the same as that used by the
Paroscientific Digiquartz pressure sensor. This format may also be used for input of
for example varying datum heights or other special height information on all models.

• A datagram format for input of tidal height is provided.

The GGA format given below is according to the NMEA 0183 version 2.30 description.

The GGK format was originally defined by the US Army Corps of Engineers for their
tests with kinematic GPS. Trimble’s proprietary version of the format, PTNL GGK, is
supported. If any changes to the format are made, and if it becomes part of the NMEA
standard, this will be implemented.

To preserve the inherent accuracy of the kinematic GPS data it is necessary to correct
the data for vessel motion. This requires accurate timing synchronisation between the
motion sensor and the GPS receiver. It is therefore imperative that
• the position datagram has a constant and known time delay,

or
• the time stamp in the datagram is actually the time of the position fix, that

synchronisation to the 1PPS signal of the GPS receiver is enabled, and that the system
clock has been set correctly.

As neither of these conditions may not be possible to achieve with a sufficient accuracy,
the application of motion correction is operator selectable. Motion compensation may be
applied to most of the position input datagrams.

10 850-160692/U



Input datagrams

In addition to position data from the GGA or GGK datagrams, speed and course
over ground from NMEA VTG datagrams may also be copied into the position
output datagram. These values may be useful in filtering of the positioning during
postprocessing. If a VTG datagram does not follow the GGA or GGK datagram the
course and speed fields of the output datagrams will be set to their invalid values.

As an alternative to GGA, the SIMRAD 90 format position datagram may be used.
The SIMRAD 90 format is intended to be the format of choice when the positioning
system is not a stand-alone GPS receiver supplying GGA or GGK format datagrams.
The SIMRAD 90 format can in addition to global longitude and latitude coordinates also
be used for Northing and Easting type projection coordinates (e.g. UTM).

To cater for applications where the EM 2000 or EM 3000 Sonar Head is mounted on a
subsea vehicle, the original SIMRAD 90 format has been expanded to allow inclusion
of the depth of the vehicle in addition to its horizontal position in longitude/latitude
or Northing/Easting coordinates.

SIS supports logging of all data from a Javad GPS receiver directly attached to the
serial port on the HWS PC.

The Javad GPS receiver outputs binary data in addition to the NMEA datagrams. The
binary can be used by third party software (like Terratec) to compute more accurate
positions using post processing tools. The Javad data files are stored in a separate folder
and kept separate from the other raw data to ease the post processing of the data. The
operator chooses this directory in the runtime parameters in SIS.

A Trimble GPS receiver can also be attached to the serial line of the HWS PC. This is
used for special purposes like land surveying.
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GGA Datagram

Table 1 GGA Datagram

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Sentence formatter Always GGA, — —

UTC of position hhmmss.ss, 000000 to 235959.9... —

Latitude in degrees and minutes, plus optional
decimal minutes

llll.ll, 0000 to 9000.0... —

Latitude – N/S a, N or S —

Longitude in degrees and minutes, plus optional
decimal minutes

yyyyy.yy, 00000 to 18000.0... —

Longitude – E/W a, E or W —

GPS quality indicator x, 0 to 8 1

Number of satellites in use xx, 00 to 12 —

HDOP x.x, — 1

Antenna altitude re mean sea level (geoid) x.x, — 2

Units of antenna altitude M, — —

Geoidal separation (sea level re WGS-84) x.x, — 2

Units of geoidal separation M, — —

Age of differential GPS data x.x, — —

Differential reference station id xxxx, 0000 to 1023 —

Checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 The HDOP (Horizontal Dilution Of Precision) value will be scaled and copied to the

”Measure of position fix quality” field in the position output datagram. The scale
factor depends upon the GPS quality indicator’s value:
• 1 - (SPS or standard GPS) => 1000
• 2 - (differential GPS) => 100
• 3 - (PPS or precise GPS) => 200, but 10 if GGA is treated as RTK. (See Note 2)
• 4 - (kinematic GPS with fixed integers) => 10
• 5 - (kinematic GPS with floating integers) => 50
• 6 - (estimated or dead reckoning mode) => 1000
• 7 - (manual input mode) => 1000
• 8 - (test mode) => 1000, but 10 if GGA is treated as RTK. (See Note 2)
• The ”Measure of position fix quality” field will be set to 65534 (largest valid

number) if the indicator is zero (non-valid position).
This scaling is used to give at least a relatively correct position fix quality change
(in the order of cm) if there are dropouts in differential, precise or kinematic
measurements, although HDOP is not a metric value.
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The GPS manufacturers may have different GPS quality indicators.
2 When the quality factor of a GGA positioning system in use is 4 or 5 a height output

datagram is automatically generated, and also if the quality factor is 3 or 8 and the
operator has set the GGA position to be an RTK position. The height is the sum of
these two fields which are assumed positive upwards (antenna above geoid).
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PTNL, GGK Local coordinate position datagram

Table 2 PTNL Datagram

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Sentence identifier Always PTNL, — —

Sentence formatter Always GGK, — —

Time of position hhmmss.ss, 000000 to 235959.9... —

Date of position mmddyy, 010100 to 123199 —

Latitude in degrees and minutes ddmm.mmmmmmm, 0000 to 9000.0... —

Latitude – N/S a, N or S —

Longitude in degrees and minutes dddmm.mmmmmmm, 00000 to 18000.0... —

Longitude – E/W a, E or W —

GPS quality indicator x, 0 to 7 1

Number of satellites in use xx, 00 to 12 —

DOP x.x, — 1

Antenna/height above ellipsoid EHT x.x, — —

Units of ellipsoidal height (meters) M, — —

Checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes

1 The DOP (Dilution of Precision) value will be scaled and copied to the ”Measure of
position fix quality” field in the position output datagram. The scale factor depends
upon the GPS quality indicator’s value

• 1 – (Standard GPS ) => 1000.0;

• 2 – (RTK float) => 50.0;

• 3 – (RTK fix) => 10.0;

• 4 – (DGPS) => 100.0;

• 5 – (WAAS/EGNOS) => 100.0;

• 6 – (Network Float) => 50.0;

• 7 – (Network fix) => 10.0;

The “Measure of position fix quality” field will be set to 65534 (largest valid
number) if the indicator is zero (non-valid position).

This scaling is used to give at least a relatively correct position fix quality change
(in the order of cm) if there are dropouts in differential, precise or kinematic
measurements, although DOP is not a meter value.

The GPS manufacturers may have different GPS quality indicators.
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Trimble GGK Datagram

Table 3 GGK Datagram

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Sentence formatter Always GGK, — —

Time of position hhmmss.ss, 000000 to 235959.99... —

Date of position MMDDYY, 010100 to 123199 —

Latitude in degrees and minutes, plus optional
decimal minutes

llll.llllll, 0000 to 9000.0... —

Latitude – N/S a, N or S —

Longitude in degrees and minutes, plus optional
decimal minutes

yyyyy.yyyyyy, 00000 to 18000.0... —

Longitude – E/W a, E or W —

GPS quality indicator x, 0 to 3 1

Number of satellites in use xx, 00 to 12 —

DOP x.x, — 1

Antenna ellipsoidal height x.x, — —

Units of antenna ellipsoidal height M, — —

Units of antenna ellipsoidal height x.x, — —

Checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 The DOP (Dilution Of Precision) value will be scaled and copied to the ”Measure of

position fix quality” field in the position output datagram. The scale factor depends
upon the GPS quality indicator’s value
• 1 - (SPS or standard GPS) => 1000
• 2 - (differential GPS) => 100
• 3 - (kinematic GPS) => 10
The ”Measure of position fix quality” field will be set to 65534 (largest valid
number) if the indicator is zero (non-valid position).
This scaling is used to give at least a relatively correct position fix quality change
(in cm) if there are dropouts in differential, precise or kinematic measurements,
although DOP is not a meter value.
The GPS manufacturers may have different GPS quality indicators.
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VTG Datagram

Table 4 VTG Datagram

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Sentence formatter Always VTG, — —

Course over ground, degrees true x.x,T, 0 to 359.9... 1

Course over ground, degrees magnetic x.x,M, 0 to 359.9.. 1

Speed over ground, knots x.x,N, 0 – 1

Speed over ground, km/h x.x,K, 0 – 1

Mode indicator a A,D,E,M,S or N —

Units of antenna ellipsoidal height x.x, — —

Checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 Only true course and the first valid speed field will be used.
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Transponder position

Table 5 SSB - SSBL Position Datagram

Data Description Format Valid range Note
Start_character $ — —

Address PSIMSSB, — —

Time hhmmss.ss, — 2

TP code B01, — 3

Status A, — 4

Error code cc_, — 1

Coordinate system (always radians) R, — —

Orientation (always north oriented) N, — —

SW filter , — 1

X coordinate (Latitiude) x.x, — —

Y coordinate (Longitude) x.x, — —

Depth (Sonar depth in m) x.x, — —

Expected accuracy (Pos. quality in m) x.x, — —

Additional info , — 1

First add value , — 1

Second add value , — 1

Checksum *hh — —

Termination CRLF — —

Notes
1 Not used by multibeam echo sounders.
2 Decoded and used if Clock Synchronisation is set from position datagram.
3 Only this transponder type is accepted by the multibeam.
4 A = OK, V will give bad positions, but datagram will be accepted for logging.
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Simrad 90 Position

Table 6 Simrad 90 datagram

Data Description Format Length Valid range Note
Start identifier = $ Always 24h 1 — —

Talker identifier aa 2 Capital letters —

Sentence formatter Always S90, 4 — —

Date of position DDMMYY, 7 010100 to 311299 —

UTC of position as hour, minute,
second, hundredth of second

hhmmssss, 9 00000000 to
23595999

—

Latitude in degrees, minutes and
decimal minutes

xxxx.xxxx 9 0000.0000 to
9999.9999

A

Hemisphere identifier a, 2 N or S A

Longitude in degrees, minutes and
decimal minutes, or depth in meters

xxxxx.xxxx 10 00000.0000 to
18000.0000

A

Hemisphere or depth identifier a, 2 E, W or D A

Northing or range in meters xxxxxxxxx.x, 12 000000000.0 to
999999999.9

B

Easting or depth in meters xxxxxxx.x, 10 0000000.0 to
9999999.9

B

UTM zone number xx, 3 01 to 60 —

User defined central meridian longitude
or bearing

xxxxx.xxxx 10 00000.0000 to
35999.9999

C

Hemisphere or bearing identifier a, 2 E, W, or B C

System descriptor x, 2 0 to 7 1

Position fix quality indicator x, 2 0 to 9 and A to F 2

Speed over ground in m/s xx.x, 5 00.0 to 99.9 3

Course over ground in degrees xxx.x 5 000.0 to 359.9 3

End of sentence delimiter = ,CRLF Always 2Ch 0Dh 0Ah 3 — —
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Notes
1 The value of system descriptor defines the content of the datagram as follows.

• 0 - The position is longitude latitude in global coordinates given in the fields
noted A.

• 1 - The position is Northing Easting on the Northern hemisphere given in the
fields noted B. If the projection is defined to be UTM the UTM zone number or a
user definable central meridian longitude may be given in the field noted C.

• 2 - As for system descriptor equal to 1, but the position is on the Southern
Hemisphere.

• 3 - As for system descriptor equal to 0, but in addition the depth is given in the
Easting field noted B.

• 4 - As for system descriptor equal to 1, but in addition the depth is given in
the longitude field noted A.

• 5 - As for system descriptor equal to 2, but in addition the depth is given in
the longitude field noted A.

Note

The EM 12, EM 950 and EM 1000 multibeam echo sounders will only accept
values less than 3.

2 The position fix quality given in the position output datagram will be derived
from the quality indicator (this differs from the original definition of the format)
as follows (in m):

Table 7

F E D C B A 9 8 7 6 5 4 3 2 1 0
0.01 0.02 0.05 0.1 .02. 0.5 1 2 5 10 20 50 100 200 500 1000

3 If these fields have valid values they will be copied to equivalent fields in the
position output datagram. They may be used in filtering of the positioning during
postprocessing. (The original definition of the format had line heading in the course
field and its use was to orient real-time displays).
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Tide Input

Table 8 Tide input datagrams

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier a Capital letter —

Sentence formatter Always TIDE, — —

Date and time of prediction / measurement YYYYMMDDhhmm, 199601010000 to
999912312359

—

Tide offset in meters and decimal meters x.x ±327.66 1

Optional checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 A negative number will be assumed to indicate an increase in sea level.

Depth, pressure or height input
This third party telegram definition provides a universal format to hold either depth,
pressure or height information.

Table 9 Depth pressure or height input datagrams

Data Description Format Valid range Note
Start identifier = * Always 24h — —

Sentence identifier ii 00 to 09 1

Talker identifier ii 00 to 09 —

Depth or height in meters and decimal meters x.x — 2

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 A sentence identifier equal to 00 is used for underwater vehicle depth, all other

identifiers are customer specific (usually a datum height).
2 If input is depth, it will be used in the depth output datagram to offset the transmit

transducer depth.
If input is height, which will usually imply a time or position variable datum height,
its use will depend on the sentence identifier and will be implemented as required
by a specific customer.
Depth is positive downwards. Depths may be scaled and offset adjusted using
constants:
output_depth [m] = scale_factor * (input_depth - offset)
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Attitude
Topics
• Overview on page 21
• EM Attitude input format on page 23
• Network attitude velocity input format on page 24
• Sperry MK-39 Attitude input format on page 25
• HDT format on page 26
• SKR80 format on page 26

Overview
Attitude data is generally accepted on one or more serial input port(s) as
• roll, pitch, heave and heading on one port,

or
• roll, pitch and heave on one port and heading separately on another port.
The data update rate should be commensurate with the expected dynamics of the vessel
(typically up to 100 Hz).

The acceptable format for roll, pitch, heave and optionally also heading is a 10 byte long
message originally defined in the EM 1000 for use with digital motion sensors. It is
supported by the following sensors like:
• Applied Analytics POS/MV
• Photokinetics Octans
• Seatex MRU
• Seatex Seapath
• TSS DMS-05
• Coda Octopus
Heading will be accepted in the NMEA 0183 HDT format or in the format used by the
Simrad Robertson SKR80(82) gyrocompass. A current loop to RS-232 converter may
then be required. The Lemkuhl LR40(60) Scan Repeater format is also accepted, as it
is the same as that of the SKR80 with the exception of an extra status byte. Note that
if the attitude sensor is capable of reading the gyrocompass and transfer the heading to
the attitude sensor datagram (if it does not measure heading itself), this is preferable to
interfacing the gyrocompass directly to the system.

Roll, pitch and heading in the Sperry Marine MK-39 MOD2 Attitude and Heading
Reference System format is also accepted. A second motion sensor must then be used to
supply heave.

Attitude data may be supplied from more than one sensor. All data may be logged, but
only one set as chosen by the operator will be used in real time.
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EM 122, EM 302, EM 710, EM 2040 and EM 2040C use frequency modulated (FM)
pulses to extend the detection range while maintaining the high resolution. To properly
take into account the Doppler-effect when using FM mode, real time 3D velocity input is
needed from the motion sensor. The data, on proprietary format, is available via Ethernet
from some of the manufacturers. Currently three manufacturers are supported.

See also Network attitude velocity input format on page 24.
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EM Attitude input format
The EM attitude format is a 10-bytes long message defined as follows
• Byte 1: Sync byte 1 = 00h, or Sensor status = 90h-AFh
• Byte 2: Sync byte 2 = 90h
• Byte 3: Roll LSB
• Byte 4: Roll MSB
• Byte 5: Pitch LSB
• Byte 6: Pitch MSB
• Byte 7: Heave LSB
• Byte 8: Heave MSB
• Byte 9: Heading LSB
• Byte 10: Heading MSB
where LSB = least significant byte, MSB = most significant byte.
All data are in 2’s complement binary, with 0.01° resolution for roll, pitch and heading,
and 1 cm resolution for heave.
• Roll is positive with port side up with ±179.99° valid range
• Pitch is positive with bow up with ±179.99° valid range
• Heave is positive up with ±9.99 m valid range
• Heading is positive clockwise with 0 to 359.99° valid range.
Non-valid data are assumed when a value is outside the valid range.
How roll is assumed to be measured is operator selectable, either with respect to the
horizontal plane (the Hippy 120 or TSS convention) or to the plane tilted by the given
pitch angle (i.e. as a rotation angle around the pitch tilted forward pointing x-axis). The
latter convention (called Tate-Bryant in the POS/MV documentation) is used inside the
system in all data displays and in logged data (a transformation is applied if the roll
is given with respect to the horizontal).
Note that heave is displayed and logged as positive downwards (the sign is changed)
including roll and pitch induced lever arm translation to the system’s transmit transducer.
This format has previously been used with the EM 950 and the EM 1000 with the first
synchronisation byte always assumed to be zero. The sensor manufacturers have been
requested to include sensor status in the format using the first synchronisation byte
for this purpose. It is thus assumed that
• 90h in the first byte indicates a valid measurements with full accuracy
• any value from 91h to 99h indicates valid data with reduced accuracy (decreasing

accuracy with increasing number)
• any value from 9Ah to 9Fh indicates non-valid data but normal operation (for example

configuration or calibration mode)
• and any value from A0h to AFh indicates a sensor error status
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Network attitude velocity input format
EM 122, EM 302, EM 710, EM 2040 and EM 2040C use frequency modulated (FM)
pulses to extend the detection range and still maintaining the high resolution. To properly
take into account the Doppler-effect when using FM mode, real time 3D velocity input is
needed from the motion sensor. The data, on proprietary format, is available via Ethernet
from some of the manufacturers. Currently the following formats are supported:
• Seatex Binary format 11
• Seatex Binary format 23
• Seatex Binary format 26
• POS-MV GRP 102/103
• Coda Octopus MCOM

For details about the formats, please refer to manufacturer documentation.

The datagram will be logged in the Network Attitude Velocity 110 datagram, and the
range corrections applied is documented in the raw range and angle 78 datagram.
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Sperry MK-39 Attitude input format
The format is 18 bytes long, and it is organised as 9 words. The most signigicant byte of
a word is transmitted first.
• Word 1 AA55h.
• Word 2 Status and time.
• Word 3 Heading.
• Word 4 Roll.
• Word 5 Pitch.
• Word 6 Heading rate.
• Word 7 Roll rate.
• Word 8 Pitch rate.
• Word 9 Checksum (MSB) and 1’s complement of checksum (LSB).

All data are in 2’s complement binary. Heading is given within ±180°, roll and pich
within ±90°. (Note however that the values ±180° and ±90° are not permitted, as these
are one bit too high.)

Heading is measured with reference to true North, and positive when the bow points
eastwards. Roll is per definition a rotation angle (Tate-Bryant) and positive when the
starboard side goes up. Pitch is positive when the bow goes down.
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HDT format

Table 10 HDT Format

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Sentence formatter Always HDT, — —

Heading, degrees true x.x,T 0 to 359.9... —

Checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

SKR80 format
The SKR80 sends out a stream of data with four bytes for each measurement. There is
one byte for each digit
• The first byte for the decimal degree (Example: xxx.X)
• The second for the degree (Example: xxX.x)
• The third for the 10’s degree (Example: xXx.x)
• The fourth for the 100’s degree (Example: Xxx.x)

The two uppermost bits of a byte are always zero, the next two bits give the digit, 00
for the decimal, 01 for the degree, 10 for the 10’s degree, and 11 for the 100’s degree.
The lowest four bits give the digit value in 4-bit BCD format. As an example a heading
of 234.5° will give the four bytes 05h 14h 23h 32h. The LR40 adds a fifth byte at the
end for status with the two upper bits of the status byte set to 11 (11000000 for OK,
11001010 for alarm). This status byte is ignored.
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Clock datagrams
Topics
• Clock on page 27
• ZDA format on page 27

Clock
The system clock is used to time stamp all data output. The clock may be set upon start
of new survey or power-up on the Processing Unit (recommended source is a NMEA
ZDA format datagram). The clock will drift, typically some seconds per day, unless it is
synchronised to a 1 PPS (pulse per second) input signal (the clock millisecond counter
will be set to zero whenever a pulse is received). A fully correct clock is only necessary if
the output data are later to be combined with other time critical data logged or created by
other systems, for example an accuracy of up to one minute would be necessary to apply
tidal changes. If the timestamp supplied in the position input datagrams is to be used, it is
imperative that the system clock is correctly set and that 1 PPS synchronisation is used.

ZDA format

Table 11 ZDA format

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Sentence formatter Always ZDA, — —

UTC hhmmss.ss, 000000 to
235959.9...

—

Day xx, 01 to +31 —

Month xx, 01 to +12 —

Year xxxx, 0000 to 9999 —

Local zone hours xx, -13 to +13 1

Local zone minutes xx, 00 to +59 1

Optional checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 Local zone time is not used. An offset time may be entered by the operator to get

the system clock to show a different time than UTC.
Note

Trimble UTC format is also supported.
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Sound speed datagrams
Topics
• Overview on page 28
• Kongsberg Maritime SSP format on page 29
• AML Smart Sensor and AML Micro Sensor format on page 32

Overview
A sound speed profile may be loaded into the Operator Station either on a serial line or
on Ethernet. Formats previously used with existing Kongsberg Maritime echo sounders
(Kongsberg Maritime ASCII and Binary Sound Velocity Profile input datagrams) will
be accepted, but since their resolution in depth is limited to 1 m and the number of
entries to 100, a newer format given below without these limitations is recommended.
This format is also accepted by the Kongsberg Maritime HIPAP and HPR underwater
positioning systems (but not necessarily vice-versa). Note that a complete profile may be
pieced together from several datagrams and edited with the Operator Station’s Sound
Speed Editor.

The new format is completely in ASCII and allows 9998 entries without limitations in
resolution. But the echosounder have other limitations, check note 9. In addition to
depth and sound speed, it allows input of absorption coefficient, pressure, temperature
and salinity or conductivity. The latter parameters may be used to calculate depth, sound
speed and absorption coefficient. Use of a depth dependent absorption coefficient allows
a more accurate determination of bottom backscatter strength.

Note that this datagram may also be logged as output, retaining information not included
in the standard sound speed profile output datagram, such as where and when the profile
has been taken.
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Kongsberg Maritime SSP format

Table 12 SSP format

Data Description Format Length Valid range Note
Start identifier = $ Always 24h 1 — —

Talker identifier aa 2 Capital letters —

Datagram identifier Always Sxx, 4 S00 to S53 1,2

Data set identifier xxxxx, 6 00000 to 65535 —

Number of measurements = N xxxx, 5 0001 to 9999 9

UTC time of data acquisition hhmmss, 7 000000 to 235959 3

Day of data acquisition xx, 3 00 to 31 3

Month of data acquisition xx, 3 00 to 12 3

Year of data acquisition xxxx, 5 0000 to 9999 3

N entries of the next 5 fields – See note 4
– Depth in m from water level or
Pressure in MPa

x.x, 2 – 0 to 12000.00
0 to 1.0000

4

– Sound velocity in m/s x.x, 1 – 1400 to 1700.00 —

– Temperature in °C x.x, 1 – -5 to 45.00 —

– Salinity in
parts per thousand
or Conductivity in S/m

x.x, 1 –
0 to 45.00 or 0 to
7.000

—

Absorption coefficient in dB/km x.x 0 – 0 to 200.00 5

Data set delimiter CRLF 2 0Dh 0Ah —

End of repeat cycle
Latitude in degrees and minutes, plus
optional decimal minutes

llll.ll, Variable
5 –

0000 to 9000.0... 6

Latitude – N/S a, 2 N or S 6

Longitude in degrees and minutes, plus
optional decimal minutes

yyyyy.yy, Variable
6 –

00000 to 18000.0... 6

Longitude – E/W a, 2 E or W 6

Atmospheric pressure in MPa x.x, 1 – 0 to 1.0000 6

Frequency in Hz xxxxxx, Variable — 7

User given comments c–c Variable — 6

Optional checksum *hh — — 8

End of datagram delimiter = \CRLF 5Ch 0Dh 0Ah 3 — —

Notes
1 The datagram identifier identifies what type of data is included. This is shown in

the following table where D is depth, P is pressure, T is temperature, S is salinity,
C is conductivity, c is sound speed, α is absorption coefficient, f is frequency and
L is latitude. The notation c(T,S) indicates for example that the sound speed is to
be calculated from the temperature and salinity input data. When pressure is used,
the atmospheric pressure must be given if the pressure is absolute, otherwise the
pressure must be given re the sea level and the atmospheric pressure must be zero.
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Table 13 SSP format

Identifier Input data Data to be used Comment
S00 D,c D,c Same as S10,

but used immediately.
S01 D,c,T,S D,c,α(D,T,S,L) Same as S12,

but used immediately.
S02 D,T,S D,c(D,T,S,L),α(D,T,S,L) Same as S22,

but used immediately.
S03 D,T,C D,c(D,T,C,L),α(D,T,S,L) Same as S32,

but used immediately.
S04 P,T,S D(P,T,S,L),c(P,T,S,L),α(P,T,S,L) Same as S42,

but used immediately.
S05 P,T,C D(P,T,C,L),c(P,T,C,L),α(P,T,C,L) Same as S52,

but used immediately.
S06 D,c,α D,c,α Same as S11,

but used immediately.
S10 D,c D,c —

S11 D,c,α D,c,α —

S12 D,c,T,S D,c,α(D,T,S,L) —

S13 D,c,α,f D,c,α Frequency dependent

S20 D,T,S D,c(D,T,S,L) —

S21 D,T,S,α D,c(D,T,S,L),α —

S22 D,T,S D,c(D,T,S,L),α(D,T,S,L) —

S23 D,T,S,α,f D,c(D,T,S,L),α Frequency dependent

S30 D,T,C D,c(D,T,S,L)

S31 D,T,C,α D,c(D,T,S,L),α

S32 D,T,C D,c(D,T,S,L),α(D,T,S,L)

S33 D,T,C,α,f D,c(D,T,S,L),α Frequency dependent

S40 P,T,S D(P,T,S,L),c(P,T,S,L)

S41 P,T,S,α D(P,T,S,L),c(P,T,S,L),α

S42 P,T,S D(P,T,S,L),c(P,T,S,L),α(P,T,S,L)

S43 P,T,S,α,f D(P,T,S,L),c(P,T,S,L),α Frequency dependent

S50 P,T,C D(P,T,C,L),c(P,T,C,L)

S51 P,T,C,α D(P,T,C,L),c(P,T,C,L),α

S52 P,T,C D(P,T,C,L),c(P,T,C,L),α(P,T,C,L)

S53 P,T,C,α,f D(P,T,C,L),c(P,T,C,L),α Frequency dependent

2 S00 – S06 is a special case because the sound speed profile will be taken into use
immediately without further operator intervention. The checksum is then mandatory
and must be correct.
Furthermore an entry for zero depth must be present and the profile must be
extended to 12000m.

3 Note that these fields have fixed length and leading zeros must be used.
4 The depth or pressure field is always required while the other fields are optional

except for those required by the datagram identifier. The field-delimiting commas
must always be included even if the fields are empty.
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5 Same date and time for all frequencies.
6 The positions, atmospheric pressure and comment fields are optional. Note that

the option field must not include a \. It is recommended to include sensor type in
the comment field.

7 The field is only present/valid for S13, S23, S33, S43, S53. These datagrams contain
absorption coefficients directly and are only valid for the given frequency. If an
echo sounder employs several frequencies (e.g. EM 710 uses frequencies between
60 and 100 kHz) a datagram must be sent for each frequency used with a maximum
of 10 seconds between each datagram.

8 The checksum field is calculated between the $ and the * delimiters by exclusive
OR’ing of all bytes. The checksum is required for datagram S00, but is optional
for the others.

9 There is a limitation on the size of the sound velocity profile. The file used by the
PU must be maximum 30 kB and limited to a maximum number of depth points.
Maximum 1000 points for EM 2040, EM 710, EM 302 and EM 122. Maximum
570 points for older sounders. The profile can be edited and decimated in the SIS
SVP editor.
SIS will give a warning and reject the input profile if to many measurements.
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AML Smart Sensor and AML Micro Sensor format
An AML Smart Sensor or AML Micro may be used directly for sound speed profile
input on a serial line to the Operator Station. The sensor may also be used to measure the
sound speed at the transducer depth continuously during surveying.
For the AML Micro Sensors, the fields have been swapped so the sound speed is always
the first field.
The supported AML Smart Sensor message formats are:
• SV = Sound Velocity
• SV&P = Sound Velocity and Pressure
• SV&T = Sound Velocity and Temperature
Each message from the sensor is transmitted as a sequence of ASCII characters
terminated by a CRLF pair.
The accepted message formats are as follows:

Table 14 SV Format

± x x x x . x CR LF

where xxxx.x is the measured sound speed in m/s.

Table 15 SV&P Format

± x x x . x x ± x x x x . x CR LF

where the first field is the pressure in decibars relative to the surface and the second is
sound speed in m/s.

Table 16 SV&T Format

± x x . x x x ± x x x x . x CR LF

where the first field is the temperature in degrees Celsius and the second is sound speed
in m/s.

Note

The message formats above are presented in table format to make it easier to see the
location and number of spaces in each message.

Note

The ’±’ character should be interpreted as follows. If the number in the field immediately
following this character is negative, then this character will be “-“ (minus). However,
if the number in the field immediately following this character is positive, then this
character will be a ” ” (space).
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Depth input datagrams from single beam
echo sounder
Topics
• DBS Format on page 33
• DPT Format on page 33
• Simrad format on page 34
Depth datagrams from a single beam echo sounder are accepted for display and logging
on the system. The following formats are supported
• NMEA 0183 DBS
• NMEA 0183 DPT
• Binary datagrams from the Kongsberg Maritime EA echo sounder series, referred

to as the Simrad format.

DBS Format

Table 17 DBS Format

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Sentence formatter Always DBS, — —

Depth in feet x.x,f, 0.1 – 1

Depth in meters x.x,M, 0.1 – 1

Depth in fathoms x.x,F 0.1 – 1

Checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 The decoding priority will be meter field, feet field and fathom field with the depth

value extracted from the first field with valid data.

DPT Format

Table 18 DPT Format

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Sentence formatter Always DPT, — —

Depth in meters from the transducer x.x, 0.1 – —

Offset of transducer from waterline in meters x.x, 0 – 1
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Table 18 DPT Format (cont'd.)

Data Description Format Valid range Note
Maximum range scale in use x.x, — —

Checksum *hh — —

End of sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 A negative value implying that the offset is from the keel should not be used.

Simrad format

Table 19 Simrad format

Data Description Format Valid range Note
Start identifier = D Always 34h — —

Channel identifier x, 1 to 311 1

Time as HHMMSShh xxxxxxxx, 00000000 to 23595999 1

Depth in meters from the transducer 32 bit IEEE 754 floating
point

0.1 – 1

Bottom backscattering strength in dB 32 bit IEEE 754 floating
point

— —

Transducer number 32 bit integer — —

Athwartship slope in degrees 32 bit IEEE 754 floating
point

— —

Notes
1 Only the channel identifier, depth and time will be decoded by the system. The least

significant byte is transmitted first (the Intel convention).
Note

The datagram must be sent on Ethernet to Processing Unit UDP2. For UDP port
address, see PU information and status on page 104
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Remote control datagrams
A Remote Control datagram has been implemented to allow
• the multibeam echo sounder to start logging on remote command.
• the multibeam echo sounder to send out parameter and sound speed profile datagrams,

“IUR”, consisting of Installation parameters (I), sound speed profile datagram (U) and
Runtime datagram (R), as a response to the remote command.

• the survey line numbers to be set from a remote location.
Note that the parameter and sound speed profile datagrams are always sent out when
logging is started or any changes are made to the parameters or sound speed. They may
also be sent out regularly at operator specified intervals.
In addition to the primary application of the Remote Control datagrams as described
above, they are also used to report the SIS pinging and logging status to external
recipients. For more information on this, see “notification of SIS pinging and logging
activity” in the SIS Operator Manual (doc.no: 850-164709).

Table 20 Remote Control datagrams

Data Description Format Valid range Note
Start identifier = $ Always 24h — —

Talker identifier aa Capital letters —

Datagram identifier Rxx, R00 to R20 1

EM model number EMX=dddd, — —

Responsible operator ROP=a—a, — 2

Survey identifier SID=a—a, — 2

Survey line number PLN=d..d, — 2

Survey line identifier (planned line no) PLL=d—d, — 2

Comment COM=a—a — 3

Optional checksum *hh — —

End of datagram delimiter = \CRLF 5Ch 0Dh 0Ah — —

Notes
1 Rxx defines what action the system is to take with respect to pinging and logging

of data in addition to changes in the parameters. Note that logging of survey data
on local storage is not affected, this is determined by operator control from the
menu only.
• R00 - System to stop pinging (and logging if on)
• R10 - System to stop all logging (but continue or start pinging).
• R11 - System to start logging locally and send a start sequence “IUR” consisting

of an installation parameter datagram (I), sound speed profile datagram (U) and a
runtime datagram (R).

• R12 - System to start logging locally. “IUR” will be sent.
• R13 - System to start logging on new line to local storage only.

850-160692/U 35



Kongsberg EM Series

• R20 - System to send “IUR”.
• The current version of SIS does not support R11 and R13. On SIS, the effect of

R00, R10 and R12 datagrams is exactly the same as if the operator has used the
pinging and logging buttons.

2 The current version of SIS has no support for ROP, SID and PLN. PLL is used for
R12 to indicate line number to be logged.

3 Only used for “External notification of SIS pinging and logging activity”, see SIS
Operator Manual.
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Sound speed at transducer
In addition to receiving sound speed at transducer from sound velocity probe/sensor
attached to the SIS HWS through a serial line, it is also possible to send this information
through the Ethernet.

Note

The datagram format and port address etc. is also explained in the “External sensors”
chapter in the SIS Reference Manual.

KSSIS 80 Datagram
Sound velocity and temperature sent over LAN (UDP) to SIS HWS

Table 21 KSSIS 80 input datagram

Data Description Format Valid Range Note
Start identifier = $ Always 24h — —

Talker identifier Always KS — —

Sentence formatter Always SIS, — —

Datagram ID Always 80, — —

Sound speed (m/s) x.x, 1400.0 – 1700.0 —

Temperature (Celsius) x.x — —

End if sentence delimiter = CRLF Always 0Dh 0Ah — —

End if sentence delimiter = CRLF Always 0Dh 0Ah — —
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Output datagrams

Topics
• Introduction on page 38
• Multibeam data on page 40
• External sensors on page 66
• Sound speed on page 77
• Multibeam parameters on page 80
• PU information and status on page 104
• SIS generated output on page 112

Introduction
Output datagrams are usually logged to disk on the EM Series Operator Station. The
output datagrams may also be exported to user provided programs on the Operator
Station or on an external Ethernet network using UDP protocol (remote logging). An
NMEA DPT depth datagram may be exported on a serial line.

The output datagrams are mostly in binary format using signed or unsigned integer
numbers with lengths of 1, 2 or 4 bytes.

Note

Please be aware that the following echo sounders: EM 3002, EM 710, EM 302, EM 122,
EM 2040, EM 2040C and ME70BO use little endian byte order.

Note

We recommend that software written to decode EM Series data includes a check for the
byte ordering with a provision for byte swapping. Suitable data fields to check on are
the length field at the start of the datagram, the EM Series model number field and
possibly the date and time fields.

The basic output datagram structure established with the EM 100 echo sounder is
retained.
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• All datagrams (except the NMEA DPT datagram) start with STX, datagram type and
time tag, and end with ETX and checksum (sum of bytes between STX and ETX). In
addition the total length of the datagram (not including the length field) will precede
the STX byte, given as a four byte binary number.

• The length field is only included when logging to tape and/or disk, but not for
datagrams logged to a remote location. The length can then be derived from the
network software. Systems logging data remotely should add this length at the start
of each datagram. This length is required if the data are to be used with Kongsberg
Maritime post-processing systems.

• The time stamp resolution is 1 millisecond and includes the century. The time stamp
is binary. The date is given as 10000*year(4 digits) + 100*month + day, for example
19950226 for February 26, 1995. All date fields in the output datagrams use this
format. A time is usually given (in milliseconds) from midnight.

• The datagrams identify the multibeam echo sounder model and its serial number. The
system model number is 120 for the EM 120, 300 for the EM 300, etc. For the EM
3000D (the dual head system) the model number was originally given as 3002 and
the serial number is that of Sonar Head number 1. However in the depth datagram
model numbers 3003-3008 are now used to also identify the actual transmit and
sampling frequencies of the two heads. If only one head is activate on the EM 3000D,
it is coded as a single head system. For EM 3002 the model number is 3020. The
EM 3002 has separate datagrams (depth, range, seabed image, water column) for the
two sonar heads.

• Due care has been taken to include all parameters needed in postprocessing in the
relevant datagrams, with a minimum of data duplication. Where resolution of a data
field is variable, a resolution descriptor is included.

• Invalid data are always identified by the highest positive number allowed in a field
unless otherwise noted.

• A real-time parameter datagram has been added to enable logging of parameters not
used in postprocessing, but which may be important in checking the quality of the
logged data, or to allow tracing of reasons for possible malfunctions.

• Attitude data as time continuous records and raw ranges and beam pointing angles are
logged to allow eventual postprocessing corrections. The logged attitudes are valid at
the transmit transducer, and are corrected for any sensor offsets.

Systems with dual swaths (fans of receiver beams with different tilt) will have separate
datagrams for each swath.

In the datagrams for EM 122, EM 302, EM 710, ME70 BO, EM 2040 and EM 2040C,
both valid and invalid beams are included (The beam index then became redundant
information and is therefore removed). This is done to be able to store seabed image data
also for beams missing a valid detection.
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Multibeam data
Topics
• Depth datagram on page 40
• XYZ 88 on page 43
• Extra detections on page 46
• Central beams echogram on page 50
• Raw range and beam angle (F) on page 52
• Raw range and beam angle (f) on page 53
• Raw range and angle 78 on page 55
• Seabed image datagram on page 58
• Seabed image data 89 on page 60
• Water column datagram on page 62

Depth datagram
Note

This datagram is used for EM 2000, EM 3000, EM 3002, EM 1002, EM 300 and EM
120. The XYZ 88 on page 43 is used for EM 122, EM 302, EM 710, ME70 BO, EM
2040 and EM 2040C.

Table 22 Depth datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = D(epth data) (Always 44h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Heading of vessel in 0.01° 2U 0 to 35999 —

Sound speed at transducer in dm/s 2U 14000 to 16000 —

Transmit transducer depth re water level at time
of ping in cm

2U 0 to 65536 1

Maximum number of beams possible 1U 48 – —

Number of valid beams = N 1U 1 to 254 —

z resolution in cm 1U 1 to 254 —

x and y resolution in cm 1U 1 to 254 —
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Table 22 Depth datagram (cont'd.)

Data Description Format Valid range Note
Sampling rate (f) in Hz
or
Depth difference between sonar heads in the EM
3000D

2U

2S

300 to 30000

-32768 to 32766

3

4

Repeat cycle — N entries of : 16*N — —

Depth (z) from transmit transducer
(unsigned for EM 120 and EM 300)

2S or 2U -32768 to +32766 or
1 to 65534

2

Acrosstrack distance (y) 2S -32768 to 32766 2

Alongtrack distance (x) 2S -32768 to 32766 2

Beam depression angle in 0.01° 2S -11000 to 11000 3

Beam azimuth angle in 0.01° 2U 0 to 56999 3

Range (one - way travel time) 2U 0 to 65534 3

Quality factor 1U 0 to 254 5

Length of detection window (samples/4) 1U 1 to 254 —

Reflectivity (BS) in 0.5 dB resolution)
(Example: -20 dB = 216)

1S -128 to +126 —

Beam number 1U 1 to 254 6

End of repeat cycle
Transducer depth offset multiplier 1S -1 to +17 1

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 The transmit transducer depth plus the depth offset multiplier times 65536 cm

should be added to the beam depths to derive the depths re the water line. The
depth offset multiplier will usually be zero, except when the EM 2000/3000 Sonar
Head is on an underwater vehicle at a depth larger than 655.36 m. Note that the
offset multiplier will be negative (-1) if the actual heave is large enough to bring
the transmit transducer above the water line. This may represent a valid situation,
but may also be due to an erroneously set installation depth of either the transducer
or the water line.

2 The beam data are given re the transmit transducer or sonar head depth and the
horizontal location of the active positioning system’s antenna. Heave, roll, pitch,
sound speed at the transducer depth and ray bending through the water column have
been applied. On the EM 1002/2000/3000/3002 the beam depths must be regarded
as signed values to take into account beams which may be going upwards. On
the EM 120/300 the beam depths are always positive and the values are therefore
unsigned.

3 The range, beam depression angle (positive downwards and 90° for a vertical beam)
and beam azimuth angle (re vessel centerline) are given relative to the transducer
(sonar head) at the ping transmit time. Heave, roll, pitch and sound speed at the
transducer depth have been applied, but not ray bending. These values may thus be
directly used for a new ray bending calculation with a revised sound speed profile to
generate new sounding depths and positions without any need for using attitude data.
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One way travel time = range / sampling rate / 4
Note that if the data need to be reprocessed with a new sound speed at the transducer
depth or new roll, pitch or heave values, full reprocessing starting with the raw range
and beam angle data is required. Attitude data is also required in this reprocessing,
and both these data types will in the future be logged as standard.
If the beam azimuth angle has a value larger than 35999, the beam pointing angle
has replaced the beam depression angle, and the raw two-way travel time has
replaced the one-way heave and beam angle corrected travel time. The transmit tilt
angle plus 54000 is given in the beam azimuth angle field. The use of this data
definition is available on remote output to a port named as “RawDepth...” for use by
other systems which do their own attitude and sound speed processing.

4 In an EM 3000D the transmit transducer depth is that of Sonar Head number 1,
taking into account the depth offset multiplier as described in note 1. The range
multiplier is replaced by the difference in depth between Sonar Head number 1 and
2, i.e. head 2 depth is equal to head 1 depth (possibly modified with depth offset
multiplier) plus the depth difference. The range sampling rates in Hz of the two
heads is given through the EM model number according to the following table:

Table 23 EM 3000D

EM model number 3003 3004 3005 3006 3007 3008
Sonar Head 1 13956 14293 13956 14621 14293 14621

Sonar Head 2 14621 14621 14293 14293 13956 13956

Previously the model number of the EM 3000D was given as 3002 with head sample
rates of 13956 and 14621 Hz respectively. The head depths in this case should be
assumed to be equal, and although the mathematical derivation of final beam depths
would otherwise be the same as described above, the transmit transducer depth was
not actually exactly that of the sonar heads.

5 The quality number’s upper bit signifies whether amplitude (0) or phase (1)
detection has been used. If amplitude the 7 lowest bits give the number of samples
used in the centre of gravity calculation. If phase the second highest bit signifies
whether a second (0) or first (1) order curve fit has been applied to determine the
zero phase range, and the 6 lowest bits indicates the quality of the fit (actually the
normalized variance of the fit re the maximum allowed, i.e. with a lower number
the better the fit).

6 Beam 128 is the first beam on the second sonar head in an EM 3000D dual head
system.
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XYZ 88
Note

This datagram is used for the models EM 2040, EM 2040C, EM 710, EM 122, EM
302 and ME70BO. All receiver beams are included, check detection info and real time
cleaning for beam status (note 4 and 5).

Table 24 XYZ 88

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = X (58h, 88d) 1U — —

EM model number (Example: EM 710 = 710) 2U — —

Date = year*10000 + month*100 + day (Example:
Sep 26, 2005 = 20050926)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Heading of vessel (at TX time) in 0.01° 2U 0 to 35999 —

Sound speed at transducer in dm/s 2U 14000 to 16000 —

Transmit transducer depth in m re water level at
time of ping

4F — 1

Number of beams in datagram = N 2U 1 – 1024 —

Number of valid detections 2U 1 – 1024 —

Sampling frequency in Hz 4F — —

Scanning info. 1U — 7

Spare 3U — —

Repeat cycle - N entries of : 20*N — —

Depth (z) from transmit transducer in m 4F — 2

Acrosstrack distance (y) in m 4F — 2

Alongtrack distance (x) in m 4F — 2

Detection window length in samples 2U — —

Quality factor 1U 0 – 254 3

Beam incidence angle adjustment (IBA) in 0.1 deg 1S -128 to 126 6

Detection information 1U — 4

Real time cleaning information 1S — 5

Reflectivity (BS) in 0.1 dB resolution
(Example: –20.1 dB = FF37h= 65335)

2S — 4

End of repeat cycle
Spare (always 0) 1U 0 —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Notes
1 The transmit transducer depth should be added to the beam depths to derive the

depths re the water line. Note that the transducer depth will be negative if the
actual heave is large enough to bring the transmit transducer above the water line.
This may represent a valid situation, but may also be due to an erroneously set
installation depth of either the transducer or the water line.

2 The beam data are given re the transmit transducer or sonar head depth and the
horizontal location (x,y) of the active positioning system’s reference point. Heave,
roll, pitch, sound speed at the transducer depth and ray bending through the water
column have been applied.

3 Scaled standard deviation (sd) of the range detection divided by the detected range
(dr):
Quality factor = 250*sd/dr.

4 This datagram may contain data for beams with and without a valid detection:
A) If the most significant bit (bit7) is zero, this beam has a valid detection. Bit 0–3
is used to specify how the range for this beam is calculated.
0= Amplitude detect (0xxx 0000)
1= Phase detect (0xxx 0001)
2-15= Future use
B) If the most significant bit (bit7) is 1, this beam has an invalid detection. Bit 0–3
is used to specify how the range (and x,y,z parameters) for this beam is calculated
0= Normal detection (1xxx 0000)
1= Interpolated or extrapolated from neighbour detections (1xxx 0001)
2= Estimated (1xxx 0010)
3= Rejected candidate (1xxx 0011)
4= No detection data is available for this beam (all parameters are set to zero)
(1xxx 0100)
5-15= Future use
The invalid range has been used to fill in amplitude samples in the seabed image
datagram.
Bit 4 Reflectivity (used in Beam intensity display) correction for Lamberts law and
for normal incidence:
0= not compensated (xxx0 xxxx) (to show beam incidence angle dependency)
1= compensated (xxx1 xxxx) ( uses same correction as for seabed image data)

5 A real time data cleaning module may flag out beams.
Negative values indicates that this beam is flagged out, and is not to be used.

6 Due to raybending, the beam incidence angle at the bottom hit will usually differ
from the beam launch angle at the transducer and also from the angle given by a
straight line between the transducer and the bottom hit. The difference from the
latter is given by the beam incidence angle adjustment (IBA). The beam incidence
angle re the horizontal, corrected for the ray bending, can be calculated as follows:
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BAC = atan( z / abs(y) ) + IBA.
BAC is positive downwards and IBA will be positive when the beam is bending
towards the bottom. This parameter can be helpful for correcting seabed imagery
data and in seabed classification.

7 Only used by EM 2040. See appendix EM 2040 Scanning mode on page 121 for
details.
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Extra detections
Note

This datagram is used for the models EM 2040 and EM 2040C with Slim Processing Unit.

Table 25 Extra detections

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = l (6Ch, 108d) 1U — —

EM model number (Example: EM 710 = 710) 2U — —

Date = year*10000 + month*100 + day (Example:
Sep 26, 2005 = 20050926)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U — —

Datagram counter 2U — —

Datagram version ID 2U — —

Swath counter 2U — —

Swath index 2U — —

Heading in 0.01 degrees 2U 0 to 3599 —

Sound velocity at TX in dm/s 2U — —

Depth of reference point in meters 4F — —

Water Column sample rate (WCsr) 4F — —

Raw amplitude (Seabed Image) sample rate (SIsr) 4F — —

RX transducer index 2U — —

Number of extra detections (Nd) 2U 0 to — —

Number of detection classes (Nc) 2U 10 —

Number of byte per class (cycle 1) 2U — —

Number of alarm flags 2U — 7

Number of bytes per detection (cycle 2) 2U —

Repeat cycle 1 – Detection classes (Nc): 16*Nc 1 to 10 —

Start depth (% of depth) 2U 0 to 300 —

Stop depth (% of depth) 2U 1 to 300 —

100 * QF threshold 2U 0.01 to 1 10

BS threshold (dB) 2S -10 to -60 11

SNR threshold (dB) 2U 5 to 15 12

Alarm threshold (number of extra det. required) 2U 1 to 99, 0 = off 6

Number of extra detections 2U 0 to — —

Show class 1U 0 to 1 13

Alarm flag 1 1U 0 or 1/16/17 5

End of repeat cycle 1
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Table 25 Extra detections (cont'd.)

Data Description Format Valid range Note
Repeat cycle 2 – Extra detections (Nd): 64*Nd — —

Depth (z) 4F — —

Across (y) 4F — —

Along (x) 4F — —

Delta latitude 4F — —

Delta longitude 4F — —

Beam Pointing angle (deg. re array) 4F — —

Applied pointing angle correction 4F — —

Two time travel time (seconds) 4F — —

Applied two way travel time corrections
(seconds, f.ex. Doppler correction)

4F — —

BS in 0.1 dB 2S — —

Beam incidence angle adjustment (IBA) in 0.1 deg 1S -128 to 126 9

Detection info 1U — 8
spare 2U — —

TX sector number/TX array index 2U — 1

Detection window length 2U — —

Quality factor (old) 2U — —

Real time cleaning info 2U — —

Range factor in % 2U — —

Detection class number 2U — —

Confidence level 2U — —

QF * 10 (Ifremer Quality factor) 2U — —

Water column beam number 2U — —

Beam angle across re vertical (deg) 4F — —

Detected range in (WCsr) samples 2U — —

Raw amplitude samples (Ns) 2U — 2

End of repeat cycle 2
Repeat cycle 3 – Ns entries: 2*Ns +1 — —

Raw amplitude samples (0.1dB) 2S — 2,3,4

End of repeat cycle 3
Spare 1C — —

Spare (Always 0) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 Same TX beam sector index as used in the range and angle 78 datagram. TX sector

dependent info like tilt, frequency, pulse length etc. can be found in this datagram.
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2 2*Ns(i) +1 raw amplitude samples are stored, ranging from (detected range –Ns)
to (detected range +Ns). The sample rate is: SIUsr, i = extra detect index number
(1-Nd).

3 BS is calculated as for Water Column data (TVG applied = XlogR + 2AlpaR + C, X
and C can be found in the Water column datagram).

4 Raw amplitude (Seabed Image) sample rate: SIsr
5 Alarm flag 1

0 – No alarm
1 – Number of extra detections are above Alarm threshold.

6 Alarm threshold. This is the number of extra detections required to raise
Alarm flag 1. The threshold limit is entered in SIS.

7 Number of Alarm flag 1 raised in Repeat cycle 1.
8 This datagram may contain data for beams with and without a valid detection:

A) If the most significant bit (bit7) is zero, this beam has a valid detection. Bit 0–3
is used to specify how the range for this beam is calculated.
0= Amplitude detect (0xxx 0000)
1= Phase detect (0xxx 0001)
2-15= Future use
B) If the most significant bit (bit7) is 1, this beam has an invalid detection. Bit 0–3
is used to specify how the range (and x,y,z parameters) for this beam is calculated
0= Normal detection (1xxx 0000)
1= Interpolated or extrapolated from neighbour detections (1xxx 0001)
2= Estimated (1xxx 0010)
3= Rejected candidate (1xxx 0011)
4= No detection data is available for this beam (all parameters are set to zero)
(1xxx 0100)
5-15= Future use
The invalid range has been used to fill in amplitude samples in the seabed image
datagram.
Bit 4 Reflectivity (used in Beam intensity display) correction for Lamberts law and
for normal incidence:
0= not compensated (xxx0 xxxx) (to show beam incidence angle dependency)
1= compensated (xxx1 xxxx) ( uses same correction as for seabed image data)

9 Due to raybending, the beam incidence angle at the bottom hit will usually differ
from the beam launch angle at the transducer and also from the angle given by a
straight line between the transducer and the bottom hit. The difference from the
latter is given by the beam incidence angle adjustment (IBA). The beam incidence
angle re the horizontal, corrected for the ray bending, can be calculated as follows:
BAC = atan( z / abs(y) ) + IBA.
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BAC is positive downwards and IBA will be positive when the beam is bending
towards the bottom. This parameter can be helpful for correcting seabed imagery
data and in seabed classification.

10 QF threshold: the Ifremer Qualty factor is used to estimate the relative depth error.
QF threshold equal to 0.1 means a 0.1% depth error threshold. At 100 m depth this
the depth error threshold would be 10 cm. Valid range is 0.01 to 1 %.

11 BS threshold: the backscatter values for the extra detections are TVG compensated
amplitude values, calculated in the same way as beam intensity values. For man
made objects the backscatter values may be higher than -40 dB.

12 SNR threshold: for extra detections the Signal-to-Noise-Ratio is the amplitude value
for the detection relative to the "neighbor" values at this range.

13 Show class: The show class value is set by the user to show extra detections in the
various display. For SIS this means the Water Column, Geographical and Cross
Track display. If the Show Class box is ticked in the extra detections tab, the value
will be 1, else 0.
All classes will be stored regardless of the show class parameter. In SIS there are
7 depth classes. There is also class number eight, with the show class parameter
always set to 0. This is an extra "rescue" class for extra detections outside user
defined thresholds, mainly intended for Kongsberg Maritime use.
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Central beams echogram
Note

This datagram is only available for EM 120 and EM 300.

Table 26 Central beams echogram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = K (Always 4Bh) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Mean absorption coefficient in 0.01 dB/km 2U 1 to 20000 1

Pulse length in μs 2U 50 – 1

Range to normal incidence used in TVG 2U 1 to 16384 1

Start range sample of TVG ramp if not enough
dynamic range (0 else)

2U 0 to 16384 —

Stop range sample of TVG ramp if not enough
dynamic range (0 else)

2U 0 to 16384 —

Normal incidence BS in dB (BSN)
(Example: -20 dB = 236)

1S -50 to +10 1

Oblique BS in dB (BSO)
(Example: -1 dB = 255)

1S -60 to 0 1

Tx beamwidth in 0.1° 2U 1 to 300 1

TVG law crossover angle in 0.1° 1U 20 to 300 1

Number of included beams (N) 1U 1 – —

Repeat cycle — N entries of : 6*N —

beam index number 1U 0 to 253 2

spare byte to get even length (Always 0) 1U — —

number of samples per beam = Ns 2U 1 – —

start range in samples 2U 1 – 3

End of repeat cycle
Repeat cycle – ΣNs entries of: ΣNs —

Sample amplitudes in 0.5 dB
(Example: -30 dB = 196)

1S -128 to +126 —

End identifier = ETX (Always 03h) 1U — —

End of repeat cycle
Spare byte if required to get even length (Always
0 if used)

0–1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Notes
1 The sample amplitudes are not corrected in accordance with the detection

parameters derived for the ping, as is done for the seabed image data.
2 The beam index number is the beam number - 1.
3 The range for which the first sample amplitude is valid for this beam given as a

two-way range. The detection range is given in the raw range and beam angle
datagram. Note that data are provided regardless of whether a beam has a valid
detection or not.
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Raw range and beam angle (F)
Note

Only used for EM 3000

Table 27 Raw range and beam angle datagrams

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = F (Always 46h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Maximum number of beams possible 1U 48 – —

Number of valid receive beams = N 1U 1 to 254 —

Sound speed at transducer in dm/s 2U 14000 to 16000 —

Repeat cycle – N entries of : 8*N — —

– Beam pointing angle in 0.01° 2S -11000 to 11000 1

– Transmit tilt angle in 0.01° 2U -2999 to 2999 1

– Range (two-way travel time) 2U 0 to 65534 1

– Reflectivity (BS) in 0.5 dB resolution 1S -128 to 126 —

– Beam number 1U 1 to 254 —

End of repeat cycle
Spare (Always 0) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 21U — —

Notes
1 The beam pointing angle is positive to port and the transmit tilt angle is positive

forwards for a normally mounted system looking downwards. The range resolution
in time is the inverse of the range sampling rate given in the depth datagrams.
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Raw range and beam angle (f)
Note

Used for EM 120, EM 300, EM 1002, EM 2000, EM 3000 and EM 3002

Table 28 Raw range and beam angle datagrams

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = f (Always 66h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Number of transmit sectors = Ntx 2U 1 to 20 —

Number of valid receive beams = N 2U 1 to 1999 —

Sampling frequency in 0.01 Hz (F) 4U 100 to 100000 * 100 —

ROV depth in 0.01 m 4S —

Sound speed at transducer in 0.1 m/s 2U 14000 to 16000 —

Maximum number of beams possible 2U 1 to 1999 —

Spare 1 2U —

Spare 2 2U

Ntx entries of : 20*Ntx — —

Tilt angle ref TX array in 0.01° 2S -2900 to 2900 —

Focus range in 0.1 m (0 = No focus) 2U 0 to 65535 —

Signal length in μs 4U — —

Transmit time offset in μs 4U — —

Center frequency in Hz 4U — —

Bandwidth in 10 Hz 2U 1 to 65535 —

Signal waveform identifier 1U 0 to 99 1

Transmit sector number 1U 0 to 99 —

N entries of : 12*N — —

Beam pointing angle ref RX array in 0.01° 2S -11000 to 11000 —

Range in 0.25 samples (R) 2U 0 to 65535 2

Transmit sector number 1U 0 to 19 —

Reflectivity (BS) in 0.5 dB resolution 1S -128 to 127 —

Quality factor 1U 0 to 254 —

Detection window length in samples
(/4 if phase)

1U 1 to 254 —

Beam number 2S -1999 to 1999 3
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Table 28 Raw range and beam angle datagrams (cont'd.)

Data Description Format Valid range Note
Spare 2U — —

Spare (Always 0) 1U 0 —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 1U — —

Notes
1 0 = cw, 1 = FM
2 Two way travel time = R / ( 4 * F / 100 )
3 The beam number normally starts at 0.
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Raw range and angle 78
Note

Used for EM 122, EM 302, EM 710, ME70 BO, EM 2040 and EM 2040C. All receiver
beams are included, check detection info and real time cleaning for beam status (see
note 3 and 4).

Table 29 Raw range and beam angle 78 datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = N (4eh, 78d) 1U — —

EM model number (Example: EM 710 = 710) 2U — —

Date = year*10000 + month*100 + day (Example:
Sep 26, 2005 = 20050926)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Sound speed at transducer in 0.1 m/s 2U 14000 to 16000 —

Number of transmit sectors = Ntx 2U 1 – —

Number of receiver beams in datagram = Nrx 2U 1 – —

Number of valid detections 2U 1 – —

Sampling frequency in Hz 4F — —

Dscale 4U — 5

Repeat cycle 1 -
Ntx entries of:

24*Ntx — —

Tilt angle re TX array in 0.01° 2S -2900 to 2900 6

Focus range in 0.1 m (0 = No focusing applied) 2U 0 to 65534 —

Signal length in s 4F — —

Sector transmit delay re first TX pulse, in s 4F — —

Centre frequency in Hz 4F — —

Mean absorption coeff. in 0.01 dB/km 2U — —

Signal waveform identifier 1U 0 to 99 1

Transmit sector number / TX array index 1U — 7

Signal bandwidth in Hz 4F — —

End of Repeat cycle 1
Repeat cycle 2 -
Nrx entries of:

16*Nrx — —

Beam pointing anlge re RX array in 0.01° 2S -11000 to 11000 6

Transmit sector number 1U — 8

Detection info 1U — 3

Detection window length in samples 2U — —

Quality factor 1U 0 to 254 2

850-160692/U 55



Kongsberg EM Series

Table 29 Raw range and beam angle 78 datagram (cont'd.)

Data Description Format Valid range Note
D corr 1S — 5

Two way travel time in s 4F — 5

Reflectivity (BS) in 0.1 dB resolution 2S — 3

Real time cleaning info 1S — 4

Spare 1U — —

End of Repeat cycle 2
Spare (Always 0) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 0 = cw, 1 = FM up sweep, 2= FM down sweep.
2 Scaled standard deviation (sd) of the range detection divided by the detected range

(dr):
Quality factor = 2500*sd/dr.

3 This datagram may contain data for beams with and without a valid detection:
A) If the most significant bit (bit7) is zero, this beam has a valid detection. Bit 0–3
is used to specify how the range for this beam is calculated.
0= Amplitude detect (0xxx 0000)
1= Phase detect (0xxx 0001)
2-15= Future use
B) If the most significant bit (bit7) is 1, this beam has an invalid detection. Bit 0–3
is used to specify how the range (and x,y,z parameters) for this beam is calculated
0= Normal detection (1xxx 0000)
1= Interpolated or extrapolated from neighbour detections (1xxx 0001)
2= Estimated (1xxx 0010)
3= Rejected candidate (1xxx 0011)
4= No detection data is available for this beam (all parameters are set to zero)
(1xxx 0100)
5-15= Future use
The invalid range has been used to fill in amplitude samples in the seabed image
datagram.
Bit 4 Reflectivity (used in Beam intensity display) correction for Lamberts law and
for normal incidence:
0= not compensated (xxx0 xxxx) (to show beam incidence angle dependency)
1= compensated (xxx1 xxxx) ( uses same correction as for seabed image data)
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4 For future use. A real time data cleaning module may flag out beams. Bit 7 will
be set to 1 if the beam is flagged out. Bit 0-6 will contain a code telling why the
beam is flagged out.

5 The Doppler correction applied in FM mode is documented here to allow the
uncorrected slant ranges to be recreated if desired. The correction is scaled by a
common scaling constant for all beams and then included in the datagram using a
signed 8 bit value for each beam. The uncorrected range (two-way travel time) can
be reconstructed by subtracting the correction from the range in the datagram:
T(uncorrected) = T(datagram) - D(corr)/D(scale)

6 The angles are relative to the transducer array, except for ME70BO, where the
angles are relative to the horizontal plane

7 Transmit sector number / TX array index parameter in the TX loop.
For EM 2040, this parameter is used to specify which of the three separate TX
arrays is used for the actual sector. See appendix EM 2040 transducer installation
offsets on page 115 for details. For other echo sounders, the parameter is a loop
index (0-(Ntx-1)).

8 Transmit sector number parameter in the RX loop
This parameter is an index to the TX loop, see note 7. For use in EM 2040, see
appendix EM 2040 transducer installation offsets on page 115 for details.
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Seabed image datagram
Note

This datagram is used for EM 2000, EM 3000, EM 3002, EM 1002, EM 300 and EM 120.

Table 30 Seabed image datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = (Seabed image data) (Always
53h)

1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Mean absorption coefficient in 0.01 dB/km 2U 1 to 20000 1

Pulse length in μs 2U 50 – 1

Range to normal incidence used to correct sample
amplitudes in no. of samples

2U 1 to 16384 —

Start range sample of TVG ramp if not enough
dynamic range (0 else)

2U 0 to 16384 —

Stop range sample of TVG ramp if not enough
dynamic range (0 else)

2U 0 to 16384 —

Normal incidence BS in dB (BSN)
(Example: -20 dB = 236)

1S -50 to 10 —

Oblique BS in dB (BSO) (Example:–1 dB = 255) 1S -60 to 0 —

Tx beamwidth in 0.1° 2U 1 to 300 —

TVG law crossover angle in 0.1° 1U 20 to 300 —

Number of valid beams (N) 1U 1 to 254 —

Repeat cycle – N entries of : 6*N —

beam index number 1U 0 to 253 2

sorting direction 1S -1 or 1 3

number of samples per beam = Ns 2U 1 – —

centre sample number 2U 1 – 4

End of repeat cycle
Repeat cycle – ΣNs entries of: ΣNs — —

Sample amplitudes in 0.5 dB
(Example: –30 dB = 196)

1S -128 to 126 —

End of repeat cycle
Spare byte if required to get even length
(Always 0 if used)

0 – 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Notes
1 These fields have earlier had other definitions.
2 The beam index number is the beam number -1.
3 The first sample in a beam has lowest range if 1, highest if -1. Note that the range

sampling rate is defined by the sampling rate in the depth output datagram and that
the ranges in the seabed image datagram are all two-way from time of transmit
to time of receive.

4 The centre sample number is the detection point of a beam.
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Seabed image data 89
Note

Used for EM 122, EM 302, EM 710, ME70 BO, EM 2040 and EM 2040C.

Table 31 Seabed image data 89 datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = Y (59h, 89d) 1U — —

EM model number (Example: EM 710 = 710) 2U — —

Date = year*10000 + month*100 + day (Example:
Sep 26, 2005 = 20050926)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Sampling frequency in Hz 4F — —

Range to normal incidence used to correct sample
amplitudes in no. of samples

2U 1 to 16384 —

Normal incidence BS in 0.1 dB (BSN) 2S — —

Oblique BS in 0.1 dB (BSO) 2S — —

Tx beamwidth along in 0.1° 2U 1 to 300 —

TVG law crossover angle in 0.1° 2U 20 to 300 —

Number of valid beams (N) 2U 1 – —

Repeat cycle – N entries of : 6*N —

Sorting direction 1S -1 or 1 1

Detection info 1U — 2

Number of samples per beam = Ns 2U 1 – —

Centre sample number 2U 1 – 3

End of repeat cycle
Repeat cycle – ΣNs entries of: ΣNs — —

Sample amplitudes in 0.1 dB
(Example: -30.2 dB = FED2h = 65234d)

2S — —

End of repeat cycle
Spare (Always 0) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 The first sample in a beam has lowest range if 1, highest if -1. Note that the ranges in

the seabed image datagram are all two-way from time of transmit to time of receive.
2 This datagram may contain data for beams with and without a valid detection:
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A) If the most significant bit (bit7) is zero, this beam has a valid detection. Bit 0–3
is used to specify how the range for this beam is calculated.
0= Amplitude detect (0xxx 0000)
1= Phase detect (0xxx 0001)
2-15= Future use
B) If the most significant bit (bit7) is 1, this beam has an invalid detection. Bit 0–3
is used to specify how the range (and x,y,z parameters) for this beam is calculated
0= Normal detection (1xxx 0000)
1= Interpolated or extrapolated from neighbour detections (1xxx 0001)
2= Estimated (1xxx 0010)
3= Rejected candidate (1xxx 0011)
4= No detection data is available for this beam (all parameters are set to zero)
(1xxx 0100)
5-15= Future use
The invalid range has been used to fill in amplitude samples in the seabed image
datagram.

3 The centre sample number is the detection point of a beam.

850-160692/U 61



Kongsberg EM Series

Water column datagram
Note

Used for EM 122, EM 302, EM 710, EM 2040, EM 3002 and ME70BO.

The receiver beams are roll stabilized.

Table 32 Water column datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U 48 to 65535 —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = k (Always 6Bh) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Number of datagrams 2U 1 to Nd 2

Datagram numbers 2U 1 to Nd 2

Number of transmit sectors = Ntx 2U 1 to 20 —

Total no. of receive beams 2U 1 to Nd —

Number of beams in this datagram = Nrx 2U 1 to Nd —

Sound speed in 0.1 m/s (SS) 2U 14000 to 16000 —

Sampling frequency in 0.01 Hz resolution (SF) 4U 1000 to 4000000 1

TX time heave (at transducer) in cm 2S –1000 to 1000 —

TVG function applied (X) 1U 20 to 40 4

TVG offset in dB (C) 1S — 4

Scanning info. 1U — 7

Spare 3U — —

Ntx entries of : —

Tilt angle re TX array in 0.01° 2S -1100 to 1100 —

Center frequency in 10 Hz 2U 1000 to 50000 —

Transmit sector number 1U 0 to 19 —

Spare 1U — —

Nrx entries of :
Beam pointing angle ref vertical in 0.01° 2S -11000 to 11000 —

Start Range sample number 2U 0 to 65534 —

Number of samples (Ns) 2U 0 to 65534 6

Detected range in samples (DR) 2U 0 to 65534 3

Transmit sector number 1U 0 to 19 —

Beam number 1U 0 to 254 5
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Table 32 Water column datagram (cont'd.)

Data Description Format Valid range Note
Ns entries of:
Sample amplitude in 0.5 dB resolution

1S -128 to126 —

Spare byte if required to get even length (always
0 if used)

0 – 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 The sample rate is normally decimated to be approximately the same as the

bandwidth of the transmitted pulse.
2 Maximum 64 kB in one datagram. More than 1 datagram may be required to

transfer the data. Example: 500 m range * 160 beams * 1 Byte / 0.1 m per sample
gives 800 kB. This requires 13 datagrams. A number of complete beams will be
transferred in each datagram.
For EM 3002 the maximum number of datagrams Nd is 16 and the maximum
number of beams Nb is 254. For EM 122, EM 302, EM 710, ME70BO, EM 2040
and EM 2040C this is increased to allow for up to 32 datagrams and 512 beams.

3 Total Range in meters = Sound speed * detected range / (sample rate * 2) = SS10 *
DR / (FS100 * 2) = 5 * SS * DR / FS (FS100= FS/100, SS10= SS/10). The range is
set to zero when the beam has no bottom detection.

4 The TVG function applied to the data is X logR + 2 Alpha R + OFS + C. The
parameters X and C is documented in this datagram. OFS is gain offset to
compensate for TX Source Level, Receiver sensitivity etc.

5 The 1U beam number (valid range 0-254) is redundant information and is limited to
a maximum of 255 beams. For systems with more than 255 beams this parameter
will be set to 255 (invalid).

6 From 01.01.2008, this number will always be an even number, due to alignments
7 Only used by EM 2040. See appendix EM 2040 Scanning mode on page 121 for

details.
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Quality factor datagram 79
Note

Used for EM 122, EM 302, EM 710, EM 2040, EM 2040C, EM 3002 and ME70BO.

Table 33 Quality factor datagram 79

Data Description Format Valid range Note
Number of bytes in datagram 4U –

Start identifier = STX (Always 02h) 1U –

Type of datagram = O (4fh, 79d) 1U –

EM model number (Example: EM 710 = 710) 2U –

Date = year*10000 + month*100 + day (Example:
Jan 23, 2012 = 20120123)

4U –

Time since midnight in milliseconds (Example:
08:12:51.234 = 29570234)

4U 0 to 86399999

Ping counter (sequential counter) 2U 0 to 65535

System serial number 2U 100 –

Number of receive beams = Nrx 2U 1 –

Number of parameters per beam = Npar 1U 1 – 2

Spare 1U –

Repeate cycle. Nrx entries of: 4*Nrx*Npar 2

IFREMER quality factor 4F >=0 1

(More parameters may be added
in the future)

End of repeate cycle.
Spare (Always 0) 1U –

End identifier = ETX (Always 03h) 1U –

Check sum of data between STX and ETX 2U –

Notes
1 The Quality Factor is an estimate of the standard deviation of the detected depth.

QF = − log
(

Est (∂z)
z

)

Examples:
QF = 3.0 means an estimated standard deviation of 0.1% of the detected depth.
QF = 2.0 means an estimated standard deviation of 1.0% of the detected depth.
QF = 0 means that the Quality Factor could not be computed.
The Quality Factor is calculated by the echo sounder according to formulas provided
by IFREMER.
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References:
a Lurton X., Augustin J.M., "A Measurement Quality Factor for Swath

Bathymetry Sounders", IEEE Journal Of Oceanic Engineering, 35 (4),
pp.852-862 (2010)

b Lurton X., Ladroit Y., Augustin J.M., "A Quality Estimator of Acoustic
Sounding Detection" The International Hydrographic Review, Nov.2010, vol.4,
pp 35-45 (2010)

2 Currently, only one parameter is defined, i.e. Npar = 1. In the future, the datagram
format may be expanded with additional parameters. Software decoding the
datagram should take into account Npar when decoding the datagram. If Npar is
larger than expected, additional parameters should be ignored. If Npar is smaller
than expected, some parameters are not available. Note there may be data collected
with preliminary echosounder software with Npar set to zero, even though there is
one parameter per beam (i.e. Npar = 0 and Npar = 1 both means 1 parameter per
repeat cycle). Each parameter is assumed to be 4 bytes long.
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External sensors
Topics
• Attitude datagram on page 66
• Network attitude velocity datagram 110 on page 68
• Clock on page 70
• Depth (pressure) or height datagram on page 71
• Heading on page 72
• Position on page 73
• Single beam echo sounder depth on page 75
• Tide datagram on page 76

Attitude datagram

Table 34 Attitude datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = A(ttitude data) (Always 041h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (at start of
data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Attitude counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 –

Number of entries = N 2U 1 – —

Repeat cycle – N entries of: 12*N —

– Time in milliseconds since record start 2U 0 to 65534 —

– Sensor status 2U — 1

– Roll in 0.01° 2S -18000 to 18000 —

– Pitch in 0.01° 2S -18000 to 18000 —

– Heave in cm 2S -1000 to 10000 —

– Heading in 0.01° 2U 0 to 35999 —

End of repeat cycle
Sensor system descriptor 1U — 2

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Notes
1 The sensor status will be copied from the input datagram’s two sync bytes if the

sensor uses the EM format. See the input format description for further details.
2 The sensor system descriptor will show which sensor the data is derived from, and

which of the sensor’s data have been used in real time by bit coding:
• xx00 xxxx – motion sensor number 1
• xx01 xxxx – motion sensor number 2
• xxxx xxx1 – heading from the sensor is active
• xxxx xx0x – roll from the sensor is active
• xxxx x0xx – pitch from the sensor is active
• xxxx 0xxx – heave from the sensor is active
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Network attitude velocity datagram 110

Table 35 Network attitude velocity datagram 110

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = n(etwork data) (Always 6Eh,
110d)

1U — —

EM model number (Example: EM 710 = 710) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 08, 2007 = 20070208)

4U — —

Time since midnight in milliseconds (Example:
08:12:51.234 = 29570234)

4U 0 to 86399999 —

Network Attitude counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 –

Number of entries = N 2U 1 – —

Sensor system descriptor 1S — 1

Spare 1U — —

Repeat cycle – N entries of: — —

– Time in milliseconds since record start 2U 0 to 65535 —

– Roll in 0.01° 2S -18000 to 18000 —

– Pitch in 0.01° 2S -18000 to 18000 —

– Heave in cm 2S -1000 to 10000 —

– Heading in 0.01° 2U 0 to 35999 —

– Number of bytes in input datagram (Nx) 1U 1 to 254 —

– Network attitude input datagram as received Nx x 1U — 2

End of repeat cycle — — —

Spare byte if required to get even length
(always 0 if used)

0 – 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 The sensor system descriptor shows which sensor the data is derived from, and

which of the sensor's data have been used in real time by bit coding:
• 0x10 xxxx – attitude velocity sensor 1 (UDP5)
• 0x11 xxxx – attitude velocity sensor 2 (UDP6)
• 01xx xxxx – velocity from the sensor is active
• 0xxx xxx1 – heading from the sensor is active
• 0xxx xx0x – roll from the sensor is active
• 0xxx x0xx – pitch from the sensor is active
• 0xxx 0xxx – heave from the sensor is active
• 1111 1111 – (-1) function is not used

68 850-160692/U



Output datagrams

2 Complete input datagram. Header is kept for identification:

POS M/V: $GRP102 or $GRP103 (ASCII)
CodaOctopus MCOM: E8h
Seapath binary 11: q (ASCII)
Seapath binary 23: AAh 51h

An extra byte is added at the end of the input datagram if needed for alignment.
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Clock

Table 36 Clock datagrams

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = C(lock data) (Always 043h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (at start of
data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Clock counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 –

Date = year*10000 + month*100 + day (from
external clock input)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (from external
clock datagram)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999

1 PPS use (active or not) (0 = inactive) 1U — 1

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 Shows if the system clock is synchronised to an external 1 PPS signal or not.
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Depth (pressure) or height datagram

Table 37 Depth (pressure) or height datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = h(eight data) (Always 068h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Height counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Height in cm 4S - 4294967296 to
4294967295

—

Heigth type 1U 0 to 200 1

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 0: The height is derived from the GGK or GGA datagram and is the height of the

water level at the vertical datum (possibly motion corrected).
Height is derived from the active position system only.
1 - 99: The height type is as given in the Depth (pressure) or height input datagram.
100: The input is depth taken from the OwnShipsData/S90.
200: Input from depth sensor.
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Heading

Table 38 Heading datagrams

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = H(eading data)
(Always 048h)

1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (at start of
data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Heading counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 –

Number of entries = N 2U 1 – —

Repeat cycle – N entries of: 4*N —

– Time in milliseconds since record start 2U 0 to 65534 —

– Heading in 0.01° 2U 0 to 35999 —

End of repeat cycle
Heading indicator (active or not) (0 = inactive) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Position

Table 39 Position datagrams

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = P(osition data)
(Always 050h)

1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Position counter (sequential counter) 2U 0 to 65535 —

System / serial number 2U 100 – —

Latitude in decimal degrees*20000000 (negative
if southern hemisphere)
(Example: 32°34’ S = -651333333)

4S — —

Longitude in decimal degrees*10000000 (negative
if western hemisphere)
(Example: 110.25° E = 1102500000 )

4S — —

Measure of position fix quality in cm 2U — 1

Speed of vessel over ground in cm/s 2U 0 – 1

Course of vessel over ground in 0.01° 2U 0 to 35999 1

Heading of vessel in 0.01° 2U 0 to 35999 —

Position system descriptor 1U 1 to 254 2

Number of bytes in input datagram 1U – 254 —

Position input datagram as received Variable — 3

Spare byte if required to get even length
(Always 0 if used)

0 – 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 These data will be valid only if available as input.

The calculation is done according to the selected position input format.
See Position on page 9.

2 The position system descriptor shows which source this data is from and its
real-time use by bit coding:
• xxxx xx01 - position system no 1
• xxxx xx10 – position system no 2
• xxxx xx11 – position system no 3
• 10xx xxxx – the position system is active, system time has been used
• 11xx xxxx - the position system is active, input datagram time has been used
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• xxxx 1xxx – the position may have to be derived from the input datagram which
is then in SIMRAD 90 format.

3 Complete input datagram except header and tail (such as NMEA 0183 $ and CRLF).
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Single beam echo sounder depth
This datagram will contain the profile actually used in the real time raybending
calculations to convert range and angle to xyz data. It will usually be issued together
with the installation parameter datagram.

Table 40 Single beam echo sounder depth datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = E(cho sounder data) (Always
045h)

1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (at start of
data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Echo sounder counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Date = year*10000 + month*100 + day (from input
datagram if available)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (from input
datagram if available)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Echo sounder depth from waterline in cm 4U 0 to 1200000 —

Source identifier (S, T, 1, 2 or 3) ASCII 1

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 Identifies the source datagram type, i.e. NMEA DBS, NMEA DPT or EA 500

series channel 1-3 respectively.
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Tide datagram

Table 41 Tide datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = T(ide data) (Always 054h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (Example:
Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Tide counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 –

Date = year*10000 + month*100 + day (from input
datagram)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (from input
datagram)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Tidal offset in cm 2S -32768 to 32766 —

Spare (Always 0) 1U —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Sound speed
Topics
• Surface sound speed on page 77
• Sound speed profile datagram on page 78
• Kongsberg Maritime SSP output datagram on page 79

Surface sound speed

Table 42 Surface sound speed datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = G (Always 047h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (at start of
data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Sound speed counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 –

Number of entries = N 2U 1 – —

Repeat cycle – N entries of: 4*N — —

– Time in seconds since record start 2U 0 to 65534

– Sound speed in dm/s (incl. offset) 2U 14000 to 15999 —

End of repeat cycle
Spare (Always 0) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Sound speed profile datagram
This datagram will contain the profile actually used in the real time raybending
calculations to convert range and angle to xyz data. It will usually be issued together
with the installation parameter datagram.

Table 43 Sound speed profile datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = U (Always 055h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (at start of
data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Profile counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Date = year*10000 + month*100 + day
(when profile was made)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in seconds
(when profile was made)
(Example: 08:12:51 = 29571)

4U 0 to 86399 —

Number of entries = N 2U 1 – —

Depth resolution in cm 2U 1 to 254 —

Repeat cycle — N entries of: 8*N — —

– Depth 4U 0 to 1200000 —

– Sound speed in dm/s 4U 14000 to 17000 —

End of repeat cycle
Spare byte to get even length (Always 0) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Kongsberg Maritime SSP output datagram
This datagram will contain the profile actually used in the real time raybending
calculations to convert range and angle to xyz data.

Table 44 Kongsberg Maritime SSP output datagram

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = W (Always 057h) 1U — —

EM model number (Example: EM 3000 = 3000) 2U — —

Date = year*10000 + month*100 + day (at start of
data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

SSP counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Input datagram starting with Sentence formatter
and ending with Comment

Variable — —

Spare byte if required to get even length (Always
0 if used )

0 – 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —
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Multibeam parameters
Topics
• Installation parameters on page 80
• Runtime parameters on page 89
• Mechanical transducer tilt on page 98
• ExtraParameters datagram on page 99

Installation parameters
This datagram is an ASCII datagram except for the header which is formatted as in all
other output datagrams. The datagram is issued as a start datagram when logging is
switched on and as a stop datagram when logging is turned off, i.e. at the start and end
of a survey line. It may also be sent to a remote port as an information datagram. It is
usually followed by a sound speed profile datagram.
In the datagram all ASCII fields start with a unique three character identifier followed
by “=”. This should be used when searching for a specific field as the position of a
field within the datagram is not guaranteed. The number or character part following is
in a variable format with a minus sign and decimal point if needed, and with “,” as
the field delimiter. The format may at any time later be expanded with the addition of
new fields at any place in the datagram.

Table 45 Installation parameters

Data Description Example Format Valid range Note
Number of bytes in datagram — 4U — —

Start identifier = STX Always 02h 1U — —

Type of datagram = I or i(installation
parameters)
or r(emote information)

Start = 049h
Stop = 069h
Remote info = 70h

1U — —

EM model number EM 3000 = 3000 2U — —

Date = year*10000 + month*100 + day Feb 26, 2009 =
20090226

4U — —

Time since midnight in milliseconds 08:12:51.234 =
29570234

4U 0 to 86399999 —

Installation datagram counter — 2U 0 to 65534 —

System serial number — 2U 100 – 24

Secondary system serial number — 2U 100 – 24

Water line vertical location in m WLZ=x.x, ASCII — —

System main head serial number SMH=x.x, ASCII 100 – 1

Hull Unit HUN=x, ASCII 0 or 1 —

Hull Unit tilt offset HUT=x.x, ASCII — —

TX serial number TXS=x–x, ASCII 100 – 25

TX no. 2 serial number T2X=x-x, ASCII 100 – 25

RX no. 1, serial number R1S=x-x, ASCII 100 – —
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Table 45 Installation parameters (cont'd.)

Data Description Example Format Valid range Note
RX no. 2, serial number R2S=x–x, ASCII 100 – —

System transducer configuration STC=x, ASCII 0– 6 26

Transducer 0 vertical location in m S0Z=x.x, ASCII 19

Transducer 0 along location in m S0X=x.x, ASCII 19

Transducer 0 athwart location in m S0Y=x.x, ASCII 19

Transducer 0 heading in degrees S0H=x.x, ASCII 19

Transducer 0 roll in degrees re horizontal S0R=x.x, ASCII 19

Transducer 0 pitch in degrees S0P=x.x, ASCII 19

Transducer 1 vertical location in m S1Z=x.x, ASCII — 19

Transducer 1 along location in m S1X=x.x, ASCII — 19

Transducer 1 athwart location in m S1Y=x.x, ASCII — 19

Transducer 1 heading in degrees S1H=x.x, ASCII — 19

Transducer 1 roll in degrees re horizontal S1R=x.x, ASCII — 19

Transducer 1 pitch in degrees S1P=x.x, ASCII — 19

Transducer 1 no of modules S1N=x–x, ASCII — 19

Transducer 2 vertical location in m S2Z=x.x, ASCII — 19

Transducer 2 along location in m S2X=x.x, ASCII — 19

Transducer 2 athwart location in m S2Y=x.x, ASCII — 19

Transducer 2 heading in degrees S2H=x.x, ASCII — 19

Transducer 2 roll in degrees re horizontal S2R=x.x, ASCII — 19

Transducer 2 pitch in degrees S2P=x.x, ASCII — 19

Transducer 2 no of modules S2N=x–x, ASCII — 19

Transducer 3 vertical location in m S3Z=x.x, ASCII — 19

Transducer 3 along location in m S3X=x.x, ASCII — 19

Transducer 3 athwart location in m S3Y=x.x, ASCII — 19

Transducer 3 heading in degrees S3H=x.x, ASCII — 19

Transducer 3 roll in degrees re horizontal S3R=x.x, ASCII — 19

Transducer 3 pitch in degrees S3P=x.x, ASCII — 19

TX array size (0=0.5º, 1=1º, 2=2º) S1S=x, ASCII — —

RX array size (1=1º, 2=2º) S2S=x, ASCII — —

System (sonar head 1) gain offset GO1=x.x, ASCII — —

Sonar head 2 gain offset GO2=x.x, ASCII — —

Outer beam offset OBO=x.x, ASCII — —

High/Low Frequency Gain Difference FGD=x.x, ASCII — —

Transmitter (sonar head no1) software
version

TSV=c–c, ASCII — 2

Receiver (sonar head 2) software version RSV=c–c, ASCII — 2

BSP software version BSV=c–c, ASCII — 2

Processing unit software version PSV=c–c, ASCII — 2

DDS software version DDS=c–c, ASCII — 2
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Table 45 Installation parameters (cont'd.)

Data Description Example Format Valid range Note
Operator station software version OSV=c–c, ASCII — 2

Datagram format version DSV=c–c, ASCII — 2

Depth (pressure) sensor along location
in m

DSX=x.x, ASCII — —

Depth (pressure) sensor athwart location
in m

DSY=x.x, ASCII — —

Depth (pressure) sensor vertical location
in m

DSZ=x.x, ASCII — —

Depth (pressure) sensor time delay in
millisec

DSD=x–x, ASCII — —

Depth (pressure) sensor offset DSO=x.x, ASCII — —

Depth (pressure) sensor scale factor DSF=x.x, ASCII — —

Depth (pressure) sensor heave DSH=aa, ASCII IN or NI 3

Active position system number APS=x, ASCII 0 to 2 7

Position system 1, quality check of
position, 0=off, 1=on

P1Q=x, ASCII 0 or 1 27

Position system 1 motion compensation P1M=x, ASCII 0 or 1 4

Position system 1 time stamp used P1T=x, ASCII 0 or 1 5

Position system 1 vertical location in m P1Z=x.x, ASCII — —

Position system 1 along location in m P1X=x.x, ASCII — —

Position system 1 athwart location in m P1Y=x.x, ASCII — —

Position system 1 time delay in seconds P1D=x.x, ASCII — —

Position system 1 geodetic datum P1G=c–c, ASCII — —

Position system 2, quality check of
position, 0=off, 1=on

P2Q=x, ASCII 0 or 1 27

Position system 2 motion compensation P2M=x, ASCII 0 or 1 4

Position system 2 time stamp use P2T=x, ASCII 0 or 1 5

Position system 2 vertical location in m P2Z=x.x, ASCII — —

Position system 2 along location in m P2X=x.x, ASCII — —

Position system 2 athwart location in m P2Y=x.x, ASCII — —

Position system 2 time delay in seconds P2D=x.x, ASCII — —

Position system 2 geodetic datum P2G=c–c, ASCII — —

Position system 3, quality check of
position, 0=off, 1=on

P3Q=x, ASCII 0 or 1 27

Position system 3 motion compensation P3M=x, ASCII 0 or 1 4

Position system 3 time stamp use P3T=x, ASCII 0 or 1 5

Position system 3 vertical location in m P3Z=x.x, ASCII —

Position system 3 along location in m P3X=x.x, ASCII —

Position system 3 athwart location in m P3Y=x.x, ASCII —

Position system 3 time delay in seconds P3D=x.x, ASCII —

Position system 3 geodetic datum P3G=c–c, ASCII —

Position system 3 on serial line or
Ethernet

P3S= x, ASCII 0 for Ethernet

Motion sensor 1 vertical location in m MSZ=x.x, ASCII —
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Table 45 Installation parameters (cont'd.)

Data Description Example Format Valid range Note
Motion sensor 1 along location in m MSX=x.x, ASCII —

Motion sensor 1 athwart location in m MSY=x.x, ASCII —

Motion sensor 1 roll reference plane MRP=aa, ASCII HO or RP
Motion sensor 1 time delay in milliseconds MSD=x–x, ASCII —

Motion sensor 1 roll offset in degrees MSR=x.x, ASCII —

Motion sensor 1 pitch offset in degrees MSP=x.x, ASCII —

Motion sensor 1 heading offset in degrees MSG=x.x, ASCII —

Motion sensor 2 vertical location in m NSZ=x.x, ASCII — 6

Motion sensor 2 along location in m NSX=x.x, ASCII — 6

Motion sensor 2 athwart location in m NSY=x.x, ASCII — 6

Motion sensor 2 roll reference plane NRP=aa, ASCII HO or RP 6

Motion sensor 2 time delay in milliseconds NSD=x–x, ASCII — 6

Motion sensor 2 roll offset in degrees NSR=x.x, ASCII — 6

Motion sensor 2 pitch offset in degrees NSP=x.x, ASCII — 6

Motion sensor 2 heading offset in degrees NSG=x.x, ASCII — 6

Gyrocompass heading offset in degrees GCG=x.x, ASCII — —

Roll scaling factor MAS=x.x, ASCII — —

Transducer depth sound speed source SHC=x, ASCII 0 or 1 8

1PPS clock synchronization PPS=x, ASCII 0 to 2 20

Clock source CLS=x, ASCII (0), 1 to 3 9

Clock offset in seconds CLO=x, ASCII
Active attitude velocity sensor VSN =x, ASCII 0 – 2 10

Attitude velocity sensor 1 UDP port
address (UDP5)

VSU =x–x, ASCII 1024 – 65535 11

Attitude velocity sensor 1 Ethernet port VSE =x, ASCII 0 to 2 12

Attitude velocity sensor 2 UDP port
address (UDP6)

VTU =x–x, ASCII 1024 – 65535 11

Attitude velocity sensor 2 Ethernet port VTE =x, ASCII 0 to 2 12

Active roll/pitch sensor ARO =x, ASCII 2, 3, 8, or 9 22

Active heave sensor AHE =x, ASCII 2, 3, 8, or 9 22

Active heading sensor AHS =x, ASCII 0 to 9 23

Ethernet 2 address VSI=
xxx.xxx.xxx.xxx,

ASCII — 13

Ethernet 2 IP network mask VSM=
xxx.xxx.xxx.xxx,

ASCII — 13

Multicast sensor IP multicast address
(Ethernet 2)

MCAn=
xxx.xxx.xxx.xxx,

ASCII — 15

Multicast sensor UDP port number MCUn=x–x, ASCII 1024 – 65535 15

Multicast sensor identifier MCIn=aaaah, ASCII See PU Setup
command

15

Multicast position system number MCPn=x, ASCII 0 – 3 16

Ships noise level SNL =x, ASCII 0 to 2 21

Cartographic projection CPR=aaa, ASCII — —
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Table 45 Installation parameters (cont'd.)

Data Description Example Format Valid range Note
Responsible operator ROP=c–c, ASCII — —

Survey identifier SID=c–c, ASCII — —

Raw File Name RFN=c–c ASCII — 17

Survey line identifier (planned line no) PLL=x–x, ASCII — Not used

Comment COM=c–c, ASCII — 18

Spare byte if required to get even length Always 0 if used 0–1U — —

End identifier = ETX Always 03h 1U — —

Check sum of data between STX and ETX — 2U — —

Notes
1 EM 3000D: Serial number of head no 2 if that head is the only one in use, otherwise

the serial number of head no 1.
EM 3000: Serial number of the head.

2 A version number is given as 3 alphanumerical fields separated by decimal points,
plus date as yymmdd (for example 3.02.11 991124).

3 IN = the heave of an underwater vehicle is presumed to be measured by the vehicle’s
depth sensor and the heave sensor input is not used by system.

4 1 = the positions are motion compensated
0 = the positions are not motion compensated

5 0 = the system has used its own time stamp for the valid time of the positions
1 = the system has used the time stamp of the position input datagram (external
time).

6 If entries for a second motion sensor are not included although two sensors are being
used, they are presumed to have the same parameters.

7 Position system number -1.
8 0 = Transducer depth sound speed is used as the initial entry the sound speed profile

used in the raytracing calculations.
1 = Transducer depth sound speed is NOT used for raytracing calculations.
Note that the source of the sound speed at the transducer depth (and this sound
speed is always used to calculate beam pointing angles if required) is logged in
the runtime datagram.

9 (0 - not set)
1 – ZDA
2 – Active POS
3 – Operator station
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10 0 – Attitude velocity sensor not used.
1 – Attitude velocity sensor 1 active.
2 – Attitude velocity sensor 2 active.
(If VSN = 0, the other VSx parameters are not relevant and need not to be sent.)
It is assumed that attitude velocity sensor 1 and motion sensor 1 is the same physical
unit and share the installation parameters MSx. It is also assumed that attitude
velocity sensor 2 and motion sensor 2 is the same physical unit and share the
installation parameters NSx.

11 Value depends on sensor type.
12 0 – Not in use

1 – Use the existing Ethernet port used for communication to topside (SIS).
2 – Use Ethernet 2 (if available). Network address and mask are set up by VSI
and VSM.

13 Ethernet 2 on the transceiver unit is configured with IP address and network mask
according to VSI and VSM.

14 Not used.
15 Sensor input datagrams to be provided on given formats.

Note

Available from SIS version 3.7.

xxxx xxxx xxxx xxxx xxxx xx1x — NMEA GGA

xxxx xxxx xxxx xxxx xxx1 xxxx — NMEA ZDA

xxxx xxxx 1xxx xxxx xxxx xxxx — NMEA GLL

xxxx xxx1 xxxx xxxx xxxx xxxx — Own Ship's Data, position

xxxx xx1x xxxx xxxx xxxx xxxx — ROV Depth and Sound speed from Own Ship's Data

xxxx x1xx xxxx xxxx xxxx xxxx — Sound Velocity (SOUNDVELOCTYPROFILE_DATA)

xxxx 1xxx xxxx xxxx xxxx xxxx — Attitude Sagem format

16 This number indicates which position system that will arrive via this multicast.
0 – no position will be received from Multi cast, default value.
1 – position system 1
2 – position system 2
3 – position system 3

17 The RFN parameter has been reintroduced specifically for customers converting
from Merlin to SIS. This parameter contains the name of the raw data file used for
normal logging and for watercolumn logging (i.e. the .all and .wcd files). The RFN
parameter is included in the Installation Parameters ( ’I’ ) datagram found at the
start of the logged filed and in the Stop datagram (’i’) datagram found at the end
of the logged file. This RFN parameter is also included in the distributed ’I’ and
’i’ datagrams.
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Note

The RFN parameter contains the file name with the extension (.all or.wcd), but not
the storage path.

Raw File Name convention:
LineNo_YYYYMMDD_HHMMSS(UTC)_ShipName.all

18 The comment field may contain any ASCII characters.
19 Transducer 1–3 (S0–S3) will have different function depending on type of echo

sounder used:
Echo sounder S0–Transducer 0 S1–Transducer 1 S2–Transducer 2 S3–Transducer 3

EM 122, EM 302,
EM 710

Not used TX transducer RX transducer Not used

EM 2040 Not used TX transducer RX transducer Not used

EM 2040 dual RX Not used TX transducer RX transducer port RX transducer
starboard

EM 2040 dual TX TX transducer port TX transducer
starboard

RX transducer port RX transducer
starboard

EM 3002/EM
2040C

Not used Sonar head 1 Sonar head 2 Not used

ME70BO Transducer Not used Not used Not used

The installation parameters refer to the centre of the transducer faces. For EM 2040,
the physical transducer arrays are offset relative to the centre of the transducer
faces. Please refer to appendix EM 2040 transducer installation offsets on page 115
for details.
For EM 2040C, the physical transducer arrays are offset relative to the centre of the
sonar head face. Please refer to appendix EM 2040C installation offsets on page 123.

20 1PPS setup:
0 – not in use
1 – falling edge detect
2 – rising edge detect

21 Ships noise level to be entered under System Parameter in the Installation menu.
0 – Normal
1 – High
2 – Very high

22 Specifies input port for active sensor.
2 – COM2 (motion sensor1)
3 – COM3 (motion sensor2)
8 – UDP5 (attitude velocity sensor 1)
9 – UDP6 (attitude velocity sensor 2)
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23 Specifies input port for active heading sensor.
0 – UDP2 (position system 3)
1 – COM1 (position system 1)
2 – COM2 (motion sensor 1)
3 – COM3 (motion sensor 2 or position system 2)
4 – COM4 (position system 3)
5 – Multicast 1
6 – Multicast 2
7 – Multicast 3
8 – UDP5 (attitude velocity sensor 1)
9 – UDP6 (attitude velocity sensor 2)

24 For EM 3002 Dual Head, EM 2040 Dual RX and EM 2040C Dual Head: Multibeam
datagrams related to Head 1 / RX 1 (port) is labelled with "System serial number".
Multibeam datagrams related to Head 2 / RX 2 (starboard) is labelled with
"Secondary system serial number".

25 For an EM 2040 dual TX configuration, “TX serial number” is used for serial number
for TX1 (port), while “TX no. 2 serial number” is is used for TX2 (starboard).

26 System transducer configuration parameter (STC) in the Installation datagram
contains system info:
STC Transducer configuration Example systems

0 Single TX + single RX EM 122, EM 302, EM 710, EM 2040 Single

1 Single Head EM 3002 Single head, EM 2040C Single head

2 Dual Head EM 3002 Dual head, EM 2040C Dual head

3 Single TX + Dual RX EM 2040 Dual RX

4 Dual TX + Dual RX EM 2040 Dual TX

5 Portable single head EM 2040P Single head

6 Modular EM 2040M

7 Portable dual head EM 2040P Dual head

If present, the STC parameter can be used in decoding of the transducer installation
parameters.

S0X/Y/Z/R/P/H S1X/Y/Z/R/P/H S2X/Y/Z/R/P/H S3X/Y/Z/R/P/H

STC=0 – TX RX –

STC=1 – Head – –

STC=2 – Head 1 Head 2 –

STC=3 – TX RX 1 RX 2

STC=4 TX 1 TX 2 RX 1 RX 2

STC=5 – Head 1 – –

STC=6 – Head 1 – –

STC=7 – Head 1 Head 2 –
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27 0 – The quality check is performed by the operator station. If there is height info in
the data, height datagram will be created.
1 – The quality check is performed in the TRU/PU
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Runtime parameters

Table 46 Runtime parameters

Data Description Format Valid range Note

Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = R(untime parameter)
(Always 052h)

1U — —

EM model number (Example: EM 710 = 710) 2U — —

Date = year*10000 + month*100 + day (at start
of data record)
(Example: june 26, 2009 = 20090626)

4U — —

Time since midnight in milliseconds (at start of
data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter 2U 0 to 65535 —

System serial number 2U 100 – —

Operator Station status 1U — 1

Processing Unit status (CPU) 1U — 1

BSP status 1U — 1

Sonar Head or Transceiver status 1U — 1

Mode 1U 0 – 2

Filter identifier 1U 0 to 255 3

Minimum depth in m 2U 0 to 10000 —

Maximum depth in m 2U 1 to 12000 —

Absorption coefficient in 0.01 dB/km 2U 1 to 20000 4

Transmit pulse length in μs 2U 1 to 50000 13

Transmit beamwidth in 0.1 degrees 2U 1 to 300 —

Transmit power re maximum in dB 1S 0 to – 50 —

Receive beamwidth in 0.1 degrees 1U 5 to 80 —

Receive bandwidth in 50 Hz resolution 1U 1 to 255 10

Mode 2 or
Receiver fixed gain setting in dB

1U —
0 to 50

12

TVG law crossover angle in degrees 1U 2 to 30 —

Source of sound speed at transducer 1U 0 to 3 5

Maximum port swath width in m 2U 10 to 30000 8

Beam spacing 1U 0 to 3 6

Maximum port coverage in degrees 1U 10 to 110 8

Yaw and pitch stabilization mode 1U — 7

Maximum starboard coverage in degrees 1U 10 to 110 8

Maximum starboard swath width in m 2U 10 to 30000 8
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Table 46 Runtime parameters (cont'd.)

Data Description Format Valid range Note

Transmit along tilt in 0.1 deg. or
Durotong speed in dm/s

2S
2U

-300 to 300
20000 to 25000

9

Filter identifier 2 or
HiLo frequency absorption coefficient ratio

1U 0 to 255
0 to 120

11

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 The table below shows the system error status coded by one bit for each detected

error. The status bit is set to one if error is detected.

Table 47 Multi beam system status

Operator Station status
Bit number Function Model
xxxx xxxx For future use –

Processing Unit status (CPU)
Bit number Function Model
xxxx xxx1 Communication error with BSP (or CBMF) All models except

ME70BO
Communication error with Sonar Head or Transceiver All models except EM

2040 and ME70BO
Communication error with slave PU EM 2040/EM 2040C

xxxx xx1x

Problem with communication with ME70 ME70BO
xxxx x1xx Attitude not valid for this ping All models

xxxx 1xxx Heading not valid for this ping All models

xxx1 xxxx System clock has not been set since power up All models

xx1x xxxx External trigger signal not detected All models except
ME70BO

CPU temperature warning All models except EM
1002

x1xx xxxx

Hull Unit not responding EM 1002

1xxx xxxx Attitude velocity data not valid for this ping EM 122, EM 302,
EM 710, EM 2040,
EM 2040C

BSP status EM 2000, EM 3000 and EM 3002
Bit number Function Model
xxxx xxx1 Error on RX data received by BSP 1

(May be a bad high speed link)
EM 2000,
EM 3000, EM 3000D,
EM 3002, EM 3002D

xxxx xx1x Too much seabed image data on BSP1 EM 3000, EM 3000D

xxxx x1xx Invalid command received by BSP1 EM 3000, EM 3000D

xxxx 1xxx Errors on BSP1 EM 3002, EM 3002D
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Table 47 Multi beam system status (cont'd.)

xxx1 xxxx Error on RX data received by BSP 2
(May be a bad high speed link)

EM 3000D, EM 3002D

xx1x xxxx Too much seabed image data on BSP2 EM 3000D

x1xx xxxx Invalid command received by BSP2 EM 3000D

1xxx xxxx Errors on BSP2 EM 3002, EM 3002D

BSP status EM 1002
Bit number Function Model
xxxx xxx1 Sample number error in RX data received from SPRX —

BSP status EM 120 and EM 300
xxxx xxx1 Sample number error in RX data received from SPRX —

xxxx xx1x Missing RX header data from SPRX —

xxxx x1xx Missing sample data from SPTX —

xxxx 1xxx Missing second RX header data from SPTX —

xxx1 xxxx Bad sync TRU – PU – BSP —

xx1x xxxx Bad parameters received from PU —

x1xx xxxx Internal sync problem in BSP —

1xxx xxxx Checksum error in header from SPTX —

BSP status EM 122, EM 302 and EM 710
Bit number Function Model
xxxx xxx1 Error on RX data received by BSP 1 —

xxxx xx1x Error on RX data received by BSP 3 —

xxxx x1xx Errors on BSP 3 —

xxxx 1xxx Errors on BSP 1 —

xxx1 xxxx Error on RX data received by BSP 2 —

xx1x xxxx Error on RX data received by BSP 4 —

x1xx xxxx Errors on BSP 4 —

1xxx xxxx Errors on BSP2 —

BSP status EM 2040/EM 2040C
Bit number Function Model
xxxx xxx1 Error on data from BSP 1 – master PU —

xxxx xx1x Error on data from BSP 2 – master PU —

xxxx x1xx Error on data from BSP 3 – master PU —

xxxx 1xxx Error on data from BSP 4 – master PU —

xxx1 xxxx Error on data from BSP 1 – slave PU —

xx1x xxxx Error on data from BSP 2 – slave PU —

x1xx xxxx Error on data from BSP 3 – slave PU —

1xxx xxxx Error on data from BSP 4 – slave PU —

CBMF status EM 2040/EM 2040C
xxxx xxx1 Error on data from CBMF 1 – master PU
xxxx xx1x Error on data from CBMF 2 – master PU
xxxx x1xx Error on data from CBMF 3 – slave PU
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Table 47 Multi beam system status (cont'd.)

xxxx 1xxx Error on data from CBMF 4 – slave PU

Sonar Head status EM 2000, EM 3000 and EM 3002
Bit number Function Model
xxxx xxx1 Temperature to high on Sonar Head 1 EM 2000,

EM 3000, EM 3000D,
EM 3002, EM 3002D

xxxx xx1x Data link failure on Sonar Head 1 EM 2000,
EM 3000, EM 3000D,
EM 3002, EM 3002D

xxxx x1xx DC Supply Voltages in Sonar Head 1 is out of range EM 2000,
EM 3000, EM 3000D,
EM 3002, EM 3002D

xxxx 1xxx Spare —

xxx1 xxxx Temperature to high on Sonar Head 2 EM 3000D,
EM 3002D

xx1x xxxx Data link failure on Sonar Head 2 EM 3000D,
EM 3002D

x1xx xxxx DC Supply Voltages in Sonar Head 2 is out of range EM 3000D,
EM 3002D

1xxx xxxx Spare —

Transceiver status EM 120 and EM 300
Bit number Function Model
xxxx xxx1 Transmit voltage (HV) out of range —

xxxx xx1x Low voltage power out of range —

xxxx x1xx Timeout error (SPRX waits for SPTX) —

xxxx 1xxx Receive channel DC offset(s) out of range —

xxx1 xxxx Illegal parameter received from PU —

xx1x xxxx Internal communication error (SPTX – SPRX sync) —

x1xx xxxx Timeout error (SPTX waits for SPRX) —

1xxx xxxx Defective fuse(s) in transmitter —

Transceiver status EM 122, EM 302 and EM 710
Bit number Function Model
xxxx xxx1 Transmit voltage (HV) out of range —

xxxx xx1x Low voltage power out of range —

xxxx x1xx Error on Transmitter —

xxxx 1xxx Error on Receiver —

xxx1 xxxx Not implemented —

xx1x xxxx Not implemented —

x1xx xxxx Not implemented —

1xxx xxxx Not implemented —

Transceiver status EM 1002
Bit number Function Model
xxxx xxx1 Transmit voltage (HV) out of range —

xxxx xx1x Low voltage power out of range —
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Table 47 Multi beam system status (cont'd.)

xxxx x1xx Transmit voltage (HV) to high —

xxxx 1xxx Error in command from PU (Illegal parameter) —

xxx1 xxxx Error in command from PU (Bad checksum) —

xx1x xxxx Error in command from PU (Bad datagram length) —

Transceiver status EM 2040
Bit number Function Model
xxxx xxx1 Transmit power (HV) out of range —

xxxx xx1x Communication error with TX —

xxxx x1xx Communication error with RX 1 (port) —

xxxx 1xxx Communication error with RX 2 (starboard) —

xxx1 xxxx Communication error with IO2040 – master PU —

xx1x xxxx Communication error with IO2040 – slave PU —

x1xx xxxx Spare —

1xxx xxxx Spare —

Sonar Head status EM 2040C
Bit number Function Model
xxxx xxx1 Transmit power (HV) out of range SH1 —

xxxx xx1x Communication error with TX SH1 —

xxxx x1xx Communication error with RX SH1 —

xxxx 1xxx Temperature to high SH1 —

xxx1 xxxx Transmit power (HV) out of range SH2 —

xx1x xxxx Communication error with TX SH2 —

x1xx xxxx Communication error with RX SH2 —

1xxx xxxx Temperature to high SH2 —

2 Mode
Ping mode (EM 3000)
• xxxx 0000 - Nearfield (4º)
• xxxx 0001 - Normal (1.5º)
• xxxx 0010 - Target detect
Ping mode (EM 3002)
• xxxx 0000 - Wide Tx beamwidth (4°)
• xxxx 0001 - Normal Tx beamwidth (1.5°)
Ping mode (EM 2000, EM 710, EM 1002, EM 300, EM 302, EM 120 and EM 122)
• xxxx 0000 - Very Shallow
• xxxx 0001 - Shallow
• xxxx 0010 - Medium
• xxxx 0011 - Deep
• xxxx 0100 - Very deep
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• xxxx 0101 - Extra deep
Ping mode (EM 2040)
• xxxx 0000 - 200 kHz
• xxxx 0001 - 300 kHz
• xxxx 0010 - 400 kHz
TX pulse form (EM 2040, EM 710, EM 302 and EM 122)
• xx00 xxxx - CW
• xx01 xxxx - Mixed
• xx10 xxxx - FM
Frequency (EM 2040C)
Frequency = 180 kHz + 10 kHz * parameter
Examples:
• xxx0 0000 - 180 kHz
• xxx0 0001- 190 kHz
• xxx1 0110 - 400 kHz
TX pulse form (EM 2040C)
• xx0x xxxx - CW
• xx1x xxxx - FM
Dual Swath mode (EM 2040, EM 710, EM 302 and EM 122)
• 00xx xxxx - Dual swath = Off
• 01xx xxxx - Dual swath = Fixed
• 10xx xxxx - Dual swath = Dynamic

3 The filter identifier byte is used as follows:
• xxxx xx00 - Spike filter set to Off
• xxxx xx01 - Spike filter is set to Weak
• xxxx xx10 - Spike filter is set to Medium
• xxxx xx11 - Spike filter is set to Strong
• xxxx x1xx - Slope filter is on
• xxxx 1xxx - Sector tracking or Robust Bottom Detection (EM 3000) is on
• 0xx0 xxxx - Range gates have Normal size
• 0xx1 xxxx - Range gates are Large
• 1xx0 xxxx - Range gates are Small
• xx1x xxxx - Aeration filter is on
• x1xx xxxx - Interference filter is on

4 The used absorption coefficient should be derived from raw range and angle 78
datagram or, for older systems, from the seabed image or central beams echogram
datagram if it is automatically updated with changing depth or frequency.
This absorption coefficient in this datagram is valid at the following frequency
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• EM 120/EM 122: 12 kHz
• EM 300/EM 302: 31.5 kHz
• EM 710: 85 kHz
• ME70BO: 85 kHz
• EM 1002: 95 kHz
• EM 2000: 200 kHz
• EM 3000/EM 3002: 300 kHz
• EM 2040/EM 2040C: 300 kHz

5 The sound speed (at the transducer depth) source identifier is used as follows :
• 0000 0000 - From real time sensor
• 0000 0001 - Manually entered by operator
• 0000 0010 - Interpolated from currently used sound speed profile
• 0000 0011 - Calculated by ME70BO TRU
• xxx1 xxxx - Extra detections enabled
• xx1x xxxx - Sonar mode enabled
• x1xx xxxx - Passive mode enabled
• 1xxx xxxx – 3D scanning enabled

6 The beamspacing identifier is used as follows:
• 0000 0000 - Determined by beamwidth (FFT beamformer of EM 3000)
• 0000 0001 - Equidistant (Inbetween for EM 122 and EM 302)
• 0000 0010 - Equiangle
• 0000 0011 - High density equidistant (In between for EM 2000, EM 120, EM

300, EM 1002)
EM 3002:

bit 7 bit 6 – 4; head 2 bit 3 – 0; head 1
Only one sonar
head is connected.
If two heads are
connected, both
have the same
beam spacing.

0 0 = always (no
head 2)

1 = equidistant
2 = equiangle
3 = high density

Two sonar heads
are connected.
Individual beam
spacing is possible.

1 1 = equidistant
2 = equiangle
3 = high density

1 = equidistant
2 = equiangle
3 = high density

7 The yaw and pitch stabilization identifier is set as follows:
• xxxx xx00 - No yaw stabilization
• xxxx xx01 - Yaw stabilization to survey line heading (Not used)
• xxxx xx10 - Yaw stabilization to mean vessel heading
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• xxxx xx11 - Yaw stabilization to manually entered heading
• xxxx 00xx - Heading filter, hard
• xxxx 01xx - Heading filter, medium
• xxxx 10xx - Heading filter, weak
• 1xxx xxxx - Pitch stabilization is on.

8 Port swath width and coverage was in earlier versions the sum of port and starboard
9 EM 3002, EM 2040, EM 3000, EM 710, EM 302, and EM 122:

Transmit along tilt value, used to offset the along-ship tilting of transmit fan (called
“Along Direction” in SIS and can be set from the Runtime parameters – Sounder
Main menu).
EM 1002:
Sound speed in Durotong (SSD) for the EM 1002 transducer. This value (set to zero
if not available) depends on the water temperature. SSD can be used to calculate the
water temperature in degree C:
• Temp = -0.013913*SSD+313.565

10 Receiver bandwidth values 1 to 254 for receiver bandwidth 50 Hz to 12.7 kHz. A
value of 255 indicates bandwidth larger than 12.7 kHz.

11 Filter identifier 2 or HiLo frequency absorption coeff:
Penetration filter (EM 2040, EM 710, EM 302 and EM 122)
• xxxx xx00 - Penetration filter = Off
• xxxx xx01 - Penetration filter = Weak
• xxxx xx10 - Penetration filter = Medium
• xxxx xx11 - Penetration filter = Strong
Detect mode (EM 3002 and EM 2040)
• xxxx 00xx - Detect mode: Normal
• xxxx 01xx - Detect mode: Waterway
• xxxx 10xx - Detect mode: Tracking
• xxxx 11xx - Detected mode: Minimum depth
Phase ramp (EM 2040, EM 3002, EM 710, EM 302 and EM 122)
• xx00 xxxx - Short phase ramp
• xx01 xxxx - Normal phase ramp
• xx10 xxxx - Long phase ramp
Special TVG (EM 3002 and EM 2040)
• x0xx xxxx - Normal TVG
• x1xx xxxx - Special TVG
Special amp detect / soft sediments
• 0xxx xxxx - Normal amp detect
• 1xxx xxxx - Special amp detect or soft sediments (EM 3002)
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HiLo frequency absorption coefficient ratio (EM 1002)
0 – 120

12 Mode 2 or RX fixed gain
RX array use (EM 2040)
• xxxx xx00 - Off (RX inactive)
• xxxx xx01 - RX 1 (port) active
• xxxx xx10 - RX 2 (starboard) active
• xxxx xx11 - Both RX units active
Sonar head use (EM 2040C)
• xxxx xx00 - Off (Both inactive)
• xxxx xx01 - SH 1 (port) active
• xxxx xx10 - SH 2 (starboard) active
• xxxx xx11 - Both active
Pulselength (EM 2040)
• xxxx 00xx - Short CW
• xxxx 01xx - Medium CW
• xxxx 10xx - Long CW
• xxxx 11xx - FM
Pulselength (EM 2040C)
• x000 xxxx - Very Short CW
• x001 xxxx - Short CW
• x010 xxxx - Medium CW
• x011 xxxx - Long CW
• x100 xxxx - Very Long CW
• x101 xxxx - Extra Long CW
• x110 xxxx - Short FM
• x111 xxxx - Long FM
Receiver fixed gain setting in dB (EM 2000, EM 1002, EM 3000, EM 3002, EM
300, EM 120)

13 Transmit pulse length
The transmit pulse length may not be the same for all TX sectors, and the pulsforms
may vary. The pulselength given here is 1/(transmit bandwidth) for the centre sector.
FM pulse: 1/sweep bandwidth. The total TX pulselength for each sector can be
found in the range and angle datagram.
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Mechanical transducer tilt

Table 48 Mechanical transducer tilt datagrams

Data Description Format Valid range Note

Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = J (Always 4Ah) 1U — —

EM model number (Example: EM 1002 = 1002) 2U — —

Date = year*10000 + month*100 + day (at start
of data record)
(Example: Feb 26, 1995 = 19950226)

4U — —

Time since midnight in milliseconds
(at start of data record)
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Tilt counter (sequential counter) 2U 0 to 65535 —

System serial number 2U 100 – —

Number of entries = N 2U 1 – —

Repeat cycle – N entries of: 4*N —

– Time in milliseconds since record start 2U 0 to 65534 —

– Tilt in 0.01 degrees 2S -1499 to +1499 1

End of repeat cycle

Spare (Always zero) 1U — —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 This tilt angle is the measured mechanical tilt of a hull unit such as that often

supplied with the EM 1002. It is positive when the transducer is tilted forwards.
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ExtraParameters datagram
This datagram is used to give supplementary information, and contains information as
specified by the Content identifier.

Table 49 ExtraParameters 3

Data Description Format Valid range Note
Number of bytes in datagram 4U — —

Start identifier = STX (Always 02h) 1U — —

Type of datagram = 3 (33h, 51d) 1U — —

EM model number (Example: EM 710 = 710) 2U — —

Date = year*10000 + month*100 + day (Example:
Sep 26, 2005 = 20050926)

4U — —

Time since midnight in milliseconds
(Example: 08:12:51.234 = 29570234)

4U 0 to 86399999 —

Ping counter (sequential counter) 2U 0 to 65535 —

System serial number 2U —

Content identifier 2U 1

Array of variable length variable 2

Spare byte if required to get even length (Always
0)

0 – 1U —

Spare (always 0) 1U 0 —

End identifier = ETX (Always 03h) 1U — —

Check sum of data between STX and ETX 2U — —

Notes
1 Content identifier.

Ident. Information contents
1 Calib.txt file for angle offset
2 Log all heights
3 Sound velocity at transducer
4 Sound velocity profile
5 Multicast RX status
6 Bscorr.txt file for back scatter corrections.

2 Array of variable length. This array is described for each content identifier.

Content identifier = 1: The Calib.txt file

The ‘Array of variable length’ contains a text field of 100 characters, containing the file
name “calib.txt”. Thereafter, the contents of the file follows.
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File layout
The angular correction table is made with 1 degree step, from 100 degrees port to 100
degrees starboard (201 elements). The angular offset in this file has been added to the
beam angles in the raw range and angle datagram.
File Comment

EM 300 Name of echo sounder

Line1 For comments

Line2 — ″ —

Line3 — ″ —

Line4 — ″ —

Line5 — ″ —

100 0.0 x.x Info BS offset Angle offset
......

-100 0.0 x.x

Content identifier = 2: Log all heights

This datagram configuration is used for logging parameter settings related to the
definition of additional approved position quality factors. Each of the three positioning
systems available in the PUs has a set of parameters.
The ‘Array of variable length’ is used as follows:
Data Description Format Valid range Note

Active positioning system 4S 0 – 2

Quality factor setting for
pos. system 1, 2, 3.

3 *4S 1=PU decodes Q-factor. Default
0=External PU decode

1

Number of quality factors for
pos. system 1, 2, 3

3 *4S 0 – n 2

Variable no of entries follows = total number of all quality factors: 3

Quality factor 4S 0 – m 4

Limit 4S 0 cm default = not used 5

Notes
1 Each positioning system has its own individual setting.

Value ‘1’ indicates that the PU should decode the quality factors in the traditional
way. This is the default.
Value ‘0’ indicates that the PU should skip quality factor decoding as this is
performed externally. The PU should always transmit the height datagram ‘h’.

2 Each positioning system have an independent set of additional quality factors. The
number of quality factors for each system must be specified. Default value is 0.

3 Each quality factor is described by two entries, the quality factor itself and a limit,
forming a pair. This results in a variable number of such pairs, depending on how
many additional quality factors is set by the operator. If no quality factors are
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defined, no pairs are included. The sequence of pairs is important. First, all pairs for
positioning system 1 is listed, if any. Next any pairs for positioning system 2 and at
the end, any pairs for positioning system 3.

4 A quality factor is a positive number. Currently no upper limit is imposed.
5 Uncertainty in position fix in cm. This uncertainty is associated with the quality

factor value. Currently not used.
Tip

The use of Log all heights is also explained in the SIS Reference Manual.

Content identifier = 3: Sound velocity at transducer

The array of variable length will contain the received datagram containing the sound
velocity at transducer.

Table 50 Current sound velocity

Data Description Format Valid range Note
Spare 2U 0 if unused

Sound velocity 4F m/s —

Content identifier = 4: Sound velocity profile

The array of variable length will contain the received datagram containing the sound
velocity profile.

Table 51 SOUNDSPEEDPROFILE_DATA

Name Type Data Description
Spare 2U 0 if unused
header

header, messageID int32 unique message ID across the PSS-CSI2 interface
header, time, seconds int32 Seconds since 1970-01-01 00:00:00 UTC

header, time, microSeconds int32 Microseconds

header, size int32 the size in bytes of the entire message (including
header)

header, sourceID int32 the ID of the component sending the message.
header, destinationID int32 the ID of the component receiving the message.
sequenceNumber int32 A number incremented for each transmission of

this message.
The current sound speed including depth

soundSpeedPoint, depth real32 Depth in meters

soundSpeedPoint, speed real32 Sound speed in m/s.
The current temperature including depth

TemperaturePoint, depth real32 Depth in meters

TemperaturePoint, temperature real32 Temperature in degrees Celsius
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Table 51 SOUNDSPEEDPROFILE_DATA (cont'd.)

Name Type Data Description
The time the official SSP was recorded.

time, seconds int32 Seconds since 1970-01-01 00:00:00 UTC

time, microSeconds int32 Microseconds

numberOfPointsInOfficialSSP int32 The number of elements in the ‘officialSSP’ array.

Repeat cycle - N entries of SSP: 12*N Array containing the official sound speed points
sorted with ascending depth order.

soundSpeedPoint, depth real32 Depth in meters

soundSpeedPoint, speed real32 Sound speed in m/s.

End of repeat cycle
The time the official TP was recorded.

time, seconds int32 Seconds since 1970-01-01 00:00:00 UTC

time, microSeconds int32 Microseconds

numberOfPointsInOfficialTP int32 The number of elements in the ‘officialTP’ array.

Repeat cycle - N entries of TP: 12*N Array containing the official temperature points
sorted with ascending depth order.

TemperaturePoint, depth real32 Depth in meters

TemperaturePoint, temperature real32 Temperature in degrees Celsius

End of repeat cycle

Table 52 Common data types

Basic data types Size
(bytes)

Description

int32 4 32-bit signed integer (two’s complement)
real32 4 32-bit floating point (IEEE 754)

Content identifier = 5: Multicast input status

The array of variable length will contain the status of received data via multicast.

Table 53 Multicast input status

Name Type Data Description
Multicast 1 status 4U 1) used for position system 1
Multicast 2 status 4U 1) used for position system 1
Multicast 3 status 4U 1) used for position system 1
Multicast 4 status 4U 1) used for sound velocity profile
Multicast 5 status 4U 1)
Multicast 6 status 4U 1)
Multicast 7 status 4U 1)
Multicast 8 status 4U 1)
Multicast 9 status 4U 1)
Multicast 10 status 4U 1)
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Notes
1 The sensor input status is coded in accordance with that given in the PU Setup

datagram, but indicates which sensor datagram types are actually being received
on the respective ports.

Content identifier = 6: Bscorr.txt file

In order to calibrate real-time back scatter levels, correction values may be incorporated
in a file called bscorr.txt and downloaded to the TRU (or PU). The contents of this file
will be stored in the *.all files using the Extra Parameters datagram.

The exact format of the file may vary from echo sounder to echo sounder. Please refer to
the documentation for the specific echo sounder for further details.

In this case, "Array of variable length" has the following format:
Data description Format Valid range
Nc = Number of bytes in text string 2U –

Text string containing contents of bscorr.txt
file

1*Nc –
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PU information and status
Topics
• PU ID output on page 104
• PU Status output on page 107
• PU BIST result output on page 110

PU ID output
The PU Id datagram is broadcasted every second after the PU is powered up, until a host
processor takes command of the Processing Unit through a PU0 datagram. The PU0
datagram may however order the broadcast of this datagram to continue. The broadcast
is sent to Ethernet adress 157:237:255:255 on Port 1999. The broadcast will resume if
the host processor sends a P00 datagram which releases its control of the PU.

Table 54 PU Id output datagrams

Data Description Example Format Valid range Note
Start identifier = STX Always 02h 1U — —

Type of datagram = 0 Always 30h 1U — —

EM model number 1002 2U — 1)

Date = year*10000 + month*100 + day Feb 26, 1995 =
19950226

4U — 2)

Time since midnight in milliseconds 08:12:51.234 =
29570234

4U 0 to 86399999 2)

Byte order flag Always 1 2U — 3)

System serial number — 2U 100 – —

UDP port no 1 — 2U 4)
UDP port no 2 — 2U — 4)
UDP port no 3 — 2U — 4)

UDP port no 4 — 2U — 4)

System descriptor — 4U — 5)

PU software version — 16U ASCII string 6)

BSP software version — 16U ASCII string 6)

Sonar Head/Transceiver software
version

Sonar head 1
software version

16U ASCII string 6)

Sonar Head/Transceiver software
version

Sonar head 2
software version

16U ASCII string 6)

Host IP address — 4U — 7)

TX Opening angle 0 1U 0, 1, 2 or 4 8)

RX Opening angle 1 1U 1, 2 or 4 9)

Spare 0 if not used 6U —

Spare 0 if not used 1U —

End identifier = ETX Always 03h 1U —

Check sum of data between STX and
ETX

2U —
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Notes
1 “1002” must be replaced with the name of the system. 1002 is for EM 1002, 120 for

EM 120, 300 for EM 300, 710 for EM 710, 2000 for EM 2000, 3000 for EM 3000,
3020 for EM 3002, 302 for EM 302, 122 for EM 122, 121 for EM 121A, 850 for
ME70BO, 2040 for EM 2040, 2045 for EM 2040C.
The EM model number and checksum are required.

2 The system time and date will start at 0 on power up, i.e. the host processor must
always set the clock in its first setup command.

3 The byte order of the whole datagram is indicated by this flag.
4 Datagrams are to be sent to the different PU UDP ports as follows (in addition to

use of PU serial ports):
• Port 1: Command datagrams
• Port 2: Sensor datagrams except motion sensor
• Port 3: First motion sensor
• Port 4: Second motion sensor

5 System descriptor (Information for internal use) :

CPU configuration (hex format):
• 00 xx xx xxh – Old CPU card
• 01 xx xx xxh – VIPer or CoolMonster
• 02 xx xx xxh – CT7
• 03 xx xx xxh – Kontron
• 04 xx xx xxh – Kontron and BSP67B for EM 710
• 05 xx xx xxh – Concurrent Technologies PP432
• 06 xx xx xxh – EM2000 AUV
• 07 xx xx xxh – Concurrent Technologies PP 833

For EM 122, EM 302, EM 710, EM 2040 and EM 2040C (binary format, 16
LSB shown):
• xxxx xxxx xxxx xxx0b – Single RX / Single Head
• xxxx xxxx xxxx xxx1b – Dual RX / Dual Head
• xxxx xxxx xxxx xx0xb – Single swath
• xxxx xxxx xxxx xx1xb – Dual swath
• xxxx xxxx xxxx x0xxb – BSP 67B
• xxxx xxxx xxxx x1xxb – CBMF
• xxxx xxxx xxxx 1xxxb – PTP (IEEE 1588 clock sync) supported
• xxxx xxxx xxx0 xxxxb – Deep water sonar head
• xxxx xxxx xxx1 xxxxb – Shallow water sonar head
• xxxx xxxx xx1x xxxxb – Extra detections supported
• xxxx xxxx x1xx xxxxb – RS 422 serial lines supported
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• xxxx xxx0 0xxx xxxxb – EM 2040 Normal
• xxxx xxx0 1xxx xxxxb – EM 2040 Dual TX (2*TX and 2*RX)
• xxxx xxx1 0xxx xxxxb – spare
• xxxx xxx1 1xxx xxxxb – EM 2040P
• xxxx x00x xxxx xxxxb – EM 710
• xxxx x01x xxxx xxxxb – EM 710–MK2

Old sounders (hex format):
• xx xx xx 01h – EM 1002S
• xx xx xx 02h – EM 952
• xx xx xx 03h – EM 1002: with Hull Unit
• xx xx xx 04h – EM 1002S: with Hull Unit
• xx xx xx 05h – EM 952: with Hull Unit
• xx xx xx 08h – EM 3001
• xx xx xx 09h – EM 3002 long pulse available
• xx xx x1 xxh – EM 3002 Rx gain not available

6 The first two elements, PU software version and BSP software version, are the
same for all echo sounders. The last two will vary, depending on which echo
sounder you have:
EM 120 / EM 300: SPRX software version and SPTX software version.
EM 710 / EM 302 / EM 122: RX32 software version and TX36 software version.
EM 1002: SPRX software version and Hull Unit software version.
EM 2000: Sonar Head software version on the third element and number four is
empty.
EM 2040 / EM 2040C: RX and TX software version
EM 3000 / EM 3002: Sonar Head 1 software version and Sonar Head 2 software
version.

7 This is the address derived from the source of the first PU0 datagram, it is 0.0.0.0 if
the PU is not controlled by a host processor.

8 TX Opening angle:
0 = 0.5 degrees, valid for EM 122, EM 302 and EM 710.
1 = 1 degree, valid for EM 122, EM 302 and EM 710.
2 = 2 degrees, valid for EM 122, EM 302 and EM 710.
4 = 4 degrees, valid for EM 122 and EM 302.

9 RX Opening angle:
1 = 1 degree, valid for EM 122, EM 302 and EM 710.
2 = 2 degrees, valid for EM 122, EM 302 and EM 710.
4 = 4 degrees, valid for EM 122 and EM 302.
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PU Status output
The PU Status datagram is sent out every second if requested by the host processor. It
has two functions, to indicate that the system is alive and receiving sensor data, and to
give sensor data regularly for a potential screen update.

Table 55 PU Status output

Data Description Example Format Valid range Note
Start identifier = STX Always 02h 1U — —

Type of datagram = 1 Always 31h 1U — —

EM model number 1002 2U — 1)

Date = year*10000 + month*100 + day Feb 26, 1995 =
19950226

4U — —

Time since midnight in milliseconds 08:12:51.234 =
29570234

4U 0 – 86399999 —

Status datagram counter — 2U 0 – 65535 —

System serial number — 2U 100 – —

Ping rate in centiHz — 2U 0 – 3000 —

Ping counter of latest ping — 2U 0 – 65535 —

Distance between swath in 10% 10 4U 0 – 255 2)

Sensor input status, UDP port 2 — 4U — 3)

Sensor input status, serial port 1 — 4U — 3)

Sensor input status, serial port 2 — 4U — 3)

Sensor input status, serial port 3 — 4U — 3)

Sensor input status, serial port 4 — 4U — 3)

PPS status — 1S — 4)
Position status — 1S — 4)
Attitude status — 1S — 4)

Clock status — 1S — 4)
Heading status — 1S — 4)
PU status — 1U — 11)

Last received heading in 0.01° — 2U 0 – 35999 5)

Last received roll in 0.01° — 2S -18000 – 18000 5)

Last received pitch in 0.01° — 2S -18000 – 18000 5)
Last received heave at sonar head in
cm

— 2S -999 – 999 5)

Sound speed at transducer dm/s — 2U 14000 – 16000 6)
Last received depth in cm — 4U 0 – 5)

Along-ship velocity in 0.01 m/s — 2S — —

Attitude velocity sensor status 0x81 1U — 12)
Mammal protection ramp — 1U — 13)

Backscatter at Oblique angle in dB -30 1S — 7)
Backscatter at normal incidence in dB -20 1S — 7)
Fixed gain in dB 18 1S — 7)
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Table 55 PU Status output (cont'd.)

Data Description Example Format Valid range Note
Depth to normal incidence in m 27 1U — 7), 8)
Range to normal incidence in m 289 2U — 7), 9)

Port Coverage in degrees — 1U — 7), 9)

Starboard Coverage in degrees — 1U — 7), 9)

Sound speed at transducer found from
profile in dm/s

— 2U 14000 – 16000 9)

Yaw stabilization angle or tilt used at 3D
scanning, in centideg.

— 2S — 9)

Port Coverage in degrees or Across-ship
velocity in 0.01 m/s

— 2S — 10)

Starboard Coverage in degrees or
Downward velocity in 0.01 m/s

— 2S — 10)

EM2040 CPU temp in °C 0 if not used 1S — —

End identifier = ETX Always 03h 1U — —

Check sum of data between STX and
ETX

— 2U — —

Notes
1 “1002” must be replaced with the name of the system: 1002 is for EM 1002, 120 for

EM 120, 300 for EM 300, 710 for EM 710, 2000 for EM 2000, 3000 for EM 3000,
3020 for EM 3002, 302 for EM 302, 122 for EM 122, 121 for EM 121A, 850 for
ME70BO, 2040 for EM 2040, 2045 for EM 2040C.
The EM model number and checksum are required.

2 Achieved swath distance in percent of required swath distance. The value is shown
in 10% steps, and the range is 0 – 255. 0 indicates that the function is not used. 10
indicates 100% (achieved swath distance equals required swath distance).

3 The sensor input status is coded in accordance with that given in the PU Setup
datagram, but indicates which sensor datagram types are actually being received
on the respective ports.

4 0 or a negative number indicates that the quality of the data received is not
acceptable, positive OK.

5 These values are all from sensor input (active motion sensor or depth sensor).
6 Not implemented on release 5.1u25 or older.
7 Automatic tracking info used by the echo sounder.
8 Spare except for releases made before January 2004 (EM 3000, EM 2000).
9 Not included for releases made before January 2004 (EM 3000, EM 2000).
10 For EM 3002: From January 2005 used for port and starboard coverage.

EM 710, EM 302, EM 122: Across and downward velocity
Other sounders: Spare

11 0 = off
1 = active
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2 = simulator
10 = ME70BO TRU – disconnected
11 = ME70BO TRU – mode change

12 The two most significant bit (MSB) indicates sensor status:
00xx xxxx = no data received
10xx xxxx = data received from attitude velocity system 1
01xx xxxx = data received from attitude velocity system 2
11xx xxxx = data received from both attitude velocity systems
The six least significant bits (LSB) are used to indicate sensor input datagram type:
xx00 0000 = velocity attitude sensor not connected
xx00 0001 = Seatex binary format 11 / binary format 23
xx00 0010 = Applanix Group 102/103
xx00 0011 = CodaOctopus MCOM
(List may be expanded in the future to include more sensor types.)

13 Mammal protection: High voltage power supply remaining ramp up time in %.
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PU BIST result output
The PU BIST (built in self test) result datagram is sent out as a result of a BIST command.
The test result is given as an ASCII string plus a status value. For a dual EM 3000 / EM
3002 and BIST # 99 (used for startup), two datagrams are used, one for each head.

Table 56 PU BIST result output

Data Description Example Format Valid range Note
Start identifier = STX Always 02h 1U — —

Type of datagram = B Always 42h 1U — —

EM model number 1002 2U — 1)

Date = year*10000 + month*100 + day Feb 26, 1995 =
19950226

4U — —

Time since midnight in milliseconds 08:12:51.234 =
29570234

4U 0 to 86399999 —

BIST result counter (sequential counter) — 2U 0 – 65535 —

System serial number — 2U 100 – —

Test number — 2U — —

Test result status — 2S — 2)
Test result description, terminated with
“/0”, total length is variable (max = 5000)

— NU ASCII string 3)

Spare byte if required to get even length Always 0 if used 0–1U — —

End identifier = ETX Always 03h 1U — —

Check sum of data between STX and
ETX

— 2U — —

Notes
1 “1002” must be replaced with the name of the system.

1002 is for EM 1002, 120 for EM 120, 300 for EM 300, 710 for EM 710, 2000 for
EM 2000, 3000 for EM 3000, 3020 for EM 3002, 302 for EM 302, 122 for EM 122,
121 for EM 121A, 850 for ME70BO, 2040 for EM 2040 and 2045 for EM 2040C.
The EM model number and checksum are required.

2 A negative number or zero indicates an error, 1 that result is OK and test is finished,
while 2 indicates that result so far is OK, but the test is not finished.
The test result status interpretation is special for EM 1002 in some cases:
When ’Test number’ is 15:
0 = error
1 = OK (no hull unit)
2 = OK (hull unit error)
3 = OK (hull unit OK)
When ’Test number’ is 99:
-2 = OK (hull unit error/missing)
0 = error
1 = OK
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3 The text will always start with an identifying mnemonic.
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SIS generated output
Topics
• APB Datagram on page 112
• DPT Datagram on page 112
• RTE Datagram on page 113
• WPL Datagram on page 113
• KSSIS 31 Datagram on page 114

APB Datagram
APB Autopilot sentence according to NMEA 0183 version 2.3.

Table 57 APB output datagram

Data Description Format Valid Range Note
Start identifier = $ Always 24h — —

Talker identifier Always KM — —

Sentence formatter Always APB, — —

Status Always A, — —

Status Always A, — —

Magnitude of XTE (cross track error) x.x, — —

Direction to steer a, L or R —

XTE units (nautical miles Always N, — —

Status 1 a, A or empty —

Status 2 a, A or empty —

Bearing origin to waypoint x.x, 0.0 to 359.9 —

Bearing type a, M or T —

Destination waypoint ID Always wid, — —

Bearing, present position to destination x.x, 0.0 to 359.9 —

Bearing type a, M or T —

Heading to steer to destination waypoint x.x 0.0 to 359.9 —

Bearing type a, M or T —

Mode indicator Always A, — 1

Checksum *hh — —

End if sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 Field does not exist if the system is configured to use NMEA version prior to 2.30

DPT Datagram
DPT sentence according to NMEA 0183 version 2.3 contains depth relative to the
transducer and offset from transducer.
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Table 58 DPT output datagram

Data Description Format Valid Range Note
Start identifier = $ Always 24h — —

Talker identifier Ka KA to KJ 1

Sentence formatter Always DPT, — —

Water depth relative to transducer, meters x.x, 0 to 12,000 —

Offset from transducer, meters x.x, — —

Maximum range scale in use Always 12000.0 — —

Checksum *hh — —

End if sentence delimiter = CRLF Always 0Dh 0Ah — —

RTE Datagram
The RTE routes datagram is part of the DynPos datagram set. Two datagrams are sent
when DynPos output is enabled and a planned line is activated

Table 59 RTE output datagram

Data Description Format Valid Range Note
Start identifier = $ Always 24h — —

Talker identifier Always KM — —

Sentence formatter Always RTE, — —

WPL Datagram
This datagram is part of the DynPos datagram set. Two datagrams are sent when DynPos
output is enabled and a planned line is activated

The WPL datagram contains the coordinates of the activated line. One datagram is
sent for each point on the line.

Table 60 WPL output datagram

Data Description Format Valid Range Note
Start identifier = $ Always 24h — —

Talker identifier Always KM — —

Sentence formatter Always WPL, — —

Waypoint latitude llll.ll, — —

Latitude — N/S a, N or S —

Waypoint longitude yyyyy.yy, — —

Longitude — E/W a, E or W —

Waypoint ID c–c
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KSSIS 31 Datagram
Datagram from SIS HWS sent to external applications containing a combined set of
information per ping.

Table 61 KSSIS 31 output datagram

Data Description Format Valid Range Note
Start identifier = $ Always 24h — —

Talker identifier Always KS — —

Sentence formatter Always SIS, — —

Datagram ID Always 31, — —

Model number x, — —

Serial number x, — —

Beams sent x, — —

Beams received x, — —

Depth from surface to seafloor(cm) x.x, — —

Depth from surface to transducer (cm) x.x, — —

Across distance (cm) x.x, — —

Across distance, port (cm) x.x, — —

Across distance, starboard (cm) x.x, — 1

Last tide (m) x.x, — —

Last geoid undulation (m) x.x, — —

Last distance from the geoid to the vertical
reference (m)

x.x, — —

Minimum depth in swath (cm) x.x, — —

Maximum depth in swath (cm) x.x, — —

End if sentence delimiter = CRLF Always 0Dh 0Ah — —

Notes
1 0 if the total across is to the opposite side
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Appendix A
EM 2040 details

EM 2040 transducer installation offsets
For most EM type echo sounders, all elements in the TX and RX transducer arrays are
used for all beams, giving a common x,y,z location for each transducer. But for the EM
2040 this is different. The TX transducer has 3 separate arrays, used for port, centre and
starboard sectors, and the RX array has an along-ship offset.

The transducer x,y,z offsets are taken into account by the PU when calculating the “XYZ
88” datagram. If it is needed to recalculate XYZ data in post-processing from the “Raw
Range and angle 78” datagram, these offsets should also be taken into account.

For the EM 2040, the transducer installation coordinates refers to the center of the
transducer faces. The installation coordinates are given in the “Installation parameters”
datagram:

TX: S1X, S1Y, S1Z
RX1: S2X, S2Y, S2Z (single RX/port RX)
RX2: S3X, S3Y, S3Z (starboard RX)

The coordinates are given in the Vessel Coordinate System, where x is forward, y
is starboard and z is downward.
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Figure 1 Typical EM 2040 transducer configuration viewed from above (single RX)

TX array offsets:

Figure 2 TX transducer seen from behind (default orientation):
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When the TX array is mounted at default orientation, i.e. plug on port side, element # 1 at
aft, the x,y,z positions for the 3 TX line arrays relative to the centre of the array face are:

Index Forward (x) Starboard (y) Downwards (z)

Port array 0 0 mm –55.4 mm –12.0 mm

Centre array 1 0 mm 13.15 mm –6.0 mm

Starboard array 2 0 mm 55.4 mm –12.0 mm

RX array offsets:

Figure 3 RX transducer seen from starboard (default orientation):

When the RX array is mounted at default orientation, ie plug on front side, element # 1 at
port side, the X,Y,Z positions of the line array re centre of the RX array face are:
Forward (x) Starboard (y) Downwards (z)

11.0 mm 0 mm –6.0 mm

Use of TX array index in the “Raw range and angle 78” datagram

In order to take into account TX array offsets when processing data from the “Raw range
and angle 78” datagram, the actual array being used is coded into the transmit sector
section of the datagram (Repeat cycle 1), using the “Transmit sector number / TX array
index” parameter. I.e. for the EM 2040, this parameter does not mean transmit sector, but
array index. The transmit sector number can be derived implicitly by counting number of
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“Repeat cycle 1” entries – first cycle is transmit sector 0, second cycle is transmit sector
1 etc. Note that in the receive beam section of the datagram (Repeat cycle 2), “Transmit
sector number” still means just that – transmit sector.

Example:
• Three sectors – sector 0, 1 and 2.
• Array indexes are 2, 1 and 0 respectively (which typically implies that the TX is

installed with a 180°heading offset).
• One of the beams has the “Transmit sector number” parameter set to 2, i.e. it is

pointing to the last TX block (Repeat cycle 1) in the datagram. For this TX sector,
the array index is 0.
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•

Figure 4 Excerpt of the “Raw range and angle 78” datagram:
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EM 2040 Dual RX

For Dual RX, the installation coordinates (x, y, z) and angles (roll, pitch, heading) are
given by the following parameters in the “Installation parameters” datagram:

TX: S1X, S1Y, S1Z, S1R, S1P, S1H
RX1 (port): S2X, S2Y, S2Z, S2R, S2P, S2H
RX2 (starboard): S3X, S3Y, S3Z, S3R, S3P, S3H

Note that the installation coordinates refer to the center of the transducer faces. For
information about the location of the physical transducer arrays inside the transducer
units, see appendix EM 2040 transducer installation offsets on page 115.

For EM 2040 Dual RX, data from RX1 (port) and RX2 (starboard) are stored in separate
datagrams. This relates to the following datagrams:
• XYZ 88 on page 43
• Raw range and angle 78 on page 55
• Seabed image data 89 on page 60
• Water column datagram on page 62

The datagrams from the different RX units are differentiated by the parameter “System
serial number”. The “System serial numbers” for the two RX units are found in the
header of the “Installation parameters” datagram. The parameters called “System serial
number” is valid for RX1 (port), while the parameter called “Secondary system serial
number” is valid for RX2 (starboard).
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Data description Example Format Valid range Note

Number of bytes in
datagram

– 4U – 1

Start identifier =
STX

Always 02h 1U –

Type of datagram
= I, I or r

49h, 69h, 70h 1U –

EM model number EM 2040 = 2040 2U –

Date = year*10000
+ month*100 + day

4U –

Time since
midnight in
milliseconds

4U 0 to 86399999

Survey line
number

— 2U 0 to 65534

System serial
number

123 2U 100 –

Secondary system
serial number

10123 2U 100 –

Using the example above, multibeam datagrams (XYZ etc) for RX1 (port) will have the
“System serial number” parameters set to 123, while multibeam datagrams for RX2
(starboard) will have the “System serial number” parameter set to 10123.

Note

Note that the “Installation parameters” datagram also contains information about
transducer serial numbers in parameters TXS, R1S and R2S. These will generally be
different from the “System serial number” parameter used in the datagram headers and
are included for reference only.

EM 2040 Scanning mode
When running in Scanning mode, one of two or three sectors is transmitted per ping.
This means that data from two or three pings need to be coupled together to form the
complete swath. This can be done using the “Scanning info” parameter which is coded
into the “XYZ 88” and “Water Column” datagrams. In the “Scanning info” parameter,
the total number of scanning sectors is coded into the four least significant bits, while the
actual scanning sector (counting from zero) is coded into the four most significant bits.

If the “Scanning info” parameter is set to 0, scanning is not used.
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Example: Scanning with 3 sectors.
Ping counter Scanning info Swath number

1 03h

2 13h

3 23h

1

4 03h

5 13h

6 23h

2

Due to lack of spare bytes, the Scanning info is not directly coded into “Raw range and
angle 78” and “Seabed image data 89” datagrams. In order to couple together data
from these datagram types, the “Scanning info” parameter has to be extracted from the
corresponding “XYZ 88” datagram using the “Ping counter” as a common reference.
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Appendix B
EM 2040C installation

offsets

For the EM 2040C, the TX and RX arrays are integrated into a common sonar head. The
transducer arrays are not placed at the centre of the sonar head. The EM 2040C can have
one or two sonar heads. For most EM echo sounders separate x,y,z installation parameters
are given for the RX and the TX arrays. For EM 2040C the installation parameters
entered by the operator refers to the centre of the face of the sonar head(s). The
transducer x,y,z offsets are taken into account by the Processing Unit when calculating
the “XYZ 88” datagram. If it is needed to recalculate XYZ data in post-processing from
the “Raw Range and angle 78” datagram, these offsets should also be taken into account.

The sonar head installation coordinates are given in the “Installation parameters”
datagram:
• SH 1: S1X, S1Y, S1Z
• SH 2: S2X, S2Y, S2Z

The coordinates are given in the Vessel Coordinate System, where x is forward, y is
starboard and z is downward. The x,y,z positions for the RX and TX transducer arrays
relative to the centre of the sonar head face are:

Forward (x) Starboard (y) Downwards (z)
TX 3.8 mm 40.0 mm -6.0 mm
RX -45.5 mm 0.0 mm -6.0 mm

For EM 2040C with dual sonar heads, data from SH1 and SH2 are stored in separate
datagrams, using different serial numbers. This relates to the following datagrams:
• XYZ 88
• Raw range and angle 78
• Seabed image data 89
• Water column
• Stave display
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The “System serial numbers” for the two sonar heads are found in the header of the
“Installation parameters” datagram. The parameters called “System serial number” is
valid for SH1, while the parameter called “Secondary system serial number” is valid
for SH2.

Data
Description

Example Format Valid range Note

Number of
bytes in
datagram

- 4U - 1

Start identifier
= STX

Always 02h 1U - -

Type of
datagram = I, I
or r

49h, 69h, 70h 1U - -

EM model
number

EM 2040C=
2045

2U - -

Date =
year*10000 +
month*100 +
day

4U - -

Time since
midnight in
milliseconds

4U 0 to 86399999 -

Survey line
number

- 2U 0 to 65534 -

System serial
number

0123 2U 100 - -

Secondary
system serial
number

0125 2U 100 -

Using the example above, multibeam datagrams (XYZ etc) for SH1 will have the
“System serial number” parameters set to 0123, while multibeam datagrams for SH2 will
have the “System serial number” parameter set to 0125.
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Appendix C
Handling of .all–files

The Seafloor Information System, SIS, is responsible for logging all the data from the
Kongsberg multibeam echosounder systems, MBES. In addition SIS will display real
time digital terrain models made from these data.

SIS runs on a PC-architecture computer running Windows. Data from the MBES arrives
at the PC via an Ethernet connection as UDP packets of variable length.

The data is stored in files with the extension .all. The prefix is normally
nnnn_YYYYMMDD_HHMMSS, with the name of the ship appended if the operator
has chosen to: nnnn_YYYYMMDD_HHMMSS_Shipname. The letters nnnn is the line
number, while the time in the first datagram in the file is decoded and used to make the
rest of the prefix. (Note that the clock in the PC is not used).

The storage locations of the .all-files are defined by the operator. First a general
location is set, i.e. c:\sisdata\rawdata with the name of the survey appended to the
path. The rest of the path can be defined by the operator in SIS to be a tree-structure
or not. Typically the rest of the path is year/month/day so the complete path may be:
c:\sisdata\rawdata\my_survey\2006\10\20\0001_20061020_123456_Shipname.all.

Because the tree-structure can be chosen freely, it is necessary to find all the files below
the general location and the survey, c:\sisdata\rawdata\my_survey, and then sort all
the files by their date and time, YYYYMMDD_HHMMSS, to find the chronological
sequence of files.

The datagrams from the MBES arrives at the PC in one stream. The timestamp of
the data may not be strictly sequential. For example motion sensor data is grouped
together and sent from the MBES to SIS in one datagram containing 100 motion sensor
measurements with individual timestamps, and then they may arrive one second behind
the depth datagram. This makes it necessary to read several motion sensor datagrams to
find the correct one to be used when applying motion to the depth data. The individual
datagram types must be handled separately and the interpolation to other datagram types
must be done based on the timestamps.

When one survey line is closed and a new survey line is opened, the stream of datagrams
is cut exactly when the operator chooses to create a new line. The result is that the
datagram needed to merge data at the end of the previous line may be found in the
beginning of the next line. One typical situation is that one position datagram is followed
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by one depth datagram in the previous line, and the next position datagram is found in
the beginning of the next line. To interpolate the correct position for the last depth
datagram, the position datagram just before it must be used together with the position
datagram in the following line.

The content of the datagrams is described in the datagram description. When the
datagrams are written to file, the size of the datagram is written before the datagram in
two bytes (one short integer). Thus to read the file, first read two bytes (one short), then
read that number of bytes from the file which is then one datagram. The datagram is
easily decoded by inspecting the header information in each datagram.
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Overview
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